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Dear Reader,

Thank you for choosing AutoCAD 2015 and AutoCAD LT 2015: No Experience 
Required. This book is part of a family of premium-quality Sybex books, all of 
which are written by outstanding authors who combine practical experience 
with a gift for teaching.

Sybex was founded in 1976. More than 30 years later, we’re still committed to 
producing consistently exceptional books. With each of our titles, we’re working 
hard to set a new standard for the industry. From the paper we print on to the 
authors we work with, our goal is to bring you the best books available.

I hope you see all that reflected in these pages. I’d be very interested to hear 
your comments and get your feedback on how we’re doing. Feel free to let me 
know what you think about this or any other Sybex book by sending me an email 
at contactus@sybex.com. If you think you’ve found a technical error in this book, 
please visit http://sybex.custhelp.com. Customer feedback is critical to our 
efforts at Sybex. 

 Best regards,

                                                           

 Chris Webb

 Associate Publisher
 Sybex, an Imprint of Wiley
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Introduc tion
This book was born of the need for a simple yet engaging tutorial that 
would help beginners step into the world of Autodesk® AutoCAD® or Autodesk® 
AutoCAD LT® software without feeling intimidated. That tutorial has evolved 
over the years into a full introduction to the ways in which architects and civil 
and structural engineers use AutoCAD to increase their efficiency and ability to 
produce state-of-the-art computerized production drawings and designs.

Because the Microsoft Windows versions of AutoCAD and AutoCAD LT are so sim-
ilar, it makes sense to cover the basics of both programs in one book. For most of 
the book, the word AutoCAD stands for the Windows versions of both AutoCAD and 
AutoCAD LT. Although Apple Macintosh versions of both AutoCAD and AutoCAD LT 
are available, the interface and underlying tool set on that platform prevent it from 
aligning with the workflows and procedures outlined in this book.

When you come to a section of a chapter that applies to AutoCAD only, 
the icon shown here is displayed in the margin to alert you. When appro-

priate, extra information for AutoCAD LT users is provided to give you a work-
around or otherwise keep you in step with the tutorial.

Because AutoCAD LT doesn’t have 3D commands or features, the last two 
chapters, which are an introduction to drawing in 3D, apply only to AutoCAD. 
But AutoCAD LT users can be assured that it is very much the same program 
as AutoCAD, with only minor differences. You’ll be prompted when those differ-
ences arise, most of which involve 3D features.

When you come to a section that applies to one of the many new fea-
tures found inside AutoCAD 2015, the icon shown here is displayed in the 

margin to alert you. This book is directed toward AutoCAD and AutoCAD LT nov-
ices—users who know how to use a computer and perform basic file-managing 
tasks, such as creating new folders and saving and moving files, but who know 
little or nothing about AutoCAD or AutoCAD LT. If you’re new to the construc-
tion and design professions, this book will be an excellent companion as you 
learn AutoCAD. If you’re already practicing in those fields, you’ll immediately be 
able to apply the skills you’ll pick up from this book to real-world projects. The 
exercises have been successfully used to train architects, engineers, and contrac-
tors, as well as college and high school students, in the basics of AutoCAD.

For those of you in other trades and professions, the project that runs through 
the book—drawing a small cabin—has been kept simple so that it doesn’t 
require special training in architecture or construction. Also, most chapters 
have additional information and exercises specifically designed for non-AEC 
(architecture, engineering, and construction) users. Anyone wanting to learn 
AutoCAD will find this book helpful.
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What Will You Learn from This Book?
Learning AutoCAD, like learning any complex computer program, requires a 
significant commitment of time and attention and, to some extent, a tolerance 
for repetition. You must understand new concepts to operate the program and 
to appreciate its potential as a drafting and design tool. However, to become pro-
ficient at AutoCAD, you must also use the commands enough times to gain an 
intuitive sense of how they work and how parts of a drawing are constructed.

At the end of most chapters, you’ll find one or more additional exercises and 
a checklist of the tools you have learned (or should have learned). The steps in 
the tutorial have a degree of repetition built into them that allows you to work 
through new commands several times and build up confidence before you move 
on to the next chapter.

Progressing through the book, the chapters fall into five general areas of study:

▶▶ Chapters 1 through 3 familiarize you with the organization of the 
AutoCAD user interface, cover a few of the basic commands, and 
equip you with the tools necessary to set up a new drawing, includ-
ing the use of a standard, such as the National CAD Standard (NCS), 
to organize your files.

▶▶ Chapters 4 and 5 introduce the basic drawing commands and develop 
drawing strategies that will help you use these commands efficiently.

▶▶ Chapters 6 through 11 work with the major features of AutoCAD, such 
as blocks, hatches, and annotation. You’ll also learn about using layers 
to organize the various components of a drawing by applying the NCS.

▶▶ Chapters 12 through 15 examine intermediate and advanced 
AutoCAD features, including managing and creating document sets 
by using Sheet Set Manager.

▶▶ Chapters 16 and 17 cover the 3D modeling tools by exploring 3D 
solids and 3D surfaces. You’ll also learn how to apply materials to 
3D objects, allowing you to produce eye-catching 3D visualizations. 
In the process of exploring these elements, you’ll follow the steps 
involved in laying out the floor plan of a small cabin. You’ll then learn 
how to generate elevations from the floor plan, and eventually you’ll 
learn how to set up a title block and layouts to print your drawing.

www.MouradEngineering.com



 I n t r o d u c t i o n  x i x

 Along the way, you’ll also learn how to do the following:

▶▶ Use the basic drawing and modify commands in a strategic 
manner

▶▶ Set up layers by using an established standard

▶▶ Assign colors to your drawing

▶▶ Define and insert blocks

▶▶ Generate elevation views

▶▶ Place hatch patterns and fills on building components

▶▶ Use text in your drawing

Chapters in the latter part of the book touch on the more advanced features of 
AutoCAD, including the following:

▶▶ Creating dynamic drawings by using geometric and dimensional 
parametric constraints

▶▶ Dimensioning the floor plan

▶▶ Drawing a site plan and managing drawings of varying units

▶▶ Efficiently organizing drawing sets by using external references

▶▶ Setting up and managing drawings for printing with layouts

▶▶ Making a print of your drawing

▶▶ Working in 3D (for AutoCAD users)

All these features are taught by using the cabin as a continuing project. As a 
result, you’ll build a set of drawings that document your progress throughout 
the project. You can use these drawings later as reference material if you need to 
refresh your memory with content that covers a specific skill.

Files on the Website
If you’re already somewhat familiar with AutoCAD and you’re reading only 
some of the chapters—or if you want to check your work on the cabin against 
the book at different stages, you can pull the accompanying files from this 
book’s page on Wiley’s website at www.sybex.com/go/autocad2015ner. Click the 
Resources & Downloads button on that page.
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To help you learn AutoCAD further, a companion website is also available at 
www.thecadgeek.com that, in addition to the dataset, offers a comprehensive 
library of instructional videos, additional exercises, and more. Visiting this site 
will also let you view this book’s errata and interact with the author by posing 
questions you may have about its contents.

Hints for Success
Because this book is essentially a step-by-step tutorial, it has a common side 
effect with tutorials of this type. After you finish a chapter and see that you have 
progressed further through the cabin project, you may wonder exactly what you 
just did and whether you could do it again without the help of the step-by-step 
instructions.

This feeling is a natural result of this type of learning tool, and you can do a 
couple of things to get beyond it:

▶▶ You can work through the chapter again. Doing so may seem 
tedious, but it will help you draw faster. You’ll be able to accomplish 
the same task in half the time it took you to do it in the first place. 
If you do a chapter a third time, you’ll halve your time again. Each 
time you repeat a chapter, you can skip more and more of the explicit 
instructions, and eventually you’ll be able to execute the commands 
and finish the chapter by just looking at the figures and glancing 
at the steps. In many ways, this process is like learning a musical 
instrument. You must go slowly at first, but over time and through 
practice, your pace will pick up.

▶▶ Follow the course of the book but apply the steps to a different proj-
ect. You might draw your own living space or design a new one. If 
you have a real-life design project that isn’t too complex, that’s even 
better. Your chances for success in learning AutoCAD, or any com-
puter program, are greatly increased when you’re highly motivated—
and a real project of an appropriate size can be the perfect motivator.

Ready, Set…
Even with some of the most knowledgeable and passionate teachers by my 
side, I remember how overwhelming it was to learn AutoCAD as a student in 
high school. With each command I learned, it seemed that there were another 
five I had yet to learn, and that was before AutoCAD evolved into the sophisti-
cated, Microsoft Windows–based modeling and design platform that it is today. 
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Ironically, the biggest challenge to knowing AutoCAD wasn’t learning the com-
mands, but rather learning how to apply them in the most efficient way.

For several years, my personal mantra has been simple: to “empower CAD 
professionals.” While writing this book, I didn’t want simply to introduce a 
bunch of commands without also putting them in context and demonstrating 
how to apply them to create drawings efficiently. With each exercise building on 
the previous one, you’ll learn not only the individual commands but also how 
everything snaps together as you produce a complete document setup in the 
same way as industry professionals do. As the title says, there is “no experience 
required”—only an interest in the subject and a willingness to learn!

Free Autodesk Software for Students and Educators

The Autodesk Education Community is an online resource with more than 5 mil-
lion members that enables educators and students to download—for free (see 
website for terms and conditions)—the same software used by professionals 
worldwide. You can also access additional tools and materials to help you design, 
visualize, and simulate ideas. Connect with other learners to stay current with 
the latest industry trends and get the most out of your designs. Get started 
today at www.autodesk.com/joinedu.
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CHAPtER 1

Getting to Know 
AutoCAD for Windows
Opening either the Autodesk® AutoCAD® or Autodesk® AutoCAD LT® 
program for the first time presents you with an expansive canvas of tools, 
settings, and more. Faced with this seemingly endless landscape of options, 
you are probably wondering where you should start. This chapter faces that 
question head on and breaks down the many components of the user inter-
face into manageable segments, introducing you to essential operations, 
such as opening drawings. Even if you’ve used earlier versions of AutoCAD, 
you’ll still want to review this chapter to become acquainted with changes 
that have taken place in recent years.

The 2015 release continues the evolution of the user interface seen in 
recent versions of the software but maintains a foundational parity between 
AutoCAD and AutoCAD LT. Generally speaking, both platforms offer the same 
2D drafting experience. The biggest difference is that AutoCAD LT doesn’t 
have any 3D capability, whereas AutoCAD offers many powerful tools for 3D 
modeling. (These tools are the topics of Chapter 16, “Creating 3D Geometry,” 
and Chapter 17, “Rendering and Materials.”) With so little separating the two 
platforms, I refer to both interchangeably as AutoCAD for most purposes in 
this book.

In this chapter, you will learn to

▶▶ Open a new drawing

▶▶ Familiarize yourself with the AutoCAD and AutoCAD LT 
Application windows

▶▶ Modify the display

▶▶ Display and arrange AutoCAD tools
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Starting AutoCAD for Windows
If you installed AutoCAD by using the default settings for the location of the pro-
gram files, start the program by choosing Start ➢ All Programs ➢ Autodesk ➢ 
AutoCAD 2015 ➢ AutoCAD 2015, or by choosing Start ➢ Programs ➢ Autodesk ➢ 
AutoCAD LT 2015 ➢ AutoCAD LT 2015, depending on the program you’re using. 
(This command path might vary depending on the Windows operating system and 
the scheme you are using.) Alternatively, you can double-click the AutoCAD 2015 
icon or the AutoCAD LT 2015 icon on your desktop.

What this Book Covers

Although this book does not focus on the discipline-specific tools found within 
products based on AutoCAD for Windows such as AutoCAD® Architecture or 
AutoCAD® Civil 3D®, it does focus on the core AutoCAD skills necessary to use 
these vertical AutoCAD platforms. To use one of these vertical products to learn 
the topics covered in this book, choose Start ➢ All Programs ➢ Autodesk ➢ 
AutoCAD Product Name 2015 ➢ AutoCAD Product Name As AutoCAD 2015. 

The Mac version of AutoCAD applies an OS X native interface that differs from 
its Windows counterparts. Although the core concepts covered in this book 
are universal, the step-by-step procedures differ between the two operating 
systems. The procedures covered in this book are intended for use with only the 
Windows-based version of AutoCAD.

Exploring the user Interface 
Like most Windows-based applications, AutoCAD launches inside an Application 
window. Serving as a starting point, the New Tab is the first user interface (UI) 
displayed within the Application window, but workspaces will control the overall 
composition of your AutoCAD environment from there. I’ll explain the general 
function of workspaces shortly, including the default workspace named Drafting 
& Annotation, but first I’ll explain the New Tab.
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using the new tab
Before creating or opening any drawings, the New Tab is displayed to provide a 
starting point for your entire AutoCAD experience. This interface is organized 
into two parts: one page for creating drawings, and another page for learning 
about AutoCAD. The Create page shown in Figure 1.1 is displayed by default and 
serves as a launchpad for creating and working with the drawing files that com-
pose your projects.

F I G u R E   1 . 1 :   The Create page on the New Tab

The Create page contains three columns and may include up to four panels:

Get Started  Serving as a pseudo File menu, the Get Started panel is focused 
on creating new files and browsing for existing files. The Start Drawing tool 
enables you to quickly create new drawing files, whereas the other tools let you 
open existing drawings and sheet sets, access templates online, and even view a 
collection of sample drawings.

Recent Documents  AutoCAD keeps a running record of each drawing file you 
open and displays the most recent drawings in this panel. The length of this 
recent document history is configurable with the OPTIONS command.
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notifications  This panel is visible only when there is an issue regarding your 
current configuration of AutoCAD. It notifies you of graphic configuration 
issues, product updates, and more. 

Connect  Autodesk® 360 is the cloud computing platform integrated into 
AutoCAD 2015. The Connect panel is made up of cloud services such as storage 
and rendering, and it provides quick access to the full portfolio of Autodesk 360 
services.

Selecting the Learn page tab at the bottom of the New Tab, or the page arrow 
on the left edge, opens the Learn page shown in Figure 1.2. You can access basic 
information about AutoCAD from this page.

F I G u R E   1 . 2 :   The Learn page on the New Tab

Like the Create page, the Learn page is divided into three columns and 
includes panels for the following:

What’s new  This panel features video content demonstrating the many new 
features and enhancements found in AutoCAD 2015.

Getting Started Videos  The videos on this panel are intended for anyone just 
getting started with AutoCAD, and highlight a collection of tools essential for 
creating drawings.

tip  This panel is especially helpful after you master the basics of AutoCAD. It 
displays suggestions for streamlining your existing workflows.
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online Resources  Quickly access web-based materials such as the main 
AutoCAD Services & Support page, which provides access to product informa-
tion, troubleshooting articles, and even training videos.

Introducing Workspaces
Our tour of the user interface has so far been limited to the New Tab that dis-
plays after starting AutoCAD. Opening or creating a drawing will dismiss the New 
Tab interface and load a vast assortment of tools in addition to the drawing you 
selected. To load this interface, click the Start Drawing tool on the Create page.

The collection of tools displayed after creating or opening a drawing is called 
a workspace, and AutoCAD includes several designed to match the type of work 
you’re doing. Most of this book uses the default Drafting & Annotation work-
space, but Chapters 16 and 17 (which focus on 3D) use the available 3D work-
spaces. The standard workspaces found within AutoCAD are as follows:

Drafting & Annotation  Utilizing the Ribbon, this workspace (shown in Figure 1.3) 
is considered the default AutoCAD workspace. Unless otherwise specified, this is also 
the workspace used throughout this book.

Application Menu
Quick Access Toolbar

Ribbon Tab
Title Bar

Ribbon Panel
InfoCenter 

Ribbon

ViewCube

Navigation Bar

Drawing Area

Status Bar

Command Line

Layout Tabs

UCS Icon

Cursor

In-Canvas Viewport Control

File Tabs

F I G u R E   1 . 3 :   The Drafting & Annotation workspace

◀

AutoCAD and AutoCAD 
LT offer numerous dia-
log boxes with various 
combinations of buttons 
and text boxes. You’ll 
learn many of their 
functions as you prog-
ress through the book.
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3D Basics  Provides the core tools needed to get started with 3D modeling in 
AutoCAD (for AutoCAD users only—3D features are not included in AutoCAD LT).

3D Modeling  Provides the complete set of 3D modeling tools found in AutoCAD, 
including materials via the Materials Browser (for AutoCAD users only—3D features 
are not included in AutoCAD LT).

AutoCAD verticals such as AutoCAD Architecture and AutoCAD Civil 3D build 
on the standard workspaces outlined here and introduce discipline-specific 
tools in tandem with those found in the standard version of AutoCAD discussed 
in this book. Although any AutoCAD vertical can be used to complete the 
exercises in this book, I recommend using the AutoCAD vertical (for example, 
Architecture or Civil 3D) as an AutoCAD application shortcut to start AutoCAD 
and maintain parity with this book.

Exploring the Drafting & Annotation Workspace
As the default UI configuration for AutoCAD, the Drafting & Annotation work-
space shown previously in Figure 1.3 serves as the primary workspace through-
out this book. Having a good understanding of this workspace is imperative as 
you perform the exercises in the coming chapters. To ensure your success with 
those exercises, I’ll start by breaking down what you can expect when using the 
Drafting & Annotation workspace. From top to bottom and from left to right, 
the following elements make up this workspace: 

Application Menu  The Application menu contains the tools for opening, sav-
ing, and printing (plotting) your drawings. These options are similar to the File 
drop-down menu that has been deprecated since the Ribbon was introduced in 
AutoCAD. When the Application menu is open, the menus for these tools project 
from the upper-left corner of the AutoCAD window and cover the drawing area 
and any open dialog boxes.

Quick Access toolbar  Located to the right of the Application menu, the 
Quick Access toolbar provides immediate access to some of the most frequently 
used commands to complete tasks such as creating, opening, saving, and plot-
ting drawings. This toolbar is a customizable element of the UI that maintains 
a consistent appearance as you interact with your designs, and many AutoCAD 
users choose to build on its default task coverage.
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title Bar  The title bar is analogous to the title bar in any Windows program. 
It contains the program name (AutoCAD or AutoCAD LT) and the title of 
the current drawing with its path, provided a drawing other than the default 
Drawing#.dwg is open.

the Ribbon  Located immediately below the title bar, and spanning the entire 
width of the Application window, the Ribbon serves as the primary launchpad 
for nearly every command used to compose drawings in AutoCAD. Related tasks 
are found under the different tabs, which are further segmented into panels 
containing similar tools. The “Using the Ribbon” section later in this chapter 
explains this taxonomy in greater detail.

InfoCenter   To the far right of the title bar is the InfoCenter, containing the 
Search, Autodesk 360, Autodesk Exchange Apps, and Help buttons. You can 
enter a question in the field to the left of the Search button to access informa-
tion from a number of locations quickly, including the standard AutoCAD help 
system through the drop-down panel. The Autodesk 360 button allows you to 
sign in with your Autodesk ID and access a wealth of cloud-based services that 
integrate with AutoCAD. The Help button is a direct link to the AutoCAD help 
system (also accessible by pressing the F1 key).

File tabs  A tab for each open drawing is displayed at the top of the drawing 
area. These tabs provide a visual method to quickly switch between open draw-
ings or to create new drawings. Should you prefer additional screen real estate 
in lieu of this functionality, File Tabs can be turned off from the Interface panel 
of the View Ribbon tab.

Drawing Area and Cursor  The blank middle section of the screen is called the 
drawing area. This represents a virtually infinite plane. The crosshairs, or cursor 
as it’s known in AutoCAD, allows you to navigate the drawing area to precisely 
compose your designs. 

ViewCube ®  Found in the upper-right corner of the drawing area, the 
ViewCube is primarily used for navigating three-dimensional drawings. It pro-
vides access to 26 predefined view orientations in addition to the basic ability to 
pivot a drawing.

In-Canvas Viewport Control  Displayed in the upper-left corner of the draw-
ing area, the In-Canvas Viewport Controls provide a quick, and convenient way 
to change the current view, visual style, or viewport configuration. 
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navigation Bar  Beneath the ViewCube, you’ll find the Navigation bar, which pro-
vides access to several universal and product-specific navigation tools. These tools, 
while tailored to the specific commands found in AutoCAD, are designed to mimic 
navigation features found in other Autodesk products such as Autodesk® Revit®.

uCS Icon  The User Coordinate System (UCS) is discussed in Chapter 2, 
“Learning Basic Commands to Get Started.” The UCS icon, an essential part of 
this system, is found in the lower-left corner of the drawing area and indicates 
the positive coordinates for the x-, y-, and z-axes. 

Command Line  Serving as the primary method for interacting with AutoCAD, 
the command-line interface is located by default along the bottom edge of the 
drawing area. Similar to a paper-tape roll on a printing calculator, the command-
line interface displays a history of previous actions as well as a summary of the 
current actions for which the system seeks your input.

Layout tabs  Each AutoCAD drawing consists of a model tab and any number 
of layout tabs whose name can be customized. As a general rule, the model tab 
represents your design, and the layout tabs represent the piece of paper used 
to document a design. The Layout Tab interface allows you to quickly switch 
between these views of your design.

Status Bar  The status bar, streamlined in AutoCAD 2015, is now aligned to the 
bottom-right corner of the Application window. Tools located on the status bar 
are primarily focused on helping you draw and on managing the user interface. 
You’ll probably find yourself using the status bar quite frequently, so I’ll describe 
each of its tools in a moment.

n o t E  The illustrations in this book show the drawing area of the AutoCAD user 
interface with a white background. However, the default and preferred UI is a dark gray 
or black background, used to reduce eyestrain. The color choice in the book is simply for 
readability.

If your screen does not look like Figure 1.3, you need to make a few changes:

 1. Click the Workspace Switching tool from the status bar, and choose 
Drafting & Annotation, as shown in Figure 1.4. Alternatively, command-
line users can launch the WSCURRENT command by entering the 
following:

WSCURRENT↵
drafting & annotation↵
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F I G u R E   1 . 4 :   Selecting the Drafting & Annotation workspace

The drawing area in the center of the screen is an infinite canvas 
where you’ll create your designs; however, it might need to be adjusted.

 2. Using the View Controls tool on the in-canvas Viewport controls, 
select the Top option (see Figure 1.5).

F I G u R E   1 . 5 :   Selecting the Top option by using the in-canvas Viewport 
controls

This step ensures that your view is perpendicular to the drawing 
area. It should be as though you were looking straight down at a 
piece of paper on a drawing table.
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 3. From the in-canvas Viewport controls, click the Visual Style control 
to display a list of visual styles. Select the 2D Wireframe option from 
the list, as shown in Figure 1.6.

F I G u R E   1 . 6 :   Selecting the 2D Wireframe visual style by using in-canvas 
Viewport controls

Your screen should now look similar to Figure 1.3 shown previously.

Putting the user Interface to Work
Every pixel of the user interface serves a specific purpose, but what exactly is that 
purpose? So far you’ve learned about the general composition of the AutoCAD UI, 
gaining a basic understanding about each of its components. During that initial 
exploration, you likely noticed that many interface elements such as the Ribbon 
and status bar introduce another level of granularity with the tools they contain.

Although subsequent chapters provide detailed instruction for using these 
tools, it’s important that you possess a solid understanding of interface orga-
nization, function, and fundamental purpose. Some of these mission-critical 
UI elements include the Ribbon, the File Tab interface, the command line, the 
Application menu, and the status bar. By mastering the uses of these interface 
elements, you will possess the skills necessary to complete the design and docu-
mentation exercises throughout this book.
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Choosing Your own Drawing Area Background Color

By default, AutoCAD uses a dark gray color for the drawing area. Some users prefer 
to customize this and several other UI elements to a color palette of their liking. 
For example, some users prefer the contrast ratio of a light background color such 
as yellow or white over the contrast ratio offered by the darker background color. 
Follow these steps to change the drawing area’s background color:

 1.  Open the Options dialog box by typing OP↵ at the command line, or choose 
Application menu ➢ Options.

 2.  Switch to the Display tab and click the Colors button in the Window 
Elements group.

This opens the Drawing Window Colors dialog box, where you’ll customize 
the colors of the user interface to your liking.

 3.  In the Drawing Window Colors dialog box, select 2D Model Space from the 
Context list and select Uniform Background from the Interface Element 
list, as shown in the following graphic.
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using the Ribbon
Perhaps one of the most prominent elements of the AutoCAD interface is the 
Ribbon (see Figure 1.7). By default, it extends across the top of the AutoCAD 
window, but it can be repositioned. Depending on the size of your AutoCAD win-
dow (or current screen resolution), the Ribbon may look a little different on your 
computer. That’s because the Ribbon self-adjusts according to the size of the 
AutoCAD window. To see the Ribbon in its fully expanded state, you must have 
a screen resolution wider than 1350 pixels. When the width is too narrow to 
display each panel fully, AutoCAD begins to collapse the panels, replacing each 
with a single button bearing the panel name.

Ribbon Tabs

Large Tool Icon (Button) Small Tool Icon (Button)
Panel

Collapsed Ribbon Panel

F I G u R E   1 . 7 :   The Ribbon fully displaying all panels (top) and with partially and completely 
collapsed panels (bottom)

The Ribbon is divided into three parts—tabs, panels, and tools:

Ribbon tabs  Ribbon tabs offer the highest level of organization; they group 
Ribbon panels by task. For instance, commands related to plotting (printing) 
are found on the Output tab, whereas commands related to entering text can be 
found on the Annotate tab.
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Ribbon Panels  Similar tools are grouped together into a series of Ribbon 
panels. For instance, the Move, Erase, and Rotate tools modify objects. 
Consequently, each of these tools is found on the Modify panel.

Ribbon tools  The individual icons and various drop-down lists found on the 
Ribbon are known as Ribbon tools. Clicking any of these tools launches the 
command associated with it.

When more tools are available than will fit on a panel, an arrow is displayed 
on the panel’s title bar. Clicking the title bar expands the panel and exposes the 
additional tools. Follow these steps to learn how the Ribbon tools work and how 
they display information:

 1. Click the Home tab on the Ribbon to expose the Home tab’s panels 
(see the top of Figure 1.7 shown earlier).

 2. Move your cursor over the Modify panel, and pause the cursor over 
the Move tool button.

This exposes the button’s tooltip, as shown in Figure 1.8. In addition 
to displaying the name of the tool, the tooltip provides a brief descrip-
tion of its function, the command-line equivalent of clicking the tool, 
and instructions to press the F1 key to open the AutoCAD Help file to 
the current tool’s Help page.

F I G u R E   1 . 8 :   The tooltip for the Move command
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 3. After a few seconds of hovering over the Move tool button, the tooltip 
is replaced with a cue card, as shown in Figure 1.9. Cue cards show 
the step-by-step implementation of the tool.

F I G u R E   1 . 9 :   The cue card for the Move tool

 4. Click the Modify panel’s title bar to expand the panel and expose all of 
the Modify tools (see Figure 1.10).

F I G u R E   1 . 1 0 :   The expanded Modify panel

 5. Often you may find yourself returning to the same tool on an 
expanded Ribbon panel. When that happens, you can pin the panel 
open by clicking the pushpin-shaped button in the bottom-left cor-
ner. When the panel is pinned open, it remains open even when the 
cursor is not hovering over it.
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 6. Click the button again to unpin the panel, and then move the cursor 
off the panel to collapse it. Regardless of whether a panel is pinned or 
unpinned, it will automatically collapse if you change Ribbon tabs.

 7. Click the Modify panel title and drag the cursor toward the drawing area.
The Modify panel becomes semitransparent, allowing you to place 

it inside the drawing area to become a floating panel (see Figure 1.11). 
Floating panels display whether their host tab is current or not. This 
feature can be helpful when quick access to tools on separate Ribbon 
tabs is needed simultaneously.

F I G u R E   1 . 1 1 :   Drag the Modify panel from the Ribbon (top) to display it a 
floating panel (bottom).

 8. To return the Modify panel to the Ribbon, hover over its title and 
then click the Return Panels To Ribbon button shown in Figure 1.12.

Return Panels To
Ribbon Button

F I G u R E   1 . 1 2 :   Using the Return Panels To Ribbon button to restore a floating 
panel to its host Ribbon tab

using File tabs to Manage Drawings
As in many programs, you can have multiple drawings open in the same session 
of AutoCAD. When multiple drawings are open, each drawing window is stacked 
behind the drawings in front of it. The File Tab feature helps streamline the 
management of these drawings by adding a tab for each drawing just below the 
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Ribbon. This interface not only provides a fast and visual way to switch between 
open drawings, but also offers several other file management functions for 
opening, saving, and even creating new drawings. To use File Tabs:

 1. Start or open two or more AutoCAD files. Right-clicking any draw-
ing tab or the plus icon at the end of the interface, as shown in 
Figure 1.13, will allow you to open additional files.

F I G u R E   1 . 1 3 :   Using the File Tab interface to open additional drawings

 2. Click any tab to bring the corresponding drawing to the front of the 
AutoCAD window.

 3. Pausing your cursor over any tab will display the thumbnail preview 
of the associated drawing and its contents (see Figure 1.14). Click the 
thumbnail to navigate directly to that portion of the drawing file.

F I G u R E   1 . 1 4 :   Using the File Tab interface to display a thumbnail preview of a 
drawing’s content 

 4. You can toggle the display of the File Tab interface by clicking the 
File Tabs icon on the User Interface panel of the View Ribbon tab. 
You’ll be using the File Tab interface throughout this book, so I rec-
ommend keeping it on for the time being.
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Working in the Command-Line Interface
The command-line interface, which is docked by default along the bottom 
edge of the drawing area, serves as your primary method of interacting with 
AutoCAD. You use this interface to tell the software what you would like it to do 
for you, and the software uses this interface to communicate the information 
it needs from you. If you’re just getting started with AutoCAD, this interaction 
may feel a little abstract at first. A golden rule of using AutoCAD is that when 
you’re in doubt about what you need to do, or what the program is expecting 
you to do, look at the command line.

Depending on your individual preference, you may choose to display this 
interface in either docked or undocked mode, as shown in Figure 1.15. The 
default undocked mode helps maximize the available drawing area and enables 
you to position the command line anywhere onscreen. By contrast, you 
may choose to dock the command line to the top or bottom of the AutoCAD 
interface. Doing this will lock the command-line interface to the AutoCAD 
Application window, shrinking the available drawing area. 

F I G u R E   1 . 1 5 :   The command-line interface in its default undocked mode (top), and docked 
to the bottom of the Application window (bottom)

Similar to a paper-tape roll on a printing calculator, the command-line interface, 
or command prompt as it’s known within AutoCAD, displays a history of previous 
actions as well as a summary of the current calculation. Just as you can choose 
when to tear the paper tape on a printing calculator, you can choose the number 
of previous command-line entries to display. In its default undocked state, the 
command-line interface displays three lines of prompt history, and it can display as 
many as 50 lines at any one time. To customize the range of prompt history:

 1. Click the wrench icon to the left of the command-line interface.

 2. Choose Lines Of Prompt History from the contextual menu, as shown 
in Figure 1.16. The command line reads CLIPROMPTLINES Enter new 
value for CLIPROMPTLINES <3>:, as shown in Figure 1.17.
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F I G u R E   1 . 1 6 :   Choosing Lines Of Prompt History from the undocked 
command-line interface

F I G u R E   1 . 1 7 :   Specifying the range of prompt history from the command-line interface

 3. Enter the desired number of prompt history lines to display, up to 50, 
and press ↵.

When in Doubt, Keep Calm and Look at the 
Command Line

Interacting with AutoCAD is much like chatting with a friend who has a topical 
response for every statement you make. Every time you ask or say something in 
AutoCAD, it will respond via the command-line interface.

The command line will play a critical role in nearly every task you perform 
in AutoCAD. One especially challenging aspect of AutoCAD is learning its often 
abstract and unique vocabulary. The synonym suggestion feature makes this 
challenge a little more manageable by proposing an appropriate AutoCAD term 
from a more common term. For example, if I asked you to insert a symbol for a 
wall receptacle, your intuition might tell you to try the SYMBOL command (see 
Figure 1.18). Although there is no such command, AutoCAD 2015 automatically 
suggests the correct command: INSERT. 
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F I G u R E   1 . 1 8 :   Entering SYMBOL at the command line elicits the correct INSERT 
command.

Should you choose to type commands at the command line, there’s a good 
chance you’ll discover many new commands, thanks to the autocomplete fea-
ture. While it’s a good way to learn the names of new commands, that won’t 
help much if you have no idea what they do or how to use them. Two icons to 
the right of the command name guide you to a wealth of information about it. 
To use these icons:

 1. Enter LINE at the command line and notice the list of possible com-
mands the autocomplete feature displays, as shown in Figure 1.19. 
As you might expect, in addition to the LINE command, several other 
command names containing line are displayed.

F I G u R E   1 . 1 9 :   List of autocomplete options for the LINE command

 2. Clicking the question mark icon will search the AutoCAD help docu-
mentation, whereas clicking the globe icon will search the Internet. 
Click the globe icon for the LINETYPE command, and the Google 
search page displays, as shown in Figure 1.20.
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F I G u R E   1 . 2 0 :   Google search performed by clicking the globe autocomplete 
icon for the LINETYPE command

n o t E  You can start AutoCAD commands in a number of ways: from the Ribbon, 
the Application menu, the command line, and the menus that appear when you right-
click. When you get used to drawing with AutoCAD, you’ll learn some shortcuts to start 
commands, and you’ll find the method that best suits the way you work.

understanding the Status Bar
The status bar is located below the command line (see Figure 1.21), and docked 
in the lower-right corner of the Application window.

F I G u R E   1 . 2 1 :   The default status bar configuration

By default, the status bar includes 18 buttons, but it can be customized to include 
as many as 21. These buttons perform a variety of functions, which include activat-
ing various drawing modes, navigating and controlling objects in the drawing area, 
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and managing the user interface. You’ll have the chance to explore each of the draw-
ing modes and aids throughout this book. As a preview, the following list briefly 
describes each of the tools shown by default:

n o t E  The tooltip displayed while hovering over each status bar tool usually 
varies from the tool’s actual name. The following list indicates the tooltip you’ll see, fol-
lowed by the name of each tool in parentheses.

Display Drawing Grid (Grid Display)  Mimics a piece of graph paper by dis-
playing nonplotting horizontal and vertical lines in the drawing’s background.

Snap Mode (Snap Mode)  Restricts movement of the cursor inside the drawing 
area to specified intervals.

Restrict Cursor orthogonally (ortho Mode)  Restricts movement of the cursor 
to 90º intervals: 0 ,̊ 90 ,̊ 180 ,̊ and 270˚ by default.

Isometric Drawing (Isometric Drafting)  Aligns the cursor to sketch 3D 
representations of objects on a 2D plane using one of three isometric planes: 
top, left, or right.

Show Snapping Reference Lines (object Snap tracking)  An advanced draft-
ing tool that allows you to draw objects with specific geometric relationships 
to other objects within your drawing. This tool is discussed in Chapter 5, 
“Developing Drawing Strategies: Part 2.”

Snap Cursor to 2D Reference Points (object Snap)  Helps you draw objects 
based on geometric reference points such as endpoint, midpoint, intersection, 
and so on. Mastering the use of object snaps is critical in the creation of accu-
rate drawings.

Show Annotation objects (Annotation Visibility)  Controls the display 
of annotative objects, by providing an advanced method for managing text, 
dimensions, and other objects used to tell the story of your designs. This tool 
is discussed in Chapter 8, “Controlling Text in a Drawing.”

Add Scales to Annotative objects when the Annotation Scale Changes 
(AutoScale)  Aids in quickly configuring annotative objects such as text and 
dimensions to display at multiple scales (discussed in Chapter 8).

Annotation Scale of the Current View (Annotation Scale)  Controls the dis-
played size of scale-dependent objects such as annotative text and dimensions, 
and linetypes in a drawing.
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Workspace Switching (Workspace Switching)  Manages the composition of 
the user interface by providing access to workspace management and custom-
ization tools.

Annotation Monitor (Annotation Monitor)  When enabled, the associativity 
of annotations is monitored, and a system tray alert is displayed when annota-
tions become disassociated.

Hardware Acceleration (Graphics Performance)  Helps improve 3D graphics 
performance for compatible graphics cards supporting OpenGL.

Autodesk trustedDWG (Autodesk trustedDWG)  This icon will display only 
after opening a DWG™ file, and indicates whether a drawing was created with 
Autodesk software (trusted) or a third-party application (untrusted).

Isolate objects (Isolate objects)  Temporarily makes objects within a drawing 
invisible, isolating only the items you select. As a temporary visibility override, 
previously hidden objects are always displayed when a drawing is opened.

Clean Screen (Clean Screen)  Hides most interface elements such as the 
Ribbon, and maximizes the drawing area to focus on the current drawing.

Customization (Customization)  Opens a menu used to manage which status 
bar tools are visible. The menu reference for each tool is listed in parentheses in 
this list.

using the Application Menu
The Application menu contains the tools for opening, saving, and printing 
(plotting) your drawings, similar to the options found under the File drop-
down menu in AutoCAD and many other programs. When the Application 
menu is open, the menus for these tools project from the upper-left corner of 
the AutoCAD window and cover the drawing area and any open dialog boxes.

Perform the following steps to begin using the Application menu: 

 1. Click the Application Menu button to open the Application menu.

 2. The left pane of the Application menu displays the various com-
mands. Clicking or hovering over a command displays its options in 
the right pane, as shown in Figure 1.22.

▶

Be careful not to 
double-click the 
Application Menu  
button, because  
doing so will make 
AutoCAD close.
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F I G u R E   1 . 2 2 :   The Application menu showing the Print options

A bar with an up- or down-arrow at the top or bottom of the right 
pane indicates that additional tools are available. You can display 
these tools by placing your cursor over either bar.

The Application menu offers a quick method for opening drawings. You can 
even see a thumbnail preview of the drawings and arrange drawings that you 
frequently edit so that they are easily accessible. Here’s how:

 1. To open a new AutoCAD file from the Application menu, choose 
New ➢ Drawing, as shown in Figure 1.23.

F I G u R E   1 . 2 3 :   Opening a new drawing from the Application menu
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This opens the Select Template dialog box, where you select a tem-
plate on which to base the new drawing. Opening a file with a template 
is covered in Chapter 2. Close the Select Template dialog box to return 
to the Application Window.

 2. To open an existing file from the Application menu, choose Open ➢ 
Drawing, as shown in Figure 1.24.

F I G u R E   1 . 2 4 :   Opening an existing drawing from the Application menu

This opens the Select File dialog box, where you can navigate to 
the desired drawing file and select it. Close the Select File dialog box 
to return to the Application Window.

 3. To open a file that you’ve worked on recently, click the Recent 
Documents button at the top of the Application menu’s left pane. 
This displays the most recent files opened in AutoCAD in the right 
pane, as shown in Figure 1.25.

F I G u R E   1 . 2 5 :   Displaying the recent documents in the Application menu
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 4. Hover over a filename in the right pane to display a thumbnail pre-
view of the drawing and additional information, including the draw-
ing location and AutoCAD drawing format (see Figure 1.26).

F I G u R E   1 . 2 6 :   Displaying a thumbnail of the selected file

opening new Files

You can open new or existing files by using the New or Open button in the Quick 
Access toolbar. Existing drawings can also be opened by dragging them from a 
Windows Explorer window to the AutoCAD title bar.
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n o t E  AutoCAD 2015 uses the AutoCAD 2013 drawing (DWG) file format. This means 
that the files created in AutoCAD 2015 are compatible only with AutoCAD 2013, AutoCAD 
2014, and AutoCAD 2015. You can share drawings with releases earlier than AutoCAD 2013 by 
performing a simple conversion. To convert a 2013 format drawing to a prior version, open 
the Application menu and then click Save As ➢ Drawing and choose the version you want 
from the Files Of Type drop-down list at the bottom of the Save Drawing As dialog box.

www.MouradEngineering.com



	 U s i n g 	 t h e 	 K e y b o a r d  2 7

Getting the Most out of the Recent Documents List

The Application menu offers many time-saving tips. Here are two of the best ways 
to use the Recent Documents list:

Access Frequently used Drawings  For drawings you access on a regular 
basis and would like to remain on the Recent Documents list, click the pushpin that 
displays next to its name. This will “pin” that drawing to the Recent Documents 
list until you unpin it.

Maximize the number of Recent Documents  By default, the Recent 
Documents list displays only the last nine drawings you’ve opened. This number 
can be increased to 50 by using the OPTIONS command, selecting the Open And 
Save tab, and changing the Number Of Recently Used Files setting under the 
Application Menu group.

The next chapter will familiarize you with a few basic commands that will 
enable you to draw a small diagram. If you want to take a break and close 
AutoCAD, choose Application menu ➢ Exit AutoCAD (lower-right corner), and 
choose not to save the drawing.

using the Keyboard
The keyboard is an important tool for entering data and commands. If you’re a 
good typist, you can gain speed in working with AutoCAD by learning how to enter 
commands from the keyboard. AutoCAD provides alias commands—single keys 
or key combinations that start any of several frequently used commands. A good 
example of a command alias that ships with AutoCAD is the LINE command. You 
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could type LINE at the command line to launch the command, but typing the one-
character alias L is much quicker and easier. You can add more aliases or change 
the existing ones as you become more familiar with the program.

In addition to the alias commands, you can use several of the F keys (function 
keys) on the top row of the keyboard as two-way or three-way toggles to turn 
AutoCAD functions on and off. Although buttons on the screen duplicate these 
functions (Snap, Grid, and so on), it’s sometimes faster to use the F keys.

While working in AutoCAD, you’ll need to enter a lot of data (such as dimen-
sions and construction notes), answer questions with Yes or No, and use the 
arrow keys. You’ll use the keyboard constantly. It might help to get into the 
habit of keeping your left hand on the keyboard and your right hand on the 
mouse if you’re right-handed, or the other way around if you’re left-handed.

using the Mouse
Your mouse most likely has two buttons and a scroll wheel. So far in this chap-
ter, you have used the left mouse button to choose menus, commands, and 
options, and you’ve held it down to drag the Ribbon. The left mouse button is 
the one you’ll be using most often, but you’ll also use the right mouse button.

While drawing, you’ll use the right mouse button for the following three 
operations:

▶▶ To display a menu containing options relevant to the particular step 
you’re in at the moment

▶▶ To use in combination with the Shift or Ctrl key to display a menu 
containing special drawing aids called object snaps

▶▶ To display a menu of toolbars when the pointer is on any icon of a 
toolbar that is currently open

The middle button with a scroll wheel serves a dual function:

▶▶ Pressing and holding the middle button enables you to pan through-
out your drawing until you release the middle button.

▶▶ You can zoom in and out within your drawing. When scrolling 
toward the screen, you zoom into your drawing. Conversely, when 
scrolling away from the screen, you zoom out from your drawing.
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AutoCAD makes extensive use of toolbars and the right-click menu feature. 
This makes your mouse an important input tool. The keyboard is necessary for 
inputting numeric data and text, and it has hot keys and aliases that can speed 
up your work; however, the mouse is the primary tool for selecting options and 
controlling toolbars.

If You Would Like More Practice…
At the start of this chapter, you learned how workspaces can dramatically change 
the overall appearance of AutoCAD. This was illustrated in the “Exploring the 
User Interface” section, as you switched between workspaces that ship with the 
software. Although many find the default workspaces more than adequate, others 
prefer custom-tailoring the UI to the way they work.

From customizing the Ribbon to loading toolbars and beyond, AutoCAD 
provides a large collection of tools to personalize its layout. Regardless of the 
extent of your customization efforts, that configuration will be lost unless it’s 
first saved as a workspace.

Follow these steps to ensure your customizations remain the next time you 
start AutoCAD:

 1. Click the Workspace Switching button on the status bar, and choose 
Save Current As from the menu, as shown on the top in Figure 1.27. 
This opens the Save Workspace dialog box, shown on the bottom in 
Figure 1.27.

F I G u R E   1 . 2 7 :   The Save Workspace dialog box
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 2. Type AutoCAD NER as the name for the workspace and click Save. 
The dialog box closes, and you are returned to your workspace.

Until you change it or select a different workspace, the AutoCAD 
NER workspace setup will remain as it is now.

When you make changes to a workspace by adding a toolbar or changing the 
background color of the drawing area, you can easily update the current work-
space to accommodate those changes. Follow steps 1 and 2, naming the work-
space again with the same name. You’ll get a warning window telling you that 
a workspace by that name already exists and asking whether you want the new 
arrangement to replace the old one. Click Yes.

Are You Experienced?
now you can…

✔✔ recognize the elements of the AutoCAD Application window

✔✔ understand	how	the	command-line	interface	works	and	why	it	is	
important

✔✔ start	commands	from	the	Ribbon

✔✔ start commands from the command line

✔✔ switch	between	open	drawings

✔✔ use the Application menu

✔✔ save	a	workspace	of	your	screen	setup	in	AutoCAD
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CHAPtER 2

Learning Basic 
Commands to Get 
Started
Now that you’ve taken a quick tour of the Autodesk® AutoCAD® and 
Autodesk® AutoCAD LT® screens, you’re ready to begin drawing! This 
chapter introduces you to some basic drawing commands by guiding you 
through the process of drawing a simple shape.

As you create this first drawing, you’ll learn to use several essential AutoCAD 
commands that will serve as a foundation for the rest of this book. First you’ll 
become familiar with the LINE command and how to draw lines of a specific 
length. Then we’ll go over the strategy for completing the drawing.

In this chapter, you will learn to

▶▶ Understand coordinate systems

▶▶ Draw	your	first	object

▶▶ Erase,	offset,	fillet,	extend,	and	trim	objects	in	a	drawing

using the Line tool
The LINE command, essential to all AutoCAD drawings,  is the first com-
mand you’ll explore as you construct the shape shown in Figure 2.1. 
Whenever you start a brand-new drawing in AutoCAD, it’s always best to take 
a step back and consider the object(s) you would like to construct. In this 
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case, the shape shown in Figure 2.1 most closely resembles a square. To apply 
this basic strategy, you’ll begin by defining each of the four sides of the square 
by using the LINE command, and then you will build on this basic shape with 
several additional commands introduced later in this chapter.

F I G u R E   2 . 1 :   The shape you’ll draw

The LINE command draws a straight-line segment between locations on exist-
ing objects, geometric features, or two points that you can choose anywhere 
within the drawing area. You can designate these points by left-clicking them on 
the screen, by entering the x- and y-coordinates for each point, or by entering 
distances and angles from an existing point. After you draw the first segment of 
a line, you can end the command or draw another line segment beginning from 
the end of the previous one. You can continue to draw adjoining line segments 
for as long as you like. Let’s see how this works.

To be sure that you start with your drawing area configured the way it’s set 
up for this book, you’ll create a new drawing. The Start Drawing tool found on 
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the Create page of the New Tab provides a convenient way to create and manage 
open drawings. Follow these steps to prepare your first AutoCAD drawing:

 1. Click the New Tab icon at the right end of the File Tab interface. This 
opens the Create page of the New Tab interface.

 2. Under the Start Drawing tool, click the disclosure triangle for 
Templates, and then select the acad.dwt file (acadlt.dwt for 
AutoCAD LT users) as shown in Figure 2.2. 

F I G u R E   2 . 2 :   Choosing the acad.dwt template from the Get Started 
panel of the New Tab

n o t E  DWT f iles are drawing templates with several parameters, such as 
dimension styles, layers, plotting settings, and more, that are already set.

 3. With the correct drawing template selected, click the Start Drawing 
tool shown in Figure 2.2 to open a new blank drawing.

 4. Right-click the File Tab for the drawing you just created and select 
Close All Except This Tab from the menu, as shown in Figure 2.3.
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The File Tab interface includes a tab for each drawing you have 
open. Although File Tabs are most commonly used to switch between 
open drawings, you can also use the interface to manage which 
drawings you have open.

F I G u R E   2 . 3 :   Using the File Tab interface to manage open drawings

It is also possible to close drawings individually by clicking the X on the right 
side of each tab. 

After creating a blank drawing file with acad.dwt, you are ready to begin your 
first drawing. To get started creating designs in AutoCAD, follow these steps to 
begin using the LINE command:

 1. Each of the drawing aids found on the status bar that runs along 
the bottom-right edge of the Application window has a specific func-
tion assigned to it. To ensure that the task at hand aligns with the 
active aids, it’s always a good practice to check which drawing aids 
are turned on before you begin drawing anything in AutoCAD. You’ll 
notice some of the tools, such as Object Snap, are turned on, while 
others remain off.

Make sure that Polar Tracking, Object Snap Tracking, and Object 
Snap are turned on and that all the others are turned off. You can 
identify the icons by pausing over each to display its tooltip. Your 
toolbar should look similar to Figure 2.4.
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F I G u R E   2 . 4 :   The toolbar as it has been set up

 2. From the Ribbon, choose the Home tab ➢ Draw panel, and then click 
the Line tool. Look at both the bottom of the command-line interface 
and your cursor. Because Dynamic Input is turned on, prompts such 
as this one display both at the command line and next to the cursor 
(see Figure 2.5).

t I P  You can also start the LINE command by typing LINE or L and pressing the 
Enter key, the spacebar, or the right mouse button.

The prompt now tells you that the LINE command is started 
(Command: _line) and that AutoCAD is waiting for you to designate 
the first point of the line (Specify first point:).

F I G u R E   2 . 5 :   Both the command prompt and the cursor change to reflect the 
current command.

 3. Move the cursor onto the drawing area, and note that the small box 
at the intersection of the crosshairs is not there.

When the cursor is used to select objects (the default condition), 
a small square displays atop the cursor. This small square cursor is 
known as the pickbox and indicates when AutoCAD expects you to 
select an existing object in lieu of a point. When the cursor is used to 
designate a point in commands such as the current LINE command, 
the pickbox is not visible. Using the left mouse button, click a ran-
dom point in the drawing area to start a line.
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 4. Move the cursor away from the point you clicked, and notice how a 
line segment appears that stretches like a rubber band from the point 
you just picked to the cursor. The line changes length and direction 
as you move the cursor, and these values are shown as input boxes in 
the drawing area.

 5. Look at the command line again, and notice that the prompt has 
changed (see Figure 2.6).

F I G u R E   2 . 6 :   The command prompt changes for the next point, and the line’s 
length and direction are shown in the drawing area.

The prompt is now telling you that AutoCAD is waiting for you to 
designate the next point (Specify next point or [Undo]:).

 6. Continue picking points and adding lines as you move the cursor 
around the screen (see Figure 2.7).

F I G u R E   2 . 7 :   Drawing several line segments

After you draw the second segment, the Command window repeats 
the Specify next point or [Close/Undo]: prompt each time you 
pick another point. The Dynamic Input fields and command prompt 
appear near the cursor, showing the angle and distance from the last 
point selected.
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 7. When you’ve drawn six or seven line segments, press ↵ to end the LINE 
command. The cursor separates from the last-drawn line segment.

The Type a command: prompt has returned to the bottom line. 
This tells you that no command is currently running.

t I P  Pressing ↵  exits the LINE  command and several others. Another option 
to exit the LINE command is to right-click and choose Enter from the context menu. 
This requires an extra step, but it still may be faster, because your eyes never leave the 
screen. When you’re not entering data, the spacebar also acts like the ↵ key and executes 
a command.

In this exercise, you used the left mouse button to click the Line tool on the 
Ribbon and also to pick several points in the drawing area to make line segments. 
You then pressed ↵ on the keyboard to end the LINE command.

using Coordinates
A coordinate system consists of numbered scales that identify an initial, or base, 
point and the direction for measuring subsequent points on a graph. As illustrated 
in Figure 2.8, each pair of axes (xy, xz, yz) forms a flat plane. Most of your time 
working with AutoCAD will be spent drawing in the xy-plane.

n o t E  The Cartesian coordinate system—named after the philosopher René 
Descartes, who defined the xy-coordinate system in the 1600s—consists of three num-
bered scales, called the x-axis, y-axis, and z-axis, that are perpendicular to each other 
and extend infinitely in each direction.

Origin

Z-Axis
+

–

–

–

+
Y-Axis

+
X-Axis

XZ-Plane

XY-Plane

YZ-Plane

F I G u R E   2 . 8 :   The x-, y-, and z-axes and the related xy-, xz-, and yz-planes
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The point where the scales intersect is called the origin. For each axis, all 
values on one side of the origin are positive, all values on the other side are 
negative, and values that fall in line with the origin have a value of 0 (zero). The 
divisions along the scales may be any size, but each division must be equal.

The axes divide the coordinate system into four regions called quadrants. 
Quadrant I is the region above the x-axis and to the right of the y-axis. Quadrant II 
is the region above the x-axis and to the left of the y-axis. Quadrant III is the region 
below the x-axis and to the left of the y-axis. Quadrant IV is the region below the 
x-axis and to the right of the y-axis. Most of your work in AutoCAD will be done in 
Quadrant I, and this is the area shown when you first open a drawing.

You may specify any point on this graph by giving its coordinates relative to 
the origin, indicated as a combination of the X value and the Y value delineated 
with a comma. For example, a coordinate of 5,7 means a point on the coordi-
nate system that is 5 units in the positive X direction and 7 units in the positive 
Y direction. Figure 2.9 shows a typical Cartesian coordinate system and the 
default region used as the drawing area in a new AutoCAD file.

+y

-y

+x-x
0,0

Quadrant II Quadrant I

Quadrant III Quadrant IV

Area shown
on your
screen

F I G u R E   2 . 9 :   The x- and y-coordinates of the drawing area.

n o t E  In the exercises that follow, the Enter symbol (↵) is used. When I ask you 
to type or enter something, it means to type the data that follows the word type or enter 
and then to press the Enter key (↵). For example, rather than saying “type L, and press 
the Enter key,” I’ll say “type L↵.” Finally, although I’ll capitalize the names of AutoCAD 
commands, be aware that commands are not case sensitive and may be entered however 

you want.
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You can also start the ERASE command by typing E↵. In this next exercise, 
you’ll use the LINE command again, but instead of picking points in the drawing 
area with the mouse as you did before, this time you’ll enter the x- and y-coordi-
nates for each point from the keyboard. To do this, follow these steps:

 1. Click the Erase icon in the Home tab ➢ Modify Ribbon panel.

 2. Type ALL↵. The objects in the drawing become dashed to indicate 
that they are selected.

 3. Press ↵ to clear the screen.

 4. Click the Grid Display icon on the status bar to display the grid if it is 
not already turned on (blue glow). The gridlines that display provide a 
graphical representation of the Cartesian coordinate system used by 
AutoCAD.

Now begin drawing lines again by following these steps:

 5. Start the LINE command by clicking the Line icon in the Home tab ➢ 
Draw panel on the Ribbon.

 6. Type #7,2↵ to start the first line segment at a location 7 units above 
and 2 units to the right of the drawing’s origin point.

 7. Type #11,3↵ to determine the endpoint of the line. Then enter the 
following:

#9,6↵

#7,2↵

#1,4↵

#3,7↵

#9,6↵

 8. Press ↵ again to end the command.
Figure 2.10 shows the completed drawing with coordinates and 

direction arrows added for clarity.
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0,0

3,7

1,4

9,6

11,3

7,2

F I G u R E   2 . 1 0 :   Completed drawing showing coordinates and direction of lines

The lines are similar to those you drew previously, but this time you know 
where each point is located relative to the 0,0 point. In the drawing area, every 
point has an absolute x- and y-coordinate. In steps 5 through 7, you entered the 
x- and y-coordinates for each point. For a new drawing such as this one, the ori-
gin (0,0 coordinate) is in the lower-left corner of the drawing area, and all points 
in the drawing area have positive x- and y-coordinates.

Let’s explore how the cursor is related to the coordinates in the drawing:

 1. Click the Zoom Extents icon located on the Navigation bar (the semi-
transparent vertical bar under the ViewCube®), or type ZOOM↵E↵ to 
adjust your view to show the extents of the drawing area.

 2. Add the Coordinates readout to the status bar by clicking the 
Customize button on the status bar, and then selecting the 
Coordinates option from the resulting menu shown in Figure 2.11.

F I G u R E   2 . 1 1 :   Adding the Coordinates readout to the status bar
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 3. Move the cursor around, and notice the left end of the status bar at 
the bottom of the screen. This is the coordinate readout, and it dis-
plays the coordinates of the cursor’s position, as shown in Figure 2.12.

F I G u R E   2 . 1 2 :   The x- and y-coordinates of the cursor are shown at the bottom 
of the AutoCAD window.

 4. Move the cursor as close to the lower-left corner of the drawing area 
as you can without it changing into an arrow. The coordinate readout 
should be close to 0.0000, 0.0000, 0.0000.

 5. Move the cursor to the top-left corner of the drawing area. The read-
out changes to something close to 0.0000, 7.0000, 0.0000, indicat-
ing that the top of the screen is 7 units from the bottom.

 6. Move the cursor one more time to the upper-right corner of the 
drawing area. The readout still has a y-coordinate of approximately 
7.0000. The x-coordinate now has a value around 10.5.

The drawing area of a new drawing is preset with the lower-left corner of the 
drawing at the coordinates 0,0.

n o t E  For the moment, it doesn’t matter what measure of distance these units 
represent. I address that topic in Chapter 3, “Setting Up a Drawing.” Don’t worry about 
the four decimal places in the coordinate readout; the number of places is controlled by a 
setting you’ll learn about soon.

using Relative Coordinates
Once you understand the coordinate system used by AutoCAD, you can draw 
lines to any length and in any direction. Look at the shape shown previously 
in Figure 2.1. Because you know the dimensions, you can calculate (by add-
ing and subtracting) the absolute coordinates for each vertex—the connecting 
point between two line segments—and then use the LINE command to draw 
the shape by entering these coordinates from the keyboard. However, AutoCAD 
offers you several tools for drawing this box much more easily. Two of these 
tools are the relative Cartesian and relative polar coordinate systems. 
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When you’re drawing lines, these coordinate systems use a set of new points 
based on the last point designated rather than on the 0,0 point of the drawing 
area. They’re called relative systems because the coordinates used are relative 
to the last point specified. If the first point of a line is located at the coordinate 
4,6 and you want the line to extend 8 units to the right, the coordinate that is 
relative to the first point is 8,0 (8 units in the positive X direction and 0 units in 
the positive Y direction), whereas the actual—or absolute—coordinate of the 
second point is 12,6.

The relative Cartesian coordinate system uses relative x- and y-coordinates in 
the manner shown, and the relative polar coordinate system relies on a distance 
and an angle relative to the last point specified. You’ll probably favor one system 
over the other, but you need to know both systems because you’ll sometimes 
find that, given the information you have at hand, one will work better than 
the other. A limitation of this nature is illustrated in Chapter 4, “Developing 
Drawing Strategies: Part 1.”

To designate the usage of relative coordinates, you’ll need to prefix each 
coordinate you enter with an at symbol (@). In the previous example, you would 
enter the relative Cartesian coordinates as @8,0. The @ lets AutoCAD know that 
the numbers following it represent coordinates that are relative to the last point 
designated. 

Working with Relative Cartesian Coordinates

The Cartesian system of coordinates uses a horizontal (x) component and a 
vertical (y) component to locate a point relative to the 0,0 point. The relative 
Cartesian system uses the same components to locate the point relative to the 
last point picked, so it’s a way of telling AutoCAD how far left or right, and up 
or down, to extend a line or to move an object from the last point picked (see 
Figure 2.13). If the direction is to the left, the x-coordinate will be negative. 
Similarly, if the direction is down, the y-coordinate will be negative. Use this 
system when you know the horizontal and vertical distances from point 1 to 
point 2. To enter data using this system, use this form: @x,y.
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+y

-y

+x-x
P1 P1

P2

Last Point Picked
Last Point Picked

Next Point

Y Distance

X Distance

F I G u R E   2 . 1 3 :   The relative Cartesian coordinate system

n o t E  Coordinates are interpreted as relative when command prompts appear 
next to the cursor, as they do by default, making the @ symbol is optional.

Working with Relative Polar Coordinates

The relative polar coordinate system requires a known distance and direction 
from one point to the next. Calculating the distance is straightforward: it’s 
always positive and represents the distance away from the first point that the 
second point will be placed. The direction requires a convention for determining 
an angle. AutoCAD defines right (toward 3 o’clock) as the default direction of 
the 0 angle. All other directions are determined from a counterclockwise rota-
tion (see Figure 2.14). On your screen, up is 90, left is 180, down is 270, and a 
full circle is 360. To let AutoCAD know that you’re entering an angle and not a 
relative y-coordinate, use the less-than symbol (<) before the angle and after the 
distance. Therefore, in the previous example, to designate a point 8 units to the 
right of the first point, you would enter @8<0.
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90°

270°

0°180°
P1 P1

P2

Last Point
Picked

Last Point Picked

Next Point

Dista
nce

Angle

F I G u R E   2 . 1 4 :   The relative polar coordinate system

n o t E  Use the relative polar coordinate system to draw a line from the f irst 
point when you know the distance and direction to its next point. Enter data using this 
form: @distance<angle.

using the Direct Distance Method
You can also draw lines by placing the cursor at any angle relative to the last 
point and entering a distance value at the command prompt. The line is drawn 
from the last point toward or through the cursor location at the length speci-
fied. The Direct Distance method is often used when either Ortho mode or Polar 
Tracking is turned on.

n o t E  When in a drawing command, Ortho mode restricts the cursor to horizon-
tal or vertical movements. Lines, for example, can be drawn only at 0, 90, 180, and 270. 
Ortho mode is toggled on by clicking the Ortho Mode icon on the status bar or by pressing 
the F8 key.

Drawing the Shape
Now that you have the basics, the following exercises will take you through the 
steps required to draw the four lines that form the outline of the shape using 
both relative coordinate systems.
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using Relative Cartesian Coordinates
To begin drawing the box, use the drawing from the previous exercise. Alternatively, 
you can start a new drawing following steps 1–4 from the “Using the Line Tool” 
exercise earlier in this chapter. 

 1. If your drawing is already blank, jump to step 2. If you still have lines 
on your drawing, start the ERASE command, type ALL↵, and then 
press ↵ again to delete them.

 2. Start the LINE command by choosing Home tab ➢ Draw panel ➢ Line.

 3. At the Specify first point: prompt in the Command window, 
type 3,3↵. This is an absolute Cartesian coordinate, and it will be 
the first point.

 4. Type @6,0↵.

 5. Type @0,5↵.

 6. Type -6,0↵.

 7. Look at the command prompt. It reads Specify next point or 
[Close/Undo]:. Items enclosed in brackets are additional available 
options at that particular point of the command that can be entered 
at the command prompt. Only the capitalized letters are required to 
execute an option.

 8. Click Close in the command-line interface to execute the Close 
option, as shown in Figure 2.15.

F I G u R E   2 . 1 5 :   Specifying a command option by clicking it within the 
command-line interface

Typing C↵ after drawing two or more lines closes the shape by 
extending the next line segment from the last point specified to the 
first point (see Figure 2.16). It also ends the LINE command. Notice 
that, in the command-line interface, the prompt is Type a command. 
This signifies that AutoCAD is ready for a new command.
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F I G u R E   2 . 1 6 :   The first four lines of the box

Erasing Lines
To prepare to draw the box again, use the ERASE command to erase the four 
lines you just drew:

 1. Start the ERASE command by choosing Home tab ➢ Modify panel ➢ 
Erase tool.

Notice how the cursor changes from the crosshairs to a little square. 
As mentioned earlier, this is called the pickbox. Its appearance indi-
cates that AutoCAD is ready for you to select objects on the screen. 
Also note the command line; it’s prompting you to select objects.

 2. Place the pickbox on one of the lines, and click that line when it’s 
highlighted. The line glows blue to indicate that it is selected.
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 3. Repeat step 2 for the remaining lines.

 4. Press ↵. The objects are erased, and the ERASE command ends.

n o t E  You’ve been introduced to two methods of selecting lines to be erased: 
typing ALL↵ and using the pickbox to select them. Throughout this book, you’ll learn 
other ways to select objects. The selection process is important in AutoCAD because you 
need to be able to select objects quickly and precisely.

using Relative Polar Coordinates
Now draw the shape again using the Relative Polar method by following these steps:

 1. Start the LINE command by choosing Home tab ➢ Draw panel ➢ 
Line tool.

 2. Type @3,3↵ to start the box at the same point.

 3. Type @6<0↵. Because the Dynamic Input tool is turned on, the @ symbol 
is not required.

 4. Type @5<90↵.

 5. Type @6<180↵.

 6. Type C↵ to close the box and end the LINE command. Your box once 
again resembles the box shown previously in Figure 2.16. 

You can see from this exercise that you can use either method to draw a simple 
shape. When the shapes you’re drawing become more complex and the amount of 
available information about the shapes varies from segment to segment, one of the 
two relative coordinate systems will turn out to be more appropriate. As you start 
drawing the floor plan of the cabin in Chapters 3 and 4, you’ll get more practice 
using these systems.

using Direct Input
Now draw the box once more—this time using the Direct Input method by fol-
lowing these steps:

 1. Erase the lines in your drawing as you did in a prior exercise 
(Home tab ➢ Modify panel ➢ Erase tool).

 2. Make sure Polar Tracking is turned on and then start the LINE 
command.
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 3. Type 3,3↵ to start the box at the same point.

 4. Place the cursor so that it is directly to the right of the first point.
When the cursor is nearly perpendicular, it will snap to a perfectly 

horizontal orientation. The Dynamic Input field shows a value of 0 
and the distance from the first point, as shown in Figure 2.17.

F I G u R E   2 . 1 7 :   Drawing a line by using the Direct Input method

 5. Type 6↵. The first line is created, extending from the initial point to 
a point 6 units away at an angle of 0. Notice that the @ symbol is not 
required when using direct input.

 6. Move the cursor so that it is directly above the last point until the 
angle field reads 90; then type 5↵. A vertical line 5 units long is 
drawn from the previous point.

 7. Move the cursor so that it is directly to the left of the end of the last 
line drawn, and then type 6↵.

A horizontal line 6 units long is drawn from the previous point. Even 
though the line is drawn in the negative X direction, the minus sign 
(negative indicator) is not required. Because Dynamic Input was turned 
on, the minus sign was implied based on the location of your cursor. In 
other words, AutoCAD drew the line in the direction your cursor was 
located.

 8. Type C↵ to close the box and end the LINE command. Your box once 
again resembles the box shown previously in Figure 2.16.

You can see from these exercises that you can use multiple methods to draw 
a simple shape. Showing so many methods may seem a little redundant at this 
point; however, as the shapes you draw become more complex and the amount 
of available information about the shapes varies from segment to segment, you’ll 
likely begin choosing one method or another based on the information available 
to you. As you start drawing the floor plan of the cabin in Chapters 3 and 4, you’ll 
get more practice applying these methods to more-realistic scenarios, and you’ll 
probably begin establishing the methods that work best for you.
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Some additional tools make the process of drawing simple, orthogonal lines 
like these much easier. I introduce these tools in the following three chapters.

using the Offset Command
The next task is to create the lines that represent the inside walls of the box. 
Because they’re all equidistant from the lines you’ve already drawn, OFFSET is the 
appropriate command to use. You’ll offset the existing lines 0.5 units to the inside.

The OFFSET command involves three steps:

 1. Setting the offset distance (Specify offset distance)

 2. Selecting the object to offset (Select object to offset)

 3. Indicating the offset direction (Specify point on side to offset)

Here’s how it works:

 1. Be sure the prompt line in the command interface reads Type a 
command. If it doesn’t, press the Esc key until it does. Then launch 
the OFFSET command by choosing the Home tab ➢ Modify panel ➢ 
Offset tool.

The prompt changes to Specify offset distance or [Through/
Erase/Layer] <Through>:. This is a confusing prompt, but it will 
become clear soon. For now, let’s specify an offset distance through 
the keyboard.

W A R n I n G  As important as it is to keep an eye on the command line, some 
prompts may not make sense to you until you get used to them. When using the Dynamic 
Input option, notice that the command prompt also appears at the cursor.

 2. Type 0.5↵ for a distance to offset the lines a half unit.
Now you move to the second stage of the command. Note  

that the cursor changes to a pickbox, and the prompt changes  
to Select object to offset or [Exit/Undo] <Exit>:.

 3. Place the pickbox on one of the lines, and click the line when it 
highlights.

The selected line appears dashed to indicate that it is selected 
(see Figure 2.18), the cursor changes back to the crosshairs, and 
the prompt changes to Specify point on side to offset or 
[Exit/Multiple/Undo] <Exit>:.

◀

You can also start the 
OFFSET command by 

typing O↵.
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F I G u R E   2 . 1 8 :   From left to right, the series of prompts required to execute the OFFSET 
command: distance, object, and direction

AutoCAD is telling you that, to determine the direction of the 
offset, you must specify a point on one side of the line or the other. 
Although a preview of the OFFSET command’s result is displayed, the 
command is not complete until you make the choice by selecting 
anywhere in the drawing area on the side of the line where you want 
the offset to occur.

 4. Click a point somewhere inside the box. (You don’t have to be precise, 
just as long as you select a point inside the box.)

The offset takes place, and the new line is exactly 0.5 units to the 
inside of the chosen line (see Figure 2.19). Notice that the pickbox 
comes back on. The OFFSET command is still running, and you can 
offset more lines by the same distance.

F I G u R E   2 . 1 9 :   The first line is offset.

You have three more lines to offset.

 5. Click another line; then click inside the box again. The second line 
is offset.

 6. Click a third line, click inside the box, click the fourth line, and then 
click again inside the box (see Figure 2.20).
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F I G u R E   2 . 2 0 :   Four lines have been offset.

 7. Press ↵ to end the OFFSET command.

n o t E  The offset distance stays set at the last distance you specify—0.5, in this 
case—until you change it.

This command is similar to the LINE command in that it keeps running until 
it’s stopped. With OFFSET, after the first offset, the prompts switch between 
Select object to offset or [Exit/Undo] <Exit>: and Specify point on 
side to offset or [Exit/Multiple/Undo] <Exit>: until you press ↵ or the 
spacebar to end the command.

Specifying Distances for the Offset Command

The prompt you see in the command-line interface after starting the OFFSET 
command is as follows:

Specify offset distance or [Through/Erase/Layer] 
<Through>:

This prompt describes several options for setting the offset distance:

▶▶ Enter a distance from the keyboard.

▶▶ Select two points on the screen to establish the offset distance as the 
distance between those two points.

▶▶ Press ↵ to accept the offset distance or option that is displayed in the 
prompt in the angle brackets.

▶▶ Type T↵ to use the Through option. When you select this option, you’re 
prompted to select the line to offset. You’re then prompted to pick a 
point. The line will be offset to that point. When you pick the next line to 
offset, you then pick a new point to locate the position of the new line. 
The Through option allows each line to be offset a different distance.

◀

You can cancel a com-
mand at any time by 
pressing Esc or by right-
clicking and choosing 
Cancel from the con-
text menu.

(Continues)
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▶▶ Type E↵, and then type Y↵ to tell AutoCAD to erase the original line that 
was offset. (After doing this, however, AutoCAD continues erasing offset 
lines until you reset it by typing E↵N↵ at the beginning of the OFFSET 
command.)

▶▶ Type L↵ to use the Layer option. (I discuss this option in Chapter 6, “Using 
Layers to Organize Your Drawing.”)

As you become accustomed to using OFFSET, you’ll find uses for each of these options.

The inside lines are now drawn, but to complete the box, you need to clean up the 
intersecting corners. To handle this task efficiently, you’ll use the FILLET command.

using the Fillet Command
The FILLET command lets you round off a corner formed by two lines. You 
control the radius of the curve, so if you set the curve’s radius to 0, the lines 
form a sharp corner (without a curve or arc). Thanks to this behavior of the 
FILLET command, it is commonly used to clean up corners such as the ones 
formed by the lines inside the box. You must pick points on the filleted lines to 
indicate portions that will remain after the fillet is implemented; otherwise, the 
wrong portion of the line may be retained. Figure 2.21 illustrates how to use the 
FILLET command to achieve the desired result.

Selectable Region
Extension

Se
le

ct
ab

le
 R

eg
io

n

F I G u R E   2 . 2 1 :   Selecting objects to obtain the expected result when using the FILLET 
command

Specifying Distances for the offset Command (Continued)
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 1. When the command line reads just Type a command, launch the 
FILLET command by choosing the Home tab ➢ Modify panel ➢ 
Fillet tool. Notice how the command-line interface changes after 
you’ve clicked the Fillet icon (see Figure 2.22).

F I G u R E   2 . 2 2 :   The command prompt after initiating the FILLET command

The default Fillet radius should be 0.0000 units. Like the Offset 
distance, the Fillet radius remains set at a constant value until you 
change it.

 2. If your Command window displays a radius of 0.0000, go on to step 
3. Otherwise, click the Radius option at the command line, and then 
type 0↵ to change the radius to 0.

t I P  When the radius value is set higher than 0, you can temporarily override 
this by holding the Shift key down while picking the two objects to be f illeted. They 
will be filleted with a radius of 0, while the value set in the FILLET command remains 
unchanged.

 3. Move the cursor—now a pickbox—to the shape, and click two inter-
secting lines, as shown at the top of Figure 2.23. Hovering over the 
second line (Figure 2.23, bottom) causes the lines to glow blue along 
the line segments that will remain.

F I G u R E   2 . 2 3 :   Blue glow indicating the resulting line segments while picking 
two lines to execute the FILLET command

The intersecting lines are both trimmed to make a sharp corner 
(see Figure 2.24). The FILLET command automatically ends.

◀

You can also start the 
FILLET command by 
typing F↵.
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F I G u R E   2 . 2 4 :   The first cleaned-up corner

 4. Press ↵ to restart the command, and this time type M↵ to activate the 
Multiple option. Multiple repeats the FILLET command until another 
option is initiated at the command prompt or the command is termi-
nated with the ↵ or Esc key or the spacebar.

 5. Fillet the lower-left and lower-right crossing lines to clean up those 
corners (see Figure 2.25) and press ↵.

F I G u R E   2 . 2 5 :   The box with three corners cleaned up

t I P  In most cases, you’ll get the same effect by pressing the spacebar as you get 
by pressing ↵. The exception is when you’re entering data in a text box within a dialog 
box or a palette; in those cases, pressing the spacebar inserts a space.

 6. Press ↵ to restart the FILLET command. This time, choose the Radius 
option; then enter 0.5↵ to set the fillet radius to 0.5, and click the two 
lines that make up the interior upper-right corner.

After a command has ended, you can restart it by pressing either ↵  
or the spacebar or by right-clicking and choosing Repeat from the con-
text menu.
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As you hover over the second line to fillet, notice the real-time 
0.5-unit fillet preview that displays.

 7. Restart the command, set the radius to 1.0, and then fillet the outer 
upper-right corner. Your box should look like Figure 2.26.

F I G u R E   2 . 2 6 :   The box with the curved radii in the upper-right corner

n o t E  If you make a mistake and pick the wrong part of a line or the wrong line, 
press Esc to end the command and then type U↵. This will undo the effect of the last 
command.

The OFFSET and FILLET commands provide you with a powerful combination 
of tools for laying out walls on a floor-plan drawing. Because these commands 
are so important, let’s take a closer look at them to see how they work. Both 
commands are in the Modify panel of the Ribbon’s Home tab, and in the Modify 
menu of the menu bar, both have the option to enter a numeric value or accept 
the current value—for offset distance and fillet radius—and both hold that 
value as the default until it’s changed. However, the OFFSET command keeps 
running until you stop it, and the FILLET command stops after each use unless 
the Multiple option is invoked. These commands are two of the most frequently 
used tools in AutoCAD. You’ll learn about more of their uses in later chapters.

The FILLET command has a sister command, CHAMFER, which is used to bevel 
corners with straight lines. When the distances for the CHAMFER command are 
set to 0, you can use the command to clean up corners in the same way that you 
use the FILLET command. Some users prefer to use CHAMFER rather than FILLET 
because they don’t bevel corners, but they may at times use FILLET to round 
off corners. If you use CHAMFER to clean up corners, FILLET can have any radius 
and won’t have to be overridden or reset constantly to 0. You’ll develop your own 
preference.

◀

The down-pointing 
arrow next to the Fillet 
tool opens a flyout 
menu that includes the 
Chamfer tool.
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Completing the Shape
The final step in completing the box (Figure 2.1 from the beginning of this 
chapter) is to make an opening in the bottom wall. From the diagram, you can 
see that the opening is 2 units wide and set off from the right inside corner by 
0.5 units. To make this opening, you’ll use the OFFSET command twice, chang-
ing the distance for each offset, to create marks for the opening.

offsetting Lines to Mark an opening
Follow these steps to establish the precise position of the opening:

 1. At the command prompt, start the OFFSET command (Home tab ➢ 
Modify panel ➢ Offset tool).

Notice the command prompt. The default distance is now set at 
0.5, the offset distance you previously set to offset the outside lines 
of the box to make the inside lines. If the distance is different, type 
0.5↵. You’ll want to use this distance again. Press ↵ again to accept 
this preset distance.

 2. Pick a point inside the vertical line on the right, and then pick a  
point to the left of this line. The line is offset, creating a new line  
0.5 units to the left (see Figure 2.27).

F I G u R E   2 . 2 7 :   Offsetting the first line of the opening

 3. Press ↵ to end the OFFSET command, and then press it again to 
restart the command. This will allow you to reset the offset distance.

 4. Enter 2 as the new offset distance, and then press ↵.

 5. Click the new line, and then pick a point to the left. Press ↵ to end 
the OFFSET command (see Figure 2.28).
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F I G u R E   2 . 2 8 :   Offsetting the second line of the opening

You now have two new lines indicating where the opening will be. You can use 
these lines to form the opening when using the EXTEND and TRIM commands.

t I P  The buttons you’ve been clicking in this chapter are also referred to as icons 
and tools. When they’re in dialog boxes or on the status bar, they have icons (little pic-
tures) on them and look like buttons to push. When they’re on the Ribbon or toolbars, 
they look like icons. But when you move the pointer arrow cursor onto one, it takes on 
the appearance of a button with an icon on it. I use all three terms—button, icon, and 
tool—interchangeably throughout this book.

Extending Lines
The EXTEND command is used to lengthen (extend) lines to meet other lines or 
geometric figures (called boundary edges). Executing the EXTEND command may 
be a little tricky at first until you see how it works. Once you understand it, how-
ever, it will become automatic. The command has two steps: first, you pick the 
boundary edge or edges, and then you pick the lines you want to extend to meet 
those boundary edges. After selecting the boundary edges, you must press ↵ 
before you begin selecting lines to extend. 

Here are the steps to using the EXTEND command:

 1. Launch the EXTEND command by choosing Home tab ➢ Modify panel ➢ 
Extend tool. If you don’t see the tool, click the down-arrow next to the 
Trim icon and then choose Extend from the flyout menu.

Notice that the command prompt reads Select objects or 
<select all>:, but, in this case, you need to observe the two lines 
of text above the command line in order to know that AutoCAD is 
prompting you to select boundary edges (see Figure 2.29).

F I G u R E   2 . 2 9 :   The Command window while using the EXTEND command

◀

You can also start the 
EXTEND command by 

typing EX↵.
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 2. Pick the very bottom horizontal line (see Figure 2.30) and then press ↵.

F I G u R E   2 . 3 0 :   Selecting a line to be a boundary edge

t I P  The Select Objects: prompt would be more useful if it read Select 
objects and press Enter when finished selecting objects:. But 
it doesn’t. You have to train yourself to press ↵ when you finish selecting objects in order 
to get out of Selection mode and move on to the next step in the command.

 3. Pick the two new vertical lines created by the OFFSET command. Be 
sure to place the pickbox somewhere on the lower halves of these lines, 
or AutoCAD will attempt to extend the opposite ends of the lines.

Because there are no boundary edges that could intersect with 
extensions from the top end of the lines, AutoCAD will ignore your 
picks if you select the wrong ends. The lines are extended to the 
boundary edge line.

 4. Press ↵ to end the EXTEND command (see Figure 2.31).

F I G u R E   2 . 3 1 :   The lines are extended to the boundary edge.
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trimming Lines
The final step is to trim away the horizontal lines to complete the opening and 
the unneeded portions of the two most recent vertical lines that you offset. To do 
this, you use the TRIM command. Like the EXTEND command, TRIM has two steps. 
The first is to select reference lines. In this case, they’re called cutting edges 
because they determine the edge or edges to which a line is trimmed. The second 
step is to pick the lines that are to be trimmed. Also like the EXTEND command, 
TRIM lets you select the objects individually or use one of the many other object 
selection methods found in AutoCAD. In this exercise, you’ll have a chance to try 
out one of these methods known as the Fence method:

 1. Choose the Home tab ➢ Modify panel, click the down arrow next to 
the Extend button, and then choose Trim from the flyout menu. This 
launches the TRIM command.

Notice the command-line interface. Similar to the EXTEND command, 
the bottom line prompts you to select objects or select everything in the 
drawing, but the second line up tells you to select cutting edges.

 2. Pick the two vertical offset lines that were just extended as your cutting 
edges, and then press ↵ (see Figure 2.32).

F I G u R E   2 . 3 2 :   Lines selected to be cutting edges

 3. Notice that the command line reads Select object to trim or 
shift-select to extend or [Fence/Crossing/Project/Edge/
eRase/Undo]:. Type F to start Fence mode.

 4. Your command line now reads Specify first fence point:. Using 
the Fence method, you will draw an imaginary line through the 
objects you want to trim. Use your cursor to draw a line that crosses 
the two horizontal lines across the opening, somewhere between the 
cutting-edge lines (see Figure 2.33).

◀

You can also start the 
TRIM command by 

typing TR↵.
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F I G u R E   2 . 3 3 :   Lines selected to be trimmed

The opening is trimmed away (see Figure 2.34).

F I G u R E   2 . 3 4 :   Lines are trimmed to make the opening.

n o t E  In these trimming procedures, the endpoints of the cutting-edge lines, 
as well as the lines themselves, are used as cutting edges.

n o t E  If you trim the wrong line or the wrong part of a line, you can click the 
Undo button on the Quick Access toolbar, on the left side of the AutoCAD title bar. This 
undoes the last trim without canceling the TRIM command, and you can try again.

Now let’s remove the extra part of the trimming guidelines:

 1. Press ↵ twice—once to end the TRIM command and again to restart it. 
The command line asks you to Select objects or <select all>:.

 2. Instead of selecting your cutting edges manually, you can press ↵ once 
again. Doing this accepts the default <select all> option listed at the 
command line. Using this method, every object in your drawing will be 
treated as a cutting edge.
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 3. Pick the two vertical lines that extend above the new opening. Be 
sure to pick them above the opening (see Figure 2.35). The lines are 
trimmed away, and the opening is complete. Press ↵ to end the TRIM 
command (see Figure 2.36).

Lines to Be
Trimmed

F I G u R E   2 . 3 5 :   Lines picked to be trimmed

F I G u R E   2 . 3 6 :   The completed trim

Congratulations! You’ve just completed the first drawing project in this book, 
and you’ve used all the tools introduced in this chapter. These skills will be use-
ful as you learn how to work on drawings for actual projects.

n o t E  You can check your f inished shape by comparing it to Chapter02 
Shape Completed.dwg, which is available from this book’s website at www.sybex 
.com/go/autocad2015ner or www.thecadgeek.com.

At this time, a valuable exercise would be to draw this box two or three more 
times—until you can do it without the instructions. This will serve as a confi-
dence builder to get you ready to take on a new challenge in the next chapter, in 
which you’ll set up a drawing for a building. 
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The box you drew was 6 units by 5 units, but how big was it? You really don’t 
know because the units could represent any distance: inches, feet, meters, miles, 
and so on. Also, the box was positioned conveniently on the screen so that you 
didn’t have any problem viewing it. What if you were drawing a building that was 
200 feet (60 meters) long and 60 feet (18 meters) wide or a portion of a microchip 
circuit that was only a few thousandths of an inch or millimeters long? In the 
next chapter, you’ll learn how to set up a drawing for a project of a specific size.

You can save the file of the simple shape you drew by clicking the Save button 
on the Quick Access toolbar, or you can exit AutoCAD now without saving this 
drawing. To do the latter, expand the Application menu and then click the Exit 
AutoCAD button in the lower-right corner. When the dialog box asks whether 
you want to save changes, click No. Alternatively, you can leave AutoCAD open 
and go on to the following practice section or the next chapter.

If You Would Like More Practice…
Draw the object shown in Figure 2.37.

F I G u R E   2 . 3 7 :   Practice drawing
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You can use the same tools and strategy from earlier in this chapter to draw 
the shape. Choose New from the Application menu (Application menu ➢ New ➢ 
Drawing) to start a new drawing, and then use the acad.dwt template file. Here’s 
a summary of the steps to follow:

 1. Ignore the three openings at first.

 2. Draw the outside edge of the shape by using one of the relative 
coordinate systems. To make sure the shape fits on your screen, 
start the outline of the box in the lower-left corner at the absolute 
coordinate of 1,0.5.

 3. Offset the outside lines to create the inside wall.

 4. Fillet the corners to clean them up. (Lines that aren’t touching can 
be filleted—just like lines that intersect.)

 5. Use the OFFSET, EXTEND, and TRIM commands to create the three 
openings.

Feel free to check your work against Chapter02 More Practice Completed.dwg 
on this book’s web page. Don’t worry about trying to put in the dimensions, cen-
terline, or hatch lines. You’ll learn how to create those objects later in the book.

Are You Experienced?
now you can…

✔✔ understand	the	basics	of	coordinates

✔✔ distinguish	between	absolute	and	the	two	relative	coordinate	sys-
tems	used	by	AutoCAD

✔✔ input	coordinates	by	using	the	Direct	Input	method

✔✔ use the LINE, ERASE, OFFSET, FILLET, EXTEND, and TRIM commands 
to create a drawing
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CHAPtER 3

Setting up a Drawing
In Chapter 2, “Learning Basic Commands to Get Started,” you explored the 
default drawing area that is set up when you open the Autodesk® AutoCAD® 
program and start a new drawing. Using an assortment of common commands, 
you drew a box within the drawing area. If you drew the additional diagram 
offered as a supplemental exercise, the drawing area was set up the same way.

In this chapter, you’ll learn how to set up the drawing area to lay out a 
floor plan for a building of a specific size. The decimal units that you have 
been using will be changed to feet and inches, and the drawing area will be 
transformed so that it can represent an area large enough to display the floor 
plan of the cabin you’ll be drawing. 

As you learn to set up your drawing, you’ll also begin exploring ways to 
navigate your drawing more easily, draw lines at a specified incremental 
distance (such as to the nearest foot), and more. Finally, you’ll save this 
drawing to a special folder on your hard drive. At the end of the chapter is a 
general summary of the units that AutoCAD supports.

Whether or not you work in architecture, the tools you’ll use and the skills 
you’ll learn in this chapter will translate into nearly any discipline, enabling 
you to draw objects of any shape or size.

In this chapter, you will learn to

▶▶ Set	up	drawing	units

▶▶ Use the AutoCAD grid

▶▶ Zoom in and out of a drawing

▶▶ Name and save a file

▶▶ Save	to	Autodesk® 360 storage
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Setting up the Drawing units
When you draw lines of a precise length in AutoCAD, you use one of five kinds 
of linear units. Angular units can also be any of five types. The combination you 
choose will largely depend on the type of drawings you plan to prepare. Each 
of these linear and angular units is presented at the end of this chapter, but for 
now let’s focus on getting ready to begin drawing our cabin.

When you first start a new drawing, AutoCAD displays a blank drawing called 
Drawing#.dwg. By default, the linear and angular units inside this drawing are set 
to decimal numbers. The units and other basic setup parameters applied to this 
new drawing are based on a prototype drawing with default settings—including 
those for the units. This chapter covers some of the tools for changing the basic 
parameters of a new drawing so that you can tailor it to the cabin project or to 
your own project.

Begin by setting up new units:

 1. With AutoCAD running, click the plus icon to the right of the draw-
ing tabs to open the New Tab.

 2. Expand the Templates menu within the Start Drawing tool on the 
Create page shown in Figure 3.1, and select the acad.dwt template.

F I G u R E   3 . 1 :   Selecting the acad.dwt template from the Start Drawing tool

 3. Choose Application menu ➢ Drawing Utilities ➢ Units to open the 
Drawing Units dialog box (UNITS command) shown in Figure 3.2. In 
the Length group, Decimal is currently selected. Similarly, in the 
Angle group, Decimal Degrees is the default.

▶

If the Select Template 
dialog box doesn’t 
appear after you click 
New from the drawing 
tab interface, choose 
Application menu ➢ 
New ➢ Drawing.
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F I G u R E   3 . 2 :   The Drawing Units dialog box

Imperial vs. Metric Measurements

From this point forward, I’ll provide the metric equivalents in parentheses for readers 
who do not work in imperial units, the standard for architectural design in the United 
States. Throughout the majority of this book, you’ll be developing drawings for a cabin 
with outside wall dimensions of 28′ × 18′ (8550 mm × 5490 mm). Although the exact 
metric conversion would equal 8534.4 mm × 5486.4 mm, you’ll notice the metric 
equivalents have been rounded to more closely align with real-world metric dimensions.

 4. Within the Drawing Units dialog box, in the Length group, click the 
arrow in the Type drop-down list and select Architectural (metric 
users can leave this set to Decimal). These units are feet and inches, 
which you’ll use for the cabin project.

Notice the two Precision drop-down lists under the Length and 
Angle groups. When you changed the linear unit specification from 
Decimal to Architectural, the number in the Precision drop-down list 
on the left changed from 0.0000 to 0′-0 1⁄16″. At this level of preci-
sion, linear distances are displayed to the nearest 1 ⁄16″. Metric users 
should set this to 0 because we won’t be using units smaller than a 
millimeter.
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 5. Select some of the other Length unit types from the list, and notice 
the way the units appear in the Sample Output group at the bottom 
of the dialog box. Then select Architectural again or leave it set to 
Decimal for metric use.

n o t E  Drop-down lists are lists of options with only the selected choice dis-
played when the list is closed. When you click the arrow, the list opens. When you make 
another selection, the list closes and your new choice is displayed. When an item on the 
list is selected and is the focus of the program (indicated by a blue highlight), you can 
change the available options by using the scroll wheel on a mouse or the up and down 
arrows on the keyboard. You can choose only one item at a time from the list.

 6. Click the down arrow in the Precision drop-down list in the Length 
group to display the choices of precision for Architectural units  
(see Figure 3.3).

F I G u R E   3 . 3 :   The Precision drop-down list for Architectural units (left) and 
Decimal units (right)
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This setting controls the degree of precision to which AutoCAD dis-
plays a linear distance. If it’s set to 1⁄16″, any line that is drawn more 
precisely, such as a line 6′-31⁄32″ long, displays a length value to the 
nearest 1 ⁄16″ when queried (which, in the example, would be 6′-3 
1⁄16″). However, the line is still 6′-31⁄32″ long.

If you change the precision setting to 1⁄32″ and then use the 
DISTANCE command to measure the distance between two features, 
you’ll see that its length is 6′-31⁄32″.

 7. Click 0′-0 1⁄16″ (0) to maintain the precision for display of linear 
units at 1 ⁄16″ (nearest millimeter).

If you open the Type drop-down list in the Angle group, you’ll see a choice, 
among others, between Decimal Degrees and Deg/Min/Sec. Like so many set-
tings in AutoCAD, the correct setting here is often dictated by the types of 
drawings you’re preparing. Decimal angular units are the most popular choice 
for individuals working in architecture (or its related disciplines). On the other 
hand, Deg/Min/Sec is most popular in the civil engineering disciplines.

Because our project is a cabin (architectural), we’ll use the default Decimal 
Degrees throughout this book. However, the default precision setting is to the 
nearest degree. This may not be accurate enough, so you should change it to 
the nearest hundredth of a degree:

 1. Click the arrow in the Precision drop-down list in the Angle group.

n o t E  When using metric units, 1 unit = 1 millimeter.

 2. Select 0.00 as the precision value for angles.
The Drawing Units dialog box now indicates that, in your draw-

ing, you plan to use Architectural length units with a precision 
setting of 1 ⁄16″ (Decimal with a precision of 0 if using metric) and 
Decimal angular units with a precision of 0.00º (see Figure 3.4). This 
doesn’t restrict the precision at which you draw, just the values that 
AutoCAD reports.
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F I G u R E   3 . 4 :   The Drawing Units dialog box for Architectural units (left), and 
Decimal (metric) units (right) after changes

 3. Change the Insertion Scale to Inches (Millimeters for metric). This 
often-overlooked setting allows AutoCAD to scale drawings automati-
cally to the proper size when inserted or referenced into other drawings.

This behavior is common, as architects have to collaborate with 
civil engineers on projects. Architectural drawings are generally 
set up such that 1 unit is equal to 1 inch, whereas civil engineering 
drawings are set up such that 1 unit is equal to 1 foot. As an archi-
tect and engineer collaborate, their drawings must be scaled up by 
12″ or down by 1⁄12, depending on whose drawing is being inserted. 
AutoCAD can automatically do this conversion for you, provided the 
Insertion Scale for your architectural drawings is set to Inches, and 
for the civil engineering drawings is set to Feet.

Clicking the Direction button at the bottom of the Drawing Units 
dialog box opens the Direction Control dialog box, which has settings 
to control the direction of 0 .̊ By default, 0˚ is to the right (east), and 
positive angular displacement goes in the counterclockwise direc-
tion. (See Figure 2.9 in Chapter 2 for an illustration of the Cartesian 
coordinate system.) These are the standard settings for most users 
of CAD. There is no need to change them from the defaults. If you 
want to take a look, open the Direction Control dialog box, note the 
choices, and then click Cancel. You won’t have occasion in the course 
of this book to change any of those settings. 
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n o t E  You’ll have a chance to work with the angular units in Chapter 12, 
“Dimensioning a Drawing,” when you develop a site plan for the cabin.

 4. Click OK to accept the changes and close the Drawing Units dialog 
box. Notice that the coordinate readout on the left side of the status 
bar now reads in feet and inches.

Missing Coordinate Readout?

If the coordinate readout is not displayed on the status bar, click the Customize 
button (three horizontal lines) on the right side of the status bar, and select 
Coordinates from the menu that opens. 

This tour of the Drawing Units dialog box has introduced you to the choices 
you have for the types of units and the degree of precision for linear and angular 
measurement. The next step in setting up a drawing is to determine its size.

n o t E  If you accidentally click the mouse when the cursor is on a blank part of 
the drawing area, AutoCAD starts a rectangular window. I’ll talk about these windows 
soon, but for now just press the Esc key to close the window.

Setting up the Drawing Size
Now that you have changed the units to Architectural, the drawing area is approxi-
mately 12″ to 16″ (500 mm) wide and 9″ (300 mm) high, a size determined from 
the programmatic defaults of AutoCAD. You can check this by moving the cross-
hair cursor around on the drawing area and looking at the coordinate readout, as 
you did in the previous chapter.

t I P  When you change Decimal units to Architectural units, 1 Decimal unit trans-
lates to 1 inch. Some industries, such as civil engineering, often use Decimal units to rep-
resent feet instead of inches. If the units in their drawings are switched to Architectural, 
a distance that was a foot now measures as an inch. To correct this, the entire drawing 
must be scaled up by a factor of 12.
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The drawing area is defined as the part of the screen in which you draw. You can 
make the distance across the drawing area larger or smaller through a process 
known as zooming in or zooming out. To see how this works, you’ll learn about a 
tool called the grid that helps you to draw and to visualize the size of your drawing.

using the Grid
The AutoCAD grid, a pattern of horizontal and vertical gridlines that mimic the 
appearance of a sheet of graph paper, is used as an aid to drawing. You can set 
the grid to be visible or invisible. When set to visible, all but two of the hori-
zontal and vertical gridlines display with a light gray color. One vertical grid-
line is colored green, whereas a single horizontal gridline is colored red. These 
colored gridlines reside at the 0 x-coordinate (red) and 0 y-coordinate (green), 
and they establish a boundary for Quadrant I of your drawing area, as shown in 
Figure 2.9 in Chapter 2.

Anything drawn above the red gridline and to the right of the green gridline 
resides in Quadrant I, having positive x- and y-coordinate values. When working 
in 3D, the green and red gridlines still represent the positive x- and y-coordinates 
of your drawing area graphically; however, a third z-axis is also represented 
in blue. Don’t worry too much about the z-axis quite yet, as it is discussed in 
Chapter 16, “Creating 3D Geometry,” and Chapter 17, “Rendering and Materials.”

The area covered by the grid depends on a setting called Drawing Limits, 
explained in the section “Setting Up Drawing Limits” later in this chapter. To 
learn how to manipulate the grid size, you’ll make the grid visible, use the Zoom 
In and Zoom Out commands to vary the view of the grid, and then change the 
area over which the grid extends by resetting the drawing limits.

Before doing this, however, let’s take a look at the icon that sits in the lower-
left corner of the drawing area. Known as the UCS, or User Coordinate System, 
icon, it provides a visual cue to how we’re looking at the drawing, and it changes 
when we’re looking from a 3D perspective. You’ll learn more about this in 
Chapter 10, “Generating Elevations,” when we begin our discussion of 3D. 

To become familiar with using and interacting with the grid in AutoCAD, fol-
low these steps:

 1. If the grid is not already displayed in the drawing area, move the 
crosshair cursor to the status bar at the bottom of the screen, and 
click the Grid Display button.
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The button changes from the Off to the On state (with a light blue 
glow), and a series of horizontal and vertical lines appear in the 
drawing area, representing a piece of graph paper.

These lines are the grid. Preset by default to be 1/2″ (10 mm) apart, 
they extend across the entire drawing area. In the drawing area, 
the gridlines may measure a greater distance apart, especially if 
you zoom out in the drawing. This is because, in the relatively large 
drawing area, lines spaced 1/2″ (10 mm) apart would be very dense, 
and working with them would be difficult. AutoCAD automatically 
reduces the density of the displayed gridlines to maintain a reason-
able appearance in the drawing area.

 2. To open the Drafting Settings dialog box, right-click the Snap Mode 
button and then choose Snap Settings from the context menu that 
appears (see Figure 3.5).

F I G u R E   3 . 5 :   Displaying the Drafting Settings dialog box

t I P  With many of the buttons on the status bar, if you right-click the button and 
choose Settings, the Drafting Settings dialog box (or other appropriate dialog box for 
defining the tool’s parameters) opens to the tab with the parameters that relate to that 
specific button. You can also open the Drafting Settings dialog box by typing DS↵.

 3. The Snap And Grid tab of the Drafting Settings dialog box should be 
active (see Figure 3.6). If it’s not, click the tab.

www.MouradEngineering.com



7 4 	 C h a p t e r 	 3 	 • 	 S e t t i n g 	Up 	 a 	D r aw i n g

F I G u R E   3 . 6 :   The Snap And Grid tab of the Drafting Settings dialog box

 4. In the Grid Behavior group, be sure Adaptive Grid is checked and 
Display Grid Beyond Limits is unchecked. Then click OK.

The grid now covers only the area from the origin to 12″, 9″ (490 
mm, 290 mm), the area defined by the limits of the drawing, but 
extends to the extents of the drawing area. This will be evident after 
this step.

Limits are discussed in the next section. The Adaptive Grid option 
causes AutoCAD to reduce the number of the grid’s columns and 
rows proportionately whenever the zoom factor would cause the grid 
to become too dense to be effective.

 5. To display a larger area within the drawing area, scroll the mouse wheel 
by dragging it toward you or use the Zoom Out command by clicking the 
drop-down arrow next to the Zoom tool from the View tab ➢ Navigate 2D 
panel on the Ribbon.

The view changes, with more gridlines displaying in a denser con-
figuration (see Figure 3.7). You may need to zoom twice to see the 
effect. Move the crosshair cursor to the lower-left corner of the grid, 
and then move it to the upper-right corner. Notice that the coordi-
nate readout at the lower left of your screen shows a large negative 
number for the lower-left corner and a larger positive number for the 
upper-right corner. You’re displaying a greater amount of space in 
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the drawing area. A closer inspection of the grid will reveal one verti-
cal line colored green and a horizontal line colored red. The inter-
section of these lines represents the origin, or 0,0 point, inside your 
drawing. Any point above the red line and to the right of the green 
line will have a positive coordinate value.

F I G u R E   3 . 7 :   The grid after zooming out

 6. To the right of the Grid Display button on the status bar, click the 
Snap Mode button. Then move the cursor back onto the grid and look 
at the coordinate readout again.

The cursor stops at each grid point intersection, even those that 
are no longer displayed because of the zoom factor, and the readout 
is to the nearest half inch. The Snap tool locks the cursor onto the 
gridlines; even when the cursor isn’t on the visible grid but some-
where outside it on the drawing area, the cursor maintains the grid 
spacing and jumps from one location to another.

 7. Use the Zoom Out command a few more times or scroll the mouse 
wheel.

 8. From the Navigation bar, choose Zoom ➢ Zoom In, or roll the scroll 
wheel on your mouse enough times to bring the view of the grid back 
to the way it appeared when it was first displayed. You aren’t chang-
ing the size of the grid, just the view of it. It’s like switching from a 
normal to a telephoto lens on a camera.
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The grid is more of a guide than an actual boundary of your drawing. For 
most purposes, you can draw anywhere on the screen. The grid merely serves as 
a tool for visualizing how your drawing will be laid out.

Because it serves as a layout tool for this project, you need to increase the area 
covered by the grid from its present size to 60′ × 40′ (18 m × 12 m).

Setting up Drawing Limits
The Drawing Limits setting defines two properties in a drawing: it records the 
coordinates of the lower-left and upper-right corners of the grid and identifies 
what is displayed when the user executes a Zoom ➢ All command with only a 
small portion of the drawing area in use. The coordinates for the lower-left cor-
ner are 0,0 by default and are usually kept at that setting. You need to change 
only the coordinates for the upper-right corner and change the settings so that 
the grid is displayed only within the limits:

 1. Make sure the Command window displays the Type a command 
prompt; then type LIMITS↵. Notice how the command-line interface 
appears, as shown in Figure 3.8.

F I G u R E   3 . 8 :   The Command window after starting the LIMITS command

The command line tells you that the first step is to decide whether 
to change the default x- and y-coordinates for the lower-left limits, 
both of which are currently set at 0'-0",0'-0" (0,0). There is no 
need to change these.

 2. Press ↵ to accept the 0'-0",0'-0" (0,0) coordinates for this cor-
ner. The command line changes, now displaying the coordinates for 
the upper-right corner of the limits. This is the setting you want to 
change.

 3. Type 60',40'↵ (18000,12000)↵. Be sure to include the foot sign (').

n o t E  AutoCAD requires that, when using Architectural units, you always indi-
cate that a distance is measured in feet by using the foot sign (′). You don’t have to use 
the inch sign (″) to indicate inches.
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 4. To bring the entire area defined by the drawing limits onto the screen, 
use the ZOOM command again, but this time use the All option to bring 
the drawing limits into view (see Figure 3.9).

F I G u R E   3 . 9 :   The drawing with the grid extending to the 60′ × 40′  
(18,000 mm × 12,000 mm) limits

The drawing area expands to display the drawing limits, and the 
grid changes appearance to accommodate the new view.

 5. Move the cursor from one gridline to another and watch the coordi-
nate readout. The coordinates are still displayed to the nearest half 
inch (10 mm), but the gridlines are much more than half an inch 
(10 mm) apart.

By default, when you zoom in or out, AutoCAD adjusts the grid spacing to 
keep the gridlines from getting too close together or too far apart. In this case, 
remember that you found the grid spacing to be 1⁄2″ (10 mm) by default. At that 
interval, the gridlines would be so close together that they would be only about 
1 pixel in size and would solidly fill the drawing area. So, AutoCAD adjusts the 
spacing of the gridlines to keep the grid readable. 

For the drawing task ahead, you need to change the default grid spacing 
to a more usable value. The dimensions of the outside wall line are 28′ × 16′ 
(8550 mm × 4850 mm), and the exterior walls are 6″ (150 mm) thick. Notice 
these dimensions are in whole feet (millimeters) and divisible by 2 (50). You 

www.MouradEngineering.com



7 8 	 C h a p t e r 	 3 	 • 	 S e t t i n g 	Up 	 a 	D r aw i n g

will take advantage of this interval by configuring the Grid and Snap modes 
to help you draw the outline of the cabin. Here’s how:

 1. Right-click the Snap button on the status bar and click Snap 
Settings. The Drafting Settings dialog box opens to the Snap And 
Grid tab. The settings in both the Grid Spacing and Snap Spacing 
groups include X and Y Spacing settings. Notice that they’re all set 
for a spacing of 1⁄2″ (10).

 2. In the Grid Spacing group, click in the Grid X Spacing text box and 
change 1⁄2″ (10) to 2′ (1000), as shown in Figure 3.10. Then click in the 
Grid Y Spacing text box. It automatically changes to match the Grid 
X Spacing text box.

F I G u R E   3 . 1 0 :   New settings on the Snap And Grid tab of the Drafting Settings 
dialog box using imperial units (left) and metric units (right)

If you want different Grid X and Grid Y Spacing values, you must 
deselect the Equal X And Y Spacing option in the Snap Spacing group.

 3. In the Snap Spacing group, change the Snap X Spacing setting to 
6 (50), as shown in Figure 3.10. (The inch sign isn’t required.) Then 
click the Snap Y Spacing input box or press the Tab key. The Snap Y 
spacing automatically changes to match the Snap X Spacing setting.

 4. In the Snap Type group, be sure Grid Snap and Rectangular Snap are 
selected (Figure 3.10).

▶

A multiple of 10 is 
used for the metric 
Snap Spacing and Grid 
Spacing values to align 
with a typical metric 
workflow. These val-
ues do not represent 
an exact conversion 
from their imperial 
equivalents.

If you set Grid Spacing 
to 0, the grid takes 
on whatever spacing 
you set for the Snap 
X Spacing and Snap Y 
Spacing text boxes. 
This is how you lock the 
snap and grid together.

▶
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 5. In the Grid Behavior group, only Adaptive Grid should be selected. 
With the grid set this way, AutoCAD will adjust the number of grid-
lines displayed as you zoom in and out, but it won’t add gridlines 
between the lowest grid spacing.

 6. The Snap On and Grid On check boxes at the top of the dialog box 
should be selected. If they aren’t, click them. Your Snap And Grid 
tab should look like Figure 3.10.

 7. Click OK. The new 2′ (1000 mm) grid is now visible. Move the cursor 
around on the grid—be sure Snap is on. (Check the Snap Mode but-
ton on the status bar; it’s pressed when Snap is on.) Notice that the 
coordinate readout displays coordinates to the nearest 6″ (50 mm) to 
conform to the new 6″ (50) snap spacing. The cursor stops at several 
snap points between each grid dot.

 8. Move the crosshair cursor to the upper-right corner of the grid, and 
check the coordinate readout. It should display 60′-0″, 40′-0″, 0′-0″ 
(18000.0000, 12000.0000, 0). In Autodesk® AutoCAD LT®, you won’t 
have the third coordinate.

Drawing with Grid and Snap
Your drawing area now has the proper settings, and it is zoomed to a convenient 
magnification. You’re ready to draw the first lines of the cabin:

 1. When the Command window displays the Type a command prompt, 
start the LINE command.

 2. From the Home tab ➢ Draw panel, click the Line button or type L↵.

 3. Type 8',8'↵ (2500,2500↵), or move the cursor until the Dynamic 
Input fields indicate the cursor is over the 8↵, 8↵ (2500, 2500) point.

 4. Click to define the starting point of the line.

 5. Hold the crosshair cursor above and to the right of the point you just 
picked.
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AutoCAD shows ghosted linear and angular dimensions that 
dynamically display the length and angle of the first line segment as 
the cursor moves, and a tool-tip window displays the current prompt 
for the LINE command (see Figure 3.11).

F I G u R E   3 . 1 1 :   One point picked on the grid

 6. Don’t click yet. Hold the crosshair cursor directly out to the right of 
the first point picked, and note how the linear dimension displays a 
distance in 6″ (50 mm) increments. The angular dimension should 
have an angle of 0.00, as shown in Figure 3.12.

F I G u R E   3 . 1 2 :   Setting the angle for the first line

 7. Continue moving the crosshair cursor left or right until the dashed 
linear dimension displays 28′ (8550).
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 8. At this point, click the left mouse button to draw the first line of the 
cabin wall (see Figure 3.13).

F I G u R E   3 . 1 3 :   The first line of the cabin wall is drawn.

 9. Move the crosshair cursor directly above the last point picked to a posi-
tion such that the dashed linear dimension displays 18′ (5490) and the 
dashed angular dimension displays 90.00 ,̊ and then pick that point.

 10. Move the crosshair cursor directly left of the last point picked until the 
dashed linear dimension displays 28′ (8550) and the dashed angular 
dimension displays 180.00 ,̊ and then pick that point (see Figure 3.14).

F I G u R E   3 . 1 4 :   Drawing the second and third wall lines
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 11. Type C↵ to close the box.
This tells AutoCAD to draw a line from the last point picked to the 

first point picked and, in effect, closes the box. AutoCAD then auto-
matically ends the LINE command (see Figure 3.15).

F I G u R E   3 . 1 5 :   The completed outside wall lines

This method for laying out building lines by using Snap And Grid and 
Dynamic Input is useful if the dimensions all conform to a convenient rounded-
off number, such as the nearest 6 inches. The key advantage to this method over 
just typing the relative coordinates, as you did with the box in Chapter 2, is that 
you avoid having to enter the numbers. You should, however, assess whether 
the layout you need to draw has characteristics that lend themselves to using 
Snap And Grid and Dynamic Input or whether typing the relative coordinates 
would be more efficient. As you get more comfortable with AutoCAD, you’ll see 
that this sort of question comes up often: which way is the most efficient? This 
happy dilemma is inevitable in an application with enough tools to give you 
many strategic choices. In Chapter 4, “Developing Drawing Strategies: Part 1,” 
and Chapter 5, “Developing Drawing Strategies: Part 2,” you’ll learn other tech-
niques for drawing rectangles.

taking a Closer Look at Dynamic Input
The kind of information shown in dynamic display is similar to what’s shown in 
the command-line interface, and the intent of this feature is to keep your eyes 
on the screen as much as possible. The specific information displayed depends—
as it does on the command line—on what you’re doing at the time. It’s con-
trolled by several settings that you access from the Dynamic Input tab within 
the Drafting Settings dialog box, shown in Figure 3.16.
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F I G u R E   3 . 1 6 :   The Dynamic Input tab of the Drafting Settings dialog box

This tab has four check boxes (two at the top, and two near the middle on the 
right) and three buttons to open three feature-specific Settings dialog boxes. To 
make the dynamic input conform to what is shown in this book, do the following: 

 1. Open the Drafting Settings dialog box by entering DS↵ at the com-
mand line, and then switch to the Dynamic Input tab.

 2. Make sure all four check boxes are selected.

 3. In the Pointer Input group, click the Settings button to open the 
Pointer Input Settings dialog box (see Figure 3.17).

F I G u R E   3 . 1 7 :   The Pointer Input Settings dialog box
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 4. In the Format group, the Polar Format and Relative Coordinates 
radio buttons should be selected. Click OK.

 5. In the Dimension Input group of the Drafting Settings dialog box, 
click the Settings button to open the Dimension Input Settings dia-
log box (see Figure 3.18).

F I G u R E   3 . 1 8 :   The Dimension Input Settings dialog box

 6. Make sure the Show 2 Dimension Input Fields At A Time radio button 
is selected, and then click OK.

 7. In the Dynamic Prompts group of the Drafting Settings dialog box, 
ensure that both Show Command Prompting And Command Input 
Near The Crosshairs and Show Additional Tips With Command 
Prompting are checked.

 8. Below the Dynamic Prompts group of the Drafting Settings dialog 
box, click the Drafting Tooltip Appearance button to open the Tooltip 
Appearance dialog box (see Figure 3.19).
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F I G u R E   3 . 1 9 :   The Tooltip Appearance dialog box

In the Apply To group at the bottom of the box, ensure that the 
Override OS Settings For All Drafting Tooltips radio button is 
selected. Vary the Colors, Size, and Transparency settings accord-
ing to your preference. (I used a setting of 0 for Size and 0% for 
Transparency.) Don’t worry about Layout Color for now. The Model 
Color you choose depends on whether your drawing area has a light 
or dark background. Experiment. When you’re finished, click OK.

 9. Click OK again to close the Drafting Settings dialog box.

If you decide to disable Dynamic Input, you can easily do so by clicking its 
button in the status bar so that it’s in unpushed mode (with a gray background).

Saving Your Work
Because today’s project teams are increasingly dispersed, AutoCAD provides sev-
eral options for saving your work. These options include saving your work to a 
physical disk such as your hard drive or a network drive, or to Autodesk’s secure 
cloud storage service named Autodesk 360.
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Although network drives are incredibly efficient for design teams that are 
colocated, it introduces challenges to teams that are geographically dispersed or 
lack such network infrastructure altogether. Autodesk 360 introduces an option 
for both scenarios and provides anywhere, anytime access to your drawings. 
Depending on your specific needs to share and exchange designs, you’ll likely 
find it worthwhile to employ the local and network drive structure in tandem 
with Autodesk 360 storage.

Saving Drawings to Your Hard Drive or 
network Drive
If your project team is at a single location, or you are working independently, 
you may choose to save your work to a physical disk drive. When you save an 
AutoCAD file for the first time by choosing Save, you can designate a name for 
the file and a folder in which to store it. I recommend that you create a special 
folder, called something like AutoCAD NER, for storing the files you’ll generate as 
you work your way through this book. This will keep them separate from project 
work already on your computer, and you’ll always know where to save or find a 
training drawing. To save your drawing, follow these steps:

 1. In AutoCAD, click the Save button on the Quick Access toolbar or choose 
Save from the Application menu. Because you haven’t named this file 
yet, the Save Drawing As dialog box opens, as shown in Figure 3.20.

F I G u R E   3 . 2 0 :   The Save Drawing As dialog box
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The Save button in the Quick Access toolbar, the Application 
menu ➢ Save option, and the Ctrl+S key combination actually 
invoke the QSAVE (Quick Save) command in AutoCAD. QSAVE asks 
for a filename only when the drawing has not yet been saved for the 
first time, after which it simply overwrites the existing file with-
out prompting. Entering the SAVE command at the command line 
(SAVE↵) always opens the Save Drawing As dialog box, where the file-
name and path are modified.

n o t E  The actual folders and files might be different on your computer.

 2. In the Save In drop-down list, designate the drive and folder where 
you want to save the drawing. If you’re saving it on the hard drive 
or server, navigate to the folder in which you want to place the new 
AutoCAD NER folder.

 3. Click the Create New Folder button near the top-right corner of the 
dialog box. The folder appears in the list of folders and is highlighted. 
It’s called New Folder, and a cursor flashes just to the right of the 
highlighting rectangle.

 4. Type AutoCAD NER↵ (or whatever name you want to give the new folder).

 5. Double-click the new folder to open it.

 6. In the File Name box, change the name to I03A-FPLAYO (M03A-FPLAYO). 
You’re not required to enter the .dwg extension.

n o t E  The filenames of the imperial (feet and inches) drawings for this book 
have an I prefix, and the metric drawing filenames have an M prefix. Drawings for indi-
vidual exercises are prefixed with the chapter number and are sequentially numbered. 
The final drawing in each chapter follows the National CAD Standard structure and is the 
file you should use to begin the succeeding chapter.

 7. Click Save. Notice that the AutoCAD title bar displays the new name 
of the file along with its path. It’s now safe to exit AutoCAD.

 8. If you want to shut down AutoCAD at this time, choose Application 
menu ➢ Exit AutoCAD or click the X button in the top-right corner of 
the AutoCAD window. Otherwise, keep your drawing up and read on.
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t I P  Each time you save, check your work against the online projec t f i les. 
Throughout the book, you will be directed to save your cabin project at major stages 
of its progress. Files corresponding to each stage are available on this book’s web page: 
www.sybex.com/go/autocad2015ner or www.thecadgeek.com.

t I P  You can also access a full range of additional resources including tutorials, vid-
eos, and more that are specific to the exercises in this book, at www.thecadgeek.com.

uS national CAD Standard (nCS)

Where applicable, this book employs the US National CAD Standard (NCS). Over the 
last several years, the popularity of this standard has grown immensely, and it is 
now in use by many of the top architectural and engineering firms in the United 
States. You’ll learn more about the NCS when you begin learning about layers, 
but for now we’ll stick to file naming. According to the NCS, our cabin drawing is 
considered a model drawing, whose standard file-naming structure is as follows:

PREFIX
Chapter number

DISCIPLINE
A - Architecture

MODEL NAME
LAYO - Layout

MODEL TYPE
FP - Floor Plan

-# # D M M N N N N

The discipline portion of an NCS filename must be one of the predefined single-
letter codes listed in Chapter 6, “Using Layers to Organize Your Drawing,” which 
explores the naming convention as applied to layer names.

The NCS has proven flexible enough to support firms both large and small. By 
working through this book, you’ll get a good introduction to how the NCS works. 
If, after reading this book, you would like to learn more about the NCS, visit 
http://nationalcadstandard.org.

From now on, when you’re directed to save the drawing, save it as X##A-FPLAYO, 
with X representing the unit of measure (I: imperial, M: metric), and ## indicating 
the two-digit number of the chapter (for example, 03 for Chapter 3). This way, 
you’ll know where in the book to look for review, if necessary. To save the current 
drawing under a different name, use the Save As command (Application menu ➢ 
Save As, or SAVEAS↵).
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Saving Drawings to Autodesk 360 Storage
If your project team is geographically dispersed, or if you find yourself fre-
quently working from the field, storing your files online can help simplify your 
project’s coordination. Autodesk 360 storage is a secure, cloud-based service 
that integrates with AutoCAD and enables you to make your designs available 
from anywhere.

Although Autodesk Subscription customers receive a premium allotment of 
storage space, a free version of Autodesk 360 is openly available to anyone by 
visiting http://360.autodesk.com. Using your Autodesk 360 account, you can 
save drawings to the cloud by doing the following:

 1. Click the Sign In button on the InfoCenter toolbar, and choose Sign 
In To Autodesk 360 from the menu that opens. The Autodesk - Sign In 
dialog box opens.

 2. From the Autodesk - Sign In dialog box, enter the username and pass-
word you used to register your account at http://360.autodesk.com, 
as shown in Figure 3.21. After you sign in, your username appears on 
the InfoCenter toolbar.

F I G u R E   3 . 2 1 :   Signing in to the Autodesk 360 service
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 3. Click the Autodesk 360 button in the InfoCenter and choose Online 
Options. This opens the Online tab of the Options dialog box.

 4. If you would like to keep an encrypted copy of the drawings you create 
on Autodesk 360, verify that the Enable Automatic Sync option shown 
in Figure 3.22 is checked.

F I G u R E   3 . 2 2 :   Enabling automatic syncing with Autodesk 360 cloud storage

When this option is enabled, a copy of your drawing will automati-
cally upload to your Autodesk 360 storage account the next time you 
save your drawing. Several collaboration options, such as AutoCAD® 
360, exist after a drawing is uploaded to the cloud.
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What Is AutoCAD 360?

As part of the Autodesk 360 offering, AutoCAD 360 is a free multiplatform design 
collaboration platform offering more than 100 of the tools found in the desktop 
version of AutoCAD covered in this book. Integrating with Autodesk 360 storage, 
AutoCAD 360 can open DWG™ and DXF™ files without installing any software. Simply 
browse to http://autocad360.com to begin viewing, editing, sharing, and 
collaborating on designs within your favorite web browser.

In addition to the web interface found at http://autocad360.com, mobile 
and desktop AutoCAD 360 clients exist for several platforms, including iOS (Apple 
iPhone and iPad), Android, and the OS X operating system.

understanding AutoCAD units
The following is a brief description of each of the linear and angular unit types 
that AutoCAD offers and how they are used. The example distance is 2′-6 1/2″. 
The example angle is 126˚35′10″.
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Exploring options for Linear units
The linear unit types that AutoCAD uses are as follows:

Architectural  This unit type uses feet and inches with fractions. You must use 
the foot sign (′): for example, 2′-6 1/2″. For this distance, enter 2'6-1/2 or 2'6.5. 
For the most part, these are the units that you’ll use in this book.

Decimal  This unit type uses decimal units that can represent any linear unit 
of measurement. You don’t use the foot sign, the inch sign, or fractions. This 
method is especially common in the civil engineering discipline, where decimal 
units are used, and 1 unit is equal to 1 foot. Therefore, for the distance 2′-6 1/2″, 
you would need to convert the inches (6.5 inches in this case) to the decimal 
equivalent of a foot (6.5 ÷ 12 = 0.5417). So in this case, you would enter 2.5417.

Let’s say you need to draw a line 10′-3″ long in a drawing where 1 unit is equal 
to 1 foot. You need to convert the inches to the decimal equivalent of a foot. So 
in this case, 3 ⁄ 12 = 0.25 and so you would enter 10.25.

Conversely, if each unit is equal to an inch, that same 2′-6 1/2″ line would be 
entered as 30.5 because (2 × 12) + 6 = 30 and 6 ⁄ 12 = 0.5.

Engineering  This unit is equivalent to Architectural units except that inches 
are displayed as decimals rather than fractions. For a distance of 2′-6 1/2″, enter 
2'6.5 or 2.5417'. In either method, the resulting distance is displayed as 2′-6.5″.

Fractional  These units are just like Architectural units except there is no use 
of feet. Everything is expressed in inches and fractions. If you enter 30-1/2 or 
30.5, the resulting distance displays as 30 1⁄2.

Scientific  This unit system is similar to the Decimal unit system except for 
the way in which distances are displayed. If you enter 3.05E+01, that is what is 
displayed. The notation always uses an expression that indicates a number from 
1 to 10 that is to be multiplied by a power of 10. In this case, the power is 1, so 
the notation means 3.05 n 10, or 30.5 in Decimal units.
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Exploring options for Angular units
The angular unit types that AutoCAD uses are as follows:

Decimal  This type uses 360˚ in a circle in decimal form, with no minutes and 
no seconds. All angles are expressed as decimal degrees. For example, an angle 
of 126˚35f10g is entered as 126.586 or 126d35f10g and displays as 126.5861. 
AutoCAD uses the letter d instead of the traditional degree symbol (˚).

Deg/Min/Sec  This is the traditional system for measuring angles. In AutoCAD 
notation, degrees are indicated by the lowercase d, the minutes use the tradi-
tional f, and the seconds use the traditional g. The use of this system is generally 
reserved for the civil engineering discipline. Most other users now use decimal 
angles instead and choose their preference for precision.

Grads  This unit is based on a circle being divided into 400 grads, so 90˚ 
equals 100 grads. One degree equals 1.11 grads, and 1 grad equals 0.90 degrees. 
AutoCAD uses g as the symbol for grads.

Radians  The radian is the angle from the center of a circle made by the radius 
of the circle being laid along the circumference of the circle.

One radian equals 57.3 ,̊ and 360˚ equals 6.28 radians, or 2> radians. AutoCAD 
uses r as the symbol for radians.

Surveyor  These units use bearings from the north and south directions 
toward the east or west direction and are expressed in degrees, minutes, and 
seconds. They’re discussed in Chapter 12. In this example, 126˚35′10″ translates 
to N 36d35′10″ W in bearings, or Surveyor’s units.

The tools covered in this chapter are your keys to starting a new draw-
ing from scratch and getting it ready for a specific project. The next chapter 
focuses on adding to the drawing, modifying the commands you learned as 
part of Chapter 2, and creating strategies for solving problems that occur in 
the development of a floor plan.
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Are You Experienced?
now you can…

✔✔ set up linear and angular units for a new drawing

✔✔ make	the	grid	visible	and	modify	its	coverage

✔✔ use the Zoom In and Zoom Out commands

✔✔ activate	Snap	mode	and	change	the	snap	and	grid	spacings

✔✔ use the Zoom All function to fit the grid on the drawing area

✔✔ draw	lines	by	using	the	Snap	And	Grid	and	Dynamic	Input	features

✔✔ create a new folder on your hard drive from within AutoCAD

✔✔ name and save your file
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CHAPtER 4

Developing Drawing 
Strategies: Part 1
Assuming that you have worked your way through the first three chapters, 
you have now successfully drawn a shape (Chapter 2, “Learning Basic Commands 
to Get Started”) as well as the outer wall lines of a cabin (Chapter 3, “Setting Up a 
Drawing”). From here, you’ll develop a floor plan for the cabin.

In this chapter, you’ll focus on gaining a feel for the strategy of drawing 
in the Autodesk® AutoCAD® program and on solving drawing problems that 
arise while laying out a floor plan. As you work your way through this chap-
ter, you’ll make the walls, cut doorway openings, and draw the doors. In the 
next chapter, you’ll add steps and two decks, and you’ll place fixtures and 
appliances in the bathroom and kitchen.

Each exercise in this chapter presents opportunities to practice using com-
mands you learned in earlier chapters and to discover a few new ones. Arguably, 
more important than knowing a large number of AutoCAD commands is the 
ability to take those commands and combine them to complete the design at 
hand. As you work through the exercises in this chapter and the next, I encour-
age you to focus less on knowing the commands themselves and more on how 
they are used to get you one step closer to a finished design. Admittedly, separat-
ing the two can be hard; however, developing a strong sense of strategic think-
ing now will undoubtedly make you a more efficient user.

In this chapter, you will learn to

▶▶ Make	interior	walls

▶▶ Zoom	in	on	an	area	by	using	various	zoom	tools

▶▶ Make	doors	and	swings

▶▶ Use	object	snaps

▶▶ Use the COPY and MIRROR commands
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Laying out the Walls
For most floor plans, the walls come first. As you begin to define the interior of 
your cabin further by adding a closet and bathroom, certain relationships can 
be established with lines that are already in your drawing. By recognizing these 
relationships, you won’t need to draw as many new lines as you might expect. 
In this chapter, I’ll show you how to build most of the new walls from the four 
exterior wall lines you drew in the previous chapter.

Take a moment to study the floor plan in Figure 4.1 to begin visualizing the 
many relationships that exist between the exterior wall boundary drawn in 
Chapter 3 (shown in bold) and the remaining linework that makes up the floor 
plan. One easily identified relationship is among the lines that create the exte-
rior wall definition. Most of the final exterior wall definition follows the outline 
drawn in Chapter 3. For this reason, the best strategy is to build on the existing 
linework by using a series of commands found on the Modify panel on the Home 
tab of the Ribbon.

Existing linework from Chapter 3

F I G u R E   4 . 1 :   The exterior wall boundary drawn in Chapter 3 overlaid onto the cabin floor plan

It’s possible to apply a similar strategy as both the bathroom and closet are 
considered. Both spaces share similar relationships with the exterior wall defi-
nitions adjacent to them. Because Modify commands allow new objects to be 
created from existing objects, these relationships are easily maintained as the 
spaces are defined.

After you build the four exterior wall lines, you’ll cut four openings in these 
walls (interior and exterior) for the doorways. 
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Creating Polylines from Existing objects
Exterior walls are slightly thicker than interior walls because they are stur-

dier, are load bearing, and have an additional layer or two of weather protection 
such as siding or stucco. Accounting for these properties, the standard thick-
ness for your exterior walls will be 6″ (150 mm). Using the tools you’ve already 
learned, you’ll apply the strategy outlined at the start of this chapter to offset 
the four existing wall lines to the inside, creating the exterior wall definition.

This section introduces the use of polylines as an alternative to the FILLET 
command. Whereas a line is a single, straight object with no measurable width, 
polylines are composed of several straight or curved segments that can also 
maintain a user-defined width. When a polyline is offset, all segments are offset 
equally, and the corners are left sharp without the need to use the FILLET com-
mand to clean them up. Any polyline can be disassembled into its component 
lines and arcs by using the EXPLODE command.

The JOIN command allows objects of different types to be joined into a poly-
line. By using JOIN, you can convert any combination of lines and arcs into a 
single polyline, as long as the endpoints of the various segments terminate in 
exactly the same location. Because polylines are treated as a single object, con-
verting the outermost perimeter into a single polyline will automate much of 
the cleanup as you continue creating the floor plan shown in Figure 4.2.

F I G u R E   4 . 2 :   The wall dimensions

◀

Most of the commands 
used in the follow-
ing exercise were 
presented in Chapters 
2 and 3. If you need a 
refresher, glance back 
at those chapters.
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In this exercise, you will create a polyline from the individual line segments 
composing the outside wall:

 1. With AutoCAD running, choose Application menu ➢ Open ➢ Drawing.
The Select File dialog box opens, where you can navigate to the 

I03A-FPLAYO.dwg (M03A-FPLAYO.dwg) file you saved at the end of 
Chapter 3. Click Open to display the cabin drawing shown in Figure 4.3.

F I G u R E   4 . 3 :   The cabin as you left it in Chapter 3

 2. Click the Grid Display and Snap Mode icons on the status bar to turn 
them off (the blue glow disappears). Alternatively, you can press F7 to 
turn off Grid Display and F9 to turn off Snap mode.

 3. Expand the Modify Ribbon panel on the Home tab and click Join, as 
shown in Figure 4.4. Command-line users can type J↵ to start the 
JOIN command.

F I G u R E   4 . 4 :   Starting the JOIN command
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 4. Select one of the exterior wall lines.
The selected line glows blue, and the command line prompts you 

to select objects to join to the line you just selected, as shown in 
Figure 4.5.

F I G u R E   4 . 5 :   The command line after choosing an object to join

 5. Select the remaining three exterior wall lines, and press the ↵ key to 
accept the selection set.

After accepting the selection set, the command line confirms the 
Join action and reads 4 objects converted to 1 polyline, as 
shown in Figure 4.6.

F I G u R E   4 . 6 :   The command-line interface after converting the lines into a 
single polyline
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 6. Select one segment of the polyline that forms the perimeter of the 
box in the drawing area.

All four polyline segments are selected (blue glow), indicating that 
they exist as a single object, and blue boxes appear at the corners along 
with blue rectangles at the midpoint of each segment. The blue boxes 
and rectangles, called grips, appear because you selected the object 
outside a command. Grips are not exclusive to polylines. (You’ll learn 
more about them in Chapter 8, “Controlling Text in a Drawing.”)

 7. Choose Application menu ➢ Save As ➢ AutoCAD Drawing and name 
this drawing I04-01-JoinLines.dwg (M04-01-JoinLines.dwg).

Creating and Editing Polylines
Polylines are composed of segments, which may be straight or curved lines, and 
vertices that terminate the segments. Each segment must have a vertex at each 
end, but several segments can share a single vertex. The perimeter that you 
drew follows the major length and width dimensions of the cabin but doesn’t 
account for the small pop-out on the south side of the structure. In this exer-
cise, you will add the pop-out, trim the original polyline, and then join the two 
polylines into a single entity:

 1. If I04-01-JoinLines.dwg (M04-01-JoinLines.dwg) is not already 
open, click the Open button on the Quick Access toolbar.

 2. Click the Polyline button in the Draw panel on the Home tab of the 
Ribbon to start the polyline (PLINE) command. Alternatively, you can 
type PL↵ at the command line.

 3. At the Specify start point: prompt, type 16',8'↵ (4850,2500↵).
A rubber-banding line, similar to the one you saw when you used 

the LINE command, is attached to the point you designated and to 
the cursor.

 4. Type the following:

0,-2'↵ (0,-610↵)

6',0↵ (1830,0↵)

0,2'↵↵ (0,610↵↵)
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Since you did not prefix the coordinates with a #, AutoCAD inter-
prets the input as relative coordinates. Your screen should look like 
Figure 4.7.

F I G u R E   4 . 7 :   The pop-out added to the cabin

 5. Start the TRIM command.

 6. At the Select Objects or <select all>: prompt, pick the pop-out 
that you just drew and press ↵.

All segments of the pop-out glow blue to indicate that the entire 
polyline is designated as a cutting edge.

 7. Trim the pop-out by selecting it as the cutting edge. When prompted 
to Select object to trim or shift-select to extend or, select 
the long horizontal line of the cabin between the two vertical lines 
that define the pop-out, as shown in Figure 4.8.

F I G u R E   4 . 8 :   Selecting the polyline segment to trim away
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 8. Press ↵ to end the TRIM command.

 9. From the expanded Modify panel on the Home tab, choose Join and 
then pick either of the two polylines.

 10. Pick the other polyline and press ↵.
Your drawing now consists of a single polyline made up of eight 

segments, as shown in Figure 4.9.

F I G u R E   4 . 9 :   The polyline after trimming the original and then joining the 
remaining entities

 11. Save your drawing as I04-02-CreatePolylines.dwg (M04-02-
CreatePolylines.dwg) by choosing Application menu ➢ Save As ➢ 
AutoCAD Drawing.

Creating the Exterior Wall Lines
Next you will use the OFFSET command to create all the interior lines for the 
exterior walls at one time:

 1. If I04-02-CreatePolylines.dwg (M04-02-CreatePolylines.dwg) is 
not already open, click the Open button on the Quick Access toolbar.
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 2. Start the OFFSET command by clicking the Offset button on the 
Modify panel. Command-line users can type O↵ to start the OFFSET 
command.

 3. At the Specify offset distance or: prompt, type 6↵ (150↵).

n o t E  You don’t have to enter the inch sign (″), but you’re required to enter the 
foot sign (′) when appropriate.

 4. At the Select object to offset or: prompt, select the polyline.

 5. Click in a blank area inside the cabin’s perimeter. All segments of the 
polyline are offset 6″ (150 mm) to the inside (see Figure 4.10).

F I G u R E   4 . 1 0 :   All line segments are now offset 6″ (150 mm) to the inside.

 6. The OFFSET command is still running; press ↵ to terminate it.
As you can see, there is no need to fillet the corners, and using 

polylines can reduce the number of steps and picks required to draw 
the inside lines. We’ll diverge from the cabin exercise briefly to exam-
ine the capabilities of the FILLET command when used in conjunc-
tion with polylines.
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 7. Start the FILLET command by clicking the Fillet button in the Modify 
panel on the Home tab.

 8. Click Radius, or type R, at the command line to select the Radius 
option; then set the radius to 12″ (3600 mm).

 9. Select any two polyline segments that share a corner of the inner box.
The two segments are shortened, and a curved segment with a 12″ 

radius is inserted. The polyline now has nine contiguous segments 
(see Figure 4.11). The FILLET command automatically ends after 
each fillet.

F I G u R E   4 . 1 1 :   The first corner is filleted.

 10. Press ↵ or the spacebar to restart the FILLET command.

 11. Type P↵, or select Polyline at the command line to instruct AutoCAD 
that the fillet is to be performed on all intersections of a polyline.

 12. At the Select 2D polyline: prompt, select the inner box. All cor-
ners are now filleted (see Figure 4.12).

▶

You can restart the 
most recently used 
command by pressing 
the spacebar or ↵  
at the command 
prompt or by right-
clicking and choosing 
the Repeat option from 
the context menu.
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F I G u R E   4 . 1 2 :   The polyline’s corners are filleted.

You can see how the FILLET command, when used with a polyline, 
can save time.

 13. You don’t want the objects to remain as polylines for this project, so 
click the Undo icon on the Quick Access toolbar, or type U↵, until all 
of the filleted edges are square again.

t I P  Selecting the down arrow next to the Undo icon on the 
Quick Access toolbar will display a list of recently executed com-
mands so that you can undo multiple commands at once.

 14. Click the Explode icon on the Home tab ➢ Modify panel, or type X↵ 
to start the EXPLODE command. ◀

You can also use the 
Windows standard 
Ctrl+Z keyboard 
combination to undo 
AutoCAD actions.
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 15. Select both of the polylines and then press the ↵ key. The two poly-
lines are now 16 separate line objects.

You will be using the OFFSET command to create the interior walls 
from the lines that make up the exterior walls. Exploding the poly-
lines into individual line objects allows you to offset single, straight 
objects rather than the closed polylines that would require trimming 
to clean up.

 16. Save your drawing as I04-03-ExteriorWalls.dwg (M04-03-
ExteriorWalls.dwg) by choosing Application menu ➢ Save As ➢ 
AutoCAD Drawing.

Creating the Interior Walls
Because the interior walls of your cabin are not load bearing, they can be a little 
thinner than the exterior walls. The standard thickness for your interior walls will 
be 4″ (100 mm). Using the strategy developed at the beginning of this chapter, you 
will create the cabin’s interior wall lines by offsetting the exterior wall lines:

 1. Make sure the drawing I04-03-ExteriorWalls.dwg (M04-03-
ExteriorWalls.dwg) is open; if it’s not, click the Open button on 
the Quick Access toolbar.

 2. Start the OFFSET command.

 3. At the Specify Offset distance or: prompt, type 7'8↵ (2350↵). 
Leave no space between the foot sign (′) and the 8.

n o t E  AutoCAD requires that you enter a distance containing feet and inches 
in a particular format: no space between the foot sign (′) and the inches value, and a 
hyphen (-) between the inches and a fraction. For example, if you’re entering a distance 
of 6′-4 3 ⁄4″, you enter 6′4-3 ⁄4. The measurement is displayed in the normal way, 6′-4 
3 ⁄4″, but you must enter it in the format that has no spaces because the spacebar acts the 
same as ↵ in most cases.
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 4. Click the inside line of the left exterior wall (see Figure 4.13).

F I G u R E   4 . 1 3 :   Selecting the wall line to offset

 5. Click in a blank area to the right of the selected line. The line is offset 
7′-8″ (2250 mm) to the right.

 6. Press ↵ twice, or press the spacebar twice.
The OFFSET command is terminated and then restarted, and you 

can reset the offset distance.

t I P  In the OFFSET command, your opportunity to change the offset distance 
comes right after you start the command. So, if the OFFSET command is already run-
ning and you need to change the offset distance, you must stop and then restart the 
command. To do so, press ↵ or the spacebar twice.
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 7. Type 4↵ (100↵) to reset the offset distance to 4″ (100 mm).

 8. Click the new line that was just offset, and then click in a blank area 
to the right of that line. You have created a vertical interior wall (see 
Figure 4.14).

F I G u R E   4 . 1 4 :   The first interior wall

 9. Press ↵ twice to stop and restart the OFFSET command.

 10. Type 6.5'↵ (1980↵) to set the distance for offsetting the next wall.

n o t E  With Architectural units set, you can still enter distances in decimal form 
for feet and inches, and AutoCAD will translate them into their appropriate form. For exam-
ple, you can enter 6′-6″ as 6.5', and you can enter 4 1⁄ 2″ as 4.5 without the inch sign.
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 11. Pick a point on the inside lower-left exterior wall line (see 
Figure 4.15).

F I G u R E   4 . 1 5 :   Selecting another wall line to offset

 12. Click in a blank area above the selected line. The inside exterior wall 
line is offset to make a new interior wall line.

 13. Press the spacebar twice to stop and restart the OFFSET command.

 14. Type 4↵ (100↵). Click the new line, and click again above it. A second 
wall line is made, and you now have two interior walls.

 15. Press the spacebar to end the OFFSET command.

 16. Save your drawing as I04-04-InteriorWalls.dwg  
(M04-04-InteriorWalls.dwg).

These interior wall lines form the boundary of the bathroom. You need to 
clean up their intersections with each other and with the exterior walls. If you 
take the time to do this properly, it will be easier to make changes in the future. 
Refer to Figure 4.2 earlier in this chapter to see where we’re headed.
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Cleaning up Wall Lines

Earlier in the book, you used the FILLET command to clean up the corners of 
intersecting lines. You can use that command again to clean up some of the 
interior walls, but you’ll have to use the TRIM command to do the rest of them. 
You’ll see why as you progress through the next set of steps:

 1. Make sure I04-04-InteriorWalls.dwg (M04-04-InteriorWalls.dwg) 
is open.

 2. If you have a mouse with a scroll wheel, double-click the scroll wheel 
to zoom to the extents of your drawing. Alternatively, you can use the 
Zoom Extents icon found on the Navigation bar or type Z↵ E↵ at the 
command line.

Performing a Zoom Extents will make it easier to pick the wall 
lines by making the drawing larger on the screen.

 3. Expand the Zoom option found on the Navigation bar (Figure 4.16) 
and click Zoom Scale.

F I G u R E   4 . 1 6 :   Selecting the Zoom Scale option from the navigation bar

 4. When the Enter a scale factor prompt appears, type 0.75x↵. The 
drawing zooms out a bit.

You’ve just used two options of the ZOOM command. First, you used 
Zoom Extents to display all the objects in your drawing. You then 
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zoomed to a scale (0.75) to make the drawing 75 percent of the size it 
was after using Zoom Extents. This is a change in magnification on the 
view only; the cabin is still 28′ (8550 mm) long and 18′ (5490 mm) wide.

 5. Start the FILLET command, set the radius to 12, and then press ↵ to 
exit the FILLET command.

 6. Restart the FILLET command. Press and hold the Shift key as you 
click the two interior wall lines shown at the top of Figure 4.17. 
The lines are filleted, and the results will look like the bottom of 
Figure 4.17.

Pick these
lines to �llet.

F I G u R E   4 . 1 7 :   Selecting the first two lines to fillet (top) and the result of the 
fillet (bottom)
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n o t E  Pressing and holding the Shif t key as you selec t objec ts with the 
FILLET command temporarily overrides the current radius and sets it to a value of 0. In 
the previous example, the Fillet radius value was set to 12; however, because the Shift 
key was pressed, the command worked as if you had set the radius to 0.

 7. Start the TRIM command, and press ↵ to skip the Select cutting 
edges... Select objects: prompt. This makes every edge in the 
drawing a cutting edge.

Select the vertical line shown at the top of Figure 4.18. The results 
are shown at the bottom of Figure 4.18.

F I G u R E   4 . 1 8 :   Selecting the second two lines to fillet (top) and the result of 
the second fillet (bottom)
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 8. Save your drawing as I04-05-WallCleanUp.dwg (M04-05-
WallCleanUp.dwg).

The two new interior walls are now the correct length, but you’ll have to clean 
up the areas where they form T-intersections with the exterior walls. The FILLET 
command won’t work in T-intersections because too much of one of the wall 
lines gets deleted. You need to use the TRIM command in T-intersection cases. 
The FILLET command does a specific kind of trim and is easy and quick to exe-
cute, but its uses are limited (for the most part) to single intersections between 
two lines or multiple intersections on a polyline.

using the ZOOM  Command

To do this trim efficiently, you need a closer view of the T-intersections. Use the 
ZOOM command to get a better look:

 1. Make sure I04-05-WallCleanUp.dwg (M04-05-WallCleanUp.dwg)  
is open.

 2. Type Z↵. Then move the crosshair cursor to a point slightly below 
and to the left of the upper T-intersection (see Figure 4.19), and click 
in a blank area outside the floor plan.

F I G u R E   4 . 1 9 :   Positioning the cursor for the first click of the ZOOM command

◀

Here’s the best rule 
for choosing between 
FILLET and TRIM: 
If you need to clean up 
a single intersection 
between two lines, 
use the FILLET 
command. For other 
cases, use the TRIM 
command.
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 3. Move the cursor up and to the right, and notice that a rectangle with 
solid lines is being drawn. Keep moving the cursor up and to the 
right until the rectangle encloses the upper T-intersection (see the 
top of Figure 4.20).

F I G u R E   4 . 2 0 :   Using the Zoom Window option: positioning the rectangle 
(top) and the new view after the ZOOM command (bottom)

When the rectangle fully encloses the T-intersection, click again. 
The view changes to a closer view of the intersection of the interior 
and exterior walls (see the bottom of Figure 4.20).
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The rectangle you’ve just specified is called a zoom window. The 
area of the drawing enclosed by the zoom window becomes the view 
on the screen. This is one of several zoom options for changing the 
magnification of the view. Other zoom options are introduced later 
in this chapter and throughout the book.

 4. In the Home tab ➢ Modify panel, click the Extend button.
In the command-line interface, notice the second and third lines of 

text. You’re being prompted to select boundary edges (objects to use 
as limits for the lines you want to extend/trim).

 5. Select the two horizontal interior wall lines, and press the spacebar or ↵. 
The prompt changes and asks you to select the objects to be extended.

 6. Press and hold the Shift key while you select the inside exterior wall 
line at the T-intersection that is between the two intersections with 
the interior wall lines that you have just picked as boundary edges 
(see the top of Figure 4.21).

F I G u R E   4 . 2 1 :   Selecting a line to be trimmed (top) and the result of the 
EXTEND command used in conjunction with the Shift key (bottom)

◀

When you start the 
ZOOM command by 
typing Z↵ and then 
picking a point on the 
screen, a zoom window 
begins.
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The exterior wall line is trimmed at the T-intersection (see the 
bottom image of Figure 4.21). Press the spacebar to end the EXTEND 
command.

n o t E  As you’ve just seen with the FILLET command, pressing and holding 
the Shift key temporarily overrides the normal functionality of a command. For the 
FILLET command, the radius is temporarily set to 0. When the Shift key is used with 
the EXTEND command, it temporarily functions like the TRIM command. Conversely, 
when used with the TRIM command, it functions like the EXTEND command.

 7. Return to a view of the whole drawing by typing Z↵ and then P↵.
This is the ZOOM command’s Previous option, which restores the 

view that was active before the last use of the ZOOM command (see 
Figure 4.22). This command is also available from the Zoom flyout 
on the Navigation bar.

F I G u R E   4 . 2 2 :   The result of the Zoom Previous command

Repeat the procedure to trim the lower T-intersection. Follow these steps:

 1. Type Z↵, and click two points to make a rectangular zoom window 
around the intersection.
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 2. Start the TRIM command, select the interior walls as cutting edges, 
and press the spacebar.

 3. Select the inside exterior wall line between the cutting edges.

 4. Press the spacebar or ↵ to end the TRIM command.

 5. Zoom Previous by typing Z↵P↵. Figure 4.23 shows the results.

F I G u R E   4 . 2 3 :   The second trim is completed.

 6. Save your drawing as I04-06-ZoomCommand.dwg  
(M04-06-ZoomCommand.dwg).

You need to create one more set of interior walls to represent the closet in the 
upper-right corner of the cabin.

Finishing the Interior Walls

You’ll use the same method to create the closet walls that you used to make the 
first two interior walls. Briefly, this is how it’s done:

 1. Make sure I04-06-ZoomCommand.dwg (M04-06-ZoomCommand.dwg) is open.
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 2. Offset the inside line of the upper exterior wall 2′-6″ (762 mm) down-
ward; then offset this new line 4″ (100 mm) downward (see Figure 4.24).

F I G u R E   4 . 2 4 :   Offsetting the lines for the first wall

 3. Offset the inside line of the right exterior wall 4′-8″ (1420 mm) 
to the left; then offset this new line 4″ (100 mm) to the left (see 
Figure 4.25).

F I G u R E   4 . 2 5 :   Offsetting the lines for the second wall
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 4. Use a zoom window to zoom in to the closet area.

t I P  Make a zoom window just large enough to enclose the closet. The resulting 
view should be large enough to allow you to fillet the corners and trim the T-intersections 
without zooming again.

 5. Use the FILLET command to clean up the interior and exterior wall 
line intersections, as shown in Figure 4.26.

F I G u R E   4 . 2 6 :   Fillet the two corners.

 6. Use the TRIM command to trim away the short portions of the inter-
secting wall lines between the two new interior walls.

This can be accomplished with one use of the TRIM command. 
After you select all four of the new wall lines as cutting edges, you 
can trim both lines that run across the ends of the selected lines to 
those same cutting edges.
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 7. Use Zoom Previous (ZOOM↵P↵) to restore the previous view.
The results should look like Figure 4.27.

F I G u R E   4 . 2 7 :   The completed interior walls

 8. Save your drawing as I04-07-FinishInteriorWalls.dwg (M04-07-
FinishInteriorWalls.dwg).

You used OFFSET, FILLET, TRIM, and a couple of zooms to create the interior 
walls. By combining these commands, you were able to build the interior walls 
from the existing exterior wall definition—harnessing the relationship between 
both the new and existing walls. The next task is to create four doorway open-
ings in the interior and exterior walls. A similar strategy, employing these same 
commands, will be used to complete this task.

Cutting openings in the Walls
Of the four doorway openings needed, two are on interior walls and two are on 
exterior walls (see Figure 4.28). Two of the openings are for swinging doors, one 
is for a sliding glass door, and one is for a set of bifold doors. You won’t be doing 
the hatchings and dimensions shown in the figure—those features will be cov-
ered in future chapters.
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F I G u R E   4 . 2 8 :   The drawing with doorway openings

The procedure used to make each doorway opening is the same one that you 
used to create the opening for the box in Chapter 2. First you establish the 
location of the jambs, or sides, of an opening. After the location of one jamb is 
located, the line defining that side is offset by the width of the door opening. 
When the jambs are established, you’ll trim away the wall lines between the 
edges. The commands used in this exercise are OFFSET, EXTEND, and TRIM. You’ll 
make openings for the 3′-0″ (915 mm) exterior doorway first.

Creating the 3′-0″  (915 mm) Exterior opening

This opening is on the back wall of the cabin and has one side set in 7′-10″ 
(2388 mm) from the outside corner:

 1. Make sure I04-07-FinishInteriorWalls.dwg (M04-07-
FinishInteriorWalls.dwg) is open.

 2. Start the OFFSET command and then type 7'10↵ (2388↵) to set the 
distance to 7′-10″ (2388 mm).

 3. Click the lower outside line indicated in Figure 4.29 and then click in 
a blank area above the line you selected.
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F I G u R E   4 . 2 9 :   Selecting the line to offset

You have to offset one line at a time because of the way the OFFSET 
command works.

 4. End and restart the OFFSET command by pressing the spacebar or ↵ 
twice; then type 3'↵ (915↵) to set a new offset distance, and offset 
the new line upward (see Figure 4.30).

F I G u R E   4 . 3 0 :   The offset line for the 3′-0″ (915 mm) opening

 5. Start the TRIM command, and press ↵ to skip the cutting edges prompt.
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 6. When you see the prompt Select object to trim, enter F↵ or select 
Fence from the command line.

 7. Draw a fence line as shown at the top of Figure 4.31. The result 
should look like the bottom of Figure 4.31.

F I G u R E   4 . 3 1 :   Using the Trim Fence option to trim away the unneeded lines

 8. Save your drawing as I04-08-3ftExterior.dwg (M04-08-
915mmExterior.dwg).
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Creating the 7 ′-0″  (2134 mm) opening

Take another look at Figure 4.28, and notice that the opening on the right side 
of the cabin has one jamb set in 4′-6″ (1372 mm) from the outside corner. This 
opening is for the sliding glass door.

You’ve done this procedure before, so here’s a quick summary of the steps:

 1. Make sure I04-08-3ftExterior.dwg (M04-08-915mmExterior.dwg) 
is open.

 2. Offset the lower exterior wall line 4′-6″ (1372 mm).

 3. Offset the new line 7′-0″ (2134 mm).

 4. Use the Trim Fence option to clean up the 3′-0″ opening to complete 
the opening. Your cabin should look like Figure 4.32.

F I G u R E   4 . 3 2 :   The cabin with the 7′-0″ (2134 mm) sliding door opening

 5. Save your drawing as I04-09-7ftExterior.dwg (M04-09-
2134mmExterior.dwg).
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Creating the 2′-6″  (762 mm) Interior opening

The 2′-6″ (762 mm) opening to the bathroom starts 30″ (762 mm) from the 
inside of the left exterior wall. You can’t simply offset the wall and trim the 
excess because the offset lines would not cross both the interior wall lines. 
Instead you will use the EXTEND command exactly as you used it in Chapter 2:

 1. Make sure I04-09-7ftExterior.dwg (M04-09-2134mmExterior.dwg) 
is open.

 2. Start the OFFSET command and offset the interior line of the lower-
left exterior wall 2′-6″ (762 mm) to the right. Then offset the new line 
another 2′-6″ (762 mm) to the right.

 3. Start the EXTEND command and then press the spacebar or ↵ to make 
every edge in the drawing a boundary edge.

t I P  If you start a new command by entering letters on the keyboard, you must 
first make sure that the previous command has ended by pressing the Esc key at least 
twice. On the other hand, if you start a new command by clicking its icon on the Ribbon, 
it doesn’t matter whether the previous command is still running. AutoCAD will cancel it.

 4. Click the two jamb lines to extend them. Be sure to pick points on 
the lines that are near the ends that you want to extend, as shown in 
Figure 4.33, or the lines will be extended in the opposite direction.

Pick here to extend the lines
to the boundar y edge.

F I G u R E   4 . 3 3 :   The lines after being extended through the bathroom walls

The lines are extended through the interior walls to make the 
jambs (see Figure 4.33).
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Keeping the EXTEND command active, you’ll use the Shift key to 
trim away the excess lines and complete the openings. You’ll do this 
by creating two crossing windows—first to trim the excess part of 
the jamb lines and then the wall lines between the jamb lines.

 5. With the EXTEND command still active, press and hold the Shift key. 
Keeping it pressed, select a point to the right side of the bathroom 
and then another to the left, as shown in Figure 4.34.

F I G u R E   4 . 3 4 :   Using a crossing window in conjunction with the Shift override 
within the EXTEND command to trim lines

 6. Repeat the same process you used in the previous steps. With the 
EXTEND command still active, press and hold the Shift key to create a 
crossing window through the wall, as shown in Figure 4.35. Press ↵ 
to exit the EXTEND command.
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F I G u R E   4 . 3 5 :   Trimming the wall opening by using a Shift key override within 
the EXTEND command

 7. Save your drawing as I04-10-30inInterior.dwg (M04-10-
762mmInterior.dwg).

Your cabin should appear as shown in Figure 4.36.

F I G u R E   4 . 3 6 :   The cabin after creating the opening for the bathroom door

You can construct the closet opening by using the same procedure.
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Creating the Closet opening

This doorway is 4′-0″ (1220 mm) wide and has one jamb set in 4″ (100 mm) 
from the inside of the exterior wall. Figure 4.37 shows the three stages of fabri-
cating this opening:

F I G u R E   4 . 3 7 :   Creating the interior openings

▶▶ Stage 1 (top left): Locate the jamb lines by using the OFFSET command.

▶▶ Stage 2 (top right): Form the opening by using the EXTEND command.

▶▶ Stage 3 (bottom): Complete the opening by using the TRIM command.

To create the closet opening:

 1. Make sure I04-10-30inInterior.dwg (M04-10-762mmInterior.dwg) 
is open.

 2. Use any combination of the OFFSET, TRIM, and EXTEND commands to 
create the 4′-0″ (1220 mm) closet opening. 

Refer to the previous section on making openings for step-by-step 
instructions.

 3. This completes the openings. Save your drawing as I04-11-
ClosetOpening.dwg (M04-11-ClosetOpening.dwg). The results 
should look like Figure 4.38.
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F I G u R E   4 . 3 8 :   The completed doorway openings

As you gain more control over the commands you used here, you’ll be able 
to anticipate how much of a task can be accomplished with each use of a com-
mand. Each opening required offsetting, extending, and trimming. It’s possible 
to do all the openings by using each command only once. In this way, you do all 
the offsetting, then all the extending, and finally all the trimming. In cutting 
these openings, however, the arrangement of the offset lines determined how 
many cycles of the TRIM command were the most efficient to use. If lines being 
trimmed and used as cutting edges cross each other, the trimming becomes 
complicated. For these four openings, the most efficient procedure is to use 
each command twice. In Chapter 8, you’ll get a chance to work with more com-
plex, multiple trims when you draw the elevations.

Now that the openings are complete, you can place doors and door swings 
in their appropriate doorways. In doing this, you’ll be introduced to two new 
objects and a few new commands, and you’ll have an opportunity to use the 
OFFSET and TRIM commands in new, strategic ways.
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What to Do When You Make a Mistake

When you’re offsetting, trimming, and extending lines, it’s easy to pick the wrong 
line, especially in a congested drawing. Here are some tips on how to correct these 
errors and get back on track:

▶▶ You can always cancel any command by pressing the Esc key until you see 
the Type a command prompt in the command-line interface. Then click 
the Undo button on the Quick Access toolbar to undo the results of the 
last command. If you undo too many commands, click the Redo button. 
You can click it more than once to redo several undone commands. Redos 
must be performed immediately following an undo.

▶▶ Errors possible with the OFFSET command include setting the wrong 
distance, picking the wrong line to offset, and picking the wrong side to 
offset toward. If the distance is correct, you can continue offsetting, end 
the command when you have the results you want, and then erase the lines 
that were offset wrong. Otherwise, press Esc and undo your previous offset.

▶▶ Errors made with the TRIM and EXTEND commands can sometimes be 
corrected on the fly; you don’t have to end the command, because each 
of these commands has an Undo option. If you pick a line and it doesn’t 
trim or extend the correct way, you can undo that last action without 
stopping the command and then continue trimming or extending. You 
can activate the Undo option used while the command is running in two 
ways: type U↵, or right-click and choose Undo from the context menu. 
Either of these actions undoes the last trim or extend, and you can try 
again without having to restart the command. Each time you activate the 
Undo option from within the command, another trim or extend is undone.

▶▶ The LINE command has the same Undo option as the TRIM and EXTEND 
commands. You can undo the last segment drawn (or the last several seg-
ments) and redraw them without stopping the command.

Creating Doors
In a floor plan, a rectangle or a line for the door and an arc showing the path of 
the door swing usually indicates a pivot door. The door’s position varies, but it’s 
most often shown at 90º from the closed position (see Figure 4.39). The best rule 
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I have come across is to display the door in such a way that others working with 
your floor plan will be able to see how far, and in what direction, the door will 
swing open.

F I G u R E   4 . 3 9 :   Possible ways to illustrate pivot doors

The cabin has four openings. Two of them need swinging doors, which open 90º. 
The main entry is a sliding glass door, and the closet is accessed by a pair of bifold 
doors. Drawing each type of door will require a different approach.

Drawing Swinging Doors
The swinging doors are of two widths: 3′ (915 mm) for exterior and 2′-6″ 
(762 mm) for interior (refer to Figure 4.28 earlier in this chapter). In general, 
doorway openings leading to the outside are wider than interior doors, with 
bathroom and bedroom doors usually being the narrowest. For the cabin, 
you’ll use two sizes of swinging doors. If multiple doors of the same width 
existed in this design, you could draw one door of each size and then copy 
them to the other openings as required.

To accomplish this, we’ll start with the back door (on the left side of the floor 
plan). The only difference between the back door and the bathroom door is size, 
so you’ll learn how to copy and modify the back door, sizing it to fit the opening 
for the bathroom. It’s a step that far too many AutoCAD users overlook, but tak-
ing a moment to develop a basic plan such as this one is certain to help you bet-
ter understand what you’re drawing while making you a more productive user.

Now that we have a plan, let’s get started drawing some doors:

 1. Make sure I04-11-ClosetOpening.dwg (M04-11-ClosetOpening.dwg) 
is open.

 2. Check the status bar at the bottom of the screen, and verify that 
Dynamic Input is enabled (a blue background).

 3. Turn off the remaining drawing aids (buttons) in the status bar.

 4. Right-click the Object Snap button on the status bar, and choose 
Object Snap Settings from the context menu.
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This opens the Drafting Settings dialog box, and the Object Snap 
tab is activated (Figure 4.40).

F I G u R E   4 . 4 0 :   The Object Snap tab of the Drafting Settings dialog box

 5. On the Object Snap tab of the Drafting Settings dialog box, click the 
Clear All button on the right and then click OK.

This step isn’t essential, as long as the Object Snap button is 
turned off, but it’s best to be sure in this case. Object snaps are cov-
ered in depth in Chapter 5, “Developing Drawing Strategies: Part 2,” 
and are used throughout the remainder of the book.

 6. Launch the Zoom Window tool from the Zoom drop-down menu 
found on the View tab ➢ Navigate 2D panel. Alternatively, you can 
type Z↵ at the command line or use the Zoom button.

 7. Pick two points to form a window around the back doorway opening, 
as shown in Figure 4.41 (top).
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F I G u R E   4 . 4 1 :   Forming a zoom window at the back door opening (top), and 
the result (bottom)

The view changes, and you now have a close-up view of the open-
ing (see Figure 4.41, bottom). You’ll draw the door in a closed posi-
tion and then rotate it open.
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 8. To begin drawing the door, use the Rectangle (RECTANG) command 
from the Home tab ➢ Draw panel ➢ Rectangle tool.

Notice the Type a command prompt in the command-line interface. 
Several options are in brackets, but the option Specify first cor-
ner point (before the brackets) is the default, and it is the one you 
want. You can also expose these options (see Figure 4.42) at the cur-
sor by pressing the down arrow on the main keyboard (not the down 
arrow on the numeric keypad).

F I G u R E   4 . 4 2 :   The Rectangle (RECTANG) command options exposed at the 
cursor

You form the rectangle in the same way that you form the zoom 
window—by picking two points to represent opposite corners of the 
rectangle. In its closed position, the door will fit exactly between the 
jambs, with its two right corners coinciding with the rightmost end-
points of the jambs. To make the first corner of the rectangle coin-
cide exactly with the upper endpoint of the right jamb, you’ll use an 
object snap to assist you.

▶

You can also start the 
Rectangle (RECTANG) 
command by typing 
REC↵ at the Type 
a command prompt.
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Object snaps (or osnaps) allow you to pick specific points on 
objects such as endpoints, midpoints, the center of a circle, and so 
on. When the Osnap button is active, the cursor will snap to any of 
the options selected in the Object Snap tab of the Drafting Settings 
dialog box. These are called running osnaps, and they should be dis-
abled from the status bar at the moment.

 9. Type END↵ to specify the Endpoint osnap manually.
Manually specifying an osnap by entering its name at the com-

mand line will override any running osnaps that may be active. For 
one pick, your cursor will snap to the nearest endpoint of any line, 
arc, or polyline that you select and ignore any running osnaps such 
as Midpoint.

 10. Move the cursor near the right side of the upper jamb line.
When the cursor gets very close to a line, a colored square, called 

a marker, appears at the nearest endpoint along with a tool tip that 
indicates which osnap is active, as shown in Figure 4.43. This shows 
you which endpoint in the drawing is closest to the position of the 
crosshair cursor at that moment.

F I G u R E   4 . 4 3 :   The Endpoint osnap marker

 11. Move the cursor until the square is positioned on the right end of the 
upper jamb line as shown in Figure 4.43, and then click that point.

The first corner of the rectangle now is located at that point. Move 
the cursor to the right and slightly down to see the rectangle being 
formed (see Figure 4.44, left). To locate the opposite corner, let’s use 
the relative Cartesian coordinates discussed in Chapter 2.

◀

Osnap is short for 
object snap. The 
two terms are used 
interchangeably.

◀

Because of the way 
AutoCAD displays the 
crosshair cursor, both 
the lines and the cross-
hair disappear when 
its lines coincide with 
lines in the drawing. 
This makes it difficult 
to see the rectangle 
being formed.
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F I G u R E   4 . 4 4 :   The rectangle after picking the first corner (left) and the 
completed door in a closed position (right)

 12. When you see the Specify other corner point or [Area/
Dimensions/Rotation]: prompt, type -1.5,-3'↵↵ (-40,-915↵↵).

The rectangle is drawn across the opening, creating a door in a 
closed position (see Figure 4.44, right). The door now needs to be 
rotated around its hinge point to an opened position.

When you used the Rectangle (RECTANG) command to draw the 
swinging doors, you had to use relative Cartesian coordinates 
because relative polar coordinates would have required you to know 
the diagonal distance across the plan of the door and the angle of 
that distance as well.

 13. Save your drawing as I04-12-SwingingDoor.dwg (M04-12-
SwingingDoor.dwg).

Rotating the Door

This rotation will be through an arc of 90º in the clockwise direction, making it 
a rotation of –90º. By default, counterclockwise rotations are positive, and clock-
wise rotations are negative. You’ll use the ROTATE command to rotate the door:

 1. Continue using I04-12-SwingingDoor.dwg (M04-12-SwingingDoor 
.dwg), or open it if it’s not already open.

 2. Click the Rotate button on the Home tab ➢ Modify panel or type 
RO↵. You’ll see a prompt to select objects. Click the door and press ↵.
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You’re prompted for a base point—a point around which the door 
will be rotated. To keep the door placed correctly, pick the hinge 
point for the base point. The hinge point for this opening is the right 
endpoint of the bottom jamb line.

 3. Type END↵ to activate the Endpoint osnap.

 4. Move the cursor near the lower-right corner of the door. When the 
marker is displayed at that corner, click to locate the base point.

 5. Check the status bar to be sure the Ortho Mode button isn’t pressed. 
If it is, click it to turn off Ortho (the blue glow will disappear).

When the Ortho Mode button is on (with a blue glow), the cursor 
is forced to move in a vertical or horizontal direction. This is useful 
at times, but in this instance such a restriction would keep you from 
being able to see the door rotate.

 6. Move the cursor away from the hinge point, and see how the door 
rotates as the cursor moves (see the left image in Figure 4.45).

F I G u R E   4 . 4 5 :   The door rotating with movement of the cursor (left) and the 
door after the 90 rotation (right)

If the door swings properly, you’re reassured that you correctly 
selected the base point. The prompt in the command line reads 
Specify rotation angle or [Copy/Reference]<0.00>:, asking 
you to enter an angle.

www.MouradEngineering.com



1 3 8 	 C h a p t e r 	 4 	 • 	 D e v e l o p i n g 	D r aw i n g 	 S t r a t e g i e s : 	 P a r t 	 1

 7. Type -90↵. The door is rotated 90º to an open position (see the right 
image in Figure 4.45).

t I P  Try entering the compass direction at the Specify rotation angle 
prompt when rotating objects by a multiple of 90. Entering N for North will rotate an 
object 90 º. Enter W for a western angle of 180 º, S for a southern angle of 270 º, and E for 
an eastern angle of 360 º.

 8. Save your drawing as I04-13-RotateDoor.dwg (M04-13- 
RotateDoor.dwg).

To finish this door, you need to add the door’s swing. You’ll use the ARC command 
for this.

Drawing the Door Swing

The swing shows the path that the outer edge of a door takes when it swings 
from closed to fully open. Including a swing with the door in a floor plan helps 
to identify the rectangle as a door and helps to resolve clearance issues. You 
draw the swings by using the ARC command—in this case, using the Endpoint 
osnap. This command has many options, most of which are based on knowing 
three aspects of the arc, as you’ll see. Here are the steps:

 1. Continue using I04-13-RotateDoor.dwg (M04-13-RotateDoor.dwg), 
or open it if it’s not already open.

 2. Click the down arrow below the Arc button on the Home tab ➢ Draw 
panel.

The menu expands to show the 11 methods for creating an arc. On 
the menu, 10 of the 11 options have combinations of three aspects 
that define an arc. The arc for this door swing needs to be drawn 
from the right end of the upper jamb line through a rotation of 90º. 
You know the start point of the arc, the center of rotation (the hinge 
point), and the angle through which the rotation occurs, so you can 
use the Start, Center, Angle option on the Arc menu.
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the options of the ARC Command

The position and size of an arc can be specified by a combination of its components, 
some of which are start point, endpoint, angle, center point, and radius. The ARC 
command gives you 11 options, 10 of which use three components to define the 
arc. Taking a moment to understand the geometry of your drawing first will help 
ensure you can choose the option that best fits the situation.

When you start the ARC command by typing A↵, you get an abbreviated form 
of the command in the command prompt. You can access all 11 options of the 
command from the command line, but you have to select the various components 
along the way.

 3. From the expanded Arc menu, choose Start, Center, Angle, as shown 
in Figure 4.46.

F I G u R E   4 . 4 6 :   The expanded Arc menu

The command prompt now reads Specify start point of arc:; 
this is the default option. You could also start with the center point, but 
you would have to type C↵ before picking a point to be the center point.

 4. Activate the Endpoint osnap (type END↵), and pick the right endpoint 
of the upper jamb line, as shown in Figure 4.47.
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F I G u R E   4 . 4 7 :   Specifying the start point for the ARC command

The prompt changes to read Specify second point of arc:. 
Because you previously chose the Start, Center, Angle option, 
AutoCAD automatically chooses Center for you as the second point. 
That is the last part of the prompt. You’ll need the Endpoint osnap 
again, but this time you will pick it from a menu.

 5. Hold down the Shift key, and right-click in the drawing area to open 
a context menu containing all the available osnaps.

 6. Click the Endpoint option, as shown in Figure 4.48, to activate the 
Endpoint osnap.

F I G u R E   4 . 4 8 :   Select the Endpoint osnap from the Object Snap context menu.
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 7. Using the Endpoint osnap, select the hinge point.
The arc is now visible, and its endpoint follows the cursor’s move-

ment, but the arc is extending in the wrong direction (see the top 
image in Figure 4.49). The prompt displays the Specify Included 
Angle option.

F I G u R E   4 . 4 9 :   Drawing the arc: The ending point of the arc follows the 
cursor’s movements (top), and the completed arc (bottom).

 8. Type -90↵. The arc is completed, and the ARC command ends (see the 
bottom image in Figure 4.49).

 9. Save your drawing as I04-14-DoorSwing.dwg (M04-14-DoorSwing.dwg).
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W A R n I n G  In this situation, it is best to create the arc by selecting the 
jamb end first and the door end later. By default, arcs are made in a counterclockwise 
fashion, so selecting the door end first and the jamb end later would result in a 270 arc 
that extends behind the door and through the external wall. Pressing the Ctrl key as you 
draw the arc will temporarily reverse this behavior.

The back door is completed. Next you’ll copy and then modify the back door to 
form the bathroom door.

Copying objects
As you would expect, the COPY command makes a copy of the objects you select. 
You can locate this copy either by picking a point or by entering relative coor-
dinates from the keyboard. For AutoCAD to position these copied objects, you 
must designate two points: a base point, which serves as a point of reference for 
where the copy move starts, and then a second point, which serves as the end-
ing or destination point for the COPY command.

The copy is moved the same distance and direction from its original position 
that the second point is located from the first point. When you know the actual 
distance and direction to move the copy, the base point isn’t critical because you 
specify the second point with relative polar or relative Cartesian coordinates. 
In this situation, however, you don’t know the exact distance or angle to move 
a copy of the back door to the bathroom door opening, so you need to choose a 
base point for the copy carefully.

In copying this new door and its swing to the back door opening of the cabin, 
you must find a point somewhere on the existing door or swing that can be 
located precisely on a point at the back door opening. You can choose from two 
points: the hinge point and the start point of the door swing. Let’s use the hinge 
point. You usually know where the hinge point of the new door belongs, so this 
is easier to locate than the start point of the arc. In the following steps, you’ll 
copy the existing door so that it can be used for the bathroom door opening:

 1. Continue using I04-14-DoorSwing.dwg (M04-14-DoorSwing.dwg), or 
open it if it’s not already open.

 2. Click the Copy button in the Home tab ➢ Modify panel of the Ribbon 
or type CO↵ at the command line.
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 3. The prompt asks you to select objects to copy. Pick the door and 
swing, and then press ↵.

The prompt in the command-line interface reads Specify base 
point or [Displacement/mOde]<Displacement>:.

 4. Pick the hinge point by using the Endpoint osnap.
A copy of the door and swing is attached to the crosshair cur-

sor at the hinge point (see Figure 4.50), and the prompt changes to 
Specify second point or <use first point of displacement>:. 
You need to pick where the hinge point of the copied door will be 
located at the bathroom door opening.

F I G u R E   4 . 5 0 :   The copy of the door and swing attached to the crosshair 
cursor

 5. Activate the Endpoint osnap once again. This time, pick the lower 
end of the right jamb line on the bathroom door opening.

The copy of the door and swing is placed in the opening  
(see Figure 4.51).
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F I G u R E   4 . 5 1 :   The door is copied to the bathroom door opening.

Looking at the command prompt, you can see that the COPY com-
mand is still running, and a copy of both the door and swing remains 
attached to the cursor.

 6. Press ↵ to end the COPY command.

 7. The door is oriented the wrong way, but you’ll fix that next. Save your 
drawing as I04-15-CopyingObjects.dwg (M04-15-CopyingObjects.dwg).

When you copy doors from one opening to another, the orientation often 
doesn’t match. The best strategy is to use the hinge point as a point of reference 
and place the door where it needs to go, as you just did. Then flip or rotate the 
door so that it sits and swings the right way. The flipping of an object is known 
as mirroring.

Mirroring objects
You have located the door in the opening, but it needs to be rotated 90º to be 
perpendicular to the wall and then flipped so that it swings to the inside of the 
bathroom. To do this, you’ll use the ROTATE command that you used earlier and 
then the MIRROR command.

The MIRROR command is similar to the flip tools found in other graphics pro-
grams, and it allows you to flip objects around an axis called the mirror line. 

▶

The COPY command 
keeps running until you 
end it. This allows you 
to make multiple cop-
ies of the same object. 
You’ll do that in Chapter 
5 when you draw the 
stovetop.

▶

The ZOOM command 
is usable while the 
COPY command is 
active. Similarly, most 
display commands 
(ZOOM, PAN, and so 
on) share this function-
ality and are known 
as transparent 
commands.
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You define this imaginary line by designating two points on the line. Strategic 
selection of the mirror line ensures the accuracy of the mirroring action. Thus, 
it’s critical to visualize where the proper line lies. Sometimes you’ll have to draw 
a guideline in order to designate one or both of the endpoints.

 1. Continue using I04-15-CopyingObjects.dwg (M04-15-
CopyingObjects.dwg), or open it if it’s not already open.

 2. Click the Rotate button found on the Home tab ➢ Modify panel, and 
select the door and swing for the bathroom door. With the door and 
swing selected, press ↵.

 3. Activate the Endpoint osnap by typing END↵ and then picking the 
hinge point from the Specify base point: prompt.

 4. At the Specify rotation angle: prompt, type 90↵.
The door is rotated 90º, but its orientation is incorrect, as shown in 

Figure 4.52.

F I G u R E   4 . 5 2 :   The door after rotating it 90º
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 5. Start the MIRROR command from the Home tab ➢ Modify panel ➢ 
Mirror tool button, or type MI↵ at the command line. Select the bath-
room door and swing, and then press ↵. The prompt line changes to 
read Specify first point of mirror line:.

 6. Activate the Endpoint osnap, and then pick the hinge point of the 
door.

The prompt changes to read Specify second point of mirror 
line:, and you’ll see the mirrored image of the door and the swing 
moving as you move the cursor around the drawing area. You’re 
rotating the mirror line about the hinge point as you move the cur-
sor. As the mirror line rotates, the orientation of the mirrored image 
changes (see Figure 4.53).

F I G u R E   4 . 5 3 :   The mirror image changes as the mirror line rotates.

 7. Press and hold the Shift key to enable Ortho mode temporarily.
A small icon displays in the upper-right quadrant of your cursor to 

indicate that Ortho mode is temporarily enabled, locking your cursor 
to increments of 90º.

▶

Try typing P↵ 
at the Select 
Objects: prompt 
to quickly reselect the 
last objects selected.
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 8. With the Shift key pressed, select any point to the left, as shown in 
Figure 4.54.

F I G u R E   4 . 5 4 :   Using the Shift key to enable Ortho mode temporarily to pick 
the mirror line

Activating the temporary Ortho mode override might take a 
moment. You’ll know the override is enabled when the small shield 
icon appears next to your cursor. Because Ortho mode locks your 
cursor to rotation increments of 90º, you don’t have to be precise 
when selecting the second point. You can see that the point selected 
in Figure 4.54 is not perpendicular; however, Ortho mode ensures 
that the mirror line is drawn along the horizontal bathroom wall.

 9. Type Y↵, or select Yes when the command prompt reads Erase 
source objects? [Yes/No] <N>:.

The flipped door is displayed, and the original one is deleted (see 
Figure 4.55). The MIRROR command ends.
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F I G u R E   4 . 5 5 :   The mirrored door and swing

 10. Save your drawing as I04-16-MirroringObjects.dwg (M04-16-
MirroringObjects.dwg).

It might take some practice to become proficient at visualizing and designat-
ing the mirror line, but once you’re used to it, you’ll have learned how to use a 
powerful tool. Because many objects—including building layouts, mechanical 
parts, steel beams, road cross-sections, and so on—have some symmetry to 
them, wise use of the MIRROR command can save you a lot of drawing time.

Now let’s change the scale of the interior to match the available opening.
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Scaling the Bathroom Door
You could have used the STRETCH command to make the door narrower, but 
that’s an advanced Modify command and won’t be introduced until Chapter 11, 
“Working with Hatches, Gradients, and Tool Palettes.” Besides, the arc would 
have to be modified to a smaller radius. It’s easier to scale the objects, and the 
slightly thinner door can be attributed to interior doors being thinner than 
exterior doors. In Chapter 9, “Using Dynamic Blocks and Tables,” I’ll demon-
strate a dynamic block that can serve as a door block for several door sizes.

For this exercise, you will use the SCALE command to resize the bathroom 
door to fit the existing opening. The SCALE command changes the size of all the 
selected objects by an equal amount based on keyboard input or the location of 
the cursor. The objects scale up or down, based on their position relative to a 
base point you’ve defined. Objects scaled up will appear to get farther away from 
the base point, whereas objects scaled down will appear to get closer.

The 30″ (762 mm) bathroom door opening is 5⁄6 the size of the 36″ (915 mm) 
back door opening; therefore, 5⁄6, or its decimal equivalent of 0.8333, can be 
used as the scale factor. Because fractions are inherently more accurate than 
rounded-off decimal values, we’ll use the fractional scale factor:

 1. Continue using I04-16-MirroringObjects.dwg (M04-16-
MirroringObjects.dwg), or open it if it’s not already open.

 2. Click the Zoom Window button found on the Navigation bar to zoom 
in to the interior door opening (see Figure 4.56).

F I G u R E   4 . 5 6 :   A close-up view of the bathroom door

◀

The scale factor 5⁄6 
was derived by reduc-
ing 30⁄ 36. Because 
a 762 mm door isn’t 
exactly 5⁄6 of a 915 mm 
door, the unreduced 
fraction 762 ⁄915 can be 
substituted to achieve 
an accurate scale 
factor.
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 3. Start the SCALE command by using the Scale button found on the 
Home tab ➢ Modify panel, or type SC↵ at the command line.

 4. At the Select objects: prompt, select the bathroom door and 
swing, and then press ↵.

 5. At the Specify base point: prompt, type END↵ and pick the hinge 
point.

As you move the cursor, you can see the scaled version of the door 
change size depending on how far the cursor is located from the base 
point (see Figure 4.57).

F I G u R E   4 . 5 7 :   Using the Scale tool to resize the bathroom door

 6. Type 5/6↵ (762/915↵) to scale the 36″ (915 mm) door down to 30″ 
(762 mm).

The rescaled door should look like Figure 4.58.

F I G u R E   4 . 5 8 :   The rescaled bathroom door
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 7. Save your drawing as I04-17-ScalingObjects.dwg (M04-17-
ScalingObjects.dwg).

As you can see, as long as you know the scale factor, it’s easy to use the SCALE 
command to resize objects in your drawing. The next door to draw is the sliding 
glass door. This kind of door requires an entirely different strategy, but you’ll use 
commands familiar to you by now.

Drawing a Sliding Glass Door
You will need to use the Endpoint osnap a lot while creating, copying, rotating, 
and mirroring objects; it’s probably the most frequently used of the osnaps. Rather 
than activating it as needed, you will turn on Endpoint as a running osnap—an 
osnap that is permanently turned on:

 1. Continue using I04-17-ScalingObjects.dwg (M04-17-
ScalingObjects.dwg), or open it if it’s not already open.

 2. Right-click the Object Snap button in the status bar, and then select 
the Object Snap Settings option in the context menu.

 3. In the Object Snap tab of the Drafting Settings dialog box, select the 
Endpoint check box.

While the cursor is near the selection, a tool tip appears, describ-
ing the features to which the osnap moves the cursor. Take a 
moment to investigate what each of the osnap options does before 
clicking the OK button (see Figure 4.59).

F I G u R E   4 . 5 9 :   The Object Snap tab of the Drafting Settings dialog box
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 4. The osnap is active, but the running osnaps are not turned on. Click 
the Object Snap button to turn on (light blue background) running 
osnaps. Now, whenever you are prompted to pick a point, a marker 
will appear over the nearest endpoint of the object the cursor is over.

Sliding glass doors are usually drawn to show their glass panels within the 
door frames, as shown in Figure 4.60.

F I G u R E   4 . 6 0 :   A common appearance for a sliding glass door

To draw the sliding door, you’ll apply the LINE, OFFSET, and TRIM commands 
to the 7′ (2134 mm) opening you made earlier. It’s a complicated exercise, 
but it will teach you a lot about the power of using these three commands in 
combination:

 1. Continue using I04-17-ScalingObjects.dwg (M04-17-
ScalingObjects.dwg), or open it if it’s not already open.

 2. Zoom out by rolling the mouse wheel toward you or by using the 
Zoom Extents (ZOOM) command. Zooming with the mouse wheel 
zooms the drawing toward or away from the location of the cursor.

 3. Zoom closely around the 7′ (2134 mm) opening.
Try zooming with the scroll wheel by placing the cursor in the cen-

ter of the opening and rolling the scroll wheel away from you. Make 
the opening as large as possible while including everything you need 
in the view (see Figure 4.61).
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F I G u R E   4 . 6 1 :   The view when zoomed in as closely as possible to the 7′ (2134 
mm) opening

You’ll be using several osnaps for this procedure. Rather than 
entering each osnap, you can activate any object snap by holding 
down the Shift key and right-clicking in the drawing area. This 
opens a context menu with all of the object snap options shown ear-
lier in Figure 4.50. Selecting any of these options activates the osnap 
for a single pick.

You probably noticed the list of osnaps that appeared when you 
right-clicked the Object Snap button in the status bar. These do not 
activate an osnap for a single pick; rather, they are a quick method 
for activating or deactivating a running osnap.

◀

Using the 
ZOOMFACTOR vari-
able, you can control 
how quickly rolling the 
mouse wheel zooms 
your drawing. Type 
ZOOMFACTOR↵ 
and, when prompted, 
enter a value between 
3 and 100. Lower values 
perform slower zooms, 
and vice versa.

www.MouradEngineering.com



1 5 4 	 C h a p t e r 	 4 	 • 	 D e v e l o p i n g 	D r aw i n g 	 S t r a t e g i e s : 	 P a r t 	 1

 4. Offset each jamb line 2″ (51 mm) into the doorway opening (see 
Figure 4.62).

F I G u R E   4 . 6 2 :   Jamb lines offset 2″ (51 mm) into the doorway opening

 5. Start the LINE command, and choose the Midpoint osnap from the 
Shift+right-click context menu, or enter MID↵ at the command line.

 6. Place the cursor near the midpoint of the upper doorjamb line and 
notice that the marker, now a triangle, appears when your cursor is 
in the vicinity of the midpoint (see Figure 4.63).
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F I G u R E   4 . 6 3 :   Using the Midpoint osnap to select the start point of the line

A symbol with a distinctive shape is associated with each osnap. 
Click when the triangle appears at the midpoint of the jamb line.

 7. Move the cursor over the bottom jamb line, and you’ll notice the 
Endpoint markers appear.

The Endpoint running osnap is still active, but typing in the first 
three letters of an osnap or clicking an osnap option from the context 
menu overrides it.

 8. Click the Midpoint osnap option again, and move the cursor to the 
bottom jamb line.
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 9. When the triangle appears at that midpoint, click again. Press ↵ to 
end the LINE command.

 10. Start the OFFSET command, and enter 1.5↵ (38↵) to set the offset 
distance.

 11. Pick the newly drawn line, and then pick a point anywhere to the 
right side.

 12. While the OFFSET command is still running, pick the original line 
again and pick another point in a blank area somewhere to the left 
side of the doorway opening (see Figure 4.64).

F I G u R E   4 . 6 4 :   The offset vertical lines between the jambs

 13. Press ↵ to end the OFFSET command.

 14. In the status bar, click the Ortho Mode button to turn that mode on 
(blue glow). Ortho mode restricts the cursor to vertical and horizon-
tal movements only.

 15. Start the LINE command, choosing the Midpoint osnap option, and 
then move the cursor near the midpoint of the left vertical line.

When the triangle marker appears at the midpoint, click to set the 
endpoint of the line.
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 16. Hold the cursor out directly to the right of that point, to draw a hori-
zontal line through the three vertical lines.

When the cursor is about 2′ (600 mm) to the right of the three 
vertical lines, pick a point to set the endpoint of this guideline (see 
Figure 4.65). Press ↵ to end the LINE command. Click Ortho mode 
off (gray background).

F I G u R E   4 . 6 5 :   The horizontal guideline drawn through vertical lines

 17. Type O↵ or click Offset on the Home tab ➢ Modify panel to start the 
OFFSET command, and then type 1↵ (25↵) to set the offset distance 
to 1″ (25 mm).

 18. Select the horizontal line you just drew, and then pick a point in a 
blank area anywhere above the line. Pick the first horizontal line 
again, and then pick anywhere below it.

The new line has been offset 1″ (25 mm) above and below itself (see 
Figure 4.66). Now you have placed all the lines necessary to create 
the sliding glass door frames in the opening. You still need to trim 
back some of these lines and erase others. Press ↵ to end the OFFSET 
command.
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F I G u R E   4 . 6 6 :   The offset horizontal guideline

 19. Start the TRIM command. When you’re prompted to select cutting 
edges, pick the two horizontal lines that were just created with the 
OFFSET command and press ↵.

 20. Trim the two outside vertical lines by selecting them, as shown on 
the left of Figure 4.67. The result is shown on the right.

Trim this line.

Trim this line.

F I G u R E   4 . 6 7 :   Picking the vertical lines to trim (left), and the result (right)
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 21. Press ↵ twice to stop and restart the TRIM command.

 22. When you’re prompted to select cutting edges, use a special window 
called a crossing window to select all the lines visible in the drawing.

A crossing window selects everything within the window or cross-
ing it. See the sidebar titled “Understanding Selection Windows” 
later in this chapter for additional information about this feature. 
Here’s how to use a crossing window:

 a. Pick a point above and to the right of the opening.

 b. Move the cursor to a point below and to the left of the opening, 
forming a semitransparent green-colored window with dashed 
boundary lines (see Figure 4.68).

F I G u R E   4 . 6 8 :   The crossing window for selecting cutting edges
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 c. Pick that point. Everything inside the rectangle or crossing an 
edge of it is selected.

 d. Press ↵.

 23. To trim the lines, pick them at the points noted on the left of 
Figure 4.69.

Pick these
10 points.

1 2

4

7

9 10

8

6

5

3

F I G u R E   4 . 6 9 :   Lines to trim (left) and the result (right)

When you finish trimming, the opening should look like the right 
side of Figure 4.69. Be sure to press ↵ to end the TRIM command.

Adjusting trim with the EDGEMODE System Variable

If all the lines don’t trim as you would expect, you may have to change the setting 
for the EDGEMODE system variable. Cancel the trim operation, and undo any trims 
you’ve made to the sliding glass door. Type EDGEMODE↵ and then type 0↵. Now 
start the TRIM command and continue trimming.

EDGEMODE controls how the TRIM and EXTEND commands determine cutting 
edges. When set to its default value of 0, EDGEMODE uses the selected edge 
without any extensions. When set to 1, EDGEMODE extends or trims the selected 
object to an imaginary extension of the cutting or boundary edge.
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 24. Start the ERASE command, and erase the remaining horizontal 
guideline.

To finish the sliding glass doors, you need to draw two lines to 
represent the glass panes for each door panel. Each pane of glass is 
centered inside its frame, so the line representing the pane will run 
between the midpoints of the inside edge of each frame section.

 25. Start the LINE command. Hold down the Shift key, right-click, and 
then select the Midpoint osnap option from the context menu.

 26. For each of the two sliding door frames, draw a line from the mid-
point of the inside frame (nearest the jamb) to a point perpendicular 
to the frame section in the middle. To do this, follow these steps:

 a. Place the cursor near the midpoint of the inside line of the 
frame section nearest the jamb. When the colored triangle 
appears there, click.

 b. Type PER↵ or click the Perpendicular osnap from the Object 
Snap context menu, and move the cursor to the other frame 
section of that door panel.

 c. When you get near the horizontal line that represents both the 
inside edge of one frame section and the back edge of the frame 
section next to it, the colored Perpendicular osnap marker will 
appear on that line, as shown in Figure 4.70. When it does, 
select that point.

F I G u R E   4 . 7 0 :   Using the Perpendicular osnap to set the endpoint of the line
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 27. Press ↵ to end the LINE command.

 28. Press ↵ to restart the LINE command, and repeat the procedure 
described in steps 25 through 27 for the other door panel, being sure 
to start the line at the frame section nearest the other jamb. The fin-
ished opening should look like Figure 4.71.

F I G u R E   4 . 7 1 :   The finished sliding glass doors

 29. Save your drawing as I04-18-SlidingGlassDoor.dwg (M04-18-
SlidingGlassDoor.dwg).

Drawing the Bifold Doors
Bifold doors are generally shown with each door in a half-open position to indi-
cate their distinctive design. Although there are four door panels on the cabin’s 
closet door, you will need to draw only one, rotate it into place, and then create 
copies with the MIRROR command. To begin the exercise, you will use the PAN 
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command to shift the view of your drawing to see the closet area without chang-
ing the zoom factor. Follow these steps:

 1. Continue using I04-18-SlidingGlassDoor.dwg (M04-18-
SlidingGlassDoor.dwg), or open it if it’s not already open.

 2. Start the PAN command from the View tab ➢ Navigate 2D panel, click 
the Pan button, or type P↵ at the command line. The cursor changes 
appearance to look like an open hand.

 3. Place the cursor near the upper jamb of the sliding glass door, and 
then click and drag the mouse downward until the drawing area 
shifts to display the closet area (see Figure 4.72).

F I G u R E   4 . 7 2 :   Pan the view to show the closet area.

 4. Press the Esc key to end the PAN command, or right-click and choose 
Exit from the context menu.

The closet opening is 4′ (1220 mm) wide, so you will need to make 
four door panels, each 1′ (305 mm) wide.

 5. Start the Rectangle (RECTANG) command and specify the lower cor-
ner of the right closet jamb as the first corner point. The running 
Endpoint osnap ensures that the corner point is selected precisely.

 6. Type -1,-12↵ (-25,-305↵) to create a rectangle 1″ (25 mm) wide 
and 12″ (305 mm) long oriented toward the bottom of the cabin, as 
shown in Figure 4.73.

◀

As an alternative to 
using the PAN com-
mand, you can simply 
hold down the scroll 
wheel and drag to 
use the pan function 
transparently—with-
out exiting an active 
command.
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F I G u R E   4 . 7 3 :   The first closet door panel is drawn.

n o t E  It should be clear by now that when a command allows multiple picks 
in order to select several objects, you need to press ↵ to terminate the selection pro-
cess and proceed with the command. From now on, when you are directed to select an 
object(s), I won’t tell you to press ↵ to end the selection process.

 7. Type -45↵. The door rotates 45º (see Figure 4.74), and the ROTATE 
command ends.

F I G u R E   4 . 7 4 :   The first closet door panel is rotated.
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 8. Start the MIRROR command from the Home tab ➢ Modify panel, and 
then select the closet door panel.

 9. Verify that Ortho mode is still turned on in the status bar. If it’s not, 
click the Ortho Mode button or press the F8 shortcut key to turn on 
Ortho mode.

 10. At the Specify first point of mirror line: prompt, click the far-
left corner point of the selected panel.

 11. Move the cursor either up or down until you see the mirror door 
panel directly to the left of the first panel (see Figure 4.75); then click 
to specify the second point of the mirror line.

F I G u R E   4 . 7 5 :   Mirroring the first closet door panel

 12. Press ↵ to accept the default No option when prompted to erase the 
source object.

 13. Start the MIRROR command again, and this time select both of the 
door panels.

 14. Choose the midpoint of the back wall of the closet as the first point of 
the mirror line.

 15. Then move the cursor downward to mirror the existing panels 
directly to the left, as shown in Figure 4.76.
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F I G u R E   4 . 7 6 :   The closet door is complete.

 16. Click to set the second point, and then press ↵ to retain the source 
objects.

 17. Click the Zoom Extents button to see the full floor plan with all doors 
(see Figure 4.77).

F I G u R E   4 . 7 7 :   The cabin with the walls and doors completed

 18. Save this drawing as I04A-FPLAYO.dwg (M04A-FPLAYO.dwg).
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understanding Selection Windows

In addition to selecting objects by using a direct pick, you can select objects by 
using a rectangular selection window. To use a selection window at any Select 
objects: prompt, pick a point at a blank spot in the drawing area to define 
one corner of the window and then a second point to define the opposite corner.

Selection windows come in two styles: windows and crossing windows. When 
you use a window selection, all objects must be entirely inside the boundary of 
the window to be selected. When you use a crossing window, all objects entirely 
within the boundary as well as any objects that cross the boundary are selected. 
AutoCAD distinguishes the two types of selection windows visually. Window 
selection areas are transparent blue and have solid boundary lines, and crossing 
windows are transparent green with dashed boundary lines.

By default, window selections are used when the boundary is created from left to 
right, and crossing selections are used when the boundary is created from right to 
left. Releasing the left mouse button after you select the first corner will result in 
a rectangular selection, whereas holding the left mouse button will allow you to 
sketch a selection of any shape. By typing W↵ or C↵ at the Select objects: 
prompt, you can override the direction default or create a selection window even 
when the mouse is clicked as the cursor is over an object.

Selection windows can even be used to select objects to be trimmed or extended. 
For instance, visualize a horizontal line with dozens of vertical lines crossing it, 
and each of those lines must be trimmed back to the horizontal line. After des-
ignating the horizontal line as the cutting edge, use a crossing selection window 
to select all of the vertical lines on the trim side. All the lines are trimmed with 
two picks instead of many.

In the Visual Effect Settings dialog box that opens (see Figure 4.78), you’ll see 
settings in the Selection Area Effect section for controlling whether the selec-
tion windows have color in them, which color will be in each window, and the 
percentage of transparency of the colors. The left side of the dialog box con-
trols the appearance of an object’s highlighting when the cursor hovers over it. 
Experiment with different settings. Click OK twice to return to your drawing, 
and test the windows to see how they look.
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F I G u R E   4 . 7 8 :   The Visual Effect Settings dialog box

This completes the doors for the floor plan. The focus here has been on walls 
and doors and the strategies for drawing them. You now have a basic floor plan 
for the cabin, and you’ll continue to develop this plan in the next chapter.

Reviewing Drawing Strategies used in This 
Chapter
The overall drawing strategy emphasized in this chapter uses objects already in 
the drawing to create new ones. You started with several lines that constituted the 
outside walls. By offsetting, filleting, extending, and trimming, you drew all the 
other walls and openings without drawing any new lines. For the swinging doors, 
you made a rectangle and an arc. Then by copying, rotating, and mirroring, you 
formed the other swinging door. For the sliding glass door, you drew two new 
lines and used OFFSET, TRIM, and ERASE to finish the door. Therefore, you used 
four lines and created six new objects to complete the walls and doors. This is a 
good start in learning to use AutoCAD efficiently.

Throughout this chapter, I have indicated several instances when you can 
press the spacebar instead of the ↵ key. This can be handy if you keep one hand 
resting on the keyboard while the other hand controls the mouse. For brevity, 
I’ll continue to instruct you to use ↵ and not mention the spacebar, but as you 
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get better at drawing in AutoCAD, you may find the spacebar a useful substitute 
for ↵ in many cases. You’ll determine your preference. You can substitute the 
spacebar for ↵ when handling the following tasks:

▶▶ Restarting the previous command

▶▶ Ending a command

▶▶ Moving from one step in a command to the next step

▶▶ Entering a new offset distance or accepting the current offset 
distance

▶▶ Entering relative or absolute coordinates

▶▶ Entering an angle of rotation

After working with the tools and strategies in this chapter, you should have 
an idea of an approach to drawing many objects. In the next chapter, you’ll con-
tinue in the same vein, learning a few new commands and strategies as you add 
steps, a balcony, a kitchen, and a bathroom to the floor plan.

If You Would Like More Practice…
If you would like to practice the skills you have learned so far, here are some 
extra exercises.

An Alternative Sliding Glass Door
Here is a simplified version of the sliding glass door of the cabin, as shown in 
Figure 4.79. This version doesn’t include any representation of the panes of glass 
and their frames.

F I G u R E   4 . 7 9 :   An alternative to the sliding glass door

To draw it, use a technique similar to the one described in the “Drawing a 
Sliding Glass Door” section. Copy the jambs for the 7′ (2134 mm) opening to 
the right, and draw this door between them.
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An Addition to the Cabin
This addition is connected to the cabin by a sidewalk and consists of a remod-
eled two-car garage in which one car slot has been converted into a storage area 
and an office (see Figure 4.80). Use the same commands and strategies you have 
been using up to now to draw this layout adjacent to the cabin. Save this exer-
cise as 04A-FPGARG.dwg.

F I G u R E   4 . 8 0 :   The garage addition
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Refer to this chapter and to the preceding chapters for specific commands. 
Here is the general procedure:

 1. Draw the outside exterior wall lines.

 2. Use OFFSET, FILLET, and TRIM to create the rest of the walls and wall 
lines.

 3. Use OFFSET, EXTEND, and TRIM to create the openings.

 4. Use RECTANG and ARC to create a swinging door.

 5. Use COPY, ROTATE, and MIRROR to put in the rest of the doors.

 6. Use OFFSET, LINE, and COPY to draw the storage partitions.

three Views of a Block
Use the tools you have learned in the last few chapters to draw the top, right 
side, and front views of the block shown in Figure 4.81.

F I G u R E   4 . 8 1 :   The block
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Figure 4.82 gives you a graphic representation of the 12 steps necessary to 
complete the exercise.

1 2 3 4

5 6 7 8

9 10 11 12

F I G u R E   4 . 8 2 :   The 12 steps for creating the block

Here’s a summary of the 12 steps that correspond to the 12 drawings, starting 
with the top view:

 1. Start a new drawing. Leave all settings at the defaults. Use relative 
polar or relative Cartesian coordinates and the LINE command to 
draw a rectangle 17.75 units wide and 11.51 units high. Zoom out if 
necessary.

 2. Offset the bottom horizontal line up 2.16 units and the new line up 
4.45 units.

 3. Offset the right vertical line 4.75 units to the left and the new line 
3.50 units to the left.

 4. Use the TRIM command to trim back lines and complete the view.
Next, you’ll draw the right side view.

 5. Draw a vertical line to the right of the top view. Make it longer than 
the top view is deep.

 6. Offset the vertical line 2.4 units to the right, and then offset the new 
line 2.4 units to the right also.

 7. Use the Endpoint osnap to draw lines from the corner points of the 
top view across the three vertical lines.

 8. Trim the lines back to complete the side view.
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Finally, you’ll draw the front view.

 9. Draw a horizontal line below the top view. Make it longer than the 
top view is wide.

 10. Offset this line 2.4 units down, and then offset the new line 2.4 units 
down.

 11. Use the Endpoint osnap to draw lines from the corner points of the 
top view, down across the three horizontal lines.

 12. Trim the lines back to complete the view.

This ends the exercise. You can rotate and move each view relative to the 
other views in several ways. You’ll look at those commands later in the book and 
then draw more views in Chapter 8.

Are You Experienced?

now you can…

✔✔ create polylines

✔✔ offset	exterior	walls	to	make	interior	walls

✔✔ zoom	in	on	an	area	with	the	Zoom	Window	(ZOOM) command and 
zoom	back	out	with	the	Zoom	Previous	(ZOOM) command

✔✔ use	the	Rectangle	(RECTANG) and ARC	commands	to	make	a	door

✔✔ use	the	Endpoint,	Midpoint,	and	Perpendicular	object	snap	modes

✔✔ use the crossing window selection tool

✔✔ use the COPY and MIRROR commands to place an existing door and 
swing in another opening

✔✔ use the OFFSET and TRIM	commands	to	make	a	complex	assembly

✔✔ begin	drawing	2D	representations	of	3D	shapes
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CHAPtER 5

Developing Drawing 
Strategies: Part 2
The previous chapter emphasized using existing geometry (or objects) in 
a drawing to create new geometry. In this chapter, you’ll look at new tools for 
forming an efficient drawing strategy. Before getting back to the cabin, I’ll give 
you a brief overview of the tools available for starting and running commands.

In this chapter, you will learn to

▶▶ Use	running	object	snaps

▶▶ Use	Polar	Tracking

▶▶ Use the STRETCH command

▶▶ Use point filters

▶▶ Zoom and pan with the Realtime commands

▶▶ Copy	and	move	objects

▶▶ Use direct entry for distances

▶▶ Create circles and ellipses

▶▶ Draw using parametric constraints

Starting and Running Commands
Developing a drawing strategy begins with determining the best way to 
start a command and when to start it. The Autodesk® AutoCAD® program 
provides several ways to start most of the commands you’ll be using. As you 
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have seen, you can start the OFFSET, FILLET, TRIM, and EXTEND commands from 
either the Ribbon’s Home tab ➢ Modify panel or by typing the first letter or two 
of the command and then pressing ↵. 

Remember that if you have just ended a command, you can restart that com-
mand by pressing ↵, by pressing the spacebar, or by right-clicking. When you 
right-click, a context menu appears near the cursor. The top item on this menu 
is Repeat Command, where Command is the last command used. For example, 
if you’ve just finished using the ERASE command and you right-click, the top 
item of the context menu is Repeat Erase. If you’ve used a command recently, 
you can select that command by pausing the cursor (hovering) over the Recent 
Input option and then selecting that command from the cascading menu that 
appears (see Figure 5.1).

F I G u R E   5 . 1 :   The right-click context menu and Recent Input cascading menu
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Accessing Commands from the Keyboard

Here’s a recap of the methods you’ve used so far to run commands from the key-
board. To start the OFFSET command from the keyboard, enter O↵. To start the 
FILLET command, enter F↵. To start the TRIM command, enter TR↵; and to 
start the EXTEND command, enter EX↵. AutoCAD employs this same framework 
for nearly all of its commands; start commands by entering the entire name of the 
command (EXTEND↵), or enter the starting characters of the command (EX↵).

The autocomplete feature allows for efficient access to commands and, when 
available, the associated command alias. Pausing after entering one or more 
characters at the command line will display a list of commands whose prefix 
matches what you’ve typed. (The following illustration shows the autocomplete 
feature displaying a list of commands whose prefix matches EX.) With this list 
open, you can continue entering the command name or select it from the list.

Another way to access commands from the keyboard is to press the F10 or Alt key. 
When you hold down the Alt key for a second or two, AutoCAD will display a series 
of shortcuts across the Ribbon. Entering these one- and two-character shortcuts 
will allow you to navigate the Ribbon without using a mouse. For example, to start 
a command on the Insert Ribbon tab, press Alt and then enter IN followed by a 
second two-character code indicated by the cue cards, as shown in the following 
illustration. These shortened command entries can range from a single character 
to several characters and are known as command aliases.

www.MouradEngineering.com



1 7 8 	 C h a p t e r 	 5 	 • 	 D e v e l o p i n g 	D r aw i n g 	 S t r a t e g i e s : 	 P a r t 	 2

n o t E  Throughout the rest of the book, I’ll introduce some of the other items 
on the context menu. This menu is called a context menu because different items are dis-
played on it, depending on whether a command is running, which command you’re using, 
and where you are in a command.

In this chapter, I’ll introduce you to several new commands and, through the 
step-by-step instructions, show you some alternative methods for accomplish-
ing tasks similar to those you have already completed. You’ll add front and back 
decks and steps, thresholds, and kitchen and bath fixtures to the cabin floor 
plan (see Figure 5.2). For each of these tasks, the focus will be on making your 
job easier by using objects and geometry that are already in the drawing and on 
choosing the appropriate tools to accomplish tasks more quickly and efficiently.

THRESHOLD

HOT
TUB

KITCHEN

BATH

LIVING ROOM

DE
CK

DE
CK THRESHOLD

F I G u R E   5 . 2 :   The cabin with front and back decks and steps, thresholds, a kitchen, and a 
bathroom

Drawing the Thresholds
To get started, let’s take a look at the two thresholds. Each threshold is repre-
sented with three simple lines. You could manually draw these lines with the 
skills you’ve learned so far, but we want to find the most efficient way. The trick 
will be to see which part of the drawing you can effectively use to generate and 
position those lines. As illustrated in Figure 5.3, the thresholds extend 2″ (51 
mm) beyond the outside wall line and run 3″ (76 mm) past either jamb line.
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F I G u R E   5 . 3 :   The thresholds with their dimensions

Drawing the Front threshold
Thresholds generally are used on doorway openings when the level changes 
from one side of the opening to the other or to prevent rain and dust from 
entering the structure. This usually occurs at entrances that open from or to 
the outside. Although they are quite different in shape, each threshold for the 
cabin has the same geometry as the steps. The lip of each threshold is offset 2″ 
(51 mm) from the outside wall, and each edge runs 3″ (76 mm) past the door-
jamb (see Figure 5.3). You’ll use a temporary tracking point with Polar Tracking 
and direct entry to draw the three thresholds for the cabin.

As you can see in Figure 5.3, the front threshold is 7′-6″ (2286 mm) wide, 
extending 3″ (76 mm) past the doorway on each side. You can draw a line from 
the endpoint of one of the jamb lines down 3″ (76 mm) and then draw the 
perimeter of the threshold. Here’s how you do it:

 1. With AutoCAD running, open your cabin drawing I04A-FPLAYO.dwg 
(M04A-FPLAYO.dwg), and use the ZOOM command options to achieve a 
view similar to Figure 5.4. The file is also available from this book’s web 
page at www.sybex.com/go/autocad2015ner or www.thecadgeek.com.
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F I G u R E   5 . 4 :   Zoomed in to the front opening

 2. Check to make sure that all buttons except Ortho Mode, Object Snap, 
and Dynamic Input on the left side of the status bar are still in their 
Off positions.

 3. Start the LINE command.
You need to start the threshold 3″ (76 mm) below the bottom 

jamb, and in line with the outside wall line. Unfortunately, there is 
no feature to snap the cursor to at that point. The techniques that 
you’ve previously used would require offsetting the jamb line or 
starting the line at the jamb and drawing an overlapping line 3″ (76 
mm) downward. Both of these methods would require you to erase 
the unnecessary line after the threshold is complete.

Instead of wasting time drawing and then erasing lots of unneces-
sary line work, you will begin using the Object Snap Tracking tool. 
This tool will help eliminate the need to create unnecessary geom-
etry. Using the Object Snap Tracking tool requires you to specify a 
location in the drawing area, called a temporary tracking point, rela-
tive to existing features or other locations.

 4. Click the Object Snap Tracking button on the status bar. In this case, 
because the threshold starts 3″ (76 mm) below the outside corner 
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of the lower jamb, you’ll use that corner as the temporary tracking 
point for the start point of the line.

 5. Pause the cursor over the outside corner of the lower jamb until the 
Endpoint osnap marker appears. A small, green cross displays inside 
the Endpoint osnap marker.

Ways to use the object Snap tools

You can access the Object Snap tools in several ways:

▶▶ The Object Snap context menu provides access to the object snaps. To open 
this menu, hold down the Shift key or Ctrl key and right-click.

▶▶ If you’re using a mouse with a scroll wheel or a three-button mouse, you 
might be able to open the Object Snap menu by clicking the wheel or the 
middle mouse button. If this doesn’t work, set the MBUTTONPAN variable 
to 0 (enter MBUTTONPAN↵0↵). Be aware that you will no longer be able 
to pan by holding down the scroll wheel.

▶▶ In most cases, you can enter the first three letters of an osnap to activate 
it, as in END↵ for Endpoint.

 6. Move the cursor directly downward, and you will see an X appear at 
the cursor, directly below the reference point (see Figure 5.5).

Endpoint osnap marker with
superimposed green cross
(temporary tracking point)

X indicates start
point of the line

Endpoint: 0´–4˝ < 270.00°

F I G u R E   5 . 5 :   Pause the cursor over the endpoint to select the reference point.
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The green cross indicates the temporary tracking point for the 
Object Snap Tracking tool, and the X indicates the point where the 
line will start.

 7. Enter 3↵ (76↵) to use the direct entry method to start the first line 
3″ (76 mm) below the temporary tracking point. With Ortho mode 
turned on, the point selected is directly below the corner of the jamb.

 8. Hold the crosshair cursor directly to the right of the last point; when 
you see the alignment path and tooltip, enter 2↵ (51↵), as shown in 
Figure 5.6.

F I G u R E   5 . 6 :   Using direct input to draw the bottom edge of the threshold

AutoCAD draws the bottom edge of the threshold. You used direct 
entry with Ortho mode again, and you didn’t have to enter the rela-
tive polar or the Cartesian coordinates.

 9. Hold the crosshair cursor directly above the last point; when you 
see the alignment path and tooltip, enter 7′6″↵ (2286↵). AutoCAD 
draws the front edge of the threshold.

 10. Select Perpendicular from the Object Snap context menu 
(Shift+right-click) and move the cursor to the outside wall line. 
Alternatively, you can enter PER at the command line to enable the 
Perpendicular osnap.
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 11. When the Perpendicular icon appears on the wall line, as shown in 
Figure 5.7, click to draw the top edge of the threshold.

F I G u R E   5 . 7 :   Use the Perpendicular osnap to draw the final line.

 12. Press ↵ to end the LINE command.
The completed front threshold looks like Figure 5.8.

F I G u R E   5 . 8 :   Completing the front threshold
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t I P  When using object snaps to locate points within a drawing, you do not need 
to select the osnap icon itself. Notice how the cursor in Figure 5.7 is located slightly 
above and to the right of the point AutoCAD found by using the Perpendicular object 
snap. Regardless of where you select, a perpendicular line will be drawn to the point 
highlighted by the Perpendicular osnap icon.

 13. Use the Zoom Extents (ZOOM) command to view the completed front 
threshold with the whole floor plan. Remember, by default, double-
clicking the middle button on a wheel mouse performs a Zoom 
Extents (ZOOM) command.

 14. Save your drawing as I05-01-FrontThreshold.dwg (M05-01-
FrontThreshold.dwg) by choosing Application menu ➢ Save As ➢ 
AutoCAD Drawing.

Drawing the Back threshold
The method of drawing the threshold for the back door is the same as the 
method used to draw the front threshold. You will use Ortho mode, direct input, 
and Object Snap Tracking to draw the lines. Here is how it’s done:

 1. Make sure I05-01-FrontThreshold.dwg (M05-01-FrontThreshold 
.dwg) is open.

 2. Zoom and pan until the back door fills the drawing area.

 3. Start the LINE command, and place the cursor over the left corner 
of the lower jamb. Then, after the temporary tracking point cross 
appears inside the endpoint marker, move the cursor directly down-
ward, as shown in Figure 5.9.

F I G u R E   5 . 9 :   Starting the rear threshold

www.MouradEngineering.com



 D r a w i n g  t h e  T h r e s h o l d s  1 8 5

 4. Enter 3↵ (76↵) to set the start point of the line 3″ (76 mm) below the 
edge of the jamb.

 5. Move the cursor directly to the left; then enter 2↵ (51↵) to draw the 
lower edge of the threshold.

 6. Finish the threshold by moving the cursor directly upward and enter-
ing 3′6″↵ (1067↵).

 7. Use the Perpendicular object snap to draw to the edge of the thresh-
old, perpendicular to the outside wall.

 8. Press ↵ to end the LINE command. The back threshold should look 
like Figure 5.10.

F I G u R E   5 . 1 0 :   The completed back threshold

www.MouradEngineering.com



1 8 6 	 C h a p t e r 	 5 	 • 	 D e v e l o p i n g 	D r aw i n g 	 S t r a t e g i e s : 	 P a r t 	 2

 9. Use the Zoom Extents (ZOOM) command to view the completed front 
and back thresholds with the whole floor plan.

 10. Save your drawing as I05-02-BackThreshold.dwg (M05-02-
BackThreshold.dwg).

When you drew the first threshold, this exercise may have seemed compli-
cated, but it was probably easier when you drew the second one. Like many tech-
niques available in AutoCAD, these methods will become second nature with a 
little practice, and you’ll use them more efficiently. In the next exercise, you will 
draw the cabin’s front deck and stairs, and then you’ll use the existing geometry 
to draw the back deck and stairs.

Drawing the Decks and Stairs
The decks consist of the platform, posts, railings, and a set of stairs. You’ll begin 
by using the OFFSET command to draw polylines for the perimeter, to facili-
tate the drawing of the railing lines. Then you’ll continue the construction by 
using lines and the OFFSET and TRIM commands. You will also begin using the 
Temporary Track Point osnap, an option with the Object Snap Tracking tool.

Drawing the Front Deck
The dimensions of the front deck that you’ll draw are shown in Figure 5.11.

Follow these steps to draw the front deck:

 1. Make sure I05-02-BackThreshold.dwg (M05-02-BackThreshold.dwg) 
is open.

 2. Right-click the Polar Tracking button on the status bar at the bottom 
of the screen, and then choose Tracking Settings from the context 
menu. The Drafting Settings dialog box opens. By default, the Polar 
Tracking tab is active (see Figure 5.12).
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F I G u R E   5 . 1 1 :   The dimensions of the front deck and stairs
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F I G u R E   5 . 1 2 :   The Polar Tracking tab of the Drafting Settings dialog box

 3. Before using Polar Tracking, you need to change a few settings:

 a. In the upper-left corner of the Polar Tracking tab, click the 
Polar Tracking On check box.

This has the same effect as clicking the Polar Tracking button 
in the status bar or pressing F10 from the Application window.

 b. In the Polar Angle Settings area, change the Increment Angle 
to 45.00.

 c. In the Polar Angle Measurement area, make sure that Absolute 
is selected.

 d.  Click OK to exit the Drafting Settings dialog box.
The Polar Tracking button is turned on in the status bar, and Ortho 

mode is automatically turned off. Polar Tracking is similar to Ortho 
mode, but it provides more angular increments to which you can snap 
the cursor.
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 4. Turn off the Object Snap Tracking button in the status bar.

 5. Start the Polyline (PLINE) command, and draw a polyline from the 
lower-right corner of the cabin to a point 8′-0″ (2438 mm) to the right.

 6. Use the Perpendicular Object Snap by entering PER↵ at the command 
line, or by pressing the Ctrl key and the right mouse button simulta-
neously. Place the cursor over the top-outside horizontal line of the 
cabin and, when the Snap marker appears (see Figure 5.13), click to 
draw the vertical line of the deck’s perimeter.

F I G u R E   5 . 1 3 :   Drawing the vertical line perpendicular to the upper cabin wall

 7. Click the top-right corner of the cabin to complete the perimeter of 
the deck, and then press ↵ to end the Polyline (PLINE) command.

Your drawing should look like Figure 5.14.
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F I G u R E   5 . 1 4 :   The perimeter of the front deck

 8. Offset the perimeter 3″ (72 mm) to the inside to represent the inside 
and outside edges of the handrail, and then terminate the OFFSET 
command.

 9. Save your drawing as I05-03-FrontDeck.dwg (M05-03-FrontDeck.dwg).

Drawing the Deck Posts
There are four posts on the deck: two 8″ (204 mm) posts at the corners that 
hold up the roof, and two 4″ (102 mm) posts at the top of the stairs. You will use 
the Rectangle (RECTANG) command to draw the posts and the MIRROR command 
to copy them:

 1. Make sure I05-03-FrontDeck.dwg (M05-03-FrontDeck.dwg) is open.
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 2. Use the Rectangle (RECTANG) command, found on the Home tab ➢ 
Draw panel ➢ Rectangle tool, to draw a post 8″ × 8″ at the lower-
right corner of the deck.

To do this, start the Rectangle (RECTANG) command. At the Specify 
first corner point or: prompt, click the endpoints where the 
lines form the lower-right corner of the deck. At the Specify other 
corner point or: prompt, enter -8,8↵ (-204,204↵) to draw the 
first 8″ (204 mm) post.

The rectangle should be similar to Figure 5.15.

F I G u R E   5 . 1 5 :   The first corner post

t I P  You can start an AutoCAD command and then select objects, or you can select 
the objects first and then start the command.
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 3. To create the opposite post, select the rectangle that you just drew 
and then start the MIRROR command (Home tab ➢ Modify panel ➢ 
Mirror tool).

 4. At the Specify first point of mirror line: prompt, use the 
Midpoint Object Snap. Then pause the cursor over either of the ver-
tical handrail lines.

When a feature is symmetrical like the deck, you can use the 
Midpoint snap to mirror objects about the centerline.

 5. Move the cursor directly to the left or right, as shown in Figure 5.16, 
to mirror the post. Then do the following:

F I G u R E   5 . 1 6 :   The first deck posts are in place.

 a. Click to execute the mirror.

 b. Press ↵ to accept the No option for deleting the source object.

 6. Use the TRIM command to trim the short polyline segments that fall 
within the posts.

When you are finished, each segment should look similar to 
Figure 5.17.
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F I G u R E   5 . 1 7 :   Trim the handrail lines to clean up the post.

 7. Save your drawing as I05-04-DeckPosts.dwg (M05-04-DeckPosts.dwg).

The 4″ (102 mm) posts at the top of the stairs are centered on the 3″ (72 mm) 
handrails on the deck and on the stairs. To create the lower small post, you 
need to locate the bottom-right corner at a point 1 ⁄2″ (15 mm) to the right of 
the front handrail and 5′-8 1⁄2″ (1740 mm) from the bottom-right corner of the 
deck. Follow these steps:

 1. Make sure I05-04-DeckPosts.dwg (M05-04-DeckPosts.dwg) is open.

 2. Select the large lower post and start the COPY command from the 
Home tab ➢ Modify panel on the Ribbon.

 3. Select the lower-right corner point as the base point and then, at the 
Specify second point or: prompt, enter .5,5′8.5″ (15,1740).
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 4. Press ↵ to end the COPY command. The copied post appears as shown 
in Figure 5.18.

F I G u R E   5 . 1 8 :   The copied deck post

 5. Zoom in to the new post. The bottom-right corner of the post is 
located in the correct location, but the post is twice the size that it 
should be.

 6. Start the SCALE command by clicking the Scale button from the 
Home tab ➢ Modify panel; then select the new rectangle.

 7. With the SCALE command active, select the lower-right corner as the 
base point. Then move the cursor to see the effect when the scale 
is based from that corner. A copy of the selected object appears, as 
shown in Figure 5.19.
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F I G u R E   5 . 1 9 :   A copy of the scaled object appears as you move the cursor.

 8. Enter 0.5↵ to scale the rectangle to 50 percent of its current size.

 9. Save your drawing as I05-05-StairPosts.dwg (M05-05-
StairPosts.dwg).

Drawing the Stairs
You could mirror the 4″ (102 mm) rectangle now to create the reciprocal post, 
but we’ll wait until the stair handrails are complete and then mirror both 
objects at once. The first stair handrail is 3″ (76 mm) wide and centered on the 
4″ (102 mm) post, so you’ll use a temporary tracking point to locate the first 
point of the line.

 1. Make sure I05-05-StairPosts.dwg (M05-05-StairPosts.dwg) is 
open.

 2. Start the LINE command, and enter TT↵ at the command line to 
establish a temporary track point.

 3. Using the running Endpoint osnap, click the lower-right corner of 
the small post to locate the temporary tracking point.

 4. With the temporary tracking point located, move the cursor directly 
upward and enter .5↵ (13↵) to place the start point 1 ⁄2″ (13 mm) 
above the corner.
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 5. To complete the handrail, do the following:

 a. Move the cursor directly to the right, and enter 3′5.5↵ (1054↵).

 b. Move the cursor directly upward, and enter 3↵ (72↵).

 c. Move the cursor directly to the left, and enter 3′5.5↵ (1054↵).

t I P  Instead of entering the exact distance of the final line, you could also use the 
Perpendicular object snap to complete the handrail.

Your first handrail should look like Figure 5.20.

F I G u R E   5 . 2 0 :   The first handrail
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 6. Save your drawing as I05-06-DrawStairRail.dwg (M05-06-
DrawStairRail.dwg).

Mirroring the Post and Railing
You can now mirror the post and railing to draw them on the opposite side of 
the stairway. You can’t use the midpoint of the deck’s perimeter line as one 
point of the mirror line, because the stair is centered on the front door and not 
on the deck. You can, however, use the midpoint of the front door’s threshold. 
Follow these steps:

 1. Make sure I05-06-DrawStairRail.dwg (M05-06-DrawStairRail.dwg) 
is open.

 2. Select the 4″ (102 mm) post and all three lines that make up the 
handrail. Try using a window selection (drag from left to right) to 
select the objects rather than picking them one at a time.

 3. Start the MIRROR command.

 4. Use the Midpoint osnap, and then specify the midpoint of the verti-
cal threshold line as the first point of the mirror line, as shown in 
Figure 5.21.

F I G u R E   5 . 2 1 :   Using the midpoint of the threshold as the first mirror point

 5. Move the cursor to the right, and then click to specify the second 
point of the mirror line. Press ↵ to retain the source objects.
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Your deck should look like Figure 5.22.

F I G u R E   5 . 2 2 :   The deck with both handrails

 6. Zoom in until you can see both stair handrails and posts.

 7. Break the outside perimeter line of the deck into individual line enti-
ties by using the EXPLODE command.

 8. Start the COPY command from the Home tab ➢ Modify panel. Select 
the outside perimeter line of the deck to begin building the stairs.

 9. Pick any point near the stairs at the Specify base point: prompt.
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 10. Enable the Array option of the COPY command by entering A↵ at the 
Specify second point: prompt.

 11. Use the following values to complete the array:

 a. Enter 5↵ at the Enter number of items to array: prompt.

 b. Move your cursor directly to the right, and enter 10↵ (254↵) at 
the Specify second point or: prompt (see Figure 5.23).

F I G u R E   5 . 2 3 :   Using the Array option of the COPY command to create stairs 
for the deck

 12. Verify that the preview looks like Figure 5.24, and then press ↵ to 
accept the array. The COPY command ends, and your stairs are drawn.

F I G u R E   5 . 2 4 :   The stairs created using the COPY command

Now you will use the TRIM command to trim away the stair lines 
that extend into and beyond the railings and the lines that pass 
through the 4″ (102 mm) posts.
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 13. Start the TRIM command. Select both of the inside lines of the stairway 
handrails and the 4″ (102 mm) post polylines as the cutting-edge objects.

t I P  Make sure that you do not select the offset perimeter polylines as cutting 
edges. When polylines are selected as cutting edges and then as the trimmed objects, 
they are trimmed back to the endpoint nearest to the picked location.

 14. Trim the four stair lines on both sides of the railing.

 15. Of the two vertical lines that extend between the two posts, trim only 
the left vertical line.

 16. Trim away the four short lines that pass through the two 4″ (102 
mm) posts, and erase the additional line along the inside perimeter.

When complete, your front stairway should look like Figure 5.25.

F I G u R E   5 . 2 5 :   The completed front stairs

 17. Zoom to the drawing’s extents.

 18. Save your drawing as I05-07-FrontStairs.dwg (M05-07-
FrontStairs.dwg).
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Drawing the Back Deck and Stairs
The deck, handrails, posts, and stairs at the rear portion of the cabin are simi-
lar to the same features at the front of the cabin. One of the most significant 
strengths of CAD software over traditional hand drafting is the ability to use 
existing geometry and linework in a drawing to create additional identical or 
similar objects. In this section, you will first mirror the front deck to the back of 
the cabin. I will then introduce you to the STRETCH command to adjust the lines 
to match the cabin’s structure. Figure 5.26 shows the dimensions of the rear 
deck that are different from those on the front deck.

F I G u R E   5 . 2 6 :   The dimensions of the rear deck and stairs
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Mirroring the Front Deck

Several similarities exist between the front and back decks of the cabin. Using 
these similarities to your advantage, the following steps utilize this existing 
geometry by mirroring the front deck to the back of the cabin:

 1. Make sure I05-07-FrontStairs.dwg (M05-07-FrontStairs.dwg) is open.

 2. Verify that the following drawing modes are active:

▶▶ Polar Tracking

▶▶ Object Snap

▶▶ Dynamic Input

 3. Start the MIRROR command.

 4. Use a crossing selection window to select all the components of the 
front deck, but do not select the cabin wall, front door, or threshold.

If you inadvertently select an unwanted object, hold down the Shift 
key and pick the object again to deselect it. The dashed, selected set 
should look like Figure 5.27.

F I G u R E   5 . 2 7 :   The selected front deck and steps
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 5. At the Specify first point of mirror line: prompt, activate the 
Midpoint osnap and click near the midpoint of the top, outside wall line.

As discussed earlier, as long as the Midpoint snap marker displays 
at the correct midpoint, it is not necessary to pick the exact midpoint 
of the line.

 6. Move the cursor downward. With Polar Tracking active, the cursor is 
restricted to the 270 angle, causing the deck to be mirrored perfectly 
to the rear of the cabin, as shown in Figure 5.28.

F I G u R E   5 . 2 8 :   Mirroring the front deck to the rear of the cabin

 7. Click to define the mirror line, and press ↵ to retain the source 
objects. The front deck is mirrored to the back of the cabin.

 8. Save your drawing as I05-08-MirrorDeck.dwg (M05-08- 
MirrorDeck.dwg).

using the STRETCH  Command to Size the Deck

The STRETCH command is used to lengthen or shorten objects in the drawing 
area. The major restriction when using it is that the objects must be selected 
with a crossing window or crossing polygon, so be sure to define your selection 
window from right to left or to enter CR↵ at the Select objects: prompt.

When part of an object resides inside the crossing window borders, the por-
tion inside the window is moved, the portion crossing the border is stretched, 
and the portion outside the border is unaffected. When an object is completely 
inside the crossing window, it is affected as if the MOVE command were used.

Figure 5.29 shows the result when the top portion of the objects in a drawing 
are selected and stretched. The far-left image shows a crossing selection window 
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encompassing the entire top portion of the objects, and the middle-left image 
shows the result of stretching the objects upward. The middle-right image shows 
a crossing selection window encompassing only the right half of the top portion 
of the objects, and the far-right image shows the result of stretching the objects 
upward. Some objects cannot be stretched, such as circles, ellipses, and blocks.

Specify opposite corner: Specify opposite corner:

F I G u R E   5 . 2 9 :   Selecting and stretching the entire top portion (left) and only the top-right 
portion (right)

Complete the following steps to fix the rear deck and stairs by using the 
STRETCH command:

 1. Make sure I05-08-MirrorDeck.dwg (M05-08-MirrorDeck.dwg) is open.

 2. Zoom in to the rear deck and stairs.

 3. Start the STRETCH command from the Home tab ➢ Modify panel ➢ 
Stretch tool, or enter S↵ at the command line.

 4. At the Select objects: prompt, place the cursor above the deck 
and to the right of the stairs, but be sure the point is to the left of the 
threshold (see Figure 5.30).

 5. At the Specify opposite corner: prompt, click a point outside and to 
the left of the deck, as shown in Figure 5.30. The deck objects glow to 
indicate that they are selected. Press ↵ to discontinue selecting objects.

Like the MOVE command, STRETCH requires you to specify a base 
point and a second point to define the result of the stretch. The 
selected objects are stretched to the same distance and angle as the 
relationship between those two points. For example, after select-
ing objects to stretch on the right side of the drawing area, you can 
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select a base point on the left side of the drawing area and a second 
point 2″ above the base point. The selected objects on the left are 
stretched upward 2″.

You can reference objects or features in the drawing area or select 
a random point for the base and specify the angle and distance for 
the second point.

F I G u R E   5 . 3 0 :   Selecting the deck components for the STRETCH command

 6. The open end of the deck needs to be stretched 4′-0″ (1220 mm) to the 
right. Pick a point anywhere in the drawing area and then move the 
cursor to the right. You will see the deck stretching to the right while 
a glowing version remains in place (see Figure 5.31).
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F I G u R E   5 . 3 1 :   The deck after specifying the base point for the STRETCH 
command

 7. Enter 4′↵ (1220↵). The deck is stretched 4′-0″ (1220 mm) to the right.

 8. Save your drawing as I05-09-StretchDeck.dwg (M05-09-
StretchDeck.dwg).

using Point Filters to Finish the Deck
To complete the back deck, you need to align the center of the stair with the 
center of the door. To do this, we’ll combine what you already know about object 
snaps with the STRETCH command and a feature named point filters. Point filters, 
also called coordinate filters, are tools that allow you to use only the X, Y, or Z 
value of a selected point in the drawing area.

For example, suppose you want to stretch an object to the center of a rectan-
gle but you don’t know where that center is located. You could draw a bunch of 
construction lines, only to erase them in a few minutes, or you could forgo all of 
that with point filters. In this scenario, you would use the X point filter and pick 
the midpoint of a horizontal line from the rectangle; then you’d use the Y point 
filter and pick the midpoint of a vertical line from the rectangle.
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The resulting location is at the intersection of the midpoints of the two sides of 
the rectangle at the center point. More important, you didn’t spend any unneces-
sary time drawing and then erasing construction lines. Let’s take a look at how 
you can employ this same method to finish the back deck. Follow these steps:

 1. Make sure I05-09-StretchDeck.dwg (M05-09-StretchDeck.dwg) is open.

 2. Verify that Polar Tracking and Object Snap are still enabled, and then 
turn on the Endpoint and Midpoint object snaps from the Drafting 
Settings dialog box, as shown in Figure 5.32.

F I G u R E   5 . 3 2 :   Enabling the Endpoint and Midpoint object snaps from the 
Drafting Settings dialog box

 3. Create a crossing selection window around the stairs, stair handrails, 
and stair posts, as shown in Figure 5.33.
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F I G u R E   5 . 3 3 :   Select the stairs for the next STRETCH command.

 4. At the Specify base point or: prompt, use the Midpoint osnap and 
pick the midpoint of the top step.

 5. At the Specify second point or: prompt, hold the Shift key down 
and right-click to open the Osnap context menu. Choose Point 
Filters ➢ .X (see Figure 5.34).

F I G u R E   5 . 3 4 :   Select the X point filter from the Object Snap context menu.
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This allows you to pick a point that is horizontally (X) equal to the 
same location as the point you selected in step 4 and vertically (Y) 
equal to the midpoint of the threshold.

The prompt in the command-line interface has .X appended to 
indicate that AutoCAD will use only the X component of the next 
location picked.

 6. Click either endpoint of the top step. This point is in line with the 
midpoint you picked in step 4, so the stretch will move the stairs ver-
tically, not horizontally.

Move the cursor around in the drawing area, and you’ll see that 
the movement of the stairs is now restricted to the y-axis. In the 
command-line interface, the notation (need YZ) is appended to the 
prompt, indicating that AutoCAD will use only the Y and Z compo-
nents of the next location picked. (Only the y-axis is referenced if you 
are using the Autodesk® AutoCAD LT® program.)

 7. Click the Snap To Midpoint button in the Object Snap toolbar, and 
then click the midpoint of the threshold (see Figure 5.35).

F I G u R E   5 . 3 5 :   Select the midpoint of the threshold as the Y and Z 
components of the second point.
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 8. The stairs are moved vertically and centered on the back door. Zoom 
to the drawing’s extents. Your drawing should look like Figure 5.36.

F I G u R E   5 . 3 6 :   The cabin after completing the back deck

 9. Save your file as I05-10-PointFilter.dwg (M05-10-PointFilter.dwg).

Laying out the Kitchen
The kitchen for the cabin will have a stove, a refrigerator, and a counter with a 
sink. The refrigerator is set 2″ (51 mm) from the back wall. Approaching this 
drawing task, your goal is to think about the easiest and fastest way to com-
plete it. The first step in deciding on an efficient approach is to ascertain what 
information you have about the various parts and what existing elements in the 
drawing will be available to assist you. Figure 5.37 gives you the basic dimen-
sions, and you’ll get more-detailed information about the sink and stove as you 
progress through the exercise.
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F I G u R E   5 . 3 7 :   The general layout of the kitchen

Drawing the Counter
Although the counter is in two pieces, you’ll draw it as one piece and then cut 
out a section for the stove. You can try two different ways to draw the counter to 
see which method is more efficient.

Method 1: using object Snap tracking and Direct Entry

The first drawing method uses Object Snap Tracking and direct entry:

 1. Continue with the drawing from the previous exercise or open 
I05-10-PointFilter.dwg (M05-10-PointFilter.dwg) from the 
book’s web page.

 2. Use a zoom window to zoom your view so that it is about the same 
magnification as Figure 5.38.
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F I G u R E   5 . 3 8 :   Zoom in to the kitchen area.

 3. From the status bar, turn on Object Snap Tracking. Verify that Polar 
Tracking, Object Snap, and Dynamic Input are still on. The rest of the 
buttons should be off.

 4. Start the LINE command to begin drawing the counter.

 5. Place the cursor near the lower end of the right-rear doorjamb line, 
where the door swing meets the wall. A small cross is superimposed 
over the Endpoint osnap icon, indicating the reference location for 
Object Snap Tracking.

 6. Move the cursor upward. Then enter 8↵ (204↵) to start the counter 
line 8″ (204 mm) from the corner of the jamb (see Figure 5.39).

 7. Hold the crosshair cursor directly to the right of the first point of the 
line, and enter 2′↵ (610↵).

 8. Hold the crosshair cursor upward, and enter 4′↵ (1220↵).
At this point, you have drawn two line segments defining the 

counter on the back wall of the cabin. You can see the dimensions in 
Figure 5.37, shown earlier.
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F I G u R E   5 . 3 9 :   Setting the location for the first counter line

 9. Hold the cursor to the right again, and enter 5′1″↵ (1550↵) to draw 
the long counter line that runs in front of the sink.

 10. Select the Perpendicular osnap, and then pick the inside wall line, as 
shown in Figure 5.40, to complete the counter.

F I G u R E   5 . 4 0 :   Completing the counter

 11. Press ↵ to end the LINE command.
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Method 2: using OFFSET  and FILLET

As with launching commands, most tasks in AutoCAD give you options galore 
for completing them. Although some methods are viewed as being more effi-
cient than others, the “best” method is often a matter of personal preference. In 
this exercise, you’re going to draw the same counter you drew in the previous 
exercise, except this time you will use the OFFSET and FILLET commands.

To complete this exercise, you’ll need to erase the countertop you just drew. 
You could use the ERASE command to do this, but because all four of the line 
segments were drawn in one cycle of the LINE command, you can also use 
the UNDO command. Follow these steps to begin using the OFFSET and FILLET 
commands:

 1. Click the Undo button on the Quick Access toolbar, enter U↵ at the 
command line, or use the standard Windows keyboard shortcut Ctrl+Z.

Alternatively, you can open I05-10-PointFilter.dwg (M05-10-
PointFilter.dwg) from the book’s web page.

The counter you just drew should disappear. If you ended the LINE 
command while drawing the counter and had to restart it before you 
finished, you might have to click the Undo button more than once.

If you undo too much, click the Redo button, which is just to the 
right of Undo.

Now you’ll draw the counter again, this time using the OFFSET and 
FILLET commands.

 2. Offset both the left-inside wall line and the top-inside wall line 2′ 
(610 mm) to the inside of the cabin.

 3. Stop and then restart the OFFSET command. This time, offset the 
inside left wall line 7′-1″ (2159 mm) to the right.

 4. Next, offset the inside top wall line 6′-0″ (1829 mm) downward—
the sum of the two counter dimensions and the stove dimension 
(see Figure 5.41).
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F I G u R E   5 . 4 1 :   Offsetting wall lines to create the counter

t I P  As discussed previously, if the FILLET command has a nonzero radius set-
ting that you want to keep, hold down the Shift key to set the radius to zero for one use of 
the command. After the command ends, the radius returns to its nonzero setting.

 5. Use the FILLET command with a radius of 0 to clean up the three cor-
ners. Be sure to click the portions of the lines that you want to retain.

 6. Save your file as I05-11-KitchenCounter.dwg (M05-11-
KitchenCounter.dwg).

Now that you have tried both methods of creating the counter, you can decide 
which one is more practical for you. Both are powerful techniques for laying out 
orthogonal patterns of lines for walls, counters, and other objects.
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undoing and Redoing in AutoCAD

AutoCAD has various Undo options, and they operate quite differently from each 
other:

▶▶ When you click the Undo button on the Quick Access toolbar, you’re using 
the AutoCAD UNDO command. You can also start it by entering U↵. The 
UNDO command works like the Undo command for Windows-compliant 
applications by undoing the results of the previous commands one step 
at a time. Using the Ctrl+Z hot-key combination also executes the UNDO 
command.

▶▶ The UNDO command in AutoCAD has many options, and you start it by 
entering UNDO↵. You use this approach when you want to undo every-
thing you’ve done since you last saved your drawing or to undo back to a 
point in your drawing session that you specified earlier by using the Mark 
option. Be careful when you use the UNDO command; you can easily lose 
a lot of your work.

▶▶ The OOPS command is a special Undo tool that restores the last objects 
erased, even if the ERASE command wasn’t the last command executed.

▶▶ The REDO command will undo the effect of several undo operations. So, 
if you undo a few steps too many, you can still get them back. The Redo 
tool must be used immediately after using the Undo tool.

▶▶ Both the Undo and Redo buttons on the Quick Access toolbar have small 
down-arrows to their right. Clicking these arrows displays a drop-down 
menu showing a list of the recent commands used (Undo) or undone (Redo). 
When there are several commands to be undone or redone, selecting the 
command to be undone may be faster than clicking the Undo or Redo 
button repeatedly.

Drawing the Stove and Refrigerator
The stove and refrigerator are simple rectangles. Here you will use the 
Temporary Tracking Point osnap to locate the first corner of each shape:

 1. Make sure I05-11-KitchenCounter.dwg (M05-11-KitchenCounter 
.dwg) is open.

 2. To begin drawing the refrigerator, click the Rectangle button on the 
Home tab ➢ Draw panel, or enter REC↵ at the command line.
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 3. Verify that Object Snap, Object Snap Tracking, and Dynamic Input 
are still enabled on the status bar.

 4. Place your cursor near the upper end of the right side of the counter, 
letting the running Endpoint osnap establish an object snap tracking 
point.

 5. Move your cursor down, and enter 2↵ (51↵), as shown in Figure 5.42.

F I G u R E   5 . 4 2 :   Locating the first corner of the rectangle

This starts the rectangle 2″ (51 mm) from the back wall, along the 
side of the counter.

 6. To specify the opposite corner of the rectangle, enter 
36,-36↵914,-914↵.

The Rectangle (RECTANG) command ends, and the refrigerator is 
drawn at the end of the counter that is running along the back wall. 
Next you’ll use a similar process to draw a basic outline of the stove.

 7. Right-click and choose Repeat RECTANG from the context menu 
that opens.

 8. Use the technique from step 4, but pick the lower end of the left side 
of the counter as the tracking point.

 9. Hold the cursor directly above that point, and enter 1′5″↵ or 17↵ 
(432↵). Then enter 26,27↵ (660,686↵) to complete the rectangle.

 10. Use the TRIM command to trim away the front edge of the counter 
that passes through the stove.

Your kitchen should look like Figure 5.43.
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F I G u R E   5 . 4 3 :   The stove and refrigerator made with rectangles

 11. Save your file as I05-12-Refrigerator.dwg (M05-12- 
Refrigerator.dwg).

n o t E  Because the stove rectangle is drawn as a polyline, you need to select 
only one segment of it for all sides of the rectangle to be selected and, in this case, for 
them to become cutting edges.

Completing the Stove with Parametrics
At this point, the cabin is really starting to take shape with the numerous lines, 
arcs, and polylines that you have drawn. There is, however, a significant discon-
nect between what you see and what AutoCAD sees while viewing the cabin. To 
you, it’s a cabin; you see how the stairs are spaced equally, how the wall inter-
sections form perpendicular angles, and in general how objects relate to other 
objects within your drawing.

AutoCAD, on the other hand, sees nothing more than a collection of lines, 
arcs, and polylines. It doesn’t know that walls should form 90˚ angles where they 
intersect or that the two lines representing door openings should be parallel and 
spaced a certain distance apart. Currently, every object inside your drawing is 
independent from the other objects in your drawing.
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Parametric drawing offers a solution to this disconnect; it allows you to assign 
both geometric and dimensional constraints to the objects inside your draw-
ing. Whereas dimensional constraints must be applied manually, geometric 
constraints may be applied manually, automatically, or inferred while drawing. 
Using the dimensions shown in Figure 5.44, you’ll have the chance to explore 
each of these methods as you use parametrics to complete the stove.

F I G u R E   5 . 4 4 :   The details of the stove
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AutoCAD Lt users

The AutoCAD LT Ribbon does not include tools for creating geometric or dimen-
sional constraints because parametric drawing is one of the features found only in  
the full version of AutoCAD. Because AutoCAD LT users will not be able to com-
plete the next several exercises on parametric drawing, substitute the following 
exercise to complete the stove:

1. Make sure I05-12-Refrigerator.dwg (M05-12-Refrigerator 
.dwg) is open.

2. Start the INSERT command by using the Insert button found on the  
Insert tab ➢ Block panel. The Insert dialog box appears.

3. Cl ick the Browse but ton to browse to and selec t the f i le I05-
StoveInsert.dwg (M05-StoveInsert.dwg) found inside the 
Chapter 5 data folder, and click Open.

If you haven’t done so already, you can download this f ile from this  
book’s web page at www.sybex.com/go/autocad2015ner  or  
www.thecadgeek.com.

4. You are taken back to the Insert dialog box. Before clicking OK, select the 
Specify On-Screen check box under Insertion Point and the Explode check 
box in the lower-left corner.

The Insert dialog should look similar to the following graphic.

(Continues)
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5. Use the Endpoint osnap to select the lower-back corner of the stove.

The stove is completed as the remaining geometry is inserted into the drawing.

6. Save your f ile as I05-16-CompleteStove.dwg  (M05-16-
CompleteStove.dwg).

Proceed to the “Drawing the Kitchen Sink” exercise later in this chapter.

Getting Started with Geometric Constraints

The first step in using parametric drawing is to define how objects should 
interact geometrically. This is done by assigning geometric constraints to your 
model. These constraints will reinforce the use of tools such as object snaps to 
define the intersection of two lines as coincident, or two lines forming a right 
angle as perpendicular. Because you’re not yet dealing with size, the primary 
focus in this exercise is to ensure that objects that should intersect do so, 
objects that should form right angles are indeed perpendicular, and parallel 
lines are truly parallel.

AutoCAD Lt users (Continued)
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Assuming you were diligent in creating your linework, the AutoConstrain tool 
will automatically determine and assign the necessary geometric constraints. 
Follow these steps to AutoConstrain your stove:

 1. Make sure I05-12-Refrigerator.dwg (M05-12-Refrigerator.dwg) is 
open, and zoom in to a closer view of the stove.

 2. Select the current outline of the stove, and click the AutoConstrain 
tool, which is found on the Parametric tab ➢ Geometric panel.

After you invoke AutoConstrain, a series of icons appear along the 
perimeter of the stove, as shown in Figure 5.45. These icons illus-
trate the geometric relationships AutoCAD established between the 
four lines that define the outline of your stove.

F I G u R E   5 . 4 5 :   Geometric constraints applied by using the AutoConstrain tool

The positioning of these icons may be slightly different from what’s 
shown in Figure 5.45, but you should have the same geometric con-
straints as shown.

 3. Hover the cursor over the Geometric Constraint icons that are 
around the perimeter of the stove.

The geometric relationship is displayed as you hover over each 
Geometric Constraint icon. For instance, the parallel geometric con-
straint highlights both the adjacent Geometric Constraint icon and 
the line to which the two lines are parallel. This inquiry method is 
an especially helpful way of visualizing which objects relate to other 
objects inside your drawing.

 4. Click the Constraint Settings, Geometric button in the lower-right 
corner of the Geometric panel on the Parametric Ribbon tab to open 
the Constraint Settings dialog box.

▶

If no icons appear 
after you invoke 
AutoConstrain, use the 
Show All tool found on 
the Parametric tab ➢ 
Geometric panel.
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 5. On the Geometric tab of the dialog box, turn on Infer Geometric 
Constraints. Click OK.

 6. Use the LINE command and the Nearest and Perpendicular object 
snaps to draw a vertical line, as shown in Figure 5.46.

F I G u R E   5 . 4 6 :   Geometric constraints inferred after drawing a line

 7. Save your file as I05-13-AutoConstrain.dwg (M05-13-
AutoConstrain.dwg).

Don’t worry about being accurate as you draw the stove at this 
point. You’ll apply dimensional constraints in a moment. Right now 
you’re interested in only the geometric relationships between objects.

Drawing the Stove Burners

The next step is to draw the circles that represent the burners. As with the last 
exercise, you don’t have to be overly concerned about size at this point. Instead, 
focus on getting the geometry correct first, and then you’ll come back to further 
constrain the stove with dimensional constraints.

 1. Make sure I05-13-AutoConstrain.dwg (M05-13-AutoConstrain.dwg) 
is open.
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 2. Click the down arrow next to the Circle tool, found on the Home tab ➢ 
Draw panel, and look at the flyout menu, as shown in Figure 5.47.

F I G u R E   5 . 4 7 :   The Circle command’s flyout menu

You have six options for constructing a circle:

▶▶ The first two (Center, Radius; and Center, Diameter) require 
you to specify a point as the center of the circle and to enter a 
radius or a diameter.

▶▶ You use the next two (2-Point and 3-Point) when you know two 
or three points that the circle must intersect.

▶▶ The last two options (Tan, Tan, Radius; and Tan, Tan, Tan) use 
tangents and a radius, or just tangents, respectively, to form a 
circle.

Notice that each circle construction method has a unique icon on 
the left side of the flyout menu. Whichever method was used last 
becomes the default method when you click the Circle button, and its 
icon appears on the button.

 3. Choose the Center, Radius option from the flyout menu.

 4. The command prompt changes from Specify center point for 
circle or: to Base point:. Draw four circles as shown in Figure 5.48.
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F I G u R E   5 . 4 8 :   Rough schematic representation of the stove

 5. Save your file as I05-14-StoveBurners.dwg (M05-14-StoveBurners.dwg).
Once again, your intent at this point is to develop a solid geomet-

ric representation of the stove. Before you apply dimensional con-
straints, I’ll show you how to add some geometric constraints.

Applying Additional Geometric Constraints

You’ve seen how the AutoConstrain and Infer Constraints features make it easy 
to add geometric constraints to your drawing. Although both are incredibly 
powerful features, sometimes you need an extra degree of control over how geo-
metric constraints are added. For this reason, you have the option of manually 
adding geometric constraints to objects inside your drawing.

Even if you had been more deliberate in drawing the burners with the 
proper alignment and size, the AutoConstrain feature would still have a dif-
ficult time establishing how the four burners truly interact with one another. 
Consequently, to ensure that the constraints are correctly applied, the best 
approach in this case is to define the necessary geometric constraints manually. 
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To do so, you’ll use many of the individual constraint icons found on the 
Parametric tab ➢ Geometric panel.

 1. Make sure I05-14-StoveBurners.dwg (M05-14-StoveBurners.dwg) 
is open.

 2. Confirm that Object Snap and Object Snap Tracking are still enabled 
on the status bar, and that Infer Geometric Constraints is enabled 
within the Constraint Settings dialog box.

 3. Click the Horizontal constraint tool from the Parametric tab ➢ 
Geometric panel.

 4. From the Select an object or [2Points]: prompt, press the down 
arrow to select 2Points, as shown in Figure 5.49.

F I G u R E   5 . 4 9 :   Selecting the 2Points option when using Dynamic Input

 5. Hover over the top-left burner, and select it when a small red circle 
with an X appears in the center, as shown on the left in Figure 5.50.

F I G u R E   5 . 5 0 :   Using the Horizontal constraint to select the center point of 
the circle
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 6. From the Select second point: prompt, use the same method to 
select the center point of the top-right burner, as shown on the right 
in Figure 5.50.

The two right burners (as if you were working at the stove and fac-
ing the rear deck) are now constrained horizontally; this means that, 
although the two burners may be located anywhere along the y-axis, 
they will always be aligned along the x-axis. You can try this out by 
using the MOVE command to move either one of the burners. Notice 
how the second burner also moves even though it was not selected.

 7. Use the Horizontal constraint once again, repeating steps 5 and 6 to 
constrain the two burners on the left side of the stove.

All of the burners are now constrained horizontally; however, there 
is no relationship between the left and right burners. To fix this, you 
will continue constraining the burners, this time applying Vertical 
constraints between the right and left burners.

 8. Click the Vertical constraint tool from the Parametric tab ➢ 
Geometric panel.

 9. At the Select an object or [2Points]: prompt, click the down 
arrow to select 2Points using Dynamic Input.

 10. Use the Vertical 2Point constraint tool to select the center points of 
the two front burners.

 11. Repeat the Vertical constraint tool once again, this time selecting the 
center points of the two rear burners.

Each of the burners is now fully constrained horizontally and 
vertically. Notice how moving a single burner also moves the two 
adjacent burners. Also note the Constraint icons under each of the 
burners. Your stove should look like Figure 5.51.

Because three of the burners will be the same size, you can use the 
Equal geometric constraint to build a relationship between the two 
right burners and the back-left burner. It’s important to remember that 
the focus here is to get the geometry correct. In the next exercise, you’ll 
apply dimensional constraints to size each of the burners correctly.
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F I G u R E   5 . 5 1 :   Burners fully constrained horizontally and vertically

 12. Click the Equal constraint tool from the Parametric tab ➢ Geometric 
panel.

 13. Select the back-right burner and then the front-right burner to set 
the radius of each equal to the back-right burner.

 14. Repeat the process once again, this time selecting the back-right 
burner and the back-left burner.

Your stove should look like Figure 5.52.

F I G u R E   5 . 5 2 :   Stove with Equal constraints applied to three burners
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 15. Save your file as I05-15-GeometricConstraints.dwg (M05-15-
GeometricConstraints.dwg).

Applying Dimensional Constraints

The previous several exercises gave you the opportunity to focus on geometry, 
not dimensions. Although the stove is geometrically correct, it’s drawn with a 
series of arbitrary dimensions. Dimensional constraints let you assign real val-
ues to the geometry in your drawing. Thanks to the geometric constraints you 
already applied to the stove, you’ll need to apply dimensional constraints to only 
a few key points. The geometric constraints will handle the rest for you auto-
matically, ensuring that the integrity of the relationships is retained.

Dimensional constraints function similarly to regular dimensions in 
AutoCAD. You’ll take a closer look at dimensions in Chapter 12, “Dimensioning 
a Drawing,” but your experience with parametrics will certainly provide a great 
foundation from which to build. One core difference between regular dimen-
sions and parametric dimensions is that parametric dimensions require you to 
select both an object and a point. In contrast, regular dimensions require you to 
specify only a point. You’ll use the dimensions shown earlier in Figure 5.44 to 
apply the necessary dimensional constraints.

 1. Make sure I05-15-GeometricConstraints.dwg (M05-15-
GeometricConstraints.dwg) is open.

 2. Add a Linear dimensional constraint to the stove’s rear control panel 
as follows:

 a. Choose the Linear dimensional constraint from the Parametric 
tab ➢ Dimensional panel.

 b. Hover over the bottom-right corner of the stove, and then click 
to accept the endpoint.

 c. Hover over the lower endpoint for the line representing the 
stove’s control panel, and click to accept the point.

 d. Specify a location for the dimensional constraint, and then 
enter 2.5″ (64 mm) as the value for d1 (see Figure 5.53).
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F I G u R E   5 . 5 3 :   Applying a Linear dimensional constraint to the stove’s control 
panel
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 3. Using the Linear tool found on the Parametric tab ➢ Dimensional 
panel once again, add an 8 1⁄2″ (216 mm) constraint between the 
back-lower corner and the center point of the left-rear burner.

 4. Continue using the Linear tool to add the following dimensional 
constraints:

 a. Add a 1′-7 1⁄2″ (495 mm) constraint between the back-lower 
corner and the center point of the left-front burner.

 b. Add a 7 1⁄2″ (190 mm) constraint between the lower-front  
corner of the stove and the left-front burner.

 c. Add a 1′-7 1⁄2″ (495 mm) constraint between the lower-front 
corner of the stove and the right-front burner.

Figure 5.54 shows the result. You have created a total of five Linear 
constraints. These constraints have correctly positioned the rear 
control panel and each of the four burners for the stove. The only 
thing left to do is correctly size each of the four burners.

F I G u R E   5 . 5 4 :   Linear constraints applied to the stove
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Because you used the Equal geometric constraint on three of the 
burners, properly sizing the burners will require only two Radius 
constraints.

 5. Choose the Radius tool from the Parametric tab ➢ Dimensional panel.

 6. From the Select arc or circle: prompt, select the front-right 
burner and choose a position for the dimensional constraint.

 7. Enter a value of 3 1/2″ (89 mm) for the rad1 constraint.
The Equal geometric constraint updates the radius of the back-

right and back-left burners to match the 3 1⁄2″ (89 mm) radius you 
specified for the front-right burner.

 8. Repeat steps 5 through 7 to apply a Radius constraint on the front-
left burner. When prompted for the radius, enter rad1+1↵ (rad1+25).

Figure 5.55 shows the result.

F I G u R E   5 . 5 5 :   Fully constrained stove
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Much like formulas can reference the value of other cells in Microsoft 
Excel, dimensional constraints can reference other dimensional con-
straints. In this example, you referenced a constraint applied to the 
front-right burner by entering its name (rad1). The expression rad1+1 is 
actually a mathematical expression telling AutoCAD to gather the value 
of rad1 (3 1⁄2″) and add 1″ to it for a total radius of 4 1⁄2″ (114 mm).

 9. Save your file as I05-16-CompleteStove.dwg (M05-16-
CompleteStove.dwg).

Drawing the Kitchen Sink
In this section, you’ll draw a double sink with one basin larger than the other 
(see Figure 5.56). You’ll use OFFSET, FILLET, and TRIM to create the sink from 
the counter and wall lines.

F I G u R E   5 . 5 6 :   The sink with dimensions

 1. Make sure I05-16-CompleteStove.dwg (M05-16-CompleteStove.dwg) 
is open. Zoom in to the sink area, keeping the edges of the refrigera-
tor and stove in view.

 2. Create the top and bottom edges by using the OFFSET command:

 a. Offset the inside wall line 2 1⁄2″ (64 mm) down.

 b. Restart the OFFSET command, and offset the inside wall line 
1′-8″ (508 mm).
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This forms the top and bottom edges of the sink. Next, you will 
draw the left and right edges of the sink.

 3. Enable Selection Cycling by entering SELECTIONCYCLING↵ at the 
command line, and then entering 2↵.

Selection Cycling is a useful tool that helps you select the right 
object in crowded areas of a drawing.

 4. Restart the OFFSET command, and set the offset distance to 16″ 
(406 mm).

You’re going to offset the right side of the counter 1′-4″ (406 mm) 
to the left, but it coincides with the left side of the refrigerator. You’ll 
use Selection Cycling to ensure that you select the correct line.

 5. At the Select object to offset: prompt, select the right edge of 
the counter. Because you enabled Selection Cycling in step 3, and 
both the right edge of the counter and left edge of the refrigerator 
coincide with one another, the Selection dialog box is displayed (see 
Figure 5.57).

F I G u R E   5 . 5 7 :   Using Selection Cycling to select the right edge of the counter

 6. Select the Line option from the Selection dialog box, and complete 
the OFFSET command by picking a point to the left of the selected 
line. Notice how the object highlighted in the Selection dialog box is 
also highlighted (with dashes) inside the drawing (see Figure 5.57).

www.MouradEngineering.com



	 L a y i n g 	O u t 	 t h e 	 K i t c h e n  2 3 5

 7. Offset this new line 2′-9″ (838 mm) to the left. This forms the outside 
edge of the sink (see the top of Figure 5.58).

F I G u R E   5 . 5 8 :   The offset lines to form the outside edge of the sink (top), the 
offset lines to form the inside edges of the sink (middle), and the finished sink (bottom)

 8. Fillet the corners of this rectangle to clean them up, using a radius of 0.
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 9. Perform the following offsets to draw the sink basins:

 a. Offset the left side, bottom, and right sides of the sink 1.5″ (38 mm) 
to the inside.

 b. Offset the top side 2.5″ (64 mm) to the inside.

 c. Offset the left basin edge to the right 9″ (229 mm).

 d. Offset the right basin edge to the left 1′-7″ (483 mm). This forms 
the basis of the inside sink lines (see the middle of Figure 5.58).

 10. Trim away the horizontal top and bottom inside sink lines between 
the two middle vertical sink lines.

 11. Fillet the four corners of each basin with a 2″ (51 mm) radius to clean 
them up. Use the Multiple option of the FILLET command so that you 
won’t need to restart the command continually.

 12. Fillet all four outside sink corners with a 1.5″ (38 mm) radius. This 
finishes the sink (see the bottom of Figure 5.58). Use Zoom Previous 
to view the whole kitchen with the completed sink.

 13. Save your file as I05-17-KitchenSink.dwg (M05-17-KitchenSink.dwg).

This completes the kitchen area. You drew no new lines to complete this task 
because you created most of them by offsetting existing lines and then trim-
ming or filleting them. Keep this in mind as you move on to the bathroom.

Constructing the Bathroom
The bathroom has three fixtures—a sink, a shower, and a toilet—as well as a 
mirror and a shelving unit. While you are drawing the bathroom, you’ll draw 
the hot tub in the main room as well (see Figure 5.59). When drawing these fix-
tures, you’ll use a few object snaps over and over again. You can set one or more 
of the osnap choices to run continually until you turn them off. That way, you 
won’t have to select them each time.
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F I G u R E   5 . 5 9 :   The bathroom fixtures and hot tub with dimensions

Setting Running object Snaps
You’ll set three osnaps to run continually for now, until you get used to how 
they work:

 1. Make sure I05-17-KitchenSink.dwg (M05-17-KitchenSink.dwg)  
is open.

 2. Right-click the Object Snap button on the status bar, and then 
choose Settings from the context menu to open the Drafting Settings 
dialog box.

By default, the Object Snap tab is automatically displayed (see 
Figure 5.60).
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F I G u R E   5 . 6 0 :   The Object Snap tab of the Drafting Settings dialog box

Each of the 13 osnap options has a check box and a symbol next to 
it. The symbol appears as a marker in the drawing when you select 
a particular osnap and the cursor is near a point where you can 
use that osnap. You can select any number of osnaps to be running 
simultaneously.

 3. Click the check boxes next to Endpoint, Midpoint, and Intersection. 
Also ensure that the Object Snap On check box is selected in the 
upper-left corner of the dialog box.

 4. Click OK to close the dialog box.
The Endpoint, Midpoint, and Intersection osnaps will now be active 

any time you’re prompted to select a point on the drawing. You can 
deactivate them by turning off the Object Snap button in the status 
bar or by pressing F3.

Now you’re ready to begin drawing the bathroom. The shower determines the 
placement of the other two items, so let’s start there.
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Drawing a Shower unit
You’ll start the shower unit with a rectangle and then trim away one corner. As 
you start this exercise, check the status bar. The Polar Tracking, Object Snap, 
and Object Snap Tracking buttons should be in their On positions. The rest of 
the buttons should be off. Follow these steps:

 1. Make sure I05-17-KitchenSink.dwg (M05-17-KitchenSink.dwg) is open.

 2. Verify that Polar Tracking, Object Snap, and Object Snap Tracking are 
turned on. The remaining drawing modes should be turned off.

 3. If Infer Geometric Constraints is currently on, turn it off by clicking 
the Constraint Settings, Geometric button on the Geometric panel 
of the Parametric Ribbon, and then unchecking the Infer Geometric 
Constraints option.

 4. Enter Z↵E↵ or click the Zoom Extents button to zoom to the draw-
ing’s extents. Then use the zoom window or the scroll wheel to view 
the bathroom close-up.

 5. Start the Rectangle (RECTANG) command and use the following settings:

 a. For the first point, move the cursor to the lower-right inside 
corner of the room. As soon as the Endpoint osnap marker 
appears on the endpoint to which you want to snap, click. This 
places the first corner of the rectangle at the endpoint.

 b. For the second point, enter -40,40↵ (-1016,1016↵).

 6. Start the CHAMFER command from the Home tab ➢ Modify panel. If 
the Chamfer tool isn’t visible on the Ribbon, click the down arrow 
next to the Fillet tool, as shown in Figure 5.61.

F I G u R E   5 . 6 1 :   Starting the CHAMFER command from the Modify Ribbon 
panel
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 7. From the Select first line or [Undo/Polyline/Distance/
Angle/Trim/mEthod/Multiple]: prompt, enter D↵, or select 
Distance to set a chamfer distance.

 8. Enter 1′-8″ (508 mm) for the first and second chamfer distances.

 9. Select the vertical shower edge as the first chamfer line and the hori-
zontal shower edge as the second chamfer edge (see Figure 5.62).

F I G u R E   5 . 6 2 :   Chamfering the shower edges

As you hover over the second line, a preview of the resulting cham-
fer is displayed, similar to the display for the FILLET command. This 
allows you to confirm the chamfer distance values before completing 
the command.

 10. Offset the shower polyline inward 1.5″ (38 mm), as shown in 
Figure 5.63.
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F I G u R E   5 . 6 3 :   The offset shower polyline

 11. Save your file as I05-18-Shower.dwg (M05-18-Shower.dwg).

Next, you’ll draw the sink to the right of the shower.

Drawing the Bathroom Sink and Mirror
You’ll offset a line and draw an ellipse for this fixture while you practice using 
the Temporary Tracking Point osnap option in the process. The Endpoint and 
Midpoint osnaps are still running.

 1. Make sure I05-18-Shower.dwg (M05-18-Shower.dwg) is open, and 
zoom in to the sink area with a zoom window.
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 2. Complete the following offsets to draw the vertical limits of the sink 
counter and the mirror:

 a. Offset the top-inside wall line down 4′ (1219 mm).

 b. Offset the new line up 4″ (102 mm).

 c. Offset the top-inside wall down 4″ (102 mm).

 3. Complete the following offsets to draw the horizontal limits of the 
sink counter and the mirror:

 a. Offset the left inside wall 1′-8″ (508 mm) to the right.

 b. Offset the same inside wall line 1⁄2″ (13 mm) to frame the 
counter and the mirror.

Your sink area should look like Figure 5.64.

F I G u R E   5 . 6 4 :   The offset sink polyline

 4. Use the FILLET command to clean up the lines to form the sink coun-
ter and mirror. You will have to zoom in to each end of the mirror to 
select the correct end of the mirror’s sides and fillet the lines prop-
erly. Figure 5.65 shows the partially completed sink and mirror.
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F I G u R E   5 . 6 5 :   The sink and mirror

 5. Click the down arrow next to the Ellipse button on the Home tab ➢ 
Draw panel, and choose the Center option. Alternatively, you can 
enter EL↵C↵ to start the command from the command line.

 6. Place the cursor near the midpoint of the bottom counter line. When 
the small cross appears in the osnap marker, the first tracking point 
is established.

 7. Establish the center point of the sink counter by using Object Snap 
Tracking:

 a. Move the crosshair cursor to the midpoint of the vertical line 
that defines the front of the counter.

 b. Move the cursor to the left when the cross appears in the 
Midpoint osnap marker. A small, dark X appears at the intersec-
tion to indicate the point that AutoCAD will use for the center 
point of the ellipse (see Figure 5.66).
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F I G u R E   5 . 6 6 :   Defining the center point for the ellipse

 c. Click to define the center point.
Instead of using the direct entry method to define a point with the 

Object Snap Tracking tool, you just used two different object snaps to 
define one point.

 8. The ELLIPSE command requires you to specify a distance for each of 
the major and minor axes:

 a. Hold the crosshair cursor directly to the right of the center 
point. Enter 5↵ (127↵).

 b. Hold the crosshair cursor directly above the center and enter 
7↵ (178↵).

The ellipse is constructed, and the sink fixture is nearly complete.

 9. Use the Offset tool to offset the ellipse 1″ (25 mm) to the outside (see 
Figure 5.67).
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F I G u R E   5 . 6 7 :   The completed sink fixture

Leave the view on your screen as it is for a moment.

 10. Save your file as I05-19-BathroomSink.dwg (M05-19-BathroomSink.dwg).

W A R n I n G  Be aware that of fsetting an ellipse does not create a new 
ellipse but instead creates a spline.

The toilet and the shelves are the final fixtures necessary in the bathroom. 
You’ll use the ELLIPSE command again, along with the RECTANG command, to 
draw them. You’ll also learn about a couple of new display options.

Positioning the toilet and Shelves
The shelves are a simple rectangle measuring 3′ × 1′ (914 mm × 305 mm). The 
toilet consists of a rectangle and an ellipse centered between the sink and  
the wall. The tank is offset 1″ (25 mm) from the back wall, and it is 9″ × 20″ 
(229 mm × 508 mm). The ellipse representing the seat measures 18″ (457 mm) 
in one direction and 12″ (304 mm) in the other. Follow these steps to add the 
shelves and toilet to the bathroom:

 1. Make sure I05-19-BathroomSink.dwg (M05-19-BathroomSink.dwg) 
is open.
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 2. On the Navigation bar, click the Pan button. The cursor changes to a 
small hand to indicate that you are in Pan Realtime mode. Position 
the cursor in the lower part of the drawing area, with the view still 
zoomed in on the sink.

 3. Drag the cursor up and to the right until the toilet area comes into 
view. The drawing slides along with the movement of the cursor. If 
necessary, zoom in and then pan again until you have the toilet area 
centered in the drawing area.

t I P  You can also perform a pan, a lateral change in the viewing area with no 
change in zoom factor, by holding down the middle mouse button or scroll wheel. The 
MBUTTONPAN variable must be set to 1 (enter MBUTTONPAN↵1↵) for this functional-
ity to be available. Now that most people use a wheel mouse, this manner of panning is 
becoming the preferred method. Rolling the wheel to zoom is also common.

 4. Right-click and choose Zoom from the context menu that opens. 
Alternatively, you can enter Z↵↵ at the command line to execute the 
Zoom Realtime operation. Back in the drawing, the cursor changes 
to a magnifying glass with plus and minus signs.

 5. Position the Zoom Realtime cursor near the top of the drawing, and 
hold down the left mouse button. Drag the cursor down, and watch 
the view being zoomed out in real time. Move the cursor up, still 
holding down the mouse button.

Position the cursor in such a way that you have a good view of the 
toilet area, and then release the mouse button. Right-click again and 
choose Exit from the context menu to end Zoom Realtime.

These zooming options are convenient tools for adjusting the view of your 
drawing. Let’s move to the toilet first. You need to find a way to position the toilet 
accurately, centering it between the wall and shower. The midpoint of the left 
wall line isn’t useful because the wall line runs behind the shower. You’ll have to 
use a reference point to locate the starting point for the toilet tank. The lower-left 
corner of the tank is 5″ (127 mm) from the bottom wall and 1″ (25 mm) from the 
left wall. Because there is no osnap feature to define the location on the left wall, 
you will use the From osnap to locate the corner. Follow these steps:

 1. Make sure I05-19-BathroomSink.dwg (M05-19-BathroomSink.dwg) 
is open.

 2. Start the Rectangle (RECTANG) command, and choose the From 
option on the right-click Object Snap menu.

▶

With Zoom Realtime, 
moving the cursor to 
the left or right has 
no effect on the view. 
The magnification is 
controlled solely by the 
up-and-down motion.
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At the Base point: prompt, click the lower-left inside corner of 
the bathroom.

 3. Enter @1,5↵ (@25,127↵) to place the first corner of the rectangle and 
then 9,20↵ (229,508↵).

The 9″ × 20″ (229 mm × 508 mm) toilet tank is drawn centered on 
the left wall (see the left of Figure 5.68).

F I G u R E   5 . 6 8 :   The toilet tank in place (left) and the completed toilet (right)

 4. Start the ELLIPSE command. If you start it from the Ribbon, be sure to 
select the Axis, End Ellipse tool from the Home tab ➢ Draw panel. The 
command line displays a default prompt of Specify axis endpoint of 
ellipse or:.

Using the Specify Axis Endpoint option and the running Midpoint 
osnap, you can easily define the ellipse’s location and first axis from 
one end of the ellipse to the other.

 5. Move the cursor near the midpoint of the right side of the tank and, 
when the triangle shows up there, click. This starts the ellipse.

 6. Hold the crosshair cursor out to the right of the rectangle, and enter 
1′6↵ (457↵). This sets the first axis.

Now, as you move the crosshair cursor, you’ll see that a line starts 
at the center of the ellipse, and the cursor’s movement controls the 
size of the other axis.

To designate the second axis, you need to enter the distance from the 
center of the axis to the end of it, or half the overall length of the axis.

 7. Hold the crosshair cursor directly above or below the center point, 
and enter 6↵ (152↵).
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The ellipse is complete, so you’ve finished the toilet (see the right 
side of Figure 5.68).

 8. To complete the fixtures, construct the shelves by drawing a 3′-0″ × 1′-0″ 
(914 mm × 305 mm) rectangle from the upper-right corner of the 
bathroom.

Figure 5.59 earlier in the chapter shows the proper orientation. 
Zoom out, and your completed bathroom should look like Figure 5.69.

F I G u R E   5 . 6 9 :   The completed bathroom fixtures

 9. Save your file as I05-20-BathroomToilet.dwg (M05-20-
BathroomToilet.dwg).

t I P  You can snap the features of an ellipse or a circle by using the Center or 
Quadrant object snaps. If an ellipse is rotated, the Quadrant points will be located at the 
two points where the curves are sharpest and the two points where the curves are flat-
test. The Quadrant snaps will always remain at the four points of a circle or arc that proj-
ect vertically or horizontally from the center point regardless of the object’s orientation.
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Drawing the Hot tub
What is a cabin without a hot tub in which to relax? You’ll complete the cabin 
fixtures by using a polyline to draw the outside perimeter of the hot tub, offset-
ting this polyline to the inside, and then filleting the appropriate corners. Here’s 
how it’s done:

 1. Make sure I05-20-BathroomToilet.dwg (M05-20-BathroomToilet 
.dwg) is open, and verify that the Polar Tracking button is still turned 
on in the status bar.

 2. Start the Polyline (PLINE) command, and click the bottom-left inside 
corner of the pop-out to the right of the bathroom, as shown in 
Figure 5.70.

F I G u R E   5 . 7 0 :   Starting the hot tub polyline

 3. Click the endpoint to the right, on the opposite end of the pop-out.

 4. Move the cursor directly above the last point, and enter 4′5-5/8″↵ 
(1362↵) to draw the first vertical line. Refer to Figure 5.59 for the 
dimensions of the hot tub.

Earlier in this chapter, you set the Polar Tracking Increment Angle 
value to 45.00 in the Drafting Settings dialog box. This setting lets 
you easily place the cursor at 45º increments from a set point rather 
than at the 90º increments provided by using Ortho mode.

 5. Place the cursor above and to the left of the current last point, until 
the Polar Snap tooltip reads 135º. Then enter 3′6-7/8″↵ (1089↵) to 
draw the diagonal line (see Figure 5.71).
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F I G u R E   5 . 7 1 :   Use Polar Tracking and direct input to draw the diagonal line.

 6. Use the Perpendicular osnap to draw the top horizontal line from the 
last point to the outside of the bathroom wall.

 7. Finally, select Close or enter C↵ at the command line to close the 
polyline and end the Polyline (PLINE) command.

 8. Use the OFFSET command to offset the polyline 4″ (102 mm) to the 
inside.

 9. Start the FILLET command, and set the Radius value to 3″ (76).

 10. Then fillet the two outside corners that project into the cabin (see 
Figure 5.72).

Fillet these two corners.

F I G u R E   5 . 7 2 :   Fillet the two corners that extend into the cabin.
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 11. Stop and then restart the FILLET command, but this time choose the 
Polyline option.

 12. Click the inside polyline to fillet all the corners at one time.

 13. Zoom to the drawing’s extents. Your cabin should look like Figure 5.73.

F I G u R E   5 . 7 3 :   The completed floor plan zoomed to fill the screen

 14. Save your drawing as I05A-FPLAYO.dwg (M05A-FPLAYO.dwg).

using Pan Realtime and Zoom Realtime

The Pan and Zoom buttons are next to each other on the Navigation bar. In addi-
tion to using the panel buttons, you can start Pan by entering P↵, and you can 
start Zoom Realtime by entering Z↵.

You can also start Pan or Zoom by right-clicking at the Type a command prompt 
and then choosing Pan or Zoom from the context menu or by clicking the Pan or 
Zoom button in the middle of the status bar. If you try this, you’ll find that it’s 
easier than clicking the Pan or Zoom buttons within the user interface.

(Continues)
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Like most AutoCAD commands, the Zoom and Pan Realtime commands offer 
several options, including the following:

Exit  Ends the Zoom Realtime or Pan Realtime command.

Pan  Switches to Pan Realtime from Zoom Realtime.

Zoom  Switches to Zoom Realtime from Pan Realtime.

orbit  Is a special viewing tool for 3D that is covered in later chapters.

Zoom Window  Allows you to make a zoom window without first ending Pan 
Realtime or Zoom Realtime. You pick a point, hold down the left mouse button, and 
then drag open a window in your drawing. When you release the button, you’re 
zoomed in to the window you made, and Pan Realtime or Zoom Realtime resumes.

Zoom original  Restores the view of your drawing that you had when you 
began Pan Realtime or Zoom Realtime.

Zoom Extents  Zooms to the drawing extents.

To end Pan Realtime or Zoom Realtime, press the Esc key, press ↵, or right-click 
and choose Exit from the context menu.

When Pan Realtime or Zoom Realtime is running, AutoCAD is in a special mode 
that makes the status bar invisible and, therefore, unusable.

If You Would Like More Practice…
The following exercises will give you the opportunity to practice the skills and 
techniques you have learned.

Drawing the Cabin Again
As is true for almost any skill, the key to mastery is practice. Redrawing the 
entire cabin might seem daunting at this point, when you think of how long it 
took you to get here. But if you try it all again, starting from Chapter 3, “Setting 
Up a Drawing,” you’ll find that it will take about half the time that it did the 
first time. If you do it a third time, it’ll take half that time again. Once you 

using Pan Realtime and Zoom Realtime (Continued)
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understand the techniques and how the commands work, feel free to experi-
ment with alternative techniques to accomplish tasks and with other options for 
the commands.

Drawing Something Else
If you have a specific project in mind that you would like to draw in AutoCAD, so 
much the better. Try drawing the floor plan of your home or a classroom.

Drawing Furniture for the Cabin
Once you put some furniture in the cabin, you’ll quickly see how small it is! 
But it can still accept some basic furniture without seeming too cramped. You 
should be able to add the following:

▶▶ Kitchen—a table and chairs

▶▶ Living room—a short couch or love seat, coffee table, easy chair, and 
a fireplace

▶▶ Bedroom—a double bed, chest, and nightstand

Use a tape measure and go around your office or home to determine the 
approximate dimensions of each piece. The goal here is not so much to ensure 
accuracy of scale but to practice drawing in AutoCAD. Figure 5.74 shows the 
floor plan with these pieces of furniture. If you draw the bed shown here, try 
using the Spline tool for the curved, turned-down sheets. It’s on the expanded 
Draw panel. You’ll see how it works after a little experimentation.

F I G u R E   5 . 7 4 :   The floor plan with furniture
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Drawing a Gasket
Figure 5.75 shows a gasket that is symmetrical around its vertical and horizon-
tal axes. This symmetry will allow you to use the MIRROR command to create 
much of the drawing.

6.00 4.00 3.00

4.00
6.00

R0.50" TYP

R0.50" TYP

R0.75" TYP

R0.25" TYP

8.00

R 0.75  
R 1.00

.25 DIA
R 0.50

R 0.50

Note:   Thickness 0.125

F I G u R E   5 . 7 5 :   A gasket

The diagram in Figure 5.76 summarizes the steps.
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F I G u R E   5 . 7 6 :   The 13 steps to creating the gasket

To draw the gasket, set Linear Units to Engineering with a precision of 0′-0.00″. 
Set Angular Units to Decimal with a precision of 0.00. Now, follow these steps: 

 1. Use the LINE command to draw a rectangle 4″ wide and 3″ high.

 2. Offset the upper horizontal line and the left vertical line 1″ to the 
inside of the rectangle.

 3. Use FILLET with a radius set to 1″ on the upper-left corner of the 
original rectangle.

 4. Draw the circle with the 0.25″ radius, using the intersection of the 
two offset lines as the center.

 5. Erase the offset lines.

 6. Offset the right vertical line 2″ to the left and the bottom horizontal 
line 1.5″ up.

 7. Use FILLET with a radius of 0.50″ on the intersection of these two 
lines, retaining the right and lower segments.

 8. Trim back the lower-right corner of the original rectangle.
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 9. Draw circles with 0.50″ and 0.75″ radii on the bottom and right sides 
of the shape.

 10. Use TRIM to remove unneeded lines.

 11. Use MIRROR to flip the shape down.

 12. Use MIRROR again to flip the shape to the right.

 13. Erase unneeded lines. (Each line to be erased is really two lines.)

 14. If you are using AutoCAD, and not LT, add the Equal constraint so 
that all four circles remain the same size.

 15. Save this drawing, naming it 05-Gasket.dwg.

Drawing a Parking Lot
Figure 5.77 shows a parking lot partially bordered by sidewalks and streets.

F I G u R E   5 . 7 7 :   A parking lot
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You’ll get a lot of practice using the OFFSET and FILLET commands while com-
pleting this drawing. Guidelines will help you, so don’t be afraid to use them. 
Note the tip at the end of this section. Here’s a summary of the steps:

 1. Set Linear and Angular units to Decimal, each with a precision of 0.0.

 2. Set the Insertion Scale to Feet. Assume that 1 linear decimal unit 
equals 1″.

 3. Set Polar Tracking to 90º, and turn it on.

 4. Set the Endpoint and Midpoint osnaps to be running.

 5. Set Snap to 10, Grid to 0, and Drawing Limits to 400, 250.

 6. Zoom All.

 7. Use Grid and Snap to draw the large 260′ × 170′ rectangle by using 
the LINE command and relative Cartesian coordinates, as you did in 
Chapter 3.

 8. Turn off Grid and Snap.

 9. Offset three of the lines 6′ to the outside to make the sidewalk.

 10. On two sides, offset the outer sidewalk line 4′ to the outside to make 
the curb.

 11. Offset the curb lines 30′ and 40′ to make the street.

 12. Draw extra lines to make the street intersection.

t I P  When using decimal units as feet, you don’t need to use the foot sign (′) when 
you enter distances.

 13. Fillet and trim lines to create the curved corners of the intersection 
and sidewalks.

 14. Offset the lines of the inner rectangle to the inside to make guide-
lines for the parking strips and islands.

 15. Use FILLET and TRIM to finish the drawing.

 16. If you choose to save this drawing, name it I05-ParkingLot.dwg 
(M05-ParkingLot.dwg).
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t I P  Using the FILLET command on two parallel lines creates a semicircle to con-
nect them. Try it on the islands in the parking area.

Are You Experienced?

now you can…

✔✔ use	the	Temporary	Tracking	Point	and	Snap	From	object	snaps	to	
create	and	use	tracking	points

✔✔ use the Perpendicular and Intersection osnaps

✔✔ set up and use running osnaps

✔✔ use the STRETCH command

✔✔ move around the drawing area with Zoom Realtime and Pan 
Realtime

✔✔ use point filters

✔✔ use the CIRCLE and ELLIPSE commands

✔✔ move	and	duplicate	objects	with	the	MOVE and COPY commands

✔✔ use parametric drawing with geometric and dimensional constraints
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CHAPtER 6

using Layers to 
organize Your 
Drawing
Before the age of computers, drafters used sets of transparent overlays on 
their drafting tables to compose document sets of multiple disciplines. Each 
design discipline, such as architecture, electrical, plumbing, and HVAC, were 
drawn on an individual overlay. Each overlay had small holes punched near 
the corners so the drafter could position the overlay onto buttons, called 
registration points, that were taped to the drawing board. Because all over-
lays had holes punched at the same locations with respect to the drawing, 
information on the set of overlays was kept in alignment. Thanks to this 
tight integration, plan sheets were more easily produced because it was not 
necessary to redraw individual overlays.

To help you organize your drawing, Autodesk® AutoCAD® software provides 
you with an amazing tool called layers, which can be thought of as a com-
puterized form of the transparent overlays, only much more powerful and 
flexible. In manual drafting, you could use only four or five overlays at a time 
before the information on the bottom overlay became unreadable. (Copying 
the drawing meant sending all the layers through the blueprint machine 
together.) In AutoCAD, you aren’t limited in the number of layers you can 
use. You can have hundreds of layers, and complex CAD drawings often do.

In this chapter, you will learn to

▶▶ Create new layers, assigning colors and linetypes

▶▶ Move	existing	objects	onto	a	new	layer

▶▶ Manage	layer	visibility	by	storing	as	layer	states
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using Layers as an organizing tool
To understand what layers are and why they are so useful, think again about the 
transparent overlay sheets used in hand drafting. Each overlay is designed to be 
printed. The bottom sheet might be a basic floor plan. To create an overlay sheet 
for a structural drawing, the drafter traces over only the lines of the floor plan 
that the overlay needs and then adds new information pertinent to that sheet. 
For the next overlay, the drafter performs the same task again. Each sheet, then, 
contains some information in common as well as data unique to that sheet.

In AutoCAD, using layers allows you to generate all the sheets for a set of 
overlays from a single file (see Figure 6.1). Nothing needs to be drawn twice or 
traced. The wall layout is on one layer, and the rooflines are on another. Doors 
are on a third. You can control the visibility of layers so that you can make all 
objects residing on a layer temporarily invisible. This feature lets you put all 
information keyed to a particular floor plan in one DWG™ file. From that draw-
ing, you can produce a series of derived drawings—such as the foundation plan, 
the second-floor plan, the reflected ceiling plan, and the roof plan—by making 
a different combination of layers visible for each drawing or drawing layout (lay-
outs are covered in Chapter 14, “Using Layouts to Set Up a Print”). When you 
make a print, you decide which layers will be visible. Consequently, in a set of 
drawings, each sheet based on the floor plan displays a unique combination of 
layers, all of which are in one file.

AutoCAD.dwg

Re�ected
Ceiling Plan

Roof
Plan

First-Floor
Plan

Second-Floor
Plan

Basement
Plan

Foundation
Plan

�le contains
all layers

F I G u R E   6 . 1 :   Several drawings can be created from one file.
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n o t E  A typical project such as a building can easily amass more than 100 layers. 
Managing so many layers from a single DWG file can prove tricky at times, and so layers 
are but one of several organizational methods AutoCAD provides. Another method, using 
external references (Xrefs), is a little more advanced but provides an extra level of flexibil-
ity needed for many real-world projects. You’ll have the chance to explore Xrefs in detail in 
Chapter 13, “Managing External References.”

As an organizing tool, layers allow you to classify every object in a drawing 
file—lines, arcs, circles, and so on—according to the component of the build-
ing they represent, such as doors, walls, windows, dimensions, and notes. Each 
layer is assigned a color, and all objects placed on the layer take on that assigned 
default color unless you specify a different color for the objects. This lets you 
easily distinguish between objects that represent separate components of the 
building (see Figure 6.2). You can quickly tell which layer a given object or 
group of objects is on.

Roof Layer

Window Layer

Door Layer

Deck Layer

Wall Layer

All Layers

F I G u R E   6 . 2 :   Separate layers combined to make a drawing
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First, you’ll look at the procedure for achieving this level of organization, 
which is to set up the new layers and then move existing objects onto them. 
Following that, you’ll learn how to create new objects on a specific layer and find 
out which objects reside on which layers.

Setting up Layers
All AutoCAD drawings have one layer in common: layer 0. Layer 0 is the default 
layer in all new drawings. If you don’t add any new layers to a drawing, every-
thing you create in that drawing is on layer 0. In fact, everything so far in the 
cabin drawing has been drawn on layer 0.

To begin using layers to organize the cabin drawing, you need to first learn 
how to set up layers. Initially, you’ll create seven new layers for your cabin draw-
ing. Then you’ll move the existing objects in your drawing onto the first five of 
these layers. After that, you’ll create new objects on the Headers and Roof layers.

In much the same way that you used the US National CAD Standard (NCS) 
to name your DWG file in Chapter 3, “Setting Up a Drawing,” you’ll also follow 
the NCS in naming your layers. Although filenames and layer names are each 
unique in many ways, the NCS naming convention is much the same for both. 
Before creating any layers, let’s have a quick look at the basic structure we’ll use 
to name the layers, illustrated in Figure 6.3.

Discipline
A - Architecture

Minor Codes
(Optional)

Major Code
(Mandatory)

D N N N NM M M M

F I G u R E   6 . 3 :   National CAD Standard (NCS) layer-naming framework

Discipline [D]  The discipline designator specifies the trade to which a layer 
belongs. For instance, only members of the architectural design team use layers 
beginning with an A. E layers are reserved for the electrical design team, and so 
on. The standard discipline designators in the NCS are the same for filenames 
and layers and are listed in Table 6.1.

▶

A best practice is to let 
layer properties (color, 
linetype, and so on) 
dictate the properties of 
individual objects. Avoid 
manually changing 
(overriding) the proper-
ties of the objects, such 
as lines and arcs, in an 
AutoCAD drawing.

▶

Objects and layers are 
analogous to people 
and countries; just as 
all people must reside 
in some country, so too 
must all objects be on 
some layer.
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t A B L E   6 . 1 :   NCS discipline designator codes

Code Discipline

A Architectural

B Geotechnical

C Civil

D Process

E Electrical

F Fire Protection

G General

H Hazardous Materials

I Interiors

L Landscape

M Mechanical

O Operations

P Plumbing

Q Equipment

R Resource

S Structural

T Telecommunications

V Survey/Mapping

W Civil Works

X Other Disciplines

Z Contractor/Shop Drawings
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Major Discipline Designator [MMMM]  At a minimum, each layer must con-
tain both a discipline [D] code and a Major Discipline Designator [MMMM]. The 
Major Discipline Designator is always four characters in length, and it helps to 
group like objects together in the layer list. For instance, you may have multiple 
types of walls, but regardless of type, each wall layer would begin with A-WALL.

Minor Discipline Designator [nnnn]  Sometimes you may need to classify 
your layers further. In the case of walls, you may have a layer for the centerline 
of your wall (A-WALL-CNTR), another for fire-rated walls (A-WALL-FIRE), and 
yet another for partial or half-walls (A-WALL-PRHT). Like the major designa-
tors, all Minor Discipline Designators (NNNN) should be four characters. Minor 
codes, unlike major designators, can be stacked together to achieve the neces-
sary level of granularity. For instance, you might name the partial wall center-
line layer A-WALL-PRHT-CNTR.

With the NCS growing in popularity, chances are that you’ll have to work 
with drawings using its prescribed framework at some point after you begin 
working on your own designs. You now have a good understanding of what 
these standards are and, more important, how to “decode” NCS layer names 
when you encounter them. More information on the NCS can be found at www 
.nationalcadstandard.org.

using the Layer Properties Manager

Knowing every detail about NCS is not necessary to complete the exercises in 
this book. As in the example you’re about to complete for working with layers, 
I’ll provide all the information you need to create layers inside the framework. 
To begin creating new layers, take the following steps:

 1. Open AutoCAD, and then open I05A-FPLAYO.dwg (M05A-FPLAYO.dwg) 
—both imperial and metric versions are included in the Chapter 6 
data folder. Make sure the Home tab is active and the Layers panel is 
in the Ribbon, centered just above the drawing area on your screen.

 2. Expand the panel and you will see that it contains several buttons, 
two drop-down lists, and a slider bar for controlling layers, as shown 
in Figure 6.4.
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F I G u R E   6 . 4 :   The expanded Layers panel

Several panels to the right is the Properties panel (see Figure 6.5), 
with four drop-down lists for controlling colors, lineweights, line-
types, and plot styles, and a slider for transparency. Once again, best 
practices discourage changing the properties of individual objects to 
anything other than ByLayer/ByBlock unless absolutely necessary.

F I G u R E   6 . 5 :   The expanded Properties panel

 3. Click the Layer Properties button on the left end of the Layers panel 
to open the Layer Properties Manager (see Figure 6.6).

F I G u R E   6 . 6 :   The Layer Properties Manager

◀

A linetype is the 
appearance style 
of a line, such as 
Continuous, Dashed, or 
Dash-Dot.
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Notice the large open area in the middle right of the palette with 
layer 0 listed at the top of the Name column. This is the Layer List 
box. All the layers in a drawing are listed here, along with their cur-
rent states and properties. I05A-FPLAYO.dwg (M05A-FPLAYO.dwg) has 
only one layer so far.

The Layer List box is where you will manage the properties for each layer in a 
drawing. Status properties such as On/Off, Freeze/Thaw, and Lock/Unlock con-
trol the visibility of a layer. By contrast, a series of appearance properties includ-
ing Color, Linetype, Lineweight, Transparency, and Plot Style control how a layer 
will display in a drawing. Don’t worry if these properties are confusing right now; 
the upcoming exercises in this section explore their functionality in detail.

To the left of the Layer List box is the Layer Filters tree view box, where you 
can define which layers to display in the Layer List box. The Layer Properties 
Manager has nine buttons along the top to perform layer and filter management 
tasks. You’ll see an Invert Filter check box at the bottom of the palette.

The Layer Properties Manager is considered modeless because you can leave 
it open while you continue to work on your drawing. This means that you can 
leave the palette open and move it away from your drawing area, where it can 
remain constantly open, waiting for you to input changes without having to stop 
to open the palette each time. Being modeless also means that your changes are 
instantly reflected in the drawing area, and you don’t need to close the palette to 
see the effects of your actions.

Creating new Layers and Assigning Colors

Let’s create a few new layers, name them, and assign colors to them:

 1. Continue using I05A-FPLAYO.dwg (M05A-FPLAYO.dwg), or open it if it’s 
not already open.

 2. In the toolbar at the top of the Layer Properties Manager, click the 
New Layer icon. A new layer named Layer1 appears in the list. The 
layer’s name is highlighted, which means you can rename it by enter-
ing another name now.

 3. Enter A-WALL↵. Layer1 changes to A-WALL. The row for the 
A-WALL layer should still be highlighted (see Figure 6.7).
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F I G u R E   6 . 7 :   The Layer Properties Manager with a new layer named A-WALL

 4. To open the Select Color dialog box shown in Figure 6.8, click the 
word white in the Color column for the A-WALL row.

F I G u R E   6 . 8 :   The Index Color tab in the Select Color dialog box

Notice the three tabs at the top: Index Color, True Color, and Color 
Books. Each has a different selection of colors available to AutoCAD.

 5. Make sure the Index Color tab is selected, and click the Cyan (Index 
Color: 4) color swatch.

The Select Color dialog box is composed of three sets of color 
swatches. Color swatches for Index Colors 10 through 249 are found 
in the upper portion of the dialog box, and colors 1–9 and colors 
250–255 are found in the lower portion.
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Each color swatch has an index number associated with it. This 
number provides the flexibility of graphically selecting the desired 
color swatch or entering the numerical value associated with it. 
Index Colors 1–7 represent primary colors including Red, Yellow, 
Green, Cyan, Blue, Magenta, and White/Black. They may be specified 
by number or textual name.

t I P  As you move the cursor over the available color swatches, the index color 
number, from 1 through 255, and the RGB (True Color) values appear beneath the large 
field of 240 choices.

 6. Click OK to close the Select Color dialog box. In the Layer List box  
of the Layer Properties Manager, you can see that the color square  
for the A-WALL layer has changed to cyan.

As you create your new list of layers and assign colors to them, notice how 
each color looks in your drawing. Some are easier to see on a screen with a light 
background, and others do better against a dark background. In this book, I’ll 
assign colors that work well with a black background. If your system has a white 
background, you might want to use darker colors, which you can find in the 
array of 240 color swatches in the upper half of the Index Color tab.

You’ll continue creating new layers and assigning colors to them. You’ll mas-
ter this procedure as you add a new layer or two in each chapter throughout the 
rest of the book:

 1. In the Layer Properties Manager, click the New Layer button or right-
click in the Layer List box and choose New Layer from the list of com-
mands in the context menu.

 2. Enter A-DOOR↵ to change the name of the layer.

 3. Pick the color square in the A-DOOR row.

 4. When the Select Color dialog box opens, click the color 40 square in 
the uppermost collection of color swatches in the Select Color dialog 
box. Click OK.

 5. Repeat these steps, creating the layers shown in Table 6.2 with their 
assigned colors.

Pick the colors from the collection of color swatches in the Select 
Color dialog box, or manually enter the index color number in the 
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Color text box at the bottom of the dialog box. In the row of nine col-
ors, the ninth swatch might not be clearly visible when it is close to 
the background color of the dialog box.

Notice that when a new layer appears in the Layer List box, it ini-
tially takes on the properties of the layer that was previously selected.

 6. Save your drawing as I06-01-CreateLayers.dwg (M06-01-
CreateLayers.dwg) by choosing Application menu ➢ Save As ➢ 
AutoCAD Drawing.

t A B L E   6 . 2 :   Layers and colors for the cabin drawing

Layer name Color

A-DECK-STRS 81

A-DECK 84

A-FLOR-FIXT 1

A-WALL-HEAD 11

A-ROOF Green (3)

Created in earlier exercises:

A-WALL Cyan (4)

A-DOOR 40

n o t E  Blue might or might not read well on a black background. If you don’t 
like the way it looks, try picking a lighter shade of blue from the array of 240 colors on 
the Index Color tab. Likewise, yellow might not read well on a lighter background; try 
picking a darker shade of yellow from the Index Color tab.

When finished, the layer list should have eight layers with their assigned col-
ors in the color squares of each row (see Figure 6.9). All layers are assigned the 
Continuous linetype by default. This is convenient because most building com-
ponents are represented in the floor plan by continuous lines, but the roof—
because of its position above the walls—needs to be represented by a dashed 
line. Later you’ll assign the Dashed linetype to the A-ROOF layer.
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F I G u R E   6 . 9 :   The Layer List box, in the Layer Properties Manager, with the seven new layers 
and layer 0

naming Layers

You can name layers in a variety of ways. With their different color assignments, 
layers make it possible for you to easily distinguish which objects in your drawing 
represent walls or other parts of your building. Most offices follow a standard for 
organizing layers by name and color. You’ve already had a chance to begin using 
the NCS. The International Organization for Standardization (ISO) also publishes 
a layering standard. Both are often adopted by architectural and engineering 
firms and customized to fit their specific needs.

With the cabin drawing, you’ll start developing a basic set of layers. Once you learn 
how to manage the set you’re using here, tackling more-complex layering systems 
will come naturally. In more-complex drawings, you might need several layers 
for variations of the same building component, landscape element, or machine 
part. For example, you might replace the A-WALL layer with several layers, such 
as Existing Walls to Remain (A-WALL-E), Walls to Be Demolished (A-WALL-D), and 
New Walls (A-WALL-N).

When you name layers, you can use uppercase and lowercase letters, and AutoCAD 
will preserve them. But AutoCAD doesn’t distinguish between them and treats 
Walls, WALLS, and walls as the same layer.

Looking at the other tabs in the Select Color Dialog Box

AutoCAD also supports a True Color palette and various Pantone, Digital Image 
Correlation (DIC), and RAL color groups. Although I won’t cover these features 
in any depth in this book, let’s take a quick look at them before moving on. Feel 
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free to follow along as you explore these additional tabs by making a copy of 
your I05A-FPLAYO.dwg (M05A-FPLAYO.dwg) file; you won’t save any changes you 
make in this section.

The	True	Color	Tab

With the Layer Properties Manager open, click one of the color swatches in the 
Layer List box to open the Select Color dialog box again. Then click the True 
Color tab. In the upper-right corner, the Color Model drop-down list displays 
either RGB or HSL. The display for the Red, Green, and Blue (RGB) color model 
looks like the top of Figure 6.10, and the Hue, Saturation, and Luminance (HSL) 
model looks like the bottom of Figure 6.10.

F I G u R E   6 . 1 0 :   The True Color tab with the RGB color model (top) and the HSL color model 
(bottom)
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using the traditional Colors of AutoCAD

The traditional set of 255 colors for AutoCAD is set up in such a way that the 
first seven colors are named (Red, Blue, and so on) and numbered (1 through 7), 
whereas the other 248 colors have only numbers.

As you saw on the Index Color tab of the Select Color dialog box (previously shown 
in Figure 6.8), AutoCAD has three groupings of colors: a large array of swatches 
in the top half and two rows of swatches below. Moving the cursor over a swatch 
displays its AutoCAD number below the array as well as its Red, Green, Blue (RGB) 
values. The RGB values indicate the amount of each color, a number from 0 (none) 
to 255 (all), which is mixed with the other two base colors to make the selected 
color. Click a swatch to assign it to the layer that has been selected in the Layer 
Properties Manager.

You should avoid using colors that resemble the background color, such as colors 
250–252, 18, or 8 with the default charcoal gray background. The objects with 
these colors could become lost visually in the drawing area. Be aware of this if 
your drawings might be sent to someone who doesn’t use your color standards 
so that they can work efficiently with the drawings.

the Array of 240 Colors  In the top half of the dialog box are colors numbered 
10 through 249, arranged in 24 columns, each having 10 swatches.

the Row of nine Standard Color Swatches  This group includes colors 
1 through 9. The first seven colors in this group also have names: Red (1), Yellow 
(2), Green (3), Cyan (4), Blue (5), Magenta (6), and White/Black (7). Colors 8 and 
9 have numbers only. Color 7 is named White, but it will be black if you’re using 
a white background color.

the Row of Six Gray Shades  These colors are often assigned screening 
values (such as 50 percent, 75 percent, and so on), numbering 250 through 255. 
As pure color assignments, they range from almost black to almost white.

These 255 colors, plus the background color, make up the traditional AutoCAD 
256-color palette. Two additional colors are in a group by themselves, Logical 
Colors, and are represented by buttons on the Index Color tab.

The two buttons in this grouping—ByLayer and ByBlock—represent two ways 
you can assign a color to objects (such as lines, circles, text, and so on) via the 
layer they are on or via the block of which they are part, rather than to the objects 
themselves. (Blocks are covered in the next chapter.) When you assign cyan to 
the A-WALL layer and place all objects representing walls on that layer, all wall 
objects are automatically assigned the color ByLayer and take on the color of 
their layer—in this case, cyan.

(Continues)
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You can change the color of an object to one other than the assigned layer color 
by selecting the object and choosing a color from the Color Control drop-down 
list in the Properties panel. Setting an object’s color directly is not always the 
best practice, however, and you should try to maintain color assignments by 
layer whenever practical.

If you select a color by using the RGB or HSL screen, that color appears in the 
Layer List box of the Layer Properties Manager along with its three RGB num-
bers (see Figure 6.11).

F I G u R E   6 . 1 1 :   The Layer List within the Layer Properties Manager with the Roof layer 
assigned a color that is not part of the standard AutoCAD 255-color list

With the combination of 256 values for each of the three primary colors, you 
now have more than 16 million colors to choose from in AutoCAD.

The	Color	Books	Tab

The Color Books tab displays the colors of the selected color book (see the image 
on the left side of Figure 6.12). AutoCAD has 20 color books. Each book appears 
in the Color Book drop-down list at the top of the tab; the current book appears 
in the box. Below that, a set of colors that corresponds to the position of the 
slider is displayed in bars. Moving the slider to a new position displays another 
set of colors. Click a displayed color bar to select it, and then click OK. The color 
appears in the Layer Properties Manager Layer List box by its identifying name 
and number (see the image on the right side of Figure 6.12).

◀

The Color column might 
be compressed in such 
a way that the names 
of colors in the list are 
abbreviated. You can 
widen the column by 
dragging the divider 
at the right of the title 
farther to the right.

using the traditional Colors of AutoCAD (Continued)
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F I G u R E   6 . 1 2 :   The Color Books tab in the Select Color dialog box (left) and the layer list 
with an assigned DIC number (right)

Later in the book you’ll create new layers and assign them colors of your 
choice. For now, take this opportunity to explore the True Color and Color 
Books tabs of the Select Color dialog box, and try using some of these colors in 
your drawing. Keep the Layer Properties Manager open. You’ll use it to assign 
linetypes in the next section.

You can delete selected layers by using the Delete Layer button, shaped like 
a red X, in the Layer Properties Manager. You can delete only empty layers—
those containing no objects. Should you have a nonempty layer that needs to be 
deleted, right-click any layer in the Layer Properties Manager and choose Merge 
Selected Layer(s) To. This will move objects to the layer you select and delete the 
source layer.

Assigning Linetypes to Layers
When you assign a color to a layer, you can choose any color supported by your 
system. This is not so with linetypes. Each new drawing has only two linetypes 
loaded into it by default (the Continuous and Phantom2 linetypes). You must 
load any other linetypes you need from an outside file:

 1. If it’s not open already, open I06-01-CreateLayers.dwg (M06-01-
CreateLayers.dwg) by clicking the Open button located on the Quick 
Access toolbar.

 2. In the Layer Properties Manager, click Continuous in the column 
for the A-ROOF layer to open the Select Linetype dialog box (see 
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Figure 6.13). In the Loaded Linetypes list, only Continuous appears. 
No other linetypes have been loaded into this drawing.

F I G u R E   6 . 1 3 :   The Select Linetype dialog box

 3. Click Load to open the Load Or Reload Linetypes dialog box.

 4. Scroll down the list to the Dashed, Dashed2, and DashedX2 linetypes 
(see Figure 6.14). Notice how, in this family, the dashed lines are dif-
ferent sizes.

Dashed linetype family

F I G u R E   6 . 1 4 :   The list of available linetypes scrolled to the three Dashed 
linetypes

 5. Click DASHED in the left column and then click OK. You’re returned 
to the Select Linetype dialog box. The Dashed linetype has been 
added to the Linetype list under Continuous (see Figure 6.15).
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F I G u R E   6 . 1 5 :   The Select Linetype dialog box with the Dashed linetype 
loaded

 6. Click DASHED to highlight it, and then click OK. In the Layer 
Properties Manager, the A-ROOF layer has been assigned the Dashed 
linetype (see Figure 6.16).

F I G u R E   6 . 1 6 :   The Layer Properties Manager with the A-ROOF layer assigned 
the Dashed linetype

 7. Save your drawing as I06-02-AssigningLinetypes.dwg (M06-02-
AssigningLinetypes.dwg) by choosing Application menu ➢ Save 
As ➢ AutoCAD Drawing.

t I P  You can select or deselect all the available linetypes in the Load Or Reload 
Linetypes dialog box by right-clicking and choosing Select All or Clear All from the con-
text menu. You can also select multiple linetypes by holding down the Ctrl or Shift key 
and clicking.
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AutoCAD Linetypes

The Available Linetypes list in the Load Or Reload Linetypes dialog box contains 
45 linetypes. They fall into three groups:

Acad_ISo  The first 14 linetypes are in the Acad_ISO family (as noted earlier, 
ISO is the International Organization for Standardization). They are set up to be 
used in metric drawings and have lineweight, or pen-width, settings.

Standard  Below the ISO linetypes are eight families of three linetypes each, 
mixed with seven special linetypes that contain graphic symbols. Each family has 
one basic linetype and two that are multiples of it: one has dashes twice the size 
(called, for example, DashedX2), and one has dashes half the size (called Dashed2), 
as you saw earlier in Figure 6.14. Having an assortment of different sizes of one 
style of linetype is helpful for distinguishing between building components, 
such as foundation walls and beams, which, in addition to rooflines, might also 
need dashed lines.

Complex  Mixed in with the Standard linetypes are seven linetypes that contain 
symbols, letters, or words. You can use these linetypes to indicate specific ele-
ments in the drawing, such as fences, hot-water lines, railroad tracks, and others.

Learning More about Lineweight

In the Layer Properties Manager is a column for the Lineweight property. When 
you first create a layer, it is assigned the default lineweight. Just as you assigned 
a color and a linetype for each new layer in the cabin drawing, you can also 
assign a lineweight. Once assigned, lineweights can be displayed so that you can 
see how your drawing will look when printed.

n o t E  The Lineweight layer property is just one of three ways the plotted thick-
ness of lines is commonly controlled. The oldest and generally most common method is 
to instruct AutoCAD to plot objects of different colors with different thicknesses. This is 
done by setting up a CTB file. Similarly, by using Plot Styles, you can configure an STB 
file to work in much the same way as CTB files. Each method has its own advantages and 
disadvantages, which are discussed in Chapter 15, “Printing a Drawing.”
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using the Current Layer as a Drawing tool

Now is a good time to look at what it means for a layer to be current. Notice the 
green check mark above the Layer List box in the Layer Properties Manager 
shown earlier in Figure 6.7. The same green check mark appears in the Status 
column in the layer 0 row. The name of the current layer, in this case, 0, appears 
in the upper-left corner of the dialog box.

At any time, one, and only one, layer is set as the current layer. When a layer is 
current, all objects you draw will be on that layer and will take on the properties 
assigned to that layer unless directed otherwise. Because layer 0 is current—and 
has been current so far in this book—all objects that you have drawn so far are 
on layer 0 and have the linetype and color that are specified by default for layer 0: 
Continuous and White (or Black), respectively. If you make the A-WALL layer cur-
rent, any new lines you draw will be Continuous and Cyan. If the A-ROOF layer is 
current, any new lines will be Dashed and Blue. Here’s how to make the A-WALL 
layer the current layer:

 1. If it’s not open already, open I06-02-AssigningLinetypes.dwg (M06-
02-AssigningLinetypes.dwg) by clicking the Open button on the 
Quick Access toolbar.

 2. Click the A-WALL layer in the Layer List box to highlight it, and then 
click the Set Current green check mark above the Layer List box.

Alternatively, you can double-click the A-WALL layer, or highlight 
it and press Alt+C. The A-WALL layer replaces layer 0 as the current 
layer, and the name appears in the text field at the top of the dialog 
box. The green check mark also appears next to the A-WALL layer in 
the Layer List box.

t I P  When the Status column is displayed, AutoCAD must evaluate the objects and 
layers several times during the drawing process. This can cause a lag when the draw-
ing is large and the list of layers is extensive. You can hide Status, or any other column, 
by right-clicking the column name and then clicking any selected option in the context 
menu that appears.

 3. Click the Auto-Hide button near the top-left corner of the Layer 
Properties Manager.
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Auto-Hide causes the palette to collapse down to the title bar. You 
can expand it by doing one of the following:

▶▶ To expand the dialog box temporarily, pause the cursor over the 
title bar.

▶▶ To expand it permanently, click Auto-Hide again.

 4. Look at the Layer drop-down list on the Ribbon’s Layers panel. Most 
of the symbols you saw in the Layer List box, in the Layer Properties 
Manager, are on this drop-down list. The A-WALL layer is the visible 
entry on the list and has a cyan square (the color you assigned to the 
A-WALL layer earlier). The layer is visible in this list when it’s col-
lapsed and no objects are selected in the current layer.

 5. Now look at your drawing. Nothing has changed because the objects 
in the drawing are still on layer 0.

You need to move the objects in the drawing onto their proper layers. To do 
this, you’ll use the Layer drop-down list on the Layers panel to assign each 
object to one of the new layers.

Assigning objects to Layers
When assigning existing objects in the drawing to new layers, your strategy will 
be to begin by selecting several of the objects that belong on the same layer and 
that are easiest to select. You’ll reassign them to their new layer by using the 
Layer drop-down list. You’ll then move to a set of objects that belong on a differ-
ent layer or that belong on the same layer as the previously selected object but 
are slightly more difficult to select, and so on.

 1. If it’s not open already, open I06-02-AssigningLinetypes.dwg (M06-02-
AssigningLinetypes.dwg) by clicking the Open button on the Quick 
Access toolbar. Verify that the A-WALL layer is set as current as outlined 
in the “Using the Current Layer as a Drawing Tool” section earlier.

 2. In the drawing, specify a selection window down and to the left to 
use a crossing selection window (a green box with dashed lines) that 
selects the front deck, as shown at the top of Figure 6.17.
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F I G u R E   6 . 1 7 :   Selecting the front deck (top), deselecting the front stairs (middle), and the 
completed selection (bottom)

Grips appear, and the lines glow blue, signaling that the objects 
have been selected.
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n o t E  See the next section, “Selecting Objects with Selection Windows,” for a 
complete description of the window selection process.

 3. Hold down the Shift key, and select the front stairs with a crossing 
selection, as shown in the middle image in Figure 6.17. The stair lines 
appear solid again.

Selecting objects with the Shift key pressed causes objects that are 
already selected to become unselected (removed from the selection 
set), while there is no effect on unselected objects.

 4. Repeat the process on the rear deck so that the deck is selected but 
the back stairs are not. The selected components should look like the 
bottom image in Figure 6.17.

Notice also that, in the Layer drop-down list, the layer being dis-
played now is layer 0 rather than A-WALL, the current layer. When 
objects are selected with no command running, the Layer drop-down 
list displays the layer to which the selected objects are currently 
assigned. If selected objects are on more than one layer, the Layer 
drop-down list is blank.

 5. Click the Layer drop-down list to open it (see Figure 6.18).

F I G u R E   6 . 1 8 :   The expanded Layer drop-down list

 6. Click the A-DECK layer. The list closes. The A-DECK layer appears 
in the Layer drop-down list. The deck lines have been moved to the 
A-DECK layer and are now green.

 7. Press Esc to deselect the lines and remove the grips. The current 
layer, A-WALL, returns to the Layer drop-down list.
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 8. Save your drawing as I06-03-AssigningLayers.dwg (M06-03-
AssigningLayers.dwg) by choosing Application menu ➢ Save As ➢ 
AutoCAD Drawing.

This is the process you need to go through for each object so that it will be 
placed on the proper layer. In the next section, you’ll move the thresholds and 
steps to the A-DECK-STRS layer. You’ll select the threshold and steps by using a 
selection window.

Selecting objects with Selection Windows

AutoCAD has two types of selection windows: the regular selection window and 
the crossing window. The crossing window is represented by dashed lines, and 
its interior is, by default, a semitransparent light green color. The regular win-
dow is represented by solid lines, and its interior is a semitransparent lavender 
color when using a white background, and blue when using a black background.

By default, AutoCAD is set up so that whenever no command is running and 
the prompt in the command line is Type a command, you can pick objects one at 
a time or start a regular or crossing window. Rectangular selection windows are 
created by picking opposite corners of the selection area, whereas the new lasso 
window selection allows selection windows of any shape to be designated by 
holding down the left mouse button while moving your mouse around the area 
to select.

Regardless of the method you choose, when you pick an object, it is selected 
and its grips appear. If you select a blank area of the drawing, this starts a selec-
tion window. If you then move the cursor to the right of the point just picked, 
you create a regular window. If you move the cursor to the left, you create a 
crossing window. You’ll use both crossing and regular selection windows to 
select the thresholds and steps:

 1. Make sure I06-03-AssigningLayers.dwg (M06-03-AssigningLayers 
.dwg) is open.

 2. Zoom in to the sliding glass door area. Click the Object Snap button 
on the status bar (or press F3) to turn it off, if it isn’t already off.

 3. Select the threshold for the sliding glass door by using a crossing 
window selection. To do that, follow these steps:

 a. Hold the crosshair cursor above and to the right of the upper-
right corner of the sliding glass door’s threshold—still inside 
the perimeter of the deck—as shown on the top of Figure 6.19.
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F I G u R E   6 . 1 9 :   Starting the crossing selection window (top) and completing it 
(bottom)

n o t E  Figure 6.19 has been rotated 90° from the way it appears in your drawing.

 b. Click that point.

 c. Move the cursor down and to the left until you have made a tall, 
thin crossing window that completely encloses the right edge of 
the threshold and is crossed on its left edge by the short, hori-
zontal connecting lines, as shown on the bottom of Figure 6.19.

 d. Click again.

The three lines that make up the threshold are selected.

 4. Click the Layer drop-down list to open it, and then click the A-DECK-
STRS layer. The front threshold is now on the A-DECK-STRS layer.

 5. Using the Zoom Previous tool, from the Zoom fly-out menu in the 
Navigation bar (the ViewCube® on the right-hand side of the drawing 
area), enter Z↵P↵, or simply use the scroll wheel to return to a view 
of the entire drawing.

 6. Zoom in to the threshold at the back door. You will use a regular 
selection window to select this threshold.

 7. Start a selection window slightly above and to the left of the thresh-
old, and drag down and to the right, as shown in Figure 6.20. Be sure 
to enclose the horizontal threshold lines completely.

◀

When you zoom or pan 
with the Zoom or Pan 
tool, the grips are dese-
lected. When you zoom 
or pan using the scroll 
wheel, they are not.
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F I G u R E   6 . 2 0 :   Selecting the threshold with a regular selection window

 8. Move the selected lines to the A-DECK-STRS layer the same way you 
did in step 3.

 9. Save your drawing as I06-04-SelectingObjects.dwg (M06-04-
SelectingObjects.dwg) by choosing Application menu ➢ Save As ➢ 
AutoCAD Drawing.

using the Quick Properties Panel

The Quick Properties panel provides access to several of the most commonly 
changed parameters of the selected objects. You can quickly change the selected 
object’s layer, color, and linetype, as well as several parameters specific to the 
type of object selected. For example, the Radius parameter is available when a 
circle is selected, and the Closed option is available when a polyline is selected. 
When multiple objects are selected, only the parameters common to all are dis-
played. You will use the Quick Properties panel to change the layer of the front 
and back stairs:

 1. Make sure I06-04-SelectingObjects.dwg (M06-04-SelectingObjects 
.dwg) is open.

 2. Click the Customization button on the right end of the status bar, 
and then select Quick Properties from the menu. This adds the Quick 
Properties tool to the status bar.

 3. Enable Quick Properties by selecting its icon from the status bar.
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 4. Use crossing selection windows to select each of the lines illustrating 
the front and back stairs.

The grips appear, indicating the objects are selected, and the Quick 
Properties panel opens in the drawing, as shown in Figure 6.21. For 
lines, grips appear at each endpoint and at the midpoint of each seg-
ment; for polylines, they appear at each endpoint, and a stretch grip 
appears at the midpoint of each linear segment. When endpoints of 
lines coincide, their grips overlap. When lines are very short, their grips 
might appear to overlap, but that is just the result of the zoom factor.

F I G u R E   6 . 2 1 :   The Quick Properties panel

 5. Click in the Layer field. Then click to expand the Layer drop-down list 
and choose the A-DECK-STRS layer, as shown in Figure 6.22.

F I G u R E   6 . 2 2 :   Assigning the objects to the A-DECK-STRS layer

All 10 polylines representing the stairs are now on the A-DECK-
STRS layer.
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 6. Press the Esc key to deselect the objects and remove the grips. Even 
when it is turned on, the Quick Properties panel disappears when no 
objects are selected.

 7. Save your drawing as I06-05-QuickProperties.dwg (M06-05-
QuickProperties.dwg) by choosing Application menu ➢ Save As ➢ 
AutoCAD Drawing.

Selecting the Doors and Swings

To select the doors and swings, you can use crossing windows. Let’s examine 
this task closely to learn more valuable skills for selecting objects:

 1. Make sure I06-05-QuickProperties.dwg (M06-05-QuickProperties 
.dwg) is open.

 2. Without any objects selected, hold down the left mouse button 
as you draw a circle in a counterclockwise direction, as shown in 
Figure 6.23.

F I G u R E   6 . 2 3 :   Using a crossing lasso window to select the doors and swings

Holding the left mouse button down as you create a selection set 
creates what is known as a lasso window selection. Similar to rect-
angular selection windows, the direction in which you draw the lasso 
matters. Just as a window selection defined from right to left would 
create a crossing window, drawing a lasso window selection from left 

▶

Grips have other uses 
besides signaling that 
an object has been 
selected. You’ll learn 
about some of these as 
you progress through 
the chapters.
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to right, or counterclockwise, will also create a crossing lasso win-
dow selection.

After you complete your selection, the back door and its swing 
glow to indicate that they are selected. Additionally, the Quick 
Properties panel reappears to display the number of objects selected.

Because you selected more than one type of object (a polyline and 
an arc), the Quick Properties panel reads All (2) as opposed to listing 
the specific type of object selected. AutoCAD lists the specific type of 
object selected only if everything selected is of the same object type 
(a set of polylines, arcs, lines, and so on).

 3. Move to the bathroom, and select its door by picking a point to the 
right and then picking a point to the left, as shown in Figure 6.24.

F I G u R E   6 . 2 4 :   Using a rectangular selection window to select the bathroom 
door and swing line

By releasing the left mouse button between each point, you create 
a rectangular crossing window selection in lieu of the lasso selection 
you created in the previous step. The bathroom door and swing are 
selected, and the quantity listed in the Quick View Properties palette 
updates.
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 4. Select the four rectangles that make up the closet doors. Then 
open the Layer drop-down list from either the Layers panel or the 
Quick Properties panel and select the A-DOOR layer, as shown in 
Figure 6.25.

F I G u R E   6 . 2 5 :   Using the Quick Properties panel’s Layer drop-down list to 
change the layer of the door objects

All of the doors you selected have been moved from layer 0 to 
the A-DOOR layer and now display in orange (the color assigned 
to the A-DOOR layer).

 5. Press Esc to deselect the objects and remove the grips.

 6. Save your drawing as I06-06-DoorSwings.dwg (M06-06-DoorSwings 
.dwg) by choosing Application menu ➢ Save As ➢ AutoCAD Drawing.

For the sliding glass door, it’s awkward to create a crossing window from left 
to right because positioning the pickbox between the threshold lines and the 
sliding door can be difficult. In this situation, use a regular window to select the 
objects:

 1. Make sure I06-06-DoorSwings.dwg (M06-06-DoorSwings.dwg) is open.

 2. Zoom in to the area of the sliding glass door.
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 3. Use a regular selection window to select the sliding glass door at the 
front of the cabin. To do this, follow these steps:

 a. Select a point to the left of the balcony opening. By selecting a 
point, you start a new selection window.

 b. Move your cursor, and pick a point to the right of the sliding glass 
window until the right edge of the window (blue background 
with solid boundary line) is just inside the wall, but just to the 
right of the sliding glass door itself (as shown in Figure 6.26).

F I G u R E   6 . 2 6 :   Using a regular selection window to select the sliding glass 
door
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The entire sliding glass door assembly is selected, but not the 
jambs, walls, threshold, or balcony. A total of 13 lines make up the 
sliding glass door, and each line has three grips: a grip at each end-
point and a grip at each midpoint. Many of the grips overlap.

 4. Open the Layer drop-down list, and select the A-DOOR layer.

 5. Press Esc to deselect the objects and remove the grips.

 6. Use the Zoom Extents tool found by selecting the View tab ➢ 
Navigate panel ➢ Zoom Extents tool from the zoom fly-out menu, or 
you can double-click the middle-button/scroll wheel on your mouse.

You have a full view of the floor plan, where each of the doors are 
red and are found on the A-DOOR layer.

 7. Save your drawing as I06-07-SlidingDoor.dwg (M06-07-
SlidingDoor.dwg) by choosing Application menu ➢ Save As ➢ 
AutoCAD Drawing.

The next task is to move the kitchen and bathroom counters and fixtures and 
the hot tub onto the A-FLOR-FIXT layer. In doing so, you’ll learn how to dese-
lect some objects from a group of selected objects.

Selecting the Kitchen and Bathroom Fixtures

Sometimes it’s more efficient to select more objects than you want and then 
deselect those you don’t want. You’ll see how this is done when you select the 
kitchen and bathroom fixtures:

 1. Make sure I06-07-SlidingDoor.dwg (M06-07-SlidingDoor.dwg) is 
open.

 2. To start a crossing window, pick a point in the kitchen area just below 
and to the right of the refrigerator but above the back door.

 3. Move the cursor to the top left and up until the upper-left corner of 
the crossing window is to the left of the left edge of the counter and 
inside the back wall, as shown at the top of Figure 6.27.
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F I G u R E   6 . 2 7 :   A crossing window to select the kitchen objects (top), another 
crossing window to select the bathroom objects (middle), and a regular selection 
window to select the mirror (bottom)
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 4. When you have your cursor placement correct, click that point. The 
entire kitchen counter area and fixtures are selected.

 5. Move down to the bathroom, and pick a point inside the shower  
near the bottom-right corner, being careful not to touch any  
lines with the crosshair cursor.

 6. Move the crosshair cursor up and to the left, until the lower-left 
corner of the crossing window is in the middle of the sink (see the 
middle of Figure 6.27). When you have the selection window posi-
tioned this way, click that point. All the bathroom fixtures, except the 
mirror, are selected.

 7. From left to right, drag a regular window that encompasses the mir-
ror, as shown at the bottom of Figure 6.27. It doesn’t matter whether 
the selection window surrounds objects that are already selected.

 8. To complete the selection set, drag a crossing selection window that 
crosses both of the hot tub polylines that encroach into the living room.

 9. Hold down the Shift key, and then pick the selected door and swing 
in the bathroom.

Be careful to not pick a grip. As you pick the objects, their lines 
become solid again and their grips disappear, letting you know 
they have been deselected, or removed from the selection set (see 
Figure 6.28). Be sure to pick the inside wall lines in the kitchen at 
locations where they don’t coincide with the stove or counter.

F I G u R E   6 . 2 8 :   The completed selection set after removing the door swing 
and back wall line
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 10. Release the Shift key.

 11. Open the Layer drop-down list, and select the A-FLOR-FIXT layer. 
The fixtures are now on the A-FLOR-FIXT layer and are color 11.

 12. Press the Esc key to deselect the objects.

 13. Save your drawing as I06-08-SelectingFixtures.dwg (M06-08-
SelectingFixtures.dwg) by choosing Application menu ➢ Save 
As ➢ AutoCAD Drawing.

The last objects to move onto a new layer are the wall lines. It won’t be 
easy to select the wall lines by using conventional methods because so many 
other objects in the drawing are in the way. However, because the only objects 
remaining on layer 0 are the walls for your cabin, you can use the Select Similar 
command.

Selecting Walls with the Select Similar Command

In the last several exercises, you learned how to select objects by using both a 
regular window and a crossing window. Although there are several ways to  
make regular and crossing selections (such as when you used the Fence option 
to trim lines in Chapter 2, “Learning Basic Commands to Get Started”), these 
remain the two fundamental ways to select multiple objects at once inside 
AutoCAD. The Select Similar option expands on that concept and adds a way to 
select multiple objects that have some similarity all at once.

To try out this selection method, you’ll select objects whose similarity is that 
they are lines on layer 0. That is, all lines currently drawn on layer 0 will be 
selected. Although only lines are drawn on layer 0, if you had both arcs and lines 
on layer 0 and used the Select Similar command on a line, only the lines would 
be selected. Again, because lines are the only objects on layer 0, the Select 
Similar command is perfect for this particular application.

 1. Make sure I06-08-SelectingFixtures.dwg (M06-08-
SelectingFixtures.dwg) is open.

 2. Select any line currently drawn on layer 0 that represents a wall 
within your cabin (see Figure 6.29).
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F I G u R E   6 . 2 9 :   Choosing the Select Similar right-click menu option after 
selecting a single wall line

 3. Being careful not to deselect the line on layer 0, right-click and select 
the Select Similar option, as shown in Figure 6.29. The Select Similar 
command selects all of the lines on layer 0.

 4. Use the Quick Properties panel to select the A-WALL layer (see 
Figure 6.30).

F I G u R E   6 . 3 0 :   Using the Quick Properties panel to select the A-WALL layer 
after using the Select Similar command to select every line on layer 0

 5. Save the current drawing as I06-09-SelectSimilar.dwg (M06-09-
SelectSimilar.dwg) by using the Save icon on the Quick Access 
toolbar.

www.MouradEngineering.com



 U s i n g  L a y e r s  a s  a n  O r g a n i z i n g  To o l  2 9 5

Selecting objects in Your Drawing

As you select objects in the cabin drawing to move them onto their prescribed 
layers, you use various selection tools. Mastering these important tools will 
greatly enhance your performance as an AutoCAD user. As you select objects by 
picking them and windowing them, you’re building a selection set. You might 
want to remove objects from that selection set later. Here is a summary of the 
basic selection procedures that you have used so far, with a couple of additions. 

Picking

This is the basic, bottom-line selection tool. Click the line, circle, or other object 
to select it. If no command is running, grips appear on the selected object, and 
the object becomes dashed. If a command is running and you’re being prompted 
with Select objects:, grips don’t appear, but the object is selected and 
ghosts (changes to a dashed appearance).

Removing objects from a Selection Set

At some point, you’ll find it more efficient to select more objects than you want 
and then remove the unwanted ones. You can do this in three ways:

▶▶ To remove a couple of objects, hold down the Shift key and pick the objects.

▶▶ To remove objects from the selection set, hold down the Shift key and use 
one of the selection window types.

▶▶ If a command is running, enter R↵, and then use the selection tools 
(picking, windows, and so on) without the Shift key to remove objects 
from the selection set.

If you are in a command and need to add objects back to the selection set after 
removing some, enter A↵. This puts you back into selection mode, and you can 
continue adding objects to the set.

turning off and Freezing Layers
You can make layers invisible either by turning them off or by freezing them. 
When a layer is turned off or frozen, the objects on that layer are invisible. These 
two procedures operate in almost the same way and perform about the same 
function, with one significant difference: objects on frozen layers cannot be 
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selected with the All option, while objects on layers that are off can be selected. 
For example, if you enter E↵A↵ to erase all objects, all the visible and invisible 
objects on the layers turned off are deleted, whereas the objects on frozen layers 
remain in the drawing but are still invisible. Here is a good rule to follow: If you 
want a layer to be invisible for only a short time, turn it off; if you prefer that it 
be invisible semipermanently, freeze it.

For the task at hand, you’ll turn off all layers except the A-WALL and A-DOOR 
layers to reveal a more simplified look of your floor plan. Afterward, you’ll learn 
how to restore the visibility of all layers in your drawing at once.

 1. Make sure I06-09-SelectSimilar.dwg (M06-09-SelectSimilar.dwg) 
is open.

 2. Click the Layer Properties button on the Layers panel to open the 
Layer Properties Manager, or expand the palette if it is still collapsed 
on your screen.

 3. Click the Settings button in the upper-right corner of the Layer 
Properties Manager. The Layer Settings dialog box opens.

 4. In the Dialog Settings group near the bottom, enable the Indicate 
Layers In Use option (see Figure 6.31), and click OK.

F I G u R E   6 . 3 1 :   Enabling the Indicate Layers In Use option from the Layer 
Settings dialog box

Notice that layer 0 is still first in the list and that the other layers 
have been reorganized alphabetically (see the top of Figure 6.32).
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F I G u R E   6 . 3 2 :   The layers, now listed alphabetically (top), and after turning off the selected 
layers (bottom)

Also, notice the icons in the Status column:

▶▶ A green check mark signifies that the A-WALL layer is current.

▶▶ The light blue layer icons signify that those layers (0, A-DECK, 
A-DECK-STRS, A-DOOR, and A-FLOR-FIXT) now have objects 
on them.

▶▶ The light gray layer icons tell you that those layers (A-ROOF 
and A-WALL-HEAD) don’t have any objects on them.

Because the A-WALL layer is current and has a green check mark 
in the Status column, you can’t tell whether the layer has any objects 
on it. You have to make a different layer current and then check 
whether the Walls icon is blue or gray.

 5. Click the A-DECK layer to highlight it.

◀

The status of layers will 
appear in the Status 
column in the Layer 
Properties Manager 
only if that feature was 
enabled in the Layer 
Settings dialog box 
(see step 4).
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 6. Then hold down the Shift key and click the A-DECK-STRS layer.  
Both the A-DECK and A-DECK-STRS layers should be highlighted 
within the Layer Properties Manager.

 7. Move the arrow cursor over to the On column, which has a lit light-
bulb as a symbol for each layer row.

 8. Click one of the lightbulbs of the selected layers (see the bottom of 
Figure 6.32).

The lit lightbulb symbols all change to unlit bulbs for the A-DECK 
and A-DECK-STRS layers.

 9. Collapse or close the Layer Properties Manager or simply move it out 
of the way. Both the deck (A-DECK) and the stairs leading up to the 
deck (A-DECK-STRS) are invisible (see Figure 6.33).

F I G u R E   6 . 3 3 :   The floor plan without the deck shown

 10. From the Home tab ➢ Layers panel, select the Off tool and then 
click any object on the A-FLOR-FIXT (color 11) layer. By selecting 
an object on the A-FLOR-FIXT layer, you have graphically turned 
that layer off, making the objects on it invisible (see the top of 
Figure 6.34).
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F I G u R E   6 . 3 4 :   The floor plan after turning off the A-FLOR-FIXT layer (top) and 
with the visibility of all layers restored (bottom)

 11. Press Esc to end the Off command.

 12. To restore the visibility of all layers at once by turning them on, 
expand the Home tab ➢ Layers panel and select the Turn All Layers 
On tool. The bottom of Figure 6.34 shows the result.

Two of your layers, A-ROOF and A-WALL-HEAD, still have no objects on them 
because these components haven’t been drawn yet. You’ll draw the headers now.

Drawing the Headers
Most door and window openings don’t extend to the ceiling. The portion of the 
wall above the opening and below the ceiling is the header. The term comes 
from the name of the beam inside the wall that spans the opening. In a floor 
plan, wall lines usually stop at the door and window openings, but you need 
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lines across the gap between jamb lines to show that an opening doesn’t extend 
to the ceiling; hence, you’ll create the header.

To draw headers directly onto the correct layer, you need to make the 
A-WALL-HEAD layer current. As you’ve seen, you can use the Layer Properties 
Manager. But several shortcuts also exist, including the Layer drop-down list in 
the Layers panel you’ve used to assign layers and the command-line interface 
you’ll use in this exercise:

 1. Make sure I06-09-SelectSimilar.dwg (M06-09-SelectSimilar.dwg) 
is open.

 2. At the command line, enter A-WALL but do not press ↵. The menu 
shown in top of Figure 6.35 will appear, listing any layers in the cur-
rent drawing whose name begins with A-WALL. Select the A-WALL-
HEAD layer from the list.

F I G u R E   6 . 3 5 :   Selecting the A-WALL-HEAD layer from the AutoComplete 
suggestion list (top), and the A-WALL-HEAD layer shown as the current layer in the 
Layers panel (bottom)

Once selected, the A-WALL-HEAD layer appears in the list box (see 
the bottom of Figure 6.35), telling you that the Headers layer has 
replaced Walls as the current layer.

 3. Make sure object snaps (osnaps) are enabled by clicking the Object 
Snap button on the status bar or by pressing F3. The Endpoint, 
Midpoint, and Intersection osnaps are now active. If they aren’t, 
right-click the Object Snap button and, in the context menu, click 
the osnaps that you want active.

 4. From the Home tab ➢ Layers panel, click the Freeze tool. As you 
begin to draw the headers, other objects, such as the doors and 
thresholds, may get in the way. You’ll use the Freeze tool to select the 
layers graphically instead of opening the Layer Properties Manager to 
freeze the respective layers.
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 5. At the Select an object on the layer to be frozen or: prompt, 
click one door or door swing (A-DOOR) and one threshold (A-DECK-
STRS). All the objects on the Doors and Steps layers temporarily 
disappear.

 6. Press Esc to end the Freeze command.
You need to draw two parallel lines across each of the three open-

ings, from the endpoint of one jamb line to the corresponding end-
point of the jamb on the opposite side of the opening.

 7. To start the LINE command, enter L↵ or click the Line button from 
the Home tab ➢ Draw panel.

 8. Move the cursor near the upper end of the left jamb for the back door 
until the colored snap marker appears at the upper-left endpoint of 
the jamb line, and then click.

 9. Move the cursor to the left end of the lower jamb, and click to complete 
the line.

 10. Right-click once to open a context menu near your cursor (see 
Figure 6.36), and then choose Enter from the contextual menu 
that displays.

F I G u R E   6 . 3 6 :   The right-click context menu for accessing recent and common 
commands
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 11. Select the header line you just drew and right-click. Choose the Add 
Selected option, as shown in Figure 6.37, to create another line with 
the same properties as the original line you drew.

F I G u R E   6 . 3 7 :   Choosing the Add Selected function from the right-click menu 
after selecting the header line

The Add Selected function can be a great substitute for the COPY 
command. As you have learned, the COPY command creates an iden-
tical duplicate of any object you select. By contrast, the Add Selected 
function only duplicates the selected objects properties and launches 
a creation command such as LINE, letting you draw whatever you 
need.

 12. Move to the right endpoint of the upper jamb line for the back door.
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 13. With the same technique used in steps 6 through 12, draw the lower 
header line across the opening. You can see the results in the image 
on the left in Figure 6.38.

F I G u R E   6 . 3 8 :   The header lines drawn for the back door opening (left) and 
for the rest of the doorway openings (right)

 14. Keep using the same procedure to draw the rest of the header lines 
for the remaining three doorway openings. The floor plan will look 
like the image on the right in Figure 6.38.

 15. Save this drawing as I06-10-Headers.dwg (M06-10-Headers.dwg).

Drawing the Roof
You’ve seen that the Layer drop-down list is a shortcut that allows you to pick a 
different layer quickly as the current layer and to turn off or turn on individual 
layers. You’ve also learned how to use the Layer Properties Manager to create 
new layers or to turn off many layers at a time. Next, you’ll learn about another 
tool for changing the current layer as you draw the rooflines.
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Before you start to draw the rooflines, refer to Figure 6.39 and note the lines 
representing different parts of the roof:

▶▶ Eight eaves lines around the perimeter of the building, representing 
the lowest edge of the roof

▶▶ One ridgeline, representing the peak of the roof

F I G u R E   6 . 3 9 :   The floor plan with the rooflines

The roof for the cabin is called a double-pitched roof because the panels slope 
down to the eaves on only two sides. You’ll start by drawing the eaves.

Creating the Eaves

Because the roof extends beyond the exterior walls the same distance on all 
sides of the building, you can generate the eaves lines by offsetting the outside 
wall lines:

 1. Make sure I06-10-Headers.dwg (M06-10-Headers.dwg) is open.

 2. Open the Layer drop-down list, and select the A-ROOF layer to make 
it current.

 3. Start the OFFSET command from the Home tab ➢ Modify panel ➢ 
Offset tool, or enter O↵ from the command line. Then follow these 
steps:

 a. At the Specify offset distance or: prompt, press the 
down arrow and select the Layer option (see the top image of 
Figure 6.40).
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F I G u R E   6 . 4 0 :   Choosing the Layer option (left) and the Current option (right)

 b. The second prompt reads Enter layer option for offset 
objects. Press the down arrow and select the Current option, 
or enter C↵ to instruct AutoCAD to create offsets on the current 
layer (A-ROOF), as shown in the bottom image of Figure 6.40.

 4. Enter 1′6↵ (457↵) when prompted to specify the offset distance.

 5. Pick the upper-left, vertical, outside handrail polyline, and then 
pick a point to the left of that polyline to offset it to the outside. The 
L-shaped offset line is on the Roof (A-ROOF) layer.

 6. Move to another side of the cabin, pick the lower-right, outside hand-
rail polyline, and offset it to the outside.

 7. Repeat this process for the three outside wall lines that define the 
pop-out on the bottom of the cabin and the short, horizontal, outside 
wall line to the left of the pop-out.

You have one offset element on each side of the cabin (see Figure 6.41).

F I G u R E   6 . 4 1 :   One outside wall line is offset to each side of the building.
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 8. Press ↵ to end the OFFSET command.

 9. Start the FILLET command from the Home tab ➢ Modify panel ➢ 
Offset tool.

 10. Verify that the fillet radius is set to 0 by entering R↵ and then 0↵ (or 
use the Shift key to override the radius value).

 11. Starting with the horizontal portion of the upper-left, L-shaped poly-
line, click two of these newly offset lines that are on adjacent sides of 
the building.

 12. Work around the building in a clockwise manner, being sure to click 
the half of the line nearest the corner where the two selected lines 
will meet (see the top of Figure 6.42).

Pick these lines 
for the �rst �llet.

F I G u R E   6 . 4 2 :   Picking lines to fillet one of the eaves’ corners (top) and the 
result (bottom)
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The lines extend to meet each other and form a corner (see the 
bottom of Figure 6.42). The FILLET command ends.

 13. Press ↵ to restart the FILLET command, and then enter M↵ to select 
the Multiple option.

Pick the remaining pairs of adjacent lines that will meet at the 
corners. When you try to fillet the final section, you’ll get a warning 
at the command prompt that reads Lines belonging to polylines 
must be consecutive or separated by one segment, and the 
command prompt returns to Select first object or:.

Although it looks as though the polyline has a single gap between 
two adjacent segments, in actuality the gap is between the first (ver-
tical) segment and the eighth (horizontal) segment. You can’t use 
the PEDIT command’s Close option yet because it would add an addi-
tional, diagonal segment from the polylines’ existing endpoints. You 
could explode the polyline into individual lines, execute the fillet, and 
then use PEDIT to join them, but in this case you’ll use the polylines’ 
grips to close the gap.

 14. Press the Esc key to terminate the FILLET command.

 15. Click the polyline to select it and display its grips.
You can temporarily turn off the Quick Properties panel by click-

ing the X in the upper-right corner, or you can turn it off completely 
by clicking the Object Properties button in the status bar.

Starting object Snaps

By now, you know that you can activate a nonrunning osnap by using the Ctrl+right-
click menu or the Object Snap toolbar or by typing the shortcut keys. From now 
on, I’ll simply instruct you to activate a specific object snap, and you can use the 
method you prefer.

 16. Click the grip at the open left endpoint of the horizontal segment (see 
the left of Figure 6.43).
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Pick this grip.

The Perpendicular osnap marker

Place the cursor over this vertical line.

Click this grip to extend the vertical line.

Select this grip �rst.

F I G u R E   6 . 4 3 :   Using the grip to move the horizontal endpoint (top) and the vertical 
endpoint (bottom)

The grip turns red to signify that it is hot (active) and can be 
manipulated.
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 17. Start the Perpendicular osnap, place the cursor over the open verti-
cal segment, and then click when the marker appears. The horizontal 
line is extended to the location perpendicular to the vertical line.

 18. Select the grip at the open end of the vertical segment to make it hot.

 19. Then click the open end of the horizontal line to move the first end-
point there (see the image on the right in Figure 6.43).

 20. Use the JOIN command on the Home tab ➢ expanded Modify panel 
to select each of the rooflines and create a closed polyline.

Visually, there is no difference in the perimeter of the roof, but 
AutoCAD no longer sees an open polyline. Closed polylines are almost 
always preferable in case you need to extrude a 2D object into a 3D 
object, and using closed polylines is generally a cleaner drafting prac-
tice. Your completed roof perimeter should look like Figure 6.44.

F I G u R E   6 . 4 4 :   The completed eaves lines after filleting

 21. Save this drawing as I06-11-DrawingRoof.dwg (M06-11-
DrawingRoof.dwg).

Setting a Linetype Scale Factor
Currently it’s hard to see that the lines drawn on the A-ROOF layer are indeed 
dashed, as specified in the Layer Properties Manager. Unless you zoom in to a 
line on the A-ROOF layer, the lines look continuous, like the objects on the other 
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layers in your drawing. This is because the dashes inside the Dashed linetype are 
set up to be 1⁄2″ (13 mm) long with 1⁄4″ (6 mm) spaces. Using the linetype scale, 
or LTSCALE as many call it, you will tell AutoCAD how to scale your linetypes.

Interestingly enough, a drawing’s linetype scale is controlled by three LTSCALE 
variables:

▶▶ LTSCALE (Linetype Scale)

▶▶ PSLTSCALE (Paper Space Linetype Scale)

▶▶ MSLTSCALE (Model Space Linetype Scale)

With three variables to choose from, it’s probably easy to see how one of 
the most debated topics among AutoCAD users is what setting should be used 
for these variables. I’ll show you two popular ways people choose to set these 
variables. The first is a manual approach, and the second is what I like to call 
LTSCALE autopilot.

In comparison to the LTSCALE variable itself, both PSLTSCALE and MSLTSCALE 
are relative newcomers. Consequently, many users still prefer to calculate their 
LTSCALE value manually. A common architectural scale is 1 ⁄2″ = 1′-0″. To make 
the dashed line segments plot (print) 1 ⁄2″ long (as desired), divide 12″ (1 foot) 
into 1⁄2″ (12″ × 1 ⁄2″ = 24).

If you set LTSCALE to 24, PSLTSCALE to 0, and MSLTSCALE to 0, the dashes for the 
DASHED linetype assigned to the A-ROOF layer will plot 1⁄2″ long. A big drawback 
to this method is that your dashes will be 1⁄2″ long only if you plot your drawing at 
a scale of 1⁄2″ = 1′-0″. Plotting your drawing at a scale of 1⁄4″ = 1′-0″ would trans-
late to the dashes in your drawing plotting 1⁄4″ long.

n o t E  The imperial-to-metric conversion is approximated.

If you’re confused by this method of calculating and setting the various 
LTSCALE variables, you’re not alone. The method I’m going to show you next is 
both a little easier and more modern than the first way I showed you. The fol-
lowing steps demonstrate how to put LTSCALE on autopilot:

 1. Make sure I06-11-DrawingRoof.dwg (M06-11-DrawingRoof.dwg)  
is open.
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 2. Enter LTSCALE↵ or LTS↵. The prompt in the command-line interface 
reads Enter new linetype scale factor <1.0000>:.

 3. Enter 1↵ to set the linetype scale factor to 1. Nothing changes quite 
yet, as the default value for LTSCALE is 1.

 4. Enter PSLTSCALE↵.

 5. When you see the prompt Enter new value for PSLTSCALE:, enter 1↵.

 6. Enter MSLTSCALE↵.

 7. When you see the prompt Enter new value for MSLTSCALE:, enter 1↵.

 8. Change the annotation scale of your drawing by clicking the Scale 
drop-down on the status bar, and select 1 ⁄2″ = 1′-0″ from the list of 
scales, as shown in Figure 6.45.

F I G u R E   6 . 4 5 :   The Annotation Scale list

If you aren’t satisfied with the dash size (shown in Figure 6.46), 
change the annotation scale again. An advantage to this method is 
that you can preview any scale (by changing the annotation scale) 
without affecting any drawing sheets in your project. Layout view-
ports have an annotation scale much like the Annotation Scale prop-
erty you just changed for model space. With LTSCALE, PSLTSCALE, and 
MSLTSCALE each set to 1, AutoCAD will automatically calculate the 
correct linetype scale based on the properties of each individual view.
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F I G u R E   6 . 4 6 :   The eaves lines on the Roof layer with visible dashes

 9. Save this drawing as I06-12-LinetypeScale.dwg (M06-12-
LinetypeScale.dwg).

Drawing the Ridgeline
To finish the roof, you’ll draw a single line to represent the peak of the roof that 
extends from the front of the cabin to the back. Because of the pop-out, the roof 
is not symmetrical, so the ridgeline will be centered on the two longest vertical 
sections.

Look at the Linetype drop-down list on the Properties panel (see Figure 6.47). 
A dashed line with the name ByLayer appears there. ByLayer tells you that the 
current linetype will be whatever linetype has been assigned to the current 
layer. In the case of the A-ROOF layer, the assigned linetype is Dashed. (You’ll 
read more about ByLayer later in this chapter.)

F I G u R E   6 . 4 7 :   The Linetype drop-down list

To draw the ridgeline, follow these steps:

 1. Continue using I06-12-LinetypeScale.dwg (M06-12-
LinetypeScale.dwg) or open it if it’s not already open.

▶

If your linetypes do 
not dash after you’ve 
changed the annota-
tion scale, enter REA↵ 
at the command 
line to perform a 
REGENALL.
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 2. Start the LINE command, and activate the Midpoint object snap.

 3. Start the line from the midpoint of the right vertical roofline.

 4. Start the Perpendicular osnap, and then click the vertical roofline on 
the opposite side of the cabin.

 5. Terminate the LINE command.
Your cabin should look like Figure 6.48.

F I G u R E   6 . 4 8 :   The completed roof

 6. Save this drawing as I06-13-Ridgeline.dwg (M06-13-Ridgeline.dwg).

using the Layer Walk tool
Before saving the next drawing, you will use the Make Object’s Layer Current 
button (Home tab ➢ Layers palette) to make the A-DOOR layer current. You 
will then use the Layer Walk tool to verify the contents of each layer by isolating 
them one at a time. Follow these steps:

 1. Make sure I06-13-Ridgeline.dwg (M06-13-Ridgeline.dwg) is open.

 2. Expand the Layers panel, and click the Pin button in the lower-right 
corner. This causes the panel to stay open after the cursor moves off 
it instead of autocollapsing.

 3. Verify that all layers are in a Thaw state by using the Thaw All Layers 
tool found on the Home tab ➢ Layers panel.
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 4. Click the Make Object’s Layer Current button in the top row of but-
tons in the Layers panel. You’ll get the Select object whose layer 
will become current: prompt.

 5. Pick one of the doors or swing lines. The A-DOOR layer replaces 
A-ROOF in the Layer drop-down list, telling you the A-DOOR layer is 
now the current layer.

t I P  The Make Object ’s Layer Current button works two ways. You can click the 
button and then select the object whose layer will become current, or you can select an 
object that’s on the target layer and then click the button. If you use the latter method to 
select multiple objects, they must all reside on the current layer, or the tool will prompt 
you to select an object.

 6. Click the Layer Walk button in the extended Layers panel to open the 
LayerWalk dialog box, shown in Figure 6.49.

F I G u R E   6 . 4 9 :   The LayerWalk dialog box

 7. Select a layer other than layer 0, and the drawing area shows only the 
objects on that layer.

 8. Use the up and down arrows to “walk” through the drawing’s layers, 
verifying that the objects reside on the correct layers. The top of 
Figure 6.50 shows the cabin drawing with the A-FLOR-FIXT layer 
selected.
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F I G u R E   6 . 5 0 :   Displaying the contents of the A-FLOR-FIXT layer (top) and the 
A-WALL layer (bottom)

If you double-click a layer name, that layer stays displayed even 
when it isn’t highlighted, and an asterisk appears next to the layer 
name. Figure 6.50 (bottom) shows the cabin drawing with the 
A-ROOF layer selected and the A-WALL layer locked on.

 9. Close the LayerWalk dialog box.

 10. Click the Unpin button to unpin the expanded Layers panel.
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By drawing the rooflines, you have completed most of the exercises for this 
chapter. The cabin floor plan is almost complete. In the next chapter, you’ll com-
plete the floor plan by using a grouping tool called a block to place windows in the 
external walls. The rest of this chapter contains a short discussion about color, 
linetypes, and lineweights and how they work with layers and objects. You’ll also 
look at the Action Recorder feature to record and play back repetitive tasks.

Setting Properties of Layers and objects
This section covers a few concepts you should consider when assigning proper-
ties to layers and objects.

Assigning a Color or a Linetype to an object 
Instead of a Layer
You can also assign properties of layers—such as color, linetype, and line-
weight—to objects. For example, think about the A-ROOF layer. It’s assigned the 
Dashed linetype. A line on the A-ROOF layer can be assigned the Continuous 
linetype, even though all other lines on the Roof layer are dashed. The same 
is true for color and lineweight. Occasionally, this makes sense, especially for 
linetypes, but that is the exception rather than the rule. To make such a change, 
follow these steps:

 1. Select the line.

 2. Open the Properties palette.

 3. Change the linetype from ByLayer to the linetype of your choice.

You can also use the Properties toolbar to make quick changes to an object’s 
appearance.

t I P  It ’s a generally accepted best practice that an object ’s color, linetype, line-
weight, and transparency should all be ByLayer. However, it ’s not uncommon to receive 
a drawing with lots of object overrides. Use the SETBYLAYER command to clean this up 

quickly.

In this chapter, you have seen how to assign colors and linetypes to layers in 
order to control the way objects on those layers appear. That is the rule to fol-
low. When objects are assigned properties that vary from those of their layer, the 
result can be confusing to someone working with your drawing file, because the 
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objects don’t appear to be on their assigned layer. If the object’s properties match 
those of another layer, you can mistakenly think the object is on that layer.

Making a Color or a Linetype Current
If you look at the Properties panel for a moment, you’ll see lists to the right of 
the Layer drop-down list. The first three of these lists are the Color, Linetype, 
and Lineweight controls. You use these tools to set a color, linetype, or line-
weight to be current. When this is done, each object subsequently created will 
be assigned the current linetype, lineweight, and/or color, regardless of which 
linetype, lineweight, and color have been assigned to the current layer. If, for 
example, the A-DOOR layer is set as the current layer, and the Dashed linetype 
and green color are assigned as current, any lines drawn are dashed and green 
but still on the A-DOOR layer. This isn’t a good way to set up the system of lay-
ers, linetypes, and colors because of the obvious confusion it will create in your 
drawing, but beginners often accidentally do this.

The best way to maintain maximum control of your drawing is to keep the 
current linetype, lineweight, and color set to ByLayer, as they are by default. 
When you do this, colors and linetypes are controlled by the layers, and an 
object takes on the color and linetype of the layer it is on. If this configuration is 
accidentally disturbed and objects are created with the wrong color or linetype, 
you can correct the situation without too much trouble:

 1. Reset the current color, lineweight, and linetype to ByLayer by using 
the drop-down lists on the Properties panel.

 2. Select all problem objects.

 3. Use the Properties palette or Quick Properties panel to change the 
linetype, lineweight, or color to ByLayer.

The objects will take on the color, lineweight, and linetype of the layer to 
which they have been assigned, and you can quickly tell whether they are on 
their proper layers.

using the Action Recorder
One of the most useful tools in AutoCAD is the Action Recorder. With this 
feature, you can perform repetitive tasks and save the steps to a file, called a 
macro, which can be played back whenever you need to repeat those steps in any 
drawing. For example, if you need to draw several countersunk holes in a plate 
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at a specified distance, you can prompt the user for a start point, angle, diam-
eter, and spacing, and then let AutoCAD do the work. The Action Recorder cre-
ates the macros for you without the need for you to learn macro programming.

For this example, you will add two new layers to your drawing and then make 
one of them the current layer. The practice of adding your standards to a draw-
ing from someone else (a client, contractor, and so on) is common. Follow these 
steps to create the action:

 1. Click the Manage tab from the Ribbon to display a series of panels 
that contain tools for managing a drawing’s interface and standards.

 2. Click the Record button (Manage tab ➢ Action Recorder panel).
The Record button changes to a Stop button, and the panel pins 

itself open, as shown in Figure 6.51. A large red dot appears at the 
cursor to remind you that the actions are being recorded.

F I G u R E   6 . 5 1 :   The Action Recorder panel as it appears when the actions are 
being recorded

You’ll use the command line to start the LAYER command. The 
- prefix starts the command without opening the Layer Properties 
Manager.

 3. Enter -LAYER↵.

 4. Enter N↵ or pick New from the list that appears at the cursor.

 5. Enter L-PLNT↵ to name the new layer. Both methods for selecting an 
option work equally well.

 6. Select the New option again, and enter E-POWR↵ to create and name 
the new layer.
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 7. Choose the Set option.

 8. Enter E-POWR↵ to make the E-POWR layer current and end the LAYER 
command.

 9. Click the Stop button to discontinue recording the actions. Your 
Action Recorder panel should look like Figure 6.52.

F I G u R E   6 . 5 2 :   The Action Recorder after creating the new layers and setting 
the current layer

 10. In the Action Macro dialog box that opens (see Figure 6.53), enter 
New_Layers↵ in the Action Macro Command Name field, and add a 
description if you like.

F I G u R E   6 . 5 3 :   The Action Macro dialog box
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W A R n I n G  Special characters, such as spaces or slashes, are not permitted 
in action filenames.

 11. Click OK, and the macro is saved as New_Layers.actm in the C:\
Users\username\appdata\roaming\autodesk\autocad 2015\r19.2\
enu\support\actions folder. (A copy is also available on this book’s 
web page.)

 12. Unpin the Action Recorder panel so that it can collapse.

 13. Open a new drawing file.

 14. Make sure the New_Layers macro name appears in the Available 
Action Macro field, and click the Play button, as shown in 
Figure 6.54.

F I G u R E   6 . 5 4 :   Playing the New_Layers macro in the Action Recorder panel

 15. Click Close when the Action Macro dialog box indicates that the 
macro has run to completion (see Figure 6.55).

F I G u R E   6 . 5 5 :   The Action Macro dialog box

 16. Switch to the Home tab, and then open the Layer drop-down list in 
the Layers panel. You will see the new layers the macro created.

 17. Save your cabin drawing as I06-14-ActionMacro.dwg (M06-14-
ActionMacro.dwg).
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As you can see, action macros are easy to record and can save you time when 
repetitive tasks are required. You could have easily set layers’ colors, linetypes, 
or on/off statuses, or performed other layer-related tasks. The Action Recorder 
is quite powerful and can save a great amount of time when you use it to create 
macros specific to your needs. You can close the blank drawing without saving 
the changes.

If You Would Like More Practice…
Layers are a critical organizational tool for your drawings. In this chapter, you 
learned to create and manage layers for the cabin project. Here are a couple of 
extra exercises that will help you manage layers in the drawings you create.

Creating a Layer State
Even a drawing that reads well when printed may get cluttered in the viewports, 
and it can become difficult to execute a command properly. Often, you will find 
yourself freezing or turning off the same layers to execute a specific task and 
then making them visible again. In the course of your workday, you might issue 
the same sequence of layer commands dozens of times. To make this task more 
efficient, layer states are available. Layer states are named settings in which 
you can save the conditions of the layers, such as On, Frozen, or Current, and 
restore them through the Layer States Manager dialog box. The following exer-
cise demonstrates how to create a layer state that shows only the floor plan and 
not the roof or fixtures:

 1. Continue using the drawing you used to complete the previous 
Action Recorder exercise, or open I06-14-ActionMacro.dwg (M06-14-
ActionMacro.dwg).

 2. In the Cabin drawing, make layer 0 the current layer.

 3. From the Layer drop-down list or the Layer Properties Manager, 
freeze the A-ROOF and A-FLOR-FIXT layers.

 4. On the Layers panel, click the Layer States drop-down list, which 
currently shows Unsaved Layer State, and click Manage Layer States, 
as shown in Figure 6.56.
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F I G u R E   6 . 5 6 :   Accessing the Layer States Manager

The Layer States Manager dialog box opens.

 5. Click the New button to create a new saved layer state.

 6. In the New Layer State To Save dialog box, enter Floor Plan in the 
New Layer State Name field. If you like, enter a description for the 
layer state as well (see Figure 6.57).

F I G u R E   6 . 5 7 :   Saving a layer state in the New Layer State To Save dialog box

 7. Click OK when you are finished.

 8. The new layer state appears in the Layer States Manager dialog box, 
as shown in Figure 6.58. Click the Close button to close the Layer 
States Manager dialog box.

www.MouradEngineering.com



	 I f 	 Yo u 	Wou l d 	 L i k e 	Mo r e 	 P r a c t i c e…  3 2 3

F I G u R E   6 . 5 8 :   The Layer States Manager dialog box showing the new layer 
state

 9. Thaw the Roof and Fixtures layers. The objects on those layers 
become visible again.

 10. Open the Layer States Manager dialog box again.

 11. Click the More Restore Options button—the right-facing arrow at the 
bottom-right corner—to display additional options.

The items shown in the Layer Properties To Restore section are, 
when checked, the features of the layer state that are affected when it 
is restored. It is important to note that if you make changes to a lay-
er’s color or lineweight, those changes are lost when the layer state is 
restored if those features are checked here.

 12. Uncheck the Color, Linetype, and Lineweight options (see 
Figure 6.59), and then click the Restore button.
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F I G u R E   6 . 5 9 :   The Layer States Manager dialog box with the restore options 
selected

The Roof and Fixtures layers are frozen again (see Figure 6.60), and 
Floor Plan appears in the Layer State drop-down list.

F I G u R E   6 . 6 0 :   The cabin with the Roof and Fixtures layers frozen

www.MouradEngineering.com



	 I f 	 Yo u 	Wou l d 	 L i k e 	Mo r e 	 P r a c t i c e…  3 2 5

 13. Save this drawing as I06A-FPLAY0.dwg (M06A-FPLAY0.dwg).

As you can see, saving layer states can reduce the number of steps it takes to 
restore a specific set of layer properties. In a complex drawing, it isn’t uncom-
mon to have a dozen or more saved layer states.

using the Layer States Manager

You also use the Layer States Manager dialog box to manage existing layer states. 
Here are its primary features:

Layer States List Box  Displays a list of previously saved layer states.

Restore Button  Restores the layer state that is highlighted in the Layer 
States list box.

Edit Button  Opens the Edit Layer State dialog box, where the current layer 
state’s properties are edited.

Delete Button  Deletes a layer state. This doesn’t affect the current layer setup.

Import Button  Imports an LAS file, from a DWG, DWS, or DWT file, as a new 
layer state in the current drawing.

Export Button  Exports the chosen saved layer state to be saved as an LAS file.

To modify a layer state, restore it to be the current layer state and then change 
it. To rename a layer state, highlight it, click its name, and enter the new name.

Setting up Layers for Your trade or Profession
Open a new drawing, and set up approximately 10 layers that you might use in 
your profession. Assign colors and linetypes to them. Most activities that use 
CAD have some layers in common, such as Centerline, Border or Titleblock, 
Drawing Symbols, Dimensions, and Text or Lettering.
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Are You Experienced?

now you can…

✔✔ create new layers and assign them a color and a linetype

✔✔ load a new linetype into your current drawing file

✔✔ move	existing	objects	onto	a	new	layer

✔✔ turn layers off and on

✔✔ freeze and thaw layers

✔✔ make	a	layer	current,	and	create	objects	on	the	current	layer

✔✔ use	the	Layer	Walk	tool	to	verify	that	objects	are	on	the	proper	layers

✔✔ reset	the	linetype	scale	factor	globally	or	for	a	selected	object

✔✔ record action macros
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CHAPtER 7

Combining objects 
into Blocks
Much of the efficiency of computer drafting is derived from a feature 
that makes it possible to combine a collection of objects into an entity that 
behaves as a single object. In the Autodesk® AutoCAD® software, these col-
lected objects are called a block. The AutoCAD tools that work specifically 
with blocks make it possible to do the following:

▶▶ Create a block in your current drawing

▶▶ Repeatedly place copies of a block in precise locations in your 
drawing

▶▶ Share blocks between drawings

▶▶ Create DWG™ files from either blocks or portions of your  
current drawing

▶▶ Store blocks on a palette for easy reuse in any drawing

In this chapter, you will learn to

▶▶ Create,	insert,	and	export	blocks

▶▶ Detect	blocks	in	a	drawing

▶▶ Insert	and	manage	blocks	by	using	AutoCAD	DesignCenter™  
and tool palettes
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Making a Block for a Door
In general, objects that are best suited to becoming part of a block are the 
components that are repeatedly used in your drawings. In architecture and 
construction, examples of these components are doors, windows, and fixtures; 
or drawing symbols, such as a North arrow; or labels for a section cut line (as 
shown in the examples in Figure 7.1). In mechanical drawings, these can be 
countersunk and counterbored holes, screws, bolts, fasteners, switches, or any 
other objects that you find yourself repeatedly drawing. 

In your cabin drawing, you’ll convert the doors with swings into blocks. You’ll 
then create a new block that you’ll use to place the windows in the cabin draw-
ing. To accomplish these tasks, you need to learn two new commands: BLOCK 
and INSERT.

F I G u R E   7 . 1 :   Examples of blocks often used in architectural drawings

When making a block, you create a block definition. This is an entity that is 
stored in the drawing file and consists of the following components:

▶▶ The block name

▶▶ An insertion point to help you place the block in the drawing

▶▶ The objects to be grouped into the block

You specify each of these in the course of using the BLOCK command. When 
the command is completed, the objects are designated as a single block, and the 
block definition is stored with the drawing file. You then insert additional copies 
of the block into the drawing by using the INSERT command.
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About Commands and tools

In previous chapters, I told you exactly what to click or enter to launch a command. 
Now that you’re familiar with the AutoCAD interface, I’ll simply instruct you to 
start a command or tool. In general, I’ll refer to a command by the tooltip that 
appears when you place the cursor on the command’s icon on the Ribbon or the 
command as it is entered at the Type a command prompt.

I’ll refer to tools and commands that do not have an icon on the Ribbon by their 
name on the associated menu or other interface element such as the status bar. 
In the rare case that the command doesn’t appear in either place, I’ll tell you 
what to enter in the command-line interface. Any command can be started by 
entering its name or an alias at the Type a command prompt, whereas some 
also have keyboard shortcuts. Where applicable, I’ll mention the command aliases 
and keyboard shortcuts.

Although it’s technically possible to create blocks on any layer of your choice, 
the generally accepted best practice is to always define blocks that are to be used 
as symbols in a drawing on layer 0. It is also recommended that the color, line-
type, and lineweight of each be set to ByLayer or ByBlock. Drawing your blocks 
with these properties in mind allows you to manage their appearance in the 
same way as other linework in your drawing. Objects on other layers retain the 
properties of their original layers, regardless of which color or linetype has been 
assigned to the current layer. This is one characteristic that distinguishes layer 0 
from all other layers.

To get started, you’ll see how to create blocks from objects already in your 
drawing. You’ll create a block for the back exterior door and call it A-DOOR-
36IN to match the NCS naming convention used throughout this book. For the 
insertion point, you need to assign a point on or near the door that will facilitate 
its placement as a block in your drawing. The hinge point makes the best inser-
tion point.

For this chapter, the Endpoint osnap should be running most of the time, and 
Polar Tracking should be off. Follow these steps to set up your drawing:

 1. Continue using the I06A-FPLAYO.dwg (M06A-FPLAYO.dwg) drawing 
you created in Chapter 6, “Using Layers to Organize Your Drawing.” 
If you’re starting a new session, you can download this file from the 
book’s website at www.sybex.com/go/autocad2015ner or from www 
.thecadgeek.com.

◀

The objects that com-
pose blocks can reside 
on more than one layer.
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 2. Click the Layer drop-down list, and click the sun icon for the 
A-WALL-HEAD layer to freeze it.

 3. Click the A-DOOR layer to close the list.
The A-DOOR layer is now current, and the sun next to the A-WALL-

HEAD layer turns into a snowflake. In addition to the A-WALL-HEAD 
layer, the A-FLOR-FIXT and A-ROOF layers should still be frozen from 
Chapter 6 (see Figure 7.2).

F I G u R E   7 . 2 :   The floor plan with the A-FLOR-FIXT, A-ROOF, and A-WALL-HEAD 
layers frozen

 4. Check the status bar, and make sure the Object Snap button is in the 
On position.

 5. Right-click the Object Snap button to display the Object Snap tab of 
the Drafting Settings dialog box.

 6. Make sure that, at a minimum, the Endpoint osnap is running. If 
it isn’t, select the Endpoint Object Snap check box in the Drafting 
Settings dialog box.

 7. In the status bar, turn Polar Tracking off if it’s on.

t I P  The features in the status bar and their options are general AutoCAD settings 
and are not saved as properties of any particular drawing. Changes made on the status 
bar in one drawing are in effect when any subsequent drawings are opened or accessed.

 8. Turn off Quick Properties to prevent the Quick Properties panel from 
opening whenever an object is selected.

▶

You’re using the Freeze 
option for layers this 
time because you won’t 
need to see the lines 
on the A-ROOF, A-FLOR-
FIXT, and A-WALL-HEAD 
layers for a while. This 
might be a good time 
to consider creating 
another layer state.
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Now you’re ready to make blocks, so follow these steps:

 1. Click the Create Block button found on the Insert tab ➢ Block 
Definition panel.

The Block Definition dialog box opens, where you can specify some 
basic parameters for your block.

 2. Notice the flashing cursor in the Name text box. Type A-DOOR-36IN 
(A-DOOR-0915), but don’t press ↵ (see Figure 7.3).

F I G u R E   7 . 3 :   The Block Definition dialog box

 3. Click the Pick Point button in the Base Point group of the Block 
Definition dialog box.

The dialog box temporarily closes, and you’re returned to your 
drawing.

 4. Use the scroll wheel on the mouse to zoom in to the back door area in 
your drawing.

 5. Move the cursor to the back door area, and position it near the  
hinge point of the door. When the Endpoint marker appears on  
the hinge point (see Figure 7.4), click.

◀

You can also start the 
BLOCK command by 
entering B↵.
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F I G u R E   7 . 4 :   The back door opening when the hinge point is picked as the 
insertion point

This selects the insertion point for the door, and the Block 
Definition dialog box returns. The insertion point is the location, 
relative to the cursor, that the block references when it is inserted.

 6. Click the Select Objects button in the Objects group of the Block 
Definition dialog box.

You’re returned to the drawing again. The cursor changes to a pick-
box, and the command-line interface displays the Select objects: 
prompt.

 7. Select the door and swing, and then press ↵.
You’re returned to the Block Definition dialog box.

 8. At the bottom of the Objects group, the count of selected objects 
appears. Just above that are three radio buttons. Click the Delete 
radio button if it’s not already selected.
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The Delete option erases the selected objects after the block defini-
tion is created, requiring you to insert the block into the drawing.

The Convert To Block option replaces objects with a block defini-
tion as soon as the block is created. In this situation, the Convert 
To Block option would be a better choice, but it’s a good idea to get 
some practice using the INSERT command, which is why you selected 
Delete at the beginning of this step.

 9. Enter a description of the block in the Description field, and make 
sure Inches (or Millimeters) is specified in the Block Unit drop-down 
list, depending on the units you are using.

The Block Definition dialog box should look similar to Figure 7.5.

F I G u R E   7 . 5 :   Defining the A-DOOR-36IN (A-DOOR-0915) settings in the Block 
Definition dialog box

 10. At the bottom of the dialog box, be sure the Open In Block Editor 
check box is selected and then click OK to close the dialog box.

The Block Editor loads, displaying the A-DOOR-36IN 
(A-DOOR-0915) block you just created (see Figure 7.6).
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F I G u R E   7 . 6 :   The Block Editor displaying the A-DOOR-36IN (A-DOOR-0915) 
block

Because the objects, in this case the door and swing, used to create 
the A-DOOR-36IN (A-DOOR-0915) block were drawn on the A-DOOR 
layer, the objects within the block are also on that layer. As discussed 
earlier, the preferred practice is to define blocks such as this one on 
layer 0 so that they’re easier to manage.

 11. Select the door and swing inside the Block Editor, and change its 
layer to layer 0 by using the Layer drop-down on the Home tab ➢ 
Layers panel (see Figure 7.7).

F I G u R E   7 . 7 :   Changing the door’s layer inside the Block Editor
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 12. Click the Close Block Editor button found on the contextual Close 
panel appended to the end of any Ribbon tab.

 13. If prompted, choose Save The Changes To A-DOOR-36IN (A-DOOR-0915) 
from the Block – Changes Not Saved dialog box, as shown in Figure 7.8.

F I G u R E   7 . 8 :   Choosing to save changes from the Block – Changes Not Saved 
dialog box

 14. Save your drawing as I07-01-DoorBlock.dwg (M07-01-DoorBlock.dwg) 
by choosing Application menu ➢ Save As ➢ AutoCAD Drawing.

You have now created a block definition called A-DOOR-36IN (A-DOOR-0915). 
Block definitions are stored electronically with the drawing file. You need to 
insert the A-DOOR-36IN (A-DOOR-0915) block (known formally as a block refer-
ence) into the back door opening to replace the door and swing that were just 
deleted when the block was created.

the Fate of objects used to Make a Block

The three radio buttons in the Objects group of the Block Definition dialog box 
represent the options you have for objects transformed into a block:

Retain  The objects remain unblocked. Click this if you want to make several 
similar blocks from the same set of objects.

Convert to Block  The objects become the block reference. Click this if the first 
use of the block has geometry identical to that of the set of objects it’s replacing.

Delete  The objects are automatically erased after the block has been defined. 
Click this if the first use of the block will be at a different scale, orientation, or 
location from the set of objects it’s replacing.
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Inserting the Door Block
You’ll use the INSERT command to place the A-DOOR-36IN (A-DOOR-0915) 
block back into the drawing:

 1. Make sure I07-01-DoorBlock.dwg (M07-01-DoorBlock.dwg) is open, 
and set the A-DOOR layer as the current layer.

 2. Click the Insert button found on the Insert tab ➢ Block panel, and 
select the A-DOOR-36IN (A-DOOR-0915) block from the Block gallery 
shown in Figure 7.9.

F I G u R E   7 . 9 :   Selecting a block from the Block gallery

This starts the INSERT command with the most-common settings 
specified by default.

 3. The preview of A-DOOR-36IN (A-DOOR-0915) is attached at the hinge 
point coinciding with the intersection of the crosshairs (see Figure 7.10).

F I G u R E   7 . 1 0 :   The A-DOOR-36IN (A-DOOR-0915) block attached to the cursor
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The command line reads Specify insertion point or 
[Basepoint/Scale/X/Y/Z/Rotate]:.

 4. With the Endpoint osnap running, move the cursor toward the right 
end of the lower jamb line in the back door opening.

 5. When the Endpoint marker appears at the jamb line’s lower-right 
endpoint (shown in Figure 7.11), click.

The A-DOOR-36IN (A-DOOR-0915) block is no longer attached to 
the cursor, its insertion point has been placed at the right end of the 
lower jamb line, and the block is placed in the drawing.

F I G u R E   7 . 1 1 :   Placing the A-DOOR-36IN (A-DOOR-0915) block with the 
Endpoint object snap

 6. Save your drawing as I07-02-BlockInsert.dwg (M07-02-
BlockInsert.dwg) by choosing Application menu ➢ Save As ➢ 
Drawing.

In addition to the insertion point, blocks also provide the ability to specify a 
rotation angle along with separate X, Y, and Z scale factors. Using these options, 
you can stretch or flip blocks horizontally by specifying a negative X scale fac-
tor, or vertically by specifying a negative Y scale factor—or you can rotate 
them from their original orientations. Because you created the A-DOOR-36IN 
(A-DOOR-0915) block from the door and swing that occupied the back door 
opening, and the size was the same, inserting this block back into the back door 
opening required no rotation, so you used the defaults. 

◀

Nothing has changed 
about the geometry of 
the door, but it’s now a 
different kind of object. 
It was a rectangle and 
an arc; now it’s a block 
reference comprising a 
rectangle and an arc.
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Blocking and Inserting the Interior Door

Because the interior door is smaller, you need to make a new block for it. You 
could insert the A-DOOR-36IN (A-DOOR-0915) block with a 5⁄6 (762⁄915) scale 
factor, but this would also reduce the door thickness by the same factor, and you 
don’t want that.

On the other hand, for consistency it’s a good idea to orient all door blocks 
the same way, and the bathroom door is turned relative to the A-DOOR-36IN 
(A-DOOR-0915) block. You’ll move and rotate the bathroom door and its swing 
to orient it like the back door:

 1. Make sure I07-02-BlockInsert.dwg (M07-02-BlockInsert.dwg)  
is open.

 2. Use Zoom Window to define a window that encloses the bathroom 
door. The view changes to a close-up of the area enclosed in your 
window (see Figure 7.12).

F I G u R E   7 . 1 2 :   The result of a zoom window

 3. Follow a procedure similar to the one you used to make a block out 
of the back door and swing to make a block out of the bathroom door 
and swing. Here is a summary of the steps:

 a. Start the BLOCK command. (Click the Create Block button on 
the Home tab ➢ Block panel.)

 b. In the dialog box, type A-DOOR-30IN (A-DOOR-0762) to name 
the new block. Don’t press ↵.

 c. Click the Pick Point button, and pick the hinge point of the 
bathroom door.

 d. Click the Select Objects button, and pick the door and swing. 
Then press ↵.

 e. In the Objects group, make sure the Delete radio button is selected.

▶

After you finish the 
swinging doors, I’ll go 
into some detail about 
the AutoCAD dynamic 
block, which you can 
use for all swinging 
doors.
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 f. Make sure the Block Unit option is correct, and add a description.

 g. Select the Open In Block Editor check box, and then click OK.
The door and swing disappear, and the Block Editor opens to 

display the block you just created.

 4. Use the Layer drop-down list on the Home tab ➢ Layers panel to change 
the layer of the door and swing to layer 0 from within the Block Editor.

After changing the layer, click Close Block Editor; be sure to save 
changes.

 5. Click the Insert button found on the Insert tab ➢ Block panel, and 
select More Options at the bottom of the Block gallery.

This opens the Insert dialog box, which allows you to override the 
default settings for inserting blocks.

 6. From the Insert dialog box, choose the A-DOOR-30IN 
(A-DOOR-0762) block by using the Name drop-down list found  
at the top of the dialog box.

A preview of the block appears in the upper-right corner (see 
Figure 7.13).

F I G u R E   7 . 1 3 :   The Insert dialog box

 7. With the A-DOOR-30IN (A-DOOR-0762) block specified, choose the 
following settings within the Insert dialog box:

 a. Under the Insertion Point Group, check the Specify On-Screen 
option.

 b. Under the Scale group, uncheck the Specify On-Screen option.
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 c. Under the Rotation group, check the Specify On-Screen option.

 d. Make sure the Explode check box in the lower-left corner is 
unchecked. Explode disassembles the block into its component 
parts upon insertion into the drawing.

 8. Click OK to return to your drawing. Similar to the last exercise, the 
A-DOOR-30IN (A-DOOR-0762) block is now attached to the cur-
sor, with the hinge point coinciding with the intersection of the 
crosshairs.

 9. With the Endpoint osnap running, move the cursor toward the lower-
right corner of the bathroom door opening, and click.

The A-DOOR-36IN (A-DOOR-0762) block is inserted into your 
drawing at the bathroom door opening (see Figure 7.14).

F I G u R E   7 . 1 4 :   The floor plan with all swinging doors converted into blocks

n o t E  If all your doors are at 90° angles, you can turn on Ortho mode to speed up 
the rotation process. With Ortho active, wherever you move the cursor at the Specify 
rotation angle <0.00>: prompt, the rotations are restricted to 90 increments.

 10. Use the Zoom Extents tool to show the entire cabin in the drawing 
area (see Figure 7.14).
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 11. Save your drawing as I07-03-InteriorDoor.dwg (M07-03-
InteriorDoor.dwg).

t I P  If you have trouble anticipating how a block such as the door block needs to 
be flipped or rotated during insertion, don’t worry about it; just be sure to locate the 
insertion point accurately in the drawing. Then, after the block is inserted, you can flip or 
turn it by using the MIRROR and ROTATE commands.

This view looks the same as the view you started with at the beginning of this 
chapter (see Figure 7.2). Blocks look the same as other objects, and you can’t 
detect them by sight. They’re useful because you can use them over and over 
again in a drawing or in many drawings and because the block is a combina-
tion of two or more (and sometimes many more) objects represented as a single 
object. Your next task is to learn how to detect a block.

understanding and using Groups
Another way you can make several objects act as one is to use the GROUP com-
mand. Groups differ from blocks in that they do not replace separate objects 
with a single definition but instead associate several objects by name so that 
they react as if they were a single object.

Selecting one member object from the group selects all the members. Unlike 
objects in a block, members of a group can be added or removed, and you can 
toggle the group to allow the individual members to be selected. Use groups 
when you know that the association between the objects is not permanent, and 
use blocks when it might be. 

The procedure for creating a group is as follows:

 1. Make sure I07-03-InteriorDoor.dwg (M07-03-InteriorDoor.dwg) 
is open.

 2. Start the GROUP command by clicking the Group button on the Home 
tab ➢ Groups panel.

 3. Select the four rectangles that compose the closet door, as shown in 
Figure 7.15. Do not press ↵ yet.

◀

Some similar programs 
use the term named 
selection set to repre-
sent what AutoCAD 
calls a group.
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F I G u R E   7 . 1 5 :   Selecting the closet door

 4. With the closet door selected, enter N↵ or select New at the command 
line to specify a name for your group.

 5. At the Enter a group name: prompt, name your group CLOSETDOOR. 
Press ↵ to define the group name.

The command line confirms the group creation: Group 
"CLOSETDOOR" has been created.

 6. Select any one of the four rectangles that define the closet door.
Although you selected only one door panel, all four door panels 

are highlighted, and a bounding box defining the extents of your 
CLOSETDOOR group is displayed along with a single grip at the 
group’s centroid (see Figure 7.16).

F I G u R E   7 . 1 6 :   The CLOSETDOOR group in a selected state with a bounding box 
and centroid grip
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 7. Click the Group Selection On/Off button on the Home tab ➢ Groups 
panel to turn off group selection temporarily.

 8. Select any one of the four door panels that define the closet door.
Because Group Selection is currently disabled, only the panel 

you selected is highlighted (see Figure 7.17). In this state, you could 
modify the polyline defining the door panel you selected as if it were 
an ungrouped entity.

F I G u R E   7 . 1 7 :   A single object in the CLOSETDOOR group selected with Group 
Selection turned off

Groups are often used as a temporary drafting tool. As such, to 
ensure that your AutoCAD drawings remain uncluttered and per-
forming at their best, you’ll want to dispose of unneeded groups 
when you’re finished with them.

 9. Click the Group Selection On/Off button once again, this time to 
re-enable Group Selection. The Group Selection On/Off icon should 
display with a blue background.

 10. Select any one of the four door panels to select the CLOSETDOOR 
group.

 11. Click the Ungroup button on the Home tab ➢ Groups panel.
The CLOSETDOOR group is discarded, and the command line 

reads Group CLOSETDOOR exploded.
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AutoCAD versions prior to the 2012 release included a limited subset of cre-
ation, editing, and management tools; AutoCAD has included a Groups feature 
for many releases. Despite these limitations, the Group object itself is the same 
as it was in earlier versions, making it possible to exchange drawings freely with 
groups between all recent AutoCAD versions.

Finding Blocks in a Drawing
You can detect blocks in a drawing in at least three ways: by using grips, by 
using the LIST command, and by looking at the Properties palette.

using Grips to Detect a Block
Grips appear on objects that are selected when no command is started. When an 
object that isn’t a block is selected, grips appear at strategic places, such as end-
points, midpoints, and center points. But if you select a block, by default only 
one grip appears, and it’s always located at the block’s insertion point. Because 
of this, clicking an object when no command is started is a quick way to see 
whether the object is a block:

 1. Make sure I07-03-InteriorDoor.dwg (M07-03-InteriorDoor.dwg) is 
open.

 2. Click one of the door swings.
The door and swing turn into dashed lines, and a square blue grip 

appears at the hinge point, as shown in Figure 7.18.

F I G u R E   7 . 1 8 :   Blocks have only one grip, which is at the insertion point.

 3. Press Esc to clear the grip.

You’ll look at grips in more detail in Chapter 12, “Dimensioning a Drawing.” 
You might need to know more about a block than just whether something is 
one. If that is the case, you’ll need to use the LIST command.

www.MouradEngineering.com



	 F i n d i n g 	 B l o c k s 	 i n 	 a 	D r aw i n g  3 4 5

using the LIST Command to Detect a Block
Much like the Properties palette, the LIST command can be used to gather 
information about a selected object. Although both are effective tools for report-
ing information about objects in a drawing, the LIST command displays only 
information. Unlike in the Properties palette, you cannot make changes to prop-
erties such as the layer. Despite this limitation, many users like the lightweight 
and concise nature of the LIST command and prefer it to the Properties palette. 
The following exercise demonstrates how to use the LIST command to learn 
more about a block:

 1. Continue using I07-03-InteriorDoor.dwg (M07-03-InteriorDoor 
.dwg), or open it if it’s not already open.

 2. Click the List button from the Home tab ➢ expanded Properties 
panel, or enter LI↵ at the Type a command prompt.

 3. Click the back door block and then press ↵.
The AutoCAD command line temporarily expands to cover the 

drawing area (see Figure 7.19). In the command-line interface, you 
can see the words BLOCK REFERENCE Layer: "A-DOOR", followed by 
12 lines of text. These 13 lines describe the block you selected.

F I G u R E   7 . 1 9 :   The expanded AutoCAD command line

The information displayed includes the following:

▶▶ What the object is (block reference)

▶▶ The layer the object is on (A-DOOR layer)

▶▶ The name of the block (A-DOOR-36IN)
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▶▶ The coordinates of the insertion point in the drawing

▶▶ The X, Y, and Z scale factors

▶▶ The rotation angle

 4. Should the command line collapse, pressing F2 will expand the 
AutoCAD command line once again to display the information shown 
in Figure 7.19.

 5. Right-click and choose Repeat LIST from the context menu.

 6. At the Select objects: prompt, select each of the lines that make 
up the back staircase.

 7. Click one of the wall lines and then press ↵.

t I P  The expanded AutoCAD command line isn’t exclusively for use with the LIST 
command. Instead, it is a constantly scrolling history of the command prompt. The F2 key 
acts as a toggle to expand or consolidate the command line. You can even copy informa-
tion from all but the bottom line for use inside or outside AutoCAD.

The command line expands again, and you can see information 
about the stair lines that you selected (see Figure 7.20).

If the command line reads Press ENTER to continue:, the 
amount of information is too large for the expanded command line.

F I G u R E   7 . 2 0 :   The expanded command line indicating additional information 
from the LIST command 
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 8. Press ↵ to display the remaining information.

 9. As the remaining information reported by the LIST command 
displays, earlier information is pushed out of view. Although this 
information is no longer in view, you can use your mouse wheel, or 
the scrolling feature on some laptop track pads, to view this earlier 
information.

using the Properties Palette to Examine a Block
In Chapter 6, you used the Properties palette to change the individual linetype 
scale for the roof objects. It can also be a tool for investigating objects in your 
drawing. When the Properties palette is open and only one object is selected, 
the palette displays data specific to the selected object. If multiple objects are 
selected, it shows only the data shared by those objects.

Given the contextual nature of the Properties palette, it’s important to note 
this behavior. As an example, information such as the name of a block will dis-
play only when one or more of that same block is selected. In contrast, selecting 
both a block and a line will display only the properties both objects share (such 
as a layer), omitting differences (such as a block name). Follow these steps to use 
the Properties palette to query information about blocks:

 1. Continue using I07-03-InteriorDoor.dwg (M07-03-InteriorDoor 
.dwg), or open it if it’s not already open.

 2. Select one of the door blocks.

 3. Click the Properties button on the View tab ➢ Palettes panel of the 
Ribbon. Alternatively, you can right-click and choose Properties from 
the context menu, or press Ctrl+1.

The Properties palette opens. The data displayed on the palette is 
similar to that displayed when you used the LIST command, but it’s in 
a slightly different form (see Figure 7.21). At the top of the dialog box, 
a drop-down list displays the type of object selected—in this case, a 
block reference. The fields that are white signify items that you can 
change directly in the palette, and items that are grayed out cannot 
be changed. You can’t change any values in the AutoCAD text window.
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F I G u R E   7 . 2 1 :   The Properties palette with a door block selected

 4. Close the Properties palette by clicking the X in the upper-left or 
upper-right corner. Then press Esc to deselect the door block.

t I P  The X you click to close the Properties palette is in the upper-left or upper-
right corner of the palette if it’s floating and in the upper-right corner if it’s docked.

If you’re ever working on a drawing that someone else created, these tools for 
finding out about objects will be invaluable. The next exercise on working with 
blocks involves placing windows in the walls of the cabin.

Creating a Window Block
You can create all the windows in the cabin floor plan from one block, even 
though the windows are four different sizes (see Figure 7.22). You’ll create a 
window block and then go from room to room to insert the block into the walls:

▶

Block insertion means 
the same thing as block 
reference, and both are 
casually called blocks.
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F I G u R E   7 . 2 2 :   The cabin windows in the floor plan

 1. Continue using I07-03-InteriorDoor.dwg (M07-03-InteriorDoor.dwg), 
or open it if it’s not already open.

 2. Make layer 0 the current layer.

 3. Right-click the Object Snap button on the status bar; click the  
Midpoint and Perpendicular osnaps, if necessary, to set them as  
running osnaps; and deselect Intersection.

The Osnap menu should look similar to Figure 7.23. Turn on the 
Object Snap option in the status bar.

F I G u R E   7 . 2 3 :   The Osnap menu
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 4. Using a zoom window, zoom in to a horizontal section of wall 
where there are no jamb lines or intersections with other walls (see 
Figure 7.24).

Select this area with a zoom window.

F I G u R E   7 . 2 4 :   Making a zoom window

Because the widths of the windows in the cabin are multiples of 
12″ (305 mm), you can insert a block made from a 12″ (305 mm) 
wide window for each window, and you can apply an X scale factor to 
the block to make it the right width. The first step is to draw a win-
dow 12″ (305 mm) wide inside the wall lines.

 5. Start the LINE command and then specify Nearest Osnap from either 
the Shift+right-click menu or by entering NEA↵.

The Nearest osnap will allow you to start a line on one of the wall 
lines. It snaps the cursor to any part of any object that is under the 
cursor and guarantees that the objects form an intersection but do 
not cross.

 6. Move the cursor to the upper wall line, a little to the left of the center 
of the screen, and with the hourglass-shaped marker displayed as 
shown in Figure 7.25, click.

F I G u R E   7 . 2 5 :   Starting the line by using the Nearest osnap

▶

Use the Nearest Osnap 
button when you want 
to locate a point some-
where on an object 
but aren’t concerned 
about exactly where on 
the object the point is 
located.
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A line begins on the upper wall line.

 7. Move the cursor to the lower wall line. The Perpendicular marker 
appears directly below the point you previously picked. When it’s dis-
played, click.

The line is drawn between the wall lines, as shown in Figure 7.26. 
Press ↵ to end the LINE command.

F I G u R E   7 . 2 6 :   Drawing the first window line

 8. Start the OFFSET command, and set the offset distance to 12 (305).

 9. Pick the line you just drew, and then pick a point to the right of 
that line.

The line is offset 12″ (305 mm) to the right. Press ↵ to end the 
OFFSET command.

 10. Start the LINE command again to draw a line between the midpoint 
of the line you first drew and the midpoint, or perpendicular to the 
line that was just offset.

After you press ↵ to end the LINE command, your drawing should 
look like Figure 7.27.

F I G u R E   7 . 2 7 :   Completed lines for the window block

 11. Save your drawing as I07-04-WindowBlock.dwg (M07-04-
WindowBlock.dwg) by choosing Application menu ➢ Save As ➢ 
Drawing.

The three lines you’ve drawn will make up a window block. They represent 
the two jamb lines and the glass (usually called glazing). By varying the X scale 
factor from 2 to 6, you can create windows 2′ (610 mm), 3′ (915 mm), 4′ (1220 
mm), 5′ (1525 mm), and 6′ (1830 mm) wide. This is a single-line representation, 
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with no double lines to indicate the frames, so for scaling the blocks, there is no 
thickness issue as there was with the doors.

Before you create the block, you need to decide the best place for the insertion 
point. For the doors, you chose the hinge point because you always know where 
it will be in the drawing. Locating a similar strategic point for the window is a 
little more difficult but certainly possible.

You know the insertion point shouldn’t be on the horizontal line represent-
ing the glazing, because the insertion point will always rest in the middle of the 
wall. There is no guideline in the drawing for the middle of the wall, so a cen-
tered insertion would require a temporary tracking point every time a window is 
inserted. Windows are usually dimensioned to the midpoint of the glazing line 
rather than to either jamb line, so you don’t want the insertion point to be at 
the endpoint of a jamb line. The insertion point needs to be positioned on a wall 
line but also lined up with the midpoint of the glazing line.

To locate this point, you’ll use an object snap called Mid Between 2 Points, or 
the M2P osnap, as it’s commonly called. As the name suggests, the M2P osnap 
snaps to a point midway between two other points you select. Follow these steps 
to set the base point for the window block along the outside wall line and mid-
way between the window’s edges:

 1. Make sure I07-04-WindowBlock.dwg (M07-04-WindowBlock.dwg)  
is open.

 2. Start the BLOCK command by clicking the Create Block button on the 
Home tab ➢ Block panel.

 3. In the Block Definition dialog box, enter A-GLAZ for the block name, 
and then click the Pick Point button.

 4. Back in the drawing, activate the Mid Between 2 Points option found 
on the Shift+right-click context menu. Alternatively, you can enter 
M2P↵ at the command line.

The Mid Between 2 Points object snap is rather unique in that it is 
generally used with other osnaps and is not found on the Object Snap 
toolbar. In this case, you want to find the midpoint between two 
endpoints.

 5. With the Endpoint osnap running, move the cursor to the lower 
end of the left window jamb (see Figure 7.28) and click when the 
Endpoint marker appears.

▶

As mentioned previ-
ously, in the archi-
tectural discipline, 
windows are often 
referred to as glazing. 
The US National CAD 
Standard also uses 
the term, making the 
NCS code for windows 
GLAZ.
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Choose these two points
for the M2P osnap.

F I G u R E   7 . 2 8 :   Selecting the two endpoints for the M2P osnap

 6. Click the lower end of the right jamb to define the insertion point 
midway between the two endpoints that you picked.

 7. In the Block Definition dialog box, click the Select Objects button.

 8. Back in the drawing, select the two jamb lines and the glazing line, 
and then press ↵.

 9. Back in the dialog box, make sure of the following:

▶▶ The Open In Block Editor check box at the bottom is 
unchecked.

▶▶ The Delete radio button is selected.

▶▶ Units are set to Inches (Millimeters).

 10. Click OK.
The A-GLAZ block has been defined, and the 12″ (305 mm) window 

has been erased.

 11. Use Zoom Previous to zoom out to a view of the whole floor plan.

 12. Save your drawing as I07-05-WindowDefinition.dwg (M07-05-
WindowDefinition.dwg).

This completes the definition of the block that will represent the windows. 
The next task is to insert the A-GLAZ block where the windows will be located 
and scale them properly.

Inserting the Window Block
Several factors come into play when you’re deciding where to locate windows in 
a floor plan:

▶▶ The structure of the building

▶▶ The appearance of windows from outside the building
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▶▶ The appearance of windows from inside a room

▶▶ The location of fixtures that might interfere with placement

▶▶ The sun angle and climate considerations

For this exercise, you’ll work on the windows for each room, starting with the 
kitchen. You’ll create a total of five windows: two 3′-0″ windows, one 4′-0″ win-
dow, one 5′-0″ window, and one 6′-0″ window (see Figure 7.29).

F I G u R E   7 . 2 9 :   The cabin’s window sizes and locations

Rotating a Block during Insertion
As you can see in Figure 7.29, the kitchen has windows on two walls: one 4′-0″ 
(1220 mm) window centered over the stove in the back wall and one 3′-0″ (915 mm) 
window centered over the sink in the top wall. You’ll make the 4′ (1220 mm) 
window first:

 1. Make sure I07-05-WindowDefinition.dwg (M07-05-WindowDefinition 
.dwg) is open.

 2. Thaw the A-FLOR-FIXT layer. You’ll need to see the sink and stove to 
place the windows properly.

 3. Zoom in to a view of the kitchen so that you can see both walls, as 
shown in Figure 7.30.
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F I G u R E   7 . 3 0 :   Zooming in to the kitchen

 4. Click the Polar Tracking button on the status bar to turn on Polar 
Tracking.

Polar Tracking, Object Snap, and Object Snap Tracking should now 
be in their On positions.

 5. Create a new layer by clicking the Layer Properties button and then 
clicking the New Layer button in the Layer Properties Manager dia-
log box.

The new Layer1 layer appears and is highlighted. Enter A-GLAZ↵ 
to rename the layer.

 6. Click the Color swatch in the A-GLAZ row to open the Select Color 
dialog box, with the white swatch highlighted and white listed in the 
Color text box.

 7. Enter 31↵ to change the color to a bright orange. The Select Color 
dialog box closes.

 8. With A-GLAZ still highlighted in the Layer Properties Manager, click 
the Set Current button, or double-click the name of the layer, to 
make the A-GLAZ layer current.

 9. Close or autohide the Layer Properties Manager.

 10. Open the Block Insertion gallery by choosing the Insert button on 
the Block panel of the Insert Ribbon tab.

 11. Choose the A-GLAZ block from the Block gallery.
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In your drawing, the 12″ (305 mm) window block is attached to the 
cursor at the insertion point (see Figure 7.31).

F I G u R E   7 . 3 1 :   The A-GLAZ block attached to the cursor

Note that it’s still in the same horizontal orientation that it was 
in when you defined the block. To fit it into the left wall, you’ll need 
to both rotate and scale the block up to 4′-0″ (1220 mm) before you 
insert it.

 12. Pick the Rotate option at the command line, and then specify a rota-
tion angle of 90 by entering 90↵.

The window block is now rotated to align with the western exterior 
wall of the cabin.

 13. Pick the X (Scale X) option at the command line, and then specify an 
X scale factor of 4↵.

The window block now measures 4′-0″ (1220 mm) long, and is 
ready to be placed along the western exterior wall of the cabin.

 14. Make sure the cursor is over the stove’s midpoint (the lower of the 
two, as shown at the left of Figure 7.32), and then click.
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F I G u R E   7 . 3 2 :   Placing the A-GLAZ block in line with the kitchen stove

The A-GLAZ block appears in the left wall. The INSERT block com-
mand ends.

 15. Save this drawing as I07-06-BlockRotate.dwg (M07-06-
BlockRotate.dwg).

using Snap tracking to Set the Insertion Point
The window over the sink is centered on the sink, but the sink line doesn’t over-
lap the wall as the stove line did. You’ll use the same snap tracking procedure 
that you used in Chapter 5, “Developing Drawing Strategies: Part 2,” to set the 
window block’s insertion point without the need to draw extraneous geometry. 
Refer to Figure 7.32, shown earlier, as you follow the procedure here:

 1. Make sure I07-06-BlockRotate.dwg (M07-06-BlockRotate.dwg)  
is open.

 2. Use the Pan and Zoom tools to get a better view of the top wall of the 
cabin.

You want to create one 3′-0″ (915 mm) window, centered over the 
sink. Be sure the Endpoint and Midpoint osnaps are running, and 
turn off the Perpendicular osnap.
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 3. Enter A-GLAZ at the command-line interface, and select Block: 
A-GLAZ from the AutoCorrect selection list shown in Figure 7.33.

F I G u R E   7 . 3 3 :   Inserting a block at the command line using an AutoCorrect 
selection list

 4. At the Specify insertion point: prompt, position the crosshair 
cursor over the intersection of the inside wall lines in the top-left 
corner of the cabin, as shown in Figure 7.34.

F I G u R E   7 . 3 4 :   Setting the first tracking point to locate the window block

 5. When the temporary track point appears inside the Endpoint marker, 
move the cursor, without clicking, over the Midpoint marker for the 
topmost line of the sink.

 6. When the temporary track point appears inside the Midpoint marker, 
move the cursor directly above that point to the intersection of the 
two track points. You have set, or acquired, two temporary tracking 
points without using the Temporary Tracking Point osnap.

t I P  When Object Snap Tracking is turned on and the plus sign (+) appears at the 
Object Snap marker, a tracking point has been acquired. It remains acquired until you 
place the cursor directly on the object snap symbol a second time or until that part of the 
command is done.
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When the crosshair reaches a point directly above the first track-
ing point, a vertical tracking line appears, and the tooltip identifies 
the intersection of the two tracking lines as Endpoint: <0.00º, 
Midpoint: <90.00º (see Figure 7.35).

F I G u R E   7 . 3 5 :   Setting the insertion point for the window block

 7. When you see this tooltip, click. This places the insertion point on 
the inside wall line, centered over the sink.

 8. At the X scale factor prompt, enter 3↵.

 9. Then, at the Y scale factor prompt, enter 1↵. Press ↵ again to accept 
the default rotation angle of 0.

The 3′-0″ (915 mm) window is inserted into the wall behind the 
sink. Your kitchen, with the second window block inserted, should 
look like Figure 7.36.

F I G u R E   7 . 3 6 :   The kitchen after inserting the second window block
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 10. Save this drawing as I07-07-OsnapTracking.dwg (M07-07-
OsnapTracking.dwg).

As you can see, by using the Object Snap Tracking tool, you can quickly and 
precisely locate an insertion point even when a snappable feature doesn’t exist.

t I P  When using Object Snap Tracking, you’ll inevitably acquire a tracking point 
that you don’t need or want. To remove it, place the crosshair cursor on it momentarily. 
The tracking point will disappear.

Changing a Block’s Scale Factor by using object 
Properties
You’ve inserted two different-sized window blocks at two different rotations. Just 
three remain to be inserted: one in the bathroom and two in the living room. 
You’ll copy the horizontal kitchen window into the living room and then use 
the Properties palette to change the block’s scale, resulting in a 6′-0″ (1830 mm) 
window.

 1. Make sure I07-07-OsnapTracking.dwg (M07-07-OsnapTracking.dwg) 
is open.

 2. Pan and zoom to get a good view of the kitchen and the top of the liv-
ing room.

Referring back to Figure 7.29, you see that the windows are 7′-6″ 
(2286 mm) apart. Because the insertion points are centered horizon-
tally in the blocks, the insertion points of the two windows are 12′-0″ 
(3659 mm) apart. You need to copy the 3′-0″ (915 mm) kitchen win-
dow 12′-0″ (3659 mm) to the right.

 3. Select the 3′-0″ (915 mm) kitchen window, and click the Copy tool 
from the Home tab ➢ Modify panel.

 4. At the Specify base point: prompt, click anywhere in the draw-
ing area.

Clicking near the block that you are moving will keep everything 
visually compact.

 5. Move the cursor directly to the right.

 6. At the Specify second point or <use first point as  
displacement>: prompt, enter 12′↵ (3659↵), as shown in  
Figure 7.37, and press ↵ again to terminate the COPY command.
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F I G u R E   7 . 3 7 :   Copying the kitchen window 12′ to the right

The window is copied 12′-0″ (3659 mm) to the right.

 7. Select the new window block, right-click, and then choose Properties 
from the context menu to open the Properties palette.

 8. In the Geometry rollout, locate the Scale X parameter and change its 
value to 6, as shown in Figure 7.38.

F I G u R E   7 . 3 8 :   Change the block’s X scale factor in the Properties palette.
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 9. The window in the living room is now 6′-0″ (1830 mm) wide. Close 
the Properties palette, and press Esc to deselect the new window.

 10. Save this drawing as I07-08-ObjectProperties.dwg (M07-08-
ObjectProperties.dwg).

As you’ve seen, you can change many parameters of an object, including the 
scale factors for a block definition, by using the Properties palette.

Finishing the Windows
The last two windows to insert are both in the bottom wall, one in the living 
room and one in the bathroom. You’ll use skills you’ve already developed to 
place them:

 1. Make sure I07-08-ObjectProperties.dwg (M07-08-ObjectProperties 
.dwg) is open.

 2. Use the Zoom and Pan tools to adjust your view of the drawing down 
to the bottom wall between the front wall and the hot tub.

This window is 5′-0″ (1525 mm) wide, and its insertion point is 7′-0″ 
(2134 mm) from the pop-out for the hot tub (4′-6″ × 2′-6″, or 1372 mm 
× 762 mm).

 3. Place the cursor over the intersection of the outside wall lines on the 
upper-right side of the pop-out, as shown in Figure 7.39.

F I G u R E   7 . 3 9 :   Selecting the first point to define the insertion point

 4. Pick the Insert button on the Block panel of the Insert Ribbon tab to 
open the Block gallery. Select the A-GLAZ block from the gallery.
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 5. Move the cursor directly to the right, and enter 7'↵ (2134↵).
The window is inserted 7′-0″ (2134 mm) to the right of the corner.

 6. Give the new block an X scale factor of 5, a Y scale factor of 1, and a 
rotation of 0″. The new window appears as shown in Figure 7.40.

F I G u R E   7 . 4 0 :   The new 5′-0″ (1525 mm) window in the living room

The final window to draw is the 3′-0″ (915 mm) window in the 
bathroom. The insertion point is located 4′-0″ (1220 mm) from the 
bottom-left outside corner of the cabin. To create this window, you’ll 
copy the living room window that you just drew and then change the 
X scale factor by using the Properties palette.

 7. Select the 5′-0″ (1525 mm) window in the living room, and start the 
COPY command.

 8. At the Specify base point: prompt, hold down the Shift key and 
press the right mouse button to open the Object Snap context menu.

 9. Activate the Insertion Point object snap by entering INS↵ at the com-
mand line, or press Ctrl+right-click to open the object snap menu. 

 10. Place the cursor over the window block until the Insert marker 
appears (see Figure 7.41). Then click to define the base point for the 
COPY command as the insertion point of the block.

F I G u R E   7 . 4 1 :   Snapping to the insertion point of the block
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 11. At the Specify second point or <use first point as displace-
ment>: prompt, pause the cursor over the bottom-left outside corner 
of the cabin to acquire a temporary track point.

 12. Move the cursor directly to the right, and enter 4′↵ (1220↵), as 
shown in Figure 7.42.

F I G u R E   7 . 4 2 :   Setting the COPY command’s second point 4′ (1220 mm) from 
the corner

The window is copied to its new location 4′-0″ (1220 mm) from the 
corner.

 13. Press ↵ again to end the COPY command.

 14. Select the new window and open the Properties palette.

 15. Change the Scale X parameter to 3.
The window resizes to 3′-0″ (915 mm) wide, as shown in Figure 7.43.

F I G u R E   7 . 4 3 :   The new 3′-0″ (915 mm) window in the bathroom
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 16. Close the Properties palette, and press Esc to end the COPY command.

t I P  In a cluttered area, you can enter NON↵ at any Select Point: or Select 
Objects: prompt to disable all running osnaps for the duration of a single pick.

 17. Perform a Zoom Extents either by using the Navigation bar or by 
double-clicking the middle button of your scroll wheel mouse.

Doing so changes the view to include all the visible lines, and the 
view fills the drawing area.

 18. Use the scroll wheel to zoom out a little from the Extents view so that 
all objects are set in slightly from the edge of the drawing area.

Your drawing, with all the windows in place, should look like 
Figure 7.44.

F I G u R E   7 . 4 4 :   The cabin drawing after inserting the windows and adjusting 
the zoom factor

 19. Save this drawing as I07-09-FinishingWindows.dwg (M07-09-
FinishingWindows.dwg).

You have inserted five windows into the floor plan, each generated from the 
A-GLAZ block. You created the A-GLAZ block on layer 0 and then made the 
A-GLAZ layer current, so each window block reference took on the characteris-
tics of the A-GLAZ layer when it was inserted.

You can disassociate the components of blocks by using the EXPLODE com-
mand. The tool is found in the Home tab ➢ Modify panel. Exploding a block has 
the effect of reducing the block to the objects that make it up. Exploding the 
A-GLAZ block reduces it to three lines, all on layer 0.

◀

You can also start 
the EXPLODE com-
mand by entering 
EXPLODE↵.
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t I P  All your windows are in walls 6″ (150 mm) thick, so the windows are all 6″  
(150 mm) deep. But what if you want to put a window block in a 4″  (100 mm) wall 
between two interior rooms? You can still use the A-GLAZ block. During insertion, you 
change the Y scale factor to 2⁄3 to reflect the change in thickness of the wall.

Typically, when you choose to explode a block, you want the linework to 
retain the layer displayed in your drawing. Users of AutoCAD (not Autodesk® 
AutoCAD LT®) have another command named BURST that does just that. 
You can find the BURST command and the Explode Attributes button on the 
Express Tools tab ➢ Blocks panel. Like the EXPLODE command, BURST reduces 
the A-GLAZ block into three lines, but they will retain the correct A-GLAZ 
layer.

Revising a Block
One of the biggest advantages to using blocks over manually drawing items 
such as doors and windows in your drawing is the ease with which blocks can be 
modified. Earlier, you used the Block Editor as you were defining blocks. In this 
section, you’ll use the Block Editor again, this time not to define a new block 
but to modify an existing one. More specifically, you’ll modify the A-GLAZ (win-
dow) block and see how the changes you make are reflected throughout your 
drawing.

Let’s say that the client who’s building the cabin finds out that double-glazing 
is required in all windows. You’ll want the windows to show two lines for the 
glass. If you revise the A-GLAZ block definition, the changes you make in one 
block reference will be made in all six windows. Do the following to edit the win-
dow (A-GLAZ) block:

 1. Make sure I07-09-FinishingWindows.dwg (M07-09-
FinishingWindows.dwg) is open.

n o t E  Using standard commands, you can move, rotate, copy, erase, scale, 
and explode blocks. All objects in a block are associated and behave as if they were one 
object.

 2. Select the A-GLAZ block inserted over the stove, right-click to display 
the context menu, and select Block Editor, as shown in Figure 7.45.
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F I G u R E   7 . 4 5 :   Accessing the Block Editor from the context menu

Alternatively, you can access the Block Editor from the Insert 
tab ➢ Block Definition panel ➢ Block Editor tool or by entering 
BEDIT↵ at the command line.

In the drawing area, the rest of the drawing disappears, the back-
ground turns gray, and the Block Editor tab and panels appear in the 
Ribbon. Only the A-GLAZ block and the Block Authoring palettes 
remain (see Figure 7.46). You are now in Block Editor mode.

F I G u R E   7 . 4 6 :   The result of the modifications to the A-GLAZ block
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 3. Use the OFFSET command to offset the glazing line 0.5″ (13 mm) up 
and down. Then erase the original horizontal line (see Figure 7.47).

F I G u R E   7 . 4 7 :   The drawing area and Ribbon in Block Editor mode

This window block now has double-glazing.

 4. On the Open/Save panel, click the Save Block button.

 5. In the Close panel, at the far-right end of the Ribbon, click the Close 
Block Editor button.

The Block Editor closes, and you are returned to the cabin 
drawing.

 6. Use the Zoom Previous tool to view the entire drawing. All windows 
in the cabin now have double-glazing.

 7. Zoom in to a closer look at the kitchen in order to view some of the 
modified window block references (see Figure 7.48).

F I G u R E   7 . 4 8 :   Zooming in to see the revised window blocks with double-
glazing

▶

If you click the Close 
Block Editor button 
without saving the 
changes to the block, 
an AutoCAD warning 
window appears, 
allowing you to save 
the changes or exit the 
Block Editor without 
saving the changes.
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 8. Use Zoom Previous to see a view of the entire floor plan.

 9. Save this drawing as I07A-FPLAYO.dwg (M07A-FPLAYO.dwg).

Sharing Information between Drawings
You can transfer most of the information in a drawing to another drawing. You 
can do so in several ways, depending on the kind of information that you need 
to transfer. You can drag and drop or copy and paste objects from one open 
drawing to another. You can copy layers, blocks, and other named objects from 
a closed drawing into an open one by using DesignCenter. I’ll demonstrate these 
methods—and touch on a few others—as I finish this chapter. Note that these 
features don’t contribute to our cabin project, so the drawing changes you make 
in the following sections are only temporary and won’t be saved.

Copying objects between Drawings
Similar to other Windows-based programs, AutoCAD provides a set of copy-and-
paste tools that may be used to exchange all or part of one drawing into another 
drawing. Here’s the general procedure:

 1. With I07A-FPLAYO.dwg (M07A-FPLAYO.dwg) as the current drawing, 
click the New button on the Quick Access toolbar.

 2. Using the Drawing Tab interface, select the I07A-FPLAYO.dwg (M07A-
FPLAYO.dwg) tab found just below the Ribbon interface. 

If the Drawing Tab interface isn’t currently visible, browse to the 
View tab ➢ Interface panel, and select File Tabs.

 3. Use the Layer drop-down list to make the A-WALL layer current, 
and then turn off the A-DECK-STRS, A-DOOR, A-FLOR-FIXT, and 
A-GLAZ layers.

The walls (A-WALL) and decks (A-DECK) should be the only lines 
visible.

 4. Use a selection window to select the cabin with its decks. Grips 
appear on all lines (see Figure 7.49).

◀

Named objects are, 
quite simply, AutoCAD 
objects with names, 
such as blocks and 
layers. Lines, circles, 
and arcs don’t have 
individual names, so 
they aren’t named 
objects.
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F I G u R E   7 . 4 9 :   A-WALL and A-DECK layers isolated and selected

 5. Click the Copy Clip command from the Home Ribbon tab ➢ 
Clipboard panel.

 6. Use the File Tab interface to switch to the drawing created in step 1 of 
this exercise.

 7. Expand the Paste button on the Home Ribbon tab ➢ Clipboard panel, 
and select Paste To Original Coordinates (see Figure 7.50).

F I G u R E   7 . 5 0 :   Selecting the Paste To Original Coordinates command from the 
Ribbon

 8. Perform a Zoom Extents, and then use the scroll wheel to zoom out a 
little. Your drawing should look like Figure 7.51.
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F I G u R E   7 . 5 1 :   The contents of the A-WALL and A-DECK layers copied into a 
new drawing

If you check the layers, you’ll see that the new drawing now has an A-FLOR-
FIXT layer, in addition to the A-WALL and A-DECK layers.

using the AutoCAD DesignCenter
DesignCenter is a tool for copying named objects (blocks, layers, text styles, 
and so on) to an opened drawing from an unopened one. You can’t copy lines, 
circles, and other unnamed objects unless they are part of a block. You’ll see 
how this works by bringing some layers and a block into your new drawing from 
I07A-FPLAYO.dwg (M07A-FPLAYO.dwg):

 1. Make I07A-FPLAYO.dwg (M07A-FPLAYO.dwg) current, and then close 
it. Don’t save changes.

 2. Maximize the window for your new drawing if it isn’t already 
maximized.

 3. Open DesignCenter from the Insert tab ➢ Content panel ➢ Design 
Center tool. Alternatively, you can open DesignCenter by pressing 
Ctrl+2 or entering DC↵ at the command line.

The DesignCenter palette appears on the drawing area (see 
Figure 7.52). Your screen might not look exactly like the example 
shown here. The tree diagram of file folders on the left might or might 
not be visible. Also, your DesignCenter might be wider or narrower.
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F I G u R E   7 . 5 2 :   DesignCenter

 4. Click the Tree View toggle button at the top of DesignCenter (the 
fourth button from the right) a few times to close and open the file 
folder tree diagram.

 5. Click the Load button in the upper-left corner of the DesignCenter 
palette to open the Load dialog box. Navigate to your Training Data 
folder and open it.

 6. Highlight I07A-FPLAYO.dwg (M07A-FPLAYO.dwg), and click Open. The 
Load dialog box closes, and you are returned to your drawing.

Now the left side of DesignCenter lists your drawings in the 
Training Data folder, and I07A-FPLAYO.dwg (M07A-FPLAYO.dwg) 
is highlighted; the right side shows the types of objects in I07A-
FPLAYO.dwg that are available to be copied into the current draw-
ing—in this case, Drawing1.dwg (see Figure 7.53).
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F I G u R E   7 . 5 3 :   DesignCenter displaying the files in the Training Data 
folder on the left, and accessible objects on the right and below I07A-FPLAYO.dwg 

 7. On the left side once again, click the plus symbol (+) to the left of 
I07A-FPLAYO.dwg (M07A-FPLAYO.dwg).

The list of named objects in the right panel now appears below 
I07A-FPLAYO.dwg (M07A-FPLAYO.dwg) in the tree view on the left.

 8. Click the Layers icon on the left side. The list of layers in I07A-
FPLAYO.dwg (M07A-FPLAYO.dwg) appears in the panel on the right (see 
Figure 7.54).

 9. Use the Shift and Ctrl keys to help you select all the layers except 0, 
A-DECK, A-FLOR-FIXT, and A-WALL (see Figure 7.54).

www.MouradEngineering.com



3 7 4 	 C h a p t e r 	 7 	 • 	 C omb i n i n g 	O b j e c t s 	 i n t o 	 B l o c k s

F I G u R E   7 . 5 4 :   DesignCenter with the layers to grab highlighted

 10. Right-click one of the highlighted layers in the right window, and 
choose Add Layer(s) from the context menu that opens.

 11. Open the Layer drop-down list on the Layers panel. It now displays 
all the layers of the I07A-FPLAYO.dwg (M07A-FPLAYO.dwg) drawing, 
including those you just transferred to the Drawing#.dwg drawing.

Now let’s see how this process works when you want to get a block from 
another drawing:

 1. On the left side of DesignCenter, click Blocks in the list under the 
I07A-FPLAYO.dwg (M07A-FPLAYO.dwg) drawing.

On the right side, the list of blocks in that drawing appears (see the 
top of Figure 7.55).

▶

If you prefer dragging 
and dropping, click and 
hold the left mouse 
button, drag the cursor 
onto the drawing, and 
then release the mouse 
button.
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F I G u R E   7 . 5 5 :   DesignCenter displaying blocks from the I07A-FPLAYO 
.dwg (M07A-FPLAYO.dwg), and A-DOOR-36IN (A-DOOR-0915) block selected

 2. Click A-DOOR-36IN (A-DOOR-0915) in the right panel, and then, if 
necessary, click the Preview button at the top of DesignCenter.

A picture of the block appears in the lower-right corner of 
DesignCenter (see Figure 7.55). You can resize the preview pane 
vertically.

 3. Open the layer list, and make A-DOOR the current layer.

 4. Zoom in to the back door area of the drawing (see Figure 7.56), and 
verify that the Endpoint osnap is running.
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F I G u R E   7 . 5 6 :   Zoomed in to the back door area, dragging the A-DOOR-36IN 
block into Drawing# from DesignCenter

 5. In DesignCenter, click and drag A-DOOR-36IN from the list to the 
drawing and continue to hold the left mouse button down after the 
block appears at the cursor.

As the cursor comes onto the drawing, the A-DOOR-36IN block 
appears. Use the Endpoint osnap to locate the block at the opening, 
as you did earlier in this chapter (see Figure 7.56).

 6. Click the Close icon in the upper-right corner of DesignCenter to 
close it.

 7. Keep your new drawing open in case you want to use it in the first 
few practice exercises at the end of this chapter. Otherwise, close it 
without saving it.

By doing this insertion, you’ve made the A-DOOR-36IN (A-DOOR-0915) block 
a part of your new drawing, and you can reinsert it in that drawing without 
DesignCenter.

At the top of the DesignCenter window, the buttons on the left are tools for nav-
igating through drives and folders to find the files you need to access; the buttons 
on the right give you options for viewing the named objects in the window.

▶

You can also right-click 
and drag a block from 
DesignCenter into the 
current drawing. If you 
do this, a context menu 
appears; click Insert 
Block. This opens the 
Insert dialog box, and 
you can complete the 
insertion procedure.
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DesignCenter options

Here’s a brief description of the functions of the DesignCenter buttons, from 
left to right:

Load  Opens the Load dialog box, which you use to navigate to the drive, folder, 
or file from which you want to borrow named AutoCAD objects.

Back  Moves you one step back in your navigation procedure.

Forward  Moves you one step forward in your navigation procedure.

up  Moves up one level in the folder/file/named objects tree.

Search  Opens a Search dialog box in which you can search for a file.

Favorites  Displays a list of files and folders that you have previously set up.

Home  Navigates to the DesignCenter folder in the AutoCAD program. This 
folder has subfolders of sample files that contain libraries of blocks and other 
named objects to import through DesignCenter. You can designate a different 
Home folder by selecting the folder, right-clicking, and then choosing Set As Home 
from the context menu.

tree View toggle  Opens or shuts the left panel that displays the logical tree 
of folders, files, and unnamed objects.

Preview  Opens or shuts a preview window at the bottom of the right palette 
window. When you highlight a drawing or block in the palette window, a preview 
appears. You can resize the preview pane.

Description  Displays or hides a previously written description of a block or 
drawing. You can resize the Description pane.

Views  Controls how the items in the palette window are displayed. There are 
four choices: Large Icons, Small Icons, List, and Details.

using other Ways to Share Information between 
Drawings
You can transfer information between drawings in several other ways. This sec-
tion looks at three of them:

▶▶ Use the WBLOCK command to take a portion of a drawing and create a 
new drawing file from the selected objects.

▶▶ Insert any DWG drawing file into any other drawing file.

▶▶ Create palettes of blocks that can be accessed for any drawing.
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using the WBLOCK  Command

To perform a Write Block, or WBLOCK, operation, you create a new file by telling 
AutoCAD which elements of the current drawing you want in the new file. Let’s say 
you want to create a new DWG file for the bathroom of the cabin. Here are the steps:

 1. Open I07A-FPLAYO.dwg (M07A-FPLAYO.dwg), and then pan and zoom 
to see the bathroom.

 2. Click the Create Block ➢ Write Block tool on the Insert tab ➢ Block 
Definition panel to start the WBLOCK command, as shown in Figure 7.57.

F I G u R E   7 . 5 7 :   Starting the Write Block (WBLOCK) command from the Ribbon

 3. At the top of the dialog box, in the Source group, click the Objects 
radio button (see Figure 7.58).

F I G u R E   7 . 5 8 :   The Write Block dialog box
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In the middle portion, the Base Point and Objects groups are simi-
lar to those for creating a block.

As mentioned earlier, most project teams will establish a common 
location for their project. Assuming each of the drawings in your 
project are located in the same place, you can use 0,0,0 as the base 
point for the blocks you create with the WBLOCK command. You can 
accept the default Base Point of 0,0,0 to retain this common point in 
your cabin project.

 4. In the Objects group, click the Select Objects button.

 5. Use a window as well as individual picks to select everything you want 
to include, and press ↵.

 6. Click the Retain radio button in this group, if necessary, so that the 
selected objects aren’t deleted from the current drawing.

 7. In the Destination area, enter a filename—say, I07-11-Bath.dwg 
(M07-11-Bath.dwg)—for the new drawing, and choose a folder in 
which to save it.

 8. In the Insert Units drop-down list, select Inches or Millimeters, in 
case the new drawing is used in a drawing that has units other than 
Architectural or Decimal.

 9. Click OK. A preview window briefly appears, the command ends, and 
the selected material is now a new drawing file located in the folder 
that you specified.

 10. Close the I07A-FPLAYO.dwg (M07A-FPLAYO.dwg) drawing without sav-
ing any changes.

You can use the WBLOCK command in three ways, which are available via radio 
buttons at the top of the Write Block dialog box in the Source group. Here’s a 
brief description of each:

Block  To make a drawing file out of a block that’s defined in the current 
drawing, select the name of the block from the drop-down list at the top and 
then follow steps 4 through 9 in the preceding exercise. When you follow this 
procedure, the objects in the new drawing are no longer a block. Write blocking 
(WBLOCK) a block has the effect of exploding it.

Entire Drawing  Click this button to purge a drawing of unwanted objects 
such as layers that have no objects on them and block definitions that have no 
references in the drawing. You aren’t prompted to select anything except the 

◀

If you select with a 
crossing window here, 
you’ll get more than 
you need, but you can 
clean up the new draw-
ing later.
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information called for in steps 4 through 9 of the preceding exercise. You can 
keep the same drawing name or enter a new one. A preferable way to accomplish 
the same task is to use the PURGE command as follows:

 1. Open the Application menu.

 2. Click Drawing Utilities ➢ Purge or enter PURGE↵ to open the 
Purge dialog box.

 3. Select which features you want to purge.

objects  You select which objects to use to create a new file, as in steps 1 
through 9 of the preceding exercise.

Inserting one Drawing into Another

When you insert a drawing into another drawing, it comes in as a block. You use 
the same Insert tool that you use to insert blocks, but in a slightly different way. 
For example, in the previous section, you created a WBLOCK, a portion of I07A-
FPLAYO.dwg (M07A-FPLAYO.dwg), and made a new file called I07-11-Bath.dwg. 
Now suppose you want to insert I07-11-Bath.dwg into a new drawing. Take the 
following steps:

 1. Start a new drawing, Drawing#.dwg, and set it as current.

 2. Start the INSERT command. To start the INSERT command from the 
Ribbon, you choose the Insert Ribbon tab ➢ Block panel ➢ Insert 
button, and then select More Options.

 3. In the Insert dialog box, click the Browse button and then navigate to 
the folder containing I07-11-Bath.dwg (M07-11-Bath.dwg).

 4. Open that folder, highlight I07-11-Bath.dwg, and then click Open to 
return to the Insert dialog box.

The drawing file that you selected is now displayed in the Name 
drop-down list. At this point, a copy of I07-11-Bath.dwg has been 
converted to a block definition in Drawing#.dwg.

 5. Set the insertion parameters and then click OK.
You can uncheck Specify On-Screen and accept the defaults for 

each parameter.

 6. Finish the insertion procedure as if you were inserting a block.
The contents of I07-11-Bath.dwg are displayed in your new draw-

ing at the same location they were found in I07A-FPLAYO.dwg (M07A-
FPLAYO.dwg).
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You transfer blocks between drawings by dragging and dropping or by using 
DesignCenter. You can also convert them into DWG files by using the WBLOCK 
command, and you can insert them back into other DWG files as blocks by 
using the INSERT command. These blocks become disassociated when they leave 
the drawing and can be inserted as a block when they enter another drawing.

Exploring AutoCAD Palettes

AutoCAD provides a tool called palettes to make blocks and other features or 
tools easily accessible for any drawing. You’ll now take a brief look at the sample 
palettes that come with AutoCAD, and you’ll see how to manage them on the 
screen. Follow these steps:

 1. Open I07A-FPLAYO.dwg (M07A-FPLAYO.dwg) and zoom to the draw-
ing’s extents.

 2. Use the scroll wheel to zoom out a little.

 3. If palettes aren’t already visible in the drawing area, click the Tool 
Palettes button, found on the View tab ➢ Palettes panel (see Figure 7.59).

F I G u R E   7 . 5 9 :   The tool palettes displayed on the screen

 4. Click the Architectural tab to display its content on the palette. Its 
tab might be abbreviated to read Archit, but pausing the cursor over 
the tab displays a tooltip showing the entire tab name.

Notice the scroll bar next to the title bar (see Figure 7.60). This 
appears when there is more content than the palette can show. 
Blocks that are shown with a lightning bolt symbol as part of the 
icon are dynamic blocks.
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F I G u R E   7 . 6 0 :   The tool palettes with the Architectural tab active

 5. Move the cursor to the title bar.

 6. Right-click and choose Transparency from the context menu to open 
the Transparency dialog box (see Figure 7.61).

F I G u R E   7 . 6 1 :   The Transparency dialog box
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Here you can toggle transparency on and off and adjust the degree 
of transparency for the tool palettes and many other palettes in the 
software.

A Few Words about tool Palettes

You can also open the tool palettes from the menu bar by clicking Tools ➢ 
Palettes ➢ Tool Palettes or by using the Ctrl+3 shortcut keys. Like the DesignCenter 
palette, tool palettes can be floating or docked on either side of the drawing area, 
and the Navigation bar can be on the left or right side.

Your palettes might appear different from those shown in a couple of ways. The 
ones shown in this section are positioned on the right side but aren’t docked 
there. Yours might be transparent, showing your drawing beneath them, or your 
palettes might be hidden and show only the title bar. In Figure 7.59, several tabs 
are on the right side of the palette area, indicating the available palettes. On its 
left side is the palette title bar with control icons at the top and bottom.

On each palette is its content. The Hatches sample palette has hatch patterns 
and fills (discussed in Chapter 11, “Working with Hatches, Gradients, and Tool 
Palettes”), and the Draw and Modify palettes contain commands from the Draw 
and Modify toolbars, respectively.

W A R n I n G  AutoCAD might display a notification dialog box, rather than 
the Transparency dialog box, if your video driver and operating system combination is 
unable to display palette transparency.

 7. Configure the Transparency dialog box as follows:

 a. Ensure that the Disable All Window Transparency (Global) 
check box is not selected.

 b. In the General group, move the Opacity slider to its mid-position 
or a bit on the Solid side.

 c. Set the Rollover to 100% Opacity so that the palette is solid 
whenever the cursor is over it.

 d. Click OK.

Now the drawing is visible through the palettes (see Figure 7.62).
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F I G u R E   7 . 6 2 :   The palettes in Transparent mode

 8. Right-click the palettes’ title bar and choose Auto-Hide from the con-
text menu.

 9. When the menu closes, move the cursor off the palettes.
The palettes disappear except for the title bar (see Figure 7.63). 

When you move the cursor back onto the title bar, the palettes reap-
pear—a handy feature.

 10. Close I07A-FPLAYO.dwg (M07A-FPLAYO.dwg) without saving any changes.

With both Transparency and Auto-Hide active, the palettes are less intrusive 
and take up less screen area, but they remain easily accessible. In Chapter 11, 
you’ll learn more about the Tool Palette feature, palette properties, and how to 
set up new palettes and change existing ones.

▶

When they are in 
floating mode, the 
Properties palette and 
DesignCenter also have 
the Auto-Hide option.
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F I G u R E   7 . 6 3 :   The palettes title bar with Auto-Hide on

If You Would Like More Practice…
This chapter has outlined the procedures for setting up and using blocks, the 
WBLOCK command, and the AutoCAD DesignCenter. Blocks follow a set of com-
plex rules, some of which are beyond the scope of this book.

Here are some suggestions that will give you some practice in working with 
blocks, drag-and-drop procedures, and DesignCenter:

▶▶ Make blocks out of any of the fixtures in the bathroom or kitchen. 
Try to decide on the best location to use for the insertion point 
of each fixture. Then insert them back into the I07A-FPLAYO.dwg 
(M07A-FPLAYO.dwg) drawing in their original locations. Create them 
on layer 0, and then insert them on the A-FLOR-FIXT layer. Here’s a 
list of the fixtures:

▶▶ Shower

▶▶ Bathroom sink and counter

▶▶ Toilet
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▶▶ Stove

▶▶ Kitchen sink

▶▶ Refrigerator

▶▶ Hot tub

▶▶ At the end of Chapter 5, I suggested creating pieces of furniture for 
the kitchen, living room, and bedroom of the cabin. If you did that, 
it will be good practice to make blocks out of those pieces and insert 
them into the cabin floor plan. If you didn’t do that exercise, you can 
do so now and then convert the pieces of furniture into blocks.

▶▶ Drag some of the blocks from the Civil, Structural, Electrical, 
Mechanical, Architectural, and Annotation sample palettes into the 
I07A-FPLAYO.dwg (M07A-FPLAYO.dwg) drawing, and experiment with 
them to see how they work. Figure 7.64 shows the cabin with a few 
trees and a car added from the Architectural palette. Some of the 
blocks on the default tool palettes are a special type of block called 
dynamic blocks. You’ll learn about dynamic blocks in Chapter 9, 
“Using Dynamic Blocks and Tables.”

F I G u R E   7 . 6 4 :   Trees and a car added from the Architectural palette
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▶▶ If you work in a profession or trade not directly concerned with 
architecture or construction, develop a few blocks that you can use 
in your own work. For example:

▶▶ Electrical diagrams consist of many simple symbols, each of 
which can be a block.

▶▶ Cams and gears—or gear teeth—and other engine parts that 
have been made into blocks can be assembled into a mechani-
cal drawing.

▶▶ Plumbing diagrams, like electrical ones, use a variety of sym-
bols repetitively—valves, meters, pumps, and joints. You can 
easily make them into blocks and then reassemble them into 
the diagram.

In each of these examples, choosing the most useful location for the insertion 
point will determine whether the block that you create will be a handy tool or a 
big frustration.

Are You Experienced?

now you can…

✔✔ create	blocks	out	of	existing	objects	in	your	drawing

✔✔ insert	blocks	into	your	drawing

✔✔ vary	the	size	and	rotation	of	blocks	as	they	are	inserted

✔✔ detect	blocks	in	a	drawing

✔✔ use point filters to locate an insertion point

✔✔ revise	a	block

✔✔ copy	and	paste	objects	from	one	drawing	to	another

✔✔ use the AutoCAD DesignCenter

✔✔ use the WBLOCK command

✔✔ open palettes and control their appearance
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CHAPtER 8

Controlling text in a 
Drawing
You have many uses for text in your drawings, including titles of views, 
notes, and dimensions. It’s not uncommon for the majority of a page to 
be covered with text outlining pertinent information such as titles, design 
requirements, and other project details. Each of these might require a differ-
ent height, orientation, justification, and style of lettering. To control text, 
you’ll need to learn how to do the following:

▶▶ Set up text styles to determine how the text will look.

▶▶ Specify where the text will be, and enter it in the drawing.

▶▶ Modify the text already in your drawing.

Autodesk® AutoCAD® software offers several annotation tools you’ll learn 
to combine in this chapter to help tell the story of your design. For example, 
you may choose to apply single-line text for titles, whereas multiline text is 
likely to be better suited for the large blocks of text typical of longer notes.

You’ll progress through this chapter by first looking at the process of set-
ting up text styles. You’ll then start placing and modifying single-line text 
in the cabin drawing. Finally, you’ll learn the methods for creating and con-
trolling multiline text as it’s used for notes and tables. If you work in a non-
AEC (architecture, engineering, and construction) profession or trade, be 
assured that the features presented in this chapter will apply directly to your 
work. The basic principles of working with text in AutoCAD and Autodesk® 
AutoCAD LT® programs apply universally.

In this chapter, you will learn to

▶▶ Set	up	text	styles

▶▶ Place new text, and modify existing text in a drawing

▶▶ Work	with	gridlines,	add	hyperlinks,	and	use	the	spell-check	feature
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Setting up text Styles
In AutoCAD, a text style consists of a combination of a style name, a text font, 
a height, a width factor, an oblique angle, and a few other mostly static set-
tings. You specify these text style properties with the help of a dialog box that 
opens when you start the STYLE command. In this section, you’ll set up two text 
styles—one for labeling the rooms in the floor plan and the other for putting 
titles on the two views. But first, you need to create a layer for the text as follows:

 1. Open the I07A-FPLAYO.dwg (M07A-FPLAYO.dwg) drawing.

 2. Zoom out so that you can see the entire drawing.

 3. Create a new layer named A-ANNO-TEXT. Assign it the color Yellow 
(2) and make it current.

 4. Thaw all the other layers.

 5. Click the Annotate tab to display the panels relevant to text and 
dimensioning, and save the file as I08-01-TextLayer.dwg (M08-01-
TextLayer.dwg).

Your drawing should look like Figure 8.1.

F I G u R E   8 . 1 :   The I08-01-TextLayer.dwg (M08-01-TextLayer.dwg) 
drawing with all layers displayed
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Determining the text and Drawing Scales
When you set up text styles for a drawing, you have to determine the height of 
the text letters. To make this determination, you first need to decide the scale at 
which the final drawing will be printed.

In traditional drafting, you can ignore the drawing scale and set the actual 
height of each kind of text. This is possible because, although the drawing is to a 
scale, the text doesn’t have to conform to that scale and is drawn full size.

In AutoCAD, a feature called layouts makes it possible to set the height of text 
in the same way—that is, at the height at which it will be printed. You’ll learn 
about using layouts in Chapter 14, “Using Layouts to Set Up a Print.” In that 
chapter, you’ll place text on layouts. In this chapter, I’ll demonstrate how you 
use text without layouts. You’ll place text in the cabin drawing. The drawing is 
actual size, but the text has to be much larger than actual size because both 
the drawing and its text will be scaled down by the same factor in the process of 
printing the drawing.

In this drawing, you’ll use a final scale of 1 ⁄4″ = 1′-0″ (1:50). This scale has a 
true ratio of 1:48 (1:50) and a scale factor of 48 (50). Table 8.1 lists the AutoCAD 
standard scales and corresponding ratios. If you want text to be 1⁄8″ (3.5 mm) 
high when you print the drawing at 1 ⁄4″ (1:50) scale, multiply 1 ⁄8″ (3.5 mm)  
by the scale factor of 48 (50) to get 6″ (175 mm) for the text height. You calcu-
late the imperial scale factor by inverting the scale fraction (1⁄4 = 4/1) and mul-
tiplying it by 12. You can check that calculated text height by studying the floor 
plan for a moment and noting the sizes of the building components represented 
in the drawing. The stair tread depth is 10″, and the text will be slightly smaller.

t A B L E   8 . 1 :   Standard scales and their corresponding ratios

true scale Scale factor

1″ = 1′-0″ 12

1⁄ 2″ = 1′-0″ 24

1⁄4″ = 1′-0″ 48

3⁄16″ = 1′-0″ 64

1⁄8″ = 1′-0″ 96

1⁄16″ = 1′-0″ 192

◀

A layout is a drawing 
environment that has 
been overlaid on the 
drawing of your proj-
ect. The layout and the 
drawing are part of the 
same file.
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Similarly, when using decimal units, the scale factor is derived by dividing the 
second number in the ratio by the first—for example, 1:50 has a scale factor of 
50, and 1:60 has a scale factor of 60.

Defining a text Style for View titles
Now that you have a good idea of the required text height, it’s time to define a 
new text style. Each new AutoCAD DWG™ file comes with two predefined text 
styles: Standard and Annotative. They reflect the two types of text styles that 
you can create inside AutoCAD. You’ll learn more about Annotative text styles in 
the next exercise. For now, we’ll focus only on Standard text styles, or static text 
styles as they’re sometimes called.

To create Standard text styles, you must calculate the correct Model Space 
Text Height setting so that your text will plot at the correct height when your 
drawing is plotted at scale. For this exercise, you’ll create a text style for text 
that will be plotted at a scale of 1 ⁄4″ = 1′. To get started with your first text style, 
follow these steps:

 1. Make sure I08-01-TextLayer.dwg (M08-01-TextLayer.dwg) is open.

 2. On the Home tab ➢ expanded Annotation panel, click the Text Style 
button (see Figure 8.2), or enter ST↵ to start the STYLE command.

F I G u R E   8 . 2 :   Starting the STYLE command

After you start the STYLE command, the Text Style dialog box 
shown in Figure 8.3 opens.
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F I G u R E   8 . 3 :   The Text Style dialog box, where you’ll begin setting up text 
styles

In the Styles list box of the Text Style dialog box, you’ll see the 
default Standard text style as well as the Annotative text style.

 3. With the Standard text style highlighted, click New to open the New 
Text Style dialog box.

You’ll see a highlighted Style Name text box set to style1. When you 
enter a new style name, it will replace style1.

 4. Enter A-Title↵ in the Style Name text box, as shown in Figure 8.4.

F I G u R E   8 . 4 :   Setting the name for the new text style

The New Text Style dialog box closes and, in the Text Style dialog 
box, A-Title appears highlighted in the Styles list.

◀

By default, all new 
DWG files have the 
Standard text style as 
the current text style.
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You’ve created a new text style named A-Title. It has settings identi-
cal to those of the Standard text style, and it’s now the current text 
style. Next, you’ll change some of the settings for this new style.

 5. Move down to the Font group, and click the Font Name drop-down 
list to open it.

A list of fonts appears; the number of choices depends on what 
software is installed on your computer. AutoCAD can use both its 
native SHX (compiled shape) font files and Windows TTF (TrueType 
font) files.

 6. Scroll through the list until you find Arial, and then click it.
Notice the TT icon to the left of the font name. This icon tells you 

that Arial font is a TrueType (.ttf) font.
The list closes and, in the Font Name text box, the Arial font 

replaces the txt.shx font that was previously there. In the Preview 
area in the lower-left corner, a sample of the Arial font replaces that 
of the txt.shx font.

 7. Because view labels are generally emphasized, change the Font Style 
from Regular to Bold.

The preview in the lower-left corner updates to reflect the Font 
Style change.

 8. Press the Tab key a few times to move to the next text box. The 
Height setting is highlighted at the default of 0′-0″ (0).

 9. Enter 12 (350), and then press Tab again. A height of 1′-0″ replaces 
the initial imperial measurement of 12″.

Because the A-Title text style will be used for headings and titles, it 
will use a plotted height of 1 ⁄4″ (7 mm). Once again, the model space 
height for this text was derived by multiplying the plotted height of 
1 ⁄4″ (7 mm) by the drawing scale factor 48 (50). Your Text Style dia-
log box should look like Figure 8.5.

▶

A font is a collection 
of text characters and 
symbols that all share 
a characteristic style of 
design and proportion.
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F I G u R E   8 . 5 :   The Text Style dialog box after setting up the Title style

You won’t need to change any of the other parameters that define 
the new text style. They can all stay at their default settings.

 10. Click the Apply button at the bottom of the dialog box.
The A-Title text style is saved with the current drawing and 

becomes the current text style. The current text style appears in the 
Text Style drop-down list in the Text panel, as shown in Figure 8.6.

F I G u R E   8 . 6 :   The Text Style drop-down list after setting A-Title as the current 
style
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 11. Click Close to exit the Text Style dialog box.

 12. Save your drawing as I08-02-TitleStyle.dwg (M08-02-TitleStyle 
.dwg).

When you define a new text style, you first name the new style. This has the 
effect of making a copy of the current text style settings, giving them the new 
name, and making the new text style current. You then change the settings for 
this new style and save the changes by clicking Apply.

Of the many fonts available in AutoCAD, you’ll use only a few for your draw-
ings. Some are set up for foreign languages or mapping symbols. Others would 
appear out of place on architectural or technical drawings but might be just 
right for an advertising brochure or a flyer. Later in this chapter, you’ll have a 
chance to experiment with the available fonts.

SHX and ttF Fonts

AutoCAD text styles can use either the AutoCAD SHX (compiled shape) font files 
or the Windows TTF (TrueType font) files on your system. The SHX fonts are older 
files that were originally designed for use with pen plotters, which required the 
pen tip to follow a precise vector. When you zoom in to an AutoCAD SHX font or 
print it large on a drawing, the straight line segments that compose it become 
apparent. Two more fonts in the Roman font family—romant (triplex) and romanc 
(complex)—have multiple, closely set lines and allow for larger text to be created 
while minimizing this straight-line effect.

TrueType fonts are mathematical representations of vector formats and are 
common in most Windows applications. Many fonts are available, and you can 
use them with no loss of crispness, regardless of the size of the font or the zoom 
factor in the drawing.

Until recently, the use of TTF fonts over the AutoCAD-specific SHX fonts would 
dramatically affect system performance. With performance as the paramount 
concern, SHX fonts became the de facto standard. Recent advancements have 
made the performance differences between the two negligible. In fact, the 
default acad.dwt drawing template from Autodesk has used the TTF font Arial 
over the former SHX font for the last several releases of AutoCAD. The use of TTF 
fonts is also preferred over SHX fonts for the purposes of electronic archiving; 
SHX fonts cannot be searched or indexed by Windows. To follow this trend and 
ensure compatibility, this book also utilizes the TTF Arial font over the older SHX 
fonts for annotating your cabin.

▶

The current text style 
is similar to the current 
layer. All text created 
while a text style is 
current will follow the 
parameters or settings 
of that text style.
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Refer to Figure 8.3 for a moment, and note that the Standard text style has 
a height of 0′-0″ (0). When the current text style has a height set to 0, you’re 
prompted to enter a height each time you begin to place single-line text in the 
drawing. The default height for the A-Title text style will scale to 1⁄4″ (or 0.25 for 
decimal units and 7 for metric) when plotted. Multiline text will use the default 
height of 1 ⁄4″ (7 mm) unless you change it.

Placing titles of Views in the Drawing
After creating a text style, you’re ready to begin adding text to your drawing. 
Before you can do that, you must first choose which type of text you would like 
to use: single-line or multiline text. Single-line text is limited to one line, and 
multiline text can support multiple lines of text for things like paragraphs.

Because the view title needs only a single line of text, you’ll use the Single 
Line Text tool in this exercise. However, you will get a chance to use multiline 
text in a subsequent exercise so that you can see the differences for yourself.

 1. Make sure I08-02-TitleStyle.dwg (M08-02-TitleStyle.dwg) is open.

 2. Use the Zoom and Pan tools to make your view similar to the one 
shown in Figure 8.7.

F I G u R E   8 . 7 :   Preparing to create title text by setting your view

 3. Set up your osnaps and status bar options so that Polar Tracking and 
Object Snap are on and the Endpoint and Midpoint osnaps are running.

 4. Drop a line from the midpoint of the ridgeline in the floor plan 
straight down to a point near the bottom of the screen.
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 5. Offset the horizontal, outside wall line to the right of the pop-out in 
the floor plan down 6′ (1830 mm), as shown in Figure 8.8.

Draw this line.

O�set this line downward 6’-0” (1830 mm).

F I G u R E   8 . 8 :   The new lines created after offsetting the ridgeline and the  
pop-out

 6. Verify that the Text Style drop-down menu found on the Annotate 
tab ➢ Text panel matches Figure 8.9 and has the A-Title text style set 
as current.

F I G u R E   8 . 9 :   Verifying the current text style (A-Title) and starting the Single 
Line Text (TEXT) command

The current text style, A-Title in this example, determines the text 
style used by any new text objects you create.
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 7. Click the down arrow below the Multiline Text button in the Text 
panel, and click the Single Line Text button in the flyout menu, 
or enter DT↵ to start the TEXT command—the command used for 
single-line text.

The command line reports information about the current text 
style: Current text style: "A-Title" Text height: 1'-0" (350) 
Annotative: No. The window then prompts you: Specify start 
point of text or [Justify/Style]:.

You will use the Justify option to change the justification to Middle.

 8. Choose the Justify option by picking it on the command line or by 
pressing the down arrow on the keyboard until Justify is selected at 
the cursor prompt and then press ↵.

All the possible justification points appear in the prompt, as shown 
in Figure 8.10.

F I G u R E   8 . 1 0 :   The single-line text justification options

 9. Enter C↵ to choose Center as the justification.

 10. Use the Shift+right-click menu to choose the Intersection osnap, and 
pick the intersection of the guideline and the offset line.

◀

The justification point 
for the text functions 
like the insertion point 
for blocks.
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 11. At the Specify rotation angle of text: prompt, press ↵ to accept 
the default angle of 0 ,̊ or enter 0↵ if 0˚ is not the default.

A flashing I-shaped cursor superimposed over a narrow box 
appears at the intersection (see Figure 8.11). 

F I G u R E   8 . 1 1 :   The text cursor sits on the guidelines.

 12. With Caps Lock on, enter FLOOR PLAN↵.
The text is centered at the intersection as you enter it, and the cur-

sor moves down to allow you to enter another line (see the left image 
in Figure 8.12).

F I G u R E   8 . 1 2 :   The first line of text is entered (left) and placed (right).

 13. Press ↵ again to end the TEXT command.
The text is centered relative to the vertical guideline and sits on the 

offset line (see the right image of Figure 8.12).

 14. Erase the offset line and the vertical guideline. Your drawing will look 
like Figure 8.13.
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F I G u R E   8 . 1 3 :   The drawing with the title complete

 15. Save your drawing as I08-03-ViewTitle.dwg (M08-03-ViewTitle.dwg).

You specified a location for the text in two steps: first, you set the justifica-
tion point of each line of text to be centered horizontally; second, you used the 
Intersection osnap to position the justification point at the intersection of the 
two guidelines. I’ll discuss justification in more depth a little later in this chapter.

Next you’ll use a similar procedure to begin adding room labels to the interior 
of your cabin. 

using Annotative text
You just finished using the Single Line Text tool in conjunction with the 
Standard text style A-Title to label your floor plan. Before you could create the 
A-Title text style, you had to use Table 8.1 to manually calculate the correct 
model space text height. Standard text styles, which require you to manually 
calculate the Height parameter, work great if you need to display your drawing 
at only a single scale.

Most plan sets include a combination of overall plan sheets, layout plan 
sheets, enlarged view sheets, and so on, so you’ll probably need to establish a 
way to address annotation for each scale. Users who annotate their drawings 
in model space have traditionally solved this dilemma by creating separate text 
layers for each scale. Although this method works, it increases the possibility of 
errors because you’re copying text and must remember to update each copy as 
revisions happen.
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Another way to approach the dilemma of multiple scales is to use annotative 
text. Rather than a manual calculation, annotative text automatically calculates 
the correct model space height based on the plotted text height you specify.

Likewise, because annotative text objects can have multiple annotation scales 
assigned to them, annotative text also helps solve the dilemma of managing 
annotation at multiple scales. Assigning multiple annotation scales to a single 
piece of text allows you to display and position that one text entity at multiple 
scales. In other words, annotative text helps you reduce potential annotation 
errors by allowing you to manage one text entity, not one text entity for each 
scale.

Defining an Annotative text Style
To get started with annotative text, you must first create an Annotative text style. 
Creating Annotative text styles is incredibly similar to creating Standard text 
styles. The biggest difference is that you will specify a Paper Space Height setting 
instead of the more generic Height parameter used with Standard text styles.

 1. Make sure I08-03-ViewTitle.dwg (M08-03-ViewTitle.dwg) is open.

 2. Start the STYLE command by entering ST↵ at the command line or 
by choosing Manage Text Styles from the Text Style drop-down list 
found on the Annotate tab ➢ Text panel.

The Text Style dialog box opens, where you will begin defining a 
new Annotative text style.

 3. Select the A-Title style from the list on the left side of the Text Style 
dialog box, and click the New button.

The New Text Style dialog box opens, prompting you for a name for 
your new text style.

 4. Enter A-Label as the name, and click OK to return to the Text Style 
dialog box (see Figure 8.14).

A new text style called A-Label is created and is now the current 
text style. Its font, height, and other settings are copied from the 
A-Title text style. Now you’ll make changes to these settings to define 
the A-Label text style.
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F I G u R E   8 . 1 4 :   Setting the name for the new text style

 5. Leave Arial as the Font Name, and change Font Style from Bold to 
Regular.

The list closes, and Regular appears as the chosen Font Style.

 6. Under the Size group within the Text Style dialog box, click the 
Annotative check box, as shown in Figure 8.15, but leave the Match 
Text Orientation To Layout box unchecked.

F I G u R E   8 . 1 5 :   The Size group inside the Text Style dialog box with the 
Annotative option unchecked (left) and checked (right)

Notice how the Height parameter changes from Height to Paper 
Text Height.

 7. Enter 1⁄8 (3.5) for the Paper Text Height value.
The Text Style dialog box should look like Figure 8.16. Notice 

the small icon next to the A-Label text style you just created. This 
icon distinguishes Annotative text styles from non-Annotative, 
or Standard, text styles in the Text Style dialog box, and it is used 
throughout the software to refer to the annotative tools in AutoCAD.

◀

If you press ↵ after 
entering the height, 
the new style is auto-
matically applied, 
meaning that it is 
saved and made the 
current text style. 
Don’t do this if you 
need to change other 
settings for the style.
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F I G u R E   8 . 1 6 :   The Text Style dialog box after setting up the A-Label style

 8. Click Apply and then click Close.

 9. Save your drawing as I08-04-AnnotativeStyle.dwg (M08-04-
AnnotativeStyle.dwg).

W A R n I n G  Depending on the drawing’s precision, the Paper Text Height 
value may round to 4 mm after you enter 3.5 mm. Despite this rounding, AutoCAD will 
still create text with a height of 3.5 mm as entered in the Text Style dialog box. To ver-
ify your drawing’s precision, use the UNITS command to change the Length Precision 
property to 0.0.

Now that you have an Annotative text style, you can start creating annotative 
text.

Placing Room Labels in the Floor Plan
To label the rooms inside your cabin, you’ll use the Annotative A-Label text style 
you just created. Using Annotative text styles is very similar to using Standard 
text styles to create text, although you will need to ensure that the Annotative 
settings are correctly set so that the text you create will be scaled correctly. The 
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following exercise will walk you through how to create annotative single-line 
text entities:

 1. Make sure I08-04-AnnotativeStyle.dwg (M08-04-AnnotativeStyle 
.dwg) is open.

 2. Click the Ortho Mode, Polar Tracking, and Object Snap buttons on 
the status bar to turn off these features.

 3. Click the Annotation Scale button on the status bar, and change the 
scale to 1⁄4″ = 1′-0″ (1:50), as shown in Figure 8.17.

F I G u R E   8 . 1 7 :   Changing the annotation scale from the status bar

t I P  It ’s important to set the annotation scale before you create any annotative 
text objects because AutoCAD will use this as the default scale for the text objects you 
create. The current annotation scale is always displayed next to the Annotation Scale 
icon on the status bar. Given this, it’s a good idea to get into the habit of glancing at the 
status bar to check this setting before creating annotative objects such as text.

 4. Verify that the A-Label text style is current by expanding the Text 
Style drop-down list on the Annotate tab ➢ Text panel to display a 
list of all the text styles in the drawing.
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If necessary, click A-Label, as shown in Figure 8.18, to make Label 
the current style.

F I G u R E   8 . 1 8 :   Selecting a new, current text style in the Text panel

 5. Start the TEXT command to begin creating the room labels.

 6. Pick a point in the living room between the refrigerator and the 
closet.

 7. Press ↵ at the rotation prompt. The text cursor appears at the point 
you picked.

View titles Highlighting after Starting the TEXT 
Command?

The FLOOR PLAN view title text may become highlighted after you start the TEXT 
command. This happens whenever you start the TEXT command for the second 
time within any single drawing session—that is, when you haven’t closed or 
otherwise reopened the current drawing since you last created text.

Starting the TEXT command for the second time will highlight the last text string 
you created. Pressing ↵ with this text highlighted at the Specify start 
point of text or [Justify/Style]: prompt will continue that string 
by creating a second string directly below it. This same behavior is seen later in 
this exercise as each room name is stacked on individual lines of text.

 8. With Caps Lock on, enter KITCHEN↵ LIVING ROOM↵ BATH↵.
The TEXT command ends. You have three lines of text in the 

kitchen and living room area (see Figure 8.19).
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F I G u R E   8 . 1 9 :   The three room labels placed in the cabin

 9. Move your cursor over one of the text objects you just created.
Notice that the same Annotative icon used in the Text Style dialog 

box appears in the upper-right quadrant of the cursor to identify 
quickly that the object (a piece of text in this case) is Annotative.

 10. Save your drawing as I08-05-RoomLabels.dwg (M08-05-RoomLabels 
.dwg).

For this text, you used the default Left justification, and each line of text was 
positioned directly below the previous line at a spacing set by AutoCAD. In many 
cases, it’s more efficient to enter a list of words or phrases first and then to move 
the text to its appropriate location. That’s what you’re doing for this text. When 
you know the location of the insertion point for the next line, you can click that 
point instead of pressing ↵ at the end of the current line. This starts the next 
line of text at the selected location.

Moving text and Working with Annotation Scales

Like most objects in AutoCAD, text can be moved by using the MOVE command 
or by using the grips associated with a given object. In most cases, there is no 
difference between using the MOVE command and using the grips to do what is 
known as a grip edit. Annotative text objects are an exception to this rule.

Using the grips associated with a piece of annotative text moves that piece of 
text only for the current annotation scale. At other scales, that same piece of text 
will remain in its previous location. You’ll get to explore the difference between 
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the two as you begin positioning the room labels in your cabin. Figure 8.20 
shows how the text will look after it is moved into position.

F I G u R E   8 . 2 0 :   The LIVING ROOM, KITCHEN, and BATH text moved to their proper positions

Follow these steps to adjust the room label placement in your drawing:

 1. Make sure I08-05-RoomLabels.dwg (M08-05-RoomLabels.dwg) is 
open.

 2. Next to the annotation scale in the status bar, make sure the 
Annotation Visibility (left) and Automatically Add Scales (right) but-
tons are in the On position.

In the case of Annotation Visibility, the On position is represented 
by a yellow lightbulb, and for Automatically Add Scales, a yellow 
lightning bolt is used.

 3. Change the annotation scale to 1⁄2″ = 1′-0″ (1:30).
The KITCHEN, LIVING ROOM, and BATH text size changes to 

reflect the newly selected annotation scale.

 4. Select the BATH text, and start the MOVE command found on the 
Home tab ➢ Modify panel.

 5. Move the BATH text between the bathroom cabinet and shower, as 
shown in Figure 8.20.
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 6. Repeat the MOVE command by pressing ↵, moving the KITCHEN text 
to the position shown in Figure 8.20.

 7. Click the LIVING ROOM text. One grip appears at the justification 
point.

 8. Click the grip to activate it. The LIVING ROOM text is attached to the 
cursor and moves with it (see the top of Figure 8.21).

F I G u R E   8 . 2 1 :   Room label locations at an annotation scale of 1 ⁄ 2″ = 1′-0″ 
(1:30) (top) and 1 ⁄4″ = 1′-0″ (1:50) (bottom)

The STRETCH command automatically starts. Because text can’t be 
stretched, the STRETCH command functions like the MOVE command.
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 9. Move the cursor just above the roof centerline near the middle of the 
living room, and then click to place text at its new location.

 10. Press Esc to deselect the text and remove the grip.

 11. From the status bar, change the annotation scale back to 1⁄4″ = 
1′-0″(1:30).

The text size for each of the room labels gets larger, and the loca-
tion for the LIVING ROOM text reverts to its original location, as 
shown at the bottom of Figure 8.21.

 12. Save your drawing as I08-06-MovingText.dwg (M08-06-MovingText.dwg).

An annotative object displays at the scale assigned to it. When you created the 
room labels, the annotation scale was set to 1⁄4″ = 1′-0 (1:50), and so AutoCAD 
used that scale to size your room labels correctly. At the start of this exercise, you 
verified that the Add Annotation Scales button was turned on and then changed 
the annotation scale from 1⁄4″ = 1′-0″ (1:50) to 1⁄2″ = 1′-0″ (1:30). In doing that, 
you added the 1⁄2″ = 1′-0″ (1:30) scale to each of the three annotative objects in 
your drawing. Your room labels were then set up to display at both scales.

When plans are being prepared at different scales, it’s often necessary to 
place annotation objects such as text in different locations for some or all of the 
scales. This is done to avoid conflicts with other objects in the drawing and to 
make plans as readable as possible. This is the reason annotative objects allow 
you to specify multiple insertion points for each annotation scale assigned to an 
object. Likewise, this is where moving annotative objects by using grips differs 
from using the MOVE command.

As you saw with the KITCHEN and BATH text, the MOVE command changes 
the location for the entire text object, including its multiple annotation scales. 
On the other hand, using grips to move an annotative object moves only the 
object for the current annotation scale. As illustrated with the LIVING ROOM 
text, you used grips to move its location for the 1⁄2″ = 1′-0″ (1:30) scale, but the 
original location was retained for the 1⁄4″ = 1′-0″ (1:50) scale.

Synchronizing Annotative text Scale Positions

Use the following procedure to move the 1⁄4″ = 1′-0″ (1:50) LIVING ROOM text 
to the same location as the 1⁄2″ = 1′-0″ (1:30) LIVING ROOM text:

 1. Make sure I08-06-MovingText.dwg (M08-06-MovingText.dwg) is open.

 2. Change the annotation scale back to 1⁄2″ = 1′-0″ (1:30) by using the 
Annotation Scale menu on the status bar.

The LIVING ROOM text moves to its correct location on the screen.
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 3. Select the LIVING ROOM text.
A blue grip appears at the insertion point of the 1⁄2″ = 1′-0″ (1:30) 

text, and the location of the 1⁄4″= 1′-0″ (1:50) text is shown ghosted 
(see Figure 8.22).

F I G u R E   8 . 2 2 :   Selected LIVING ROOM text displaying its multiple annotation 
scales

 4. With the LIVING ROOM text still selected, right-click and choose 
Annotative Object Scale ➢ Synchronize Multiple-Scale Positions 
from the context menu shown in Figure 8.23.

F I G u R E   8 . 2 3 :   Choosing the Synchronize Multiple-Scale Positions option from 
the context menu
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 5. Change the annotation scale to 1⁄4″ = 1′-0″ (1:50) by using the 
Annotation Scale menu on the status bar.

 6. Using the Synchronize Multiple-Scale Positions tool, move the 1⁄4″ = 
1′-0″ (1:50) LIVING ROOM text so that it and the 1⁄2″ = 1′-0″ (1:30) 
text share the same insertion point (see Figure 8.24).

F I G u R E   8 . 2 4 :   Location of the 1 ⁄4″ = 1′-0″ (1:30) LIVING ROOM text after its 
location is synchronized

 7. Save your drawing as I08-07-SyncPosition.dwg (M08-07-
SyncPosition.dwg).

As you’ve seen, you have a couple of options when positioning text in a draw-
ing. Annotative text is easier to size than standard text; however, using the grip 
at the insertion point will place the text at different locations for each scale, 
which may be an undesired result. When working with annotative text, the 
better choice is the MOVE command, although the Synchronize Multiple-Scale 
Positions option will help correct text placement if you erroneously use the 
insertion-point grip.

Even with the versatility that annotative text provides in the placement of 
text, occasionally the free space in a drawing will be so limited that a line and 
a piece of text will coincide. A common solution is to break the line where the 
text overlaps. To demonstrate how you might solve this type of issue in your 
own drawings, in the next section you’ll need to erase part of a line where text 
intersects.
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Breaking Lines with the BREAK  Command

The BREAK command chops a line into two lines. When you’re working with text 
that intersects a line, you’ll usually want a gap between the lines after the break. 
The BREAK command provides this option as well as others. Follow these steps:

 1. Make sure I08-07-SyncPosition.dwg (M08-07-SyncPosition.dwg) 
is open.

 2. Enter UNDO↵M↵ to set the undo mark so that you can return your 
drawing to the state it is in now.

 3. Select the LIVING ROOM text, and use the MOVE command to move it 
so that it rests on the ridgeline, as shown in Figure 8.25.

F I G u R E   8 . 2 5 :   The selected text overlapping the ridgeline

 4. Turn off Object Snap, and start the BREAK command by selecting the 
Break button from the expanded Modify panel on the Home tab.

 5. Place the pickbox on the ridgeline just to the right of the text and click.
The cursor changes to the crosshair cursor, and the portion of the 

line that will remain glows. You just selected the line to break and 
picked one of the break points.

◀

You can also start the 
BREAK command by 
entering BR↵.
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 6. Put the crosshair cursor on the ridgeline just to the left of the text, 
and pick that point.

The line is broken around the text, and the BREAK command ends. 
As you can see in Figure 8.26, the text is easier to read now than it 
was when the line was running through it.

F I G u R E   8 . 2 6 :   The ridgeline is broken on either side of the text.

 7. You don’t want to retain your drawing in its current state, so enter 
UNDO↵B↵ to revert to the undo point that you set with the Mark option.

 8. Continue to the next exercise without saving changes.

A Closer Look at the BREAK Command

Use your own judgment to determine how far from the text a line must be broken 
back. You have to strike a balance between making the text easy to read and being 
clear about what the broken line represents.

Here are some options for the BREAK command:

▶▶ Ordinarily, when you select a line to be broken, the point where you pick 
the line becomes the beginning of the break. If the point where the break 
needs to start is at the intersection of two lines, you must select the line

(Continues)
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to be broken somewhere other than at a break point. Otherwise, AutoCAD 
won’t know which line you want to break. In that case, after selecting 
the line to break, enter F↵. You’ll be prompted to pick the first point  
of the break, and the command continues. Now that AutoCAD knows 
which line you want to break, you can use the Intersection osnap to pick 
the intersection of two lines.

▶▶ To break a line into two segments without leaving a gap, do the following:

 1.  Click the Break At Point button, which is on the expanded Modify 
panel. You might want to do this to place one part of a line on a 
different layer from the rest of the line.

 2. Start the command.

 3. Select the line to break.

 4.  Pick the point on the line where the break is to occur, using an 
osnap if necessary.

AutoCAD makes the break and ends the command.

Breaking Lines with the TRIM  Command

When selecting cutting edges to be used by the TRIM command, you almost 
always select a linear object, line, arc, or polyline. A lesser-known feature of the 
TRIM command is that text objects may also be used as cutting edges. The end 
result is much the same as when you used the BREAK command, but the TRIM 
command ensures that the gap between the line and text is equal on both sides. 
Follow these steps:

 1. Continue using I08-07-SyncPosition.dwg (M08-07-SyncPosition.dwg).

 2. Enter UNDO↵M↵ to set the undo mark so that you can return your 
drawing to the state that it is in now.

 3. Start the TRIM command from the Home tab ➢ Modify panel, or 
enter TR↵ at the command line.

 4. When you see the prompt Select Cutting Edges, select the LIVING 
ROOM text and press ↵.

A Closer Look at the BREAK Command (Continued)

www.MouradEngineering.com



4 1 6 	 C h a p t e r 	 8 	 • 	 C o n t r o l l i n g 	 Te x t 	 i n 	 a 	D r aw i n g

 5. At the Select Object To Trim Or Shift-Select To Extend 
prompt, select a point along the ridgeline where the LIVING ROOM 
text overlaps it, as shown in Figure 8.27.

F I G u R E   8 . 2 7 :   Breaking the ridgeline by using the TRIM command

 6. Press ↵ to end the TRIM command.
The ridgeline is trimmed along the LIVING ROOM text object, as 

shown in Figure 8.28.

F I G u R E   8 . 2 8 :   The ridgeline trimmed away
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 7. To reset the position of the LIVING ROOM text and undo trimming 
the ridgeline, enter UNDO↵B↵.

 8. Continue to the next exercise without saving changes.

t I P  The multiline text objects have a mask feature that creates an envelope over 
and around the text, hiding the objects behind it. Unlike the breaking-lines approach, the 
masked objects reappear when you move the text. Masking is not supported for single-
line text, but the Text Mask utility is available in the Express Tools. Express Tools are not 
included with AutoCAD LT.

using text in a Grid
AutoCAD provides a grid, which you worked with in Chapter 3, “Setting Up a 
Drawing.” The grid is a tool for visualizing the size of the drawing area and for 
drawing lines whose geometry conforms to the spacing of the dots or lines. 
Many floor plans have a separate structural grid created specifically for the 
project and made up of lines running vertically and horizontally through key 
structural components of the building. At one end of each gridline, a circle or a 
hexagon is placed, and a letter or number is centered in the shape to identify it. 
This kind of grid is usually reserved for large, complex drawings, but you’ll put a 
small grid on the cabin floor plan to learn the basic method for laying one out:

 1. Make sure I08-07-SyncPosition.dwg (M08-07-SyncPosition.dwg) 
is open.

 2. Create a new layer called A-GRID. Assign it the color Red (1) and 
make it current.

 3. Offset the roofline polyline 10′ (3050 mm).

 4. Pan and zoom as necessary so that the cabin is centered onscreen 
and takes up only about 75 percent of the drawing area.

 5. Turn Object Snap on if it’s off; set the Endpoint, Midpoint, and 
Perpendicular osnaps to be running; and then start the LINE 
command.

 6. Draw lines from the upper-left and upper-right inside corners of the 
walls up to the offset roofline.
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 7. Draw lines from the upper-left and lower-left inside corners of the 
exterior walls to the vertical offset line on the left (see Figure 8.29).

F I G u R E   8 . 2 9 :   The first gridlines

The gridlines need to be centered on the structural member they 
are identifying, in this case an 8″×8″ (204 mm × 204 mm) column.

 8. Start the OFFSET command, enter E↵Y↵ to set the Erase parameter, 
and then set the offset distance to 4″ (102 mm). Now when an object 
is offset, the original is erased.

 9. Offset each of the gridlines 4″ (102 mm) toward the inside of the cabin.
You may notice that the toilet will interfere with the new column 

in the lower-left corner of the cabin.

 10. Move the toilet up 4″ (102 mm) to add clearance and then adjust the 
size of the sink counter and mirror as well.

Now you need to draw gridlines for the posts at the corners of the 
decks.

 11. From the horizontal midpoint of the top-right and top-left deck 
posts, draw lines vertically to the offset roofline.
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 12. Draw lines from the upper-left and lower-left deck posts horizontally 
to the offset roofline.

 13. This time add a jog to each column line so that their endpoints are 
not too close to the endpoints of the existing horizontal column lines 
(see Figure 8.30). You need to leave space for the column tag and 
don’t want them to overlap.

Jog this line.

Jog this line.

F I G u R E   8 . 3 0 :   The column lines for the deck posts

The column lines should not extend all the way to the cabin; there 
should be a gap to keep the drawing from getting congested and 
confusing.

 14. Use the TRIM command to trim each of the column lines back to the 
roofline, as shown in Figure 8.31.
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F I G u R E   8 . 3 1 :   The column lines are trimmed back to the newly offset 
rooflines.

 15. Start the LENGTHEN command by clicking the Lengthen tool in the 
expanded Modify panel of the Home tab. Alternatively, you can enter 
LEN↵ at the command line.

t I P  Multifunctional grips provide in-context access to many commands such as 
the Lengthen tool. Hovering over the endpoint of a line, arc, or polyline will reveal a 
menu with the option of lengthening each of these objects. Because this version of the 
Lengthen tool relies on Dynamic Input, it does not provide access to options such as the 
Delta option used in the next step, and it is therefore not the best tool for this exercise.

 16. Enter DE↵ to choose the Delta option at the Select an object or 
[DElta/Percent/Total/DYnamic] prompt.

The Delta option lets you change the length of a line, arc, or polyline 
by a specified distance. In this case, you want to subtract 6″ (150 mm) 
from the total length of each gridline.

 17. To subtract 6″ (150 mm) from each gridline, enter -6↵ (-150↵) at the 
Enter delta length or [Angle] <0'-0">: prompt.

▶

Use the F8 key to toggle 
Ortho mode on and off 
in order to keep the 
jogged lines straight.
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 18. Select each of the eight column lines near where it intersects with 
the offset roofline.

Upon selecting each column line, its length will be shortened by 6″ 
(150 mm).

 19. Erase the roofline offset you created in step 3, and then zoom out to a 
view that includes the floor plan and the gridlines (see Figure 8.32).

F I G u R E   8 . 3 2 :   The cabin with the completed gridlines drawn and the offset 
roofline deleted

 20. Save your drawing as I08-08-GridLine.dwg (M08-08-GridLine.dwg).

This completes the gridlines. To finish the grid, you need to add a circle with 
a letter or a number in it to the left or upper end of the lines. You’ll use letters 
across the top and numbers running down the side:

 1. Make sure I08-08-GridLine.dwg (M08-08-GridLine.dwg) is open.

 2. From the Home tab ➢ Draw panel, expand the Circle flyout menu 
and click 2-Point.

The 2-Point option draws a circle defined by selecting two opposite 
points of the circle’s diameter.

 3. At the Specify first end point of circle's diameter: prompt, 
pick the upper end of the leftmost vertical gridline.

◀

When several osnaps 
are running, the 
marker for only one 
(and not necessar-
ily the correct one) 
appears at a time. By 
pressing the Tab key, 
you can cycle through 
all the running osnaps 
for every object your 
cursor is over or near.
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 4. Turn Ortho mode on, move the cursor directly above the last point, 
and enter 12″ (305) at the Specify second end point of circle's 
diameter: prompt.

This places a circle 12″ (305 mm) in diameter at the top of the 
gridline (see the left image of Figure 8.33). Note that you can enable 
drawing modes with a command active.

F I G u R E   8 . 3 3 :   The circle on the gridline (left) and the KITCHEN text copied to 
the circle (right)

 5. Turn Ortho mode off and click the KITCHEN text. A grip appears.

 6. Click the grip. Type C for Copy and then press ↵.

 7. Activate the Center osnap, and click the circle on the grid.
The KITCHEN text appears on the circle, with the lower-left 

corner of the text at the center of the circle (see the right image of 
Figure 8.33).

 8. Press Esc twice, once to end the Stretch function and again to clear 
the grip.

 9. Click the copy of the KITCHEN text that is now on the grid, right-
click to bring up the context menu, and then click Properties to open 
the Properties palette.

Text appears on the drop-down list at the top, telling you that 
you’ve selected a text object.

 10. Use the Properties palette to make the following changes to the 
KITCHEN text:

 a. Under General, change Layer to A-GRID (see Figure 8.34).
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F I G u R E   8 . 3 4 :   Modifying the KITCHEN text by using the Properties palette

 b. Under Text, change Contents from KITCHEN to A.

 c. Change the Justify setting from Left to Middle Center.

t I P  This exercise might seem like a roundabout way to generate letters for the grid 
symbols, but it is meant to show you how easy it is to use text from one part of the draw-
ing for a completely different text purpose. It’s a handy technique as long as you want to 
use a font that has been chosen for a previously defined text style. A faster way to do this 
is to use the Single Line Text tool. With the Justify setting set to Middle, use the Center 
osnap to place the text cursor at the center of the circle, and then enter A↵↵.

For each change, follow these steps in the Properties palette:

 1. Click the category in the left column that needs to change. If the set-
ting is on a drop-down list, an arrow appears in the right column.

 2. Click the down arrow to open the list. In the case of the KITCHEN 
text, just highlight it because there is no drop-down list.

 3. Click the new setting or enter it.

 4. When you’ve finished, close the Properties palette and press Esc to 
deselect the text.
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 5. Save your drawing as I08-09-GridBubble.dwg (M08-09-GridBubble 
.dwg).

The KITCHEN text changes to the letter A, centered in the grid circle, and 
moves to the Grid layer (see Figure 8.35).

F I G u R E   8 . 3 5 :   The grid circle with the letter A

You used the Center osnap on the KITCHEN text to position its justification 
point at the center of the circle. You then modified the justification point from 
the Left position (which is short for Base Left) to the Middle Center position. 
The Middle Center position is the middle of the line of text, horizontally and 
vertically. Thus, what you did had the effect of centering the text in the circle. 
You’ll now look briefly at text justification.

Justif ying text

Each line of single-line text is an object. It has a justification point, which is 
similar to the insertion points on blocks. When drawing, you can use the Insert 
osnap to locate precisely the justification point of text (or the insertion point of 
blocks) and thereby control the text’s position on the drawing. When you use 
the Single Line Text or TEXT command, the default justification point is the 
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lower-left corner of the line of text. At the TEXT prompt (Specify start point 
of text or [Justify/Style]:), if you enter J↵, you get the prompt Enter an 
option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]:. 
These are your justification options.

Figure 8.36 shows most of these options. The dots are in three columns—left, 
center, and right—and in four rows—top, middle, lower, and base. The names 
of the justification locations are based on these columns and rows. For example, 
you have TL for Top Left, MR for Middle Right, and so on. The third row down 
doesn’t use the name Lower; it simply goes by Left, Center, and Right. Left is 
the default justification position, so it’s not in the list of options. The Middle 
position sometimes coincides with the Middle Center position, but not always. 
For example, if a line of text has descenders—portions of lowercase letters that 
drop below the baseline, such as j and p—the Middle position drops below the 
Middle Center position. Finally, the lowest row, the Base row, sits just below the 
letters at the lowest point of any descenders.

Top Left [TL]

Left

Middle Left [ML]

Bottom Left [BL]

Top Right [TR]

Right

Middle Right [MR]

Bottom Right [BR]

Top Center [TC]
Middle/Middle 
Center [MC]

Bottom Center [BC] Center

F I G u R E   8 . 3 6 :   The justification points on a line of text

Finishing the Grid

To finish the grid, you need to copy the grid circle and its text to each gridline 
and then change the text:

 1. Make sure I08-09-GridBubble.dwg (M08-09-GridBubble.dwg) is open.

 2. Make sure Object Snap is turned on, and enable the Endpoint and 
Quadrant osnaps.

 3. Select both the letter A and the circle.
Grips appear: two for the text (one at the original justification 

point and one at the new justification point), one at the center of the 
circle, and one at each of the circle’s quadrant points.

 4. Right-click and choose Copy Selection from the context menu. Pick 
the upper endpoint of the grid with the A as the base point.

 5. Pick the top end of each vertical gridline.
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 6. Right-click and choose Enter to terminate the command (see 
Figure 8.37).

F I G u R E   8 . 3 7 :   The grid circle and letter are copied to the top of all three 
vertical lines.

 7. Move back to the original grid circle, and select the grip on the right 
side of the circle to activate it.

 8. Right-click, choose Copy Selection from the context menu, and pick 
the right quadrant of the circle as the base point.

 9. Copy the circle to the left endpoint for each of the horizontal gridlines.

 10. Press Esc to deselect the objects and remove the grips. Then, if neces-
sary, use the STRETCH command to adjust the jogged lines and elimi-
nate any overlap.

Now you’ll use the DDEDIT command to change the text in each 
circle.

 11. Be sure Caps Lock is on, and then double-click the letter A in the 
second grid circle from the left in the top row.

The text now has a blue background to indicate that it is being edited.

 12. Enter B↵. The A changes to B.
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 13. Click the A in the next circle to the right, and then enter C↵. The A 
changes to a C.

 14. Repeat this process for the remaining five grid circle letters, chang-
ing them to D, 1, 2, 3, and 4.

 15. Press ↵ to end the Edit Text command.
The letters and numbers are all in place, and the grid is complete 

(see Figure 8.38).

F I G u R E   8 . 3 8 :   The completed grid

 16. Save this drawing as I08-10-CompleteGrid.dwg (M08-10-
CompleteGrid.dwg).

Often, it’s easier to copy existing text and modify it than to create new text, 
and grips are a handy way to copy text. Using the command (technically called 
TEDIT) is a quick way to modify the wording of short lines of text, meaning 
those that consist of a word or a few letters. The Properties palette is useful for 
changing all aspects of a line of text.

For the next exercise with text, you’ll get a chance to set up some more new text 
styles, place text precisely, and use the DDEDIT command again to modify text con-
tent. You’ll do all this while you develop a border and a title block for your drawing. 

◀

Editing text is one of 
the situations in which 
pressing the spacebar 
does not have the same 
effect as pressing ↵.
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Creating a Border and title Block 
The first step in creating a border and a title block for the cabin drawing is 
deciding on a sheet size for printing the final drawing. Because many people 
have access to 11″ × 17″ (297 mm × 420 mm) format printers, you’ll use that 
sheet size. So if you print the drawing at a scale of 1 ⁄4″ = 1′-0″ (1: 50), will the 
drawing fit on the sheet?

To answer that question, you have to ask how big an area will fit on an 11″ × 17″ 
(A3, or 297 mm × 420 mm) sheet at 1⁄4″ = 1′-0″ (1:50) scale. The answer is quite 
simple. Every inch (millimeter) on the sheet represents 48″ (50 mm) in the drawing 
(because 12″ divided by 1⁄4 is 48″, and 50 mm divided by 1 is 50 mm). Therefore, 
you multiply each dimension of the sheet in inches (millimeters) by 48 (50). For 
this sheet, you multiply 11″ × 48 (297 mm × 50) to get 528″ (14,850 mm), or 45′-4″. 
You multiply 17″ × 48 (420 mm × 50) to get 816″ (21,000 mm), or 68′ (21 meters), 
as shown in Figure 8.39. So, the sheet represents a rectangle with dimensions of 
approximately 528″ × 816″ (14,850 mm × 21,000 mm) at a scale of 1⁄4″ = 1′-0″ 
(1:50), which is usually called quarter-inch scale.

11
” x

 48
 =

 52
8”

17” x 48 = 816”

29
7 m

m
 x 

50
 =

 14
,85

0 m
m

420 mm x 50 = 21,000 mm

F I G u R E   8 . 3 9 :   Approximating the viewable area for the 1 ⁄4″ = 1′-0″ (1:30) scale
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Because most printers and plotters are not full-bleed devices, you’ll need to 
factor in room for a margin around the outer edge of your sheet. Although the 
floor plan fits without any problems, you may need to adjust the column lines 
for them to fit into the printable area. Chapter 14 discusses layouts, and you will 
learn how to display the content of a single drawing at different scales—likely 
solving this issue. Even when you account for the unprintable area around the 
perimeter of the sheet, there should be plenty of room for your cabin drawing. 
This is the information you need to start creating the border.

Drawing the Border

The border of the drawing will be set in from the edge of the sheet. Here are 
the steps:

 1. Make sure I08-10-CompleteGrid.dwg (M08-10-CompleteGrid.dwg) 
is open.

 2. Create a new layer called A-ANNO-TTLB. Assign the color Green (3), 
and make this layer current.

 3. Start the Rectangle (RECTANG) command (used in Chapter 4, 
“Developing Drawing Strategies: Part 1,” to make the doors).

 4. At the prompt, enter 0,0↵. Then enter 68', 48'↵ (21000,14850↵).
This draws a rectangle that may extend off the top of the screen.

 5. Use Zoom Extents to zoom out until the entire rectangle is visible in 
the drawing area (see Figure 8.40).

F I G u R E   8 . 4 0 :   Zooming out to include the entire rectangle
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You need to fit the drawing into the rectangle as if you were fitting 
it on a sheet of paper. The easiest and safest way to do this is to move 
the rectangle over to enclose the drawing. You’ll leave plenty of room 
for the elevations that you will draw in a later chapter.

 6. At the command line, click the rectangle to select it. Grips appear at 
the corners of the rectangle.

 7. Click the lower-left grip.

 8. Press the spacebar once to switch from Stretch mode to Move mode.

 9. Move the rectangle over the drawing (see the top of Figure 8.41).

F I G u R E   8 . 4 1 :   Moving the rectangle with grips (top) and the results (bottom)

▶

Once you activate a 
grip and the Stretch 
function begins, 
pressing the spacebar 
toggles through the 
other four commands 
in this order: Move, 
Rotate, Scale, Mirror.

www.MouradEngineering.com



 U s i n g  A n n o t a t i v e  Te x t  4 3 1

 10. When the rectangle is approximately in the position shown at the 
bottom of Figure 8.41, click to finalize its placement.

 11. Press Esc to deselect the rectangle. The rectangle is positioned 
around the drawing and represents the edge of the sheet.

 12. You need a border set in from the edge. Offset the rectangle 2′ (650 mm) 
to the inside.

With a scale of 1⁄4″ = 1′-0″ (1:50), each 1′-0″ (50 mm) on the drawing 
will be represented by 1⁄4″ (1 mm) on the sheet. So, a 2′ (650 mm) off-
set distance will create an offset of 1⁄2″ (13 mm) on the printed sheet.

 13. Double-click the inside rectangle to start the PEDIT command.

 14. Enter W↵2↵ (50↵).
This command sets the width of the inside rectangle’s segments 

to 2″ (50 mm).

 15. Move both rectangles to center the cabin.

 16. Use Zoom Extents, and then zoom out a little to create a view in which 
the drawing with its border nearly fills the screen (see Figure 8.42).

F I G u R E   8 . 4 2 :   The drawing with its border
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 17. Save this drawing as I08-11-BorderFrame.dwg (M08-11-
BorderFrame.dwg).

The outer rectangle represents the edge of the sheet of paper, and the thicker, 
inner rectangle is the drawing’s border.

Constructing a title Block

The title block is a box that contains general information about a drawing, such 
as the name of the project, the design company, and the date. It will be set up 
along the right edge of the border and will use the same special line, the polyline, 
that is created when the Rectangle (RECTANG) command is executed.

You first used the Rectangle (RECTANG) command in Chapter 4 for drawing 
the doors. At that time, I mentioned that rectangles created with this command 
consist of a polyline whose four segments are grouped as one object. In step 14 
in the previous section, you saw that these segments could have varying widths.

These same principles will apply as you construct the title block for your cabin 
project. You’ll draw a series of rectangles that will eventually contain informa-
tion such as project name, drawing title, and drawing scale. Polylines, such as 
those created by the RECTANG command, include a width property. The ability 
to have a width property makes polylines especially useful in constructing title 
blocks. You’ll use the RECTANG and PLINE commands to draw the various lines 
that make up the title block, and then you’ll fill in the text:

 1. Make sure I08-11-BorderFrame.dwg (M08-11-BorderFrame.dwg)  
is open.

 2. With the entire title-block frame in view, start the STRETCH command 
found on the Home tab ➢ Modify panel.

 3. At the Select objects: prompt, create a crossing window selection 
around the inner-right edge, as shown at the top of Figure 8.43, and 
press ↵.
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F I G u R E   8 . 4 3 :   A crossing window selection around the inner-right title-block 
edge (top), and specifying the displacement distance (bottom)

 4. Pick any point in the drawing at the Specify base point prompt.

www.MouradEngineering.com



4 3 4 	 C h a p t e r 	 8 	 • 	 C o n t r o l l i n g 	 Te x t 	 i n 	 a 	D r aw i n g

 5. With Ortho mode turned on, move your cursor to the left and use 
direct distance entry to specify a displacement of 6′-6″ (2050 mm), as 
shown at the bottom of Figure 8.43.

By reducing the inner frame’s width, you now have enough room 
to include both project and drawing information along the right edge 
of your plan sheet. The rectangles and polylines you’ll draw next will 
help provide structure to this data.

 6. Ensure that Object Snap and Object Snap Tracking are both enabled 
with Endpoint chosen as a running object snap.

 7. Zoom in to the upper-right corner of your title block, bringing both 
the inner and outer title-block frames into view.

 8. Start the Rectangle (RECTANG) command, and use Object Snap 
Tracking to begin drawing a rectangle 6″ (150 mm) to the right of the 
inner title-block frame, as shown in Figure 8.44.

F I G u R E   8 . 4 4 :   Using Object Snap Tracking to acquire the rectangle starting 
point

 9. Enter 72,-72 (1900,-1900) at the Specify other corner point 
prompt to complete the rectangle. The top rectangle shown in 
Figure 8.45 is drawn.

www.MouradEngineering.com



 U s i n g  A n n o t a t i v e  Te x t  4 3 5

F I G u R E   8 . 4 5 :   Accurately positioned 72″ × 72″ (1900 mm × 1900 mm) title-
block components

 10. Using the same process, acquire a point 6″ (150 mm) below the rect-
angle; create another 72″ × 72″ (1900 mm ×1900 mm) rectangle, 
shown as the bottom rectangle in Figure 8.45.

 11. Repeat steps 8 and 9 to create a 72″ × 96″ (1900 mm × 2440 mm) rect-
angle 6″ (150 mm) to the right of the lower-right title-block frame.
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 12. Use Object Snap Tracking to compose the final rectangle 6″ (150 mm) 
below the top series of rectangles, and 6″ (150 mm) above the bottom 
rectangle, as shown in Figure 8.46).

F I G u R E   8 . 4 6 :   Using Object Snap Tracking to acquire the first corner point 
(left) and second corner point (right)

 13. Use the Match Properties (MATCHPROP) command found on the Home 
tab ➢ Clipboard panel to assign the correct polyline width to each of 
the newly created rectangles as follows:

 a. At the Select source object prompt, select the inner title-
block frame that’s currently bolder (thicker) than the other 
lines in your drawing.

 b. At the Select destination object(s) prompt, select each of 
the rectangles drawn during this exercise along the right edge 
of the title block by using the selection method of your choice. 
Press ↵ to exit the command.

Each of the object properties, such as layer, lineweight, and width, 
are synchronized between the source and destination objects (see 
Figure 8.47).
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F I G u R E   8 . 4 7 :   The completed rectangle stack along the right title-block edge

 14. Use the LINE command to subdivide the lower two rectangles along 
the right edge of your title block (look ahead to Figure 8.48):

 a. Create three horizontal lines each spaced 2′ (650 mm) apart 
inside the lower rectangle.

 b. Use the Midpoint osnap to subdivide the largest rectangle vertically.

Your drawing should now look like Figure 8.48.

F I G u R E   8 . 4 8 :   The completed title-block frame
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 15. Save this drawing as I08-12-CompleteFrame.dwg (M08-12-
CompleteFrame.dwg).

Matching Properties with the Match Properties 
Command

The Match Properties (MATCHPROP) command is an excellent way to easily syn-
chronize the properties between any two AutoCAD objects. Although the source 
and destination objects do not need to be of the same object type (text to text, 
lines to lines, and so forth), it is important to recognize that only shared proper-
ties will be matched. For example, it ’s possible to match the inner title-block 
(polyline) frame with a piece of text; however, Global Width, a property exclusive 
to polylines, would not be applied to any text entities.

A common use of the Match Properties command is to coordinate the Layer property 
of two or more objects. Although this can be an effective approach, it’s impor-
tant to recognize that all shared properties will be matched. If Layer is the only 
property you need to match, the Match (LAYMCH) command found on the Home 
tab ➢ Layers panel can be a great alternative to the Match Properties command.

Putting text in the title Block

The title block has several boxes that will each contain distinct pieces of infor-
mation. The two top boxes will contain information related to your company, 
including its logo and contact information. Below these two uppermost boxes, 
the largest box will contain the name of the project and the current drawing’s 
title. Finally, the lowest box will contain information specific to this drawing: 
drawing scale, submittal date, creator’s initials (yours), and drawing or sheet 
number. Most title-block layouts contain this information and more, depending 
on the complexity of the job.

You need to put labels in some of the boxes to identify what information will 
appear there. For this, you need to set up a new text style as follows:

 1. Make sure I08-12-CompleteFrame.dwg (M08-12-CompleteFrame.dwg) 
is open.

 2. Create a new layer named A-ANNO-TTLB-TEXT. Assign it the color 
Cyan (4), and make it current.
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 3. On the Text panel under the Ribbon’s Annotate tab, expand the Text 
Style drop-down list, and click Manage Text Styles.

 4. The A-Label text style should still be current. If not, select it.

 5. Click New, enter A-Ttlb, and then click OK.

 6. Leave the font set to Arial, but deselect the Annotative check box and 
change the height to 6″ (175).

 7. Assuming the Text Style dialog box looks like Figure 8.49, click Apply 
and then Close. A-Ttlb is the current text style.

F I G u R E   8 . 4 9 :   Using the A-Label text style as a template for the A-Ttlb text 
style

 8. Make sure Caps Lock is on, and then start the Single Line Text or 
TEXT command.

 9. Enter J↵ at the command line to open the text justification options, 
and then TL↵ to specify a Top Left justification.

 10. Use the Endpoint osnap to pick the upper-left corner of the lowest 
box.

 11. Press ↵ at the rotation prompt. Enter SCALE↵ ↵.
The word SCALE: appears in the lowest box (see the left image of 

Figure 8.50). Don’t worry about the box’s boundary overlapping the 
SCALE text, as you’ll fix this in a moment.

◀

If you press ↵ after 
changing the height, 
the Apply button turns 
gray and is unselect-
able. Pressing ↵ at this 
point has the same 
effect as clicking the 
Apply button.
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F I G u R E   8 . 5 0 :   One line of text placed (left) and the completed title-block 
labels (right)

 12. Use the COPY command to copy this text to the two boxes below it, 
using the endpoint of the horizontal lines above each of the boxes as 
the base and displacement points.

 13. Double-click the topmost-copied text to start the TEDIT command.

 14. Enter DATE: and press ↵. Pick the lower copy of text. The blue editing 
background returns.

 15. Enter DRAWN BY: and press ↵. Press ↵ to end the TEDIT command.

 16. Position each of the labels by using the MOVE command.

 17. Pick any point in the drawing as a base point, and enter @3,-3↵ 
(@75,-75↵) for the second point to move the labels into place (see the 
right image of Figure 8.50).

 18. Save this drawing as I08-13-DrawingLabels.dwg (M08-13-
DrawingLabels.dwg).

Using the DDEDIT command is a quick way to change the wording of text and 
to correct spelling. You have to change one line at a time, but the command 
keeps running until you stop it. You can also change the Contents text box in 
the Properties palette.

The final area to work on in this lowest box is where the sheet number 
appears. This sheet number will serve as the unique identifier and distinguish 
it from all other drawing sheets in your plan set. For many of the same reasons 

▶

The closer you zoom 
in, the more precisely 
you’ll be able to fine-
tune the location of 
the text. You’ll need to 
zoom out to check how 
it looks.
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that page numbers in this and many other books are found in the corners of 
each page, sheet numbers are typically placed in a similar fashion. To aid in 
making the sheet number of each drawing in your plan set easy to read and 
identify, you’ll place it in the lower-right corner and create a new text style. 
Follow these steps:

 1. Make sure I08-13-DrawingLabels.dwg (M08-13-DrawingLabels.dwg) 
is open.

 2. Open the Text Style dialog box and click New.

 3. Turn off Caps Lock, enter A-Snbr, and click OK.

 4. Leave Arial as the font and change the height to 12 (350).

 5. Click Apply and then click Close. A-Snbr is now the current text style.

 6. Start the TEXT command and enter J↵.

 7. Enter MC↵ to set the justification to the top center of the text.

 8. Right-click to select the Mid Between 2 Points osnap, and use  
the Endpoint osnap to pick the two endpoints along the top of the  
bottom-right box, as shown in Figure 8.51.

Pick these Endpoints using the 
Mid Between 2 points osnap.

F I G u R E   8 . 5 1 :   Positioning the text insertion point for the large box in the 
title block
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 9. Press ↵ at the rotation prompt.

 10. Turn Caps Lock back on and then enter A-101↵↵.
The sheet number text is correctly positioned within its designated 

block (see Figure 8.52).

F I G u R E   8 . 5 2 :   The sheet number text after being inserted

 11. With Polar Tracking on, use the MOVE command to move the text 
down and center it vertically in the box (see Figure 8.52).

 12. Save this drawing as I08-14-SheetNumber.dwg (M08-14-
SheetNumber.dwg).

Now it’s time for you to experiment, using the techniques you just learned to 
fill in the text for the other boxes.

The tallest of the four boxes composing your title block will be used to desig-
nate both the project name and sheet title. As with the other boxes, you’ll desig-
nate each of these respective areas with a label.

 1. Make sure I08-14-SheetNumber.dwg (M08-14-SheetNumber.dwg) is 
open.

 2. Use the ZOOM command to bring the lower edge of the tallest box 
composing your title block into view.

 3. Set the A-Ttlb text style as current, and start the Single Line Text 
(TEXT) command.

 4. Set the justification to Top Left (TL), and choose the bottom-left end-
point as the start point.

▶

Remember, when 
you select the text to 
move it, you have to 
pick each line because 
they are two separate 
objects.
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 5. At the Specify rotation angle of text: prompt, enter 90↵.

 6. Turn Caps Lock on if it’s not already on, and then enter PROJECT:↵↵.

 7. Repeat the procedure outlined in steps 3–5 to create the SHEET 
TITLE: label in the area to the right of your PROJECT: label. Your 
drawing should look like the left image of Figure 8.53.

F I G u R E   8 . 5 3 :   Defining the PROJECT and SHEET TITLE areas (left) and 
positioning the labels (right)

 8. Position the PROJECT: and SHEET TITLE: labels by using the MOVE 
command.
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 9. Choose any point in your drawing as a base point, and then specify a 
displacement of @3,3↵ (@75,75↵).

Your drawing should match the right image of Figure 8.53.

 10. Using the A-Ttlb text style and a text justification of Bottom Right, fill 
in the following information:

▶▶ SCALE: 1⁄4″ = 1′-0″ (1:50)

▶▶ DATE: Enter any date

▶▶ DRAWN BY: Enter your initials

 11. Use the MOVE command to position each of the title-block entries 
@-3,3↵ (@-75,75↵) to the left.

 12. Use the A-Snbr text style to fill in the project name, SUMMER CABIN, 
and sheet title, FIRST FLOOR PLAN, using the following parameters:

 a. Apply the Bottom Center (BC) text justification, and snap to the 
midpoint of the bottom line for each area.

 b. Specify a text rotation angle of 90 .̊

Your drawing should match Figure 8.54.

F I G u R E   8 . 5 4 :   The completed lower title-block boxes
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 13. Use the collection of Draw and Modify commands you’ve learned so 
far to create your own logo in the uppermost title-block box, or insert 
I08-Logo.dwg (M08-Logo.dwg) with these steps:

 a. Click Insert on the Insert tab ➢ Block panel to start the INSERT 
command.

 b. From the Insert dialog box, click Browse to locate the I08-
Logo.dwg (M08-Logo.dwg) file. You can find this file in the 
Chapter 8 download at www.sybex.com/go/autocad2015ner or 
from www.thecadgeek.com.

 c. Check Specify On-Screen for Insertion Point if it’s not already 
checked, and uncheck Specify On-Screen for both Scale and 
Rotation. Click OK.

 d. Using the Endpoint osnap, pick the lower-left corner of the 
uppermost title-block box (see Figure 8.55).

F I G u R E   8 . 5 5 :   Inserting the title-block logo (top) and the completed title 
block (bottom)
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 14. Save this drawing as I08-15-TtlbLogo.dwg (M08-15-TtlbLogo.dwg).

using Multiline text
Multiline text (often referred to as Mtext) is more complex than single-line text. 
You can use it in the same way you used single-line text in this chapter, but 
it can do more. When you have several lines of text or when you need certain 
words within a line of text to appear differently from the adjacent words, multi-
line text is the best feature to use.

A paragraph of multiline text is a single entity. The text wraps around, and 
you can easily modify the length of a line after you place the text in the drawing. 
Within the multiline text entity, all text can be edited and behaves as if it were 
in a word processor. You can give a special word or letter of the text its own text 
style or color. Everything you learned about defining a new text style applies to 
multiline text because both kinds of text use the same text styles. Just as poly-
lines become lines when exploded, multiline text is reduced to single-line text 
when exploded.

Dimensions use multiline text, and any text that is imported into an AutoCAD 
drawing from a word processing document or text editor becomes multiline text 
in the drawing. In this section, you’ll learn how to place a paragraph of multi-
line text in the cabin drawing and then modify it. In Chapter 12, “Dimensioning 
a Drawing,” you’ll work with dimension text and text with leader lines, both of 
which use multiline text.

t I P  If you are using AutoCAD and have the Express Tools installed, the TXT2MTXT 
command (click Express Tools tab ➢ Text panel ➢ Convert Text To Mtext) changes the 
selected Text objects into Mtext objects. When multiple lines of text are selected, they 
are converted into a single Mtext object. AutoCAD LT does not have the Express Tools 
available.

Finishing the title Block
In addition to the logo you inserted a moment ago, most title blocks contain 
basic company contact information. Because contact information usually spans 
several lines, multiline text is a perfect candidate to put the final touch on the 
composition of your title block. Follow these steps to complete the title block:

▶

Use the EXPLODE 
command to turn 
multiline text into 
single-line text, to 
unblock objects in a 
block reference, and to 
convert a polyline into 
regular lines. Click the 
Explode button on the 
Modify panel to start 
the command.
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 1. Make sure I08-15-TtlbLogo.dwg (M08-15-TtlbLogo.dwg) is open, 
and verify that the A-ANNO-TTLB-TEXT layer is set as current.

 2. Start the MTEXT command by clicking the Multiline Text button found 
on the Annotate tab ➢ Text panel. If the Multiline Text button isn’t 
visible, click the down-arrow beneath the Single Line text button, 
and choose it from the list.

 3. Use the Endpoint osnap to choose the upper-left and lower-right cor-
ners of the title-block box directly below the logo box (see Figure 8.56).

F I G u R E   8 . 5 6 :   Defining the multiline text box within the title block

 4. Enter the following information:

▶▶ Company Name

▶▶ Street Address

▶▶ City, State, and Zip Code

▶▶ Telephone Number

▶▶ Facsimile Number

▶▶ Website
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Figure 8.57 shows some sample text for these entries.

F I G u R E   8 . 5 7 :   The company contact information placed within the title block 
before modifying formatting

 5. Click anywhere outside the text box, or click the Close Text Editor 
button on the contextual Text Editor tab ➢ Close panel. This closes 
the Multiline Text Editor and inserts your text into the drawing (see 
Figure 8.57).

Although the title-block box now includes the necessary contact information, 
it’s likely not very legible. You may choose to do any number of things to make 
this text more legible: place greater emphasis on the company name or fix text-
wrapping issues such as the City, State, Zip text seen in Figure 8.57. Thanks 
to the additional formatting options that multiline text provides, each of these 
modifications are easily applied:

 1. With your cursor placed over any character in your text box, double-
click to open the contextual Text Editor Ribbon tab.

 2. Click the Justification button on the contextual Text Editor tab ➢ 
Paragraph panel to apply a Middle Center text justification.

The text is centered both vertically and horizontally within the 
text box.

 3. Use your cursor to highlight the Company Name text.
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 4. Click the Bold button on the contextual Text Editor tab ➢ 
Formatting panel.

 5. Still in the Multiline Text Editor, highlight the Street Address, City, 
State, and Zip Code, Telephone Number, and Website text.

 6. Reduce the text height for each of the selected components by 
entering 5 (125) in the Ribbon Combo Box - Text Height area of 
the Style panel on the contextual Text Editor tab.

 7. Ensure that your text is correctly positioned both horizontally and 
vertically by using the Middle Center justification option.

 8. On the contextual Text Editor tab ➢ Paragraph panel, expand the 
Justification button and choose Middle Center.

 9. Click anywhere outside the text box, or click the Close Text Editor 
button on the contextual Text Editor tab ➢ Close panel.

 10. Your title block should now resemble Figure 8.58. Save this drawing 
as I08-15-TtlbLogo.dwg (M08-15-TtlbLogo.dwg).

F I G u R E   8 . 5 8 :   The completed title block

Using tools familiar to anyone who has used a word processor such as 
Microsoft Word, you were quickly able to increase the legibility of the text within 
the company-contact title-block box. This is just one example of how multiline 
text can prove invaluable when you’re working with several lines of text at once.
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Beyond the formatting tools explored in this first exercise involving multiline 
text, it’s also important to note how text within a block of multiline text inter-
acts with the other text within the same block. Changing the size of all but the 
company name from 6″ (175 mm) to 5″ (125 mm) also changed the spacing 
between each line of text. Had this been several strings of single-line text, the 
vertical relationship between each line of text would not have been retained.

using Mtext for General notes
The previous exercise introduced you to several of the available multiline text 
formatting options. This expansive list of formatting options is especially helpful 
when you’re managing large blocks of text such as the general notes typically 
found on many plan sheets. Expanding on this concept, the next several exer-
cises will introduce you to many of these formatting options as you add general 
notes to your drawing.

Adding Columns to Mtext

To fit large blocks of text (for example, general notes) onto a plan sheet, it’s often 
necessary to divide the text into a series of columns. Complete the following 
steps to format the general notes for your cabin drawing into multiple columns:

 1. Make sure I08-15-TtlbLogo.dwg (M08-15-TtlbLogo.dwg) is open.

 2. Click the Make Object’s Layer Current button on the Layers panel of 
the Home Ribbon tab.

 3. Click the FLOOR PLAN text to make the A-ANNO-TEXT layer current.

 4. If it isn’t so already, change the current text style to A-Label from the 
Annotate tab ➢ Text panel.

 5. Zoom in to the blank area to the left of the title block, in the lower-
left corner of the cabin drawing.

 6. Start the MTEXT command by clicking the Multiline Text button on 
the Annotate tab ➢ Text panel, and press F3 to turn Object Snap off 
temporarily.

The command line displays the name of the current text style and 
height and prompts you to specify a first corner.

 7. Select a point near the left border, vertically in line with the roofline.
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The prompt now reads Specify opposite corner or [Height/
Justify/Line spacing/Rotation/Style/Width/Columns]:. These 
are all the options for the Multiline Text (MTEXT) command.

Unlike single-line text, Mtext uses a window to define the width of 
the text, rather than a point for the justification point.

 8. Drag open a window that fills the space between the left border and 
the left side of the pop-out.

This defines the line width for the multiline text (see Figure 8.59). 
Click to finish the window.

F I G u R E   8 . 5 9 :   Making a multiline text window

Once you’ve defined the Multiline Text window, the Text Editor 
contextual Ribbon opens, providing options that let you configure and 
edit your Mtext entities. The Text Editor contextual Ribbon tab and its 
associated panels appear in the Ribbon.

The Style and Formatting panels allow you to see the current text 
style and its font and height, as shown in Figure 8.60. Just above the 
rectangle you defined, the Multiline Text Editor opens. This is where 
you’ll enter the text.

F I G u R E   8 . 6 0 :   The Style and Formatting panels on the Text Editor tab
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 9. Enter the following text, using single spacing and pressing ↵ only at 
the end of the first line:

GENERAL NOTES:

1. All work shall be in accordance with the 2000 Ed. Uniform 
Building Code and all local ordinances.

A lightning bolt appears next to the first note when you enter a 
space after the numeral 1 (see the top of Figure 8.61). This lightning 
bolt indicates that AutoCAD has detected what it believes is a num-
bered list and will advance to the next sequential number each time 
you press ↵.

F I G u R E   8 . 6 1 :   Lightning bolt indicating an automatically numbered list (top), 
and the completed notes (bottom)

 10. Press ↵ to advance to the next line, now numbered 2, and continue 
entering the remaining notes as follows:

Roof can be built steeper for climates with heavy snowfall.

All windows to be double-paned.
In addition to the automatic sequential numbering, notice that any 

lines that are longer than the window you dragged out automatically 
wrap to the next line.

 11. When you’ve finished, click a blank spot in the drawing area.
The text appears in the drawing (see the bottom of Figure 8.61). 

The window you specified was used to define only the line length. Its 
height doesn’t control how far down the text extends; that is deter-
mined by how much text you enter.
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 12. Double-click anywhere on the new text to display the Multiline Text 
Editor and the Mtext panels.

 13. Select the GENERAL NOTES: text, and in the Text rollout, highlight 
the Annotation Text Height input field and change the value from 
1⁄8″ (5) to 3⁄16″ (4.5), and press ↵.

AutoCAD redraws the GENERAL NOTES: text larger.

 14. Use the grip at the upper-right corner of the text to stretch the text 
box farther to the right so your text box matches the bottom of 
Figure 8.61.

 15. Place your cursor after the ordinances text. Expand the Columns tool 
on the contextual Text Editor tab ➢ Insert panel, and choose Insert 
Column Break, as shown at the top of Figure 8.62. Your Mtext entity 
should look like the bottom of Figure 8.62 after inserting the column 
break.

F I G u R E   8 . 6 2 :   Using the Multiline Text Editor to insert a column break (top) 
and a new column (bottom)

 16. Use the double arrow to the far right of the Multiline Text Editor to 
position the new column closer to the first column on the left, as 
shown in Figure 8.63.

◀

Inserting a column 
break may insert an 
additional number in 
the GENERAL NOTES 
numbered list. If 
this happens, use 
the Backspace key to 
remove the additional 
line.
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Use this slider to adjust column width Use this slider to adjust column spacing

F I G u R E   8 . 6 3 :   Using the column sliders to adjust multiline text column width and spacing

 17. Use the diamond grip between the two columns to adjust the width 
for both columns so that they will fit along the lower edge of your 
drawing (see Figure 8.63).

Your GENERAL NOTES text block should look like Figure 8.63.

 18. Complete the composition of your drawing sheet by using the MOVE 
and STRETCH commands as follows:

 a. Use the MOVE command to move the GENERAL NOTES text to 
the lower-left corner of the title-block drawing area.

 b. Move the title block down until the cabin fits neatly within the 
upper-border area and the notes are unobstructed.

 c. Use the STRETCH command to bring the vertical column grid-
lines within the title-block drawing area.

Once complete, your drawing should resemble Figure 8.64.

F I G u R E   8 . 6 4 :   The results of text and title-block adjustments
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Formatting Individual Words within Mtext Entities

When TrueType fonts are used in AutoCAD drawings, any combination of for-
matting options may be applied. For example, you may choose to apply bold or 
italicized formatting to some portion of an Mtext entity. To see how to change 
individual words within the text, you’ll underline and boldface the Uniform 
Building Code text:

 1. Zoom into and double-click the Mtext again.

 2. Use the same technique as you did earlier to highlight only the 
Uniform Building Code text.

 3. Click the Bold and Underline buttons on the Formatting panel.
This underlines the selected text and displays the bold feature.

 4. Click in the drawing area.
AutoCAD redraws the text with the changes (see Figure 8.65).

F I G u R E   8 . 6 5 :   The Mtext with individual words modified

 5. Save this drawing as I08-16-GeneralNotes.dwg (M08-16-
GeneralNotes.dwg).

You just created an Mtext entity by applying several formatting func-
tions (bold and underline), and organized your general notes into columns. 
Organizing large blocks of text is commonly done in many plan sets. Although 
you could create multiple Mtext entities to organize your text into columns, 
the column feature provides a much more comprehensive approach. By keeping 
everything contained in a single Mtext entity, you’ll ensure that features such as 
numbered lists work in a more predictable manner.
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In addition to columns, you learned how to format individual words within an 
Mtext entity. You can italicize or strike through individual words—and give them a 
different color or height from the rest of the Mtext by using the other tools on the 
Multiline Text panel. I encourage you to experiment with all these tools to become 
familiar with them. Another feature of Mtext is the ability to insert hyperlinks.

Adding a Hyperlink

You have the ability to add hyperlinks, links to web pages or files, to the body 
of an Mtext object. When a hyperlink to a URL exists, anyone with the drawing 
open can hold down the Ctrl button and click the link to open the associated 
page in their web browser. Hyperlinks can also point to local or network files, 
causing the file’s associated application to open when they are clicked. Here is 
the procedure for adding a hyperlink:

 1. Make sure I08-16-GeneralNotes.dwg (M08-16-GeneralNotes.dwg) 
is open.

 2. Double-click the Mtext object.

 3. Highlight the Uniform Building Code text to indicate where you want 
the hyperlink to appear.

 4. On the contextual Text Editor tab ➢ Insert panel, click Field, or 
right-click and choose Insert Field from the context menu.

 5. In the Field Category section of the Field dialog box that opens, 
select Linked.

 6. Select Hyperlink from the Field Names section directly below the 
Field Category section.

 7. In the Text To Display field, enter Uniform Building Code.
This is the text that will appear in the tooltip when the cursor 

hovers over the hyperlink (see Figure 8.66).
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F I G u R E   8 . 6 6 :   The Field dialog box

 8. Click the Hyperlink button. In the Edit Hyperlink dialog box (shown 
in Figure 8.67), you can do any of the following:

▶▶ Enter the web page or filename and path in the Type The File 
Or Web Page Name box.

▶▶ Click the File button under Browse For to select a file that you 
will link to the text.

▶▶ Click the Web Page button under Browse For to navigate to the 
web page that you will link to the text.
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F I G u R E   8 . 6 7 :   The Edit Hyperlink dialog box

 9. Ensure that Existing File Or Web Page is selected on the right side of 
the dialog box, and then enter http://www.iccsafe.org in the Type The 
File Or Web Page Name text box.

 10. Click OK twice to close both the Edit Hyperlink and Field dialog boxes.

 11. Click a blank area to deselect the Mtext.
The link appears as text with a gray background; the background 

doesn’t appear in a printed drawing.

 12. Hover the cursor over the gray background (see Figure 8.68).

F I G u R E   8 . 6 8 :   Selecting a hyperlink embedded in Mtext

The cursor changes to the hyperlink cursor.
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 13. Hold the Ctrl key down and click the background.
This opens your browser and navigates to the selected web page.

 14. Perform a Zoom Extents, and then save this drawing as I08-17-
Hyperlink.dwg (M08-17-Hyperlink.dwg).

Your drawing should look like Figure 8.69.

F I G u R E   8 . 6 9 :   The cabin with the text added

using the Spell-Check Feature
Like most programs with word processing capability, AutoCAD includes a spell-
check feature to identify potential spelling errors. The spell check can be run 
to look for errors in a selected single-line or multiline text object. There is also 
a real-time spell-check feature to spot misspellings as you type and to suggest 
alternative words.

www.MouradEngineering.com



4 6 0 	 C h a p t e r 	 8 	 • 	 C o n t r o l l i n g 	 Te x t 	 i n 	 a 	D r aw i n g

Real-time Spell Checking

Follow these steps to see the spell-check feature in action:

 1. Make sure I08-17-Hyperlink.dwg (M08-17-Hyperlink.dwg) is open.

 2. Zoom in to the notes at the bottom of the drawing area and move 
them up enough to allow space for one more line of text.

 3. Expand the Mtext window down to accommodate the next line of text.

 4. Double-click the notes, place the cursor just past the period at the end 
of the third note, and type Soler panels, by SolCorp, are available↵. 
(You are intentionally misspelling solar.)

The fourth numbered note is appended to the others.

 5. From the contextual Text Editor tab, click the Spell Check button, 
found on the Spell Check panel, to enable spell check.

 6. Notice how the words Soler and SolCorp are underlined with a 
dashed line (see Figure 8.70).

F I G u R E   8 . 7 0 :   The new line of text with the misspelled words

This is how the real-time spell-check tool identifies the words that 
the AutoCAD dictionary doesn’t recognize.

 7. Position the cursor in the word Soler, and right-click to open a con-
text menu. At the top of the menu are spelling suggestions.

 8. Click or pause the cursor over the More Suggestions options; then 
click Solar, as shown in Figure 8.71.
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F I G u R E   8 . 7 1 :   Using the context menu to replace a misspelled word

Soler is replaced with Solar in the selected Mtext.
Many words that you frequently use, such as company, city, or 

individual names, may not exist in the AutoCAD dictionary and will 
be flagged as misspelled words. You can easily add words to the dic-
tionary to keep these words from being flagged repeatedly.

 9. Put the cursor in the word SolCorp, and right-click to open the con-
text menu.

 10. Near the top of the menu, click Add To Dictionary (see Figure 8.72).

F I G u R E   8 . 7 2 :   Adding a word to the AutoCAD dictionary
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SolCorp is added to the AutoCAD dictionary and is no longer 
underlined.

 11. Save this drawing as I08-18-SpellCheck.dwg (M08-18-SpellCheck.dwg).

Spell Checking an Entire Drawing

Often, drawings can have many separate text elements in the form of single-line 
text, multiline text, and dimensions. Although you can select each object indi-
vidually, you can also run the Spell Check tool on the entire drawing. Here’s how:

 1. Make sure I08-18-SpellCheck.dwg (M08-18-SpellCheck.dwg) is open.

 2. Make sure nothing is selected in the drawing. Then, click the Check 
Spelling button in the Annotate tab ➢ Text panel.

 3. In the Check Spelling dialog box that opens, choose Entire Drawing 
in the Where To Check drop-down list and then click Start.

AutoCAD checks the entire drawing for words that do not exist in 
the dictionary, highlights them, and offers suggestions for apparently 
misspelled words, such as the initials RDG in Figure 8.73.

F I G u R E   8 . 7 3 :   The Check Spelling dialog box and an unknown word
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 4. When an unknown word is identified, you can do any of the 
following:

▶▶ Click Add To Dictionary to add the word to the AutoCAD 
dictionary.

▶▶ Click Ignore to take no action and continue searching the 
drawing for misspelled words.

▶▶ Click Ignore All to take no action and continue searching the 
drawing for misspelled words, ignoring all occurrences of the 
flagged word.

▶▶ Select a word in the Suggestions list, and then click Change to 
replace the flagged word with the suggested word.

▶▶ Select a word in the Suggestions list, and then click Change All 
to replace the flagged word with the suggested word and auto-
matically substitute all occurrences of the flagged word for the 
suggested word.

 5. When the spell-checking task is finished, do the following:

 a. Click OK in the Spell Check Complete dialog box.

 b. Click Close in the Check Spelling dialog box.

 6. Perform a Zoom Extents, and then save this drawing as I08A-
FPLAYO.dwg (M08A-FPLAYO.dwg).

Exploring other Aspects of Multiline text
Multiline text has several other features that I can only touch on in this book. 
I encourage you to experiment with any features that you might find useful for 
your work.

using Justif ication Points

Mtext has justification points similar to those of single-line text, and they behave 
the same way. The default justification point for Mtext, however, is the upper-left 
corner of the body of text, and the available options are for nine points distrib-
uted around the perimeter of the body of text and at the center (see Figure 8.74).
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F I G u R E   8 . 7 4 :   Justification points for Mtext

When you need to modify the justification of Mtext, double-click the text to 
open the Multiline Text Editor and display the Text Editor tab and panels. In the 
Paragraph panel, click the Justification button and then click the justification 
preference from the flyout menu, as shown in Figure 8.74. I’ll describe the other 
items on this menu in the “Tools for Modifying Multiline Text” sidebar.

tools for Modifying Multiline text

Here’s a brief summary of the various features of the contextual Text Editor tab’s 
panels that are available whenever you select Mtext with a double-click:

the Style Panel

Style List  Lists all existing text styles in the drawing file.

Annotative Button  Toggles the Annotative property for text and dimensions. 
This property can cause the text to scale automatically as necessary. Chapter 12 
covers annotation.

text Height Drop-Down text Box  Sets the height for selected text or 
sets the height for subsequently entered text.

the Formatting Panel

Bold, Italic, underline, overline, and Strikethrough Buttons  Changes 
selected text or sets up for subsequently entered text.

Make uppercase and Make Lowercase Flyout Button  Changes the 
case of the selected text to all uppercase or all lowercase.

Font Drop-Down List  Sets the font for the selected text or sets the font 
for subsequently entered text.

(Continues)
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Color Drop-Down List  Changes the color of a selected portion of text or 
sets a color for subsequently entered text.

Background Mask Button  Sets the parameters for using a background 
mask to hide objects behind the text.

oblique Angle Spinner Buttons  Sets the selected text to an oblique angle 
off the vertical, from –85 to the left, to 85 to the right.

tracking Spinner Buttons  Adjusts the spacing between selected letters 
from a minimum of 75 percent of the default spacing to a maximum of four times 
the default spacing.

Width Factor Spinner Buttons  Adjusts the width of selected letters and 
the spacing between them from a minimum of 10 percent of the default width 
and spacing to a maximum of 10 times the default.

Stack  Creates fractions and tolerance forms by stacking text objects and 
mleaders.

the Paragraph Panel

Justification Button  Displays a menu with the nine Mtext justification 
choices.

Bullets And numbering Button  Opens a flyout menu for controlling 
numbering and bullets.

Line Spacing Button  Opens a flyout menu for controlling spacing between 
lines of text.

Combine Paragraphs Button  Removes the line break between two or 
more paragraphs and combines them into a single paragraph.

Paragraph Button  Clicking the arrow on the right opens the Paragraph 
dialog box, where you can set tab and paragraph spacing, indents, and other 
paragraph-related parameters.

Left, Center, Right, Justify, and Distribute Buttons  Justifies the 
selected text accordingly.

the Insert Panel

Columns Button  Opens a menu for controlling the column options.

Symbol Button  Opens a menu of symbols to insert into the Mtext where 
the cursor rests.

tools for Modifying Multiline text (Continued)

(Continues)
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Field Button  Begins the process of inserting a field in the Mtext in place of 
selected text or where the cursor rests in the text.

the Spell Check Panel

Spell Check Button  Runs the Spell Check utility.

Edit Dictionaries  Opens the Dictionaries dialog box, where custom dictionar-
ies can be selected and edited.

the tools Panel

Find & Replace Button  Opens the Find And Replace dialog box, where 
you can specify a text string to search for and the text string that will replace it.

Import text  Imports a word processing or text file into an AutoCAD drawing. 
The maximum size allowed is 32 KB, so the smallest document possible in some 
versions of Microsoft Word is too large. You can, however, use files in text-only 
or RTF formats. Clicking the Import Text button opens the Select File dialog box 
that displays only files with the .txt and .rtf extensions. You can bring in text 
files with other extensions if you enter the full filename with its extension and 
if the files aren’t larger than 32 KB. Text comes in as Mtext and uses the current 
text style, height setting, and layer. The imported file might not retain complex 
code fields for such elements as tabs, multiple margin indents, and so on.

AutoCAPS   When checked, this capitalizes all text.

the options Panel

More  Displays a menu with several options for adjusting the parameters for 
text, Mtext, and the Multiline Text Editor.

Ruler Button  Toggles the ruler above the Mtext to be visible or invisible.

undo Button  Undoes the last editing action.

Redo Button  Redoes the last undo.

the Close Panel

Close Button  Deselects the Mtext, and closes the Multiline Text tab.

the Mtext Context Menu

The features of the Mtext context menu, the menu that appears when you place 
your cursor in the text or highlight text and right-click, are as follows:

tools for Modifying Multiline text (Continued)

(Continues)

www.MouradEngineering.com



 U s i n g  M u l t i l i n e  Te x t  4 6 7

Spelling Suggestions  If the highlighted text is not in the dictionary, a set 
of suggested words is displayed along with a cascading menu with additional 
word options.

Add to Dictionary and Ignore All  Two more actions available when 
misspelled words are highlighted.

Select All  Selects and highlights all the text in the selected Mtext object.

Cut  Copies the selected text to the Windows Clipboard and deletes it from 
the Mtext object.

Copy  Copies the selected text to the Windows Clipboard.

Paste  Pastes text from the Windows Clipboard to the cursor location in the 
Mtext object.

Paste Special  Displays a submenu containing additional methods for pasting 
content into an Mtext object.

Insert Field  Opens the Field dialog box, which you use to insert a field into 
the selected text. If you select text containing a field, this menu item changes to 
three menu items: Edit Field, Update Field, and Convert Field To Text.

Symbol  Imports symbols (such as diameter, degree, and so on) that aren’t 
available in the font you’re using.

Import text  Imports a word processing or text file into an AutoCAD drawing, 
as described under “The Tools Panel” earlier in this sidebar.

Paragraph Alignment  Sets the justification for the selected Mtext.

Paragraph  Opens the Paragraph dialog box. It has settings for indenting 
the first line and subsequent paragraphs of Mtext (similar to what the sliders 
do on the ruler above the Multiline Text Editor window) and tab stop positions.

Bullets And Lists  Opens a flyout menu that offers various options for using 
the listing features.

Columns  Provides access to the column parameters.

Find And Replace  Opens the Replace dialog box, in which you search for a 
word or a series of words (text string) and replace them with text that you specify.

Change Case  Changes the case of all highlighted text to uppercase or 
lowercase.

AutoCAPS  When selected, capitalizes all text.

tools for Modifying Multiline text (Continued)

(Continues)
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Character Set  Opens a menu of several languages. When applicable, the 
codes of the selected language are applied to selected text.

Combine Paragraphs  Joins highlighted individual paragraphs into one 
paragraph.

Remove Formatting  Removes formatting, such as bold, underline, and so 
on, from highlighted text.

Background Mask  Opens the Background Mask dialog box in which you 
specify color for and activate a background mask to go behind the selected 
Mtext object.

Editor Settings  Opens a menu for selecting whether certain features appear, 
such as the ruler or toolbar.

Help  Opens the AutoCAD Help file at the entry regarding Mtext.

Cancel  Closes the menu.

Adding Special Characters

With Mtext, you can add special characters—the degree symbol, the diameter 
symbol, and so on—that aren’t included in most font character packages. You’ll 
have a chance to do this in Chapter 12.

If you want to experiment with the Mtext in the cabin drawing, make a copy of 
it and place it outside the title block. Double-click it, and see what you can learn 
about the Multiline Text Editor, the tools found in the panels located under 
the Multiline Text tab, and the Mtext shortcut menu. The preceding “Tools for 
Modifying Multiline Text” sidebar summarizes the features of the latter two.

If You Would Like More Practice…
Trades and professions other than architecture and construction use text with 
AutoCAD and AutoCAD LT in the same way as demonstrated in this chapter.

For more practice using single-line text, follow these steps:

 1. Close all drawings, and then open 08A-FPGARG.dwg.

tools for Modifying Multiline text (Continued)
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 2. Using the DesignCenter, bring in the A-Title and A-Label text styles 
from the 08A-FPLAYO drawing while it’s closed.

 3. Place labels on the features that were added:

▶▶ Use the A-Title text style to identify the addition as GARAGE.

▶▶ Use the A-Label text style to give the features the following 
names: WALKWAY, STORAGE, OFFICE, and CAR.

For more practice using Mtext, follow these steps:

 1. Open 08A-FPLAYO, and zoom in to the blank space between the notes 
and the title block.

 2. Create a new text style called A-Desc that uses the Times New Roman 
font and a height of 8″ (204 mm).

 3. Start Mtext, and specify a rectangle for the text that covers the area 
between the notes and the title bar.

 4. Enter the following text exactly as shown here, spelling errors and all:

This is a design for a small vacation cabin. It contains approxi-
mately 380 square feet of living space and includes one bed-
room and one bath. It can be adopted to provide shelter in 
all climates and can be modified to allow construction that 
uses local building materials. Please send all inquiries to the 
manufacturer.

 5. Double-click the new text and make these changes:

 a. Correct all spelling errors by using the Spell Check tool or real-
time spell checking.

 b. Change square feet to sq. ft.

 c. Bold the following: one bedroom, one bath, all climates, and 
local building materials.

 d. Italicize the last sentence.

www.MouradEngineering.com



4 7 0 	 C h a p t e r 	 8 	 • 	 C o n t r o l l i n g 	 Te x t 	 i n 	 a 	D r aw i n g

Are You Experienced?

now you can…

✔✔ set up text styles

✔✔ place	single-line	text	in	a	drawing	for	titles	and	room	labels

✔✔ create a structural grid for a drawing

✔✔ modify single-line text

✔✔ construct	a	title	block	and	place	text	in	it

✔✔ open AutoCAD template files

✔✔ place Mtext in a drawing

✔✔ modify Mtext in several ways

✔✔ add	a	hyperlink	to	an	Mtext	object

✔✔ check	the	spelling	in	a	drawing
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CHAPtER 9

using Dynamic 
Blocks and tables
In Chapter 7, “Combining Objects into Blocks,” you explored creating 
and using blocks to combine separate objects into a single, complex object to 
aid in selecting objects and editing properties. Chapter 8, “Controlling Text 
in a Drawing,” covered the addition of text into drawings. In this chapter, you 
will expand your knowledge of blocks and use text inside blocks and tables to 
display information about specific features of a drawing.

The blocks you’ve worked with have been static collections of objects that 
you have inserted throughout your drawing as doors or windows. Each 
instance of the same block was visually identical to the others, and you were 
able to scale the window blocks along one axis and without distortion to 
fit the walls. Blocks can also contain textual information, called attributes, 
which are specific to an individual block instance. Blocks do not have to 
remain static and unchanging. In this chapter, you will learn how to define 
your blocks so that they can change as required, without needing to explode 
the blocks and modify the component objects.

After exploring blocks further, you’ll learn how to create a table to act as a 
door schedule, displaying the door type, unit price, and total cost. A schedule 
is a chart in a drawing that contains logically organized information about 
a particular component of a project, such as a steel base plate, valve, bolt, 
screw, door, window, or room finish. Each of these components has its own 
schedule. Information in a door schedule, for example, might include size, 
material, finish, location, and type of jamb.

In this chapter, you will learn to

▶▶ Add	block	attributes	and	fields,	and	create	dynamic	blocks

▶▶ Calculate areas 

▶▶ Extract	data	into	tables

▶▶ Create	tables
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using Attributes for a Grid
The gridlines and associated labels you drew in Chapter 8 are a critical col-
laboration tool for technical drawings. Especially in larger projects, they are 
frequently used to call attention to a specific place in a drawing. For instance, 
it would be rather ambiguous to ask someone to look at the closet in a plan. 
Instead you might direct someone to a specific closet by saying, “Have a look at 
the closet near gridline intersection C2.” 

Despite the practicality of these labels, composed of a text object and a circle, 
their management is rather disparate at the moment. Because each grid needs 
to have a unique letter or number, creating a static block as you did in Chapter 
7 won’t work for this application. Instead, you need a block that can display a 
unique number or letter for each block insertion. You can achieve this level of 
interaction with any block by adding attributes to its definition.

A simple but handy use of attributes is to make the letter or number in the cir-
cle an attribute and then make a block out of the attribute and circle. By redoing 
the grid symbols in the cabin drawing, you’ll learn how to set up attributes and 
create a new block that can be used in any other drawing. Because you’ll define 
the block as an annotative block, the grid label blocks you create will not be scale 
dependent. Follow these steps to create block attributes for the grid labels:

 1. Open I08-A-FPLAYO.dwg (M08-A-FPLAYO.dwg).
The drawing consists of the floor plan with a structural grid, notes, 

and a title block.

 2. Make sure that the A-GRID layer is current, and then freeze the 
A-ANNO-TTLB and A-ANNO-TTLB-TEXT layers.

t I P  You’ve already seen how the -LAYER command can be used to create new 
layers, but it can also be useful in layer management. Instead of freezing the two 
A-ANNO-TTLB layers individually, try entering -LAYER↵F↵*TTLB*↵. This command 
sequence tells the Autodesk® AutoCAD® program to freeze all TTLB layers at once. The 
asterisk (*) is a wildcard character that tells AutoCAD to look for any layers with TTLB in 
their names—and, in this case, freeze them.

 3. Zoom in to the floor plan, keeping the grid visible.
In this case, the letters run horizontally across the top, and the 

numbers run vertically along the side.

 4. Erase all the circles, letters, and numbers in the grid except for A and 
1. Leave the gridlines intact (see Figure 9.1).
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F I G u R E   9 . 1 :   The floor plan of I08-A-FPLAYO (M08-A-FPLAYO) with all 
but two grid symbols erased

 5. Turn off the Automatically Add Annotative Scales mode from the 
status bar (the icon turns gray).

 6. Change your current annotation scale to 1:1, as shown in Figure 9.2.

F I G u R E   9 . 2 :   Changing the current annotation scale to 1:1
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 7. Start the SCALE command.

 8. Select the top-left circle and press ↵.

 9. At the Specify base point: prompt, use the Endpoint osnap and 
pick the endpoint of the gridline where it meets the circle.

 10. Enter 1/48↵ (1/50↵).
This reduces the circle to its actual plot height.

 11. Repeat steps 7–10 for the circle on the left side.

 12. Start the ATTDEF command by clicking the Define Attributes button 
on the Insert tab ➢ Block Definition panel. The Attribute Definition 
dialog box opens (see Figure 9.3).

F I G u R E   9 . 3 :   The Attribute Definition dialog box

In the Attribute group are three text boxes: Tag, Prompt, and 
Default. The cursor is flashing in the Tag text box. Think of the let-
ter in the grid circle. It’s a grid letter, which is a tag that provides the 
visual textual information.

 13. Enter GRID-LETTER. Don’t press ↵.

 14. Press the Tab key to move to the Prompt text box.
Here you enter a prompt that will display for a future user. When 

a user inserts a block containing the attribute, the prompt will ask 
the user to input text for the tag.
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 15. Type Enter grid letter, again without pressing ↵.

 16. Press Tab to move to the Default text box.
Here you enter a default or sample value that will be used if the 

future user presses ↵ instead of entering a new value. You want the 
letter capitalized in this case, so enter A.

This sets up the attribute so that the user setting up the grid will 
be prompted to enter the grid letter and will be given a default of A. 
The capital A lets the user know that the letter should be uppercase.

The lower portion of the dialog box is where you set up parameters 
for the attribute text: location in the drawing, justification, text style, 
height, and rotation.

 17. Click the Justification drop-down list, and select Middle Center.

 18. Choose A-Label in the Text Style list box.
Because the A-Label text style is annotative, the Annotative check 

box is automatically selected. Likewise, because a text height other 
than 0′-0″ (0) is associated with the A-Label text style, the Text 
Height text box is grayed out.

 19. Make sure that the only check box selected in the Mode group is Lock 
Position.

The Attribute Definition dialog box should look like Figure 9.4.

F I G u R E   9 . 4 :   The Attribute Definition dialog box showing the appropriate 
values
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 20. Click OK. Doing so returns you to the drawing to pick an insertion 
point.

 21. Back in the drawing, use the Center osnap and click the circle at the 
top of the grid.

GRID-LETTER is centered over the circle (see Figure 9.5), and the 
ATTDEF command ends.

F I G u R E   9 . 5 :   The first attribute definition placed in the grid circle

The text over the circle is called the attribute definition. Its function in 
AutoCAD is similar to that of a block definition. When you made the A-GLAZ 
block for the windows, the definition was a 12″ (305 mm) long window with an 
insertion point. When the A-GLAZ block is inserted, you can use the original 
block definition to make windows of various sizes. The same is true for the attri-
bute definition. When it becomes part of a block that’s inserted, the attribute 
can be any letter you want. You’ll see that happen in a minute. First make a 
similar attribute definition for the numbered grid symbol:

 1. Click the Define Attributes button again, or enter ATT↵ to start the 
Attribute Definition command. The Attribute Definition dialog box 
opens again.

 2. Repeat steps 7 to 20 from the preceding exercise, using the following 
guidelines:

 a. Enter GRID-NUMBER in the Tag text box.

 b. Type Enter grid number in the Prompt text box.
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 c. Enter 1 in the Default text box.

 d. Select Middle Center from the Justification drop-down list.

 e. Click OK, use the Center osnap, and click the grid circle on 
the left.

The second attribute definition is centered over the circle (see 
Figure 9.6).

F I G u R E   9 . 6 :   The second attribute definition is placed.

 3. Save your drawing as I09-01-DefineAttribute.dwg (M09-01-
DefineAttribute.dwg).

You now have two attribute definitions, and you are ready to make each of them 
part of a block that includes the circle over which they’re currently centered.

Defining Blocks with Attributes
You have to define two blocks for the grid symbols and their attributes. The 
insertion point for the block used for the top of the grid should be at the lowest 
point of the circle. The insertion point for the block used for the left side should 
be at the point on the circle farthest to the right. Follow these steps:

 1. Make sure I09-01-DefineAttribute.dwg (M09-01-DefineAttribute 
.dwg) is open.

 2. Click the Create Block button on the Block Definition panel to start 
the BLOCK command, and open the Block Definition dialog box.

 3. In the Name drop-down list, choose GRID-V (for vertical) and then 
click the Pick Point button in the Base Point group.

 4. In the drawing, use the Endpoint osnap and select the gridline that 
ends at the circle on top.

 5. In the Block Definition dialog box that reopens, click the Select 
Objects button in the Objects group.
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 6. In the drawing, select the circle and attribute definition on the top. 
Press ↵.

The Block Definition dialog box reopens.

 7. Click the Annotative check box in the Behavior group.

 8. Check to make sure the Delete button is selected in the Objects 
group.

 9. Verify that the Block Definition dialog box looks like Figure 9.7, and 
click OK.

1 2

4

3

F I G u R E   9 . 7 :   The Block Definition dialog box for the GRID-V attribute block

The block is defined, and it includes the attribute definition. In the 
drawing, the top circle and attribute definition have been deleted.

 10. Click the Create button again.

 11. Repeat steps 2 through 8 to define a second block for the circle and 
attribute definition on the left side. Use the following guidelines:

 a. Choose GRID-H from the Name drop-down list.

 b. Click Pick Point. Use the Endpoint osnap, and pick the horizon-
tal gridline that ends at the rightmost point of the grid circle on 
the left of the floor plan.
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 c. When selecting objects, select the circle on the left and its attri-
bute definition.

When you complete the command, you have a second block definition 
that includes an attribute definition and no grid circles in the drawing.

 12. Save your drawing as I09-02-BlockDefinition.dwg (M09-02-
BlockDefinition.dwg).

Inserting Blocks with Attributes
Let’s insert these blocks (which are now grid symbols) at the endpoints of the 
gridlines. As you insert them, you’ll assign them the appropriate letter or num-
ber, but first you’ll make sure that AutoCAD uses a dialog box to prompt for the 
user input:

 1. Make sure I09-02-BlockDefinition.dwg (M09-02-BlockDefinition 
.dwg) is open.

 2. From the status bar, change the annotation scale to 1⁄4″ = 1′-0″ 
(1:50).

 3. Be sure that the Endpoint osnap is running, and then enter ATTDIA↵.

 4. Click the Insert button in the Block panel and select the GRID-V 
block from the Block Insertion gallery (see Figure 9.8).

F I G u R E   9 . 8 :   Selecting GRID-V from the Block Insertion gallery

◀

The ATTDIA variable 
defines whether the 
INSERT command 
opens a dialog box or 
prompts the user at the 
command prompt for 
attribute information. 
When the variable is 
set to 0, no dialog box 
is used.
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 5. Click the endpoint of the leftmost vertical gridline in the drawing 
(see the left image in Figure 9.9).

F I G u R E   9 . 9 :   Choosing the block attribute insertion point (left), and entering 
values with the Edit Attributes dialog box (right)

The Edit Attributes dialog box shown on the right in Figure 9.9 opens 
after you select an insertion point. Each block attribute prompt is shown 
along the left side of this dialog box, with the default values for each of 
those attributes shown along the right side of the dialog box.

 6. Verify that the Enter Grid Letter value is set to A in the Edit 
Attributes dialog box. Click OK. Clicking OK inserts the grid symbol 
at the endpoint of the leftmost vertical gridline (see Figure 9.10).

F I G u R E   9 . 1 0 :   The first grid symbol block is inserted.
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 7. Press ↵ to restart the INSERT command.

 8. Click OK to accept GRID-V as the current block to be inserted.

 9. Click the gridline to the right of the one you just selected.

 10. In the Edit Attributes dialog box, enter B as the Enter Grid Letter 
value and click OK.

The second grid symbol is inserted on a gridline, and the letter B 
is located in the circle. Be sure to use a capital B here; the tag will 
not prevent you from using a lowercase letter, but drawing standards 
require consistency.

Although you defined the GRID-V block at a much smaller scale, 
notice how it inserts at the correct scale. Just as text does, an anno-
tative block sizes itself based on the current annotation scale when 
you insert it.

 11. Repeat steps 7 through 10 to insert the other two grid symbols across 
the top of the floor plan, incrementing the values for each.

 12. Continue repeating steps 4 through 10, but select the GRID-H block 
for the four grid symbols that run down the left side of the floor plan. 
The result should look like Figure 9.11.

F I G u R E   9 . 1 1 :   The grid with all symbols inserted

 13. Save your drawing as I09-03-InsertAttribute.dwg (M09-03-
InsertAttribute.dwg).
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Editing Attribute text
To illustrate how you can edit attribute text, let’s assume that you decide to 
change the C grid symbol to B1. You must then change the D symbol to C. Here 
are the steps:

 1. Make sure I09-03-InsertAttribute.dwg (M09-03-InsertAttribute 
.dwg) is open.

 2. Double-click the C grid symbol.
Doing so opens the Enhanced Attribute Editor dialog box shown 

in Figure 9.12. You can change several items here, but you want to 
change only the Value parameter.

F I G u R E   9 . 1 2 :   The Enhanced Attribute Editor dialog box

 3. Check to make sure the Attribute tab is selected. Highlight C in the 
Value text box, enter B1, and then click the Apply button.

B1 replaces C in the larger window where the tag, prompt, and 
value appear together.

 4. Click OK to close the dialog box.

n o t E  Because you set the justification point for the attribute text to Middle 
Center and located the text at the center of the grid circle, the B1 text is centered in the 
circle, just like the single letters.

 5. Double-click the D grid symbol.

 6. In the Enhanced Attribute Editor dialog box, repeat step 3 to change 
D to C. The attributes are updated (see Figure 9.13).
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F I G u R E   9 . 1 3 :   The grid symbols after being updated

 7. Save your drawing as I09-04-EditAttributes.dwg (M09-04-
EditAttributes.dwg).

t I P  Instead of using the Enhanced Attribute Editor, you can edit individual block 
attributes by double-clicking any attribute while holding down the Ctrl key.

The exercises in this chapter so far have illustrated the basic procedures for 
defining, inserting, and changing attributes. You can apply these same proce-
dures to the process of setting up a title block in which attributes are used for 
text that changes from one sheet to the next. You can now move to a more com-
plex application of the attribute feature to see its full power.

Setting up Multiple Attributes in a Block
The cabin has three rooms and two decks, with the kitchen and living room sharing 
the same space. Each room has a different area and floor covering. You can store 
this information, along with the room name, in the drawing as attributes. You’ll set 
up a block that consists of three attributes (name, area, and covering). You’ll then 
insert the block back into the floor plan. As you may remember, the text style for the 
room labels is A-Label. You’ll use that for the attributes.

You have to erase the room labels for now, but it will be handy to mark their 
justification points. That way, you can insert the attribute exactly where the 
label text is now. Follow these steps:

 1. Make sure I09-04-EditAttributes.dwg (M09-04-EditAttributes.dwg) 
is open.

 2. Thaw the A-ANNO-TTLB-TEXT layer.
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 3. With layer 0 current, from the menu bar, expand the Utilities panel 
on the Home tab and choose Point Style, or enter DDPTYPE↵ to open 
the Point Style dialog box (see Figure 9.14).

F I G u R E   9 . 1 4 :   The Point Style dialog box

n o t E  A point is a single location in space, defined by an X, Y, and Z position, 
with no area or volume. The Point Style dialog box determines how the marker at the 
point location appears. By default, the point appears as a single pixel, which can be visu-

ally lost in the drawing.

 4. In the second row, click the fourth point style example (the one with 
a circle and an X). Then click OK to close the dialog box.

 5. Set the Insertion osnap to be running, and then click the Multiple 
Points button on the expanded Draw panel on the Home tab to start 
the POINT command.

 6. Place the cursor on the LIVING ROOM text.

 7. When the Insertion symbol appears at the lower-left corner, click to 
place the point object. Don’t end the command yet.

 8. Repeat steps 6 and 7 for the KITCHEN and BATH labels.
The decks don’t have any associated text in this drawing, so you 

can place the attribute anywhere you want.

 9. Press Esc to end the POINT command.
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 10. Erase the LIVING ROOM, KITCHEN, and BATH labels.
The drawing should look like Figure 9.15.

F I G u R E   9 . 1 5 :   The floor plan with markers for insertion points and three 
room labels erased

 11. Change the current annotation scale to 1:1 from the status bar.

 12. Make layer 0 current.

 13. Click the Define Attributes button on the Insert tab ➢ Block 
Definition panel to open the Attribute Definition dialog box.

 14. Enter the following:

▶▶ For Tag, enter RM_NAME.

▶▶ For Prompt, enter Room name.

▶▶ For Default, enter LIVING ROOM. This default value will 
remind the user to use all uppercase letters.

 15. In the bottom half of the dialog box, the settings for the text stay the 
same. Click OK.

 16. In the drawing, click above the cabin and between the B and B1 
gridlines. This places the first attribute definition in the drawing 
(see Figure 9.16).
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F I G u R E   9 . 1 6 :   The room name attribute definition placed in the drawing

Because you’re going to make a block out of it and reinsert it into 
the rooms, you don’t have to place the attribute definition where the 
room labels are positioned; any open area in the drawing is fine.

t I P  Because you’re drawing at a scale of 1:1, the attribute definition is very small 
in relation to the rest of your drawing. Instead of using Zoom Window, try selecting the 
attribute definition and then choosing the Zoom Object option from the Navigation bar. 
This will zoom in on the selected attribute definition.

 17. Press ↵ to restart the ATTDEF command. For this attribute, enter the 
following:

▶▶ For Tag, enter RM_AREA.

▶▶ For Prompt, enter Area of room.

▶▶ For Default, enter 10.00 Sq. Ft. (10.00 M2). This will show the 
user the proper format for the area.

 18. In the Mode group, click to activate Invisible.
The Invisible mode makes the attribute values invisible in the 

drawing, but they’re still stored there and can be accessed when 
required.
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 19. In the lower-left corner of the dialog box, click the Align Below 
Previous Attribute Definition check box.

All the text options fade out (see Figure 9.17). The style is the same 
as that of the first attribute, and this attribute definition will appear 
right below the first one.

F I G u R E   9 . 1 7 :   Setting the proper values in the Attribute Definition dialog box

 20. Click OK. The second attribute definition appears in the drawing 
below the first one.

 21. Repeat steps 17 to 19 to define the third attribute:

▶▶ For Tag, enter RM_FLOOR.

▶▶ For Prompt, enter Floor Material.

▶▶ For Default, enter Wood Parquet.

 22. Click OK. All three attribute definitions are now in the drawing 
(see Figure 9.18).
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F I G u R E   9 . 1 8 :   The floor plan with all three attribute definitions

 23. Save your drawing as I09-05-MultipleAttributes.dwg (M09-05-
MultipleAttributes.dwg).

Now you’ll make a block out of the three attributes.

Defining a Block with Multiple Attributes
A block with attributes usually includes lines or other geometric objects along 
with the attribute definitions, but it doesn’t have to do so. In this case, the three 
attribute definitions are the sole content of the block, and the block’s insertion 
point is the justification point for the first attribute: the room label text. Follow 
these steps to define the block:

 1. Make sure I09-05-MultipleAttributes.dwg (M09-05-
MultipleAttributes.dwg) is open.

 2. Click the Create button found on the Insert tab ➢ Block Definition 
panel to start the BLOCK command.

 3. In the Block Definition dialog box, enter A-ROOM-IDEN for the name.

 4. Click the Pick Point button.

 5. In the drawing, use the Insert osnap and choose the top attribute 
definition.

Doing so aligns the justification point of this attribute with the 
insertion point of the block.
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 6. Back in the Block Definition dialog box, click the Select Objects 
button.

 7. In the drawing, pick each attribute definition individually in the 
order you created them.

Selecting the attribute definitions in this order causes them to be 
listed in the Enter Attributes dialog box in the same order.

 8. Press ↵ after selecting the last attribute definition.

 9. Make sure that Delete is still selected. Then select the Annotative 
check box, making the A-ROOM-IDEN block annotative.

 10. Assuming the Block Definition dialog box looks like Figure 9.19, click 
OK to dismiss the dialog box.

F I G u R E   9 . 1 9 :   The Block Definition dialog box for the A-ROOM-IDEN block

The A-ROOM-IDEN block is defined, and the attribute definitions 
are deleted from the drawing.

 11. Save your drawing as I09-06-MultiAttBlock.dwg (M09-06-
MultiAttBlock.dwg).

You’re almost ready to insert the A-ROOM-IDEN block in each of the three 
rooms and the decks. But first you need to calculate the area of each room.
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Calculating Areas
You can calculate areas in a drawing by using the HATCH command in conjunc-
tion with the Properties palette or by using the Area tool. Because area calcula-
tions are made over and over again in design, construction, and manufacturing, 
the AREA and MEASUREGEOM commands are important tools. You can calculate 
an overall area and then subtract subareas from it, or you can add subareas 
together to make a total. Chapter 11, “Working with Hatches, Gradients, and 
Tool Palettes,” covers hatches.

For this exercise, you’ll use the Area tool to calculate the areas of the five floor 
spaces in the floor plan. You need to write down the areas after you make the 
calculations. Follow these steps:

 1. Make sure I09-06-MultiAttBlock.dwg (M09-06-MultiAttBlock.dwg) 
is open.

 2. Create a new layer named A-AREA-NPLT, and make it the current 
layer.

 3. Freeze all the other layers except A-DECK, A-GLAZ, and A-WALL. 
Your drawing should look like Figure 9.20.

F I G u R E   9 . 2 0 :   The floor plan with all layers turned off except A-AREA-NPLT, 
A-DECK, A-WALL, and A-GLAZ

t I P  When you want to select all the layers in a drawing except a few, select those 
few layers in the Layer Properties Manager, right-click, and choose Invert Selection from 
the context menu. The unselected layers become selected, and the selected layers are 
deselected.

▶

The lines you’ll draw on 
the A-AREA-NPLT layer 
will be used for refer-
ence and not plotted 
in your final plans. This 
is why we’re using the 
NCS code NPLT, which 
stands for No Plot.
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 4. Make sure that the Endpoint osnap is running.

 5. Draw a closed polyline around the inside of each room. To delineate 
the kitchen from the living room, use the left edge of the large win-
dow near the closet as the right edge of the kitchen, and use the 
bathroom wall as the lower limit.

 6. Draw a polyline around each of the decks by using the Perpendicular 
object snap to draw the segments through the posts on the decks’ 
outside corners.

Your cabin should be divided as shown in Figure 9.21.

F I G u R E   9 . 2 1 :   Divide the cabin into five distinct sections by using closed 
polylines.

 7. Save your drawing as I09-07-AreaBoundary.dwg (M09-07-
AreaBoundary.dwg).

Now that the perimeter lines are drawn, you need to calculate the area bound 
by them:

 1. Make sure I09-07-AreaBoundary.dwg (M09-07-AreaBoundary.dwg) 
is open.

 2. Turn on Selection Cycling from the status bar. If the Selection 
Cycling button does not appear in the status bar, click the Customize 
button on the status bar, and then select Selection Cycling from the 
menu that opens.

Selection cycling will help you select the polylines you just drew 
when they overlap other lines in the drawing.
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 3. From the Home tab ➢ Utilities panel, click the down arrow under the 
Measure button, and then select the Area option, as shown in Figure 9.22.

F I G u R E   9 . 2 2 :   Starting the Measure ➢ Area command

 4. Choose the Object option at the Specify first corner point or 
[Object/Add area/Subtract area/eXit]: prompt to switch to 
Object mode and then select the bathroom polyline.

If the Selection dialog box opens after you’ve made your selection, hover 
over each of the objects displayed in the list until you find the polyline 
along the perimeter of the bathroom that highlights (see Figure 9.23).

F I G u R E   9 . 2 3 :   Using Selection Cycling to select the polyline along the 
bathroom’s perimeter
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 5. The area of the polyline turns green in the drawing area. Press the F2 
key to open the AutoCAD text window.

The text window displays the results of your calculation: Area = 
7176.00 square in. (49.8333 square ft.), Perimeter = 28'-
4". (Area = 4455000, Perimeter = 8460). You’ll also notice that 
you’re not actually in the AREA command; you’re in the Area option 
of the MEASUREGEOM (Measure Geometry) command. This command 
combines many of the older inquiry commands such as AREA and 
DISTANCE into a single command.

 6. Write down the area in square feet (square millimeters) to check 
against the number calculated in the next section.

 7. Press ↵ to restart the Area option.

 8. Enter O↵, and then click the kitchen polyline.
The area should be 135.9792 square feet (12660810). Write down 

this number. (You can round it to two decimal places; you just want 
to be able to verify the numbers that AutoCAD will calculate.)

 9. Repeat this process for the living room, where the area should be 
278.3542 square feet (26201990).

 10. Write down 278.35 (26201990).

 11. Repeat this process one last time for the front and back decks. The 
areas should be 135.63 square feet (12648636) and 65.63 square feet 
(6126516), respectively.

 12. Thaw all the layers except A-ANNO-TTLB and A-ANNO-TTLB-TEXT, 
and make the A-ANNO-TEXT layer current.

n o t E  The Add and Subtrac t options in the Area prompt allow you to add 
together areas you have calculated and to subtract areas from each other. If you’re going 
to add or subtract areas, enter A↵ after you start the AREA command. Then, after each 
calculation, you’ll be given the Add and Subtract options. If you don’t enter A  at the 
beginning, you can make only one calculation at a time.

To use the Properties palette to calculate an area, select the polyline to be 
measured, open the Properties palette, and then scroll down to the Area readout 
in the Geometry rollout. The area appears in square inches and square feet. This 
also works for hatch patterns, which are covered in Chapter 11.
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Inserting the Room Information Block
You have five areas calculated and recorded, and you are ready to insert the 
A-ROOM-IDEN block. When you inserted the grid symbols as blocks with attri-
butes earlier in this chapter, the prompts for the attribute text appeared in the 
command-line interface. With multiple attributes in a block, it’s more conve-
nient to display all the prompts in a dialog box. Let’s change the setting that 
makes the dialog box replace the command prompts:

 1. Continue using I09-07-AreaBoundary.dwg (M09-07-AreaBoundary.dwg), 
or open it if it’s not already open.

 2. Set the Node osnap to be the only one running, and make sure the 
Object Snap button is turned on. The Node osnap snaps the cursor to 
a point object.

 3. If it’s not already set, change your annotation scale to 1⁄4″ = 1′-0″ 
(1:50) from the status bar.

 4. Click the Insert button from the Insert tab ➢ Block panel, and 
choose the A-ROOM-IDEN block from the gallery.

 5. Select the point object that marks the justification point for the LIVING 
ROOM label text to open the Edit Attributes dialog box (see Figure 9.24).

F I G u R E   9 . 2 4 :   The Edit Attributes dialog box

 6. The only change you need to make is the value for Area Of Room. The 
defaults are correct for the other two items.
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Rather than inputting text, you’ll instruct the attribute to read the 
Area parameter from the polyline.

 7. Press the Tab key to highlight the Area Of Room box, right-click, and 
choose Insert Field from the context menu, as shown in Figure 9.25.

F I G u R E   9 . 2 5 :   Inserting a field as an attribute

 8. The Field dialog box opens. In the Field Names column, choose 
Object and click the Select Object button (see Figure 9.26).

F I G u R E   9 . 2 6 :   Choose Object from the Field Names list, and click the Select 
Object button in the Field dialog box.
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The dialog box closes so that you can pick the object that the field 
will reference.

 9. Select the polyline that follows the perimeter of the living room.
The Field dialog box reopens with additional content in its list boxes.

 10. Select Area in the Property column, Architectural (Decimal) in the 
Format column, and 0.00 in the Precision drop-down list.

The correct area measurement appears in the top-right corner of 
the dialog box (see Figure 9.27).

1

2

4

3

F I G u R E   9 . 2 7 :   The Field dialog box after selecting the polyline and choosing 
the property and format

If you’re working in Architectural units, you can skip to step 16. If 
you’re working in metric units, continue with the next step.

Notice the value in the Preview window in the top-right corner of 
the dialog box. The number is much too large to be defining the area 
of the living room in square meters; instead, it’s showing the area in 
square millimeters. Therefore, you need to multiply the value by a 
conversion factor to display the correct number.
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 11. Click the Additional Format button to open the Additional Format 
dialog box.

One square meter equals 1,000,000 square millimeters (1000 × 1000), 
so each square millimeter is 1/1,000,000 of a square meter.

 12. To figure out the conversion factor needed to convert square inches 
into square feet, divide 1 by 1,000,000 and you’ll come up with 
0.000001.

 13. Enter 0.000001 in the Conversion Factor field.

 14. To identify the units, enter M2 in the Suffix field.
Be sure to place a space prior to the M to ensure a gap between the 

suffix and the calculated area. Your Additional Format dialog box 
should look like Figure 9.28.

F I G u R E   9 . 2 8 :   The Additional Format dialog box

 15. Click OK to close the Additional Format dialog box.
Note that the Preview section in the Field dialog box now shows 

the correct value of 26.18 M2, as you can see in Figure 9.29.
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F I G u R E   9 . 2 9 :   The Field dialog box after changing the values in the 
Additional Format dialog box

 16. Click OK to close the Field dialog box and return to the Edit 
Attributes dialog box.

The Area Of Room value is now shown with a gray background, as 
you can see in Figure 9.30, to identify it as a field rather than a text 
element.

F I G u R E   9 . 3 0 :   The Edit Attributes dialog box with a field for the Area Of 
Room value
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 17. Click OK to insert the A-ROOM-IDEN block into the drawing in the 
living room.

The room label is the only visible attribute (see Figure 9.31). You 
set the other two attributes to be invisible.

F I G u R E   9 . 3 1 :   The first A-ROOM-INFO block is inserted.

 18. Save your drawing as I09-08-InsertInfoBlock.dwg (M09-08-
InsertInfoBlock.dwg).

Editing Attributes
The remaining four block insertions are almost identical to the first one, with 
just a few modifications: changing the room name and referencing a different 
polyline. Follow these steps to copy and modify the block and attributes that 
you’ve created:

 1. Make sure I09-08-InsertInfoBlock.dwg (M09-08-InsertInfoBlock 
.dwg) is open.

 2. Select the LIVING ROOM attribute and, using the Node osnap, copy 
it to the node at the insertion point for the BATH text.

 3. Double-click the new attribute to open the Enhanced Attribute 
Editor dialog box, and select the RM_AREA row, as shown in 
Figure 9.32.
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F I G u R E   9 . 3 2 :   Select the RM_AREA row in the Enhanced Attribute Editor.

 4. Double-click the 278.35 SQ. FT. (26.18 M2) value with the gray back-
ground at the bottom of the dialog box to open the Field dialog box, 
where you can edit the preferences and references.

 5. In the Field dialog box, click the Select Object button near the Object 
Type field.

Both dialog boxes disappear, and the cursor turns into a pickbox.

 6. Select the polyline that follows the perimeter of the bathroom.
If you’re using metric units, do the following:

 a. Click the Additional Format button when the Field dialog box 
reappears.

 b. Repeat steps 14 to 16 from the previous exercise.

 7. Click OK to close the Field dialog box, and return to the Enhanced 
Attribute Editor dialog box.

 8. Select the RM_NAME row.

 9. At the bottom of the dialog box, highlight LIVING ROOM and enter 
BATH to replace the text.

 10. Change the floor material to Tile.

 11. Click OK to close the dialog box.
The revised BATH attribute is now properly placed in the drawing.

 12. Repeat steps 2 through 11, substituting KITCHEN, FRONT DECK, 
and BACK DECK for the room name attribute and selecting the 
appropriate polyline as a reference for each block.
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There are no node point objects for the deck text, so you can just 
rotate and place the attribute a little left of center on the appropri-
ate deck. For the decks, change the floor material to Cedar Planks. 
Metric users will need to open the Additional Format dialog box for 
each block and add the conversion factor and suffix for each block. 
When you are finished, your cabin should look like Figure 9.33.

F I G u R E   9 . 3 3 :   All A-ROOM-IDEN blocks inserted

 13. Save your drawing as I09-09-EditRoomAttributes.dwg (M09-09-
EditRoomAttributes.dwg).

Editing tools for Attributes

The attribute-editing tools seem complicated at first because their names are 
similar, but they are easily distinguishable once you get used to them and know 
how to use them. Here are the descriptions of five attribute-editing tools.

the Edit Attributes Dialog Box

This is the same dialog box displayed in the process of inserting a block that has 
attributes, when the ATTDIA setting is set to its default value of 1. This dialog 
box is used to change attribute values only. Enter ATTEDIT↵ to use it to edit 
values of attributes already in your drawing. You will be prompted to select a 
block reference in your drawing. When you do that, the Edit Attributes dialog 
box appears.

(Continues)
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the Enhanced Attribute Editor Dialog Box

With this dialog box, you can edit values and the properties of the attribute text—
such as color, layer, text style, and so on. When you enter EATTEDIT↵ or click 
Modify ➢ Object ➢ Attribute ➢ Single or click the Edit Attribute (Single) button 
in the Block panel on the Insert tab and then pick a block that has attributes, the 
dialog box opens. Double-clicking the block has the same effect.

the Properties Palette

Use the Properties palette to edit most properties of attribute definitions. Select 
the attribute definition; then right-click and choose Properties to open the 
Properties palette. Then scroll down to the Attributes rollout.

the Block Attribute Manager

Click the Attribute, Block Attribute Manager… button in the expanded Block panel 
on the Home tab, or enter BATTMAN at the command line to open the Block Attribute 
Manager dialog box. There you can select a block and edit the various parts of each 
attribute definition that the block contains, such as the tag, prompt, and value.

the –AttEDIt Command

You can also edit more than one attribute at a time by clicking Edit Attributes 
(Multiple) from the Attributes panel of the Insert tab, by choosing Modify ➢ 
Object ➢ Attribute ➢ Global, or by entering -ATTEDIT↵. The prompt reads 
Edit attributes one at a time? [Yes/No] <Y>. If you accept the 
default of Yes, you’re taken through a series of options for selecting attributes to 
edit. Select the attributes to edit, and then press ↵ to end the selection process. 
A large X appears at the insertion point of one of the selected attributes. At this 
point, you get the following prompt: Enter an option [Value/Position/
Height/Angle/Style/Layer/Color/Next] <N>:, allowing you to modify 
any of the characteristics listed in the prompt for the attribute with the X. Press 
↵ to move to the next selected attribute.

If you respond to the first prompt with No, you’re taken through a similar set of 
selection options. You’re then asked to enter a current value to be changed and 
to enter the new value after the change. You can change the values of attributes 
globally by using the ATTEDIT command this way.

Editing tools for Attributes (Continued)
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Controlling the Visibility of Attributes
The floor plan looks the same as it did at the beginning of this exercise, except for the 
addition of the deck labels. But it includes more than meets the eye. What was regu-
lar text is now an attribute, and your drawing is “smarter” than it was before. The 
next few steps illustrate the display controls for the visible and invisible attributes:

 1. Make sure I09-09-EditRoomAttributes.dwg (M09-09-
EditRoomAttributes.dwg) is open.

 2. On the Insert tab ➢ Expanded Block panel, click the down arrow 
next to the Retain Attribute Display button, and click Display All 
Attributes, as shown in Figure 9.34.

F I G u R E   9 . 3 4 :   Selecting the Display All Attributes option

All the attributes, including those designated as invisible, appear 
with the room labels (see Figure 9.35).

F I G u R E   9 . 3 5 :   The floor plan with all attributes displayed
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n o t E  Like the hyperlink you added to the notes in Chapter 8, the f ields are 
shown with a gray background, but this background does not appear in the printed 
drawings. As you can see, one of the benefits of using attributes over simple text is the 
ability to control their visibility. However, their true strength is the ability to output 
attribute values to spreadsheets or databases. When you use fields and formulas (cov-
ered in the “Creating a Table” section later in this chapter), the attribute can adjust its 
values as the circumstances change, as shown in Figure 9.35.

 3. Start the STRETCH command, and drag a crossing window to enclose 
part of the front deck, as shown in Figure 9.36.

F I G u R E   9 . 3 6 :   Select part of the front deck with the STRETCH command.

 4. Pick any location in the drawing area as the base point, move the 
cursor to the right, and then click to stretch the deck, as shown in 
Figure 9.37. Use Ortho mode or Polar Tracking to stretch the objects 
directly to the right.

The deck is now larger, but the attribute indicating the area remains 
at its previous value. Attributes need to be instructed to reevaluate or 
regenerate themselves. This can happen whenever a drawing is opened 
or when the REGEN or REGENALL commands are issued.
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F I G u R E   9 . 3 7 :   The front deck after stretching it to the right

 5. The REGEN and REGENALL commands are not included in the Ribbon 
interface and must be executed at the command line. Enter REA↵ to 
regenerate and update the display of your block attributes.

The area updates to show the true value for the associated polyline 
(see Figure 9.38).

F I G u R E   9 . 3 8 :   The front deck after the REGENALL command is issued

◀

The default com-
mand alias for the 
REGENALL com-
mand is REA. For the 
REGEN command, the 
default alias is RE.
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 6. You don’t want the deck at this larger size, so click the Undo button 
in the Quick Access toolbar, or press U↵ until your drawing is in the 
state it was just before the STRETCH command was executed.

The visibility of the attributes, as you defined them in the Attribute 
Definition dialog box, is called their normal state.

 7. To return the attribute visibility to this state, click the down arrow 
next to the Display All Attributes button on the expanded Block panel 
within the Insert tab, and then click Retain Attribute Display (see 
Figure 9.39).

F I G u R E   9 . 3 9 :   Returning the attribute display to normal

All the attributes return to their normal state (see Figure 9.40).

F I G u R E   9 . 4 0 :   All the attributes in their normal state
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The Display All Attributes and Hide All Attributes options make all attributes 
in a drawing visible or invisible, regardless of how you set the Visible/Invisible 
mode in the attribute definition. The Normal setting allows an attribute to be 
displayed only if the Visible/Invisible mode was set to Visible in the definition.

Exploring other uses for Attributes
Beyond the grid symbols and room label examples you created in the preced-
ing exercises, attributes are a versatile tool for organizing data within your 
drawings. Interior designers might use attributes to collect information about 
individual pieces of furniture; facilities management professionals might use 
attributes to track occupancy of rooms throughout a building; and engineers 
might use attributes to track information about equipment in their designs. 
Attributes are a great choice whenever you need to collect tabular data, other-
wise known as text, for items in your drawings.

In the next section, you’ll go through an exercise that demonstrates how you 
can create dynamic blocks that vary their appearance based on user input.

Creating a Dynamic Block
In Chapter 7, you created blocks for the windows and doors. However, because 
of the door block’s schematic appearance, you were not able to scale it as you 
did with the window block. Scaling the door and swing would have allowed one 
door block to fit into any size opening, but it would have also scaled the thick-
ness of the door differently for each door width. Dynamic blocks are standard 
blocks with additional functionality to allow certain features to change without 
affecting all objects in the block. The door blocks are an excellent opportunity to 
explore the abilities of dynamic blocks in AutoCAD.

The basic procedure for setting up a dynamic block has the following stages:

 1. Create the block by using the BLOCK command.

 2. Right-click the block and choose Block Editor.

 3. Click a parameter, and follow the command prompts to create the 
parameter.

 4. Click the Actions tab and click an action to associate with the 
parameter.

www.MouradEngineering.com



5 0 8 	 C h a p t e r 	 9 	 • 	 U s i n g 	D y n am i c 	 B l o c k s 	 a n d 	 Ta b l e s

 5. Follow the command prompts to set up the action.

 6. Use the Properties palette to rename and specify settings for the 
parameter and any actions associated with it.

 7. Save your work back to the block definition, and close the Block 
Editor.

You’ll work through this process by converting the A-DOOR-36IN 
(A-DOOR-0915) block from your cabin drawing into a dynamic block in a new 
drawing. Follow these steps to begin converting the door blocks:

 1. With I09-09-EditRoomAttributes.dwg (M09-09-
EditRoomAttributes.dwg) as the current drawing, zoom in to the 
floor plan at the back of the cabin.

 2. Right-click in a blank area of your drawing and select Clipboard ➢ 
Copy With Basepoint from the context menu that appears.

The command line changes to Specify base point:.

 3. Use the Insert osnap to select the insertion point of the back door 
block as the base point.

 4. Select the back door block and press ↵.
This copies the door block to the Windows Clipboard.

 5. Start a new drawing. Change the Length units to Architectural 
(Decimal), verifying that Insertion Scale is set to Inches (Millimeters).

 6. From the Home tab ➢ Clipboard panel, choose the Paste tool and, 
when prompted to specify the base point, enter 0,0↵.

The A-DOOR-36IN (A-DOOR-0915) block is inserted into your new 
drawing. Perform a Zoom Extents to bring the entire block into view.

 7. Save your new drawing containing the A-DOOR-36IN (A-DOOR-0915) 
block as I09-10-DynamicBlock.dwg (M09-10-DynamicBlock.dwg).

 8. Select the door block, right-click, and choose Block Editor from the 
context menu.

The drawing area turns gray, and the Block Authoring palettes 
open along with the Block Editor contextual tab to indicate that you 
are in the Block Editor.
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 9. Pan the view, and adjust the Block Authoring palettes so that your 
screen looks similar to Figure 9.41.

F I G u R E   9 . 4 1 :   The door block in the Block Editor

You want to be able to use this door block for openings of the following 
widths: 2′-0″, 2′-6″, 3′-0″, and 3′-6″ (609 mm, 762 mm, 915 mm, and 1068 mm).

Setting up Parameters and Actions
You’ll use the Linear parameter to set up the 6″ (153 mm) increments for the 
door width. Then you’ll associate a Stretch action with that parameter to allow 
the door width to change, and you’ll associate a Scale action to allow the door 
swing to change. Follow these steps:

 1. Make sure I09-10-DynamicBlock.dwg (M09-10-DynamicBlock.dwg) is 
open.

 2. Make sure Parameters is the active palette in the Block Authoring 
Palettes panel, and then click the Linear Parameter icon (see 
Figure 9.42).

www.MouradEngineering.com



5 1 0 	 C h a p t e r 	 9 	 • 	 U s i n g 	D y n am i c 	 B l o c k s 	 a n d 	 Ta b l e s

F I G u R E   9 . 4 2 :   The Linear parameter in the Block Authoring Palettes panel

 3. Make sure the Endpoint osnap is running.

 4. Click the lower-left corner of the door, and then click the open end-
point of the door swing.

 5. Move the cursor to position the dimension symbol a little to the left 
of the door block, and then click to place it (see Figure 9.43).

F I G u R E   9 . 4 3 :   The Linear parameter is placed.
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For the Distance parameter to work, it must be paired with a Dynamic Block 
action. Note the small exclamation symbol on a square yellow background. This 
reminds you that no action has been associated with this parameter. You’ll set 
up the Stretch action first:

 1. Click the Actions tab on the Block Authoring Palettes palette set, and 
then click the Stretch icon.

 2. Select the Distance parameter (Distance1) to the left of the door, and 
then click the up arrow at the end of the door swing (see Figure 9.44).

F I G u R E   9 . 4 4 :   Selecting the Distance parameter (top) and picking the linear 
grip (bottom)
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 3. At the Specify opposite corner of stretch frame or 
[CPolygon]: prompt (see the top of Figure 9.45), form a crossing 
polygon around the right half of the door, clicking each of the oppos-
ing corners rather than clicking and dragging, as shown at the bot-
tom of Figure 9.45.

F I G u R E   9 . 4 5 :   Defining the stretch frame (top) and selecting the door objects 
(bottom)

 4. At the Select objects: prompt, select the door and then press ↵.
The Stretch Action icon appears near the end of the door swing 

(see Figure 9.46).
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F I G u R E   9 . 4 6 :   The A-DOOR-36IN block with the Stretch and Scale actions 
assigned to the Distance parameter

 5. Click the Scale Action icon on the Actions palette.
The Scale Action icon appears next to the Stretch Action icon, as 

shown in Figure 9.46.

 6. Select the Distance (Distance1) parameter again, select the arc, and 
then press ↵.

 7. Minimize the Block Authoring palettes.

 8. Save your drawing as I09-11-ParametersActions.dwg (M09-11-
ParametersActions.dwg).

This completes your work with the Block Authoring Palettes panel. You’ll 
accomplish the rest of the tasks with the Properties palette.

Fine-tuning the Dynamic Block with the 
Properties Palette
The Distance Linear parameter shows the width of the opening and is perpen-
dicular to the door’s width. You need to set up an offset angle so that the door 

www.MouradEngineering.com



5 1 4 	 C h a p t e r 	 9 	 • 	 U s i n g 	D y n am i c 	 B l o c k s 	 a n d 	 Ta b l e s

width changes as the opening width changes. Then you need to set up the incre-
mental widths and rename the parameter and actions. You’ll set up the incre-
ments first:

 1. Make sure I09-11-ParametersActions.dwg (M09-11-
ParametersActions.dwg) is open.

 2. Select the Distance parameter and then open the Properties palette.

 3. In the Property Labels section on the palette, change Distance Name 
from Distance1 to Door Opening.

 4. Scroll down to the Value Set section and click the Dist Type text box, 
which reads None.

 5. Open the drop-down list and select Increment.

 6. Moving down line by line in the Properties palette, set the following 
values:

▶▶ Dist Increment to 6″ (153)

▶▶ Dist Minimum to 2′ (609)

▶▶ Dist Maximum to 3′-6″ (1068)
See Figure 9.47.

F I G u R E   9 . 4 7 :   Change the parameters in the Properties dialog box.
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 7. Deselect the Distance parameter.
The block now has the increment markers for the door-opening 

widths (see Figure 9.48).

Increment Markers

F I G u R E   9 . 4 8 :   Dynamic door block with increment markers for the opening 
widths

Now, the final task is to fine-tune the Stretch and Scale actions that control 
the door size and swing:

 1. Click the Stretch Action symbol near the end of the door swing.
The symbol, the Distance parameter, and the window you drew 

earlier dim.

 2. In the Properties palette, scroll down to the Overrides section; for 
Angle Offset, enter 270↵.

This is the direction the door will stretch relative to movement of 
the open end of the door swing arc. The Distance multiplier stays at 
1.0000 because you don’t want the width of the door to change in the 
same proportion as the width of the opening.

 3. In the Misc section, change Action Name from Stretch to Door Size.

 4. Deselect this action, and select the Scale action.

 5. In the Misc section of the Properties palette, change Action Name 
from Scale to Door Swing Size.
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 6. Click the Test Block button on the Block Editor contextual tab ➢ 
Open/Save panel.

A new window opens with the block displayed in the drawing area, 
the Block Editor contextual tab disappears, and the contextual Close 
panel (green background) opens on the far-right side of the Ribbon.

 7. Select the block, and then use the light-blue arrow to test the 
Distance parameter you added to the A-DOOR-36IN (A-DOOR-0915) 
block, as shown in Figure 9.49.

F I G u R E   9 . 4 9 :   Using Test Block to verify the functionality of the Distance 
parameter

 8. After testing the block, click the Close Test Block Window button on 
the contextual Close panel found to the right of any Ribbon tab.

 9. Close the Properties palette, and click the Save Block button in the 
Open/Save panel under the Block Editor contextual tab.

 10. Click the Close Block Editor button at the right end of the Ribbon to 
return to the drawing.

Because the A-DOOR-36IN (A-DOOR-0915) block is now dynamic 
and able to illustrate doors ranging in size, let’s give the block a more 
appropriate name.

 11. Enter RENAME at the command line to open the Rename dialog box 
shown in Figure 9.50.

www.MouradEngineering.com



	 C r e a t i n g 	 a 	D y n am i c 	 B l o c k  5 1 7

1 2

3

F I G u R E   9 . 5 0 :   Renaming the A-DOOR-36IN (A-DOOR-0915) block to A-DOOR by 
using the RENAME command

 12. Select Blocks under the Named Objects group in the Rename dialog box.

 13. Select the A-DOOR-36IN (A-DOOR-0915) block in the Items list, and 
enter A-DOOR in the Rename To text box, as shown in Figure 9.50.

 14. Click OK after entering the new A-DOOR name.

 15. Save the drawing as I09-DynDoor.dwg (M09-DynDoor.dwg) in the 
same folder as your other Chapter 9 drawings, and then close the 
drawing.

Inserting a Dynamic Block
When you use this block in your floor plans, insert it just as you would a regular 
door block. Then copy it to the various doorway openings in the plan, orient it, 
and adjust its size to fit the openings. You can easily edit dynamic blocks, which 
are a versatile feature to have at your disposal.

You’ll use the dynamic door block that you just created to replace the doors in 
your cabin:

 1. In the I09-09-EditRoomAttributes.dwg (M09-09-EditRoomAttributes 
.dwg) drawing, delete the two existing swing doors.

 2. Make the A-DOOR layer current, and then freeze the A-ANNO-TEXT, 
A-AREA-NPLT, A-GRID, A-ROOF, A-WALL-HEAD, and A-FLOR-FIXT 
layers.
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Your drawing should look like Figure 9.51.

F I G u R E   9 . 5 1 :   The cabin drawing with most of the layers frozen and the doors 
deleted

You will use the A-DOOR block you defined in the I09-DynDoor 
(M09-DynDoor) drawing. Because this block will take the place of both 
the A-DOOR-36IN (A-DOOR-0915) and A-DOOR-30IN (A-DOOR-0762) 
blocks, it’s best to remove both from the I09-09-EditRoomAttributes 
(M09-09-EditRoomAttributes) drawing. Spending a moment to per-
form some drawing maintenance and clean out unneeded objects will 
help achieve the best drawing performance. You will delete the block 
definition by using the Purge dialog box.

 3. From the Application menu, choose Drawing Utilities ➢ Purge, or 
enter PURGE↵ to open the Purge dialog box.

 4. Click the plus sign (+) to expand the Blocks entry to display the two 
door blocks (see Figure 9.52).

 5. Select the Blocks entry, check the Purge Nested Items option, and 
make sure Confirm Each Object To Be Purged is unchecked.

 6. Click the Purge button and then close the dialog box.
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F I G u R E   9 . 5 2 :   Deleting the block references with the Purge dialog box

t I P  You can purge only those objects and features that do not exist in the draw-
ing, such as deleted blocks, empty layers, or linetypes that are not used. Some items, 
including layer 0 and the Standard text style, can’t be purged. AutoCAD can also accumu-
late registered applications (regapps), usually from third-party applications or features 
no longer used in the current drawing and geometry lines with a length of 0. To eliminate 
them, you must enter -PURGE↵ to start the PURGE command without the dialog box 
and then choose the Regapps (R↵) option. The All option (A↵) will not purge these types 
of objects. Run PURGE often to eliminate accumulated junk in your drawing that con-
tributes to larger file sizes and slower performance.

 7. With the Endpoint osnap and Polar Tracking running, click the 
DesignCenter button on the View tab ➢ Palettes panel.

 8. Click the Folders tab in the AutoCAD DesignCenter™ palette that 
opens.
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 9. Use the folder tree to browse to the I09-DynDoor.dwg (M09-DynDoor 
.dwg) drawing you just saved in your dataset directory.

The I09-DynDoor.dwg (M09-DynDoor.dwg) file can also be found in 
the Chapter 9 download on this book’s web page at www.sybex.com/
go/autocad2015ner or www.thecadgeek.com.

 10. Expand the I09-DynDoor (M09-DynDoor) drawing inside the 
DesignCenter palette to select the Blocks option.

 11. Right-click the A-DOOR block and select Insert Block (see Figure 9.53).

F I G u R E   9 . 5 3 :   Using DesignCenter to insert the dynamic A-DOOR block

The Insert dialog box opens, where you can specify how you would 
like the A-DOOR block inserted into your drawing.

 12. Verify that the only check box selected in the Insert dialog box is the 
Specify On-Screen check box under the Insertion Point group, and 
click OK.

The A-DOOR dynamic door block appears, attached to the cursor.

 13. Click the lower-right corner of the back door opening to insert the 
block.

This is a 3′-0″ (915 mm) door opening, so you don’t need to modify 
the block.

 14. Press ↵ to restart the INSERT command.
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 15. In the Insert dialog box, select the Specify On-Screen options under 
Rotation. Then enter the following values:

 a. Enter -1 for the X scale.

 b. Enter 1 for the Y and Z scales.

 16. Click the lower-right corner of the bathroom opening to place the door.

 17. Using Polar Tracking, move your cursor to rotate the door as shown 
in Figure 9.54.

F I G u R E   9 . 5 4 :   The door must be resized to fit.

The door is placed properly, but as shown in Figure 9.54, the 
default size is too large for the opening.

 18. Close DesignCenter if it’s still open, and select the bathroom door 
block to reveal the blue dynamic arrows (see Figure 9.55).
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F I G u R E   9 . 5 5 :   The dynamic block’s resizing arrows

 19. Select the left arrow and drag it up to the corner of the opening. 
Notice how the length of the door changes as well (see Figure 9.56).

F I G u R E   9 . 5 6 :   Resizing the dynamic block
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 20. Click to set the door size, and then press Esc to deselect the door.
The door block is scaled properly with no distortion to the width of 

the door itself (see Figure 9.57).

F I G u R E   9 . 5 7 :   The dynamic door block scaled to fit the 2′-6″ (762 mm) door 
opening

 21. Save your drawing as I09-12-InsertDynBlock.dwg (M09-12-
InsertDynBlock.dwg).

This completes the section on dynamic blocks. If you want to experiment with 
the dynamic block feature, examine the sample dynamic blocks to see how they 
work and are set up, and try to create one of your own. The next section covers 
the methods for creating a table.
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Creating a table
Most professions that use AutoCAD use tables to consolidate and display data 
in organized formats. Architectural construction documents usually include at 
least three basic tables: door, window, and room finish schedules. These are usu-
ally drawn in table form, and they display the various construction and material 
specifications for each door or window type or for each room. In mechanical 
drawings, the bill of materials and other specifications can be found in tables. 
To see how the AutoCAD tools for creating tables work, you’ll construct a simple 
door schedule for the cabin.

You create tables in AutoCAD by first creating a table style and then creating a 
table using that style. This process is similar to that of defining a text style and 
then inserting text in a drawing using that style.

Defining a table Style
Table styles are more complex than text styles. They include parameters for the 
width and height of rows and columns and, among other elements, at least one 
text style. Follow these steps to define a table style:

 1. Make I09-12-InsertDynBlock.dwg (M09-12-InsertDynBlock.dwg) 
the current drawing if it isn’t already.

 2. Create a new layer called A-ANNO-TABL, assign it color 62, and 
make it the current layer.

 3. Click the Annotate tab. Then click the small arrow in the Tables 
panel’s title bar to open the Table Style dialog box (see Figure 9.58).

F I G u R E   9 . 5 8 :   The Table Style dialog box
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On the left is the Styles list box. It displays all of the defined table 
styles. To the right of that is a Preview Of window that displays the 
current table style—in this case, the Standard style because it’s the 
only one defined so far. Below the Styles list box is a drop-down list 
called List that gives you options for which table styles to display. To 
the right of the preview window are four buttons.

 4. Click the New button to open the Create New Table Style dialog box.

 5. In the New Style Name text box, enter Schedule, as shown in Figure 9.59, 
to create a new table style name, and then click Continue.

F I G u R E   9 . 5 9 :   Naming the new table style

The New Table Style dialog box opens with Schedule in the title 
bar (see Figure 9.60). The new style you’re defining will be like the 
Standard style with the changes you make here. The drop-down list 
in the Cell Styles section contains the three parts of the sample table 
at the bottom-right corner of the dialog box: Data, Header, and Title.

F I G u R E   9 . 6 0 :   The New Table Style dialog box
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You can specify text and line characteristics for each of the three 
parts. Be sure the Data option is active in the Cell Styles group.

t I P  Not only can each table have its own style, but each cell can have a distinct 
style as well. By using the Launches The Create A New Cell Style Dialog Box and Launches 
The Manage Cell Styles Dialog Box buttons in the top-right corner of the New Table Style 
dialog box, you can design and apply any number of cell styles within a table.

 6. Click the Text tab, and then click the Text Style ellipsis button to the 
right of the Text Style drop-down list to open the Text Style dialog box.

You want a new text style for the door schedule.

 7. Define a new style called A-Tabl, and use the Arial font and a 0′-0″ (0) 
height.

A Height value here allows you to control the height in the New 
Table Style dialog box.

 8. Click Apply and then click Close.
The table style now appears in the Text Style drop-down list, and 

the data cells in the two preview windows now show the Arial font.

 9. Set Text Height to 6″ (152). Leave Text Color and Text Angle at their 
default settings.

 10. Switch to the General tab, and click the ellipsis button at the end of 
the Format row. In the Table Cell Format dialog box, change Data 
Type to Text and change Format to (None), as shown in Figure 9.61. 
Then click OK.

F I G u R E   9 . 6 1 :   Changing the data format in the Table Cell Format dialog box
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The selected data type prevents numeric data from justifying to the 
right, rather than following the specified Middle Center option.

 11. Change Alignment to Middle Center. The General tab should look like 
Figure 9.62.

F I G u R E   9 . 6 2 :   The General tab of the New Table Style dialog box

 12. In the Cell Styles drop-down list at the top of the dialog box, choose 
Header to expose its parameters.

 13. In the Text tab, choose the same text style (A-Tabl) and set the 
height to 9″ (229).

 14. Choose Title from the Cell Styles drop-down list.

 15. Select the A-TABL text style again, and set the height to 12″ (305).

 16. In the General tab, set the Horizontal and Vertical Margins to 4″ (102).
You’ll leave the Border properties at their default settings. These 

control the visibility of the horizontal and vertical lines of the table, 
their lineweights, and their colors. Your profession or discipline 
might have its own standard for these parameters.

 17. In the General section, on the left side of the dialog box, make sure 
Table Direction is set to Down. Click OK to save the new table style.

 18. Back in the Table Style dialog box, in the Styles list, click Schedule to 
highlight it, and then click the Set Current button to make it the cur-
rent table style (see Figure 9.63). Click Close.
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F I G u R E   9 . 6 3 :   The Table Style dialog box with Door Schedule as the current 
table style

 19. Save your drawing as I09-13-TableStyle.dwg (M09-13-TableStyle.dwg).

Now let’s look at the geometry of the new table.

Designing a table
The parameters in the Schedule table style have set the height of the rows. 
You now need to determine the width of the columns and figure out how 
many columns and rows you need for the door schedule. You do this as you 
insert a new table. Remember that Schedule is the current table style. Follow 
these steps:

 1. Make sure I09-13-TableStyle.dwg (M09-13-TableStyle.dwg)  
is open.

 2. Zoom and pan so that you can see the area below the cabin.

 3. In the Annotate tab’s Tables panel, click the Table button to open the 
Insert Table dialog box (see Figure 9.64).

The table won’t fit 
inside the title block 
perimeter, but I’ll 
show you how to give 
it its own title block 
in Chapter 14, “Using 
Layouts to Set Up a 
Print.”

▶
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F I G u R E   9 . 6 4 :   The Insert Table dialog box

In the Table Style group, Schedule appears in the Table Style drop-
down list because it’s now the current table style. An abstract version 
of the table appears below, in the preview area.

 4. On the right side, click the Specify Window radio button if necessary.
You’ll make a window to define the extents of the table.

 5. Below, in the Column & Row Settings group, click the Columns and 
Row Height text boxes.

You need to define only the number of columns in the table. You 
won’t worry about the row height for now; it’s determined by the 
number of lines of text, and you’re using only one line of text.

 6. You’ll have six categories to describe the doors, so set the Columns 
box to 6.

Each column is initially set to the same width. You can adjust it later.

 7. Click OK.

 8. Back in the drawing, turn off Object Snap and Polar Tracking on the 
status bar.

 9. Click a point that is left of center and below the cabin.
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This establishes the upper-left corner of the new table, so make 
sure it’s below the extents of the title-block border.

 10. Drag the cursor across the drawing and down until the screen dis-
plays a table that has eight rows (six data rows, a header row, and a 
title row) and then release the mouse button (see Figure 9.65).

F I G u R E   9 . 6 5 :   The new table inserted in the drawing

The new table appears; its title bar has a flashing cursor and a 
light-gray background. The background above and to the left of the 
table is dark gray. The table’s columns are indicated by letters, and 
the rows are numbered. The Text Editor contextual tab and panels 
appear in the Ribbon.

 11. With Caps Lock on, enter DOOR SCHEDULE↵.
The cursor moves to the upper-left cell in the table. This is the row 

for the column headers.

 12. With Caps Lock on, enter SYM and press the Tab key to highlight the 
next column header to the right.

 13. Moving across the header row, do the following:

 a. Enter (in caps) NAME and press the Tab key.

 b. Enter H&W and press the Tab key.

 c. Enter TYPE and press the Tab key.

 d. Enter MATL and press the Tab key.

 e. Enter COST↵.
This completes the row of column heads (see the left side of 

Figure 9.66).
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F I G u R E   9 . 6 6 :   The table with its title and column heads (left), and the table 
partially filled in (right)

 14. Partially fill in the data for the door schedule that’s shown on the 
right in Figure 9.66 in the same manner.

n o t E  Pressing the Tab key instead of ↵ moves the activated cell left to right 
across each row and then down to the next row. Pressing ↵  moves the activated cell 
down each column and then ends the command. For the Glass and Aluminum material, 
don’t press ↵ to move to the next line; simply keep typing. The text wraps automatically, 
and the cell height changes to accommodate the additional lines of text.

 15. You don’t have to enter everything from scratch. It’s easy to copy the 
contents of one cell into other cells; just follow these steps:

 a. Enter Swinging in cell D4, and then highlight the text.

 b. Press Ctrl+C to copy the highlighted text to the Windows 
Clipboard.

 c. Deselect the current cell, and then select the cell below it by 
clicking in cell D5.

 d. Press Ctrl+V to paste the word Swinging into the selected cell.

 16. Complete the Type and Material columns, as shown in Figure 9.67.

A B C D E F

1

2
3
4
5
6
7
8

F I G u R E   9 . 6 7 :   The table with its text-based cells filled in
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 17. Save your drawing as I09-14-CreateTable.dwg (M09-14-
CreateTable.dwg).

Setting the Cell Style

If a cell justification doesn’t appear correctly or you want to change the style of a 
cell or range of cells, select the cells you want to change. In the Cell Styles panel 
under the Table Cell tab, expand the Cell Justification flyout button and choose 
the appropriate style.

Adding Formulas to a table
Currently, all the data cells are configured to hold text information and not 
numbers. You will now change the Cost column to read the information as 
numbers and then sum the values in the bottom cell with a formula:

 1. Make sure I09-14-CreateTable.dwg (M09-14-CreateTable.dwg) is 
open.

 2. Select all the cells below the Cost header in column F by clicking in 
cell F3, holding down the Shift key, and then clicking in cell F8.

 3. From the Cell Format panel on the contextual Table Cell Ribbon, 
choose Data Format ➢ Custom Table Cell Format.

 4. In the Table Cell Format dialog box that opens, choose Currency for 
Data Type.

 5. Choose 0.00 from the Precision drop-down list (see Figure 9.68).
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F I G u R E   9 . 6 8 :   Formatting the table cells

 6. If necessary, change the Symbol value to the symbol of your local 
currency.

 7. Click OK to close the dialog box.

 8. In the Cost column, enter the following:

▶▶ 350 for the front door

▶▶ 105 for the back door

▶▶ 85 for the bathroom door

▶▶ 65 for the closet door

AutoCAD automatically formats the numbers to two decimal places 
and adds a dollar sign to each, as shown in Figure 9.69.

F I G u R E   9 . 6 9 :   The Cost column filled in
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 9. Click in the empty cell at the bottom of the Cost column to select it.

 10. In the Insert panel, click the Formula button and then choose Sum, 
as shown in Figure 9.70.

F I G u R E   9 . 7 0 :   Adding a formula to the cell

As in a spreadsheet, a Sum formula adds the values of all the cells 
in a selected region.

 11. At the Select first corner of table cell range: prompt, click 
in cell F3 (the first door-cost cell).

 12. At the Select second corner of table cell range: prompt, click 
in cell F6 (the bottom door-cost cell).

 13. The formula "=SUM(F3:F6)" appears in cell F8. Click anywhere out-
side the table to deselect the cell and display its calculated value of 
$605.00, as shown in Figure 9.71.

F I G u R E   9 . 7 1 :   The completed table
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 14. Save your drawing as I09-15-TableFormula.dwg (M09-15-
TableFormula.dwg).

t I P  You would expect that the formatting previously assigned to the cell would 
carry through to the formula, but it doesn’t always. You might need to reformat indi-
vidual cells as required.

The table is finished, and now you just need to do a little cleanup in your 
drawing to avoid any problems in the future and to tie elements in the drawing 
back to the table. Follow these steps:

 1. Make sure I09-15-TableFormula.dwg (M09-15-TableFormula.dwg) 
is open.

 2. Thaw the A-ANNO-TEXT, A-ANNO-TTLB-TEXT, and A-ANNO-TTLB 
layers.

 3. Move your table as required so that it doesn’t overlap the notes or 
title block.

 4. Select one of the point objects you used to place the room name blocks, 
right-click, and choose Select Similar to select each of the points.

 5. Press the Delete key to remove the points from your drawing.
You need a symbol for each door that corresponds to each number 

in the SYM column.

 6. With the A-ANNO-TABL layer current, draw a circle with a radius 
of 6″ (175).

 7. Press the Single Line Text button in the Annotation panel under the 
Home tab.

 8. Right-click and choose the Justify option from the context menu.

 9. Choose the Middle option so that the text will be centered around the 
insertion point.

 10. Activate the Center osnap and then click the circle.

 11. Set the height to 6″ (175) and the rotation angle to 0.

 12. When the blinking cursor appears at the center of the circle, enter 
↵↵. The number 1 is centered in the circle.
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 13. Move the symbol near the front door, as shown in Figure 9.72, and 
then copy it to locations near the other three doors.

F I G u R E   9 . 7 2 :   The first door symbol placed by the front door

 14. Edit each of the symbol’s numbers so that they correspond to their 
entries in the SYM column.

Your drawing should look like Figure 9.73.

F I G u R E   9 . 7 3 :   The cabin with the door symbols added

 15. Thaw the A-GRID layer, and save this drawing as I09-16-DoorTags 
.dwg (M09-16-DoorTags.dwg).
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Creating tables from Attributes
Early in this chapter, you replaced your static room labels with more-versatile 
attribute blocks. The A-ROOM-IDEN attribute block you defined for your room 
labels contains three attributes: one set to a visible state and two set to an invis-
ible view state. As you may recall, the two invisible attributes allowed you to 
enter the area (RM_AREA) and floor material (RM_FLOOR) for each room.

Even though you cannot see either of these attributes in the drawing area, 
both are still accessible by other parts of the software. You can pull the values 
from all three attributes contained within the A-ROOM-IDEN block into a table 
by using the Data Extraction feature of the TABLE command. Using a data-
extraction table, AutoCAD will scan your drawing for every insertion of the 
A-ROOM-IDEN block and compile its data (attributes) into a table that will serve 
as your room schedule. Let me show you how:

 1. Continue using I09-16-DoorTags.dwg (M09-16-DoorTags.dwg), or 
open it if it isn’t already open.

 2. Start the TABLE command from the Annotate tab ➢ Tables panel to 
open the Insert Table dialog box.

 3. Select the From Object Data In The Drawing (Data Extraction) option 
in the Insert Options group of the Insert Table dialog box, as shown in 
Figure 9.74. Then click OK.

F I G u R E   9 . 7 4 :   Creating a new data-extraction table
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The Data Extraction Wizard opens. This eight-part wizard will walk 
you through the creation of a data-extraction table.

 4. From the Data Extraction - Begin (Page 1 of 8) screen, select the 
Create A New Data Extraction option and then click Next.

The Save Data Extraction As dialog box opens.

 5. Browse to your Chapter 9 Training Dataset folder in the Save Data 
Extraction As dialog box, enter I-RoomArea (M-RoomArea) in the 
File Name text box, and click Save.

The Save Data Extraction As dialog box closes, and you’re taken to 
the second step within the Data Extraction Wizard.

 6. Choose the Drawings/Sheet Set option.

 7. Check the Include Current Drawing check box in the Data Extraction 
- Define Data Source screen, and click Next.

t I P  Although in this case you’re extracting data only from the current drawing, 
data-extraction tables can pull information from multiple drawings all at once. This fea-
ture is useful when using data-extraction tables for quantity takeoffs, when each floor 
of a multilevel building is stored in a separate drawing.

Next, the Data Extraction Wizard asks you to specify the objects 
from which to extract data. In this case, you’re interested only in the 
data contained within the A-ROOM-IDEN block.

 8. Uncheck the Display All Object Types check box, and choose the 
Display Blocks Only option.

 9. Right-click one of the objects listed in the Objects group of the 
screen, and choose Uncheck All.

 10. Select the check box next to the A-ROOM-IDEN object.
The Data Extraction - Select Objects (Page 3 of 8) screen should 

look like Figure 9.75. After selecting the A-ROOM-IDEN block, click 
Next to move on to the next step of the wizard.
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F I G u R E   9 . 7 5 :   Selecting the A-ROOM-IDEN block in the Data Extraction Wizard

Next, you need to specify the attributes (properties) you want the 
data-extraction table to include. In this case, you’re interested in only 
the three block attributes contained within the A-ROOM-IDEN block.

 11. Click the Category header to sort the properties by category type.
This brings the Attributes category to the top of the list.

 12. Deselect the check boxes next to the RM-NAME, RM_AREA, and 
RM_FLOOR properties.

 13. Right-click in the list area and select Invert Selection.
This deselects all but the three block attributes contained within 

your room identification block.

 14. Double-click in the Display Name cell for the RM_NAME attribute 
and enter ROOM.

 15. Repeat the process in step 14 to enter AREA for the RM_AREA 
attribute and MATL for the RM_FLOOR attribute.

The Display Names will be used as the column headings in your table.
Verify that the Data Extraction - Select Properties (Page 4 of 8) 

screen looks like Figure 9.76, and click Next to continue.
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F I G u R E   9 . 7 6 :   Selecting the block attributes within the A-ROOM-IDEN block

You have now selected the data you want included in your data-
extraction table. The Refine Data portion of the Data Extraction 
Wizard will allow you to order the columns and to choose whether to 
include or exclude the block name and count.

 16. Deselect the Show Count Column and Show Name Column check 
boxes, as shown in Figure 9.77, and click Next to continue.

F I G u R E   9 . 7 7 :   Choosing the display and order of your data-extraction 
columns
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If you were further analyzing your data in a program such as 
Microsoft Excel, you could send the data extracted from your draw-
ing to an external XLS file.

 17. Because our goal is to create a room schedule, choose the Insert Data 
Extraction Table Into Drawing check box and click Next.

After you’ve chosen to insert the data-extraction table into your 
drawing, the Data Extraction Wizard will prompt you to select which 
table style you would like to use along with a title for your table.

 18. Verify that the Schedule table style is selected in the Table Style group 
of the screen, and then enter ROOM SCHEDULE in the Enter A Title 
For Your Table text box (see Figure 9.78). Click Next to continue.

F I G u R E   9 . 7 8 :   Picking the table style to be used and entering a title for the 
table

 19. You’ve finished the Data Extraction Wizard; click Finish.

 20. Use the cursor to choose a location for your ROOM SCHEDULE near 
the DOOR SCHEDULE you created earlier (see the top of Figure 9.79).
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F I G u R E   9 . 7 9 :   Placing the ROOM SCHEDULE table (top), and the results of the 
data extraction (bottom)

Your ROOM SCHEDULE inserts to display the block attribute val-
ues from the A-ROOM-IDEN block in table form (see the bottom of 
Figure 9.79).

 21. Save your drawing as I09-17-DataExtraction.dwg (M09-7-
DataExtraction.dwg).

Modifying the table Display
The ROOM SCHEDULE data extraction is now inserted into your drawing as 
an AutoCAD Table object. Although the correct table style is in use, its display 
needs to be tweaked. Follow these steps:

 1. Make sure I09-17-DataExtraction.dwg (M09-17-DataExtraction.dwg) 
is open.

 2. Open the Properties palette from the View tab ➢ Palettes palette, and 
select the ROOM SCHEDULE table.

 3. Change the Table Width property within the Table group to 20′ (6 m), 
as shown in Figure 9.80.
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F I G u R E   9 . 8 0 :   Adjusting the width of the ROOM SCHEDULE table

 4. Select the ROOM cell (A2), press and hold the Shift key, and select the 
lower-right cell C7, as shown in Figure 9.81.

F I G u R E   9 . 8 1 :   Selecting multiple table cells

 5. Under the Cell heading within the Properties panel, change the 
Vertical Cell Margin property to 2″ (50 mm), as shown in Figure 9.82.

F I G u R E   9 . 8 2 :   Modifying the Vertical Cell Margin property
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 6. Press Esc to deselect the ROOM SCHEDULE table.

 7. Save your drawing as I09A-FPLAYO.dwg (M09A-FPLAYO.dwg).

Your final table should look like the one shown in Figure 9.83.

F I G u R E   9 . 8 3 :   The completed ROOM SCHEDULE table

This concludes the chapter on dynamic blocks and tables. In the next chapter, 
you’ll look at adding the elevations to the drawings.

This has been a quick tour of the features of attributes and the commands 
used to set them up and modify the data they contain. In the process, you saw 
several ways that you can use attributes in an AutoCAD drawing. If you continue 
to work with attributes, you’ll find them to be a powerful tool and a way to link 
information in your AutoCAD drawing to other applications. You also explored 
the methods for creating dynamic blocks that change as required to match your 
drawing’s needs. Finally, you created a table to display the door schedule infor-
mation and added a formula to calculate the total cost.

If You Would Like More Practice…
Blocks and attributes are commonly used in title blocks. For more practice 
using attributes, you can try the following:

▶▶ Replace the title block text with attributes.

▶▶ Add attributes to the window blocks.

▶▶ Experiment with the dynamic block functionality by creating win-
dow blocks that can be dragged to the appropriate width without 
resorting to scaling the blocks.

▶▶ Add a window schedule to calculate the cost of the cabin’s windows.
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Are You Experienced?

now you can…

✔✔ set	up	blocks	with	attributes

✔✔ control	the	visibility	of	the	attributes

✔✔ calculate the area of an enclosed space

✔✔ create	dynamic	blocks

✔✔ define	a	table	style

✔✔ create	a	table	complete	with	formulas

✔✔ create	a	table	by	extracting	data	from	objects	in	the	drawing
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CHAPtER 10

Generating Elevations
Now that you have created all the building components that will be in the 
floor plan, it’s a good time to draw the exterior elevations. Elevations are 
horizontal views of a building, seen as if you were standing facing the build-
ing instead of looking down at it, as you do with a floor plan. An elevation 
view shows you how windows and doors fit into the walls and gives you an 
idea of how the building will look from the outside. In most architectural 
design projects, the drawings include at least four exterior elevations: front, 
back, and one for each side.

I’ll go over how to create the south elevation first. Then I’ll discuss some 
of the considerations necessary to complete the other elevations, and you’ll 
have an opportunity to draw them on your own.

In mechanical drawing, the item being drawn is often a machine part or a 
fixture. The drafter uses orthographic projection—a method for illustrating 
an object in views set at right angles to each other: front, top, side, back, and 
so on—instead of elevations and plans. An exercise later in this chapter will 
give you practice with orthographic projection, but the procedure will be the 
same whether you’re drawing buildings or mechanical objects.

In this chapter, you will learn to

▶▶ Draw an exterior elevation from a floor plan

▶▶ Use	grips	to	copy	objects

▶▶ Set	up,	name,	and	save	user	coordinate	systems	and	views

▶▶ Transfer lines from one elevation to another

▶▶ Move and rotate elevations
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Drawing the South Elevation
The first elevation view you’ll create is the south view. This will reflect the 
appearance of the cabin as if you were looking at it from the side with the bath 
and living room windows. Before starting on these elevation views, however, 
you’ll need to create some additional layers. These layers will mimic many of the 
layers already in your drawing but will use the major ELEV code to distinguish 
them from the layers used for your floor plan. Follow these steps to draw your 
first elevation:

 1. Open I09A-FPLAYO.dwg (M09A-FPLAYO.dwg).

 2. Open the Layer Properties Manager palette from the Home tab ➢ 
Layers panel.

 3. Using the New Layer button, create layers with the properties shown 
in the following table:

Layer Color Linetype

A-ELEV-DECK 3 (Green) Continuous

A-ELEV-DECK-STRS 82 Continuous

A-ELEV-DOOR 1 (Red) Continuous

A-ELEV-FNDN 11 Continuous

A-ELEV-GLAZ 31 Continuous

A-ELEV-ROOF 4 (Cyan) Continuous

A-ELEV-TEXT 2 (Yellow) Continuous

A-ELEV-WALL 84 Continuous

 4. Save this drawing as I10-01-ElevLayers.dwg (M10-01-ElevLayers.dwg).
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Creating the South Elevation
You draw the elevation by using techniques similar to those used on a tradi-
tional drafting board. You’ll draw the south elevation view of the cabin directly 
below the floor plan by dropping lines down from key points on the floor plan 
and intersecting them with horizontal lines representing the heights of the cor-
responding components in the elevation. Figure 10.1 shows those heights. For 
this project, we’ll consider the top of the screen to be north.

F I G u R E   1 0 . 1 :   The south elevation with heights of components

Follow these steps:

 1. Continue using I10-01-ElevLayers.dwg (M10-01-ElevLayers.dwg), 
or open it if it’s not already open.

 2. Freeze the A-ANNO-TABL, A-ANNO-TEXT, A-ANNO-TTLB, A-ANNO-
TTLB-TEXT, and A-GRID layers. The A-AREA-NPLT layer should 
already be frozen, but check it and freeze it if it is still thawed. Thaw 
the A-ROOF layer.

 3. Offset the bottom horizontal wall line that is to the right of the pop-
out 30′ (9144 mm) down. The offset line may be off the screen.

 4. Perform a Zoom Extents; then zoom out just enough to bring the off-
set wall line up off the bottom edge of the drawing area.

 5. Select the object and, when the grips are visible, click the left grip.

 6. Use the Perpendicular osnap to stretch the line to the left extent of 
the building, as shown in Figure 10.2.
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Stretch to o�set line 
perpendicular to this line.

Select this grip.

F I G u R E   1 0 . 2 :   Using the grip to stretch the offset line

 7. Deselect the offset line. When done, your drawing should look like 
Figure 10.3.

F I G u R E   1 0 . 3 :   The floor plan with space below it for the south elevation
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 8. Save this drawing as I10-02-SouthElevPlacement.dwg (M10-02-
SouthElevPlacement.dwg).

Setting up Lines for the Heights
The line you offset establishes a baseline to represent the ground or the bottom 
of the cabin. You can now offset the other height lines from the baseline or from 
other height lines as follows:

 1. Continue using I10-02-SouthElevPlacement.dwg (M10-02-
SouthElevPlacement.dwg), or open it if it’s not already open.

 2. Check the status bar to make sure that Polar Tracking and Object 
Snap are in their On positions, while the other buttons are Off. The 
Endpoint osnap should be running.

 3. Change the layer of the offset line from A-WALL to A-ELEV-WALL, 
and perform the following offsets:

 a. Offset the baseline 6′-7″ (2007 mm) up to mark the lowest edge 
of the roof supports and the bottom edge of the soffit.

 b. Offset the same line 6′-11 1/4″ (2115 mm) and again 7′-0″ 
(2134 mm) to establish the lower and upper heights of the 
roof covering, respectively.

 c. Offset the baseline up 17′-0″ (5182 mm) to mark the ridgeline 
of the roof.

The lines should look like those shown in Figure 10.4.

F I G u R E   1 0 . 4 :   Lines representing different heights in the elevation

◀

A soffit is the underside 
of the roof overhang 
that extends from the 
outside edge of the 
roof back to the wall.
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 4. Offset the baseline 2′-11″ (889 mm) to represent the bottom of the 
windows.

 5. Offset the offset line 3′-6″ (1069 mm) to mark the top.

 6. To complete the lines representing different heights in the elevation, 
copy the three horizontal rooflines down 1′-11″ (584 mm).

These will be the lines at the edge of the roof, where it covers the 
pop-out (see Figure 10.5). Note that two of the lines appear to be at 
the same height. Use a crossing selection window to select the lines; 
be sure not to select the line representing the tops of the windows.

Copy these three lines...

Do not copy this line.

to here.

F I G u R E   1 0 . 5 :   The horizontal height lines for the elevation in place

 7. Save this drawing as I10-03-SouthElevOffsets.dwg (M10-03-
SouthElevOffsets.dwg).

Each of these lines represents the height of one or more components of the 
cabin. Now you’ll drop lines down from the points in the floor plan that coincide 
with components that will be visible in the elevation. The south elevation will 
consist of the exterior walls, two windows, the pop-out, and the roof.
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using Construction Lines to Project Elevation 
Points
As you know, to create a standard line, you must define both a starting point 
and ending point for the line. Along with the standard LINE command, however, 
the Autodesk® AutoCAD® software offers two additional types of lines: rays and 
construction lines.

Rays  Rays are a mix between standard and construction lines. Rays have a 
starting point but no endpoint.

Construction Lines  Construction lines have neither a starting point nor an 
endpoint, and they extend to infinity in both directions.

Both rays and construction lines can be trimmed in much the same way 
as standard lines. Because, by definition, a construction line is a line of infi-
nite length, trimming it will force it to extend to infinity in one direction. 
Consequently, using the TRIM command on a construction line will, at a mini-
mum, turn it into a ray. Similarly, using the TRIM command on a ray will define 
an endpoint, consequently reducing it to a standard AutoCAD line.

You’ll use construction lines to project key points from your floor plan to the 
area within the drawing where you will draw your south elevation. As you do 
this, pay attention to the way construction lines are reduced into rays, and rays 
into standard lines.

 1. Continue using I10-03-SouthElevOffsets.dwg (M10-03-
SouthElevOffsets.dwg), or open it if it’s not already open.

 2. Zoom in to the floor plan, and make sure Object Snap is turned on 
with the Endpoint osnap enabled.

 3. Start the XLINE (Construction Line) command from the expanded 
Draw panel on the Home tab.

 4. Enter V↵ or select Ver at the Specify a point or [Hor/Ver/Ang/
Bisect/Offset]: prompt to choose the Ver, or Vertical, option.

With the Vertical option, the XLINE command will create a vertical 
line extending to your south elevation and beyond at each point you 
select.
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 5. Using the Endpoint osnap, choose the lower-left outside wall by the 
bathroom, as shown in Figure 10.6. Keep this drawing open as you 
continue to the next exercise.

F I G u R E   1 0 . 6 :   Drawing a construction line to represent the outside wall by 
the bathroom

Copying objects by using Grips
Construction lines, like most other objects in AutoCAD, have a number of grips. 
Selecting the construction line you just drew will make three grips (blue boxes) 
appear. Grips can be used to modify objects in your drawing quickly and easily. 
Among the possible operations using grips is the Copy function. You’ll create 
the remaining projection points by using this method:

 1. Select the construction line you just drew.
Three grips appear along the construction line: one at the inser-

tion point and two more above and below it (see Figure 10.7).
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F I G u R E   1 0 . 7 :   Select the construction line dropped from the floor plan.

 2. Click the middle grip on the construction line. (This is the same 
point you used to insert the construction line.)

The grip changes color from blue to red, and the prompt changes 
to Specify stretch point or [Base point/Copy/Undo/eXit]:. 
This is the STRETCH command. Any time you activate a grip, the 
STRETCH command automatically starts.

 3. Right-click and choose Copy from the context menu.
This starts the COPY command, using the selected grip as the first 

point.

 4. With the Endpoint osnap running, select each of the 11 endpoints 
shown in Figure 10.8.

1 11

2 3 8 9 10

4 7

5 6

F I G u R E   1 0 . 8 :   Copy the construction line to the 11 points shown here.

The construction line is copied to each of these corners and 
extends down to where you’ll draw the south elevation. 

The STRETCH com-
mand is a modifying 
tool that you use to 
lengthen or shorten 
lines and other objects. 
You’ll have another 
chance to use it in 
Chapter 11, “Working 
with Hatches, 
Gradients, and Tool 
Palettes.”

◀

◀

Every command that 
works with grips has 
a Copy option, which 
keeps the original 
object “as is” while you 
modify the copy. You 
can copy with grips in 
ways not possible with 
the COPY command.
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 5. Press Esc twice to end the command, and deselect the line. Your 
drawing should resemble Figure 10.9.

F I G u R E   1 0 . 9 :   All the lines dropped down from the floor plan

 6. Save this drawing as I10-04-ProjectionLines.dwg (M10-04-
ProjectionLines.dwg).

In the next section, you’ll trim the lines as necessary to continue the elevation 
drawing.

Getting a Grip on Grips

In Chapter 7, “Combining Objects into Blocks,” you saw how to use grips to detect 
whether an object is a block. Grips actually serve a larger function. The STRETCH 
command will automatically start when you select a single grip. With a single grip 
selected, the right-click menu offers a list of additional tools for editing objects 
quickly by using one or more of the following five commands: STRETCH, MOVE, 
ROTATE, SCALE, and MIRROR. These commands operate a little differently when 
you’re using grips than when you’re using them without grips.

The commands can also perform a few more tasks with the help of grips. Each 
command has a Copy option. So, for example, if you rotate an object with grips, 
you can keep the original object unchanged while you make multiple copies of 
the object in various angles of rotation. You can’t do this by using the ROTATE 
command in the regular way or by using the regular COPY command.

To use grips, follow these steps:

 1.  When no commands have been started, click an object that you want 
to modify.

 2. Click the grip that will be the base point for the command’s execution.

(Continues)
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 3.  Right-click at this point and choose any of the five commands just described 
from the context menu that opens on the drawing area.

You can also cycle through these commands by pressing the spacebar and 
watching the command prompt.

 4. When you see the command you need, execute the necessary option.

 5. Enter X↵ when you’re finished.

 6. Press Esc to deselect the object.

The key to being able to use grips efficiently is knowing which grip to select to 
start the process. This requires a good understanding of the five commands that 
work with grips.

This book doesn’t cover grips in depth, but it introduces you to the basics. You’ll 
get a chance to use the MOVE command with grips in this chapter, and you’ll use 
grips again when you get to Chapter 12, “Dimensioning a Drawing.”

Keep the following in mind when working with grips:

▶▶ Each of the five commands available for use with grips requires a base 
point. For MIRROR, for example, the base point is the first point of the 
mirror line. By default, the base point is the grip that you select to activate 
the process. But you can change base points, as follows:

 1. Select a grip, and enter B↵.

 2. Pick a different point to serve as a base point.

 3. Continue the command.

▶▶ When you use the Copy option with the MOVE command, you’re essentially 
using the regular COPY command.

trimming Lines in the Elevation
The next task is to extend and trim the appropriate lines in the elevation. You’ll 
start by extending the rooflines:

 1. Continue using I10-04-ProjectionLines.dwg (M10-04-
ProjectionLines.dwg), or open it if it’s not already open.

Getting a Grip on Grips (Continued)
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 2. Click the Extend button in the Modify panel of the Home tab, and 
then select the two outermost construction lines extending from the 
roofline in plan view and press ↵. These are the boundary edges.

 3. Click once on each end of the top four horizontal lines: the ridgeline, 
the top and bottom of the roof covering, and the bottom of the soffit 
(see Figure 10.10).

F I G u R E   1 0 . 1 0 :   The elevation after extending the rooflines

 4. Start the TRIM command, and press ↵ when prompted to select cut-
ting edges.

By not selecting any cutting edges, every edge in the drawing is 
used as a cutting edge.

 5. Enter F↵ to choose the Fence option.
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 6. Draw a fence line along the bottom of your elevation, as shown in 
Figure 10.11.

F I G u R E   1 0 . 1 1 :   Trimming the lower construction line extensions by using the 
Fence option with the TRIM command

 7. Press ↵↵ to apply the fence line and end the TRIM command.

 8. Select one of the vertical lines extending down from the floor plan, 
and open the Properties palette (Ctrl+1).

The roof extends a little farther than the rest of the roof where the 
hot tub is located.

 9. Start the TRIM command, and select the two horizontal lines high-
lighted in Figure 10.12.

Pick these lines as cutting edges.

Pick these locations to trim the lines. Pick these locations to trim the lines.

F I G u R E   1 0 . 1 2 :   The cutting edges for trimming the roof extension, and selecting the trim 
points
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n o t E  Notice that the extension lines are no longer construction lines. By using 
the TRIM command, you defined a start point for each construction line where it inter-
sected a cutting edge. Because construction lines extend to infinity in both directions, 
our line is reduced to a ray. As you may recall, a ray has a start point but no endpoint.

 10. After choosing the cutting edges, pick the vertical lines above and 
below the cutting edges, as shown in Figure 10.12, to trim the con-
struction lines.

 11. Start the TRIM command again, and select the two roof extension 
lines you just created along with the bottom roofline as cutting edges 
(see Figure 10.13).

Cutting Edges

Crossing Windows

F I G u R E   1 0 . 1 3 :   Defining the cutting edges and crossing windows to trim the roof 
extension

 12. Use a total of three crossing windows to complete the TRIM com-
mand, as shown in Figure 10.13.

 13. Start the FILLET command from the Home tab ➢ Modify panel.

 14. Using a 0 radius, pick the left side of the top roofline and the rear 
(left-side) vertical roof extension line.

 15. Repeat the FILLET command, this time selecting the right side of the 
top roofline and the front (left-side) vertical roof extension line.

This completes the roof outline in your elevation view. The only 
thing left to do is clean up the lines defining the two windows.
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 16. From the extended Modify panel within the Home tab, choose the 
Break At Point tool.

 17. Select the lower window line at the Select object: prompt, and use 
the Midpoint osnap to specify the break point.

The line will appear unchanged visually; however, selecting it will 
reveal that the line has been divided into two separate line segments.

 18. Zoom in to the bathroom window, and start the FILLET command.

 19. Enter M↵ to select the Multiple option at the Select first object 
prompt.

 20. Using a Fillet radius of 0, fillet each of the four corners of the bath-
room window, as shown in Figure 10.14.

F I G u R E   1 0 . 1 4 :   Using the FILLET command to complete the bathroom 
window
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 21. Repeat steps 16 and 17 to complete the living room window toward 
the front of your cabin.

 22. Complete the elevation view by using the TRIM command to trim 
the two vertical lines representing the front and rear outside walls 
to the roof soffit line. When finished, the elevation should resemble 
Figure 10.15.

F I G u R E   1 0 . 1 5 :   The completed elevation view

 23. Save the current drawing as I10-05-TrimElevation.dwg (M10-05-
TrimElevation.dwg).

This is the basic process for generating an elevation: drop lines down from the 
floor plan, and trim the lines that need to be trimmed. The trick is to learn to 
see the picture you want somewhere among all the crossed lines and then to be 
able to use the TRIM command accurately to cut away the appropriate lines.

tips for using the TRIM and EXTEND Commands

TRIM and EXTEND are sister commands. Here are a few tips on how they work.

Basic operation

Both commands involve the following steps:

 1.  Select the cutting edges (TRIM) or boundary edges (EXTEND), and then 
press ↵.

 2. Pick lines to trim or extend.

 3. Press ↵ to end the commands.

You can use the Fence option or a selection window to select several lines to trim 
or extend at one time.

(Continues)
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trimming and Extending in the Same Command

If you find that a cutting edge for trimming can also serve as a boundary edge 
for extending, hold down the Shift key and click a line to extend it to the cutting 
edge. The opposite is true for the EXTEND command.

Correcting Errors

It’s easy to make a mistake in selecting cutting or boundary edges or in trimming 
and extending. You can correct a mistake in two ways:

▶▶ If you select the wrong cutting or boundary edge, do the following:

 1.  Enter R↵, and then choose the lines again that were picked 
in error. They will lose their highlighting.

 2.  If you need to keep selecting cutting or boundary edges, 
enter A↵ and select new lines.

 3.  When finished, press ↵ to move to the second part of the 
command.

▶▶ If you trim or extend a line incorrectly, proceed as follows:

 1.  Enter U↵ or right-click and choose Undo from the context 
menu. This undoes the last trim.

 2.  Click Undo again if you need to untrim or unextend more lines.

 3.  When you have made all the corrections, continue trimming 
or extending.

 4. Press ↵ to end the command.

If the command ended and you click the Undo button, you will undo all trimming 
or extending that was done in the preceding command.

Assigning Elevation Layers
You set the A-ELEV-WALL layer as current as you began drawing your elevation 
view. At that point, you were mostly interested in getting the elevation’s geom-
etry in place, and not as interested in layers. With the geometry in place, now is 
a good time to pause for a moment and place everything on the correct layers. 

tips for using the tRIM and EXtEnD Commands (Continued)

www.MouradEngineering.com



5 6 4 	 C h a p t e r 	 1 0 	 • 	 G e n e r a t i n g 	 E l e v a t i o n s

Currently, the exterior walls, roof, and windows are drawn. Follow these steps to 
assign A-ELEV-WALL, A-ELEV-ROOF, and A-ELEV-GLAZ, respectively, to those 
objects:

 1. Continue using I10-05-TrimElevation.dwg (M10-05-
TrimElevation.dwg), or open it if it’s not already open.

 2. Select the lines shown in Figure 10.16, and use the layer drop-down 
list on the Layers panel of the Home tab to assign the A-ELEV-ROOF 
layer.

F I G u R E   1 0 . 1 6 :   Assigning the A-ELEV-ROOF layer to the roof objects within 
the elevation view

 3. Repeat step 2, this time selecting the bathroom and living room win-
dows and assigning the A-ELEV-GLAZ layer.

 4. Select the four vertical lines and the horizontal line running along 
the bottom of your elevation view and, using the process shown in 
step 2, assign the A-ELEV-WALL layer.

 5. Save the current drawing as I10-06-AssignLayers.dwg (M10-06-
AssignLayers.dwg).

With each component of your elevation view on the proper layer, you can 
begin to refine the view further. Currently, the elevation view does not illustrate 
your deck, stairs, or foundation. Let’s begin adding these components, starting 
with the front and rear decks.
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Drawing the Decks in Elevation
The cabin sits on an 18″ (457 mm) foundation (which you’ll add in the “Drawing 
the Supports and Foundation” section later in this chapter), with the surround-
ing land falling away from it at a slight angle. On the front and back sides are 
decks with stairways to step up to the door levels. In this section, you’ll draw the 
front deck first, mirror it to the other end, and then adjust the second deck to 
match the conditions at the back of the cabin.

Drawing the Front Deck

Figure 10.17 shows the dimensions required to draw the horizontal elements of 
the stairway, while most vertical lines are dropped from the floor plan.

F I G u R E   1 0 . 1 7 :   The front deck and stairs with dimensions

Follow these steps to draw the front deck:

 1. Continue using I10-06-AssignLayers.dwg (M10-06-AssignLayers 
.dwg), or open it if it’s not already open.

 2. Make the A-ELEV-DECK layer current.

www.MouradEngineering.com



5 6 6 	 C h a p t e r 	 1 0 	 • 	 G e n e r a t i n g 	 E l e v a t i o n s

 3. Draw a horizontal line from the elevation’s bottom-right corner of 
the wall directly to the right.

Make sure the line extends beyond the limits of the stairway in the 
floor plan.

 4. Start the XLINE (Construction Line) command.

 5. Choose the Vertical option, and draw lines from the corner post, 
the stairs, and the end of the railing in the floor plan, as shown in 
Figure 10.18.

F I G u R E   1 0 . 1 8 :   Vertical construction lines drawn from deck post, stairs, and 
railings

 6. Zoom in to the right end of the cabin elevation.
Here you’re first going to offset the horizontal line several times and 

then trim the resulting lines back to the lines that represent the post.

 7. Start the OFFSET command.
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 8. Offset the horizontal line upward 6″ (152 mm), and press the Esc key 
to exit the command.

 9. Repeat steps 7 and 8 five times, offsetting the original line up by 
these distances:

7 5⁄8″ (194 mm)

11 5⁄8″ (295 mm)

1′-1 5⁄8″ (346 mm)

4′-1 5⁄8″ (1260 mm)

4′-3 5⁄8″ (1312 mm)

The right end of your elevation should look like Figure 10.19.

F I G u R E   1 0 . 1 9 :   The offset lines for the stairs

 10. Start the TRIM command, and select the two post lines, the soffit line, 
and the third horizontal deck line (deck surface) from the bottom as 
the cutting edges (see Figure 10.20).
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Select these lines.

F I G u R E   1 0 . 2 0 :   Select the cutting edges for the TRIM command.

 11. Continue using the TRIM command to clean up the construction lines 
you drew by doing the following:

 a. Trim all the deck horizontal lines to the right post line, and 
then trim the top four deck lines again, this time to the left post 
line.

 b. Trim the vertical post lines back to the soffit line on top and the 
third horizontal deck line below.

 c. Draw a short vertical line from the bottom of the right post line 
to the lowest horizontal line, as shown in Figure 10.21.
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F I G u R E   1 0 . 2 1 :   The deck and post lines after trimming them back to their 
proper lengths

 12. Save the current drawing as I10-07-FrontDeck.dwg (M10-07-
FrontDeck.dwg).

Drawing the Railing Posts with a Path Array

The railing posts are 3/4″ (20 mm) square components that are 3′-0″ (915 mm) 
long and spaced with a 4″ (102 mm) gap between each one. After the first object 
is drawn, you could apply strategies learned in earlier chapters to copy the 
remaining posts manually.

As you will see in a moment, the ARRAY command provides an efficient way 
to copy objects as an associative group. This associative group can be created 
in any one of three distinct ways: rectangular, polar, or what you’ll use in this 
exercise—path. Using the Path Array (ARRAYPATH) command, each of the verti-
cal railing posts will be created using only a single instance of one command. 
Here’s how:

 1. Continue using I10-07-FrontDeck.dwg (M10-07-FrontDeck.dwg), or 
open it if it’s not already open.

 2. Offset the left post line 4″ (102 mm) to the left, and then offset this 
line another 3/4″ (20 mm).
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 3. Trim these two lines back to the lower edge of the upper rail and to 
the upper edge of the lower rail (see Figure 10.22).

Select these lines.

Select as path.

F I G u R E   1 0 . 2 2 :   Draw the first railing post.

 4. On the Home tab ➢ Modify panel, expand the Array button and select 
Path Array, as shown in Figure 10.23.

F I G u R E   1 0 . 2 3 :   Starting the Path Array (ARRAYPATH) command from the 
Ribbon

 5. At the Select objects: prompt, select the two lines composing the 
vertical railing post, as shown earlier in Figure 10.22. Press ↵.

 6. Define the direction in which you would like to copy the vertical rail-
ing by selecting the lower horizontal railing line at the Select path 
curve: prompt (also shown earlier in Figure 10.22).
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Because you have not yet defined any parameters for the array, the 
ARRAYPATH command fits a large number of vertical railings along 
the selected path, as shown in Figure 10.24.

F I G u R E   1 0 . 2 4 :   Initial vertical railing placement created with the Path Array 
(ARRAYPATH) command

 7. Because the initial railing placement does not accurately reflect our 
intended placement, make the following modifications at the Select 
grip to edit array prompt:

 a. Select the Items options, or enter I↵ at the command line.

 b. Enter 4-3/4″ (122 mm) at the Specify the distance between 
items along path or [Expression]: prompt.

 c. Adjust the total number of vertical railings by entering 18↵ at 
the Specify number of items: prompt.

 d. Press ↵ ↵ to complete the ARRAYPATH command.

The array is created using the parameters specified in the preced-
ing procedure, and it should now match Figure 10.25.
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F I G u R E   1 0 . 2 5 :   Final vertical railing placement created with the Path Array 
(ARRAYPATH) command

 8. Save the current drawing as I10-08-RailingArray.dwg (M10-08-
RailingArray.dwg).

Drawing the Stairs

There are four steps leading up to the cabin, each with an 8″ (204 mm) rise and 
a 1 5⁄8″ (41 mm) thick tread. The 10″ (254 mm) length of the steps, also called 
the run, is based on the lines dropped from the steps in the floor plan. Draw the 
stairs for the cabin by doing the following:

 1. Continue using I10-08-RailingArray.dwg (M10-08-RailingArray.dwg), 
or open it if it’s not already open.

 2. Using Object Snap Tracking and direct input, draw a line from a point 
8″ (204 mm) below the top of the deck directly to the right, well 
beyond the last vertical step line, as shown in Figure 10.26.
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Tracking Point

F I G u R E   1 0 . 2 6 :   Drawing the first step tread

 3. Using the OFFSET command, make three copies of this line, each one 8″ 
(204 mm) below the previous.

These lines are the tops of the stair treads.

 4. Offset each of the stair tread lines downward 1 5⁄8″ (41 mm), as 
shown in Figure 10.27.

www.MouradEngineering.com



5 7 4 	 C h a p t e r 	 1 0 	 • 	 G e n e r a t i n g 	 E l e v a t i o n s

F I G u R E   1 0 . 2 7 :   Offset the lines downward.

 5. Using the vertical step lines as cutting edges, trim each of the steps 
to its proper 10″ (254 mm) length.

Try using a crossing window to select multiple lines to trim at 
one time.

 6. Next, use the horizontal step lines as cutting edges to trim back the 
vertical lines, leaving the short, vertical line between each step intact.

Your stairway should look like Figure 10.28.
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F I G u R E   1 0 . 2 8 :   The steps after trimming away the extraneous lines

For the stringer (the support for the steps), you need a line that 
matches the angle between each step.

 7. Draw a line from the top-right corner of the first step to the top-right 
corner of the last step, and then offset this line 10″ (254 mm) so that 
the copy appears below the stairs, as shown in Figure 10.29.
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Line Created by        Command

Draw this line
and o�set it
10" (254 mm).

Draw these lines.

F I G u R E   1 0 . 2 9 :   Drawing the stringer

 8. Draw a line from the bottom of the lowest step tread 8″ (204 mm) 
downward and then a few feet directly to the left.

 9. Fillet the bottom-left corner of the stringer with a radius of 0, as 
shown previously in Figure 10.29.

The last parts of the stairway to draw are the 2″ (51 mm) railing 
posts and the handrail.

 10. Move the angled line at the top of the stairs up 3′-6″ (1067 mm), and 
then offset it upward 2″ (51 mm).

 11. Extend the upper line until it intersects the post on the left and the 
last remaining vertical line dropped from the floor plan.

 12. Extend the lower line only to the post on the left, as shown in 
Figure 10.30.
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Fillet this corner.

Erase this line.

Draw this line.

F I G u R E   1 0 . 3 0 :   Finishing the stair rail

 13. Draw a line from the right endpoint of the upper-railing line, perpen-
dicular to the lower line, and then fillet the corner.

 14. Erase the vertical line that extends from the floor plan (as shown pre-
viously in Figure 10.30).

 15. To create the posts, draw a line from the midpoint of a stair tread 
upward and then offset it 1″ (25.5 mm) to the left and right.

 16. Erase the original line, and then trim or extend the other two lines 
until they intersect with the lower-railing line.

 17. Using the top-right corner of each step as a reference point, copy the 
post to the other three steps.

When you’re finished, your deck should look like Figure 10.31.
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F I G u R E   1 0 . 3 1 :   The stairway, deck, posts, and railings

 18. Save the current drawing as I10-09-StairElevation.dwg (M10-09-
StairElevation.dwg).

Drawing the Supports and Foundation

The cabin rests on a foundation, and the decks are supported by concrete posts. 
You can quickly draw these by using the Rectangle (RECTANG) command with 
object snaps and the Object Snap Tracking tool as follows:

 1. Continue using I10-09-StairElevation.dwg (M10-09-
StairElevation.dwg), or open it if it’s not already open.

 2. Using the layer drop-down list, change the current layer to A-ELEV-
FNDN from the Home tab ➢ Layers panel.

 3. Start the Rectangle (RECTANG) command, and draw a rectangle with 
its first point at the right end of the lowest horizontal deck line and 
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the second point 1′ (305 mm) to the left and 2′-10″ (864 mm) below 
that point (in other words, at –1′,–2′-10″ or at –305,–864 mm).

 4. Extend the lower stringer line until it intersects the support post, as 
shown in Figure 10.32.

F I G u R E   1 0 . 3 2 :   The extended stringer and the first deck support post

 5. Zoom out so that you can see the entire cabin, and start the 
Rectangle (RECTANG) command again.

 6. At the Specify first corner point or: prompt, click the lower-
right corner of the cabin’s exterior wall.

 7. At the Specify other corner point or: prompt, pause the cursor 
over the lower-left corner of the cabin’s exterior wall until the tempo-
rary track point appears. Then move the cursor directly downward, 
and enter 18↵ (457↵).
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The foundation rectangle is shown in Figure 10.33.

F I G u R E   1 0 . 3 3 :   The completed foundation rectangle

 8. Save the current drawing as I10-10-SupportFoundation.dwg (M10-
10-SupportFoundation.dwg).

Mirroring the Deck

From this view, the decks, stairways, post, and supports are nearly symmetri-
cal, making the Mirror tool an excellent choice for creating most of the objects 
on the back deck. The front deck is wider than the back deck, but an efficient 
use of the ERASE and TRIM commands can quickly fix that. Follow these steps:

 1. Continue using I10-10-SupportFoundation.dwg (M10-10-
SupportFoundation.dwg), or open it if it’s not already open.

 2. Start the MIRROR command, and then select all the components of 
the deck, stairs, railings, posts, and the concrete support.

 3. At the Specify first point of mirror line: prompt, use the 
Midpoint osnap to select the midpoint of the roof.

 4. At the Specify second point of mirror line: prompt, pick a point 
directly below the first point.
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The components on the right remain ghosted, while the new com-
ponents on the left appear solid, as shown in Figure 10.34.

F I G u R E   1 0 . 3 4 :   The front deck mirrored to the back of the cabin

 5. When prompted whether to erase source objects, press ↵ to accept 
the default No option to retain the selected objects on the right.

 6. Zoom in to the back deck and clean up the mirrored linework by 
doing the following:

 a. Select any one of the vertical railing posts, and use the Item 
Count grip to adjust the number of railings so that they fill only 
the area to the left of the exterior wall.

 b. Trim the horizontal deck lines back to that wall line, including 
the line that overlaps the top of the foundation.

Your back deck should look like Figure 10.35.

◀

Try enabling Selection 
Cycling on the status 
bar to help you select 
the line that over-
laps the top of the 
foundation.
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F I G u R E   1 0 . 3 5 :   The back deck after trimming and erasing unneeded lines

 7. Save the current drawing as I10-11-DeckMirror.dwg (M10-11-
DeckMirror.dwg).
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W A R n I n G  Trimming the horizontal deck lines prior to adjusting the Path 
Array will open an Associative Path Array error dialog box. This dialog box is simply warn-
ing that your array extends beyond the length of the path (or in this case, line) that was 

selected when the array was created.

Generating the other Elevations
The full set of drawings that contractors use to construct a building includes an 
elevation for each side of the building. In traditional drafting by hand, the eleva-
tions were usually drawn on separate sheets. This required transferring mea-
surements from one drawing to another by taping drawings next to each other, 
turning the floor plan around to orient it to each elevation, and using several 
other cumbersome techniques. You do it about the same way on the computer, 
but it’s much easier to move the drawing around. You’ll be more accurate, and 
you can quickly borrow parts from one elevation to use in another.

Making the opposite Elevation
Because the north elevation shares components and sizes with the south eleva-
tion, you can mirror the front elevation to the rear of the building and then 
make the necessary changes. Follow these steps:

 1. Open I10-11-DeckMirror.dwg (M10-11-DeckMirror.dwg), if it’s not 
already open.

 2. Change the view to include space above the floor plan for the eleva-
tion on the opposite side of the building.

 3. Use the Pan tool, or hold down the scroll wheel, to move the view of 
the floor plan to the middle of the screen.

 4. Zoom out the view enough to include the front elevation.

 5. Start the MIRROR command.

 6. Use a window to select the south elevation and then press ↵.

 7. For the mirror line, select the Midpoint osnap and pick the left edge 
of the ridgeline in the floor plan.

 8. With Polar Tracking on, hold the crosshair cursor directly to the 
right of the point you just picked (see the left side of Figure 10.36) 
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and pick another point. At the Erase source objects?[Yes/No]<N>: 
prompt, press ↵ to accept the default of No.

F I G u R E   1 0 . 3 6 :   Specifying a mirror line (left) and the result (right)

The first side elevation is mirrored to the opposite side of the cabin 
(see the image on the right in Figure 10.36). You can now make the 
necessary changes to the new elevation so that it correctly describes 
the south elevation of the cabin. However, you might find it easier to 
work if the view is right side up.

Take a look at the icon, currently located at the origin, for a 
moment. The two lines in the icon show the positive X and Y direc-
tions of the current User Coordinate System (UCS). That is the 
World Coordinate System (WCS), which is the default system for 
all AutoCAD drawings. You’ll change the orientation of the icon to 
the drawing and then change the orientation of the drawing to the 
screen.

The UCS defines the positive X and Y directions in your drawing. A 
drawing can have several UCSs, but can use only one at a time.

 9. Using the ViewCube® found in the upper-right corner of the drawing 
area, click the UCS drop-down menu and select New UCS, as shown 
in Figure 10.37.

▶

The WCS is the default 
UCS for all new draw-
ings and remains avail-
able in all drawings.
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F I G u R E   1 0 . 3 7 :   Creating a new UCS by using the ViewCube

 10. To rotate the current UCS 180˚ about the z-axis, type Z↵180↵ at the 
Specify origin of UCS or [Face/NAmed/OBject/Previous/View/
World/X/Y/Z/ZAxis] <World>: prompt.

This rotates the UCS icon 180˚ around the z-axis, to an upside-
down position. The square box at the intersection of the x- and y-axes 
disappears, showing you that you’re no longer using the default WCS 
(see Figure 10.38).

F I G u R E   1 0 . 3 8 :   The UCS icon showing the UCS rotated 180

 11. Start the PLAN command by entering PLAN↵ at the command line and 
then C↵ to select the Current UCS option.

The entire drawing is rotated 180 ,̊ and the mirrored elevation is 
now right side up. Note that the UCS icon is now oriented the way 
it used to be, but the square in the icon is still missing. This signals 
that the current UCS is not the WCS.

n o t E  You used the UCS command to reorient the UCS icon relative to the draw-
ing. You then used the Current option of the PLAN command to reorient the drawing 
on the screen so that the positive X and Y directions of the current UCS are directed to 
the right and upward, respectively. This process is a little bit like turning your monitor 
upside down to get the correct orientation—but easier.
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 12. Zoom in to the lower edge of the floor plan and the mirrored eleva-
tion (see Figure 10.39). Now you can work on the rear elevation.

F I G u R E   1 0 . 3 9 :   The cabin drawing rotated 180 and zoomed in

 13. Save the current drawing as I10-12-OppositeElevation.dwg (M10-
12-OppositeElevation.dwg).

Revising the new South Elevation
A brief inspection will tell you that the decks and stairs don’t need any changes. 
Since this side of the cabin does not include the pop-out, and has a different 
window placement as a result, the windows and roof need several revisions:

▶▶ The two remaining windows need to be resized and repositioned.

▶▶ The roof needs to be a series of straight, unbroken lines.

▶▶ The vertical pop-out lines and the pop-out roof extension need to be 
deleted.
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You can accomplish these tasks quickly by using commands with which 
you’re now familiar:

 1. Continue using I10-12-OppositeElevation.dwg (M10-12-
OppositeElevation.dwg), or open it if it’s not already open.

 2. Use the ERASE command to remove the following:

▶▶ The roof offset

▶▶ The walls for the roof offset

▶▶ The vertical lines from the remaining windows
After removing these lines, your elevation view should look like 

Figure 10.40.

F I G u R E   1 0 . 4 0 :   Erasing the unneeded elements copied from the original 
south elevation

 3. Zoom in to the area where the roof extension was previously located.
The gap left after erasing the pop-out needs to be reconstructed.

 4. Start the JOIN command by choosing the Home tab ➢ extended 
Modify panel ➢ Join tool.

 5. Pick the top roofline at the Select source object: prompt, and 
then choose the adjacent top roofline.

 6. Press ↵ to end the command, and join the two segments into a single 
line segment.

 7. Repeat steps 5 and 6 for the two remaining rooflines.
After you’ve joined each of the rooflines into three individual seg-

ments, your view should look like Figure 10.41.
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F I G u R E   1 0 . 4 1 :   Elevation view after repairing the lower roofline by using 
the JOIN command

 8. Change the current layer to A-ELEV-GLAZ by using either the 
Ribbon or the LAYER command.

 9. Using the Construction Line tool found on the Draw panel of the 
Home tab, create extension lines from the jambs of the two windows 
in the floor plan.

Once these are drawn, your elevation will look like Figure 10.42.

F I G u R E   1 0 . 4 2 :   Construction lines drawn from the floor plan windows to the 
elevation view

 10. Use the FILLET command to construct the new windows. If neces-
sary, use Selection Cycling to aid in selecting the correct line when 
filleting the top of your windows.
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Your elevation should look like Figure 10.43.

F I G u R E   1 0 . 4 3 :   Use the FILLET command to construct the new windows.

You need to save the UCS you used to work on this elevation so 
that you can quickly return to it in the future, from the WCS or from 
any other UCS you might be in. The default AutoCAD workspace 
does not include access to coordinate commands for managing your 
UCS. To access these coordinate commands, you’ll load an additional 
Ribbon panel to the View Ribbon tab.

 11. Switch to the View Ribbon tab.

 12. Right-click the Model Viewports panel title and select Show Panels ➢ 
Coordinates (see the top of Figure 10.44).

F I G u R E   1 0 . 4 4 :   Loading the Coordinates Ribbon panel (top) and the 
Coordinates panel loaded onto the View Ribbon tab (bottom)
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The Coordinates Ribbon panel is now included within the View 
Ribbon tab (see the bottom of Figure 10.44).

 13. Click the UCS, Named UCS button on the Coordinates panel of the 
View tab to open the UCS dialog box. Alternatively, you can enter 
UCSMAN at the command line.

 14. From the UCS dialog box, click the Named UCSs tab, and then click the 
current UCS name (currently named Unnamed) once to highlight the 
text. Then select North_Elev (see Figure 10.45).

F I G u R E   1 0 . 4 5 :   The UCS dialog box

This enables you to recall the UCS if you need to work on this 
elevation again.

 15. Click OK to exit the dialog box.

t I P  You can save any UCS in this way. The WCS is a permanent part of all drawings, 
so you never need to save it.

You can also save the view to be able to recall it quickly.

 16. Right-click the Model Viewports panel title and select Show Panels ➢ 
Views.

 17. Click the View Manager button in the View tab ➢ Views panel to 
open the View Manager dialog box, shown at the top of Figure 10.46. 
You can also start the VIEW command by typing V↵.
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F I G u R E   1 0 . 4 6 :   Saving a view in the View Manager (top) and in the New 
View / Shot Properties dialog box (bottom)

 18. Click New to open the New View / Shot Properties dialog box.
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 19. In the View Name text box, enter North-Elev, as shown at the bottom 
of Figure 10.46.

 20. Click the Current Display radio button and click OK.
Back in the View Manager dialog box, North_Elev appears in the 

list of views.

t I P  You can name and save any view of your drawing and then restore it later.

 21. Click OK again.
Now you can restore the drawing to its original orientation, with 

the side elevation below the floor plan and right side up. You do this 
by restoring the preset Top view.

Use the In-Canvas Viewport Control toolbar found in the upper-left 
corner of the drawing area to restore the preset Top view.

 22. Click the View Controls menu (currently displayed as [Top]) 
from the In-Canvas Viewport Control toolbar, and select Top (see 
Figure 10.47).

F I G u R E   1 0 . 4 7 :   Restoring the preset Top view from the In-Canvas Viewport 
Control toolbar

This zooms to Extents view and displays a plan view of the drawing 
with the X and Y positive directions in their default orientation.
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 23. Save the current drawing as I10-13-NorthElevUCS.dwg (M10-13-
NorthElevUCS.dwg).

You created a new UCS as a tool to flip the drawing upside down without 
changing its orientation with respect to the WCS. Now you’ll use it again to cre-
ate the front and back elevations.

Making the Front and Back Elevations
You can generate the front and back elevations by using techniques similar to 
those you have been using for the two side elevations. You need to be able to 
transfer the heights of building components from one of the side elevations to 
either of the remaining elevations. To do this, you’ll make a copy of the first 
elevation you drew, rotate it 90º, and then line it up so that you can transfer the 
heights to the front elevation. It’s quite easy:

 1. Continue using I10-13-NorthElevUCS.dwg (M10-12-NorthElevUCS 
.dwg), or open it if it’s not already open.

 2. Zoom out slightly and then zoom in to a view of the floor plan and 
the first elevation.

 3. Pan the drawing so that the floor plan and elevation are on the left 
part of the drawing area.

You need to transfer the height data from the side elevation to the 
front elevation. To ensure that the front elevation is the same dis-
tance from the floor plan as the side elevation, you’ll use a 45˚ line 
that extends down and to the right from the rightmost and lower-
most lines in the floor plan.

 4. Turn on Polar Tracking, and ensure that Increment Angle is set to 45 .̊ 
Also make sure that the Object Snap Tracking button on the status 
bar is toggled on.

 5. Set the Endpoint osnap to running, and be sure the Midpoint osnap 
isn’t running.

 6. Start the LINE command.

 7. Move the crosshair cursor to the bottom-right corner of the front 
stairway handrail in the floor plan. Hold it there for a moment.

A cross appears at the intersection point. Don’t click yet.
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 8. Move the crosshair cursor to the lower-right corner of the roof pop-
out in the floor plan, and hold it there until a cross appears at that 
point. Don’t click yet.

 9. Move the crosshair cursor to a point directly to the right of the cor-
ner of the roof pop-out and directly under the intersection point of 
the handrail (see the top of Figure 10.48).

F I G u R E   1 0 . 4 8 :   Starting a diagonal reference line with tracking points (top) 
and the completed diagonal line (bottom)

Vertical and horizontal tracking lines appear and intersect where 
the crosshair cursor is positioned, and a small X appears at the inter-
section. A tracking tooltip also appears.
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 10. Click to start a line at this point.

 11. Move the crosshair cursor down, away from this point and to the 
right at a negative 45˚ angle (or a positive 315˚ angle).

 12. When the 45˚ Polar Tracking path appears, enter 40′↵ (12200↵). 
Press ↵ again.

This completes the diagonal reference line (see the bottom of 
Figure 10.48).

 13. Start the COPY command, and select the entire south elevation and 
nothing else. Then press ↵.

 14. For the base point, select the left endpoint of the baseline of the cabin.

 15. For the second point, pick the Intersection osnap, and place the cursor 
on the diagonal line.

 16. When the X symbol with three dots appears at the cursor, click (see 
Figure 10.49).

F I G u R E   1 0 . 4 9 :   Using the diagonal line to find the extended intersection

 17. Move the cursor to any point on the baseline of the south elevation.
An X appears on the diagonal line, where the ground line would 

intersect it if it were longer (see the top of Figure 10.50). This is 
called the implied intersection: a distinct object snap in itself, and 
also the osnap that is used when the Intersection osnap is specified 
but an intersection is not clicked. This is why the three dots appear 
after the X symbols.
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F I G u R E   1 0 . 5 0 :   Making a copy of the side elevation (top) and adjusting the 
view (bottom)

 18. When the X appears, click to locate the copy.

 19. Press Esc to end the COPY command.

 20. Zoom out to include the copy, and then use Zoom Window to include 
the floor plan and south elevations (see the bottom of Figure 10.50).

 21. Press Esc to terminate the COPY command.

 22. Start the ROTATE command, and select the copy of the south eleva-
tion; then press ↵.

 23. Activate the Intersection osnap, and click the intersection of the 
diagonal line with the baseline as you did in steps 15 and 16.

 24. For the angle of rotation, enter 90↵ (see Figure 10.51).
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F I G u R E   1 0 . 5 1 :   Rotating the copied elevation

 25. Start the MOVE command and, when prompted to select objects, enter 
P↵ ↵ to select the most recently selected objects. The rotated eleva-
tion is selected.

 26. For the base point, click a point in a blank space to the right of the 
rotated elevation and on the upper part of the drawing area.

 27. For the second point, move the cursor down using Polar Tracking 
until the last step on the elevation is lower than the roof pop-out in 
the plan view. Then click.

 28. Zoom out, and use Zoom Window to adjust the view (see 
Figure 10.52).

 29. Save the current drawing as I10-14-FrontElevProjection.dwg 
(M10-14-FrontElevProjection.dwg).
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F I G u R E   1 0 . 5 2 :   The copied elevation moved and rotated into place with the 
view adjusted

The rest of the process for creating the front elevation is straightforward and 
uses routines you have just learned. Here’s a summary of the steps:

 1. Continue using I10-14-FrontElevProjection.dwg (M10-14-
FrontElevProjection.dwg), or open it if it’s not already open.

 2. Set up a new UCS for the front elevation showing the east side of the 
cabin:

 a. From the ViewCube, click the UCS drop-down menu ➢ New UCS.

 b. Rotate the UCS 90˚ about the z-axis by entering Z↵90↵ at the 
command line.

 c. Use the PLAN command to rotate the drawing to the current UCS.

 3. Drop construction lines from the floor plan across the drawing area 
and height lines. You will create these in the copied elevation.
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 4. Trim or fillet these lines as required, and add any necessary lines:

 a. Draw the roof first and remember that there is a thin layer of 
roof covering (see the top of Figure 10.53).

F I G u R E   1 0 . 5 3 :   Incrementally drawing the front elevation starting with the 
roof (top); the wall, door, and foundation (middle); and finally the deck (bottom)
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 b. Draw the wall, door, and foundation next.
You won’t be able to get the height line for the sliding glass 

door from the side elevation. It’s 7′-3″ (2210 mm) from the top 
of the deck (see the middle of Figure 10.53).

 c. Draw the pop-out, deck, and support posts.
The support post measures 1′-0″ (305 mm) across.
The railing posts have the same size and spacing on the front 

of the deck as they do on the sides.

 d. Copy the associative Array object from another elevation, and 
use the grips to adjust the Item Count.

This process can create a congested drawing, and you may want to 
draw the guidelines only as necessary to draw each component and 
then erase them. (See the bottom of Figure 10.53.)

t I P  Although colors aren’t visible in this book’s grayscale print, it’s a good idea to 
“layer” your drawing when working with so many extension lines at once. Because each 
layer has a different color, assigning layers as you go will help you differentiate objects 
by color.

 5. Erase or trim away any lines that represent objects that are visually 
behind any objects in the foreground.

For instance, do not draw two lines on top of one another in areas 
where the foundation is behind the steps or support posts or where 
the vertical door lines are behind the railings. Only draw the features 
you would see if you were standing at the front of your cabin.

 6. Make sure all the objects reside on the proper A-ELEV-… layer.
When you’re finished, the east elevation should look like 

Figure 10.54.
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F I G u R E   1 0 . 5 4 :   The completed east elevation

 7. Erase the copy of the south elevation and the diagonal transfer line.

 8. Name and save the UCS and view (call them both East_Elev).

 9. Save the current drawing as I10-15-EastElev.dwg (M10-15-
EastElev.dwg).

Selection Cycling

When creating elevations, you might accidentally draw a line over an existing 
line. To catch this error, take the following steps:

 1. Select Customization ➢ Selection Cycling from the status bar if the 
Selection Cycling tool isn’t already displayed.

 2. Turn on Selection Cycling from the status bar.

 3. Move your cursor over the suspect line.

(Continues)

www.MouradEngineering.com



6 0 2 	 C h a p t e r 	 1 0 	 • 	 G e n e r a t i n g 	 E l e v a t i o n s

If more than one object exists in a given area, two blue boxes will appear in 
the upper-right quadrant of the cursor, as shown here:

 4. Pick the object, which opens the Selection dialog box.

 5. In that dialog box, cycle through each of the overlapping objects.

You can create the rear elevation from a mirrored image of the front elevation. 
Here are the steps:

 1. Continue using I10-15-EastElev.dwg (M10-15-EastElev.dwg), or 
open it if it’s not already open.

 2. Mirror the front elevation to the opposite side.

 3. Set up a UCS for the left elevation:

 a. From the ViewCube, click the UCS drop-down menu ➢ New UCS.

 b. Rotate the UCS 90˚ about the z-axis by entering Z↵180↵ at the 
command line.

 c. Use the PLAN command to rotate the drawing to the current UCS.

Now you’ll revise the elevation to match the left side of the cabin.

 4. Temporarily move the railing posts a known distance and angle away 
from their current locations.

 5. Use the STRETCH command and Perpendicular osnap to stretch the 
stairway and railings to match the stairway location on the back of 
the cabin as shown on the floor plan.

 6. Move the railing posts back to their original locations.

 7. Adjust the associative Array objects to add or delete posts as required.

 8. Delete the sliding door frame that divides the left and right panels, 
and then adjust the door to match the extents shown on the plan view.

Selection Cycling (Continued)
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 9. Move the wall lines to the A-ELEV-WALL layer.

 10. Add the window with the lower edge at 2′-11″ (889 mm) above the 
baseline and the top edge at 7′-11″ (2413 mm) above the baseline.

When you’re finished, the elevation should look like Figure 10.55.

F I G u R E   1 0 . 5 5 :   The completed rear elevation

 11. Name and save the UCS and view (call them both West_Elev).

When you have completed all the elevations, follow these steps to clean up and 
save the drawing:

 1. To return to the WCS, from the ViewCube, click the UCS drop-down 
menu and choose WCS.

 2. Display the plan view (PLAN command).

 3. Erase any remaining construction lines.

 4. Thaw the A-ANNO-TEXT layer, and then move the notes down and to 
the left so that they no longer overlap any elevation.

www.MouradEngineering.com



6 0 4 	 C h a p t e r 	 1 0 	 • 	 G e n e r a t i n g 	 E l e v a t i o n s

 5. Copy and rotate the FLOOR PLAN label under each of the plans, and 
edit the content appropriately.

 6. Zoom out slightly for a full view of all elevations.
The drawing should look like Figure 10.56.

F I G u R E   1 0 . 5 6 :   The finished elevations

 7. Save the drawing as I10A-FPLAYO.dwg (M10A-FPLAYO.dwg).

Considering Drawing Scale Issues
This last view raises several questions: How will these drawings best fit on a 
page? How many pages will it take to illustrate these drawings? What size sheet 
should you use? At what scale will the drawing be printed? In traditional hand 
drafting, you wouldn’t be able to draw the first line without answers to some of 
these questions. 

You have completed a great deal of the drawing on the computer without hav-
ing to make decisions about scale and sheet size because, in AutoCAD, you draw 
in real-world scale, or full scale. This means that when you tell AutoCAD to 
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draw a 10′ (3048 mm) line, it draws the line 10′ (3048 mm) long. If you inquire 
how long the line is, AutoCAD will tell you that it’s 10′ (3048 mm) long. Your 
current view of the line might be to a certain scale, but that changes every time 
you zoom in or out. The line is stored in the computer as 10′ (3048 mm) long.

You need to make decisions about scale when you’re choosing the sheet size, 
putting text and dimensions on the drawing, or using hatch patterns and non-
continuous linetypes. (Chapter 11 covers hatch patterns, and Chapter 12 covers 
dimensioning.) You were able to avoid selecting a scale based on linetypes alone 
in Chapter 6, “Using Layers to Organize Your Drawing,” by setting all three 
LTSCALE variables to 1. Thanks to the flexibility this method provides, you were 
able to avoid committing to a scale so early in the project.

Instead you were largely able to postpone the scale decision until you began 
setting up your title block. At that point, you discovered that the largest scale 
that would allow you to keep the entire floor plan visible on a single sheet was 
about 1/2″ = 1′-0″. That scale has a true ratio of 1:24, or a scale factor of 24. 
You’ll get further into scale factors and true ratios of scales in the next chapter.

If you look at your I10A-FPLAYO.dwg (M10A-FPLAYO.dwg) drawing with all ele-
vations visible on the screen, the dashes in the dashed lines look like they might 
be too small, so you might need to increase the linetype scale factor. As you may 
recall, the easiest way to preview how the drawing scale affects linetypes is to 
change the annotation scale. This is possible because LTSCALE, PSLTSCALE, and 
MSLTSCALE are each set to 1.

Something else to consider is how the elevations you just drew will fit into 
your plotted plan set. If you were to thaw the title block’s layer now, you would 
see that your elevations wouldn’t all fit. Don’t worry about that yet. Beginning 
with the next chapter, and right on through the end of this book, you’ll need to 
make decisions about scale each step of the way.

Drawing Interior Elevations
Sometimes referred to as sections, interior elevations can be constructed using 
the same techniques you learned for constructing exterior elevations. You drop 
lines from a floor plan through offset height lines and then trim them away. 
Interior elevations usually include fixtures, built-in cabinets, and built-in shelves, 
and they show finishes. Each elevation consists of one wall and can include a side 
view of items on an adjacent wall if the item extends into the corner.

Not all walls appear in an elevation—usually only those that require special 
treatment or illustrate special building components. You might use one eleva-
tion to show a wall that has a window and to describe how the window is treated 
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or finished, and then assume that all other windows in the building will be 
treated in the same way unless noted otherwise.

In the next chapter, you’ll learn how to use hatch patterns and fills to enhance 
floor plans and elevations.

If You Would Like More Practice…
Here are three exercises for practicing the techniques you learned in this chap-
ter. The last one will give you practice in basic orthogonal projection.

Exterior Elevations  Open I10A-FPLAYO.dwg (M10A-FPLAYO.dwg), and revise 
each elevation by adding 1 1/2″ (38 mm) frames around the windows and doors. 
Add mullions, the dividers between windowpanes, to separate each window 
into four equal panes. Add a rectangular window to the back door. Figure 10.57 
shows the revised south elevation with the features added to the windows.

F I G u R E   1 0 . 5 7 :   The revised south elevation

Interior Elevations  For some practice with interior elevations, try drawing 
one or two elevations. You can measure the heights and sizes of various fixtures 
in your own home or office as a guide.

orthogonal Projection  Draw the three views of the block shown in 
Figure 10.58, following the procedures you used for the cabin elevations, except 
that, in this case, you’ll use the procedure that mechanical drafters employ—
that is, draw the front view first, and then develop the top and right side views 
from the front view. The completed drawing, named X10-00-OrthoProject.dwg, 
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can be found on the book’s website, www.sybex.com/go/autocad2015ner, or by 
visiting www.thecadgeek.com.

F I G u R E   1 0 . 5 8 :   Front, top, and side views of a block

Are You Experienced?

now you can…

✔✔ draw exterior elevations from a floor plan

✔✔ create associative arrays

✔✔ use	grips	to	copy	objects

✔✔ add detail to an elevation

✔✔ set	up,	name,	and	save	a	UCS	and	a	view

✔✔ transfer height lines from one elevation to another

✔✔ copy, move, rotate, and mirror elevations
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CHAPtER 11

Working with 
Hatches, Gradients, 
and tool Palettes
Hatches can be abstract patterns of lines, they can be solid fills, or they 
can resemble the surfaces of various building materials. With a nearly end-
less number of combinations, hatches are incredibly versatile, and they pro-
vide a way to introduce depth and texture into otherwise flat plans.

Architectural plans frequently use hatches as a way to designate materials 
or even varying wall types. Similarly, solid and gradient hatches are popular 
ways to add realism to presentation drawings. This chapter demonstrates 
how each of these hatch types can be used to compose drawings in the 
Autodesk® AutoCAD® program.

To learn how to hatch and fill areas, you’ll start with some of the visible 
surfaces in the south elevation of the cabin. You’ll then move to the floor 
plan, hatch the floors, and put hatch patterns and fills in the walls and a 
gradient on the balcony. You’ll use the contextual Hatch Creation and Hatch 
Editor Ribbon tabs for the creation and manipulation of hatches and gradi-
ents. Gradient hatches are tools with many options that you can use to cre-
ate a sense of depth or texture in your drawings.

In this chapter, you will learn to

▶▶ Set	up	and	apply	both	user-defined	and	custom	hatch	patterns	 
to drawings

▶▶ Fill an enclosed area with a gradient solid color

▶▶ Set	up	and	use	palettes	and	palette	tools
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Hatching the South Elevation
Hatches and fills should be on their own layers so that they can be turned off or 
frozen without also making other objects invisible. You’ll begin the exercise by 
creating new layers for the hatches and assigning colors to them:

 1. Open the I10A-FPLAYO.dwg (M10A-FPLAYO.dwg) drawing created in 
Chapter 10, “Generating Elevations.” (See the “If You Would Like 
More Practice” section.)

If you did not complete those exercises, I10A-FPLAYO.dwg  
(M10A-FPLAYO.dwg) is also included in the Chapter 11 download 
found on this book’s website (www.sybex.com/go/autocad2015ner  
or www.thecadgeek.com).

t I P  To clearly see the visual effect of putting hatch patterns on the south ele-
vation, change the background color for the drawing area to white. Click the Options 
button at the bottom of the Application menu to open the Options dialog box, and then 
select the Display tab. Click the Colors button and choose 2D Model Space in the Context 
list, Uniform Background in the Interface Element list, and White in the Color list to make 
the change.

 2. Set up seven new layers as follows:

Layer name Color

A-ELEV-DOOR-PATT 21

A-ELEV-FNDN-PATT 91

A-ELEV-GLAZ-PATT 61

A-ELEV-ROOF-PATT 11

A-ELEV-SHAD-BNDY 60

A-ELEV-SHAD-PATT Black (White) (7)

A-ELEV-WALL-PATT 41

 3. For the A-ELEV-SHAD-BNDY layer only, click the printer icon in the 
Plot column of the Layer Properties Manager.
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The icon changes to a printer with a red circle and a line through 
it. The objects on that layer will not appear in print regardless of 
whether they are visible in the drawing area.

 4. Make the A-ELEV-ROOF-PATT layer current.
Now any new objects you create will be assigned to this layer.

 5. Start the HATCH command by clicking the Hatch button found on the 
Home tab ➢ Draw panel.

The contextual Hatch Creation Ribbon tab, shown in Figure 11.1, 
loads, and the command line reads Pick internal point or 
[Select objects/Undo/settings]:. You’ll use this same contex-
tual Ribbon tab to create and modify hatch entities in your drawing. 
Among the choices to make using this Ribbon tab are which pattern 
to use, the pattern’s properties, and the method for specifying the 
boundary of the area to be hatched. 

F I G u R E   1 1 . 1 :   The contextual Hatch Creation tab

 6. From the Pattern panel in the contextual Hatch Creation tab, click 
the down arrow in the lower-right corner.

A complete list of available hatch patterns appears in the expanded 
panel.

 7. Scroll down in the expanded Pattern panel to find and select the 
AR-RROOF pattern (see the left image in Figure 11.2).

F I G u R E   1 1 . 2 :   Selecting the AR-RROOF pattern from the expanded Pattern 
panel on the contextual Hatch Creation tab (left) and the Pattern panel after selecting 
the AR-RROOF pattern (right)

◀

You can also start the 
HATCH command by 
typing H↵.
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The expanded Pattern panel collapses to display the AR-RROOF 
pattern with a blue background, as shown on the right in 
Figure 11.2.

Besides the simple ability to select a pattern, hatches provide you 
with many more options to control their display. Many of these 
options, such as Scale and Angle, are found in the Properties panel 
on the contextual Hatch Creation tab. The default 0.00 pattern angle 
is fine, but you need to adjust the Scale setting.

The Hatch Pattern Scale text box defaults to a scale of 1.0000. You 
can manually enter virtually any number into this text box, or you 
can use the up and down arrows on the right side to increase or 
decrease the scale.

 8. Enter 6 (150) in the Hatch Pattern Scale text box and press ↵, as 
shown in Figure 11.3.

F I G u R E   1 1 . 3 :   Setting the Hatch Pattern Scale on the contextual Hatch 
Creation tab

 9. In the Options section on the right side of the contextual Hatch 
Creation tab, verify that the Associative option is chosen.

If the Associative option has been chosen, a blue background 
appears behind the Ribbon tool. Associative hatches automatically 
update the areas they cover whenever their boundaries change. 
If you delete any component of the boundary, however, the hatch 
becomes nonassociative.

 10. Click the Pick Points button on the far left of the contextual Hatch 
Creation tab in the Boundaries panel.

 11. In the south elevation view, move your cursor somewhere near the 
middle of the roof area.

A preview of your hatch appears within the roof area, as shown at 
the top of Figure 11.4.
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F I G u R E   1 1 . 4 :   The Hatch preview displayed after the cursor hovers over the 
roof area (top), and the finished hatch pattern displayed in the roof area (bottom)

 12. With this preview correctly displaying the AR-RROOF pattern in the 
roof area, click and then press ↵ to create the hatch (see the bottom 
of Figure 11.4).

 13. Zoom in to a view of just the south elevation.
Notice how the appearance of the hatch pattern gets more detailed 

as the roof gets larger on the screen.

 14. Save this drawing as I11-01-RoofHatch.dwg (M11-01-RoofHatch.dwg).
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Looking at Hatch Patterns
Let’s take a short tour through the available patterns:

 1. Continue using I11-01-RoofHatch.dwg (M11-01-RoofHatch.dwg), or 
open it if it’s not already open.

 2. Start the HATCH command.

 3. With the contextual Hatch Creation tab open, expand the Pattern 
panel to browse the library of hatch patterns included with AutoCAD. 
Start at the top of the Pattern panel; the first group of hatch pat-
terns you will come across contains the ANSI patterns. These are 
abstract line patterns developed by the American National Standards 
Institute, and they are widely used by public and private design 
offices in the United States.

 4. Scroll down slightly farther to reveal 11 hatch patterns with names 
that begin with AR-. These patterns have been designed to look like 
architectural and building materials, which is why you see the AR 
prefix. In addition to the roof pattern you just used, you’ll see several 
masonry wall patterns, a couple of floor patterns, and one pattern 
each for concrete, wood shakes, and sand.

 5. Take a look below the AR- hatch patterns to see a number of non-AR 
patterns. These are geometrical patterns, some of which use common 
conventions to represent various materials.

n o t E  As mentioned at the start of this chapter, hatches aren’t purely limited 
to repeating patterns. Gradient hatches are also possible inside AutoCAD. The simplest of 
these gradient hatches is the linear option, but more-complex gradients are also avail-
able from the pattern library.

 6. Go almost to the bottom of the Pattern list to find some ISO pat-
terns. These are abstract line patterns developed by the International 
Organization for Standardization.

 7. Press the Esc key two times to collapse the Pattern panel, and press it 
again to cancel the HATCH command.

As you work with hatch patterns, you’ll need to adjust the scale factor for each 
pattern so that the patterns will look right when the drawing is printed. The 
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AR patterns are drawn to be used with the scale factor set approximately to the 
default of 1 to 1—displayed as 1.0000 (1)—and should need only minor adjust-
ment. However, even though the treatment you just chose for the roof is an 
AR pattern, it is something of an anomaly. Instead of using it as is, you had to 
change its scale factor to 6.0000 (150) to make it look right in the drawing.

t I P  When you’re using one of the AR patterns, begin with a scale factor at 1.0000 
until you preview the hatch; then you can make changes. This rule also applies to the 
14 ACAD_ISO patterns displayed on the Pattern panel of the contextual Hatch Creation 
Ribbon tab.

For the rest of the non-AR patterns, you’ll need to assign a scale factor that 
imitates the true ratio of the scale at which you expect to print the drawing. 
Table 11.1 gives the true ratios of some of the standard scales used in architec-
ture and construction. When you’re using metric units, the scales are simple 
ratios (1:50, 1:100, and so on).

t A B L E   1 1 . 1 :   Standard scales and their corresponding ratios

Scale true scale factor

1″ = 1′-0″ 12

1⁄ 2″ = 1′-0″ 24

1⁄4″ = 1′-0″ 48

1⁄8″ = 1′-0″ 96

1⁄16″ = 1′-0″ 192

The scale is traditionally written by mixing inches with feet in the expression, 
which causes some confusion. For example, the third scale in the table, com-
monly called quarter-inch scale, shows that a quarter inch equals 1 foot. A true 
ratio of this scale must express the relationship by using the same units, as in 
1⁄4″ = 1′-0″. Simplifying this expression to have no fractions, you can translate 
it to, say, 1′ = 48″. This is how you arrive at the true scale factor of 48, or the 
true ratio of 1:48. The exact method for calculating this ratio can be found in 
Chapter 8, “Controlling Text in a Drawing.”

As you continue through this chapter, take special note of the various scale 
factors used for different hatch patterns.
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Hatching the Rest of the South Elevation
You’ll apply hatches to the foundation, support posts, wall, and ground. You’ll 
then work with some special effects.

using a Concrete Hatch on the Foundation

Follow these steps to hatch the foundation:

 1. Continue using I11-01-RoofHatch.dwg (M11-01-RoofHatch.dwg), or 
open it if it’s not already open.

 2. From the Home tab ➢ Layers panel, set the current layer to 
A-ELEV-FNDN-PATT.

 3. Start the HATCH command. Then expand the Pattern panel from the 
contextual Hatch Creation tab to display the library of available hatch 
patterns.

 4. Scroll as necessary to find and select the AR-CONC pattern.

 5. Moving to the Properties panel, enter 1 (25) in the Hatch Pattern 
Scale text box to set the scale to 1.0000 (25).

 6. Expand the Options panel, and select the Create Separate Hatches 
option, as shown in Figure 11.5.

F I G u R E   1 1 . 5 :   Choosing the Create Separate Hatches option from the 
expanded Options panel

When multiple areas are selected for hatching, this option creates 
a distinct hatch in each area rather than a single hatch consisting of 
multiple, noncontiguous hatched areas.
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 7. Move your cursor back to the drawing area, and click once in each 
rectangle representing the foundation and the deck support posts.

To confirm your hatch area selection visually, pay attention to the 
live preview that appears before you pick the internal point for each 
hatch area. After you’ve chosen these points, the boundary used to 
create each hatch insertion glows blue, providing yet another visual 
cue during the hatch-creation process.

 8. Press ↵ or click the Close Hatch Creation button on the contextual 
Hatch Creation tab to end the HATCH command.

The Concrete hatch pattern is then applied to the foundation and 
support areas, as shown in Figure 11.6.

F I G u R E   1 1 . 6 :   The south elevation with a Concrete hatch pattern added to 
the foundation and support posts

 9. Save this drawing as I11-02-FoundationHatch.dwg (M11-02-
FoundationHatch.dwg).

Take a moment to pick the hatch insertion for one of the deck support posts. 
Notice how the hatch insertion is separate from the hatch for the foundation 
and the other deck support post. By default, all of the areas selected during a 
single instance of the HATCH command are grouped together as a single hatch 
entity. Because you chose the Create Separate Hatches option, each area is a 
separate hatch entity.
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Creating Multiple Foundation Hatch Entities

When you select the deck support-post hatch entity, you might forget to choose 
Create Separate Hatches from the Options panel of the contextual Hatch Creation 
tab. If you do, you can correct the problem without having to erase and then re-
create the foundation hatching:

 1. Select the foundation hatch to open the contextual Hatch Editor tab.

This tab is similar to the Create Hatch tab you have already used.

 2. Expand the Options panel and select Separate Hatches.

What was formerly a single hatch entity splits into three separate hatch entities: 
the cabin foundation and two deck support posts.

You’ll work with the Hatch Editor shortly, in the “Hatching the Pop-Out” section.

Hatching the Wall

For the walls, you’ll use the AR-RSHKE pattern, which looks like wood shingles 
(often called shakes). You’ll need to account for the openings in the wall for the 
windows and the pattern change at the pop-out. Here are the steps:

 1. Continue using I11-02-FoundationHatch.dwg (M11-02-
FoundationHatch.dwg), or open it if it’s not already open.

 2. Change the current layer to A-ELEV-WALL-PATT.

 3. Start the HATCH command, and go through the same process to apply 
a hatch to the wall. Here is a summary of the steps:

 a. Expand the Pattern panel on the contextual Hatch Creation tab 
to choose the AR-RSHKE pattern.

 b. Set the Hatch Pattern Scale to 1 (25) from the Properties panel.

 c. Verify that Create Separate Hatches is selected from the Options 
panel.

 d. Using the live preview, pick a point inside the pop-out wall and 
pick one on each side of the wall.

When choosing points on either side of the pop-out, make 
sure that you do not to pick a point inside the window.
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Each wall section is hatched using the AR-RSHKE pattern, as 
shown in Figure 11.7.

F I G u R E   1 1 . 7 :   The completed hatching of the south wall

 4. Save this drawing as I11-03-WallHatch.dwg (M11-03-WallHatch.dwg).

Even though a hatch entity for each wall section exists, there’s not much to 
distinguish the pop-out from the main wall. The next section demonstrates how 
to do this by modifying the location where AutoCAD begins the hatch pattern.

Hatching the Pop-out

The hatch has a base point, or origin (usually at the drawing’s origin of 0,0), 
which is the starting point for the pattern that is emitted equally in all direc-
tions. If you hatch two overlapping areas with separate hatches, the hatches in 
the overlapping areas will be identical. This is the problem with the pop-out: 
even though the pop-out wall was a different hatched area than the areas on 
either side, the pattern appeared to be continuous because all three hatches 
share the same origin. In this exercise, you’ll edit the origin for the pop-out:

 1. Continue using I11-03-WallHatch.dwg (M11-03-WallHatch.dwg), or 
open it if it’s not already open.

 2. Zoom in to and select the AR-RSHKE hatch for the pop-out.
The contextual Hatch Editor tab opens to display a Ribbon very 

similar to the contextual Hatch Creation tab you used earlier. Both 
contextual tabs are nearly identical, with subtle differences such 
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as Create Separate Hatches on the Hatch Creation tab vs. Separate 
Hatches found on the Hatch Editor tab.

 3. Expand the Origin panel on the contextual Hatch Editor tab, and 
select the Bottom Left button.

The AR-RSHKE pattern updates, and it is no longer in line with 
the AR-RSHKE pattern along the main wall. As you can see from 
expanding the Origin panel, the software provides a number of pre-
defined origin points out of the box. Another option is to define a 
new origin point manually.

Origin points may be defined by graphically picking a location on 
the screen or by manually entering a point at the command line.

 4. Click the Set Origin button found on the contextual Hatch Editor 
tab ➢ Origin panel.

 5. At the Select point: prompt, choose the lower-left endpoint for the 
pop-out, as shown in Figure 11.8.

F I G u R E   1 1 . 8 :   Revising the hatch origin for the pop-out

 6. Press Esc to deselect the hatch for the pop-out, and exit the HATCH 
command.

The contextual Hatch Editor tab will also close after you deselect 
the hatch.

Once complete, the south elevation should resemble Figure 11.9.

 7. Save the current drawing as I11-04-PopOut.dwg (M11-04-PopOut.dwg).
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F I G u R E   1 1 . 9 :   The pop-out with the revised hatch pattern

Modify the Hatch origin with Multifunction Grips

Hatches are one of several AutoCAD objects, including lines, polylines, dimensions, 
and multileaders, that feature multifunction grips. Multifunction grips provide 
contextual access to many common commands, reducing the need to take your 
eyes off your design to launch commands from the Ribbon. Among these tools 
for hatch objects is the Origin function. To use multifunction grips to modify the 
origin of a hatch, follow these steps:

 1. Select the hatch whose origin you would like to change. A circular grip 
appears at the center of the hatched area.

 2. Move your cursor atop the circular hatch grip so that it changes from blue 
to red. Without clicking, keep your cursor in place for a moment to display the 
contextual multifunction grip menu.

 3. Select Origin Point from the contextual multifunction grip menu, and use 
your cursor to choose a new origin point for the selected hatch.
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using a Solid-Fill  Hatch

The windows will be hatched with a solid fill. You apply this hatch in the same 
way as the other hatches you’ve been using, except that you don’t have a choice 
of scale or angle:

 1. Continue using I11-04-PopOut.dwg (M11-04-PopOut.dwg), or open it 
if it’s not already open.

 2. Make A-ELEV-GLAZ-PATT the current layer.

 3. Start the HATCH command to open the contextual Hatch Creation 
Ribbon tab, and then click the Swatch sample box.

 4. Select the first pattern, SOLID, on the Properties panel.

n o t E  The text boxes for Angle and Scale aren’t available because they don’t 
apply to solid fills.

 5. Change the value of the Hatch Type pull-down from Pattern to Solid 
(see Figure 11.10).

F I G u R E   1 1 . 1 0 :   Changing Hatch Type from Pattern to Solid

Note that the SOLID pattern is now selected (blue background) in 
the Pattern panel and that Background Color, Angle, and Scale are 
no longer available in the Properties panel and have been grayed out. 
Because the SOLID hatch pattern is a solid fill, these properties do 
not apply.

 6. Move your cursor back into the drawing area, and select a point in 
the middle of each glass pane, or the middle of the window if you 
didn’t draw the mullions.

Like the other hatches you have created, a preview of the final 
hatch is automatically displayed as you hover over each area.

 7. After selecting each glass pane, press ↵ to end the HATCH command.
The windows have a solid black (or white) fill (see Figure 11.11).
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F I G u R E   1 1 . 1 1 :   The windows with a solid-fill hatch

 8. Save the current drawing as I11-05-SolidFill.dwg (M11-05-
SolidFill.dwg).

t I P  Depending on the quality and resolution of your monitor, solid f ills can 
appear to flow over thin, nonhatched areas. This is only an illusion; the hatch actually 
stops at the border, as you can see if you zoom in to an area in question.

Applying Special Ef fects with Shading and Gradients

To finish this elevation, you need to show shading to give the impression that 
the roof overhangs the wall.

When shaded surfaces are illustrated on an exterior elevation, they give a 
three-dimensional quality to the surface. You’ll put some additional hatching at 
the top portion of the wall to illustrate the shading caused by the roof overhang.

You need to hatch the top 2′-0″ (610 mm) of the wall with a gradient. To deter-
mine the boundary line of the hatch, you’ll turn off the layer that has the shake 
pattern. You’ll then create a guideline to serve as the lower boundary of the 
hatch. Follow these steps to use hatching to shade under the roof overhangs:

 1. Continue using I11-05-SolidFill.dwg (M11-05-SolidFill.dwg), or 
open it if it’s not already open.

 2. Make the A-ELEV-SHAD-BNDY layer current, and then turn off the 
A-ELEV-WALL-PATT layer.
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using the Layer off tool

Try using the Layer Off tool (LAYOFF command) found on the Home tab ➢ Layers 
panel to turn off the A-ELEV-WALL-PATT layer.

To use it, simply follow these steps:

 1. Start the Layer Off (LAYOFF) command.

 2. Select the wall hatching.

Because the wall hatching is on the A-ELEV-WALL-PATT layer, it is turned off by 
you graphically selecting an object on that layer.

 3. Use the Rectangle (RECTANG) command to draw rectangles that 
extend from the corners, where the roof and vertical lines meet,  
to 2′-0″ (610 mm) below the lowest three roof lines.

Figure 11.12 shows the rectangles to draw in bold and the windows 
hidden for clarity.

Draw these rectangles.

F I G u R E   1 1 . 1 2 :   Creating the boundaries for the forthcoming gradient

 4. Make the A-ELEV-SHAD-PATT layer current, and then start the 
HATCH command.

 5. From the Properties panel in the Hatch Creation tab, change the 
Hatch Type property to Gradient (see Figure 11.13).
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F I G u R E   1 1 . 1 3 :   Using the contextual Hatch Creation tab to change the Hatch 
Type to Gradient

 6. Expand the Gradient Color 1 drop-down (also found on the Properties 
panel), and pick Select Colors from the bottom of the list.

This opens the Select Color dialog box, where you can pick the first 
color for your gradient. Unlike other hatches, gradients do not get 
their color from the layer they are on; you must explicitly select the 
color.

 7. Click the Index Color tab in the Select Color dialog box.

 8. Select color 250 in the bottom row of swatches (see Figure 11.14) and 
then click OK.

F I G u R E   1 1 . 1 4 :   Selecting the gradient color

The gradient samples found on the Pattern panel now include gray 
in their preview. Because our goal is to simulate shadows being cast 
from the roof, it’s best to have AutoCAD fade to white.

Although it’s possible to specify 255,255,255 (the RGB true color 
for white), the better choice is to make this a single-color gradient.
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 9. To create a single-color gradient, click the Gradient Colors button 
just below the drop-down list you used to select 250 as your first 
color.

Doing this disables the Gradient Color 2 drop-down list and will 
force the gradient to fade to white.

 10. In the second column of the Properties panel, change the angle to 270.
This will force the gradient to fade from color 250 at the top to 

white at the bottom.

 11. Expand the Pattern panel, and choose GR_LINEAR, as shown in 
Figure 11.15.

F I G u R E   1 1 . 1 5 :   Selecting the linear gradient type

 12. Click the Select Boundary Objects button on the Boundaries panel 
of the contextual Hatch Creation tab, and then click the three rect-
angles that you drew.

Using the Select Objects option, you can select closed polylines, 
circles, or ellipses as the boundary objects. The hatch inserts imme-
diately after you select the object.

t I P  An automatic preview is not displayed when you insert hatches by object. 
Instead, the hatch inserts immediately after selecting the object. If you accidentally 
choose the wrong object, press and hold the Shift key and select the boundary object you 
want to remove.
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 13. With each of the hatches in place, press ↵ to end the HATCH command.
When creating hatches, AutoCAD may not always initially display 

the result properly.

 14. Enter REA↵ to run the REGENALL command, which forces AutoCAD to 
reevaluate the drawing and refresh the drawing area.

Your gradients should look like Figure 11.16. The gradient obscures 
the windows, but you’ll fix that in the next couple of steps.

F I G u R E   1 1 . 1 6 :   The gradient shaded effect

 15. Turn on the A-ELEV-WALL-PATT layer. The shakes return, but the 
gradient hides a portion of them.

Although all objects in your drawing so far reside on the same 
plane, like lines on a piece of paper, one object may appear to be on 
top of another visually. You can rearrange the order of the objects 
by selecting them and then changing their location in the stacking 
order. You need to move the shading behind the hatch pattern.

 16. Select all the gradients, and then right-click in the drawing area.
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 17. From the right-click menu that opens, choose Draw Order ➢ Send To 
Back, as shown in Figure 11.17.

F I G u R E   1 1 . 1 7 :   Sending the gradient objects behind the others in the 
drawing

The gradient moves behind the shakes (see Figure 11.18). Don’t 
worry about the gradient boundaries; they won’t appear when the 
drawing is plotted.

F I G u R E   1 1 . 1 8 :   The gradient shaded effect after moving the gradients to  
the back

 18. Save this drawing as I11-06-GradientHatch.dwg (M11-06-
GradientHatch.dwg).

www.MouradEngineering.com



 U s i n g  H a t c h e s  i n  t h e  F l o o r  P l a n  6 2 9

Automatically Setting Draw order by object type

The draw order of objects such as hatches and annotations plays a critical role 
in the composition of a drawing. For this reason, AutoCAD provides several 
specialized commands to assign draw order by object type. These specialized 
draw order commands are found on the Home tab ➢ expanded Modify panel. 
In addition to tools such as Bring To Front and Send To Back, specialized tools 
such as Bring Text To Front, Bring Dimensions To Front, Bring Leaders To Front, 
Bring All Annotations To Front, and Send Hatches To Back exist.

using Hatches in the Floor Plan
In the floor plan, you can use hatches to fill in the walls or to indicate various 
kinds of floor surfaces.

So far, you’ve used only predefined hatch patterns—the 69 patterns that come 
with AutoCAD. For the floor, you’ll use a user-defined pattern, which is a series 
of parallel lines that you can set at any spacing and angle. If you want to illus-
trate square floor tile, for example, you can select the Double option of the user-
defined pattern, which uses two sets of parallel lines—one perpendicular to the 
other, resulting in a tiled effect. You’ll also learn how to control the origin of the 
pattern and then finish the floor.
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Creating the user-Defined Hatch Pattern
You’ll use the user-defined pattern for a couple of rooms and then return to the 
predefined patterns. Follow these steps:

 1. With I11-06-GradientHatch.dwg (M11-06-GradientHatch.dwg) 
open, zoom in to the floor plan and thaw the A-WALL-HEAD and 
A-FLOR-FIXT layers.

You can use the header lines to help form a boundary line across 
an entryway to a room and to keep the hatch pattern from extending 
to another room.

 2. With the floor plan in full view, freeze the A-ROOF and A-ANNO-
TEXT layers and then zoom in to the bathroom.

Even if the rooflines are dashed, they will still form a boundary to 
a hatch.

 3. Create a new layer called A-FLOR-PATT.

 4. Assign the layer color 141 and make it current.

 5. Start the HATCH command to load the contextual Hatch Creation tab.

 6. Change the Hatch Type to User Defined from the drop-down on the 
Properties panel of the contextual Hatch Creation tab.

After you choose User Defined as the Hatch Type, USER is selected 
as the current pattern in the Pattern panel, and the Scale text box in 
the Properties panel is replaced by the Hatch Spacing text box.

 7. In the Hatch Spacing text box, change 1″ (1) to 9′ (230).

 8. Expand the Properties panel and click the Double button (see 
Figure 11.19).

F I G u R E   1 1 . 1 9 :   Defining the hatch pattern
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 9. Back in the drawing, be sure no osnaps are running. Use the auto-
matic preview to pick two points to match the tiled hatch pattern 
shown in Figure 11.20 by doing the following:

 a. For the first point, pick a location in the bathroom floor area 
that is not touching the fixture lines or the door.

 b. To finish the bathroom floor hatch, click the floor between the 
door swing and the door, being careful to not touch the door.

F I G u R E   1 1 . 2 0 :   The tiled hatch pattern in place

 10. With the bathroom hatches in place, press ↵ to end the HATCH 
command.

The tiled hatch pattern should fill the bathroom floor and stop 
at the header, while not encroaching into the door or fixtures (see 
Figure 11.20).

 11. Save this drawing as I11-07-UserDefinedHatch.dwg (M11-07-
UserDefinedHatch.dwg).
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Note that the user-defined pattern has no scale factor about which it needs to 
be concerned. You simply set the distance between lines in the Hatch Spacing 
text box.

W A R n I n G  If you can’t get the HATCH  command to hatch the desired 
area, you might have left a gap between some of the lines serving as the hatch boundary. 
This can prevent AutoCAD from finding the boundary you intend to use. Zoom in to the 
areas where objects meet, and check to see that there are no gaps, or increase the Gap 
Tolerance value on the expanded Options panel in the contextual Hatch Creation tab.

Controlling the origin of the Hatch Pattern
Often a designer wants to lay out the tile pattern so that the pattern is centered 
in the room or starts along one particular edge. For this project, the tiles are set 
to start in the center of the room and move out to the edges, where they’re cut to 
fit. You’ll change the hatch pattern’s origin to set this up in the kitchen:

 1. Continue using I11-07-UserDefinedHatch.dwg (M11-07-
UserDefinedHatch.dwg), or open it if it’s not already open.

 2. Use the Pan and Zoom tools to slide the drawing up until the kitchen 
occupies the screen. Thaw the A-AREA-NPLT layer.

 3. Turn Object Snap Tracking on (on the status bar), and set the 
Midpoint osnap to be running.

 4. Start the HATCH command, and make sure that User Defined is still 
selected as the Hatch Type.

 5. From the Properties panel, change the Hatch Spacing to 12″ (305 mm) 
and verify that Double is selected by expanding the Properties panel.

 6. Choose the Set Origin tool from the Origin panel of the Hatch 
Creation tab, and move your cursor back into the drawing area.

 7. Use the running Midpoint osnap in conjunction with Object Snap 
Tracking to acquire the midpoint of the lower kitchen-area line and 
the midpoint of the right-side kitchen-area line.

When the cursor is positioned properly, two tracking lines and a 
tooltip appear (see the top of Figure 11.21).
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F I G u R E   1 1 . 2 1 :   Hatching the kitchen: the two tracking lines (top) and the 
finished, centered hatch (bottom)

This sets the origin of any subsequently created hatch patterns at the 
center of this room, and you see the prompt Pick internal point:.

 8. Similar to the way you hatched the bathroom, pick a point anywhere 
in the main floor area of the kitchen, and then pick a second point 
between the door swing and the door.

 9. After choosing the two points, press ↵ to end the HATCH command.
This places the hatch of 12″ (305 mm) tiles in the kitchen (see the 

bottom of Figure 11.21). Notice how the pattern is centered left to 
right and top to bottom.

 10. Save this drawing as I11-08-HatchOrigin.dwg (M11-08-
HatchOrigin.dwg).
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Each time you change the origin, all subsequent hatch patterns will use the 
new setting as their origin. For most hatches, the origin isn’t important, but 
if you need to control the location of tiles or specific points of other hatch pat-
terns, you can reset the hatch origin before you create the hatch by clicking 
Specify New Origin and then entering 0,0↵.

Finishing the Hatches for the Floors
To finish hatching the floors, you’ll use a parquet pattern from the set of predefined 
patterns in the living room and another user-defined pattern on the two decks:

 1. Continue using I11-08-HatchOrigin.dwg (M11-08-HatchOrigin.dwg), 
or open it if it’s not already open.

 2. Use Pan and Zoom to adjust the view so that it includes the living room.

 3. Using the (Layer) Off tool found on the Layers panel of the Home tab, 
select the wall header for the closet to turn off the A-WALL-HEAD layer.

 4. Start the HATCH command, and change the Hatch Type to Pattern 
from the Properties panel of the contextual Hatch Creation tab.

 5. Expand the Pattern panel on the contextual Hatch Creation tab, and 
select the AR-PARQ1 pattern.

 6. Set the scale to 1 (25) in the Properties panel, and verify that the 
angle is set to 0.

 7. Move your cursor back into the drawing area, and use the automatic 
preview to display what your hatch will look like when inserted into 
the drawing.

As you can see in Figure 11.22, the squares look a little small.

F I G u R E   1 1 . 2 2 :   The parquet hatch with its initial scale of 1 (25)
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 8. Return to the contextual Hatch Creation tab, and reset the Hatch 
Pattern Scale to 1.33 (34).

 9. Move your cursor back into the drawing area, pausing inside the liv-
ing room area to see a preview of the hatch.

 10. This looks better; click to insert the parquet pattern, and press ↵ to 
end the HATCH command.

The parquet pattern is placed in the living room (see Figure 11.23).

F I G u R E   1 1 . 2 3 :   The parquet hatch in the living room

 11. Freeze the A-AREA-NPLT layer.

 12. Start the HATCH command, and change the Hatch Type to User 
Defined in the Properties panel of the contextual Hatch Creation tab.

 13. Expand the Properties panel, and deselect the Double option.

 14. Set the Hatch Angle to 90 and Hatch Spacing to 6″ (152).

 15. Choose the Set Origin tool from the Origin panel, and use the 
Endpoint osnap to pick the lower-left inside corner of the front deck.

 16. Move your cursor anywhere inside the front deck area, pausing for a 
moment to see the automatic hatch preview display.

 17. Assuming the preview looks like Figure 11.24, click to insert the 
hatch into your drawing and press ↵ to end the HATCH command.
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F I G u R E   1 1 . 2 4 :   The user-defined hatch pattern on the front deck

 18. Repeat steps 12 through 17 on the back deck, using the lower-right 
corner of the deck as the hatch origin.

The transition between the kitchen and the living room floor cov-
erings isn’t as clean and evident as it could be.

 19. Draw a polyline with a width of 0 from the corner of the bathroom, 
perpendicular to the living room window opening and then directly 
to that window, as shown in bold in Figure 11.25.

Draw these lines.

F I G u R E   1 1 . 2 5 :   The hatch pattern on the rear deck and the line between the 
living room and kitchen

 20. Save the drawing as I11A-FPLAYO.dwg (M11A-FPLAYO.dwg).
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Modifying the Shape of Hatch Patterns
The next exercise demonstrates how hatches are associative. An associative 
hatch pattern automatically updates when you modify the part of a drawing that 
is serving as the boundary for the pattern. You’ll be changing the current draw-
ing, so before you begin making those changes, save the drawing as it is. Then 
follow these steps:

 1. Continue using I11A-FPLAYO.dwg (M11A-FPLAYO.dwg), or open it if it’s 
not already open.

 2. Zoom out and pan to get the floor plan and the north and south 
elevations in the view.

 3. Thaw the A-ANNO-TEXT, A-ROOF, and A-AREA-NPLT layers.
You’ll use the STRETCH command to modify the plan and two side 

elevations.

 4. Turn on Polar Tracking from the status bar.

 5. Start the STRETCH command by selecting the Stretch tool on the 
Home tab ➢ Modify panel.

 6. Pick a point above and to the right of the stairway in the north 
elevation.

 7. Drag a window down and to the left until a crossing selection window 
lands between the two closet doors in the floor plan and ends below 
the cabin in the south elevation (see the left image of Figure 11.26).
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F I G u R E   1 1 . 2 6 :   The crossing selection window (left) and the modified cabin 
with the adjusted hatch patterns (right)

 8. Click to complete the window, and then press ↵ to finish the selection 
process.

 9. For the base point, choose a point in the blank area to the right of the 
selection and click.

 10. Move the cursor directly to the right of the point you picked; then 
enter 5′ (1524↵).

The living room and roof are now longer, and the hatch pat-
terns have expanded to fill the new areas (see the right image of 
Figure 11.26).

 11. Close the current drawing. When prompted, choose to discard the 
changes.

Hatches are a necessary part of many drawings. You’ve seen a few of the pos-
sibilities AutoCAD offers for using them in plans and elevations.
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Creating and Managing tool Palettes
If you find yourself using particular hatch patterns over and over in various 
drawings, wouldn’t it be advantageous to have them available at a moment’s 
notice instead of setting them up each time? The AutoCAD tool palettes let you 
do just that and more. Now you’ll go through the process of setting up a few 
palettes and customizing them to contain specific hatch patterns, blocks, and 
commands that are used with the cabin drawings. From these exercises, you’ll 
get the information you need to set up your own custom palettes.

Creating a new tool Palette
You’ll create a new tool palette and then populate it with the blocks you’ve used 
so far in the cabin drawing:

 1. Open the I11A-FPLAYO.dwg (M11A-FPLAYO.dwg) file and thaw the 
A-ROOF layer.

 2. Click the Tool Palettes tool found on the View tab ➢ Palettes panel to 
display the Tool Palettes palette set on the screen.

 3. Place the cursor on a blank space on the palettes, right-click, and 
choose New Palette, as shown in Figure 11.27.

F I G u R E   1 1 . 2 7 :   Creating a new tool palette
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A new, blank palette appears with a small text box on it.

 4. Enter Cabin Blocks↵ to name the new palette.

 5. Open the AutoCAD DesignCenter™ by clicking its button on the 
View tab ➢ Palettes panel, by entering DC↵, or by pressing Ctrl+2 
on the keyboard.

 6. On the left side of DesignCenter, click the Open Drawings tab and then 
select the current drawing, I11A-FPLAYO.dwg (M11A-FPLAYO.dwg).

 7. When you find the filename, click the plus sign (+) to its left.
The list of drawing content types in it opens below the drawing.

 8. Select Blocks from this list.
Now the right side of the DesignCenter displays the six blocks in 

I11A-FPLAYO.dwg (M11A-FPLAYO.dwg), either as small images or by 
name only.

 9. Click the arrow on the Views button in the DesignCenter toolbar, 
and choose Large Icons as the view option to see a display like 
Figure 11.28.

F I G u R E   1 1 . 2 8 :   DesignCenter with the Large Icons view enabled

 10. Select A-DOOR and then hold down the Shift key and click GRID-V to 
select the five blocks used in plan view.
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 11. Click and drag the five blocks over to the Cabin Blocks palette.
Small images of the blocks appear on the new palette (see 

Figure 11.29), and they’re now available for any drawing. Simply drag 
a block off the palette and onto the drawing. You can then fine-tune 
its location, rotate it, and so forth. Any layers used by the block are 
also brought into the drawing.

F I G u R E   1 1 . 2 9 :   The Cabin Blocks tool palette you’ve just created

n o t E  Tool Palette tools such as blocks are dynamically linked back to the 
source DWG™ file. In this example, the five blocks you added to the Cabin Blocks tool 
palette are now available to any drawing, provided the I11A-FPLAYO.dwg (M11A-
FPLAYO.dwg) file still exists in its original location. Moving or deleting the drawing 
will break the link, consequently breaking the Tool Palette tool as well.

 12. Place the cursor on A-DOOR on the new palette, right-click, and then 
select Properties to open the Tool Properties dialog box.

It displays information about A-DOOR and provides a means to 
change many parameters (see Figure 11.30).
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F I G u R E   1 1 . 3 0 :   The Tool Properties dialog box

 13. Change the description for the A-DOOR tool to Use for 2′, 2′-6″, 3′, 
and 3′-6″ doors so that the tooltip will more accurately describe the 
block’s intended application (see Figure 11.30).

 14. Close the Tool Properties dialog box and then move your mouse over 
the A-DOOR tool to display its description.

Setting up a Palette for Hatches
To create a palette for hatches, you’ll create and name a new palette by using the 
same procedure as in the preceding section, but the hatches are assigned to the 
palette in a different way:

 1. Continue using I11A-FPLAYO.dwg (M11A-FPLAYO.dwg) or open it if it’s 
not already open.

 2. Right-click a blank space on the Cabin Blocks palette, choose New 
Palette, and then enter Cabin Hatches↵ in the text box.

 3. Zoom in on the south elevation of the cabin, and click the roof hatch 
to display a grip.

 4. Move the cursor to a portion of the roof hatch that isn’t close to the 
grip, and then click and drag the hatch pattern over to the new pal-
ette (see Figure 11.31).
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F I G u R E   1 1 . 3 1 :   Copying the roof hatch to the new palette

 5. When the cursor is over the palette and a horizontal line appears 
there, release the mouse button.

The roof hatch is now positioned on the palette and available 
for use in any drawing. Simply drag it off the palette and into the 
enclosed area in the drawing that you want to hatch with the pattern.

 6. Place the cursor on the new swatch of AR-RROOF, right-click, and 
choose Properties.

The Tool Properties dialog box opens (see Figure 11.32).

F I G u R E   1 1 . 3 2 :   The Tool Properties dialog box for the hatch pattern
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 7. Change the name from AR-RROOF to Cabin Roof, as shown on the 
left in Figure 11.33.

F I G u R E   1 1 . 3 3 :   Renaming the AR-RROOF tool (left) and the Cabin Hatches 
palette after the first hatch is renamed (right)

 8. Enter a description of what the hatch represents, such as Cabin roof, 
south elevation, or shakes.

Notice that the hatch has the angle and scale used on the roof and 
that the hatch is also on the A-ELEV-ROOF-PATT layer.

 9. Use the slider at the left to view all the properties.

 10. Click OK to close the dialog box and update the palette (see the right 
side of Figure 11.33).

By using the Tool Properties dialog box, you can also give hatches color. You 
can place all the hatches that you’ve used for the cabin so far on the palette in 
the same manner. They retain the properties they had in the original drawing, 
but by using the Tool Properties dialog box, you can change those properties.

Creating a Palette for Commands
Take a moment to look at a few of the sample palettes that come with AutoCAD, 
and check the properties of some of the items that you see. In addition to blocks 
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and hatches, there are command icons. These are placed on the palette in a 
slightly different way from blocks and hatches:

 1. Continue using I11A-FPLAYO.dwg (M11A-FPLAYO.dwg), or open it if it’s 
not already open.

 2. Right-click the Cabin Hatches palette in a blank area, and choose 
New Palette from the context menu.

 3. Name the new palette Commands.

 4. Use the Zoom and Pan tools to bring the kitchen floor plan into view.

 5. Click to select a single wall line, and then drag it to the palette, just 
as you dragged the hatches in the previous section.

This adds the A-WALL line to the Commands tool palette with the 
rather ambiguous name Line.

 6. Right-click the Line tool you just added to the Commands palette and 
choose Properties.

 7. From the Tool Properties dialog box, enter A-WALL for the name.

 8. Enter Creates a new wall object on the A-WALL layer as the descrip-
tion (see Figure 11.34).

F I G u R E   1 1 . 3 4 :   Changing the name and description for the A-WALL 
command tool
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 9. Repeat the process outlined in steps 5 through 8 to drag several 
additional objects of various kinds onto the Commands palette (see 
Figure 11.35).

F I G u R E   1 1 . 3 5 :   The Commands palette with four command icons

When you need to use one of these commands, click the icon on the palette.

using Auto-Hide

If you set the palettes to Auto-Hide, they fold under the palette title bar. When 
you put your cursor on the bar, the palettes display and then hide a moment after 
your cursor moves off the palettes. To activate Auto-Hide, follow these steps:

 1. Right-click the palette title bar.

 2. Choose Auto-Hide from the context menu.

This has been a brief introduction to the palette feature. To become familiar 
with palettes so that you can use them as you find the need, experiment with 
the various options. Try right-clicking a blank portion of a palette and investi-
gating the commands available on the context menu. From this menu, you can 
delete any palette, and you can copy and paste tools from one palette to another.

If You Would Like More Practice…
The hatching exercises in this chapter included only the floor plan and the south 
elevation. Complete the following exercise to hatch the three remaining elevations.

▶

You can also click the 
Auto-Hide button 
under the X at the top 
of the palette’s title bar 
to activate Auto-Hide.
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Creating the Hatch Patterns for the other 
Elevations
To create your hatch pattern for the roof, make these changes and additions to 
I11A-FPLAYO.dwg (M11A-FPLAYO.dwg):

 1. Make the A-ELEV-WALL-PATT layer current.

 2. Start the HATCH command.

 3. Click the Match Properties button on the Options panel of the con-
textual Hatch Creation tab, and then click the hatch pattern on either 
side of the pop-out in the south elevation.

This copies that hatch’s properties to the contextual Hatch 
Creation tab.

 4. Change the Hatch Angle in the Properties panel of the Hatch 
Creation tab to 180.

 5. Move your cursor to a point inside the wall in the north elevation to 
display the automatic preview.

 6. Assuming the hatch correctly fills the wall in the north elevation, 
click and press ↵ to insert the hatch and end the HATCH command.

 7. Repeat the previous process, changing the rotation, pattern, and 
layer until all the hatches and gradients in the south elevation (except 
the roof pattern, which appears only in the north and south) appear 
in the other three elevations.

▶▶ Make sure that you’re on the correct layer when creating the 
new hatches.

▶▶ You’ll need to draw additional rectangles on the A-ELEV-
SHAD-BNDY layer to constrain the new gradients. Use poly-
lines to draw the boundaries in the east and west elevations.

▶▶ Make sure that Create Separate Hatches is selected when you 
create the hatch patterns for the windows.

t I P  As you hatch the east, west, and north elevations, try using the LAYMCUR 
command (called the Make Object’s Layer Current tool on the Home tab ➢ Layers panel). 
This command will allow you to select an object and set its layer as current.
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When you are finished, the remaining elevations should look similar 
to those in Figure 11.36.

F I G u R E   1 1 . 3 6 :   The hatch patterns applied to the remaining elevations

 8. Set the UCS back to World, and use the PLAN command to reorient 
the drawing area.

 9. Save this drawing as I11A-FPLAYO.dwg (M11A-FPLAYO.dwg).

W A R n I n G  As layers are added to a drawing after saving a named view, 
you must select that named view in the View Manager dialog box and then click the 
Update Layers button to display the layers correctly when you set the view to Current.

Are You Experienced?

now you can…

✔✔ create a predefined hatch pattern and apply it to a drawing

✔✔ set up and apply user-defined hatch patterns

✔✔ modify the scale of a hatch pattern

✔✔ modify the shape of a hatch pattern

✔✔ control the origin of a hatch pattern

✔✔ apply solid fills and gradients

✔✔ create	and	populate	a	tool	palette	with	blocks,	hatches,	or	
commands
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Dimensioning a 
Drawing
Dimensions are the final ingredients to include with your cabin drawing. 
To introduce you to dimensioning, I’ll follow a pattern similar to the one I 
used in Chapter 8, “Controlling Text in a Drawing.” You will first create a 
dimension style that contains the properties for the dimensions, and then 
you will add the dimensions themselves.

In this chapter, you will learn to

▶▶ Set	up	a	dimension	style

▶▶ Dimension	the	floor	plan	of	the	cabin

▶▶ Modify existing dimensions

▶▶ Set	up	a	multileader	style

▶▶ Modify existing dimension styles

Introducing Dimension Styles
Dimension styles are similar to text styles but they give you more options to 
control. You set them up in the same way, but many parameters control the 
various parts of dimensions, including the dimension text. Each dimension 
has several components:

▶▶ The dimension line

▶▶ Arrowheads or tick mark

▶▶ Extension lines

▶▶ Dimension text (see Figure 12.1)
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Dimesion Text

Arrowhead 
(Tick Mark)

Extension Line

Dimesion Line

F I G u R E   1 2 . 1 :   The parts of a dimension

An extensive set of variables stored with each drawing file controls the appear-
ance and location of these components. You work with these variables through 
a series of dialog boxes designed to make setting up a dimension style as easy 
and trouble free as possible. Remember that Autodesk® AutoCAD® software 
is designed to be used by drafters from many trades and professions, each of 
which has its own drafting standards. To satisfy these users’ widely varied needs, 
AutoCAD dimensioning features have many options and settings for controlling 
the appearance and placement of dimensions in drawings.

Preparing for Dimensioning
Before you start setting up a dimension style, you need to make a few changes to 
your drawing to prepare it for dimensioning:

 1. Open I11A-FPLAYO.dwg (M11A-FPLAYO.dwg).
This is the cabin with hatch patterns added to all the views. If you 

didn’t complete the “If You Would Like More Practice” section in 
Chapter 11, “Working with Hatches, Gradients, and Tool Palettes,” 
you can download the file from this book’s website, www.sybex.com/
go/autocad2015ner or www.thecadgeek.com.

 2. Create a new layer called A-ANNO-DIMS, assign color 2 (Yellow), and 
make it current.

 3. Freeze all the remaining layers except 0, A-ANNO-TEXT, A-DECK, 
A-DECK-STRS, A-DOOR, A-GLAZ, A-ROOF, A-WALL, and all of the 
A-ELEV layers without a -PATT or -BNDY suffix.
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 4. Set the Endpoint and Midpoint object snaps to be running.

 5. Set the status bar so that only the Object Snap, Dynamic Input, and 
Selection Cycling buttons are in their On positions.

 6. Click the Annotate tab. Your drawing will look like Figure 12.2.

F I G u R E   1 2 . 2 :   The cabin floor plan and elevations with the Annotate panels 
at the top of the drawing area

Restoring the State of Multiple Layers

The Layer States Manager is an incredibly powerful tool that will allow you to 
restore the state of a large number of layers. Although it cannot create any layers, 
it can save, export, and import nearly every layer property found in the Layer 
Properties Manager. By default, these are saved inside the DWG™ file itself, but 
they may also be exported to an external file. Assuming that you have employed a 
solid layer standard such as the NCS, you can build a library of layer states to auto-
mate tasks such as turning layers on/off, changing the color of layers, and more.

Instead of making the layer visibility changes in step 3 manually, try importing 
and restoring a layer state found in this chapter’s set of download files:

 1.  Select Manage Layer States from the Layer States drop-down list found 
on the Home tab ➢ Layers panel.

The Layer States Manager dialog box opens.

 2.  Click the Import button in the Layer States Manager dialog box, and browse 
to the file 12-Start.las, found in the Chapter 12 download.

(Continues)
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To see the file, you may need to change the Files Of Type setting to Layer 
States in the Import Layer State dialog box.

 3.  Click Open to load the 12-Start.las file. The Layer State – Successful 
Import dialog box opens.

 4.  Select the Restore States button from the dialog box, which will automati-
cally apply the imported layer state.

 5.  You’ll look at the restore options in more detail in a moment, so click the 
Close Dialog button for now.

 6.  The lower-right corner of the Layer States Manager dialog box has a circular 
button with an arrow pointing to the right. Click it to expand the dialog box.

When you are restoring layer states, it’s not necessary to restore all properties 
associated with a layer. Instead, using the expanded Layer States Manager 
dialog box, you can pick the specific properties to restore by checking or 
unchecking the associated property.

 7.  With the 12-Start layer state selected, click the Restore button at the 
bottom of the Layer States Manager.

The Layer States Manager closes, the selected layer properties are restored 
(all properties in this case), and you are taken back to your drawing.

Creating a text Style for Dimensions
Critical for nearly all dimensions within a drawing is the text string that con-
tains a measurement. Although what a dimension is measuring may vary, the 
appearance of the text within the dimension should remain uniform throughout 
a drawing. Follow these steps to create a new text style for dimensions:

 1. Continue using I11A-FPLAYO.dwg (M11A-FPLAYO.dwg).

 2. Click the Text Style drop-down menu from the Annotate Ribbon 
tab ➢ Text panel, and select Manage Text Styles.

The Text Style dialog box opens.

Restoring the State of Multiple Layers (Continued)
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 3. Click the New button to open the New Text Style dialog box. Enter 
A-DIMS as the Style Name and click OK.

 4. Set up the A-DIMS text style to include the following parameters:

▶▶ Arial font

▶▶ 0′-0″ (0) height

▶▶ 0.8000 width factor

▶▶ All other settings at their default

If you need a reminder about creating text styles, refer to Chapter 8. 

 5. Apply this text style, click the Set Current button, and then close the 
Text Style dialog box.

t I P  Setting the text height to 0′-0″ (0) in the Text Style dialog box allows the Text 
Height parameter of the dimension style to dictate the actual height of the text in the 
drawing. This enables many dimension styles to use the same text style, each producing 
text with different heights. If you give the text a nonzero height in the Text Style dialog 
box, that height is always used and the Text Height parameter of the dimension style 
is disregarded. Typically, dimension styles are defined using a text style similar to the 
A-DIMS one you just created with a 0′-0″ text height.

Making a new Dimension Style
Every dimension variable has a default setting, and these variables as a group 
constitute the default Standard dimension style. As in defining text styles, the 
procedure is to copy the Standard dimension style and rename the copy—in 
effect making a new style that is a copy of the default style. You then make 
changes to this new style so that it has the settings you need to dimension your 
drawing and save it. Follow these steps:

 1. Continue using I11A-FPLAYO.dwg (M11A-FPLAYO.dwg).

 2. Click the Dimension Style button, the small arrow at the bottom 
right of the Dimensions panel on the Annotate tab, to open the 
Dimension Style Manager (see Figure 12.3).
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F I G u R E   1 2 . 3 :   The Dimension Style Manager

At the top left in the Styles list box, you’ll see Standard high-
lighted, or ISO-25 if your drawing is in metric.

 3. With Standard (ISO-25) highlighted in the Styles window, click the 
New button on the right side of the Dimension Style Manager.

The Create New Dimension Style dialog box shown in Figure 12.4 
opens.

F I G u R E   1 2 . 4 :   The Create New Dimension Style dialog box

 4. In the New Style Name field, Copy Of Standard (ISO-25) is high-
lighted. Enter A-DIMS-PLAN, but don’t press ↵ yet.

Because it’s the current dimension style in this drawing, the new 
dimension style you’re about to define will begin as a copy of the 
Standard style.

 5. Click the Continue button.
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The Dimension Style: A-DIMS-PLAN dialog box opens (see 
Figure 12.5). It has seven tabs, which you will use to define the 
appearance of the dimensions for your cabin project.

F I G u R E   1 2 . 5 :   Configuring the Lines tab of the New Dimension Style: A-DIMS-
PLAN dialog box

 6. Verify that the Lines tab is active (on top). If it’s not, click it, and 
change the following parameters to match Figure 12.5:

▶▶ Extend Beyond Dim Lines: 1/8″ (1.25)

▶▶ Offset From Origin: 1/8″ (1.25)

The Lines tab is used to control the appearance of the dimension 
and extension lines. In most cases, the color, linetype, and lineweight 
should stay at their default ByBlock value, indicating that an object 
inherits its color from the block containing it.

 7. Click the Symbols And Arrows tab, and change the following param-
eters within the Arrowheads group to match Figure 12.6:

▶▶ First: select Architectural Tick

▶▶ Second: select Architectural Tick
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▶▶ Leader: verify Closed Filled

▶▶ Arrow Size: 1/8″ (1.25)

F I G u R E   1 2 . 6 :   The Symbols And Arrows tab with the settings for the A-DIMS-
PLAN style

The Symbols And Arrows tab is used to control the appearance of 
arrowheads and other symbols related to dimensioning. Although 
the First and Second Arrowhead settings may be configured inde-
pendently, changing the First setting will automatically change the 
Second setting to match.

 8. Click the Text tab, and change the following parameters to match 
Figure 12.7.

Text Appearance Group:

▶▶ Text Style: select A-DIMS

▶▶ Text Height: 1⁄8″ (3.5)

Text Placement Group:

▶▶ Vertical: select Centered

▶▶ Horizontal: select Centered

▶

Architectural ticks are 
common for the build-
ing trades, whereas 
the Closed Filled option 
may be used in manu-
facturing or civil engi-
neering drawings. This 
list contains options for 
those and several other 
arrowheads, dots, and 
so on.
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Text Alignment Group:

▶▶ Vertical: select Aligned With Dimension Line

The settings in the Text tab control the appearance of dimension 
text and how it’s located relative to the dimension and extension lines.

F I G u R E   1 2 . 7 :   The Text tab with settings for the A-DIMS-PLAN style

 9. Click the Fit tab in the New Dimension Style dialog box, and change 
the following parameters to match Figure 12.8:

▶▶ Fit Options: select Either Text Or Arrows (Best Fit)

▶▶ Text Placement: select Over Dimension Line, Without Leader

▶▶ Scale For Dimension Features, Use Overall Scale Of: 48 (50)

▶▶ Fine Tuning: uncheck Draw Dim Line Between Ext Lines

These settings on the Fit tab control the overall scale factor of the 
dimension style and how the text and arrowheads are placed when the 
extension lines are too close together for both text and arrows to fit.
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F I G u R E   1 2 . 8 :   The new settings in the Fit tab

Setting up the Primary units tab 
(Architectural)
If your drawing is set up to use architectural units, continue with this section. If 
you are using decimal units, skip this section and continue with the next section, 
“Setting Up the Primary Units Tab (Metric).” In the preview window, you might 
have noticed that the numbers in the dimension text maintain a decimal format 
with four decimal places, rather than the feet-and-inches format of the current 
architectural units. Dimensions have their own units setting, independent of the 
basic units for the drawing as a whole. On the Primary Units tab, set the dimen-
sion units as follows:

 1. Click the Primary Units tab, and look at Figure 12.9 to see how it’s 
organized. As you can see in the figure, the Primary Units tab is 
divided into two main groups: Linear Dimensions on the left and 
Angular Dimensions on the right. Each of these sections has several 
types of settings.
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F I G u R E   1 2 . 9 :   The Primary Units tab after changes have been made using 
imperial units

 2. In the Linear Dimensions group, make the following changes, starting 
at the top:

 a. Change the Unit Format setting from Decimal to Architectural.

 b. Change the Precision setting to 1⁄8″.

 c. Change the Fraction Format setting to Diagonal.

 d. In the Zero Suppression group, uncheck 0 inches.

 3. In the Angular Dimensions group: 

 a. Verify that Units Format is set to Decimal Degrees.

 b. Change Precision to two decimal places.

 c. Leave the Zero Suppression section as it is.

After these changes, the Primary Units tab looks like Figure 12.9.
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n o t E  Zero Suppression controls whether the zero is shown for feet when the 
dimensioned distance is less than 1 foot and also whether the zero is shown for inches 
when the distance is a whole number of feet. For the cabin drawing, you’ll suppress the 
zero for feet, but you’ll show the zero for inches. As a result, 9″ will appear as 9″, and 3′ 
will appear as 3′-0″.

Setting up the Primary units tab (Metric)
If your drawing is set up to use architectural units and you’ve completed the 
previous section, skip this section and continue with the next, “Completing the 
Dimension Style Setup.”

In the preview window, you might have noticed that the numbers in the 
dimension text maintain a decimal format with four decimal places rather than 
the feet-and-inches format of the current architectural units. Dimensions have 
their own units setting, independent of the basic units for the drawing as a 
whole. On the Primary Units tab, set the dimension units as follows:

 1. Click the Primary Units tab, and look at Figure 12.10 to see how 
it’s organized. As you can see in the figure, the Primary Units tab 
is divided into two main groups: Linear Dimensions on the left and 
Angular Dimensions on the right. Each of these groups has several 
types of settings.

F I G u R E   1 2 . 1 0 :   The Primary Units tab after changes have been made using 
metric units

www.MouradEngineering.com



	 I n t r o du c i n g 	D im en s i o n 	 S t y l e s  6 6 1

 2. In the Linear Dimensions group, starting at the top, make the follow-
ing changes:

 a. Make sure Unit Format is set to Decimal.

 b. Change the Precision setting to 0.

 c. In the Suffix box, enter mm↵, making sure you add a space 
before the first m.

 d. In the Zero Suppression group, make sure Trailing is checked 
and Leading is not.

n o t E  Zero Suppression controls whether the zero is shown for measure-
ments when the dimensioned distance is less than 1 millimeter and whether the zero 
is shown when the f inal digits, to the right of the decimal point in the dimension,  
are zeros. For the cabin drawing, you’ll suppress the trailing zeros but not the leading 
zeros. As a result, .9500 will appear as 0.95 with Precision set to 0. This won’t be a fac-
tor during these exercises.

 3. In the Angular Dimensions group, leave Decimal Degrees as the 
Units Format setting and change Precision to two decimal places, 
as you did for the basic drawing units in Chapter 3, “Setting Up a 
Drawing.” For now, leave the Zero Suppression group as it is.

After these changes, the Primary Units tab looks like Figure 12.10.

Completing the Dimension Style Setup
Any industry involved in global projects may use the Alternate Units tab, and 
the mechanical engineering trades and professions use the Tolerances tab. You 
won’t need to make any changes to these last two tabs for this tutorial, but 
you’ll look at them briefly in this section and the next. 

First, it’s time to save these settings changes to the new A-DIMS-PLAN 
dimension style and to begin dimensioning the cabin:

 1. Click the OK button at the bottom of the New Dimension Style 
dialog box.

You’re returned to the Dimension Style Manager (see Figure 12.11).
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F I G u R E   1 2 . 1 1 :   The Dimension Style Manager with A-DIMS-PLAN listed

A-DIMS-PLAN appears with a gray background in the Styles list 
box, along with Standard and Annotative. In the lower-right corner 
of the dialog box, in the Description group, you’ll see the name of the 
new style. See Table 12.1, later in this section, as a reference for the 
differences between the Standard style that you started with and the 
A-DIMS-PLAN style.

 2. Click A-DIMS-PLAN to highlight it in a dark blue.

 3. Click the Set Current button and then click the Close button.
You’re returned to your drawing, and the Dimensions panel dis-

plays A-DIMS-PLAN in the Dimension Style drop-down list, as shown 
in Figure 12.12. This indicates that A-DIMS-PLAN is now the current 
dimension style.

F I G u R E   1 2 . 1 2 :   The Dimensions panel showing A-DIMS-PLAN as the current 
dimension style

 4. Save your drawing as I12-01-DimensionStyle.dwg (M12-01-
DimensionStyle.dwg).
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You have made changes to 16 settings that control dimensions. This isn’t too 
many, considering that there are more than 50 dimension settings. Table 12.1 
summarizes the changes you’ve made so that the dimensions will work with the 
cabin drawing.

t A B L E   1 2 . 1 :   Changes made so far

tab option Default Setting
A-PLAn-DIMS 
Setting

Lines Offset From Origin 0′-01⁄16″ (0.63) 0′-01⁄8″ (1.25)

Symbols And Arrows First Closed Filled Architectural Tick

Second Closed Filled Architectural Tick

Leader Closed Filled Closed Filled (Verify)

Arrow Style 3⁄16″ (2.5) 1⁄8″ (3.5)

Text Text Style Standard A-DIMS

Text Alignment Horizontal Aligned With 
Dimension Line

Text Height 3⁄16″ (2.5) 1⁄8″ (3.5)

Fit Fit Options Either Text Or Arrows 
(Best Fit)

Either Text Or Arrows 
(Best Fit) (Verify)

Overall Scale 1.000 (1) 48.000 (50)

Primary Units Unit Format Decimal Architectural

Fraction Format Horizontal Diagonal

Zero Suppression Feet, Inches  
(Trailing Only)

Feet Only  
(Trailing Only)

Angular Precision Zero decimal places Two decimal places

You’ll change a few more settings throughout the rest of this chapter as you 
begin to dimension the cabin in the next set of exercises. Now you’ll look briefly 
at the Alternate Units and Tolerances tabs.
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n o t E  The following section describes dimensioning features that you won’t 
use in the cabin project. If you would rather begin dimensioning the cabin and look at 
this material later, skip to the “Placing Dimensions on the Drawing” section.

Exploring the Alternate units and tolerances tabs
The New Dimension Style dialog box and the Modify Dimension Style dialog box 
contain two additional tabs named Alternate Units and Tolerances. Although 
neither of these tabs is necessary for the cabin project, I’ll quickly review some 
key points about each tab.

the Alternate units tab  If your work requires your dimensions to display 
both metric and architectural units, use the Alternate Units tab in the New 
Dimension Style dialog box or in the Modify Dimension Style dialog box when 
you are changing an existing style. In the example shown in Figure 12.13, the 
primary units setting is Architectural (Decimal).

F I G u R E   1 2 . 1 3 :   The Alternate Units tab after being set up for millimeters

Many of the settings found on the Alternate Units tab align with those found on 
the Primary Units tab. The core difference between these tabs is the Multiplier 
For Alt Units setting. Since 1″ is equal to 25.4 millimeters, the default value 
multiplier shown in Figure 12.13 is set to 25.4. Although 25.4 is the most 
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common multiplier value, you may enter a value of your choice to calculate val-
ues for another unit of measure. 

the tolerances tab  AutoCAD offers features with options that help you cre-
ate several kinds of tolerances: allowable variances from the stated dimension. 
These are very common in the machining and manufacturing industries, where 
it’s understood that the dimensions given are only approximations of the part 
fabricated. Tolerances are usually measured in thousandths of an inch or hun-
dredths of a millimeter.

The Tolerances tab provides four methods for creating lateral tolerances, which 
include Symmetrical, Deviation, Limits, and Basic. These represent the tradi-
tional kind of tolerance that most draftspeople use. This is the plus or minus 
kind of tolerance. If you were to set up the Tolerances tab as shown at the top of 
Figure 12.14, a dimension looks like the one shown at the bottom of the figure.

F I G u R E   1 2 . 1 4 :   The Tolerances tab with some settings changed (top) and a resulting 
dimension with deviation tolerances (bottom)
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Placing Dimensions on the Drawing
Upon returning to your drawing, it should still look almost exactly like 
Figure 12.1 (shown previously), and it should have the following:

▶▶ A new layer called A-ANNO-DIMS, which is current

▶▶ A new dimension style called A-DIMS-PLAN, which is current and is 
now displayed in the drop-down list on the Dimensions panel

▶▶ Most of the layers frozen

▶▶ The Endpoint osnap running (Other osnaps may be running, but 
only Endpoint is important to this exercise.)

▶▶ On the status bar: Ortho mode, Polar Tracking, and Object Snap 
Tracking off

▶▶ A new text style called A-DIMS, which is current

Placing Horizontal Dimensions
First you’ll dimension across the top of the plan, from the corner of the build-
ing to the closet wall, and then to the other features on that wall. Then you’ll 
dimension the decks and roof. Follow these steps:

 1. Open I12-01-DimensionStyle.dwg (M12-01-DimensionStyle.dwg), 
and zoom in to the area around the closet.

 2. Click the Linear Dimension button at the left side of the Dimensions 
panel on the Annotate tab to activate the DIMLINEAR command.

If the Linear Dimension button isn’t visible, click the down arrow 
below the current dimension command and then choose Linear from 
the drop-down list. The prompt reads Specify first extension 
line origin or <select object>:.

 3. Pick the upper-right corner of the cabin walls.
The prompt changes to Specify second extension line origin:.

 4. Activate the Perpendicular osnap, place the cursor over the outside of 
the closet wall as shown in Figure 12.15, and then click.
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F I G u R E   1 2 . 1 5 :   Selecting the wall with the Perpendicular osnap

 5. At the Specify dimension line location or: prompt, click a point 
above the roofline to place the dimension in the drawing (see the top 
of Figure 12.16).

F I G u R E   1 2 . 1 6 :   The dimension attached to the cursor (top) and the grips 
associated with a dimension (bottom)
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Also notice that the left extension line starts perpendicular to the 
wall you picked.

 6. Click anywhere on the new dimension.
The dimension becomes dashed, and five grips appear (see the bot-

tom of Figure 12.16).

n o t E  When you need to adjust a dimension, click and drag the necessary grip. 
You’ll learn more about using grips to modify dimensions in the “Modifying Dimensions” 
section later in this chapter.

 7. Press Esc to deselect the dimension.

 8. Save this drawing as I12-02-HorizDimension.dwg (M12-02-
HorizDimension.dwg).

Your first dimension is completed.
When dimensioning a drawing, you usually dimension to the outside or cen-

terline of the objects and to each significant feature. The next dimension will 
run from the left side of the first dimension to the right side of the window.

n o t E  Studs are the vertical 2″×4″ (51 mm × 102 mm) or 2″×6″ (51 mm × 152 mm) 
members in the framing of a wall. When dimensioning buildings that have stud walls, 
architects usually dimension to the face of the stud rather than the outside surface of the 
wall material, but I won’t go into that level of detail in this book.

using the Dimension Continue Command
AutoCAD has an automatic way of placing adjacent dimensions in line with 
one another—the DIMCONTINUE (Dimension Continue) command. You use it 
as follows:

 1. Continue using I12-02-HorizDimension.dwg (M12-02-
HorizDimension.dwg), or open it if it’s not already open.

 2. Zoom out, and pan until you have a view of the upper wall and 
roofline, with space above them for dimensions (see Figure 12.17).
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F I G u R E   1 2 . 1 7 :   The result of zooming and panning for a view of the top of 
the floor plan

 3. Enter DIMCONTINUEMODE at the command line, and verify that it is 
set to 1.

The DIMCONTINUEMODE system variable controls whether the 
DIMCONTINUE and DIMBASELINE commands use the current dimension 
style (system variable set to 0) or the style of the selected dimension 
(system variable set to 1). 

 4. Start the DIMCONTINUE (Dimension Continue) command by selecting 
the Continue button on the Annotate tab ➢ Dimensions panel.

If it’s not visible, click the down arrow next to the Baseline button 
and choose Continue from the flyout menu.

When you see the prompt Specify a second extension line 
origin or [Undo/Select] <Select>, all you need to do is pick a 
point for the right end of the dimension—in this case, the right cor-
ner of the nearest window.

 5. Click the right corner of the living room window.
This draws the second dimension in line with the first (see 

Figure 12.18). Note that the same prompt has returned to the  
command-line interface. You can keep picking points to place the 
next adjacent dimension in line.

F I G u R E   1 2 . 1 8 :   Using the DIMCONTINUE command
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 6. Continue adding dimensions with the DIMCONTINUE command by 
clicking (moving right to left) the endpoints of the window openings, 
the endpoint of the wall, and the end of the deck.

Continue Dimensions with Multifunction Grips

In addition to the Ribbon, dimensions may be continued by using multifunction 
grips. To access the DIMCONTINUE command by using multifunction grips, fol-
low these steps:

 1. Select the dimension you would like to continue.

 2. Hover over but do not select the dimension-line grip on the side to continue. 
The grip turns red, and the contextual multifunction grip menu displays.

 3. Choose Continue Dimension from the contextual multifunction grip menu 
to launch the DIMCONTINUE command.

 7. Use the Linear tool to add a dimension for the width of the front deck 
and the Perpendicular osnap to align the dimension lines.

When you’re finished, the dimensions in your drawing should look 
like Figure 12.19.

F I G u R E   1 2 . 1 9 :   Dimensions added to each critical point along the top wall
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Some of the dimensions, particularly those on the left end of 
the cabin, appear cluttered with some of the arrowheads and text 
overlapping.

 8. Select the dimensions that need adjustment, and use the grips near 
the arrows or at the text to adjust the dimension line or text location 
(see Figure 12.20).

Add this dimension.Move these dimensions.

F I G u R E   1 2 . 2 0 :   Adjusted dimensions with an overall cabin dimension added

 9. Add a linear dimension from the end of the front deck to the begin-
ning of the cabin, and another overall dimension from one end of the 
cabin to another, as shown in Figure 12.20.

 10. Save this drawing as I12-03-DimContinue.dwg (M12-03-
DimContinue.dwg).

With the DIMCONTINUE (Dimension Continue) command, you can dimension 
along a wall of a building quickly just by picking points. AutoCAD assumes that 
the last extension line specified for the previous dimension will coincide with the 
first extension line of the next dimension. If the extension line from which you 
need to continue isn’t the last one specified, press ↵ at the prompt, pick the exten-
sion line from which you want to continue, and resume the command.

Another automation strategy that you can use with linear dimensions is the 
Dimension Baseline tool.

using the Dimension Baseline Command
The DIMBASELINE (Dimension Baseline) command gets its name from a style of 
dimensioning called baseline, in which all dimensions begin at the same point 
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(see Figure 12.21). Each dimension is stacked above the previous one. Because 
of the automatic stacking, you can use the Dimension Baseline tool for overall 
dimensions. AutoCAD will stack the overall dimension a set height above the 
incremental dimensions.

F I G u R E   1 2 . 2 1 :   An example of baseline dimensions

The steps for creating baseline dimensions are described here:

 1. Create a linear dimension.

 2. Click the down arrow next to the Continue button in the Annotate 
tab ➢ Dimensions panel and then click the Baseline option.

The prompt reads Specify a second extension line origin 
or [Undo/Select] <Select>:, just like the first prompt for the 
DIMCONTINUE (Dimension Continue) command.

 3. Pick the next feature to be dimensioned.

 4. Repeat step 3 as necessary to add the required dimensions.

 5. Press Esc to end the DIMBASELINE command.

t I P  Try accessing the DIMBASELINE (Dimension Baseline) command by using 
multifunction grips. To access the contextual multifunction grip menu, hover over the 
dimension-line grip, holding your cursor in place until the contextual menu displays.
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Setting up Vertical Dimensions
Because you can use the Linear Dimension tool for vertical and horizontal 
dimensions, you can follow the steps in the previous exercise to do the vertical 
dimensions on the right side of the floor plan. The only difference from the hori-
zontal dimensioning is that you need two sets of dimensions: one for the wall 
and another for the deck. The following steps will take you through the process 
of placing the first vertical dimension. You’ll then be able to finish the rest of 
them by yourself.

 1. Continue using I12-03-DimContinue.dwg (M12-03-DimContinue.dwg), 
or open it if it’s not already open.

 2. Pan and zoom to get a good view of the right side of the floor plan, 
including the front deck (see Figure 12.22).

F I G u R E   1 2 . 2 2 :   The result of zooming and panning for a view of the right 
side of the floor plan

 3. Click the Linear button, and then start a vertical dimension from the 
top of the right exterior wall.

 4. Place the second point at the endpoint on the opening of the slid-
ing door.
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 5. Click to place the dimension between the wall and the FRONT 
DECK text.

 6. Adjust the location of the text if needed (see the top image of 
Figure 12.23).

F I G u R E   1 2 . 2 3 :   The dimension drawn to the start of the sliding door 
opening (top), and the completed first set of vertical dimensions (bottom)
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t I P  AutoCAD can sometimes be conservative when deciding whether both text 
and arrows can fit between the extension lines. Try moving the text a bit toward one of 
the extension lines in one of the 4′-6″ dimensions, and notice how the arrows move from 
outside the extension lines to inside.

 7. Use the Dimension Continue tool and grips to draw and edit the 
remaining two dimensions for the front of the cabin (see the bottom 
image of Figure 12.23).

 8. Using a similar procedure, draw the vertical dimensions for the front 
deck, placing the dimensions to the right of the deck.

 9. Add a horizontal dimension showing the length of the stairway.
When you’re finished, the dimensions in your drawing should look 

like those shown in Figure 12.24.

F I G u R E   1 2 . 2 4 :   The dimensions for the front deck

 10. Save this drawing as I12-04-VerticalDimensions.dwg (M12-04-
VerticalDimensions.dwg).
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Finishing the Dimensions
You place the rest of the horizontal and vertical dimensions by using a proce-
dure similar to the one you used to complete the horizontal dimensions. Here is 
a summary of the steps:

 1. Continue using I12-04-VerticalDimensions.dwg (M12-04-
VerticalDimensions.dwg), or open it if it’s not already open.

 2. Use the Linear Dimension and Dimension Continue tools to add hori-
zontal dimensions to the bottom side of the building. Move the title 
and label text as required to display the dimensions clearly.

 3. Add dimensions to the rear of the cabin and for the rear deck.

 4. Dimension the roof.

 5. Dimension the inside of the bathroom:

 a. Start the Linear Dimension (DIMLINEAR) tool.

 b. Press ↵ to allow the selection of an object, rather than a start-
ing point for a dimension.

 c. Click one of the vertical walls, and then click to place the 
dimension.

The completed dimensions will be similar to Figure 12.25.

F I G u R E   1 2 . 2 5 :   The completed dimensions
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 6. Save your drawing as I12-05-FinishedDimensions.dwg (M12-05-
FinishedDimensions.dwg).

using other types of Dimensions
AutoCAD provides tools for placing radial and angular dimensions on the draw-
ing and for placing linear dimensions that are neither vertical nor horizontal. 
You’ll make some temporary changes to the cabin file that you just saved so that 
you can explore these tools, and then you’ll close the drawing without saving it:

 1. Make layer 0 current.

 2. Freeze the A-ANNO-TEXT, A-ANNO-DIMS, A-ELEV-DECK, and 
A-ELEV-DECK-STRS layers.

 3. Use the FILLET command to fillet the top-right corner of the roof 
with a radius of 5′-0″ (1525 mm).

 4. Start the LINE command, and then pick the lower-right corner of the 
roof as the start point.

 5. Activate the Nearest osnap, and pick a point on the roof’s ridgeline.
The right end of the cabin should look like Figure 12.26.

Fillet this corner with a 
5'-0" radius.

Draw this line.

F I G u R E   1 2 . 2 6 :   The right end of the cabin after some temporary changes are 
implemented
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using Radial Dimensions
On the drop-down menu on the left side of the Dimensions panel are icons for 
the Radius, Diameter, and Arc Length dimensions. They all operate the same 
way and are controlled by the same settings.

Follow these steps to place a radius dimension at the filleted corner, measuring 
the distance from the curve to the center point:

 1. Click the Osnap button on the status bar to disable any running 
osnaps temporarily.

 2. Click the arrow below the Linear button on the Annotate tab ➢ 
Dimensions panel, and then click the Radius button to start the 
DIMRADIUS command.

 3. Click the inside filleted corner well above the midpoint.
The radius dimension appears, and the text is attached to the cur-

sor. Where you pick on the curve determines the angle of the radius 
dimension (see Figure 12.27).

F I G u R E   1 2 . 2 7 :   The radius dimension initially positioned on the curve

 4. Click to place the radius text in the dimension.
The R prefix indicates that this is a radial dimension.

n o t E  Most of the commands used for dimensioning are prefaced with DIM 
when you enter them at the command line—that is, DIM is part of the command name. 
For example, when you click the Radius button on the Annotate tab ➢ Dimensions panel 
or Dimension toolbar, you see _DIMRADIUS in the command line to let you know that 
you have started the DIMRADIUS command. You can also start this command by enter-
ing DIMRADIUS↵ or DRA↵ (the command alias).
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The radial dimension you just inserted uses the same architectural tick used 
by the other linear dimensions in your drawing. Typically, an arrow, not an 
architectural tick, would be used to illustrate radial dimensions. To fix this, you 
will need to create a Child Dimension style. You’ll learn how to create parent and 
child dimension styles at the end of this section, under “Setting Up Parent and 
Child Dimensioning Styles.”

Adding a Diameter Dimension
Similar to the radius dimension, a diameter dimension measures the distance 
from one side of a circle or arc, through the center point, to the other end. 
Follow these steps to place a diameter at the filleted corner:

 1. Erase the radius dimension.

 2. Click the arrow below the Radius button on the Dimension panel 
within the Annotate tab, and then click the Diameter button to start 
the DIMDIAMETER command.

 3. Click the inside filleted corner near the location where it meets the 
vertical wall.

The diameter dimension appears, and the text is attached to the 
cursor.

 4. Click to place the radius text in the dimension. The Ø prefix indicates 
that this is a diameter dimension. Where you click on the curve 
determines the angle of the radius dimension (see Figure 12.28).

F I G u R E   1 2 . 2 8 :   The diameter dimension positioned on the curve
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Like the radial dimension you created a moment ago, the diameter dimen-
sion also uses architectural ticks as opposed to the more standard arrows. 
Completing the process outlined in “Setting Up Parent and Child Dimensioning 
Styles” will walk you through how to make this fix.

Adding an Arc Length
An arc length dimension measures the length of an arc or polyline arc segment. 
As shown in Figure 12.29, an arc symbol, or cap, precedes the text to identify it 
as an arc length dimension.

F I G u R E   1 2 . 2 9 :   The arc length dimension positioned on the curve

t I P  You can change the location of the arc length symbol from in front of the 
text to over it, or eliminate it altogether in the Symbols And Arrows tab of the Modify 
Dimension Style dialog box.

Follow these steps to place an arc length dimension at the filleted corner:

 1. Erase the diameter dimension.

 2. Click the arrow below the Diameter button on the Dimension panel 
within the Annotate tab, and then click the Arc Length button to 
start the DIMARC command.

 3. Click anywhere on the arc at the filleted corner, and the arc length 
dimension appears attached to the cursor.

 4. Click to locate the dimension (shown previously in Figure 12.29).
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Setting up Parent and Child Dimensioning Styles
The A-DIMS-PLAN dimension style that you set up at the beginning of this 
chapter applies to all dimensions, and it is called the parent dimension style. 
You can change settings in this dimension style for particular types of dimen-
sions, such as the radial type. This makes a child dimension style.

The child version is based on the parent version, but it has a few settings that 
are different. In this way, all your dimensions will be made by using the A-DIMS-
PLAN dimension style, but radial dimensions will use a child version of the style. 
Once you create a child dimension style from the parent style, you refer to both 
styles by the same name, and you call them a dimension style family. Follow 
these steps to set up a child dimension style for radial dimensions:

 1. Click the Dimension Style button at the right end of the Dimensions 
panel to open the Dimension Style Manager dialog box.

 2. With the parent style A-DIMS-PLAN highlighted in the Styles list, click 
the New button to open the Create New Dimension Style dialog box.

 3. Open the Use For drop-down list, select Radius Dimensions, and then 
click the Continue button.

The New Dimension Style: A-DIMS-PLAN: Radial dialog box opens 
and has the seven tabs that you worked with earlier. Had you selected 
a different option in the Use For drop-down list, it would replace 
Radial in the title of the dialog box.

By default, the values in the Child Dimension Style dialog box will 
be the same as the values found in its parent. For instance, switching 
to the Symbols And Arrows tab will reveal that the Arrowhead setting 
is Architectural Tick, the same as the parent A-DIMS-PLAN style.

 4. From the Symbols And Arrows tab, click the Second drop-down list 
within the Arrowheads group to change from Architectural Tick to 
Closed Filled, as shown in Figure 12.30.
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F I G u R E   1 2 . 3 0 :   Changing the Arrowhead style for the Radial A-DIMS-PLAN 
child style

The change you just made will not affect the way you actually cre-
ate dimensions. You’ll still use the A-DIMS-PLAN dimension style. 
The only difference is that when you create a radius dimension, it 
will use a filled arrow instead of the architectural tick that was used 
when creating a radius dimension earlier.

 5. Click OK to close the New Dimension Style dialog box.
Notice that the current dimension style in the Dimension Style 

Manager dialog box now has a child style for Radial dimensions 
indented below it (see Figure 12.31).
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F I G u R E   1 2 . 3 1 :   The Radial child style shown as a node in the Dimension 
Style Manager

 6. Click Close to close the Dimension Style Manager dialog box.

 7. Using the Radius tool found on the Dimensions panel within the 
Annotate tab, redraw the same radial dimension you created earlier.

The result should look like Figure 12.32.

F I G u R E   1 2 . 3 2 :   The Radius dimension after creating a child style
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Notice that the arrowhead is no longer an architectural tick but rather a 
closed arrow. Despite this override to radial dimensions, linear dimensions will 
still use the architectural tick.

using Aligned and Angular Dimensions
To become familiar with the aligned and angular dimension types, you’ll experiment 
with the line you drew from the opposite corner of the roof in the previous exercise.

using Aligned Dimensions

Aligned dimensions are linear dimensions that aren’t horizontal or vertical. You 
place them in the same way that you place horizontal or vertical dimensions 
with the Dimension Linear tool. You can also use the Dimension Baseline and 
Dimension Continue tools with aligned dimensions.

Use the Aligned Dimension tool, which works just like the Linear Dimension 
tool, to dimension the line you drew at the beginning of this exercise. Follow 
these steps to add an aligned dimension:

 1. Zoom in to the lower-right corner of the cabin roof.

 2. Click the down arrow on the right side of the Annotate tab ➢ 
Dimensions panel and then click the Aligned button.

 3. Press ↵ to switch to accept the Select Object option.
The cursor changes to a pickbox.

 4. Pick the diagonal line.
The dimension appears attached to the cursor.

 5. Click to place the dimension.
Your drawing should look similar to Figure 12.33.

F I G u R E   1 2 . 3 3 :   An aligned dimension added to the cabin drawing
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using Angular Dimensions

The angular dimension is the only basic dimension type that uses angles in the 
dimension text instead of linear measurements. Try making an angular dimension 
on your own. Because the default arrowhead style for the A-DIMS-PLAN dimen-
sion style is Architectural Ticks, you’ll want to create another child style for angu-
lar dimensions. Refer to the “Setting Up Parent and Child Dimensioning Styles” 
exercise previously in this chapter for step-by-step instructions on how to do this. 
To summarize, you’ll need to do the following to create an angular child style:

 1. Open the Dimension Style Manager, select the A-DIMS-PLAN dimen-
sion style, and click New.

 2. Change the Use For drop-down list to Angular, and click Continue.

 3. From the Symbols And Arrows tab, change the First and Second 
Arrowhead styles to Closed Filled and then click OK.

 4. Close out of the Dimension Style Manager to return to your drawing.

With the Angular child style in place, you’re ready to add an angular dimension 
to your drawing. Follow these steps to add an angular dimension to your drawing:

 1. Turn off Object Snap mode.

 2. Start the DIMANGULAR command by selecting the Angular tool on the 
Annotate tab ➢ Dimensions panel.

 3. Follow the prompts; pick the line you drew, and then pick the hori-
zontal roofline.

 4. Click a point inside your drawing to insert the angular dimension.
When you’re finished, your drawing will look like Figure 12.34.

F I G u R E   1 2 . 3 4 :   The roof with the angular dimension added
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using Leader Lines
You will use the MLEADER (Multileader) command to draw an arrow to features in 
the cabin drawing in order to add descriptive information. Multileaders are not 
part of the dimension family, and you can find them on the Multileaders panel.

Creating a Multileader Style

Before you create a leader, you need to create a multileader style, as follows:

 1. If it’s still open, close the drawing you created during the Ordinate 
Dimensions exercise, and open the I12-05-FinishedDimensions.dwg 
(M12-05-FinishedDimensions.dwg).

 2. Click the Multileader Style Manager button at the lower right of the 
Leaders panel’s title bar on the Annotate tab.

 3. Click the New button in the Multileader Style Manager.

 4. In the Create New Multileader Style dialog box that opens, enter 
A-DIMS-MLDR in the New Style Name text box and then click 
Continue (see Figure 12.35).

F I G u R E   1 2 . 3 5 :   Creating a new multileader style

The Modify Multileader Style dialog box opens (see Figure 12.36). 
This is where you define the leader properties.

 5. Click the Leader Structure tab.
The landing is the horizontal line at the end of the leader, just 

before the text.
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F I G u R E   1 2 . 3 6 :   The Modify Multileader Style dialog box

 6. Make sure the Set Landing Distance option is checked, and then 
enter 1⁄8″ (3.5) in the text box (see Figure 12.37).

F I G u R E   1 2 . 3 7 :   The Leader Structure tab in the Modify Multileader Style 
dialog box
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 7. In the Scale group, make sure the Specify Scale radio button is 
selected and then click in the text box and enter 48↵ (50↵), as shown 
in Figure 12.37.

 8. Switch to the Content tab shown in Figure 12.38.

F I G u R E   1 2 . 3 8 :   The Content tab in the Modify Multileader Style dialog box

 9. Expand the Text Style drop-down list, choose A-DIMS, and set the 
text height to 1⁄8″ (3.5).

 10. In the Leader Connection group, set both the Left Attachment  
and Right Attachment options to Middle Of Top Line, as shown  
in Figure 12.38.

This places the middle of the top line of the leader text even with 
the landing.

 11. Set the Landing Gap value to 1⁄8″ (3.5), as shown in Figure 12.38.

 12. Click the OK button.
In the Multileader Style Manager, the A-DIMS-MLDR Leader style 

appears in the Styles list box (see Figure 12.39).
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F I G u R E   1 2 . 3 9 :   The A-DIMS-MLDR multileader style shown in the 
Multileader Style Manager

 13. Select A-DIMS-MLDR, click Set Current, and then click the Close 
button.

 14. Save this drawing as I12-06-MLeaderStyle.dwg (M12-06-
MLeaderStyle.dwg).

Adding the Leaders

To add the leaders to the drawing, follow these steps:

 1. Continue using I12-06-MLeaderStyle.dwg (M12-06-MLeaderStyle.dwg), 
or open it if it’s not already open.

 2. Zoom in to the front deck.

 3. Click the Multileader button on the Annotate tab ➢ Leaders panel.

 4. Activate the Endpoint osnap, if necessary, and then click the top-
right corner of the top-right deck post.

 5. At the Specify leader landing location: prompt, click a point 
above and to the right of the deck.

The Text Editor tab and panels replace the Annotate tab and panels 
in the Ribbon, and a flashing vertical cursor appears to the right of 
the landing, as shown in Figure 12.40.
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F I G u R E   1 2 . 4 0 :   The flashing vertical cursor indicates that AutoCAD is 
waiting for text input.

 6. Enter Use only pressure-treated lumber for deck and supports.
Longer notes like this one are typically displayed on several lines.

 7. If the Ruler is not already enabled (blue background), on the contex-
tual Text Editor Ribbon tab ➢ Options panel, click the Ruler tool.

This displays a ruler with two outward-facing arrows above the 
multileader text (see the top of Figure 12.41).

F I G u R E   1 2 . 4 1 :   Multileader text with ruler toolbar (top) and expanded text 
box distributing text to several lines (bottom)
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 8. Expand the arrows above the multileader text to the right to expand 
the text box, and distribute the text among several lines (see the bot-
tom of Figure 12.41).

 9. Click a blank spot in the drawing area to complete the text, and 
return to the Annotate tab.

t I P  To reposition a leader without moving the arrow, click it and then click the 
grip at the middle of the landing. Then move the cursor. When you do, the text, landing, 
and one end of the leader line will all move with the cursor.

 10. Pan to the right so that you can see the two windows on the north 
side of the cabin.

 11. Add a leader that starts at the right edge of the 3″ (915 mm) window 
and then extends below and to the right.

 12. Enter All windows to be double paned at the text prompt.

 13. Adjust the width of the text, and then click a blank spot in the draw-
ing area (see Figure 12.42).

F I G u R E   1 2 . 4 2 :   The multileader pointing to the first window

Several leader lines can extend from a single landing.

 14. Click the Add Leader button on the Leaders panel within the 
Annotate tab, and then, at the Select a multileader: prompt, click 
the last leader you made.

An arrowhead with a leader appears attached to the cursor and 
anchored to the landing.

 15. Click the left corner of the window to the right and then press ↵.
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n o t E  AutoCAD may place the second leader on the right side of the text if it 
determines that the leader fits better there. If this happens, click the multileader to select 
it and then move the text to the right. The second leader will reposition itself to the left 
side of the text.

 16. Reposition the text as necessary.
Your drawing should look similar to Figure 12.43.

F I G u R E   1 2 . 4 3 :   The cabin drawing with leaders

 17. Save this drawing as I12-07-AddingLeaders.dwg (M12-07-
AddingLeaders.dwg).

The final part of this chapter is devoted to showing you a few techniques for 
modifying dimensions.

Modifying Dimensions
You can use several commands and grips to modify dimensions, depending on 
the desired change. Specifically, you can do the following:

▶▶ Change the dimension text content.

▶▶ Move the dimension text relative to the dimension line.

▶▶ Move the dimension or extension lines.

▶▶ Change the dimension style settings for a dimension or a group of 
dimensions.

▶▶ Revise a dimension style.

The best way to understand how to modify dimensions is to try a few. You’ll 
look at how to change the content first.
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Editing Dimension text Content
You can modify any aspect of the dimension text. To change the content of  
text for one dimension or to add text before or after the dimension, you can use  
the Properties or Quick Properties palette. In the following steps, you’ll use 
Quick Properties to change the text in the horizontal dimensions for the cabin 
and walls:

 1. Continue using I12-07-AddingLeaders.dwg (M12-07-
AddingLeaders.dwg), or open it if it’s not already open.

 2. Zoom and pan until your view of the floor plan is similar to 
Figure 12.44.

F I G u R E   1 2 . 4 4 :   A modified view of the floor plan

 3. Select the horizontal 40′-0″ (8550 mm) cabin dimension near the 
top of the drawing, and then click the Quick Properties button in 
the status bar.

t I P  The procedure shown here can also be done in the Tex t rollout of the 
Properties palette.

 4. Highlight the Text Override field, and enter <> verify in field↵.
The phrase is appended to the dimension (see Figure 12.45). The 

<> (opening and closing angle brackets without a space in between) 
instructs AutoCAD to add the phrase to the dimension text; if 
you had not prefixed the override with <>, the phrase would have 
replaced the dimension text entirely.
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F I G u R E   1 2 . 4 5 :   Adding a phrase to dimension text

 5. Press the Esc key, and then click the 5′-6″ (1670 mm) dimension, 
measuring the distance from the end of the cabin to the closet wall.

 6. In the Text Override box, enter <> %%P↵.
The ± symbol is now appended to the text (see Figure 12.46).

F I G u R E   1 2 . 4 6 :   Adding a special character to your dimension text

 7. Save this drawing as I12-08-ModifyDimText.dwg (M12-08-
ModifyDimText.dwg).
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Inserting ASCII Symbols

Unless you have memorized all the ASCII symbol codes, it might be easier to insert 
symbols into dimension text by using the text-editing tools. To do this, enter 
TEDIT↵ and then select the dimension text. The default AutoCAD workspace 
does not provide access to the DDEDIT command through the Ribbon.

The text is highlighted, and the Text Editor tab is activated. Place the cursor 
where you want the symbol to appear, and then click the Symbol button in the 
Insert panel to see a list of available symbols and their related ASCII codes. Click 
the symbol name to be added. 

Next you’ll learn about moving a dimension.
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Moving Dimensions
You can use grips to move dimensions. You used grips to move the dimension 
lines when you were putting in the vertical and horizontal dimensions. This 
time, you’ll move the dimension line and the text:

 1. Continue using I12-08-ModifyDimText.dwg (M12-08-
ModifyDimText.dwg), or open it if it’s not already open.

 2. Zoom in to a view of the upper-left side of the floor plan until you 
have a view similar to Figure 12.47, which includes the left window 
and the top of the rear deck and their dimensions.

F I G u R E   1 2 . 4 7 :   The result of zooming in to the upper-left side of the  
floor plan

 3. Select the 3′-0″ (915 mm) window dimension. Its grips appear.

 4. Click the grip on the right arrowhead to activate it.

 5. Move the cursor down until the dimension text is just below the 
roofline.

 6. Click again to fix it there.

 7. Click the grip that’s on the text and, with Polar Tracking on, move the 
text to the right, outside of the extension line; then click to place it.

 8. Press Esc to deselect the dimension (see Figure 12.48).
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F I G u R E   1 2 . 4 8 :   Moving the window dimension and dimension text with grips

 9. Select either of the leader lines pointing to the two windows.
The leaders, landing, and leader text ghost, and the grips appear.

 10. Click the grip at the tip of the left leader and then move the grip to 
the end of the inner pane of the left window (see Figure 12.49).

F I G u R E   1 2 . 4 9 :   Using grips to move the position of leader lines

 11. Click the grip at the tip of the right leader, and move the grip to 
the left end of the inner pane of the right window (also shown in 
Figure 12.49).

 12. Save this drawing as I12-09-MovingDims.dwg (M12-09-MovingDims.dwg).
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Adjusting Space between Stacked Dimensions
Dimensions for the back deck are stacked in three rows. Because each row of 
dimensions was placed visually, the spacing between each row is an arbitrary 
distance. The Adjust Space tool can help fix spacing variations like this one, 
helping you to produce a more polished and professional-looking drawing. To 
use the Adjust Space tool, follow these steps:

 1. Continue using I12-09-MovingDims.dwg (M12-09-MovingDims.dwg), 
or open it if it’s not already open.

 2. Zoom in to the area around the back deck so that the deck, stairs, 
and dimensions are each visible.

 3. Start the DIMSPACE command by selecting the Adjust Space tool 
found on the Dimensions panel on the Annotate tab.

 4. From the Select base dimension: prompt, pick the 7′-1″ (2160 mm) 
dimension.

The command line prompts you to select the dimensions on which 
to adjust spacing.

 5. Select the remaining dimensions for the back deck, as shown in 
Figure 12.50, and press ↵.

F I G u R E   1 2 . 5 0 :   Selecting the remaining deck dimensions to adjust the 
spacing
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After selecting the dimensions on which to adjust spacing, you 
are given an option about how you would like them spaced. You can 
enter a custom value of your choice or let AutoCAD determine the 
best spacing for you.

 6. Press ↵ to accept the default Auto option.
The command ends, and all three rows of dimensions are equally 

spaced, as shown in Figure 12.51.

F I G u R E   1 2 . 5 1 :   All three rows of deck dimensions are equally spaced.

 7. Save this drawing as I12-10-SpacingDims.dwg (M12-10-
SpacingDims.dwg).
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using Dimension overrides
You can suppress the left extension line with the Properties palette, which 
allows you to change a setting in the dimension style for one dimension without 
altering the style settings. Follow these steps:

 1. Continue using I12-10-SpacingDims.dwg (M12-10-SpacingDims.dwg), 
or open it if it’s not already open.

 2. Thaw the A-WALL-HEAD layer.
Notice how the white (or black) left extension line for the 8′-0″ (2350 

mm) dimension, which measures the width of the bathroom, coincides 
with the header line for the back door. You could use the Draw Order 
tools to move the dimension behind the header, but that may still 
result in a visibly overlapping condition when the drawing is printed. 
In this case, you’ll suppress the extension line, rendering it invisible.

 3. Double-click the 8′-0″ (2350 mm) dimension to open the Properties 
palette.

 4. Scroll down to the Lines & Arrows rollout. If this section isn’t open, 
click the arrow to the right.

 5. Scroll down the list of settings in this section, and click Ext Line 1.

 6. Click the down arrow to the right to open the drop-down list. Click Off.
This suppresses the left extension line of the dimension (see 

Figure 12.52).

F I G u R E   1 2 . 5 2 :   The 8′-0″ (2350 mm) dimension with the left extension line 
suppressed

www.MouradEngineering.com



 M o d i f y i n g  D i m e n s i o n s  7 0 1

 7. Close the Properties palette.

 8. Press Esc to deselect the dimension.

 9. Save this drawing as I12-11-DimOverrides.dwg (M12-11-
DimOverrides.dwg).

To illustrate how dimension overrides work, you suppressed an extension line 
without having to alter the dimension style. Extension lines are usually the thin-
nest lines in a drawing. It’s usually not critical that they be suppressed if they 
coincide with other lines, because the other lines will overwrite them in a print.

However, in this example, the left extension line of the 8′-0″ (2350 mm) 
dimension for the bathroom coincides with the line representing the header 
of the back door. If the Headers layer is turned off or frozen, you will have to 
unsuppress the extension line of this dimension so that it will be visible span-
ning the door opening. Also, if you dimension to a noncontinuous line, such as a 
hidden line, use the dimension style override features to assign special linetypes 
to extension lines.

n o t E  In the practice exercises at the end of this chapter, you’ll get a chance to 
learn how to incorporate centerlines into your dimensions.

Dimensioning Short Distances
When you have to dimension distances so short that the text and the arrows 
can’t fit between the extension lines, a dimension style setting determines 
where they are placed. To see how this works, in the following exercise you’ll add 
dimensions to the deck for the widths of the handrails and posts as well as the 
thickness of an interior wall. Then you’ll make a change in the Fit tab to alter 
the A-DIMS-PLAN dimension style to change where it places text that doesn’t fit 
between the extension lines.

 1. Continue using I12-11-DimOverrides.dwg (M12-11-DimOverrides.dwg), 
or open it if it’s not already open.

 2. Zoom and pan to a view of the upper portion of the front deck so 
that the horizontal dimensions above the floor plan are visible (see 
Figure 12.53).
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F I G u R E   1 2 . 5 3 :   The new view of the upper-right floor plan and its 
dimensions

 3. Activate the running osnaps if necessary, click the Linear Dimension 
button, and pick the upper-left corner of the deck post.

 4. Pick the lower-left corner of the same deck post.

 5. Place the dimension line about 2′ (610 mm) to the left of the deck post.
The 8″ (204 mm) dimension is placed even farther to the left of the 

point you selected (see Figure 12.54).

F I G u R E   1 2 . 5 4 :   The text for the short dimension is not placed near the 
dimension lines.
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 6. Open the Dimension Style Manager, click the Modify button, and 
then, in the Modify Dimension Style dialog box, click the Fit tab.

 7. In the Text Placement group, select the Beside The Dimension Line 
radio button (see Figure 12.55).

F I G u R E   1 2 . 5 5 :   The Fit tab of the Modify Dimension Style dialog box after 
making the change

 8. Click OK and then click Close to dismiss both dialog boxes.
The dimension changes to reflect the modification to the style 

(see Figure 12.56). This is a global change that will affect all future 
dimensions.

F I G u R E   1 2 . 5 6 :   The short dimension after changing the style

◀

Several of the dimen-
sioning commands 
are also available on 
the Annotation panel 
under the Home tab.
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 9. Add another dimension measuring the width of the horizontal 
handrail, and add the text TYP after the dimension text, as shown in 
Figure 12.57.

F I G u R E   1 2 . 5 7 :   The handrail dimension after adding the TYP text

n o t E  The abbreviation TYP stands for typical; it tells someone reading your 
plans that all handrails are 3″  in width unless designated other wise. Refer to the 
“Editing Dimension Text Content” section earlier in this chapter if you need a refresher 

on modifying dimension text.

 10. Repeat step 9, and add the TYP abbreviation to the 4″ dimension in 
the upper-right corner of the bathroom.

This tells someone reading the plans for your cabin that all interior 
walls are 4″ in width unless designated otherwise.

 11. Make any adjustments necessary to make the drawing readable, and 
then save the drawing as I12A-FPLAYO.dwg (M12A-FPLAYO.dwg).

This concludes the exercises for dimensions in this chapter. Working successfully 
with dimensions in your drawing requires an investment of time to become famil-
iar with the commands and settings that control how dimensions appear, how they 
are placed in the drawing, and how they are modified. The exercises in this chapter 
have led you through the basics of the dimensioning process. For a more in-depth 
discussion of dimensions, refer to Mastering AutoCAD 2015 and AutoCAD LT 2015 
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by George Omura (Sybex, 2014), or visit this book’s website at www.sybex.com/go/
autocad2015ner or www.thecadgeek.com for additional resources.

The next chapter will introduce you to external references, which can be used 
to view a drawing from within another drawing.

If You Would Like More Practice…
In the first practice exercise, you’ll get a chance to use the dimensioning tools 
that you just learned. After that is a short exercise that shows a technique for 
incorporating centerlines into dimensions, and finally some guiding principles 
for further exercises.

Dimensioning the Garage Addition
Try dimensioning the garage addition to the cabin (04A-FPGARG.dwg) that was 
shown at the end of Chapter 4, “Developing Drawing Strategies: Part 1.” Apply the 
same dimensioning techniques you learned in this chapter when dimensioning 
the cabin.

 1. Open 04A-FPGARG.dwg. 

 2. Use AutoCAD DesignCenter™ to bring over the following:

▶▶ A-DIMS-PLAN dimension style

▶▶ A-DIMS text style

▶▶ A-DIMS-MLDR multileader style

▶▶ A-ANNO-DIMS layer

 3. Dimension to the outside edges of exterior walls, the edges of the 
openings, and the centerlines of interior walls, using the A-DIMS-
PLAN dimension style.

 4. Drag an A-ROOM-IDEN block and a room label from the cabin drawing 
into the garage drawing, and then copy and modify them as required.

 5. If the leader does not display properly, check the Overall Scale value 
in the Properties panel and make sure it is set to 64 (70).

When you’re finished, the drawing should look similar to Figure 12.58.
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F I G u R E   1 2 . 5 8 :   The walkway and garage dimensioned

 6. When you’re finished, save this drawing as 12A-FPGARG.dwg.

Dimensioning to a Centerline
This exercise shows you how to use centerlines as replacements for extension 
lines in dimensions. In order to get a sense of what AutoCAD looks like out-of-
the-box, you’ll use several of the default settings for text styles, dimension styles, 
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units, and so forth. The drawing you’ll make is similar to the one you made in 
Chapter 2, “Learning Basic Commands to Get Started,” but you know so much 
more now. Follow these steps to set up a new drawing: 

 1. Choose Application menu ➢ New ➢ Drawing. Then, in the Create 
New Drawing dialog box, select the acad.dwt template.

 2. Start the RECTANG command, and click a point in the lower-left 
quadrant of the drawing area.

 3. For the second point, enter @6,2↵.

 4. Use the Zoom Extents tool, and then zoom out a bit.

 5. Pan to move the new rectangle down a little (see Figure 12.59).

F I G u R E   1 2 . 5 9 :   The rectangle after panning down

You want to dimension from the upper-left corner of the rectangle to the cen-
ter of the upper horizontal line and then to the upper-right corner. You’ll select 
the Dimension tool from the menu bar and use the default dimension settings:

 1. Create a new layer called A-ANNO-DIMS, accept the White color, and 
make A-ANNO-DIMS current.

 2. Set the Endpoint and Midpoint osnaps to be running, and then click 
the Linear button in the Dimensions panel or in the Annotation 
panel under the Home tab.

 3. Click the upper-left corner of the rectangle, and then click the mid-
point of the upper horizontal line of the rectangle.

 4. Drag the dimension line up to a point about 1 unit above the upper 
line of the rectangle, and click.

This places the first dimension.

 5. Click the dimension to make grips appear.
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 6. Click the grip that is at the midpoint of the upper horizontal line of 
the rectangle and, with Polar Tracking on, drag it down to a point 
below the rectangle.

 7. Press Esc to deselect the dimension.

 8. Click the Continue button, and select the upper-right corner of the 
rectangle.

Doing so places the second dimension.

 9. Press Esc to end the command.

 10. On the Home tab ➢ Properties panel, open the Linetype drop-down 
list and select Other.

 11. In the Linetype Manager dialog box, click the Load button.

 12. In the Load Or Reload Linetypes dialog box, scroll down, find and 
click Center2, and then click OK.

The Center2 linetype now appears in the Linetype Manager dialog box.

 13. Click OK.

 14. Double-click the left dimension to open the Properties palette.

 15. In the Lines & Arrows rollout, click Ext Line 2 Linetype.

 16. Open the drop-down list, and select Center2.

 17. Press Esc to deselect the dimension.

 18. Select the right dimension.

 19. On the Properties palette, return to the Lines & Arrows rollout and 
click Ext Line 1 Linetype.

 20. Open the drop-down list and select Center2.

 21. Press Esc to close the Properties palette.

Now there is a centerline through the rectangle that’s part of the dimensions. 
As a final touch, you’ll put a centerline symbol at the top of the centerline by 
using the MTEXT command:

 1. Start the MTEXT (Multiline Text) command, and make a small defin-
ing window somewhere in a blank portion of the drawing area.

 2. Expand the Symbol tool found on the contextual Text Editor Ribbon 
tab, and select Center Line.

A centerline symbol now appears in the Multiline Text Editor.
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 3. Highlight it, and change its height from 0.2000 to 0.4000 in the Text 
Height text box in the Text Style panel, as shown in Figure 12.60.

F I G u R E   1 2 . 6 0 :   Changing the height of the centerline symbol

 4. With the text still highlighted, click the Justification button in the 
Paragraph panel.

 5. From the flyout menu that appears, click Bottom Center BC (see 
Figure 12.61). 

F I G u R E   1 2 . 6 1 :   Setting the Justification for the centerline symbol

 6. Click the Close Text Editor button in the Close panel to execute the 
changes and close the Multiline Text tab.

 7. Click the centerline symbol to activate the grips.

 8. Click the lower-middle grip, and then click the upper end of the 
centerline.

This locates the symbol properly.

 9. Turn off running osnaps, be sure Polar Tracking is on, and click the 
same grip as you did in the previous step.
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 10. Move the symbol up slightly to create a space between it and the cen-
terline (see Figure 12.62).

F I G u R E   1 2 . 6 2 :   The centerline symbol and a centerline used as part of two 
dimensions

This completes the exercise. You can save the drawing if you want.

Practicing on Your own
Use the skills you’ve learned in this chapter to do the following:

▶▶ Set up a dimension style for your own use.

▶▶ Dimension a drawing as you would in your own profession or trade.

▶▶ Dimension any of the other drawings offered in previous chapters, 
such as the block, the gasket, or the parking lot.

▶▶ Add dimensions to the cabin elevations.
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Are You Experienced?

now you can…

✔✔ create a new dimension style

✔✔ place vertical and horizontal dimensions in a drawing

✔✔ use radial, aligned, and angular dimensions

✔✔ create a multileader style

✔✔ create multileader lines for notes

✔✔ modify dimension text

✔✔ override a dimension style

✔✔ modify a dimension style
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CHAPtER 13

Managing External 
References
The floor plan of a complex building project might actually be a composite 
of several Autodesk® AutoCAD® files that are linked together as external refer-
ences to the current drawing. This enables parts of a drawing to be worked on 
at different workstations (or in different offices) while remaining linked to a 
central host file. In mechanical engineering, a drawing might similarly be a 
composite of the various subparts that make up an assembly.

External references, or Xrefs, are DWG™ files that have been temporarily 
connected to the current drawing and are used as reference information. 
The externally referenced drawing is visible in the current drawing. You can 
manipulate its layers, colors, linetypes, and visibility, and you can modify its 
objects, but it isn’t a permanent part of the current drawing. Changes made 
in the current drawing to the Xref’s appearance, such as color or linetype, 
are not reflected in the Xref source drawing.

External references are similar to blocks in that they behave as single 
objects and are inserted into a drawing in the same way. But blocks are part 
of the current drawing file, and external references aren’t.

Before you set up the Xref, you’ll create a site plan for the cabin. You’ll then 
externally reference the site plan drawing into the cabin drawing. After these 
exercises, you’ll look at a few ways that design offices use external references.

In this chapter, you will learn to

▶▶ Understand external references

▶▶ Create external references

▶▶ Edit external references

▶▶ Convert	external	references	into	blocks
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Drawing a Site Plan
The site plan you’ll use has been simplified so that you can draw it with a mini-
mum number of steps and get on with the external referencing. The following 
are the essential elements:

▶▶ Property lines

▶▶ Access road to the site

▶▶ North arrow

▶▶ Indication of where the building is located on the site

In Figure 13.1, the lines of the site plan constitute the Xref, and the rest of the 
objects are part of the host drawing.

F I G u R E   1 3 . 1 :   The cabin with the site plan as an external reference
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The first step is to draw the property lines.

using Surveyor’s units
You draw property lines by using Surveyor’s units for angles and decimal feet 
for linear units. In laying out the property lines, you’ll use relative polar coor-
dinates. You’ll enter coordinates in the format @distance<angle, in which the 
distance is in feet and hundredths of a foot, and the angle is in Surveyor’s units 
to the nearest minute.

Introducing Surveyor’s units

Surveyor’s units, called bearings in civil engineering, describe the direction of a 
line from its beginning point. The direction (bearing), described as a deviation 
from the north or south (up and down along the y-axis) toward the east or west 
(right and left along the x-axis), is given as an angular measurement in degrees, 
minutes, and seconds. The angles used in a bearing can never be greater than 90, 
so bearing lines must be headed in one of the four directional quadrants: north-
easterly, northwesterly, southeasterly, or southwesterly.

If north is set to be at the top of a plot plan, then south is down, east is to the 
right, and west is to the left. Therefore, when a line from its beginning goes up 
and to the right, it’s headed in a northeasterly direction; when a line from its 
beginning goes down and to the left, it’s headed in a southwesterly direction; 
and so on. A line that is headed in a northeasterly direction with a deviation 
from true north of 30 and 30 minutes is shown as N30d30′E in AutoCAD nota-
tion. Figure 13.2 shows examples of a line drawn using Surveyor’s units.

Second
Point

Second
PointFirst

Point
First

Point

First
Point

First
Point

Second
Point

Second
Point

F I G u R E   1 3 . 2 :   Drawing a line using Surveyor’s units

With the Surveyor’s unit system, a sloping line that has an up-and-to-the-left 
direction has a down-and-to-the-right direction if you start from the opposite 
end. So, in laying out property lines, it’s important to move in the same direction 
(clockwise or counterclockwise) as you progress from one segment to the next.
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The bigger reason to ensure that lines move in the same direction relates to 
the way that property is recorded. In addition to a drawing, or plat as surveyors 
call it, each piece of property has what is known as a legal description. This legal 
description defines one corner as the starting or control point and then pro-
ceeds to describe a piece of property textually by using bearings and distances. 
Each bearing and distance builds on the previous one and constructs what sur-
veyors call a traverse. 

n o t E  Constructing, balancing, and closing traverses is a topic unto itself. This 
concept will help you understand how the geometry behind property lines is, in many 
ways, more important than the illustration itself. How you draw a property line has a pro-
found effect on the way that parcel will be deeded and legally defined to a landowner. 

Laying out the Property Lines

Property lines are generally dimensioned using bearing and distance labels. These 
are different from the dimensions you created in Chapter 12, “Dimensioning a 
Drawing,” as they are typically defined using a couple of pieces of text containing 
the direction (angle) and distance (length) of a line. Figure 13.3 shows how the 
piece of property for your cabin may be drawn by a surveyor. You’ll set up a new 
drawing and use the bearings and distances shown in Figure 13.3 to create your 
cabin’s property line in a counterclockwise direction.

F I G u R E   1 3 . 3 :   Property line with bearing and distance labels
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 1. Open a New Tab, and start a new drawing using the acad.dwt template.
All the units in these first few sections are noted as architectural 

and, in a later section, I’ll show you how to bring in a drawing using 
a different scale.

 2. From the Application menu, choose Drawing Utilities ➢ Units to 
open the Drawing Units dialog box.

 3. Change the Precision value in the Length group to two decimal 
places (0.00).

 4. In the Angle group, open the Type drop-down list and select 
Surveyor’s Units.

 5. Change the Precision value to the nearest minute (N0d00′E).
The floor plan drawings you have created so far defined each unit 

as an inch. Because this is a civil/survey drawing, you’ll change that 
by making each drawing unit equal a foot.

 6. Change the drawing’s insertion scale by changing the Units To Scale 
Inserted Content drop-down list to Feet (Meters).

Your Drawing Units dialog box should look like Figure 13.4.

F I G u R E   1 3 . 4 :   The Drawing Units dialog box set up to use Surveyor’s units

 7. Click OK.
You’ll need an area of about 250′ × 150′ for the site plan.

◀

You’re using decimal 
linear units in such a 
way that 1 decimal unit 
represents 1 foot. In 
AutoCAD and AutoCAD 
LT®, the foot symbol (′) 
is used only with archi-
tectural and engineer-
ing units.
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 8. Set the Drawing Limits by entering LIMITS↵ at the command line.

 9. Press ↵ to accept the default of 0.00,0.00 for the lower-left corner. 
Enter 250,150↵ (76.2, 45.72↵). Don’t use the foot sign.

 10. Enter Z↵E↵, or double-click the middle mouse button to zoom to the 
drawing’s extents.

 11. Create a new layer called C-PROP-LINE.

 12. Assign it the color 4 (Cyan), and make it current.

 13. Turn on Dynamic Input in the status bar.

 14. Start the LINE command. For the first point, enter 220,130↵ (67,40↵).
This starts a line near the upper-right corner of the grid.

 15. Make sure that Snap is turned off. Then enter the following:

@140<N90DW↵ (@42<N90DW↵)

@90<S42D30'W↵ (@27<S42D30'W↵)

@140<S67D30'E↵ (@42<S67D30'E↵)

@80<N52D49'E↵ (@24<N52D49'E↵)

@72<N6D9'30"E↵ (@22<N6D9'30"E↵)

↵

The LINE command ends, and all five property lines are drawn (see 
Figure 13.5).

F I G u R E   1 3 . 5 :   The property lines on the site drawing
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 16. Use the ZOOM command to zoom in tightly on the upper-right corner 
of your property line.

Notice how the last property line you drew extends past the starting 
point (see Figure 13.6). This happens because of the very small amount 
of rounding that occurs as line segments are drawn with angles to the 
nearest second. When surveyors use the term balancing, or closing a 
traverse, they are referring to the process of fixing this small margin  
of error.

F I G u R E   1 3 . 6 :   The open traverse at the start/end point of the property line

 17. Clean up the intersection by using the FILLET command with a 0 
radius, and perform a Zoom Extents to bring the entire property back 
into view.

 18. Save this drawing as I13-01-PropertyLine.dwg (M13-01-
PropertyLine.dwg).

Drawing the Driveway
The driveway is 8′ (2.5 m) wide and set in 5′ (1.5 m) from the horizontal property 
line. The access road is 8′ from the parallel property line. The intersections of the 
access-road lines and the driveway lines form corners; you’ll create a curb return 
for each of these intersections with a 3′ (1 m) radius. The driveway extends 70′ 
(21 m) in from the upper-right corner of the property.

Follow these steps to lay out the driveway:

 1. Continue using I13-01-PropertyLine.dwg (M13-01-PropertyLine 
.dwg), or open it if it’s not already open.

 2. If the entire property line is not in view, perform a Zoom Extents and 
then zoom out a little more.
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 3. Offset the topmost horizontal property line 5′ (1.5 m) down to estab-
lish the first edge of the driveway. Offset the resulting line 8′ (2.5 m) 
down to form the second edge of the driveway.

W A R n I n G  As you enter distances, be sure to remember that 1 unit is 
equal to a foot, not an inch as with the f loor plan drawings you’ve created up to this 
point. Consequently, you will enter 5 and 8 as the offset distances, not 5′ and 8′. Because 
each unit is equal to a foot, there is no need to include the foot mark after the number.

 4. Offset the rightmost property line 8′ (2.5 m) to the right (see the top 
of Figure 13.7) to show the limits of the access road.

F I G u R E   1 3 . 7 :   Offset property lines (top) and the completed intersection of 
the driveway and access road (bottom)
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 5. Create a new layer called C-ROAD.

 6. Assign it the color 3 (Green), and make the C-ROAD layer current.

 7. Select the three new lines, and open the Layer drop-down list in the 
Layers panel of the Home tab.

 8. Click the C-ROAD layer to move the selected lines to the C-ROAD layer.

 9. Press Esc to deselect the lines.

 10. Extend the driveway lines to the access-road line.

 11. Trim the access-road line between the driveway lines.

 12. Fillet the two corners where the driveway meets the road by using 
a 3′ (1 m) radius (see the bottom of Figure 13.7).

 13. Save this drawing as I13-02-DrawingDriveway.dwg (M13-02-
DrawingDriveway.dwg).

Finishing the Driveway

A key element of any site plan is information that shows how the building is 
positioned on the site relative to the property lines. Surveyors stake out prop-
erty lines. After staking out the property lines, the surveyor will then begin 
staking building offsets. They are generally placed at critical building corners 
and used by the contractor to begin constructing the building. In this site, you 
need only one corner because you’re assuming that the front door of the cabin 
is facing due east.

As shown previously in Figure 13.1, the end of the driveway lines up with the 
top-rear corner of the cabin. Extending from the driveway are sidewalks that run 
to the front and rear steps. This locates the cabin on the site (see Figure 13.8).
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F I G u R E   1 3 . 8 :   The driveway and patio lined up with the cabin

Imagine the site being on the bluff of a hill overlooking land that falls away 
to the south and west, providing a spectacular view in that direction. To accom-
modate this view, you will change the orientation of the site drawing when you 
externally reference it into the cabin drawing:

 1. Continue using I13-02-DrawingDriveway.dwg (M13-02-
DrawingDriveway.dwg), or open it if it’s not already open.

 2. On the status bar, turn on Object Snap Tracking and make sure the 
Endpoint osnap is running.

 3. Start a line with the first point 83′ (25 m) to the left of the intersec-
tion of the upper driveway line and the property line.

 4. Draw the line straight down 24′ (7.3 m).

 5. Draw another line 22′ (6.7 m) to the right; then end the LINE 
command.
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 6. Offset the vertical line 22′ (6.7 m) to the right.
This will mark the end of the driveway.

 7. Fillet the intersection of the upper driveway line and the left verti-
cal line with a radius of 0, and the intersection of the lower driveway 
line and the right vertical line with a radius of 6′ (2 m), as shown in 
Figure 13.9.

Fillet this corner 
with a radius of 0.

Fillet this corner with a radius of 6'.

F I G u R E   1 3 . 9 :   Completing the driveway

 8. To draw the rear sidewalk, use Object Snap Tracking to draw a line 
that starts 3.333′ [3′-4″ (1.02 m)] up from the lower-left corner of the 
driveway to a point 10.916′ [10′-11″ (3.26 m)] to the left.

 9. Continue by drawing a line straight up 3.5′ [3′-6″ (1.06 m)] and then 
10.916′ [10′-11″ (3.26 m)] back to the right before you terminate the 
LINE command.

See the top of Figure 13.10. You can refer to Figure 13.8 to see the 
dimensions if necessary.
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F I G u R E   1 3 . 1 0 :   The first sidewalk (top) and the second sidewalk (bottom)

 10. To draw the side and front sidewalk, start the LINE command again.

 11. Pick the lower-left corner of the driveway as the first point.

 12. Either use the direct-entry method with the following distances to 
draw the remaining sidewalk lines or enter the distances and angles 
as shown:

43.333<270↵ (13.22<270↵)
12.25<180↵ (3.67<180↵)
3.5<270↵ (1.06<270↵)
15.75<0↵ (4.73<0↵)

 13. With the LINE command still running, use the Perpendicular osnap 
to finish the sidewalk, and press ↵ to end the LINE command.
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 14. Create a new layer named C-SWLK with a color of 2 (Yellow).

n o t E  Because this is a decimal foot drawing, inches are entered as their deci-
mal equivalent. For instance 4″ = 0.333′ because 4″ ÷ 12″ = 0.33. If this drawing were 
set up using architectural units, the distances in step 12 would be 43′-4″ (43.333), 12′-3″ 
(12.25), 3′-6″ (3.5), and 15′-9″ (15.75), respectively.

 15. Move front and back sidewalks to the newly created layer.
The bottom of Figure 13.10 shows the completed side and front 

sidewalk.

 16. Press ↵ to end the command.

 17. Save this drawing as I13-03-FinishedDriveway.dwg (M13-03-
FinishedDriveway.dwg). 

understanding Site Plan Dimensioning

Civil engineers and surveyors typically use labels instead of dimensions to repre-
sent the length of lines and arcs. Because there are no extension lines indicating 
what’s being dimensioned, the placement of the label is key. Unless designated 
otherwise, a label represents the length of a line or curve until it ends or intersects 
with another object.

For instance, the 83′ driveway label indicates that the driveway is 83′ long from 
its intersection with the property line to the point where it ends near your cabin. 
Because there are no other intersections to consider, it would not matter whether 
the label was placed above or below the line. Label placement does, however, 
become important as we take a look at the lower edge of the driveway.

Aside from the start and endpoints, the top side of the lower edge of the driveway 
does not intersect with any other lines. Therefore, the 22′ label indicates the 
overall length of the line (from endpoint to endpoint). The other side of the line 
is a slightly different story; the sidewalk intersects with it. Therefore, the 18.5′ 
label indicates the length from the right endpoint to where the line intersects 
with the sidewalk.

Conventional dimensions like the ones you created in Chapter 12 are used only 
when representing the distance between two objects, and not for the length of 
an object. Take, for example, the width of the driveway or sidewalks. Because 
the measurement was between two objects, not a linear distance along a single 
object, a conventional dimension is used. As a reminder, the TYP abbreviation 
means typical. This tells you that all of the sidewalks are 3.5′ wide, and both curb 
returns have a radius of 3′.
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Adding a north Arrow

You’ve been identifying east to the right of the cabin and north to the top. Now 
you’ll add a North arrow to identify the directions to anybody looking at your 
drawing. Here’s how:

 1. Create a new layer named C-ANNO-NARW with a color of 2 (Red), 
and set it as current. 

 2. Start the INSERT command, and use the Browse button to locate the 
I-SITE-MISC-NARW.dwg (M-SITE-MISC-NARW.dwg) file found in the 
Chapter 13 download.

If you haven’t already, you can download the dataset for this chap-
ter from this book’s website at www.sybex.com/go/autocad2015ner 
or from www.thecadgeek.com.

 3. From the Insert dialog box, make sure Insertion Point is the only 
property set to Specify On-Screen and click OK.

 4. Place the block in the upper-left quadrant of the plan, just outside the 
property line, as shown in Figure 13.11.

F I G u R E   1 3 . 1 1 :   The completed site plan

 5. Open the Layer Properties Manager, and change the linetype for the 
C-PROP-LINE layer to PHANTOM2.

You’ll have to load this linetype; review Chapter 6, “Using Layers to 
Organize Your Drawing,” if necessary.
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 6. Verify that LTSCALE, PSLTSCALE, and MSLTSCALE are each set to 1, and 
change the annotation scale to 1:20 (1:2).

You’ll see the PHANTOM2 linetype for the property lines.
Finally, you need to set the base point—that is, the location that 

will be attached to the cursor when this drawing is inserted as a 
block or external reference.

 7. Type BASE↵, and click the lower-left corner of the driveway. Refer to 
Figure 13.8 if necessary.

Your drawing should look like Figure 13.11.

 8. Save this drawing in your Training Data folder as I13C-SPLAYO.dwg 
(M13C-SPLAYO.dwg).

t I P  You can begin to see how NCS provides a certain consistency between disci-
plines. C is the discipline code for civil plans, and SP stands for site plan. Therefore, this is 
a civil site-plan layout drawing.

This completes the site plan. The next step is to attach the site plan as an 
external reference into the cabin drawing.

Setting up an External Reference
When you set up an external reference, you go through a process similar to that 
of inserting a block into a drawing, as you did in Chapter 7, “Combining Objects 
into Blocks.” You select the drawing to be referenced and specify the location of 
its insertion point. There are options for the X scale factor, Y scale factor, and 
rotation angle, the same as there are for inserting blocks. Here, as with blocks, 
you can set up the command so that it uses the defaults for these options with-
out prompting you for approval.

using the External References Palette
You can run all external reference operations through the External References 
palette, which you can open by clicking the Insert tab and then clicking the 
External References button (the small arrow in the lower-right corner) on the 
Reference panel, or by entering XR↵. The External References palette is capable of 
referencing a wide assortment of file types in addition to AutoCAD drawing (DWG) 
files. Popular raster image formats such as JPEG and TIF can be referenced as 
images in addition to DWF, DGN, and PDF files. DWF files are vector image files 

www.MouradEngineering.com



7 2 8 	 C h a p t e r 	 13 	 • 	M an a g i n g 	 E x t e r n a l 	 R e f e r e n c e s

produced by several Autodesk products and are similar to Adobe PDF files. Files 
that have the .dgn extension are drawings created with MicroStation CAD soft-
ware from Bentley Systems. Finally, point clouds stored in the PCG and ISD for-
mats are created from laser scanners or products such as Autodesk® ReCap™ and 
Autodesk® ReCap 360™.

t I P  Autodesk ReCap Studio is a separate program included with the AutoCAD 
installation media. Serving as an abbreviation for reality capture, ReCap Studio allows 3D 
point clouds to be referenced into AutoCAD as a real-world reference for design.

Autodesk ReCap 360 is a product within the Autodesk 360 family of products that builds 
3D models from digital photographs taken with any standard digital camera. Visit www 
.recap360.autodesk.com to learn more about Autodesk ReCap 360.

The following two series of steps will guide you through the process of attaching 
I13C-SPLAYO.dwg (M13C-SPLAYO.dwg) to I12A-FPLAYO.dwg (M12A-FPLAYO.dwg) as 
an Xref. First, you will attach the site plan drawing to the floor plan drawing as an 
external reference:

 1. Open I12A-FPLAYO.dwg (M12A-FPLAYO.dwg) from your Training Data 
folder (or from this chapter’s download), and zoom to the drawing’s 
extents.

 2. Create a new layer called A-ANNO-REFR.

 3. Assign color 7 (White) as the layer color, and make the A-ANNO-REFR 
layer current.

 4. Click the Insert tab, and then click the External References button 
(small arrow in the lower-right corner of the Reference panel) to open 
the External References palette.

 5. Click the Attach DWG button in the palette toolbar, as shown in 
Figure 13.12.

 6. In the Select Reference File dialog box that opens, locate the 
Training Data folder (or the folder in which your training files are 
stored) and select I13C-SPLAYO.dwg (M13C-SPLAYO.dwg).

A thumbnail image of the drawing appears in the preview window, 
as shown in Figure 13.13.
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F I G u R E   1 3 . 1 2 :   The Attach DWG button on the External References palette

F I G u R E   1 3 . 1 3 :   Select the Xref in the Select Reference File dialog box.
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 7. Click Open to open the Attach External Reference dialog box, and 
then click the Show Details button in the bottom-left corner to dis-
play the reference paths (see Figure 13.14).

F I G u R E   1 3 . 1 4 :   The Attach External Reference dialog box with I13C-
SPLAYO (M13C-SPLAYO) as the named reference

The file being referenced, I13C-SPLAYO.dwg (M13C-SPLAYO.dwg), appears in 
the Name drop-down list at the top of the dialog box, with the full path of the 
file’s location at the bottom. The middle of the dialog box contains three options 
for the insertion process, which are like those in the Insert dialog box that you 
used for inserting blocks in Chapter 7. Note that only the insertion point is set 
to be specified on the screen. The Scale and Rotation options should be set to 
use their default settings. If they aren’t, click the appropriate check boxes so 
that this dialog box matches Figure 13.14. Continue as follows:

 1. With the Attach External Reference dialog box still open, check 
Specify On-Screen for the Insertion Point and leave it unchecked for 
Scale and Rotation.

 2. Make sure Overlay is selected in the Reference Type group, and set 
the path type to Relative Path.

The Attach External Reference dialog box should look like 
Figure 13.14.

 3. Click OK.

Note the difference 
between the Found 
In and Saved Path 
options listed at the 
bottom of the External 
References palette. The 
different path types 
are explained in the 
“Changing Path Types” 
section later in this 
chapter.

▶
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You return to your drawing, and the site plan drawing appears and 
moves with the base point attached to the crosshair cursor.

 4. Click at the top-left corner of the rear deck post to indicate the 
insertion point, and then zoom to the drawing’s extents.

The Xref drawing is attached, and it appears in the site plan  
(see Figure 13.15).

F I G u R E   1 3 . 1 5 :   The I13C-SPLAYO (M13C-SPLAYO) drawing attached to 
the I12A-FPLAYO (M12A-FPLAYO) drawing

t I P  If the site plan I13C-SPLAYO (M13C-SPLAYO) is screened back or trans-
parent after attaching it as an Xref, expand the Reference tab on the Insert tab and dese-
lect the Xref Fading button.

 5. Save this drawing as I13-04-ExternalReference.dwg (M13-04-
ExternalReference.dwg).

Notice the scale of the site layout drawing. Despite the difference in units (the 
site drawing was set up with each unit equal to a foot, and this floor plan draw-
ing is set up with each unit equal to an inch), AutoCAD automatically scaled 
the site plan to the correct size. This conversion was performed based on the 
Insertion Units setting you made with the UNITS command. As you may recall, 
your floor plan drawing had this set to inches, whereas your site plan was set to 
feet. Being diligent as you set up your drawings has allowed you to work smarter 
by letting AutoCAD handle this small but incredibly important detail.
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Attachment and overlay: What’s the Difference?

External references are especially popular in architectural and engineering proj-
ects. This is partially because each discipline is typically completed by separate 
teams. By dividing a project into logical segments with external references, one 
member of the architectural design team can work on the first-floor plan at the 
same time another team member is working on the first-floor furniture plan, for 
example. While the architectural team advances their design, a member of the 
electrical design team could reference their individual drawings to begin work 
on the first-floor lighting plan. External references also provide a way for project 
teams to assemble different plan sheets.

Because Xrefs are such an integral part of so many projects, it’s especially impor-
tant to think before you reference. Choosing the wrong reference type can have 
a bad effect on the entire project.

In the previous image, SQUARE.DWG has two drawings referenced into it: 
PENTAGON.DWG and CIRCLE.DWG. The External Reference Type for PENTAGON 
.DWG is Attachment, whereas the External Reference Type for CIRCLE.DWG is 
Overlay. Despite the differing reference types, there is no difference in what’s 
shown in SQUARE.DWG; you’re able to see the pentagon, circle, and square.

The difference between the Attachment and Overlay reference types is not seen 
until you try referencing SQUARE.DWG into another drawing—TRIANGLE.DWG 
in our example. Take note of the objects displayed in TRIANGLE.DWG. Both the 
pentagon and square are shown; however, the circle is not.

(Continues)
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The overlay Reference type

When an Xref reference type is set to Overlay, that reference is dropped when 
referenced into another drawing. In the example, CIRCLE.DWG is referenced into 
SQUARE.DWG as an overlay reference. As a result, it displays in SQUARE.DWG, but 
not when SQUARE.DWG is referenced into another drawing (TRIANGLE.DWG).

Beware of Circular References

A danger of using the Attachment reference type is the potential for circular refer-
ences. In the previous example, PENTAGON.DWG is attached to SQUARE.DWG, 
and SQUARE.DWG is attached to TRIANGLE.DWG. This means that PENTAGON 
.DWG is a nested reference inside TRIANGLE.DWG. Because the Attachment 
reference type was used, you cannot reference TRIANGLE.DWG into SQUARE 
.DWG or PENTAGON.DWG without creating a circular reference.

A circular reference occurs when a drawing contains a sequence of nested references 
that refer back to itself. Because everything to the left is a nested reference, the 
reference sequence PENTAGON.DWG ➢ SQUARE.DWG ➢ TRIANGLE.DWG ➢ 
PENTAGON.DWG is a circular reference.

For this reason, I recommend that you always default to the Overlay reference 
type unless you have a specific reason to use the Attachment reference type. 
Using the Overlay reference type will allow you to create references between 
any drawings without worrying about circular references.

organizing the Drawing objects
The attached Xref appears exactly as it did when it was the current drawing. The 
drawing is cluttered now, and when you use this file as part of a site plan or part 
of the cabin drawing, you don’t want all the information to be visible. In fact, 
you want most of the information to be invisible. You’ll ultimately accomplish 
this by freezing many of the layers in the drawing viewports, as explained in 
Chapter 14, “Using Layouts to Set Up a Print.” For now, you’ll just move the 

Attachment and overlay: What’s the Difference? (Continued)
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elevations and notes out of the site area by using a layer state to return to the 
current layer configuration. Here’s how:

 1. Continue using I13-04-ExternalReference.dwg (M13-04-
ExternalReference.dwg), or open it if it’s not already open.

 2. Expand the Layer State drop-down list from the Layers panel on the 
Home tab, and select Manage Layer States (see Figure 13.16).

F I G u R E   1 3 . 1 6 :   Accessing the Layer States Manager from the Ribbon

 3. In the Layer States Manager, click New and then name this new state 
Plan and Elev No Hatch.

 4. Click OK to close the New Layer State To Save dialog box.

 5. Click Close to save the layer state and return to the drawing.

 6. Turn on and thaw all the layers.

 7. Carefully move the elevations and notes outside the property line.
Figure 13.17 shows the elevations stacked on the right side of the 

drawing area.

F I G u R E   1 3 . 1 7 :   The elevations and notes moved to the right side of the 
drawing area

▶

Experiment with 
the LAYON (Turn 
All Layers On) and 
LAYTHW (Thaw All 
Layers) commands 
found by expanding 
the Layers panel on the 
Home tab.
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 8. Expand the Layer States drop-down list once again, and choose the 
Plan And Elev No Hatch state.

This restores the selected state, and the layers return to the condi-
tions they had when the layer state was saved.

 9. Save this drawing as I13-05-OrganizeObjects.dwg (M13-05-
OrganizeObjects.dwg).

Moving and Rotating an Xref
Now you need to rotate the site plan to match the orientation of the cabin:

 1. Continue using I13-05-OrganizeObjects.dwg (M13-05-
OrganizeObjects.dwg) or open it if it’s not already open.

 2. Freeze the A-ANNO-DIMS layer.

 3. Start the ROTATE command, click the site plan, and then press ↵.

 4. To specify the insertion point of the Xref as the rotation point, activate 
the Insert object snap and then click any object from the site plan.

 5. At the Specify rotation angle or: prompt, enter 90↵.
The site plan is rotated 90 counterclockwise, matching the orienta-

tion of the cabin (see Figure 13.18).

F I G u R E   1 3 . 1 8 :   The site plan Xref is rotated properly in the cabin drawing.

www.MouradEngineering.com



7 3 6 	 C h a p t e r 	 13 	 • 	M an a g i n g 	 E x t e r n a l 	 R e f e r e n c e s

 6. Save the current drawing, I13-05-OrganizeObjects.dwg (M13-
05-OrganizeObjects.dwg), as I13-06-XRefRotate.dwg (M13-06-
XRefRotate.dwg).

You have established I13C-SPLAYO (M13C-SPLAYO) as an external reference in 
this drawing. The next step is to make revisions to I13C-SPLAYO (M13C-SPLAYO) 
and see how they are reflected in the host drawing.

Modifying an Xref Drawing
You can modify an Xref drawing by following this general procedure:

 1. Make the Xref the current drawing.

 2. Make the modification.

 3. Save the changes.

 4. Make the host drawing current.

 5. Reload the Xref.

AutoCAD users can also modify an Xref by using a special modification com-
mand while the host drawing is current. This section demonstrates both meth-
ods. You’ll start by opening I13C-SPLAYO.dwg (M13C-SPLAYO.dwg) and adjusting 
the width of the road. Then you’ll make I13C-SPLAYO (M13C-SPLAYO) current 
again and use AutoCAD to modify the site plan as an Xref, changing the prop-
erty line and moving the North arrow.

Modifying an Xref by Making It the Current 
Drawing
The longest part of the driveway is 8′-0″ (2.5 m) wide, and you want to increase 
that to 10′-0″ (3.1 m). You’ll begin by making the change in the site plan 
drawing:

 1. With I13C-SPLAYO.dwg (M13C-SPLAYO.dwg) as the current drawing, 
zoom in to the area that includes the road and the driveway.

 2. Offset the lower road line 2′ (0.6 m) downward, as shown in the top of 
Figure 13.19.

 3. Fillet the right side with a radius of 3′ (1 m) and the left at 6′ (2 m).
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F I G u R E   1 3 . 1 9 :   Offset the lower driveway line (top), fillet the new lines, and 
delete the existing radii (bottom).

 4. Delete the original line and radii.
Your driveway is now 10′ (3.1 m) wide, as shown at the bottom of 

Figure 13.19.

 5. Save the I13C-SPLAYO.dwg (M13C-SPLAYO.dwg) drawing.

n o t E  Remember that 1 unit in the site plan drawing is equal to a foot, not an 
inch as in the floor plan drawing. Consequently, the foot mark is not needed as you enter 
distances. For example, to complete step 2, enter 2↵, not 2′.

Although you’ll make more changes later, this concludes the modifications 
you’ll make to the site plan in this exercise. Now you can return to the cabin 
drawing. From the cabin drawing, you will reload the site plan external refer-
ence to see the changes you made to the driveway:

 1. Switch to the I12A-FPLAYO.dwg (M12A-FPLAYO.dwg) file.
A balloon message appears at the bottom of the AutoCAD window 

(see Figure 13.20), pointing to the Manage Xrefs icon in the tool tray. 
This indicates that an externally referenced drawing has been saved 
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after it was attached to the current drawing. You could click the blue 
link text to reload the file, but for this exercise, you will look at the 
External References palette and reload the file from there.

F I G u R E   1 3 . 2 0 :   The balloon message indicating that the Xref has changed

 2. Open the External References palette, as shown in Figure 13.21, and 
stretch it to make it wider.

F I G u R E   1 3 . 2 1 :   The External References palette showing the status of  
the Xrefs

The palette shows most of the pertinent information regarding the 
externally referenced files in the scene, including the status. When 
you pause the cursor over a reference, a cue card displays a thumbnail 
image and additional information about that file. In this case, the pal-
ette indicates that I13C-SPLAYO (M13C-SPLAYO) needs reloading.

 3. Select the I13C-SPLAYO (M13C-SPLAYO) Xref in the palette, right-click, 
and choose Reload from the context menu.

www.MouradEngineering.com



 M o d i f y i n g  a n  X r e f  D r a w i n g  7 3 9

This causes AutoCAD to reevaluate the external reference and 
update the current drawing. The cabin drawing now shows the 10′ 
(3.1 m) wide access road from the site plan drawing (see Figure 13.22).

F I G u R E   1 3 . 2 2 :   The cabin drawing with the updated site plan Xref

 4. Close the I13C-SPLAYO (M13C-SPLAYO) file, but leave the I13-06-
XRefRotate.dwg (M13-06-XRefRotate.dwg) file open.

In this exercise, you saw how a host drawing is updated when the drawing that 
is externally referenced is made current, modified, saved, and then reloaded as 
an Xref. Layers become an even more important tool when using external refer-
ences. You can set them up one way in the actual drawing and another way in the 
Xref of that drawing in a host file. In fact, you can externally reference the same 
drawing into any number of host files; have the layer characteristics of visibility, 
color, and linetype be different in each host file; and save them as such with each 
host file. External referencing is a powerful feature of AutoCAD, and you’ll learn 
more about the possible applications of this tool toward the end of this chapter.
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Modifying an Xref from within the Host Drawing
Sometimes all you need to do is make a minor edit to a referenced drawing. The 
Edit Reference In-Place (REFEDIT) command provides an excellent way of doing 
this without leaving your current drawing. You can’t do things like create a new 
layer with this tool, but many of the regular editing commands are available 
when you use it. To see how this feature works, follow these steps to make a few 
modifications to the site plan Xref:

 1. In the I13-06-XRefRotate.dwg (M13-06-XRefRotate.dwg) file, make 
layer 0 current.

 2. Zoom in to see the cabin and the lower portion of the property line 
(see Figure 13.23).

F I G u R E   1 3 . 2 3 :   The cabin and the lower portion of the property line
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 3. Select the property line or any other object belonging to the I13C-
SPLAYO.dwg (M13C-SPLAYO.dwg) drawing.

This opens the contextual External Reference Ribbon tab 
(Figure 13.24), which contains many of the most commonly used 
External Reference commands.

F I G u R E   1 3 . 2 4 :   The contextual External Reference Ribbon tab that opens 
after selecting an Xref

 4. On the Edit panel of the contextual External Reference tab, pick the 
Edit Reference In-Place (REFEDIT) command.

Alternatively, you could also start the REFEDIT command from the 
Reference panel on the Insert tab, or by selecting the Xref and using 
the right-click context menu to choose the Edit Xref In-Place option. 
The Reference Edit dialog box opens (see Figure 13.25). On the Identify 
Reference tab, I13C-SPLAYO (M13C-SPLAYO) is listed as the selected Xref 
with the North Arrow block shown as a nested reference. A preview 
window illustrates the Xref drawing.

F I G u R E   1 3 . 2 5 :   The Reference Edit dialog box

◀

The REFEDIT com-
mand edits both blocks 
and Xrefs. So, in the 
AutoCAD technical 
vocabulary for this 
command and its 
prompts, both blocks 
and Xrefs are referred 
to as references.
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 5. Click OK. The contextual Edit Reference panel appears at the right 
end of every Ribbon tab.

W A R n I n G  If you have the AutoSave tool set automatically to save your 
drawing periodically (Application menu ➢  Options ➢  Open And Save ➢  File Safety 
Precautions ➢ Automatic Save or SAVETIME↵), this feature is disabled during refer-
ence editing.

You’re now free to use many of the drawing and modifying com-
mands on the site plan drawing that you just selected.

 6. Open the Layer Properties Manager, and notice that several new lay-
ers now appear.

The following are at the top:

▶▶ $0$C-PROP-LINE

▶▶ $0$C-ROAD

These are lower down in the list:

▶▶ 0-REfEdit0

▶▶ I13C-SPLAYO |C-PROP-LINE (M13C-SPLAYO |C-PROP-LINE)

▶▶ I13C-SPLAYO |C-ROAD (M13C-SPLAYO |C-ROAD)

The layer names separated by the pipe (|) symbol indicate that 
these are layers from the externally referenced C-SPLAY1 drawing 
and are referred to as Xref-dependent. C-SPLAY1|C-PROP-LINE and 
C-SPLAY1|C-ROAD appear in the Layer Properties Manager even 
when you are not editing an Xref in-place.

One restriction in the layer tools is that you can’t make an Xref-
dependent layer current in the host drawing. The layers at the top of 
the dialog box, the ones with the dollar sign ($), are temporary and 
will hold any objects created on them in the editing session and then 
shift those objects to the proper Xref layer at the conclusion of the 
editing session.

 7. Make the $0$C-PROP-LINE layer current, and then offset the lower-
right diagonal property line 10′-0″ (3048) to the right (see Figure 13.26).
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Fillet this corner.

Fillet this corner.

O�set and then erase 
this line.

F I G u R E   1 3 . 2 6 :   The new property line created in the externally referenced 
site plan

W A R n I n G  When using the REFEDIT command to modify a drawing that 
has different units than the current drawing, the current drawing always takes prece-
dence. In this example, although the reference you’re editing is set up in decimal feet, 
the current drawing is set up in architectural units. Consequently, you must enter the 
foot symbol to offset the property line 10′.

 8. Fillet the two lines that intersected with the line you just offset to the 
newly created line by using a radius of 0.

 9. Erase the original line (see Figure 13.26).

 10. Select the Save Changes button on the contextual Edit Reference 
Ribbon panel appended to the end of each Ribbon tab.

 11. When the Warning dialog box opens, click OK.
Your changes to the site plan are now saved back to the I13C-SPLAYO 

.dwg (M13C-SPLAYO.dwg) file, and the Edit Reference In-Place tool is 
terminated.
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 12. Use Zoom To Extents, and then zoom out a little to a view of the 
whole site (see Figure 13.27).

F I G u R E   1 3 . 2 7 :   The floor plan drawing with the revised Xref of the site plan

 13. Save this drawing. It’s still named I13-06-XRefRotate.dwg (M13-06-
XRefRotate.dwg).

In this exercise, you saw how a host drawing is updated when its external ref-
erence is changed and how you can control the appearance of objects in the Xref 
drawing from the host drawing by working with the Xref-dependent layers. You 
also saw how you can modify objects in the Xref from the host drawing by using 
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the in-place Xref editing tool. A drawing can serve as an external reference in 
several host drawings at the same time and have a different appearance in each 
one, including location, rotation, and scale. The results of in-place Xref editing, 
however, must be saved back to the original drawing in order to be viewed in the 
Xref. In-place Xref editing is usually done only when the results are meant to be 
permanent changes in the original source drawing.

Adding an Image to a Drawing
Not only can you externally reference other drawing files into the current draw-
ing, but you can also reference image files. Using this feature, you can add digi-
tal photographs or scanned images, such as artist renderings and construction 
forms, to a drawing. The procedure is similar to adding an externally referenced 
drawing; just follow these steps:

 1. Continue using I13-06-XRefRotate.dwg (M13-06-XRefRotate.dwg), 
or open it if it’s not already open.

 2. Create a new layer named A-ANNO-REFR-IMAG and make it current.

 3. Open the External References palette from the View tab ➢ Palettes 
panel.

 4. Right-click a blank area in the File References area below the existing 
filenames, and choose Attach Image from the context menu shown in 
Figure 13.28 to open the Select Image File dialog box.

F I G u R E   1 3 . 2 8 :   Attaching an image from the External References palette
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You can also click the down arrow next to the Attach DWG button, 
and choose Attach Image from the context menu.

 5. Navigate to the CabinLand.jpg file included with the download for 
this chapter, and then click the Open button (see Figure 13.29).

F I G u R E   1 3 . 2 9 :   Selecting the image to be referenced in the Select Reference 
File dialog box

You can download the CabinLand.jpg file from this book’s web 
page, www.sybex.com/go/autocad2015ner or www.thecadgeek.com.

n o t E  The list of compatible formats also includes other popular image file for-
mats, such as USGS Digital Orthophoto Quadrangle (DOQ); Multiresolution Seamless Image 
Database, or MrSID (SID); and Adobe Photoshop (PSD) documents. Both DOQ and SID files 
are especially popular in the civil engineering and geographical information system (GIS) 
fields, whereas Adobe Photoshop documents are popular in graphic design fields.

▶

Most of the common 
image file formats, 
such as JPEG and TIF, 
are compatible with 
AutoCAD 2015.
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The Attach Image dialog box that opens is similar to the External 
Reference dialog box that you saw earlier in this chapter.

 6. Select Relative Path for the path type. Check the Specify On-Screen 
options for both Scale and Insertion point (see Figure 13.30), and 
then click OK.

F I G u R E   1 3 . 3 0 :   Select Relative Path for the path type in the Attach Image 
dialog box.

 7. In the drawing area, click once to designate the lower-left corner of 
the image, move the cursor, and then click again to create the rect-
angular frame for the image.

The image appears inside the frame (see Figure 13.31). The exact 
size and location of the frame are unimportant for this exercise, so 
ignore them for now. In the next chapter, you will decide how to view 
the image in the context of the rest of the drawing.

◀

When you select an 
image file, a preview 
appears in the Select 
Reference File dialog 
box. You can use the 
arrow buttons on the 
keyboard to change the 
selection and associated 
preview image quickly.
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F I G u R E   1 3 . 3 1 :   Placing the referenced image in the drawing

 8. Enter IMAGEFRAME↵0↵ to set the variable to 0.

 9. Save the cabin drawing as I13A-FPLAYO.dwg (M13A-FPLAYO.dwg), and 
then close the file.
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Controlling the Visibility of Image Frames

The IMAGEFRAME variable determines the visibility of the image frame as follows:

▶▶ Setting the variable to 0 (zero) causes the frame to be invisible.

▶▶ Setting the variable to 1 displays the frame and also shows the frame 
when the drawing is plotted. (Plotting is covered in Chapter 15, “Printing 
a Drawing.”)

▶▶ Setting IMAGEFRAME to 2 displays the frame in the viewport, but it does 
not display the frame when the drawing is plotted.

This variable affects all the images in the drawing and, prior to AutoCAD 2012, it 
also controlled whether an image could be selected.

That’s all there is to adding images to AutoCAD drawings. You can move and 
rotate the image by using the same tools as with any other object. You can resize 
the image by selecting the frame and adjusting the grips. You get access to some 
rudimentary image-editing tools when you double-click the image frame. Feel 
free to experiment with these tools, but do not be concerned about altering the 
image file; these adjustments affect only the image’s display inside AutoCAD.

Putting Xrefs to use
External references have many uses. I’ll describe two common applications to 
illustrate their range.

Suppose you’re working on a project as an interior designer and a subcon-
tractor to the lead architect. The architect might use Autodesk® 360 to share 
the floor plan with you and the other members of the project team. Using the 
Autodesk 360 functionality built into AutoCAD, you can use external references 
to load the architect’s drawing into your drawing. This loads the architect’s 
drawing as a background that you can proceed to draw on top of.

Just as the architect shared the floor plan with you by using Autodesk 360, 
you too can use the service to share your own design with the project team that 

◀

You can browse files 
saved to the Autodesk 
360 service within 
AutoCAD by clicking the 
Autodesk 360 button in 
the upper-left corner of 
any file dialog box.
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might include a structural engineer, mechanical engineer, or even a landscape 
architect. Because shared files automatically synchronize with everyone on 
the project team, referencing drawings from Autodesk 360 helps ensure you’re 
always working with an up-to-date version of the floor plan drawing.

t I P  To acce ss an e ar l ie r  ve r s i o n of  any f i le  s ave d to Au to de sk 36 0,  v i s i t 
http://360.autodesk.com and log in with your Autodesk ID. Browsing to the 
Document Details of any file will allow you download previous versions of a file. 

The specific mechanics of this workflow begins with the architect saving the 
most recent version of the floor plan to the Autodesk 360 service. Once the 
floor plan is saved to Autodesk 360, the architect can specify permissions and 
share the floor plan with other members of the project team. Sharing provides 
immediate and constant access to the floor plan, and allows the floor plan 
to be externally referenced into other drawings. With the framework shown 
in Figure 13.32, as the architect uploads new versions of the floor plan, the 
changes are immediately available to the rest of the project team.

Share to Autodesk 360 (A360)

Xref from
A360

Xref from
A360

Xref from
A360

Interior Structural Landscape

Architect

F I G u R E   1 3 . 3 2 :   Sharing and externally referencing drawings with Autodesk 360
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Xrefs are often used when parts of a job are being done in an office where a 
network is in place. Suppose a project involves work on several buildings that 
are all on the same site. If the project uses Xrefs, each building can be externally 
referenced to the site plan. This keeps the site plan drawing file from getting too 
large and allows the project work to be divided among different workstations; 
in addition, the project manager can open the host site plan and keep track of 
progress on the whole project (see Figure 13.33).

Site Plan

F I G u R E   1 3 . 3 3 :   Three buildings as Xrefs to a single site plan

These two applications for setting up Xrefs in relation to a host file are appli-
cable to almost any profession or trade using AutoCAD.

Exploring Additional Xref Features
You have seen how you can modify an Xref in the host or the original drawing 
and how to bring in images. A few other features of external references deserve 
mention.

Setting the Xref Path
When you attach an Xref to the host drawing, AutoCAD stores the name of the 
Xref and its path.
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Each time you open the host drawing, AutoCAD searches for any Xrefs saved 
with the host file and displays them in the host drawing. If the Xref drawing is 
moved to a new folder after the Xref has been attached to a host, AutoCAD won’t 
be able to find the Xref or display it. To avoid that situation, you must update the 
host drawing with the new path to the Xref file. Let’s go through a quick exer-
cise to illustrate how this works:

 1. Use Windows Explorer to create a new subfolder called Xref within 
the Training Data folder you previously set up.

 2. Move I13C-SPLAYO.dwg (M13C-SPLAYO.dwg) to this folder.

 3. Return to AutoCAD and open I13A-FPLAYO.dwg (M13A-FPLAYO.dwg) 
again.

The Xref doesn’t show up, and the References – Unresolved 
Reference Files dialog box opens (see Figure 13.34).

F I G u R E   1 3 . 3 4 :   References – Unresolved Reference Files dialog box

AutoCAD is unable to find the Xref because the path has changed.

 4. Click the Update The Location Of The Referenced Files option to open 
the External References palette.

In the Details area where Xrefs are listed, the path appears for each 
Xref under the heading Saved Path (see Figure 13.35). The dot back-
slash (.\) preceding the filename indicates that the current file path 
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is relative and in the same folder as the current drawing. You can slide 
the scroll bar to the right—or widen the palette—to see the full path. 
Notice also that the Status column for this Xref reads Not Found.

F I G u R E   1 3 . 3 5 :   The missing Xref is identified in the External References 
palette.

 5. Click the I13C-SPLAYO (M13C-SPLAYO) Xref to highlight it.

 6. Move down to the Details area, and click the blank space to the right 
of Saved Path.

 7. A button with three dots appears at the right end of the blank space. 
Click it.

This opens the Select New Path dialog box.

 8. Find the I13C-SPLAYO.dwg (M13C-SPLAYO.dwg) drawing in the new 
Xref folder, highlight it, and click Open.

Back in the External References palette, the path has been updated to 
reflect the current location for I13C-SPLAYO.dwg (M13C-SPLAYO.dwg).

 9. Move or minimize the palette, and then perform a Zoom Extents.
You can see that the Xref is restored in your drawing.
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W A R n I n G  When you’re working with Xrefs, be careful where you store 
files that are acting as Xrefs to other files. All the files’ paths must remain valid for the 
Xrefs to be located.

Changing Path types
As you share drawings, it’s important to understand how the path type you 
choose will impact how the drawings you create can be shared. AutoCAD pro-
vides three distinct path types for Xrefs:

Full (Absolute) Path  This is the default path type for Xrefs, and it includes 
the full hierarchy of folders that locates the file reference. Because this type 
of reference includes both the drive letter and folder reference, it is not con-
ducive to sharing as it requires the recipient to use the same drive and folder 
structure as you.

no Path  When this path type is selected, both the host drawing and the refer-
ence drawing must be located in the same directory. This can be a useful option 
when sharing files with third parties as it doesn’t require the recipient to use 
your file management structure.

Relative Path  Often regarded as the most versatile path option, relative paths 
store only as much of the folder structure as needed for AutoCAD to find a refer-
ence. Provided both the host and reference drawings are on the same drive and 
in the same project directory, a third-party recipient will be able to open your 
drawing with its Xrefs as long as the project directory structure remains intact.

Although you can choose between these path types when creating an Xref, 
AutoCAD does not provide a path option when modifying Xref paths. As you 
modify Xref paths by using the procedure outlined in the “Setting the Xref 
Path” exercise earlier, it’s important to understand that AutoCAD will make 
your Xref an Absolute Path Xref regardless of the previously selected path 
type. The Change Path tool allows you to change between the path types 
outlined earlier. 

Follow these steps:

 1. Select the I13C-SPLAYO.dwg reference from the External References 
palette shown on the left in Figure 13.36.
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F I G u R E   1 3 . 3 6 :   Changing the Xref path type (left) and the resulting relative 
path (right)

 2. Choose Make Relative by clicking the Change Path button along the 
top edge of the External References palette (highlighted on the right 
in Figure 13.36).

 3. Select the I13C-SPLAYO.dwg reference once again, and note the Saved 
Path field in the Details panel of the External References palette.

In this example, I13C-SPLAYO.dwg (M13C-SPLAYO.dwg) will correctly load  
into the I13A-FPLAYO.dwg (M13A-FPLAYO.dwg) drawing if the project’s drawing 
directory structure remains unaltered. Because AutoCAD is only looking at  
the directory structure, moving from the current C:\ drive to another drive  
letter would not have any impact on this Xref.

Binding Xrefs
On occasion, you’ll want to attach an Xref to the host drawing permanently. If 
you send your drawing files to a printing service to be plotted, including a set 
of Xref files can complicate things. Also, for archiving finished work, it might 
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be better to reduce the number of files. On some occasions, the Xref might be 
revised for the last time and no longer need to be a separate file. In all these 
situations, you’ll use the BIND command as follows to convert an external refer-
ence into a block that is stored permanently in the host drawing:

 1. In the External References palette, right-click I13C-SPLAYO (M13C-
SPLAYO) in the File References list.

 2. Choose Bind from the context menu to open the Bind Xrefs/DGN 
Underlays dialog box (see Figure 13.37).

F I G u R E   1 3 . 3 7 :   The Bind Xrefs/DGN Underlays dialog box

The two options in the Bind Type area have to do with how layers 
are treated when an Xref is bound to the host drawing:

Bind  This is the default. It sets the Xref layers to be maintained 
as unique layers in the host drawing.

Insert  With the Insert option, layers that have the same name in 
the two drawings are combined into one layer.

None of the layers in I13C-SPLAYO.dwg (M13C-SPLAYO.dwg) has 
the same name as any layer in I13A-FPLAYO.dwg (M13A-FPLAYO 
.dwg). Let’s use the Insert option.

 3. Change Bind Type to Insert, and click OK.
The Xref disappears from the File References list.

 4. Close the External References palette.
Your drawing looks unchanged.

 5. Click the site plan and then open the Properties palette.
The field at the top of the palette identifies the site plan as a block 

reference, as shown in Figure 13.38.
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F I G u R E   1 3 . 3 8 :   The top of the Properties palette with the former Xref 
selected

 6. Open the Layer Properties Manager.
Figure 13.39 shows that the site plan’s layers have all become lay-

ers in the I13A-FPLAYO.dwg (M13A-FPLAYO.dwg) drawing and no lon-
ger have the I13C-SPLAYO| (M13C-SPLAYO|) prefix.

F I G u R E   1 3 . 3 9 :   The Layer Properties Manager showing the new layers

 7. Click the Insert button in the Block panel of the Insert tab.

 8. In the Block Gallery, scroll down until you locate I13C-SPLAYO 
(M13C-SPLAYO).

The former external reference is listed here as a block, along with 
the window and door blocks that you created in Chapter 7 and the 
Grid and North Arrow blocks. A few additional blocks might be on 
the list. These blocks are used by the dimensions in the drawing.

 9. Close the Block gallery by pressing the Esc key.
The site plan is now a permanent part of the I13A-FPLAYO.dwg 

(M13A-FPLAYO.dwg) drawing. If you need to make changes to the site 
plan part of the drawing, you can explode it and use the Modify com-
mands. To edit the site plan while preserving it as a block, you can use 
the REFEDIT (Edit Reference In-Place) command and the BEDIT (Block 
Edit) tool that you used in Chapter 7 to modify the window block.
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 10. You do not want to save the changes in this drawing. Click the Close 
button in the top-right corner of the drawing area, and then click No 
in the dialog box that opens.

 11. Move the I13C-SPLAYO (M13C-SPLAYO) file back into the Training 
Data folder where it was before you began the exercises in the 
“Exploring Additional Xref Features” section.

This has been a quick tour of the basic operations used to set up and control 
external references. There are more features and commands for working with Xrefs 
than I’ve covered here, but you now know enough to start working with them.

Exploring on Your own
What follows are a few additional operations and features that you might find 
useful when you delve more deeply into external references. Play around a little, 
and see what you can do:

▶▶ Externally referenced drawings can also be hosts and have drawings 
externally referenced to them. These are called nested Xrefs. There is 
no practical limit to the number of levels of nested Xrefs that a draw-
ing can have.

▶▶ You can’t explode an Xref, but you can detach it from the host. The 
DETACH command is on the context menu that appears when you 
right-click an Xref in the External References palette.

▶▶ Large, complex drawings that are externally referenced often have 
their insertion points coordinated in such a way that all Xrefs are 
attached at the 0,0 point of the host drawing. This helps keep draw-
ings aligned properly. By default, any drawing that is externally ref-
erenced into a host drawing uses 0,0 as its insertion point. However, 
you can change the coordinates of the insertion point with the BASE 
command. With the drawing you want to change current, enter 
BASE↵ and enter the coordinates for the new insertion point.

▶▶ You can limit which layers and, to some degree, which objects in a 
drawing are externally referenced in the host drawing by using index-
ing and demand loading.
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▶▶ A host drawing can be externally referenced into the drawing that has 
been externally referenced into the host, causing a circular reference. 
An option to avoid this scenario is to choose the Overlay option in the 
Attach External Reference dialog box. Overlays ignore circular Xrefs.

▶▶ If you freeze the layer that was current when an Xref was attached, the 
entire Xref is frozen. Turning off this same layer has no effect on the 
visibility of the Xref.

▶▶ The Unload option—available when you right-click a reference in the 
External References palette—lets you deactivate Xrefs without detach-
ing them from the host file. They stay on the list of Xrefs and can be 
reloaded at any time with the Reload option. This option can be useful 
when you’re working with complex drawings that have many Xrefs.

If You Would Like More Practice…
External references provide a versatile way to organize and collaborate on proj-
ects. Creating individual files for the various components of a project allows 
several team members to collaborate with one another. It is likewise important 
to consider how you choose to structure this collaborative environment. The 
following exercises explore both of these concepts, first by creating separate ref-
erence files and then by testing the different reference types.

Building Architectural References
In this chapter, you externally referenced the site plan drawing into the cabin draw-
ing as an architect who was designing the project might have done. If you were the 
architect, you might want to have several additional drawings. Try doing this:

 1. Create several new drawings of furniture and a shed.
Each object is to have its own layer. Make more than one drawing 

for some of the objects, such as two beds or tables.

 2. Add digital images on their own layers that show real-world examples 
of the furniture.

 3. Externally reference all the furniture and shed drawings into the 
cabin drawing.

 4. Use the Layer States Manager, as covered in Chapter 6, to create layer 
states for each combination of furniture.
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Comparing Reference types
Try using the files found in the RefTypes folder of this chapter’s download to 
test the Attachment and Overlay reference types. See what happens if you try to 
create a circular reference by doing the following:

 1. Open SQUARE.DWG and load PENTAGON.DWG as an Attachment reference.

 2. Also load CIRCLE.DWG as an Overlay reference.
Use an insertion point of 0,0 and scale of 1 for all Xrefs in this 

exercise.

 3. Save SQUARE.DWG and open PENTAGON.DWG.

 4. Use the XREF command to load SQUARE.DWG.

 5. Save and close SQUARE.DWG and open TRIANGLE.DWG.

 6. Attach SQUARE.DWG to TRIANGLE.DWG as either an Attachment or 
Overlay reference type.

 7. Save your completed reference type drawing as MASTER.DWG.

Are You Experienced?

now you can…

✔✔ draw	a	basic	site	plan

✔✔ use	Surveyor’s	units	to	lay	out	a	property	line

✔✔ attach an external reference

✔✔ revise a drawing that is externally referenced

✔✔ modify an Xref from the host drawing

✔✔ change the path type of Xrefs

✔✔ insert image files into an AutoCAD drawing

✔✔ update an Xref path

✔✔ bind	an	Xref	to	a	host	file
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CHAPtER 14

using Layouts to Set 
up a Print
A design is only as good as your ability to communicate that design with the 
people building it. Printing, or plotting as it’s called in the Autodesk® AutoCAD® 
program, is considered by many to be the final phase of that communication 
process. Preparing a document set can be just as challenging as plotting it.

As you work through this and the next chapter, you’ll quickly discover the 
incredible control you have over nearly every aspect of how a drawing plots. 
This versatility means you can probably get AutoCAD to plot exactly the way 
you want it to. However, remembering each of those settings can prove chal-
lenging. Consequently, the key to getting consistent plots is to find a way to 
capture all of those settings in a way that will allow you to reuse them for new 
drawings in the future.

In this chapter, you will set up sheet files by applying a drawing scale that 
allows your 28′ × 18′ (8550 mm × 5490 mm) cabin to fit on an 8 1/2″ × 11″ 
(210 mm × 297 mm), or A4, piece of paper. Since every aspect of the project 
cannot fit on a single Letter (A4) size piece of paper, you will also learn to 
manage entire sets of drawings with Sheet Set Manager. To get to a point 
where you can begin plotting, you will apply the knowledge you’ve gained 
from numerous chapters throughout this book, including Chapter 6 (“Using 
Layers to Organize Your Drawing”), Chapter 9 (“Using Dynamic Blocks and 
Tables”), and Chapter 13 (“Managing External References”).

In this chapter, you will learn to

▶▶ Put	a	title	block	in	a	layout

▶▶ Set	up	viewports	in	a	layout

▶▶ Lock	the	display	of	viewports

▶▶ Control	visibility	in	viewports

▶▶ Add text in a layout
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Preparing the title Block
In Chapter 8, “Controlling Text in a Drawing,” you created the title block or 
border for your cabin. As you may recall, you had to draw the title block much 
larger than the intended plot size of 8 1/2″ × 11″ (210 mm × 297 mm) to fit the 
entire cabin on the sheet. Because layout tabs always have a standard paper size 
such as A4, or 8 1/2″ × 11″ (A4 210 mm × 297 mm), assigned, you will need to 
make a 1:1 version of the title block. Doing this will give you a single reference 
drawing that will be used as the foundation for each of your plan sheets.

Creating the title Block Drawing
You certainly don’t want to waste the time you invested in creating the title 
block for your cabin in Chapter 8. Therefore, while the primary focus of this sec-
tion is to create a usable title block reference, the secondary focus is to preserve 
as much of the work you’ve already done as possible. You can accomplish this by 
using many commands that you already know.

To define your title block reference, take the following steps:

 1. Open the I13A-FPLAYO.dwg (M13A-FPLAYO.dwg) file you created in 
the previous chapter, or from this chapter’s download site at www 
.sybex.com/go/autocad2015ner or www.thecadgeek.com.

 2. Start the Thaw All Layers (LAYTHW) command from the Layers panel 
of the Home Ribbon tab.

 3. Click the Isolate (LAYISO) button also located on the Layers panel of 
the Home Ribbon tab.

 4. Select the outer border of the title block, and a piece of text within 
the title block, as shown in the left image in Figure 14.1. Press ↵ to 
accept the selection set.

Your drawing should show only objects on the A-ANNO-TTLB and 
A-ANNO-TTLB-TEXT layers, matching the right image in Figure 14.1.
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F I G u R E   1 4 . 1 :   Selecting objects on the title block layers (left), and the 
resulting layer state (right)

 5. Start the Write Block (WBLOCK) command by expanding the 
Create Block tool on the Insert tab ➢ Block Definition panel (see 
Figure 14.2).

F I G u R E   1 4 . 2 :   Starting the Write Block (WBLOCK) command from the Ribbon

 6. From the Write Block dialog box, choose the Objects radio button as 
the Source.

 7. Click the Pick Insertion Base Point button, and pick the endpoint in 
the lower-left corner of the outer boundary shown in Figure 14.3.
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F I G u R E   1 4 . 3 :   Choosing the base point for the title block

 8. Click the Select Objects button under the Objects group, and then 
select everything on the A-ANNO-TTLB and A-ANNO-TTLB-TEXT 
layers. Press ↵ to return to the Write Block dialog box.

The bottom of the Objects group of the Write Block dialog box 
should read 23 objects selected.

 9. Toggle the Delete From Drawing option in the Objects group.

 10. In the Destination group, click the ellipsis button for the File Name 
And Path setting to open the Browse For Drawing File dialog box.

 11. Click the ellipsis button at the end of the File Name And Path text box 
to create a file named I14-01-A-BD1117.dwg (M14-01-A-BDA3.dwg) in 
your Chapter 14 Training Data folder.

 12. Verify that your Write Block dialog box looks like Figure 14.4 and 
then click OK to finish the command.
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F I G u R E   1 4 . 4 :   Creating a new drawing for the title block with the WBLOCK 
command

 13. Expand the Layers panel on the Home Ribbon tab, and click the Previous 
(LAYERP) tool to restore the display of layers in the layout drawing.

 14. Save the drawing I13A-FPLAYO.dwg (M13A-FPLAYO.dwg) as I14A-
FPLAYO.dwg (M14A-FPLAYO.dwg), and close it.

You have now extracted the title block out of your floor plan layout drawing 
and created a new drawing with nothing but the title block.

Sizing and Cleaning up the title Block
Your title block was originally constructed in model space with real-world units; 
you will need to scale it down to the dimensions of a letter-sized (A4) piece of 
paper. Since this title block will be used as a block definition in your sheet draw-
ings, you’ll also place everything except the text on layer 0. Follow these steps to 
size and clean up the title block:

 1. Open the I14-01-A-BD1117.dwg (M14-01-A-BDA3.dwg) file you created 
in the previous exercise.

 2. Start the SCALE command and then do this:

 a. Select the entire title block.

 b. Pick the lower-right corner of the interior boundary as the 
base point.
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 3. Instead of entering a scale factor, do this:

 a. Press R↵ to choose the Reference option.

 b. Pick the lower-left corner of the outer boundary and then the 
upper-left corner of the outer boundary (see Figure 14.5).

Reference Length Point 2

Reference Length Point 1

Base Point

F I G u R E   1 4 . 5 :   Specifying a reference length by using the SCALE command

 4. After choosing the points to define the reference length, enter 11↵ 
(297↵) to scale your title block to the exact height of 11″ (297 mm).

You may need to perform a Zoom Extents to bring the title block 
back into view.

 5. Turn layer 0 on if it’s not already, and set it as current.

 6. Expand the Layers panel on the Home Ribbon tab, and click the 
Merge (LAYMRG) tool.

 7. At the Select object on layer to merge prompt, select any object 
on the A-ANNO-TTLB layer and press ↵.

 8. Select Name at the Select object on target layer or [Name] 
prompt, or enter N↵.
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 9. Select layer 0 from the Merge To Layer dialog box shown in Figure 14.6.

F I G u R E   1 4 . 6 :   Selecting layer 0 from the Merge To layer dialog box

 10. Save the drawing I14-01-A-BD1117.dwg (M14-01-A-BDA3.dwg) as 
I14-02-A-BD1117.dwg (M14-02-A-BDA3.dwg).

You have now sized the title block you drew in Chapter 8 to fit on a standard 
11″ × 17″ (297 mm × 420 mm), or A3, sheet size. To make your title block usable 
for any drawing sheet, you’ll continue refining your title block reference by add-
ing block attributes in the next exercise.

Defining the title Block Attributes
Instead of starting from scratch, you’ll use the title block reference you already 
have as the foundation for your sheet information block. The following exercise 
will guide you through the process of creating attributes from the existing text 
in the title block drawing:

 1. Open I14-02-A-BD1117.dwg (M14-02-A-BDA3.dwg) from the 
Training Data folder if it isn’t already open.

 2. From the Insert tab ➢ Block Definition panel, select the Define 
Attributes button to open the Attribute Definition dialog box.

You will create attribute definitions as you did in Chapter 9, except 
this time you’ll focus more on text justification than text style. After 
all of the attributes are defined, you’ll learn how to use the existing 
text as a template for style by using the MATCHPROP (Match Properties) 
command.

 3. For the first attribute, enter PROJECT for the Tag and Enter Project 
Name for the Prompt.
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Sheet Set Manager is an extensive feature set that helps you man-
age the drawings that make up your project. It is discussed a little 
later in this chapter, but for now you’ll simply set up your sheet infor-
mation block so that it can use some of these advanced features.

 4. Click the Insert Field button next to the Default text box in the 
Attribute Definition dialog box.

 5. Select the Field Category drop-down list, and then click the 
SheetSet option.

This filters the list of available Field Names to include only those 
pertaining to Sheet Set Manager.

 6. Choose CurrentSheetSetProjectName from the list of available Field 
Names, and then choose Uppercase from the Format list on the right.

The Field dialog box should look like Figure 14.7.

F I G u R E   1 4 . 7 :   Selecting the Sheet Set Manager project name from the Field 
dialog box

 7. Click OK to exit the Field dialog box.
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n o t E  Design drawings typically use uppercase letters, especially when promi-
nent items such as titles are designated.

Back in the Attribute Definition dialog box, the Default field now 
contains #### and has a gray background, as shown in Figure 14.8.

F I G u R E   1 4 . 8 :   The Attribute Definition with a field set as the Default value

 8. In the Text Settings group, modify the following settings:

 a. Set Justification to Bottom Center.

 b. Set Text Style to Standard, and set Rotation to 90 .̊

 c. Enter an arbitrary text height, such as 1 ⁄8″ (3.5 mm).

With your settings matching those illustrated in Figure 14.8, click OK.

 9. Use the Insertion osnap to place the PROJECT attribute on top of the 
existing SUMMER CABIN text string.

 10. Select the Match Properties button on the Properties panel on the 
Home tab, or enter MA↵ to start the MATCHPROP command.

 11. With Match Properties running, select the SUMMER CABIN text 
string as the source object (see the top image of Figure 14.9), and 
then select the PROJECT attribute definition as the destination 
object (see the bottom image of Figure 14.9).
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F I G u R E   1 4 . 9 :   Matching the properties of the SUMMER CABIN text string with 
the PROJECT attribute definition

 12. Erase the SUMMER CABIN text string to leave the PROJECT attri-
bute definition in its place.

 13. Repeat steps 2 through 12 to create attribute definitions for the 
SHEET_TITLE, SCALE, DATE, DRAWN BY, and SHEET NUMBER 
blocks. Replace the parameters for the PROJECT attribute definition 
with the following:

▶▶ SHEET TITLE

Tag: SHEET_TITLE

Prompt: Enter Sheet Title

Default: Select the Uppercase CurrentSheetTitle Field 
under the SheetSet Field Category.

Justification: Bottom Center

Rotation: 90˚
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▶▶ SCALE

Tag: DRAWING_SCALE

Prompt: Enter Drawing Scale

Default: #″ = #′-#″ (# : ##)

Justification: Bottom Right

▶▶ DATE

Tag: DATE

Prompt: Enter Date Drawn

Default: Select the CurrentSheetRevisionDate under the 
SheetSet Field Category.

Justification: Bottom Right

▶▶ DRAWN BY

Tag: DRAWN_BY

Prompt: Enter Drafter’s Initials

Default: Select the Uppercase Author Field under the 
Document Field Category.

Justification: Bottom Right

▶▶ SHEET NUMBER

Tag: SHEET_NO

Prompt: Enter Sheet Number

Default: Select the Uppercase CurrentSheetNumber Field 
under the SheetSet Field Category.

Justification: Middle Center
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Adjust the position of the DRAWN_BY and DATE attributes as 
needed. The title block should look like Figure 14.10.

F I G u R E   1 4 . 1 0 :   Text strings replaced with attribute definitions

 14. Save your drawing as I14A-BD1117.dwg (M14A-BDA3.dwg).

Instead of static text strings, the title block now has a series of attributes that 
will make changing—and more important, managing—the variable data within 
your title block easier.

Setting up a Sheet template
Keeping all of these settings at consistent values throughout a plan set can be 
rather challenging. One of the best ways to ensure that your entire plan set is 
configured exactly the same way is to start with a template. By creating a tem-
plate of a typical plan sheet, you can then create subsequent plan sheets from it, 
which, in turn, copies all of the plot settings.
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Complete the following to create the template that you’ll use later in this 
chapter for your plan sheets:

 1. Create a folder named Sheets in your Chapter 14 folder.
You will use this folder to store each of the plan sheets.

 2. To begin creating your plan sheet template, create a new drawing 
using the Start Drawing tool on the New Tab.

 3. Click the Model button in the status bar to switch from model space 
to view the drawing through the layout.

The appearance of the drawing area changes to show a view 
into model space inside a white rectangle sitting in front of a gray 
background.

Your drawing has two borders along the perimeter of the white 
rectangle (one dashed and one solid).

▶▶ If the UCS icon consists of two lines inside the solid border (see 
the left of Figure 14.11), you are working in model space.

F I G u R E   1 4 . 1 1 :   The layout in model space (left) and in paper space (right)

▶▶ If the UCS icon is shaped like a triangle and located in a por-
tion of the drawing area (see the right of Figure 14.11), you are 
working in paper space.

The solid line is the boundary to the viewport, and the dashed line 
is the limit of the printable area.
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t I P  You can switch back to paper space when working in model space by moving 
your cursor outside the inner, solid rectangle and double-clicking, or by entering PS↵.

 4. Choose Page Setup Manager from the Output tab ➢ Plot panel to 
open the Page Setup Manager dialog box (see Figure 14.12).

F I G u R E   1 4 . 1 2 :   The Page Setup Manager dialog box

 5. Click New to open the New Page Setup dialog box.

 6. In the New Page Setup Name text box, enter PDF-1117 (PDF-A3) and 
click OK.

This opens the Page Setup dialog box, which has PDF-1117 (PDF-
A3) added to the title bar (look ahead to Figure 14.13). The PDF-1117 
(PDF-A3) name also appears toward the top of the dialog box in the 
Page Setup group. In all, the dialog box has 10 groups containing 
settings that control how the drawing will fit on the printed page and 
what part of the drawing is printed.
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n o t E  This chapter is designed so that you can follow along even if you don’t 
have a printer hooked up to your computer. The plotter used by this book is one that 
installs with AutoCAD and creates a common PDF file.

If you have not created a page setup previously, None will be 
selected. By default, the Printer/Plotter Name drop-down list also 
lists all of the plotters (printers) installed on your computer.

 7. Select the DWG To PDF. pc3 plotter from the Printer/Plotter Name 
drop-down list.

In the Printer/Plotter group, DWG To PDF.pc3 is the selected 
plotter.

 8. From the drop-down list in the Paper Size group, select ANSI Full Bleed 
B (17.00 × 11.00 Inches) or ISO Full Bleed A3 (420.00 × 297.00 mm).

Because each printer/plotter will likely have slightly different page 
sizes, it’s best to select the plotter first and the paper size second.

 9. With both the plotter and paper size selected, complete your page 
setup by setting the following parameters:

▶▶ Plot Area

What To Plot: Layout

▶▶ Plot Scale

Scale: 1:1

Units: Inches (mm)

▶▶ Plot Style Table (Pen Assignments)

Plot Style Table: monochrome.ctb

Display Plot Styles: Checked

▶▶ Drawing Orientation

Landscape: Selected

When finished, the Page Setup - PDF-1117 (Page Setup - PDF-A3) 
dialog box should look like Figure 14.13.
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F I G u R E   1 4 . 1 3 :   The completed page setup

t I P  The Scale drop-down list contains several preset scales and a Custom option. 
To delete unnecessary scales, add new ones, edit existing ones, or rearrange the order of 
the listing, use the Ribbon to choose Annotate tab ➢ Annotation Scaling panel ➢ Scale 
List tool, use the menu bar to choose Format ➢ Scale List, or enter SCALELISTEDIT↵ 
at the command line to open the Edit Drawing Scales dialog box.

 10. Click OK. You are returned to the Page Setup Manager dialog box.
PDF-1117 (PDF-A3) is now on the Page Setups list.

 11. Highlight PDF-1117 (PDF-A3), and then click Set Current.
The layout area behind the dialog box changes to match the 

parameters you set in the Page Setup dialog box.

 12. Click Close to close the Page Setup Manager dialog box.
You are returned to your drawing, and Layout1 appears  

(see Figure 14.14).
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F I G u R E   1 4 . 1 4 :   The named page setup applied to Layout1 for the cabin

You don’t want the current viewport, the window that lets you see 
your drawing from the layout. You will make your own shortly.

 13. Make sure that you’re in paper space, and then enter E↵ALL↵ to select 
all the objects in the layout.

In the command window, you can see that only the viewport is 
selected.

 14. Double-click the Layout1 tab, and enter PDF-1117 (PDF-A3) to specify 
a name for the tab.

 15. To remove Layout2 from the current drawing, right-click the Layout2 
tab in the lower-left corner of the Application window, and select 
Delete from the context menu that opens.

 16. Save the current drawing as an AutoCAD drawing template by choos-
ing Application menu ➢ Save As ➢ AutoCAD Drawing Template. 
Browse to the root of your Chapter 14 folder, and save the drawing as 
I14A-BDTPLT.dwt (M14A-BDTPLT.dwt).

 17. When the Template Options dialog box opens, enter Title block layout 
template, select English (Imperial) or Metric Measurement, and click OK.

The basic sheet is now set up, but nothing is drawn on it. In the next several 
exercises, you will continue assembling the many pieces that go into a typical 
title block.
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Finishing the Sheet template
Although nothing is drawn on your sheet template, you’ve taken care of most of 
the behind-the-scenes settings. All that’s left to complete the sheet template is 
to insert the title block you created earlier in this chapter.

 1. Make sure the I14A-BDTPLT.dwt (M14A-BDTPLT.dwt) file you created 
in the preceding exercise is open.

DWT files open a little differently than standard DWG™ files. To 
open the template file if it’s not already:

 a. Start the OPEN command.

 b. In the Select File dialog box, set the Files Of Type drop-down 
list to Drawing Template (*.dwt).

 c. Browse to the template file.

 2. Using the Layer Properties Manager, create a new layer named 
A-ANNO-TTLB, assign it the color 3 (Green), and set it as current.

You can close, dock, or collapse the Layer Properties Manager pal-
ette after creating the A-ANNO-TTLB layer.

 3. Use the INSERT command to insert the I14A-BD1117.dwg (M14A-
BDA3.dwg) file that you created earlier in this chapter, and use the 
following parameters:

▶▶ Insertion Point: X, Y, and Z set to 1

▶▶ Scale: X, Y, and Z set to 1

▶▶ Rotation: Angle set to 0

▶▶ Explode: Unchecked

Because the I14A-BD1117.dwg (M14A-BDA3.dwg) block, like the 
title block reference, was created with a common insertion point, 
you should use the default Insertion Point of 0,0,0, Scale of 1, and 
Rotation of 0.

 4. Click OK to accept the default values contained within the Edit 
Attributes dialog box.
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The Edit Attributes dialog box opens because the I14A-BD1117 
(M14A-BDA3) block contains block attributes. You’ll use Sheet Set 
Manager to populate these attributes.

 5. Open the Properties dialog box by choosing Application menu ➢ 
Drawing Utilities ➢ Drawing Properties.

 6. Switch to the Summary tab in the I14A-BDTPLT.dwt (M14A-BDTPLT 
.dwt) Properties dialog box.

 7. From the Summary tab, change the value of the Author field to your 
initials (see Figure 14.15).

F I G u R E   1 4 . 1 5 :   Changing the Author drawing property

 8. Click OK to return to the drawing.
The DRAWN_BY attribute probably won’t update as soon as you 

return to the drawing.

 9. Enter REA↵ at the command line to force a regeneration of the entire 
drawing.

As shown in Figure 14.16, the DRAWN_BY attribute displays your 
initials.
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F I G u R E   1 4 . 1 6 :   The Author drawing property displaying as a field in the  
title block

 10. Save and close the current I14A-BDTPLT.dwt (M14A-BDTPLT.dwt) file, 
keeping its name.

This concludes the setup of your sheet template drawing. You’re now ready to 
begin creating sheets by using this template. The first sheet you’ll create, and 
perhaps one of the simplest, is a cover sheet.
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Creating Plan Sheets
The summer cabin drawing set you’ll create will include a cover sheet, a series of 
layout plans, and a series of elevation plans. Since all of the necessary settings 
are already configured within this template, you can forgo repeating all the 
work preceding this exercise for each sheet you would like to create. In addition 
to providing time savings, this approach has the benefit of ensuring that every 
drawing is configured the same throughout your project.

Creating the Cover Sheet
You’ll begin the process of creating sheets by creating a cover sheet for the 
cabin project:

 1. Create a new drawing by using the Start Drawing tool on the New Tab.

 2. Right-click the Layout1 layout tab, and choose From Template within 
the context menu that opens (see Figure 14.17).

F I G u R E   1 4 . 1 7 :   Selecting the From Template option

 3. Browse to the I14A-BDTPLT.dwt (M14A-BDTPLT.dwt) file you created 
in the preceding section, and click Open from the Select Template 
From File dialog box.
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 4. The Insert Layout(s) dialog box opens, and it lists each of the layout 
tabs in the selected template drawing. Choose the PDF-1117 (PDF-A3) 
option shown in Figure 14.18, and then click OK.

F I G u R E   1 4 . 1 8 :   Selecting the layout to use as a template

A new layout tab named PDF-1117 (PDF-A3) is created in the cur-
rent drawing. This tab is an exact copy of the PDF-1117 (PDF-A3) lay-
out tab in the I14A-BDTPLT.dwt (M14A-BDTPLT.dwt) file.

Similar to the layer- and file-naming standards, the National CAD 
Standard also outlines the numbering of drawing sheets. The stan-
dard sheet number for an architectural cover sheet is A-000.

 5. Rename the PDF-1117 (PDF-A3) layout tab to A-000 by double-clicking 
its name.

You will need only a single layout tab for the cover sheet drawing. 
Too many layout tabs in a drawing can dramatically affect drawing 
performance, so you should keep the total number as low as possible. 
For this reason, you’ll delete the unneeded Layout1 and Layout2.

 6. Right-click the Layout1 tab at the bottom of the Application window, 
and choose Delete from the context menu that appears. Do the same 
for Layout2.

 7. Save your cover sheet as I-A-000.dwg (M-A-000.dwg) in the Sheets 
folder you created previously.

You have now created a cover sheet for your drawing set. Although this is just 
a simple sheet, the time it took to create it was dramatically less than the time 
it took to establish the sheet template. With the cover sheet in place, you’ll con-
tinue building your plan set by creating sheets to illustrate the many elements 
of the cabin’s floor plan.

▶

Because layout tabs are 
used in many ways, it’s 
important to establish 
a naming conven-
tion for them. One 
of the most popular 
conventions is to name 
the layout tab after 
the sheet number it 
represents.
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Generating Floor Plan Sheets
Similar to creating the cover sheet in the previous exercise, you’ll use the sheet 
template created earlier in this chapter for your floor plan drawing sheets. 
However, unlike the cover sheet that was just a single layout tab, you will com-
pose a series of drawing sheets to illustrate the many parts of the cabin’s design. 
To avoid the unnecessary duplication of work, this section introduces a work-
flow to copy layout tabs within a drawing.

Starting the Floor Plan Drawing Set

The floor plan drawing set will consist of three separate drawing sheets. Instead 
of manually creating each of these, you’ll begin by creating one layout tab for 
the first sheet:

 1. Create a new drawing by choosing Application menu ➢ New ➢ 
Drawing.

 2. Browse to I14A-BDTPLT.dwt (M14A-BDTPLT.dwt) and click Open.

n o t E  Creating a new drawing from the sheet template will make an exact 
copy of the selected template drawing. This stands in contrast to the procedure used in 
the cover sheet exercise, where you created a layout From Template, which made a copy 
of the objects on the PDF-1117 (PDF-A3) layout tab you selected. The difference in this 
case is seen with the A-ANNO-NPLT and A-ANNO-REFR layers; they are included when you 
create an entire drawing from the sheet template, but omitted (since they’re not used) 
when only a layout tab is created From Template.

 3. Switch to model space, and set the A-ANNO-REFR layer as current.

 4. Use the XREF command to attach I14A-FPLAYO.dwg (M14A-FPLAYO.dwg) 
to the current drawing.

W A R n I n G  Don’t forget to change Files Of Type to Drawing (*.dwg) when 
attaching the I14A-FPLAYO.dwg (M14A-FPLAYO.dwg) drawing.
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 5. Configure the Attach External Reference dialog box to match 
Figure 14.19.

F I G u R E   1 4 . 1 9 :   The Attach External Reference dialog box

 6. Switch to the PDF-1117 (PDF-A3) layout tab, and rename it to A-101.

 7. Use the Layer drop-down list on the Layers panel of the Home tab to 
change the current layer to A-ANNO-NPLT.

You’ll create your viewports on this layer so that the borders for 
your viewports are not plotted in your final plan sheets.

 8. Click the Layout tab and then, in the Layout Viewports panel, click 
the Rectangular button.

 9. At the Specify corner of viewport: prompt, click the endpoint at 
the upper-right corner of the title block.

 10. At the Specify Opposite Corner: prompt, click the endpoint at the 
lower-left corner of the title block.

Your cabin drawing appears in the new viewport (see Figure 14.20).
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F I G u R E   1 4 . 2 0 :   The cabin displayed through the new viewport

 11. Double-click anywhere inside the viewport boundary you just 
created, and use the Zoom tool to compose your viewport as in 
Figure 14.21.

F I G u R E   1 4 . 2 1 :   Approximating the composition of the viewport for  
sheet A-101
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Since viewports are like windows into model space, double-clicking 
in a viewport switches you to model space. Be careful when zooming in 
a viewport, as this will change the scale of the viewport. Since no scale 
has been specified, this step is intended to establish an approximate 
composition of the drawing sheet.

 12. Click the Viewport Scale button and, from the drop-down list, choose 
1⁄4″ = 1′-0″ (1:50), as shown in Figure 14.22.

F I G u R E   1 4 . 2 2 :   Selecting the imperial viewport scale (left) and the metric 
viewport scale (right)

The viewport scales to 1⁄4″ = 1′-0″ (1:50), and the scale is reflected 
on the status bar.

 13. Click the Lock button in the status bar to lock the current viewport.
Locking the current viewport will prevent its scale of 1 ⁄4″ = 1′-0″ 

(1:50) from being changed accidentally.

 14. Double-click the gray area outside the title block to switch back to 
paper space.
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 15. Save your floor plan sheet as I-A-100.dwg (M-A-100.dwg) in the 
Sheets folder you created previously.

You have now created the initial layout tab, complete with a scaled viewport, 
for the first of three floor plan sheets that will be included with your drawing 
set. Since all of these sheets are related, you’ll create the two remaining sheets 
by copying the layout tab you just completed.

Copying the Initial Floor Plan Layout tab

Your finished document set will include a Floor Plan Materials and a Floor Plan 
Doors plan. The A-101 layout now contains a scaled view of your floor plan. 
Rather than duplicating all of this work, you’ll use the completed A-101 layout 
as a template for these additional drawings by copying it. Here’s how:

 1. Open the I-A-100.dwg (M-A-100.dwg) file you created in the previous 
exercise.

 2. Right-click the A-100 layout tab, and select Move Or Copy from the 
context menu that opens.

The Move Or Copy dialog box opens.

t I P  Notice the small padlock that displays next to the A-101 sheet in Sheet Set 
Manager after you open it. This padlock indicates that the drawing is locked, which most 
likely means that someone else has it open. Hover the cursor over the A-101 sheet to dis-
play information about the sheet, including who currently has the drawing open. This is 
especially helpful when multiple people are working on a project at the same time.

 3. Select the (Move To End) option in the Before Layout portion of the dia-
log box, and then select the Create A Copy check box (see Figure 14.23).

F I G u R E   1 4 . 2 3 :   Copying a layout by using the Move Or Copy dialog box
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 4. Click OK to copy the layout and exit the Move Or Copy dialog box.

 5. Right-click the A-101 (2) layout tab and choose Rename.

 6. Rename the layout to A-102 and then press ↵.

 7. Repeat steps 2 through 6 to create another layout named A-103.

 8. Save the current I-A-100.dwg (M-A-100.dwg), keeping its existing 
filename.

The initial setup for your floor plan sheets is now complete. You should have 
three layout tabs in your I-A-100.dwg (M-A-100.dwg), each including the title 
block and a 1⁄4″ = 1′-0″ (1:50) viewport. Now that each sheet has been defined, 
you can begin focusing on the composition of each plan.

Composing the Floor Plan Sheets
The Floor Plan sheet file is composed of three differing layouts and thus is 
rather atypical. Each layout, while similar, has numerous dissimilar elements. 
Much of the layer management affecting the entire drawing has been taken care 
of through the use of Xrefs. That is, because the civil site plan is not referenced 
in the I-A-100.dwg (M-A-100.dwg) file, there’s no need to worry about turning 
the layers contained within it off.

Even with the civil site plan layers off the table, there are still plenty of layers 
whose visibility you need to configure in the Floor Plan sheet file. Because many 
of these exceptions are for a single sheet, much of the remaining layer manage-
ment for this sheet file will be done using viewport layer overrides.

the Floor Plan Sheet

After adjusting the visibility of layers common to each layout in the current sheet 
file, you’ll begin addressing layer visibility for the individual plan sheets. First up 
is the Floor Plan sheet A-101. In this plan, you do not want the grid, plan materi-
als, or door label layers to display. You will make these changes in this exercise:

 1. Make sure the I-A-100.dwg (M-A-100.dwg) file is open, and switch to 
the Floor Plan A-101 layout.

 2. Double-click anywhere inside the viewport boundary to enter model 
space from the viewport.

 3. Select the Freeze tool (LAYFRZ) found on the Layers panel of the 
Home tab, and then manually select one of the floor material hatches 
on the A-FLOR-PATT layer.
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After you select an object on the A-FLOR-PATT layer, that layer is 
no longer visible on the screen. Because this change was made from 
within a viewport, the change is applied as a viewport override. This 
means the A-FLOR-PATT layer will be visible in other viewports in 
the same drawing but will not display in the viewport on sheet A-101.

n o t E  The viewports in layouts are described as floating because they can be 
moved around. They always reside in the layout portion of the drawing. There is another 
kind of viewport in AutoCAD called a model space, or tiled, viewport, which is fixed and 
exists only in model space. If you want more information on this subject, search for the 
phrase set model space viewports in the AutoCAD help system. For brevity, in this chapter 
I refer to floating viewports simply as viewports.

 4. Using the Freeze tool once again, select one of the door tags (a circle 
with a number inside it near the doors).

 5. Remaining inside the viewport on sheet A-101, open the Layer 
Properties Manager and locate the 14A-FPLAY1|A-GRID layer.

If necessary, scroll to the right until you find the VP Freeze column.

 6. Click the icon to freeze the grid layer in the current viewport.

 7. Close the Layer Properties Manager palette to return to your drawing.

With these layer changes complete, your drawing should look like Figure 14.24.

F I G u R E   1 4 . 2 4 :   The A-101 Floor Plan layout after the layers in the viewport are selectively 
frozen
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the Floor Plan Materials Sheet

Similar to the Floor Plan sheet you just finished, you’ll apply a series of viewport 
overrides to the Floor Plan Materials sheet. This time you’ll be changing the vis-
ibility of the grid, dimension, and door tag layers:

 1. Make sure I-A-100.dwg (M-A-100.dwg) is open, and switch to the 
Floor Plan Materials A-102 layout.

 2. Double-click in the viewport, and use the Freeze (LAYFRZ) tool to 
select any of the dimensions.

The 14A-FPLAY1|A-ANNO-DIMS layer is frozen in the current 
viewport only.

 3. Use the Freeze tool once again to select one of the vertical gridlines 
above the floor plan.

Selecting one of these lines freezes the 14A-FPLAY1|A-GRID layer.

 4. Finally, use the Freeze tool to select one of the door tags to freeze the 
14A-FPLAY1|A-ANNO-TABL layer.

 5. You may choose to use the PAN command to orient the floor plan bet-
ter on the Plan Materials sheet.

When finished, your drawing should look like Figure 14.25.

F I G u R E   1 4 . 2 5 :   The A-102 Floor Plan Materials layout after the layers in the viewport are 
selectively frozen
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the Floor Plan Doors Sheet

The Floor Plan Doors sheet is the first layout that requires more than one viewport. 
Here is a summary of the steps to clean up the drawing:

 1. Make the A-103 layout active.

 2. Inside the viewport, freeze the A-ANNO-DIMS and A-FLOR-PATT layers.

 3. Click the Lock button (currently glowing blue) in the status bar to 
unlock the current viewport.

Changes to the scale are not possible when the lock icon is blue 
(enabled).

 4. Enable AutoScale by selecting the “Add scales to annotative objects 
when the annotation scale changes” button on the status bar.

 5. In the status bar, click the Viewport Scale button, and choose  
3⁄16″ = 1′-0″ (1:70).

The viewport zooms out to reflect the smaller scale. To set the 
metric scale 1:70, it may be necessary to enter ZOOM↵ 1/70↵↵ at 
the command line.

 6. Select the viewport and, using the grips, adjust it so that it fits more 
closely to the floor plan.

Your drawing should look similar to Figure 14.26.

F I G u R E   1 4 . 2 6 :   The A-103 Floor Plan Doors layout after the layers are frozen 
and the viewport is adjusted
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 7. Make the A-ANNO-NPLT layer current.

 8. Create a new viewport in the lower-left corner of the layout (see 
Figure 14.27).

F I G u R E   1 4 . 2 7 :   The new notes and table viewports

The viewport displays all the model space contents. Although the 
view will be labeled as not having a scale, you should create the view-
port with a scale of 1 ⁄4″ = 1′-0″ (1:50).

 9. Select the I14A-FPLAYO.dwg (M14A-FPLAYO.dwg) Xref, right-click, and 
then choose Open Xref from the context menu that opens.

This opens the I14A-FPLAYO.dwg (M14A-FPLAYO.dwg) file in a new 
drawing window.

 10. Modify the General Notes text box to be a single column by doing the 
following:

 a. Place the cursor just after the first note in the left column.

 b. Press the Delete key.

 11. Change the Annotation Scale of the I14A-FPLAYO.dwg (M14A-FPLAYO 
.dwg) drawing to 3/16″ = 1′-0″ (1:70).
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 12. To allow more room in the plan sheet, stretch the 1, 2, 3, and 4 grid-
lines to be closer to the cabin.

 13. Use the Sync Scale Positions (ANNORESET) command to ensure that 
the grid labels match the new endpoint of the gridlines for all anno-
tation scales.

 14. Save and close I14A-FPLAYO.dwg (M14A-FPLAYO.dwg), and then return 
to the A-103 layout tab in the I-A-100.dwg (M-A-100.dwg) file.

 15. Copy this viewport, double-click inside the new viewport, and then 
pan and zoom until the General Notes text fills the viewport. Your 
drawing sheet should look like Figure 14.27.

n o t E  Most plan sheets require some degree of refinement as they are put 
together. Learning how to switch quickly between different Xrefs is imperative in mak-
ing these edits in an efficient manner. You’ll likely determine a preference, between 
editing Xrefs in place or opening the referenced file, as you gain more experience with 
the software.

The floor plan drawings for your plan set are now complete. In this section, 
you learned how to create viewports at a specific scale, and manage the layers in 
those viewports. In the next section, you’ll apply many of these same concepts 
to setting up your elevation plan sheets.

Creating Elevation Sheets
It’s important to start every sheet for a project from a common template to 
ensure consistency throughout your project. Although the content will be very 
different from the floor plan sheets you just completed, the process for creating 
these sheets will follow an identical workflow. In this section, you’ll apply the 
same workflow you learned in the “Creating Plan Sheets” section earlier in this 
chapter to generate the elevation sheets for your project.

Since you’ve already created several sheets by using this workflow, I’ll provide 
an overview of the sheet creation process. Complete the following steps to create 
elevation sheets:

 1. Create a new drawing using the I14A-BDTPLT.dwt (M14A-BDTPLT.dwt) 
template, and save it as I-A-200.dwg (M-A-200.dwg) in the Sheets 
directory.

 2. Create a new viewport for the A-201 layout on layer A-ANNO-NPLT.
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 3. Switch to model space, and use the XREF command to attach I14A-
FPLAYO.dwg (M14A-FPLAYO.dwg) to the current drawing on the 
A-ANNO-REFR layer.

 4. Turn on and thaw all of the layers in the current drawing by using 
the Turn All Layers On (LAYON) and Thaw All Layers (LAYTHW) tools 
found on the extended Layers panel on the Home tab.

 5. Rename the PDF-1117 (PDF-A3) layout tab to A-201.

 6. Copy the A-201 layout tab three times, and then rename the layout 
tabs to A-202, A-203, and A-204.

 7. Save the current I-A-200.dwg (M-A-200.dwg) file, keeping its name.

Repeating the same process initially used to generate floor plan sheets, you 
have completed the initial layout tab setup for your elevation sheets. With this 
foundation in place, you will shift your attention to the composition of each 
drawing sheet. Unlike the floor plan drawing sheets that shared a common view, 
each elevation has a unique location, meaning each viewport will be different.

Composing the South Elevation
You’ll start with the south elevation because it is the only one drawn without 
rotating the UCS. Consequently, it should be the quickest to set up. Here’s how:

 1. Make sure I-A-200.dwg (M-A-200.dwg) is open, and switch to the 
Floor Plan Materials A-203 layout.

 2. Double-click into the viewport located on the A-203 layout tab, and 
use the ZOOM command to zoom to extents.

 3. Zoom into the south elevation until it fills the viewport.

 4. Pan in the viewport so that the south elevation is centered in the 
viewport.

 5. Click the Viewport Scale button, choose 1 ⁄4″ = 1′-0″ (1:50), and 
then pan in the viewport so that the south elevation is centered in 
the viewport. 

 6. Exit model space, and adjust the viewport boundary as necessary so 
that only the south elevation is viewable on the A-203 drawing sheet.

When you’re finished, the South Elevation drawing sheet should look like 
Figure 14.28.
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F I G u R E   1 4 . 2 8 :   The South Elevation placed on the A-201 layout after the viewport is 
adjusted

Composing the other Elevations
The remaining elevations were drawn with a rotated User Coordinate System 
(UCS) so that they appeared in the correct orientation while you were draw-
ing them. However, they are rotated when looking at the drawing in the World 
Coordinate System (WCS). In a similar fashion, you’ll modify the view of each 
viewport by rotating the UCS:

 1. Make the A-202 (East Elevation) layout active, and double-click inside 
the viewport.

 2. To rotate the UCS, do the following:

 a. Click the View tab, and then click the Z button located in the 
left column and middle row of the Coordinates panel.

 b. Enter 90↵ at the Specify Rotation Angle About Z Axis: 
prompt.
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Enable the Coordinates Panel

If the Coordinates panel is not visible from the View tab, do the following:

 1. Right-click any panel title to display a context menu.

 2. From the context menu, choose Show Panels ➢ Coordinates.

 3. To use the PLAN command to rotate the view to match the UCS, enter 
PLAN↵ ↵.

 4. Click the Viewport Scale button, choose 1⁄4″ = 1′-0″ (1:50), and then 
exit model space.

 5. Pan in the viewport so that the east elevation is centered.

 6. Adjust the viewport boundary as necessary so that only the east 
elevation appears on the A-202 layout.

Your layout should look like Figure 14.29.

F I G u R E   1 4 . 2 9 :   The East Elevation layout after the viewport is adjusted

 7. Repeat steps 1 through 6 for the two remaining elevation layouts, sub-
stituting the appropriate text and values as required. For example, the 
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viewport in the A-201 - North Elevation layout must be rotated 180 ,̊ 
and the A-204 - West Elevation layout must be rotated 270˚ or –90 .̊

When the elevations are completed, the A-201 - North Elevation 
layout should look like the top of Figure 14.30, and the A-204 - West 
Elevation layout should look like the bottom of Figure 14.30.

F I G u R E   1 4 . 3 0 :   The North Elevation plan sheet (top) and the West Elevation 
plan sheet (bottom)
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using Sheet Set Manager
To many, Sheet Set Manager is nothing more than a glorified PLOT command. 
Although it can certainly be used that way, Sheet Set Manager is truly designed 
to help you manage your plan sheets from the moment you create a sheet to the 
moment you plot it. By using Sheet Set Manager, you can organize each of your 
drawing sheets (layouts) into what is known as a sheet set. A sheet set will store 
links to each of your drawings, in addition to storing basic information about 
each drawing, including how the title block should be completed. 

Creating a new Sheet Set
All of the information for a sheet set is stored in a sheet set data (DST) file. Like 
drawing sheets, this data file can be created from scratch or from a template 
by using the Create Sheet Set Wizard. To create the sheet set data file for your 
cabin project, complete the following steps:

 1. With any drawing open, select the Sheet Set Manager tool in the 
Palettes panel of the View tab.

This opens the Sheet Set Manager palette set.

 2. With the Sheet Set Manager palette set open, select the drop-down 
list on the Sheet List palette and select New Sheet Set, as shown in 
Figure 14.31.

F I G u R E   1 4 . 3 1 :   Creating a sheet set by using the Sheet List palette

The Create Sheet Set Wizard opens. This wizard is divided into four 
segments (pages):

▶▶ Begin

▶▶ Sheet Set Example

▶▶ Sheet Set Details

▶▶ Confirm

▶

The Sheet Set Manager 
palette set is typically 
referred to as Sheet Set 
Manager. Sometimes 
you may see Sheet Set 
Manager abbreviated 
as SSM.
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 3. From the Begin step, select An Example Sheet Set and then click Next.
This takes you to the second step, Sheet Set Example, where you 

will select the example sheet set to start with.

 4. You will build your sheet set from scratch, so select the A Sheet Set 
To Use As An Example radio button, and then select Architectural 
Imperial Sheet Set (Architectural Metric Sheet Set) from the list 
below the radio button.

 5. Click Next to advance to the next step.
Now you’ll need to provide a name for your sheet set. Although this 

name won’t be set up to print on any drawings, it’s still important to 
enter a meaningful name that will make sense to you later. In addi-
tion to choosing a name for your sheet set, you will tell AutoCAD 
where to save your sheet set.

 6. In the Name Of New Sheet Set text box, enter I-Summer Cabin 
(M-Summer Cabin).

You may enter an optional description in the Description text box.

 7. Finally, and perhaps most important, click the ellipsis button at the 
end of the Store Sheet Set Data File (.dst) Here text box to choose 
the Sheets folder you created previously in this chapter.

When you’re finished, the Create Sheet Set - Sheet Set Details dialog 
box should look like Figure 14.32.

F I G u R E   1 4 . 3 2 :   Choosing a name and location for the sheet set
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 8. At the bottom of the Create Sheet Set - Sheet Set Details dialog box, 
click the Sheet Set Properties button to open the Sheet Set Properties 
- Summer Cabin dialog box.

 9. Click the Page Setup Overrides File property in the Sheet Set property 
group, and then click the ellipsis button.

 10. In the Select Template dialog box that opens, browse to and select the 
I14A-BDTPLT.dwt (M14A-BDTPLT.dwt) file and click Open.

 11. Verify that the Sheet Storage Location property in the Sheet Creation 
group is set to the Sheets folder within your Chapter 14 folder.

 12. Choose the Sheet Creation Template property, also in the Sheet 
Creation group, to browse to and select the same I14A-BDTPLT.dwt 
(M14A-BDTPLT.dwt) file selected in step 10.

Once you select the template file, the Select Layout As Sheet 
Template dialog box shown in Figure 14.33 opens.

F I G u R E   1 4 . 3 3 :   Selecting the sheet-creation layout template

 13. Select the PDF-1117 (PDF-A3) layout from the list, and then click OK 
to exit the dialog box (see Figure 14.33).

 14. Click the Project Name property to make it active, and enter 
Summer Cabin as the project name, as shown in Figure 14.34.

Unlike the Sheet Set Name that does not plot, the Project Name 
property specified here will plot throughout the entire drawing set.
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F I G u R E   1 4 . 3 4 :   The Sheet Set Properties dialog box configured for the 
Summer Cabin project

 15. Verify that the Sheet Set Properties - Summer Cabin dialog box looks 
like Figure 14.34, and then click OK to save the settings and exit the 
dialog box.

 16. Back in the Create Sheet Set dialog box, click the Next button to 
advance to the Confirm portion of the wizard.

 17. Click Finish to create the sheet set, and exit the wizard.
After the wizard closes, the Sheet List palette within the Sheet Set 

Manager palette set will display a number of groups (see Figure 14.35).

F I G u R E   1 4 . 3 5 :   The Summer Cabin sheet set
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You have now created a sheet set for your cabin project. Sheet Set Manager con-
sists of two parts: the sheet and the sheet set. Sheet set properties affect the entire 
drawing set (every drawing listed in the Sheet Set Manager sheet list), whereas 
sheet properties affect only that one individual sheet. The difference between the 
two will become more apparent the more you work with Sheet Set Manager.

Adding Drawings to a Sheet Set
You currently have three drawing files that each contain layout tabs representing 
the drawing sheets for the Summer Cabin project: I-A-000.dwg, I-A-100.dwg, 
and I-A-200.dwg (M-A-000.dwg, M-A-100.dwg, and M-A-200.dwg). Although the 
composition of these sheets is correct, their title blocks do not accurately reflect 
each sheet’s contents. Since the title block attributes were created to include 
fields that reference Sheet Set Manager, adding your existing drawing files to 
your sheet set will also automatically fill out each sheet’s title block for you. 

Take these steps to add your existing drawings to the Summer Cabin sheet set:

 1. Right-click the Architectural group on the Sheet List palette of Sheet 
Set Manager, and choose Import Layout As Sheet (see Figure 14.36).

F I G u R E   1 4 . 3 6 :   Importing an existing layout into Sheet Set Manager

The Import Layouts As Sheets dialog box opens.
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 2. From the Import Layouts As Sheets dialog box, click the Browse For 
Drawings button at the top of the screen. Browse to and select all three 
drawings saved in your Sheets folder: I-A-000.dwg, I-A-100.dwg, and 
I-A-200.dwg (M-A-000.dwg, M-A-100.dwg, and M-A-200.dwg).

After you select the three drawings, the layouts contained within 
each one are listed in the Import Layouts As Sheets dialog box (see 
Figure 14.37).

F I G u R E   1 4 . 3 7 :   Importing the sheet layout tabs into Sheet Set Manager

When you’re importing existing layouts, it’s important to note the 
Status column. The status for each layout should read Available For 
Import, and the check boxes should be selected on the left side of the 
dialog box.

 3. Click the Import Checked button to import the layout and return to 
the Sheet Set Manager palette set.

Each layout tab imports into the Sheet Set Manager sheet list with 
a generic name like I-A-000 - A-000 (M-A-000 - A-000), as shown 
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on the left in Figure 14.38. This generic name represents the sheet 
number and sheet title for the layout.

F I G u R E   1 4 . 3 8 :   Reordering a drawing in the Sheet Set Manager sheet list 
(left), and the final sheet order (right)

 4. Drag and drop the sheets you imported to match the sequential order 
shown on the right of Figure 14.38.

Each layout tab for the Summer Cabin project now has an entry within the 
sheet list of Sheet Set Manager. Generic names are still used for each layout, and 
the title block information for those layouts hasn’t been specified yet.

Defining Sheet Properties
Every sheet within Sheet Set Manager must have both a sheet number and a sheet 
title. To accommodate this requirement, AutoCAD established a very generic nam-
ing convention when importing the existing layout tabs into Sheet Set Manager. 
Although a default name was established for each sheet, the flexibility of Sheet Set 
Manager makes it easy to change this information. 

 1. From the Sheet List palette in Sheet Set Manager, right-click the 
I-A-000 - A-000 (M-A-000 - A-000) sheet and choose Properties, as 
shown on the right in Figure 14.39.

The Sheet Properties dialog box opens to display settings related to 
the A-000 sheet.

www.MouradEngineering.com



	 U s i n g 	 S h e e t 	 S e t 	M an a g e r  8 0 5

F I G u R E   1 4 . 3 9 :   Accessing the properties for an individual sheet to replace 
its default name in Sheet Set Manager

 2. Enter the following values, as shown in Figure 14.40:

Sheet Title: Cover Sheet

Sheet Number: A-000

Revision Date: Today’s date

F I G u R E   1 4 . 4 0 :   Changing the properties for sheet A-000
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 3. Click OK to return to Sheet Set Manager.
The former I-A-000 - A-000 (M-A-000 - A-000) sheet list entry 

updates to read A-000 - Cover Sheet. 

 4. Double-click A-000 - Cover Sheet from the Sheet Set Manager sheet 
list to open it.

You may need to enter REA↵ to regenerate the drawing, but notice 
how the title block is largely completed, as shown in Figure 14.41. All 
of this information is pulled from the properties you set in Sheet Set 
Manager.

F I G u R E   1 4 . 4 1 :   The sheet information block populated with values from 
Sheet Set Manager

Notice that the Drawn By box includes your initials. Remember, this 
is not a Sheet Set Manager field; it comes from the DWG file properties.

 5. Choose Application menu ➢ Drawing Utilities ➢ Drawing Properties, 
and then change the Author property on the Summary tab to your 
initials and click OK.

The Properties dialog box closes, and you return to the drawing. 
Once again, you may need to enter REA↵ to regenerate your drawing, 
but afterward the sheet information block will reflect this change to 
the drawing properties.
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 6. From the Sheet List palette in Sheet Set Manager, right-click the I-A-
100 - A-101 (M-A-000 - A-000) sheet and choose Rename & Renumber.

The Rename & Renumber Sheet dialog box opens.

 7. Enter A-101 as the Number, and Floor Plan as the Sheet Title. Leave 
the Layout Name, File Name, and Rename Options at their default 
and unchecked values, and click Next.

 8. Continue using the Rename & Renumber Sheet dialog box to specify 
the sheet number and sheet title values for the remaining layout tabs, 
as shown in Table 1.1. Click Next to proceed to each subsequent sheet.

t A B L E   1 . 1 :   Sheet numbers and titles

Layout name number Sheet title

A-102 A-102 Floor Plan Materials

A-103 A-103 Floor Plan Doors

A-201 A-201 North Elevation

A-202 A-202 East Elevation

A-203 A-203 South Elevation

A-204 A-204 West Elevation

 9. Click OK to dismiss the Rename & Renumber Sheet dialog box after 
specifying values for the A-204 sheet.

In the preceding exercise, you changed the sheet number and title of your 
Summer Cabin project drawings in two ways. The Rename & Renumber Sheet 
dialog box allowed you to quickly specify sheet numbers and titles for a whole 
range of sheets, whereas the Sheet Properties function required you to exit the 
dialog box after each sheet. Although the Sheet Properties function was likely 
more time-consuming, its core advantage is that it provides access to every 
sheet property, whereas the Rename & Renumber Sheet function provides 
access to only a limited subset of this information.

Since the Rename & Renumber Sheet dialog box provides access to only a lim-
ited subset of a sheet’s properties, you were not able to specify a Revision Date 
for any sheet this function was used on. Follow these steps to define a date and 
drawn-by value for the rest of your drawing set:
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 1. From the Sheet List palette in Sheet Set Manager, right-click the 
A-101 sheet and choose Properties.

 2. Enter today’s date for the Revision Date field within the Sheet Properties 
dialog box.

 3. Repeat steps 1 and 2 for sheets A-102 through A-204.

 4. Double-click the A-101 layout from the sheet list to open I-A-100.dwg 
(M-A-100.dwg).

 5. Choose Application menu ➢ Drawing Utilities ➢ Drawing Properties, 
change the Author property on the Summary tab to your initials, and 
then click OK. Save your drawing.

 6. Repeat steps 4 and 5 for the A-201 layout.

This section has provided a brief introduction to the powerful drawing manage-
ment features found within Sheet Set Manager. By using Sheet Set Manager, you 
were able to quickly organize your drawing, complete the necessary information 
for each title block, and even manage the daunting task of renumbering sheets. In 
addition to these functions, Sheet Set Manager can also be used to create drawing 
sheets from scratch, create and manage the composition of layout tab viewports, 
and more. For a more in-depth discussion about Sheet Set Manager, refer to 
Mastering AutoCAD 2015 and AutoCAD LT 2015 by George Omura (Sybex, 2014).

If You Would Like More Practice…
Most plan sets for a building project like this one will include a long list of draw-
ing sheets to document all aspects of its construction. Additional sheets might 
include an overall site plan, a detailed cross section of your kitchen with cabi-
nets and appliances, or even a series of detail sheets documenting how the foun-
dation should be constructed. To create additional sheets (layouts) like these, 
follow these steps:

 1. Create a new drawing from scratch, attaching the necessary external 
references.

 2. Create another layout for the cabin drawing that has a landscape ori-
entation and is sized to fit a 30″ × 42″ (841 mm × 1189 mm) paper.

 3. Create four or more viewports: one for an overall site plan and the 
others for various views of the drawing.

Your new layout may look something like Figure 14.42.
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F I G u R E   1 4 . 4 2 :   An additional layout for the cabin project

 4. Save this drawing as I-A-100-extra.dwg (M-A-100-extra.dwg).

Are You Experienced?

now you can…

✔✔ create a layout and associate it with a page setup

✔✔ move	between	paper	space	and	model	space

✔✔ create	and	manage	plan	sheets	by	using	Sheet	Set	Manager

✔✔ set up viewports on layouts

✔✔ control	layer	visibility	in	individual	viewports

✔✔ zoom to a scale in a viewport

✔✔ lock	the	display	of	a	viewport

✔✔ turn viewports off and on
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CHAPtER 15

Printing a Drawing
With today’s equipment, there is no difference between printing and plot-
ting. Printing used to refer to smaller-format printers, and plotting referred 
to pen plotters, most of which were designed for plotting large sheets. But the 
terms are now used interchangeably. Pen plotters have been virtually replaced 
by large-format inkjet or laser plotters that have a few additional settings not 
commonly found on standard printing devices. Otherwise, as far as Autodesk® 
AutoCAD® software is concerned, the differences between plotters and laser, 
inkjet, or electrostatic printers are minimal. In this book, printing and plotting 
have the same meaning.

Although you may have a variety of small-format and large-format plotters 
attached to your computer, this chapter assumes as a standard the DWG To 
PDF.pc3 plotter. Because each plotter is slightly different, standardizing on 
this one virtual device will ensure that you’re able to follow each of the steps 
as they are discussed in this chapter.

You will print the layouts from I-A-100.dwg (M-A-100.dwg) and I-A-200.dwg 
(M-A-200.dwg) by using the default Ledger 11″ × 17″ (297 mm × 420 mm) A3 
sheet size, and also learn to plot-check prints from model space.

Plotting to an electronic format similar to PDF is not all that uncommon in 
industry. There is often a need to keep an electronic record of each submittal of 
a project, and PDF printing is one of the ways this is possible. After completing 
this chapter, you may choose a different device to meet your own needs, but for 
now it’s more important to know that the purpose of using a PDF plotter is to 
give you the basic principles for plotting, regardless of whether you have access 
to a printer or plotter.

In this chapter, you will learn to

▶▶ Navigate	the	Plot	dialog	box

▶▶ Assign lineweights to drawing layers, and manage plot styles

▶▶ Configure and preview a model space print

▶▶ Publish	multiple	layouts,	and	use	Sheet	Set	Manager
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using the Plot Dialog Box
The job of getting your AutoCAD file to plot (electronically or as a hard copy) 
can be broken down into five tasks. You need to tell AutoCAD the following:

▶▶ The printing device you’ll use

▶▶ The lineweight assigned to each object in your drawing

▶▶ The portion of the drawing you’re printing

▶▶ The sheet size to which you’re printing

▶▶ The scale, orientation, and placement of the print on the sheet

You handle most of these tasks in the Plot dialog box:

 1. Open I-A-100.dwg (M-A-100.dwg), shown in Figure 15.1. Click the 
A-101 layout to make it active and ensure that you are in paper space.

F I G u R E   1 5 . 1 :   The A-101 layout showing the floor plan
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 2. Click the Output tab, and then click the Plot button on the Plot panel 
to open the Plot dialog box shown in Figure 15.2.

The title bar includes the name of the layout because, in this case, 
you’re printing a drawing from paper space (layout). If you print from 
model space, the title bar displays the word Model. 

F I G u R E   1 5 . 2 :   The simplified Plot dialog box

 3. If the Plot dialog box opened in its simplified format shown in 
Figure 15.2, expand it by clicking the More Options disclosure tri-
angle button.

Expanding the Plot dialog box adds four more groups to it, as 
shown in Figure 15.3.

◀

You can also open the 
Plot dialog box by 
pressing Ctrl+P or by 
entering PLOT↵ or 
PRINT↵.
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unreconciled Layers

If you receive a Layer Notification Warning dialog box or a notification bubble 
stating that you have unreconciled layers, you should address the situation 
before plotting the drawing. Unreconciled layers are new layers that have been 
added since the last time the drawing was saved, the PLOT command was used, 
or a layer state was saved. The purpose of the warning or notification is to signal 
you to look at these new layers and determine whether any action is required. 
Follow these steps:

 1.  Open the Layer Properties Manager, and click Unreconciled New Layers in 
the left pane to display the list in the right pane.

 2.  Select all the layers shown, right-click, and choose Reconcile Layer from 
the context menu.

 3. Close the Layer Properties Manager.

All layers are now reconciled, and the warnings should discontinue until you add 
any new layers.

F I G u R E   1 5 . 3 :   The expanded Plot dialog box
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This expanded version of the Plot dialog box provides access to the same set-
tings found within the Page Setup dialog box you worked with in Chapter 14, 
“Using Layouts to Set Up a Print,” when you were setting up a sheet template. 
Here’s an overview of the Plot dialog box settings:

Page Setup  As you learned in Chapter 14, page setups help standardize the 
configuration of plots by saving the settings with a unique name within the 
Page Setup and Plot dialog boxes. Choosing a named page setup from the drop-
down list in this group will replace the current settings contained within the 
Plot dialog box with those stored within the page setup. Similarly, the Add but-
ton allows you to save an existing Plot dialog box configuration as a page setup.

Printer/Plotter  In this group, the Name drop-down list contains the various 
plotting devices to which AutoCAD has been configured. By default, this list 
includes any printer installed on your local machine, in addition to several vir-
tual devices such as the DWG To PDF.pc3 that will generate an electronic plot to 
a variety of formats.

Paper Size  The Paper Size drop-down list allows you to select how big or small 
of a piece of paper you would like to plot on. This list automatically updates 
based on the Printer/Plotter you have selected, and will display only paper sizes 
supported by the selected device.

Although most plotters support standard paper sizes such as Letter (A4), you 
may observe slight variations in the Letter (A4) paper size available between two 
different devices. These differences are typically due to technical limitations, 
such as margins, or how close to the edge of a piece of paper a device can print. 
Recognizing that subtle differences may be observed as you switch between plot-
ters, it’s recommended you configure your plots with the Printer/Plotter you 
anticipate using to publish your document set.

number of Copies  When you’re plotting to a physical device, the Number 
Of Copies drop-down list is enabled on the right side of the Paper Size group. 
Although the function of this setting is self-explanatory, it’s best to use this 
feature with caution. When you have a large run of pages to print, it’s prudent 
to print a single copy of each, check for errors or omissions, and then print mul-
tiple copies of each page. 

Plot Area  The Plot Area allows you to tailor what portion of a drawing will be 
plotted. This is accomplished by choosing one of these five options under the 
What To Plot drop-down menu:
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Layout/Limits  Plots everything inside the dashed line that 
represents the printable area of the Paper Size associated with a 
Layout tab, and everything within the defined grid limits when 
plotting from model space. 

Extents  Similar to performing a Zoom Extents, this option plots 
all geometry in the current space (paper or model).

Display  Generates a plot that approximately matches what is 
shown on your screen. Some cropping is likely, unless your draw-
ing area matches the aspect ratio of your selected paper size.

View  Available only when plotting from model space and a 
named view is present in the current drawing. This option plots 
the contents of a view created with the VIEW command.

Window  Helpful for quick-check plots, this option allows you to 
plot any rectangular region in a drawing.

The specific options available from the Plot dialog box are determined by the 
space you’re plotting from. Paper space provides access to the Layout, Extents, 
Display, and Window options, whereas model space provides access to the 
Limits, Extents, Display View, and Window options.

Plot offset  Frequently used to align plots to the right in order to provide 
space to bind (staple) drawings together, the Plot Offset setting allows you to 
adjust the plot relative to the lower-left corner of the printable area. Values 
entered in the X text box shift your plot to the right, and values entered into the 
Y text box shift your plot toward the top of your page.

This feature can also be used if you simply want the resulting plot to be centered on 
a piece of paper. Selecting the Center The Plot check box will automatically calcu-
late the X and Y values necessary to center your drawing on the selected paper size.

Plot Scale  Primarily adjusted when plotting from model space, Plot Scale 
controls the relative size of the current view when it is plotted. Since layout tabs 
always represent a sheet of paper, adjusting the Plot Scale of a layout tab will 
shrink the piece of paper it represents. To keep the dimensions of a paper size 
such as Letter (A4), layout tabs will almost always use a scale of 1:1.

Since model space represents your design in real-world units, you need some 
way to fit it to a standard paper size when plotting. Although the Plot Scale 
setting is rarely used when plotting a layout tab, it’s of critical importance 
when plotting from model space. For this reason, the Fit To Paper check box is 
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enabled by default for all model space plots. Uncheck this check box to choose a 
standard scale such as 1/4″ = 1′-0″ (1:50).

Plot Style table  Colors are typically used to help visually distinguish differ-
ent elements of a design, yet most document sets are plotted in black-and-white. 
The primary function of PlotStyle Tables is to instruct AutoCAD how to convert 
a drawing from color to black-and-white for the purposes of plotting.

We’ll discuss some of the additional functions of Plot Style Tables later in this 
chapter, including the way they can also be used to determine lineweights for 
your drawing.

Shaded Viewport options  This option is primarily used to designate how 3D 
geometry will be plotted, and closely aligns with the Visual Styles function you’ll 
learn about in Chapter 16, “Creating 3D Geometry,” and Chapter 17, “Rendering 
and Materials.” The Shade Plot option within this group allows you to choose to 
display a viewport as a wireframe, shaded, or even as a photorealistic rendering.

Plot options  This group contains eight settings that allow you to specify how 
your plot will be processed. By default, the Plot Object Lineweights, Plot With 
Plot Styles, and Plot Paperspace Last settings are enabled. It’s important to keep 
each of these settings enabled, because you’ll want to plot a black-and-white 
document set (Plot With Plot Styles) that uses lines of varying thicknesses  
(Plot Object Lineweights) to emphasize certain elements of your design. Since 
model space typically contains more objects to process than paper space does, 
paper space geometry is typically plotted last. 

Drawing orientation  The settings in this area are self-explanatory and found 
in nearly every Windows-based plot dialog box. The radio buttons serve as a 
toggle between the portrait and landscape orientation. This group also includes 
a Plot Upside-Down check box that is commonly left unchecked because not all 
AutoCAD objects support the setting.

This concludes our tour of the Plot dialog box. You need to make a few tweaks 
to the Summer Cabin before generating final plots for the project, so click 
Cancel to close the Plot dialog box.

Assigning Lineweights to a Drawing
Imagine if the headings throughout this book used the same font and text 
height as the body text. Without this visual separation, it would be difficult to 
distinguish between the headings and the regular text. In a similar way, varying 
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line thicknesses are typically applied to drawings to make the plans you gen-
erate more readable. Lines representing a wall or edge of a machine part, for 
example, typically are configured to plot with a thicker line than the dimension 
lines that are associated with them.

Lineweights can be applied to an AutoCAD drawing in two ways: through the 
use of a Plot Style Table, or by using the Lineweight property. I’ll talk about Plot 
Style Tables later in this chapter, but for the Summer Cabin project, you’ll use 
the Lineweight property. When you created layers in Chapter 6, “Using Layers to 
Organize Your Drawing,” you also assigned other properties, including color and 
linetype, to each layer definition. Lineweights will be applied to layers in much 
the same way you applied colors and linetypes.

Assigning Lineweights to Layers
Look at the I14A-FPLAYO (M14A-FPLAYO) drawing as a whole. You need to decide 
on weights for the various lines. The floor plan is drawn as if a cut were made 
horizontally through the building, just below the tops of the window and door 
openings. Everything that was cut will be given a heavy line. Objects above and 
below the cut will be given progressively lighter lines, depending on how far 
above or below the cut the objects are located.

In this system, the walls, windows, and doors will be heaviest. The roof, head-
ers, fixtures, deck, and steps will be lighter. For emphasis, you’ll make the walls 
a little heavier than the windows and doors. The hatch pattern will be very light, 
and the outline of the various components will be heavier for emphasis. Text and 
the title block information will use a medium lineweight. These are general 
guidelines; weights will vary with each drawing.

n o t E  Lineweight standards var y for each trade and profession that uses 
AutoCAD. Details usually follow a system that is independent from the one used by other 
drawings in the same set. Section lines, hidden lines, centerlines, cutting plane lines, 
break lines, and so on, will all be assigned specific lineweights.

using Project Lineweights

You’ll use four lineweights for the project, as shown in Table 15.1.
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t A B L E   1 5 . 1 :   The four lineweights used in the Summer Cabin project

Weight thickness in Inches

Very Light 0.005 (0.13 mm)

Light 0.008 (0.20 mm)

Medium 0.010 (0.25 mm)

Heavy 0.014 (0.35 mm)

In I14A-FPLAY1 (M14A-FPLAY1), 30 layers are visible in the floor plan, the site 
plan, and the elevation layouts as they are currently set up. Their lineweights 
will be assigned as shown in Table 15.2.

t A B L E   1 5 . 2 :   Lineweights associated with the layers in the I14A-FPLAY1  
(M14A-FPLAY1) drawing

Layer Lineweight

A-ANNO-DIMS Very Light

A-ANNO-TABL Medium

A-ANNO-TEXT Medium

A-ANNO-TTLB Medium

A-ANNO-TTLB-TEXT Medium

A-DECK Medium

A-DECK-STRS Light

A-DOOR Medium

A-ELEV-DECK Medium

A-ELEV-DECK-STRS Medium

A-ELEV-DOOR Medium

A-ELEV-DOOR-PATT Medium

(Continues)
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Layer Lineweight

A-ELEV-FNDN Light

A-ELEV-FNDN-PATT Very Light

A-ELEV-GLAZ Medium

A-ELEV-GLAZ-PATT Medium

A-ELEV-ROOF Medium

A-ELEV-ROOF-PATT Very Light

A-ELEV-SHAD-PATT Very Light

A-ELEV-TEXT Medium

A-ELEV-WALL Medium

A-ELEV-WALL-PATT Very Light

A-FLOR-FIXT Light

A-FLOR-PATT Very Light

A-GLAZ Medium

A-GRID Medium

A-ROOF Very Light

A-TTLB-LABL Medium

A-WALL Heavy

A-WALL-HEAD Light

The site plan model file I13C-SPLAYO.dwg (M13C-SPLAYO.dwg) has five layers of 
concern. You’ll need to open it and assign the lineweights shown in Table 15.3.

t A B L E   1 5 . 2 :  (Continued)

www.MouradEngineering.com



 A s s i g n i n g  L i n e w e i g h t s  t o  a  D r a w i n g  8 2 1

t A B L E   1 5 . 3 :   Lineweights associated with the layers in the I13C-SPLAYO  
(M13C-SPLAYO) drawing

Layer Lineweight

C-ANNO-NARW Fine

C-PROP-LINE Medium

C-ROAD Medium

C-SITE-REFR Medium

C-SWLK Fine

When you look at the lineweights currently assigned to the layers across your 
two model files, you can generate a third chart that shows what lineweight 
needs to be assigned to each group of layers, as shown in Table 15.4.

t A B L E   1 5 . 4 :   The thickness of each lineweight and the assigned layers

thickness Layers

Very Light: 0.005 (0.13) A-ANNO-DIMS, A-ELEV-FNDN-PATT, A-ELEV-
ROOF-PATT, A-ELEV-SHAD-PATT, A-ELEV-WALL-
PATT, A-FLOR-PATT, A-ROOF

Light: 0.008 (0.20) A-DECK-STRS, A-ELEV-FNDN, A-FLOR-FIXT, 
A-WALL-HEAD, C-ANNO-NARW, C-SWLK

Medium: 0.010 (0.25) A-ANNO-TABL, A-ANNO-TEXT, A-ANNO-TTLB, 
A-ANNO-TTLB-TEXT, A-DECK, A-DOOR, A-ELEV-
DECK, A-ELEV-DECK-STRS, A-ELEV-DOOR, A-ELEV-
DOOR-PATT, A-ELEV-GLAZ, A-ELEV-GLAZ-PATT, 
A-ELEV-ROOF, A-ELEV-TEXT, A-ELEV-WALL, 
A-GLAZ, A-GRID, A-TTLB-LABL, C-PROP-LINE, 
C-ROAD, C-SITE-REFR

Heavy: 0.014 (0.35) A-WALL
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Applying Lineweights to Layers

You’ll use Table 15.1 and Table 15.2 to apply lineweights to the I14A-FPLAY1 
(M14A-FPLAY1) and I13C-SPLAY1 (I13C-SPLAY1) drawings, respectively. The fol-
lowing procedure will guide you through the process:

 1. Open I14A-FPLAYO.dwg (M14A-FPLAYO.dwg) from your Chapter 15 
folder, and start the LAYER command to display the Layer Properties 
Manager.

 2. Make layer 0 the current layer.
The A-AREA and Defpoints layers do not plot, so you don’t need to 

be concerned with them at this time, but verify that they are set to 
not plot. The E-POWR and L-PLNT layers are empty.

 3. Click the A-ANNO-DIMS layer to highlight it.

 4. Hold down the Ctrl key, and click the A-ELEV-FNDN-PATT, A-ELEV-
ROOF-PATT, A-ELEV-SHAD-PATT, A-ELEV-WALL-PATT, A-FLOR-
PATT, and A-ROOF layers to select them. Then release the Ctrl key.

 5. In the Lineweight column of the Layer Properties Manager dialog 
box, click one of the highlighted Default words in the Lineweight col-
umn to open the Lineweight dialog box (see Figure 15.4).

F I G u R E   1 5 . 4 :   Assigning a lineweight in the Lineweight dialog box

▶

The I15-FP 
Lineweight 
.las (M15-FP 
Lineweight 
.las) layer state is 
also available from the 
Chapter 15 download, 
and it will automati-
cally assign the line-
weights discussed in 
this exercise.
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n o t E  If your lineweight units are shown in millimeters instead of inches, click 
Cancel, enter LWUNITS↵0↵, and then reopen the Lineweight dialog box.

 6. Click 0.005″ (0.13 mm). Then click OK to assign the lineweight and 
exit the Lineweight dialog box.

In the Layer Properties Manager, the highlighted layers now have a 
lineweight of 0.005″ (0.13 mm) assigned to them (see Figure 15.5).

F I G u R E   1 5 . 5 :   The new lineweight is shown in the Layer Properties Manager.

 7. Repeat steps 3 through 6 three more times to assign the remaining 
lineweights to the layers within I14A-FPLAYO.dwg (M14A-FPLAYO.dwg):

 a. Assign the 0.008″ (0.20 mm) lineweight to the A-DECK-STRS, 
A-ELEV-FNDN, A-FLOR-FIXT, and A-WALL-HEAD layers.
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 b. Assign the 0.010″ (0.25 mm) lineweight to the A-ANNO-TABL, 
A-ANNO-TEXT, A-ANNO-TTLB, A-ANNO-TTLB-TEXT, A-DECK, 
A-DOOR, A-ELEV-DECK, A-ELEV-DECK-STRS, A-ELEV-DOOR, 
A-ELEV-DOOR-PATT, A-ELEV-GLAZ, A-ELEV-GLAZ-PATT, 
A-ELEV-ROOF, A-ELEV-TEXT, A-ELEV-WALL, A-GLAZ, and 
A-GRID layers.

 c. Assign the 0.014″ (0.35 mm) lineweight to the A-WALL layer.

 8. Save the I14A-FPLAYO.dwg (M14A-FPLAYO.dwg) file, and open the 
I13C-SPLAYO.dwg (M13C-SPLAYO.dwg) file.

 9. Repeat steps 3 through 6 by applying linetypes to these layers as follows:

 a. Assign the 0.008″ (0.20 mm) lineweight to the A-ANNO-NARW 
and C-SWLK layers.

 b. Assign the 0.010″ (0.25 mm) lineweight to the C-PROP-LINE, 
C-ROAD, and C-SITE-REFR layers.

 10. Save the I13C-SPLAYO.dwg (M13C-SPLAYO.dwg) file, keeping its 
existing name.

You have assigned the lineweights. When the print is complete, you can judge 
whether these lineweight assignments are acceptable or need to be adjusted. In 
an office, a lot of time is invested in developing a lineweight standard that can 
be used in most drawings. The development of such a standard is typically led 
by a CAD manager and decided on by a CAD committee of key users throughout 
the company.

updating Xref Layer Definitions
In the preceding exercise, you learned ways to assign lineweights to layers. 
Currently, these lineweights are reflected only inside the respective model files 
such as I14A-FPLAYO.DWG (M14A-FPLAYO.DWG). By default, changes to the layer 
properties of an external reference are not reflected in the host drawing, or sheet 
file in this case. In this section, you’ll learn about the VISRETAIN variable and 
how to use it in conjunction with layer states to update the lineweights inside 
your sheet files. Let’s get started:

 1. Open the I-A-100.dwg (M-A-100.dwg) sheet file, and switch to 
model space.

 2. Start the LAYER command to open the Layer States Manager.

▶

The 15-SP 
Lineweight 
.las layer state is 
also available from the 
Chapter 15 download, 
and it will automati-
cally assign the line-
weights for your civil 
site plan.
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 3. Click the Layer States Manager button on the toolbar of the Layer 
Properties Manager.

 4. In the Layer States Manager dialog box, create a new layer state by 
clicking the New button on the right side.

 5. Name your new layer state 15-LayerBackup, and click OK to return to 
the Layer States Manager.

 6. Click the Close button to exit the Layer States Manager.
Keep the Layer Properties Manager displayed on your screen.
The VISRETAIN drawing variable controls how layers in external 

references are stored inside your drawing. With its default value 
of 1, layer properties are stored in the host drawing, and changes 
in the reference drawing are not reflected in the current drawing. 
Conversely, when this value is set to 0, changes in the Xref drawing 
are reflected in the current drawing.

 7. Enter VISRETAIN↵ at the command line, and change its value to 0.

 8. Start the XREF command to open the External References palette.

 9. Right-click the I14A-FPLAY1 (M14A-FPLAY1) reference, and choose Reload.
The I14A-FPLAYO.DWG (M14A-FPLAYO.DWG) drawing reloads in the 

current drawing. Notice the lineweight column in the Layer Properties 
Manager; the lineweights have updated in the current drawing.

 10. Set the VISRETAIN variable back to 1, and open the Layer States 
Manager once again.

 11. Expand the Layer States Manager by using the arrow icon in the 
lower-right corner to reveal the Layer Properties To Restore group at 
the right side of the dialog box.

 12. Uncheck the Lineweight check box, as shown in Figure 15.6, and 
then click the Restore button.

www.MouradEngineering.com



8 2 6 	 C h a p t e r 	 15 	 • 	 P r i n t i n g 	 a 	D r aw i n g

F I G u R E   1 5 . 6 :   Restoring all but the Lineweight property from the 
15-LayerBackup layer state

 13. Repeat steps 2 through 12 on the I-A-200.dwg (M-A-200.dwg) sheet file.

To avoid overwriting the lineweights just loaded into the A-100 sheet file, you 
chose not to restore the Lineweight property from your 15-LayerBackup layer 
state. Had you chosen to restore this property, the lineweights in your draw-
ing would have been set back to Default. A drawback to this method is that any 
viewport layer overrides you created have been reset to match the properties of 
that layer in model space.

This drawback is one of the main reasons that many in industry choose to 
avoid viewport overrides whenever possible and manage their layers from model 
space. With the size of your Summer Cabin project, re-creating these viewport 
overrides shouldn’t be too difficult. To summarize, you’ll need to re-create the 
following viewport overrides:

A-101 Layout  VP Freeze: A-FLOR-PATT and A-ANNO-TABL from the 
14A-FPLAY1 reference

A-102 Layout  VP Freeze: A-GRID, A-ANNO-TABL, and A-ANNO-DIMS from 
the 14A-FPLAY1 reference

A-103 Layout  VP Freeze: A-FLOR-PATT and A-ANNO-DIMS from the 
14A-FPLAY1 reference
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n o t E  Because all the layers are managed from model space in the I-A-200 
.dwg (M-A-200.dwg) and I-C-100.dwg (M-C-100.dwg) sheet files, there’s no 
need to re-create the viewport overrides in those drawings.

Plotting from Model Space
You’ll learn to plot the individual plan sheets in a moment, but your first task will 
be to print 14A-FPLAYO.dwg from model space at a scale of 1⁄4″ = 1′-0″ (1 = 50) 
on an 11″ × 17″ (297 mm × 420 mm) format printer. In this section, you’ll use 
the DWG To PDF.pc3 printer. Since the PDF plotter will simply plot to a file, you 
could select any sheet size you wanted. 

Configuring the Plot
Model space plots are frequently used during the design phase to quickly gener-
ate a plot for some area of your project’s design. As an example, your project 
manager may ask you to generate a plot of an area of interest so he or she 
can mark up the design. Although you have many options, outlined in the 
“Overview of the Plot Dialog Box” section earlier in this chapter, check plots like 
these most commonly use the Window option. Here’s how to create such a plot 
from model space: 

 1. If it’s not open already, open the I14A-FPLAYO.DWG (M14A-FPLAYO.DWG) 
file and switch to model space.

 2. In the Layer Properties Manager, select A-ANNO-TABL, A-FLOR-
PATT, A-GRID, and all three Site layers.

 3. Click the lightbulb icon to turn off each of the selected layers.

 4. Start the PLOT command.

 5. In the Plot dialog box, check the Printer/Plotter group to be sure that 
you have DWG To PDF.pc3 displayed in the drop-down list.

 6. Check the Paper Size group to verify that ANSI Full Bleed  
(17.00 × 11.00 Inches) or ISO Full Bleed A3 (420.00 × 297.00 mm)  
is the selected paper size.
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 7. Move down to the Plot Area group, open the What To Plot drop-down 
list, and select Window.

 8. In the drawing, turn off Object Snap.

 9. To start the window, pick a point just above and to the right of the 
topmost and rightmost dimensions.

 10. To complete the window, click a point below and to the left of the bot-
tommost and leftmost dimensions.

Back in the Plot dialog box, Window is displayed in the What To 
Plot drop-down list, and a new Window button appears on the right 
side of the Plot Area group.

 11. Click this button if you need to redo the window after viewing a pre-
view of the plot.

 12. If you have not already done so, click the right-pointing arrow in the 
lower-right corner of the Plot dialog box to display another column of 
plotting options.

 13. In the Drawing Orientation group in the lower-right corner, be sure 
that Landscape is selected.

 14. Assign the monochrome.ctb plot-style table by using the Plot Style 
Table drop-down list in the expanded Plot dialog box.

 15. In the Plot Scale group, uncheck Fit To Paper and, if you’re using archi-
tectural units, open the Scale drop-down list and select 1⁄4″ = 1′-0″.

Notice that the text boxes below the Fit To Paper check box now 
read 0.25 and 12, a form of the true ratio for 1 ⁄4″ scale. If you’re 
using decimal units, do the following:

 a. Choose Custom from the Scale drop-down list.

 b. Enter 1 in the upper text field and 50 in the lower.

 16. In the Plot Offset group, click the Center The Plot check box.
Your dialog box should look like Figure 15.7.
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F I G u R E   1 5 . 7 :   The Plot dialog box with the current settings

This completes the setup for your first plot. It’s a good idea to preview how it 
will look as a result of the setup changes before you plot a drawing.

Previewing a Print
The Preview feature gives you the opportunity to view your drawing exactly as it 
will print.

 1. Click the Preview button in the lower-left corner of the Plot dialog box.
The computer takes a moment to calculate the plot and then displays 

a full view of your drawing as it will fit on the page (see Figure 15.8). If a 
Plot Scale Confirm dialog box opens, click Continue.
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F I G u R E   1 5 . 8 :   The preview of the cabin drawing, ready to print

 2. Right-click and choose Zoom Window from the context menu.

 3. Make a window that encloses the bathroom, hot tub, and a couple of 
the dimensions. You have to click and hold down the mouse button, 
drag open the window, and then release the button.

The new view displays the lineweights you have set up (see Figure 15.9).

F I G u R E   1 5 . 9 :   The zoomed-in view of the cabin showing the lineweights
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 4. Right-click and choose Zoom Original from the context menu to 
return to the first preview view.

 5. Right-click again and choose Exit to return to the Plot dialog box.
If your print was oriented correctly on the sheet, you’re ready to 

print. If not, recheck the setup steps for errors.

 6. In the Browse For Plot File dialog box, browse to your Chapter 15 
folder, accept the default filename, and click the Save button.

The computer begins calculating the print and eventually sends it 
to the printer.

After the print is done, a notification balloon appears at the lower-
right corner of the AutoCAD window (see Figure 15.10). You can turn 
notifications on and off by right-clicking the Plot/Publish Detail icon 
in the AutoCAD tray and choosing the appropriate option.

F I G u R E   1 5 . 1 0 :   The notification balloon indicating that the plot is complete

 7. Save and close the I14A-FPLAYO.DWG (M14A-FPLAYO.DWG) drawing.

t I P  On the right side of the Printer/Plotter group of the Plot dialog box, AutoCAD 
displays a partial preview of the plot as you set it up. If there is a problem with the setup, 
AutoCAD displays red lines to warn you, but sometimes this doesn’t accurately reflect the 
actual plot. It ’s better to use the Preview feature, which provides you with a WYSIWYG 
view of the plot.

When your print comes out, it should look like Figure 15.8, shown earlier. 
Check the lineweights of the various components on the print. You might have 
to adjust the settings outlined in this section when plotting to a physical plotter 
attached to your computer.
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Because the PDF plotter was selected, a Portable Document Format (.pdf) file 
was created instead of a physical print. The ubiquitous nature of the PDF file 
format means that any application such as Adobe Reader can be used to open 
and view the electronic plot you just created.

n o t E  You can change a setting in the Lineweight Settings dialog box to be able 
to see lineweights in your drawing before you preview a plot, but they aren’t very accu-
rate unless you’re using layouts. When you print from model space, you have to preview 
the drawing from the Plot dialog box to see how the lineweights look.

Plotting a Drawing using Layouts
Plotting drawings using layouts is similar to plotting from model space. The 
core difference between the two methods relates to the way your drawing is 
scaled. When plotting from model space, you must choose a plot scale from the 
Plot dialog box, whereas that parameter is already taken care of when plotting 
layouts. Aside from the occasional need to publish a half-size set of drawings, 
the plot scale inside the Plot dialog box will almost always be set to 1:1.

Publishing a Single Layout
The rest of this section focuses on the multiple ways of plotting layouts from 
AutoCAD. Each method has its own advantages and disadvantages, and the 
method you ultimately choose will likely change based on the specific task at 
hand. To begin our discussion, you’ll first look at plotting a single layout.

To summarize, when a layout has been set up properly and is active, you print 
at a scale of 1:1. The elements of the drawing on the layout are then printed at 
actual size, and the model space portion of the drawing is printed at the scale to 
which the viewport has been set. Follow these steps:

 1. With I-A-100.dwg (M-A-100.dwg) open, switch to the A-101 layout by 
using the Quick View Layouts tool. For a review of layouts and view-
ports, see Chapter 14.

Your layout should look like Figure 15.11.

 2. Make sure that you are in paper space to start the PLOT command.
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F I G u R E   1 5 . 1 1 :   The cabin drawing ready for printing from a layout

 3. You’re using the PDF-1117 (PDF-A3) page setup. Verify the printer, 
paper size, and orientation as before.

 4. Make sure that, in the Plot Area group, the current choice displayed 
in the What To Plot drop-down list is Layout instead of Limits.

 5. In the Plot Scale group, the scale has been set to 1:1. This is what you 
want.

In the Plot Offset group, the Center The Plot check box is grayed 
out; it isn’t needed when using a layout to plot.

 6. Expand the Plot dialog box as necessary to verify that the mono-
chrome.ctb plot-style table is assigned.

There are no changes to make. Because this layout was set up for 
printing when it was created, all the settings in the Plot dialog box 
are automatically set correctly.

 7. In the lower-left corner, select Preview.
Your preview should look like Figure 15.12. Notice how the preview 

looks exactly like the layout, but without the dashed frame.
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F I G u R E   1 5 . 1 2 :   The preview of the current layout

 8. Right-click and choose Exit to close the preview window.

 9. Click OK to start the print.

 10. Save the resulting electronic plot as I15-A-100.pdf (M15-A-100.pdf).

This exercise shows that once a layout has been created, most of the setup 
work for printing is already done for you. This greatly simplifies the printing 
process because the parameters of the print are determined before the PLOT 
command begins.

Publishing Multiple Layouts
In AutoCAD terminology, you plot a single layout or view one or more times. 
The terms publishing and batch plotting are interchangeable and refer to assign-
ing several layouts or views to plot in sequence, one or more times. In this exer-
cise, you will publish all your layouts at one time.

 1. Open the I-A-100.dwg (M-A-100.dwg) sheet file, select the Output 
tab, and then click the Batch Plot button in the Plot panel.

You may also choose the Publish option from the Application 
menu, or enter PUBLISH↵ to open the Publish dialog box (see 
Figure 15.13). This shows all the layouts, including model space for 
all open drawings.
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F I G u R E   1 5 . 1 3 :   The Publish dialog box

 2. You don’t want to plot the objects from model space, so select the 
Model layout in the Sheet Name list and then click the Remove 
Sheets button.

 3. To prevent the Model sheet from automatically being added in the 
future, right-click and then uncheck the Include Model When Adding 
Sheets option in the context menu.

In the Page Setup column, you can see that all the layouts are set 
to <Default:PDF-1117> (<Default:PDF-A3>). This indicates that all 
the layouts will use the original page setup designated when the first 
layout, Cabin Floor Plan, was created. Remember, the other layouts 
were copied from this original layout.

 4. To add the other sheet files in your plan set, click the Add Sheets 
button.

 5. Select the I-A-000.dwg (M-A-000.dwg), I-A-200.dwg (M-A-200.dwg), 
and I-C-100.dwg (M-C-100.dwg) sheet files.

If necessary, drag the sheets into the proper order.
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 6. Click the Publish button at the bottom of the dialog box.

 7. In the Save Sheet List dialog box, click Yes.
This provides you with the opportunity to save this publishing job 

as a Drawing Set Description (DSD) file so that it can be reloaded 
with the Load Sheet List button. It’s not always necessary to plot 
all the layouts in a drawing every time you use the Publish tool. By 
creating DSD files for frequently published layout combinations, you 
can reduce the amount of time required to produce hard-copy prints.

 8. In the Save List As dialog box that opens, name the DSD file and 
navigate to your current working folder to place it. Then click Save.

 9. The Publish dialog box closes, and the plots begin. If a Processing 
Background Job dialog box appears, click Close.

An extensive number of plots can take a while to finish, depending 
on the size and complexity of the drawings and speed of the printer. 
The publish operation takes place in the background, so you can con-
tinue to work on your drawings as the publishing occurs.

 10. Click the Plot And Publish Details button in the bottom-right corner 
of the AutoCAD window to see information regarding the current and 
previous plots.

Only one publish operation can occur at a time. If you start an operation 
before the previous one is completed, you will see the Job Already In Progress 
dialog box, shown in Figure 15.14, indicating that you must wait before starting 
the next one.

F I G u R E   1 5 . 1 4 :   The Job Already In Progress dialog box

Without the PUBLISH command, you would have to open each layout tab indi-
vidually and use the PLOT command to make a print of each layout. In addition 
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to providing out-of-the-box batch plotting capabilities, the option to save a DSD 
file helps to further automate the plotting process. These DSD files can be espe-
cially helpful for projects for which multiple submittals are expected.

There is one final way of plotting multiple drawings at once, and it is by using 
Sheet Set Manager. The next section will allow you to harness one of the most 
popular features of Sheet Set Manager.

Publishing with Sheet Set Manager
In Chapter 14, you learned how Sheet Set Manager can be used to create and 
manage drawing sheets. Now that it’s time to plot your drawings, this section 
will teach you how to use Sheet Set Manager to plot nearly any combination of 
sheets. Follow these steps to begin plotting with Sheet Set Manager:

 1. If it’s not already displayed on your screen, open the Sheet Set 
Manager palette set by selecting the Sheet Set Manager tool on the 
Palettes panel of the View tab on the Ribbon.

 2. Expand the drop-down list at the top of the Sheet List palette, 
and choose Open. Browse to and open the I-Summer Cabin.dst 
(M-Summer Cabin.dst) file in your Chapter 15 folder.

After you open the sheet set, the Sheet Set Manager palette 
set should display a list of drawing sheets in your project (see 
Figure 15.15).

F I G u R E   1 5 . 1 5 :   The Summer Cabin sheet list displaying a list of drawing 
sheets

www.MouradEngineering.com



8 3 8 	 C h a p t e r 	 15 	 • 	 P r i n t i n g 	 a 	D r aw i n g

 3. Right-click the Summer Cabin sheet set name at the top of the Sheet 
List palette, and choose Publish ➢ Publish To Plotter from the con-
text menu that appears (see Figure 15.16).

F I G u R E   1 5 . 1 6 :   Publishing the entire sheet set to the default plotter

Choosing the Publish To Plotter option from Sheet Set Manager will use the 
plotter assigned to each individual layout tab. That is, if half of your layouts had 
Plotter A assigned to them and the other half had Plotter B, half of your drawing 
set would plot on each plotter. Therefore, if you plan to use Sheet Set Manager, 
it’s especially important for you to set up each of your drawings in a uniform 
way. Sheet Set Manager offers you multiple ways of plotting your sheet set:

Publish to DWF/DWFx  Uses the assigned page setup of each layout and cre-
ates a DWF™ or DWFX™ file by using the settings such as page size and plot-
style table contained within the page setup.

Publish to PDF  Identical to the Publish To DWF or DWFx option, with the 
exception of the output file type. As its name indicates, the Publish To PDF 
option creates a PDF file compatible with the popular Adobe Acrobat program.
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Publish to Plotter  As previously discussed, this option uses the page setup 
assigned to each layout and uses those settings to publish the sheet set. If differ-
ent plotters are assigned to the various layouts, your sheet set will plot to sepa-
rate plotters.

Publish using Page Setup override  Among the settings you specified as you 
created your Summer Cabin sheet set was the location for Page Setup Overrides. 
This was set to the same template drawing used to create your sheets. Therefore, 
any additional page setups you create in your sheet template drawing automati-
cally appear here. Using Page Setup Override will inherit all of the settings, 
including the plotter, contained within the page setup.

You don’t always need to plot every drawing inside your sheet set. Let’s say 
you want to plot only the Architectural sheets in your plan set. Rather than 
right-clicking the Summer Cabin sheet set name, you would right-click the 
Architectural subset to display the context menu shown earlier in Figure 15.16. 
Instead of plotting every drawing in your sheet set, Sheet Set Manager will plot 
only the sheets under the Architectural subset.

It’s also possible to select any combination of sheets and subsets by using 
the Ctrl key, to plot only the sheets you select. Although setting up Sheet Set 
Manager takes more time than using the PUBLISH command, this versatility, 
coupled with the sheet management features covered in Chapter 14, makes it a 
worthwhile investment for a plan set of any notable size.

A Few Words about Plot Styles
The assumption has been that the printer will be monochromatic and convert 
all colors in an AutoCAD drawing to black. However, although laser printers are 
usually monochromatic, they might print the lighter colors in your drawing as 
screened. If you have access to a large-format inkjet plotter, you might have the 
option to print in monochrome or color. In that case, you might have objects 
in your drawing that are one color, but you want them printed in another color. 
Plot styles offer a means to handle these kinds of situations. You don’t have to 
use plot styles in AutoCAD, but you might need to work on a drawing that uses 
them. We’ll finish this chapter with a tour of the various dialog boxes and proce-
dures for setting up and assigning plot styles.

www.MouradEngineering.com



8 4 0 	 C h a p t e r 	 15 	 • 	 P r i n t i n g 	 a 	D r aw i n g

Introducing Plot Style table Files
A plot style is a group of settings assigned to a layer, a color, or an object. It 
determines how that layer, color, or object is printed. Plot styles are grouped 
into plot-style tables that are saved as files on your hard drive. Two kinds of plot 
styles exist:

▶▶ Color-dependent, which are assigned to colors in your drawing

▶▶ Named, which are assigned to layers or objects

Open the current Plot Style Table directory by choosing Application menu ➢ 
Print ➢ Manage Plot Styles. Unless you’ve changed this setting from its default, 
a new Windows Explorer window will open the following folder: C:\Users\your 
name\AppData\Roaming\Autodesk\AutoCAD 2015\R20.0\enu\Plotters\Plot 
Styles. As you can see in Figure 15.17, this folder contains 13 preset plot-style 
table files. Nine of them are color-dependent plot-style table files, with the exten-
sion .ctb; and four are named plot-style table files, with the extension .stb. (If 
you can’t see the .ctb and .stb extensions, choose Tools ➢ Folder Options ➢ 
View, and uncheck Hide Extensions For Known File Types.) This folder also con-
tains a shortcut to the Add-A-Plot Style Table Wizard, which you use to set up 
custom plot-style tables. Close Windows Explorer, and return to AutoCAD.

F I G u R E   1 5 . 1 7 :   The contents of the Plot Styles folder

www.MouradEngineering.com



	 A 	 F ew 	Wo rd s 	 a b o u t 	 P l o t 	 S t y l e s  8 4 1

understanding How Plot-Style table Files Are 
organized
Plot-style table files are assigned to a drawing and contain all the plot styles 
needed to control how that drawing is printed. Color-dependent plot styles 
control printing parameters through color. There are 255 of them in each color-
dependent plot-style table, one for each color. Named plot-style tables, on the 
other hand, have only as many plot styles as are necessary, possibly only two or 
three. You’ll now look at a plot-style table and see how it’s organized:

 1. Open the Plot dialog box.

 2. Expand the dialog box if necessary, and choose acad.ctb from the Plot 
Style Table drop-down list in the top-right corner (see Figure 15.18)

F I G u R E   1 5 . 1 8 :   Assigning a color-dependent plot style to the drawing

 3. Click the Edit Plot Style button next to the drop-down list.
The Plot Style Table Editor dialog box with acad.ctb in its title bar 

opens (see Figure 15.19). This dialog box has three tabs. The General 
tab displays information and a Description text box for input.
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F I G u R E   1 5 . 1 9 :   The General tab of the Plot Style Table Editor dialog box for 
the acad.ctb file 

 4. Click the Table View tab (see Figure 15.20). 
Now you see the plot styles across the top and the plot style properties 

listed down the left side. The benefit of this view is that all information 
is organized like a spreadsheet. Use the scroll bar to assure yourself that 
there are 255 plot styles. Notice that each plot style has 12 properties 
plus a text box for a description. This tab displays the plot-style informa-
tion in a way that gives you an overview of the table as a whole.
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F I G u R E   1 5 . 2 0 :   The Table View tab of the Plot Style Editor dialog box for the 
acad.ctb file

 5. Click the Form View tab (see Figure 15.21).

F I G u R E   1 5 . 2 1 :   The Form View tab of the Plot Style Table Editor dialog box 
for the acad.ctb file 

www.MouradEngineering.com



8 4 4 	 C h a p t e r 	 15 	 • 	 P r i n t i n g 	 a 	D r aw i n g

The same information found on the Table View tab is organized in a 
slightly different way. Here the plot styles are listed in the box on the 
left. You can highlight one or more plot styles at a time. The properties 
of the highlighted styles appear on the right. This view is set up to mod-
ify the properties of chosen plot styles. Notice that the first property, 
Color, has Use Object Color assigned for all plot styles. This means that 
red objects are plotted in red, blue in blue, and so on. You can override 
this by expanding the drop-down list and selecting another color. 

 6. Close the Plot Style Table Editor, assign the color-dependent  
monochrome.ctb file to the drawing, and then open the file for  
editing. Click the Table View tab. 

Now look at the Color property. All plot styles have the color Black 
assigned (see Figure 15.22).

F I G u R E   1 5 . 2 2 :   The Table View tab of the Plot Style Table Editor dialog box 
for the monochrome.ctb file

 7. Click Cancel to close the Plot Style Table Editor dialog box, and then 
close the Plot Styles dialog box.

The monochrome.ctb file will print all colors in your drawing as black, 
but the Plot Style Table won’t change the colors in the AutoCAD file.
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Going Forward
This chapter has been a quick tour and introduction to the plot-style feature, 
which helps control how your drawing will plot. Getting consistently good out-
put from your AutoCAD drawings requires an investment of time by you, or the 
office CAD manager/information technologist, to set up the best configuration 
of your printers and AutoCAD. As you have seen, layouts provide a good tool for 
setting up plots, once the configuration is right.

The next two chapters cover drawing in 3D (for AutoCAD users only). There 
you’ll learn how to build a comprehensive 3D model and render it to create a 
photorealistic illustration of how your cabin will look after it is built. This book’s 
web page (www.sybex.com/go/autocad2015ner or www.thecadgeek.com) offers a 
collection of all the AutoCAD drawings and adjunct files that you’ll use or gener-
ate throughout the course of this book.

Just because the 3D features found inside AutoCAD aren’t included in the 
Autodesk® AutoCAD LT® program doesn’t mean that your journey has to end here. 
Be sure to visit the companion sites noted in the preceding paragraph, where you’ll 
find additional resources to help you continue mastering AutoCAD and also get 
answers to any questions that may have arisen as you worked through the book.

If You Would Like More Practice…
This chapter used the virtual DWG To PDF.pc3 device that’s included with 
AutoCAD to create plots of your drawings. Apply the concepts you learned 
throughout this chapter to plot to a physical printer/plotter connected to your 
computer. To create a hard-copy plot of a layout tab, follow these steps:

 1. Open the PLOT command.

 2. Select the physical device to which you would like to plot.

 3. Choose the best paper size for your device. Remember that many 
plotters include several versions of the same overall paper size.

 4. Set the Plot Area, Plot Offset, and Plot Scale as needed. Use the 
Preview button to verify each of these settings.

 5. Pick a Plot Style Table, and set Drawing Orientation to Landscape.

 6. Validate your plot by clicking the Preview button once again. Make 
any necessary changes.

 7. Click OK to begin plotting your drawing.
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Are You Experienced?

now you can…

✔✔ set	up	a	drawing	to	be	printed

✔✔ assign lineweights to layers in your drawing

✔✔ select the area of your drawing to print

✔✔ choose a sheet size to use to print your drawing

✔✔ set the scale of the print

✔✔ preview a print

✔✔ print a layout

✔✔ use	Sheet	Set	Manager	to	publish	one	or	many	drawings

✔✔ publish	multiple	layouts

✔✔ navigate through the plot-style features
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CHAPtER 16

Creating 3D 
Geometry
Nothing in Autodesk® AutoCAD® software is quite as fascinating as 
drawing in 3D. In addition to being interesting to create, 3D models are 
incredibly valuable project assets. Today’s architects and engineers are 
increasingly using AutoCAD 3D features not only to communicate designs 
with clients, but also as a design and analysis tool. This chapter covers 3D 
modeling, and the next chapter introduces materials and rendering.

Constructing a 3D model of a building requires many of the tools that you’ve 
been using throughout this book and some new ones that you’ll be introduced 
to in this chapter. Your competence in using the basic drawing, editing, and 
display commands is critical to your successful study of 3D for two reasons:

▶▶ Drawing in 3D can seem more complex and difficult than draw-
ing in 2D, and it can be frustrating until you get used to it. If 
you aren’t familiar with the basic commands, you’ll become that 
much more frustrated.

▶▶ Accuracy is critical in 3D drawing. The effect of errors is com-
pounded, so you must be in the habit of using tools, such as the 
osnap modes, to maximize your precision.

Many 3D software packages are on the market today, and some are bet-
ter for drawing buildings than others. Often, because of the precision that 
AutoCAD provides, a 3D DWG™ file is exported to one of these specialized 
3D packages for further work, after being laid out in AutoCAD. Three other 
Autodesk products—Autodesk® 3ds Max®, Autodesk® 3ds Max® Design, and 
Autodesk® Showcase® software—are designed to work with AutoCAD DWG 
files and maintain a constant link with AutoCAD-produced files.

In this chapter, you’ll look at the basic techniques of solid modeling and 
a couple of tools used in mesh and surface modeling. In the process, you’ll 
learn some techniques for viewing a 3D model.

▶

Autodesk® AutoCAD LT® 
software has a few 3D 
viewing tools but none 
of the 3D solid-model-
ing tools that AutoCAD 
supports. Therefore, 
this chapter doesn’t 
apply to AutoCAD LT.
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In this chapter, you will learn to

▶▶ Set	up	a	3D	workspace	and	navigate	a	3D	environment

▶▶ Use	the	Polysolid	tool	and	Boolean	functions	

▶▶ Extrude	2D	objects	

▶▶ Create 3D surfaces

Modeling in 3D
You’ll begin by building a 3D model of the cabin, using several techniques for 
creating 3D solids and surfaces. When you use solid-modeling tools, the objects 
you create are solid, like lumps of clay. They can be added together or subtracted 
from one another to form more-complex shapes. By contrast, 3D surfaces are 
composites of two-dimensional planes that stretch over a frame of lines, the way 
a tent surface stretches over the frame inside.

As you construct these 3D objects, you’ll become more familiar with the User 
Coordinate System (UCS), learn how it’s used with 3D, and begin using the basic 
methods of viewing a 3D model.

Setting up the 3D Workspace and Environment
So far, you’ve been using the Drafting & Annotation workspace to create your 
drawings. Your first task in transitioning into 3D begins by switching to a new 
workspace for working in 3D and changing how AutoCAD displays the avail-
able tools.

Follow these steps to switch the workspace:

 1. Open the I14A-FPLAYO.dwg (M14A-FPLAYO.dwg) file you created previ-
ously, or download it from this book’s website at www.sybex.com/go/
autocad2015ner or www.thecadgeek.com.

 2. Switch to the 3D Modeling workspace by using the Workspace 
Switching flyout on the status bar (see Figure 16.1).
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F I G u R E   1 6 . 1 :   Switching to the 3D Modeling workspace from the status bar 

Switching to the 3D Modeling workspace updates the AutoCAD user 
interface, deemphasizing the 2D drafting tools used until this point 
and placing emphasis on the 3D-modeling tool set (see Figure 16.2). 
While many of the 2D-drafting tools have been deemphasized and/
or removed from the Ribbon, it’s important to note that all AutoCAD 
commands are still available from the command line. Likewise, it’s 
always possible to restore the complete 2D-drafting tool set by switch-
ing back to the Drafting & Annotation workspace.

F I G u R E   1 6 . 2 :   The 3D Modeling workspace

 3. Zoom in to the floor plan, make the A-WALL layer current, and freeze 
all other layers.

Your drawing and AutoCAD setup will look like Figure 16.3.
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F I G u R E   1 6 . 3 :   I14A-FPLAYO.dwg (M14A-FPLAYO.dwg) with all layers 
turned off except A-WALL

 4. If the UCS icon isn’t visible on your screen, click the Home tab and 
then click the Show UCS Icon button on the Coordinates panel.

You’ll use the UCS icon in a moment, but for now keep an eye on 
it as the drawing changes. Remember that the icon’s arrows indicate 
the positive direction for the x-, y-, and (in 3D) z-axes.

thinking in 3D

Try to start thinking of your model in three dimensions. The entire drawing is 
on a flat plane parallel to the monitor screen. When you add elements in the 
third dimension, they project straight out of the screen toward you if they have 
a positive dimension, and straight through the screen if they have a negative 
dimension. The line of direction is perpendicular to the plane of the screen and 
is called the z-axis. You’re already familiar with the x- and y-axes, which run left 
and right, and up and down, respectively. Think of the z-axis as running into and 
out of the screen.
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Now you’ll use the in-canvas viewport controls to change the view 
from a plan view of the drawing—looking straight down at it—to 
one in which you’re looking down at it from an angle. There are sev-
eral preselected viewpoints, and here you’ll switch to one of them.

The in-canvas viewport controls are composed of three bracketed 
menus in the upper-left corner of the drawing window. Starting from 
the left, these menus are as follows:

▶▶ Viewport Control

▶▶ View Controls

▶▶ Visual Style Control

You’ll use the View Controls menu to change the angle in which 
the drawing is displayed.

 5. Using the in-canvas viewport controls, click the View Controls menu, 
currently displayed as [Top], and choose SW Isometric, as shown in 
Figure 16.4.

F I G u R E   1 6 . 4 :   Select the Southwest Isometric view from the in-canvas 
viewport control’s View Controls menu.
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The view changes to look like Figure 16.5. Notice how the UCS 
icon has altered with the change of view. The X and Y arrows still 
run parallel to the side and front of the cabin, but the icon and the 
floor plan are now at an angle to the screen, and the z-axis is visible. 
The crosshair cursor is now colored and also displays the z-axis.

F I G u R E   1 6 . 5 :   The walls as displayed from the Southwest Isometric view

Visual styles allow a 3D model to display in several different ways: 
with nonvisible edges hidden, with materials applied, or even trans-
parently. The most appropriate visual style is often dictated by the 
task at hand, the context of which will be established in the succeed-
ing exercises.

Currently, the most basic of these visual styles, 2D Wireframe, is in 
use. To get started, you’ll change this to one of the 3D visual styles 
included with the product.

 6. Returning to the in-canvas viewport controls, click the Visual Style 
Control menu, currently displayed as [2D Wireframe], and select 
X-Ray (see Figure 16.6).
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F I G u R E   1 6 . 6 :   Selecting the X-Ray visual style

The drawing area takes on a dark gray background, and the UCS 
icon changes to a chunkier, three-color appearance. Also note how the 
position of the ViewCube® tool in the upper-right corner reflects the 
current orientation of your drawing (see Figure 16.7). The ViewCube is 
a navigation tool covered later in this chapter.

F I G u R E   1 6 . 7 :   The drawing using the X-Ray visual style

 7. Save your drawing as I16-01-ViewSetup.dwg (M16-01-ViewSetup.dwg).
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n o t E  A common convention in 3D graphics is to color vectors or other axes to 
indicate elements so that red indicates the x-axis, green indicates the y-axis, and blue 
indicates the z-axis. The phrase used to remember this scheme is RGB = XYZ. You’ll see 
this convention used several times in this and the next chapter.

Making the Walls
The main task ahead is to create a 3D model of the cabin. You’ll use solid ele-
ments for the cabin’s walls, doors, windows, floor, decks, and steps. You’ll learn 
several ways of viewing your work as you progress. To make the walls, you’ll 
start with the polysolid object and then, like a sculptor, remove everything that 
isn’t an interior or exterior wall from the polysolid. The elements to be removed 
are the void spaces for the doors and windows.

Creating the Exterior Walls

To make the exterior walls, follow these steps:

 1. Continue using I16-01-ViewSetup.dwg (M16-01-ViewSetup.dwg), or 
open it if it is not already open.

 2. Set the Endpoint osnap to be running.

 3. Create a new layer called A-WALL-EXTR-3DOB, assign it color 22, 
and make it current.

 4. Click the Polysolid tool on the Primitive panel of the Solid tab.
AutoCAD may pause briefly as it loads the 3D-specific applications.

 5. At the _Polysolid 0'-4", Width = 0'-0 1/4", Justification = 
Center Specify start point or [Object/Height/Width/Justify] 
<Object>: prompt, enter H↵7'7-1/4"↵ (2318↵) to set the object 
height to 7′-7 1/4″ (2318 mm).

This is the height where the inside faces of the exterior walls meet 
the roof.

The exterior walls are 6″ (150 mm) thick, so the polysolid object 
should be 6″ (150 mm) thick as well.

 6. Enter W↵ or select Width, and then enter 6↵ (150↵) at the Specify 
width < 0'-01/4"NF: prompt.
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The Justification option determines the side of the polysolid on 
which you will pick the endpoints. You will be picking the outside 
lines of the cabin in a counterclockwise order, so the justification 
must be set to Right.

 7. Enter J↵ or select Justify to choose Justify from the command line, 
and then enter R↵ or select Right to specify a right justification.

You’re now ready to begin creating the walls.

 8. Use the Endpoint osnap to select the corner for the exterior wall of 
the cabin nearest to the bottom of the screen, and then move the 
cursor.

The first wall appears, and it is tied to the cursor, as shown in 
Figure 16.8.

F I G u R E   1 6 . 8 :   Starting the first polysolid wall

 9. Moving in the counterclockwise direction, click each of the endpoints 
along the outside perimeter of the cabin until only one segment sepa-
rates the last segment from the first.

Your drawing should look like Figure 16.9.
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F I G u R E   1 6 . 9 :   The exterior walls drawn with polysolids

 10. Right-click and choose Close from the context menu to close the 
polysolid.

 11. Save your drawing as I16-02-ExteriorWalls.dwg (M16-02-
ExteriorWalls.dwg).

Adding the Interior Walls

The interior cabin walls are thinner than the exterior walls and will probably 
have a different material assigned to them. You will make a new layer for these 
walls and change the polysolid parameters:

 1. Continue using I16-02-ExteriorWalls.dwg (M16-02-
ExteriorWalls.dwg), or open it if it is not already open.

 2. Create a new layer called A-WALL-INTR-3DOB, assign it color 44, 
and make it the current layer.

 3. Click the upper corner of the ViewCube to change your view to a 
northeast orientation (see Figure 16.10), and zoom in to the lower-
left corner of the cabin so that you can see the bathroom walls.
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F I G u R E   1 6 . 1 0 :   Using the ViewCube to change the view orientation

 4. Start the POLYSOLID command again.

 5. Press the down arrow on the keyboard to expose the context menu at 
the cursor, and then click the Width option, as shown in Figure 16.11.

F I G u R E   1 6 . 1 1 :   Choosing the Width option from the context menu

 6. Enter 4↵ (100↵) to change the width to 4″ (100 mm).

 7. Starting with the interior endpoint of the inside wall nearest to the 
back door, draw the two walls that enclose the bathroom.

 8. Right-click and choose Enter to terminate the command.
If you have trouble clicking the correct endpoints, temporarily 

freeze the A-WALL-EXTR-3DOB layer, create the new wall, and then 
thaw the layer.

 9. Press the spacebar to restart the command, and then draw the two 
walls that surround the closet, starting at the endpoint that is far-
thest from the sliding glass door.

Make sure that the walls are justified properly, and then zoom to the 
drawing’s extents. Your drawing should look similar to Figure 16.12.

◀

You can also start 
the POLYSOLID 
command by entering 
PSOLID↵.
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F I G u R E   1 6 . 1 2 :   The cabin with all the walls drawn as polysolids

 10. Save your drawing as I16-03-InteriorWalls.dwg (M16-03-
InteriorWalls.dwg).

Creating the Door and Window Block-outs
Before you add the geometry for the doors and windows, you must make the 
openings in the walls. You will accomplish this by using the Boolean tools, 
which can create a single object from the volumes of two overlapping objects 
called operands. There are three Boolean functions:

union  Union combines the two volumes.

Subtraction  Subtraction deletes one object and the overlapping volume 
shared with the other.

Intersection  Intersection deletes both objects, leaving only the shared volume 
behind.
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For the doors and windows, you will make solid boxes the size of the openings. 
You’ll then use the SUBTRACT command to create voids by removing the boxes as 
well as the volume they share with the walls. The boxes act as block-outs—vol-
umes that are to be deleted—and their only function is to help delete part of the 
polysolid wall.

Creating the Door Block-outs

Follow these steps to make the door block-outs:

 1. Continue using I16-03-InteriorWalls.dwg (M16-03-
InteriorWalls.dwg), or open it if it is not already open.

 2. Make a new layer named A-DOOR-3DOB, apply color 100, and set it 
as the current layer.

 3. Freeze the two A-WALL 3DOB layers, and thaw the A-GLAZ layer.

n o t E  See Figure 10.1 in Chapter 10, “Generating Elevations,” for the window 
elevations above the floor.

 4. Click the upper corner of the ViewCube to change from the current 
northeast view to a southwest orientation.

 5. Zoom in to the cabin so that you can see the back door and the 
kitchen window.

 6. Click the Box button in the Modeling panel of the Home Ribbon tab, 
or enter BOX↵ at the command prompt.

If the Box tool is not shown, click the down arrow below the tool 
on the far-left side of the panel and choose it from the flyout menu. 
You will be making a block-out that will act as the operand that is 
removed from the polysolid.

The box object requires three items of information to be con-
structed: two points that define the opposing corners of the object’s 
footprint, and a height value.

 7. At the prompts, click two opposite corners of the back door opening, 
as shown in Figure 16.13.

◀

Boxes (as well as cyl-
inders, cones, and the 
other 3D objects on the 
flyout) are known as 
primitives, and they are 
often used as the build-
ing blocks of more-
complex objects.
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F I G u R E   1 6 . 1 3 :   Defining the footprint of the back door

 8. At the Specify height or [2Point]: prompt, enter 7'6↵ (2286↵). 
The box appears in place (see Figure 16.14).

F I G u R E   1 6 . 1 4 :   The first door operand created in place

▶

When I instruct you to 
pick an object when 
working in 3D, you 
need to click an edge of 
the object or a line that 
helps define the object. 
If you try to select a 
surface, the selection 
may not be recognized.
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 9. Repeat steps 6 through 8 to create the block-outs for two internal 
doors and the sliding glass door.

When using the Boolean functions, it’s best not to have a situation 
where the two operands have coplanar faces.

 10. Select the box at the back door.
The box’s grips appear all around the base and at a single location 

at the top. Dragging the triangular grips changes the lengths of the 
sides of the box but doesn’t change the angles between the sides. The 
square grips move the corners of the box or the box itself, and the 
single top grip changes the box’s height.

 11. Click the triangular grip on the front of the box, and drag it forward 
to pull the front of the box out from the front of the cabin.

It doesn’t have to be a great distance, just enough so that the box 
and the frozen polysolid don’t share the same plane.

 12. Drag the rear triangular grip backward, and position it off the inside 
of the exterior wall.

The base of the door should look similar to Figure 16.15.

F I G u R E   1 6 . 1 5 :   The base of the door after dragging the grips

 13. Repeat the process for the other three door block-outs so that each is 
thicker than its associated opening.
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Your screen should look similar to Figure 16.16.

F I G u R E   1 6 . 1 6 :   All the thick door block-outs in place

 14. Save your drawing as I16-04-DoorBlockOut.dwg (M16-04-
DoorBlockOut.dwg).

Creating the Window Block-outs

As you might expect, making the window block-outs will be just like making the 
doorway openings. The only difference is that the bottoms of the window open-
ings sit at a different height above the 2D floor plan. Here are the steps:

 1. Continue using I16-04-DoorBlockOut.dwg (M16-04-DoorBlockOut.dwg), 
or open it if it’s not already open.

 2. Using the same procedure as in the previous section, create the boxes 
for all the window block-outs, with each box set to 3′-6″ (1067 mm) tall.

t I P  After you make the first window box, the default height for the BOX com-
mand is the correct height for the remaining windows. When prompted for the height, 
just press the spacebar or ↵.
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 3. Change the thicknesses of the boxes so that they overlap the thick-
ness of the outside walls.

Your drawing should look like Figure 16.17.

F I G u R E   1 6 . 1 7 :   The drawing with all the block-outs in place

 4. Save your drawing as I16-05-WindowBlockOut.dwg (M16-05-
WindowBlockOut.dwg).

Moving and Rotating in 3D
When you moved objects in the 2D portion of this book, terms such as left and 
right or up and down were acceptable to use because all movements were asso-
ciated with the sides of the drawing area. Even when you rotated the views in 
Chapter 10, it was so that you could relate movements to the screen more eas-
ily. When working in 3D, however, these terms are no longer easily translated 
from your intent to proper movement on the screen. Let’s take the back door 
block-out, for example. If I told you to move it forward, would that mean into 
the cabin, away from the cabin, or toward the bottom of the screen? You can see 
what the problem is. When the viewpoint is significantly different from what you 
may expect, say, from the bottom or the back, then front or back may be even 
more confusing.
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using the First Right-Hand Rule
To help you stay oriented in 3D space, the UCS becomes more important. Each 
colored axis of the UCS icon points in the positive direction for that particular 
axis. To understand whether a movement, particularly in the z-axis, is in the 
positive direction, you should be familiar with the first of two right-hand rules.

The first right-hand rule relates your hand to the UCS and helps clarify the 
axis directions. Start by extending the thumb and index finger on your right 
hand to form an L-shape. Then project your middle finger perpendicular to your 
palm, as shown in Figure 16.18. The rule states: When your thumb is pointing 
in the positive X direction and your index finger is pointing in the positive Y 
direction, your middle finger must be pointing in the positive Z direction.

F I G u R E   1 6 . 1 8 :   Use the first right-hand rule to identify x-, y-, and z-axes.
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To apply this to the window block-outs in our cabin example, compare your right 
hand to the UCS icon in the drawing area. With your thumb pointing toward the 
cabin, and your index finger pointing away from the cabin and to the left, your 
middle finger then points toward the top of the screen. This indicates that the 
window block-outs, which are currently resting on the ground plane with the door 
block-out, need to be moved in the positive Z direction. Follow these steps:

 1. Continue using I16-05-WindowBlockOut.dwg (M16-05-
WindowBlockOut.dwg), or open it if it’s not already open.

 2. Click the 3D Move tool in the Modify panel on the Home tab.
With the 3D Move tool, objects are moved using the Move grip tool, 

which looks similar to the UCS icon.

 3. At the Select objects: prompt, select the bathroom window block-
out and then press ↵ to end the selection process.

The Move grip tool appears at the center of the box, as shown in 
Figure 16.19. Note the different-colored arrows that make up the 3D 
Move tool: the color of each arrow matches the RGB = XYZ conven-
tion used for the 3D UCS icon.

F I G u R E   1 6 . 1 9 :   The Move grip tool at the center of the box
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 4. Move the cursor over each of the colored axes of the Move grip tool.
Notice that the axis turns yellow to indicate that it is current, 

and a vector appears in line with the axis, as shown in Figure 16.20. 
When a vector is visible, all movements, whether indicated with the 
cursor and a mouse click or with input from the keyboard, are con-
strained to the axis indicated.

F I G u R E   1 6 . 2 0 :   The z-axis vector indicating that moves are restricted to the 
z-axis

 5. Move the cursor over the blue z-axis.
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 6. When the axis vector appears, click and move the box in the positive 
Z direction, and enter 2'11↵ (889↵).

The box moves 2′-11″ (889 mm) above the wall lines.

t I P  You can also use the standard Move tool and enter @0,0,2′11 (@0,0,889) 
to move the box 2′-11″ (889 mm) along the z-axis.

 7. Start the 3D Move tool again, and this time pick the four remaining 
window block-outs.

 8. Move the cursor directly above the Move grip tool, and then click and 
drag the z-axis.

Notice that all four boxes are moving, and each leaves a ghosted 
version of itself at its original location (see Figure 16.21).

F I G u R E   1 6 . 2 1 :   Move the remaining block-outs 2′-11″ (889 mm) in the 
positive Z direction.
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 9. Enter 2'11↵ (889↵) to move the selected block-outs.

 10. A move operation in a 3D view can sometimes be deceiving. Do the 
following to verify that everything is in its proper place:

 a. Click the Top text located on the ViewCube to switch to the Top 
view, and make sure the block-outs are all located properly.

 b. If they are, use the ViewCube to switch back to the southwest 
view once again. If they’re not, undo to the point before the 
move and try it again.

 11. Save your drawing as I16-06-ElevateWindows.dwg (M16-06-
ElevateWindows.dwg).

Cutting the openings
You are ready to start the Boolean processes and cut the openings in the walls. 
When prompted to select an object, be sure to click an edge of the 3D objects 
and not a face, or the selection may not be successful.

 1. Continue using I16-06-ElevateWindows.dwg (M16-06-
ElevateWindows.dwg), or open it if it’s not already open.

 2. Thaw the A-WALL-EXTR-3DOB and A-WALL-INTR-3DOB layers, and 
freeze the A-GLAZ layer.

 3. Click the Subtract button on the Solid Editing panel of the Home tab, 
or enter SUBTRACT↵.

 4. At the Select solids and regions to subtract from… Select 
objects: prompt, select the exterior wall and then press ↵ to end the 
selection process.

You can perform the Boolean functions on several objects at one 
time, but first you will do it to only one.

 5. At the Select solids, surfaces and regions to subtract… 
Select objects: prompt, select the back door and then press ↵.

The door block-out, and the volume that it shared with the wall, 
are subtracted from the exterior wall (see Figure 16.22).
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F I G u R E   1 6 . 2 2 :   The back door subtracted from the exterior wall of the cabin

 6. Start the SUBTRACT command again, and select the exterior wall 
again.

t I P  If you have trouble seeing the window block-outs, temporarily switch to the 3D 
Wireframe visual style, execute the Boolean operation, and then switch back to the X-Ray 
style.

 7. When prompted for the objects to subtract, select all the remaining 
exterior door and window block-outs and then press ↵.

All the openings appear on the cabin’s exterior walls, as shown in 
Figure 16.23.
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F I G u R E   1 6 . 2 3 :   Each of the interior and exterior openings created for the 
cabin

 8. Repeat the subtraction process on the two interior walls to remove 
the bathroom and closet door volumes.

 9. Save your drawing as I16-07-ExteriorOpenings.dwg (M16-07-
ExteriorOpenings.dwg).

Creating the Floor, Foundation, and 
Thresholds
In designing the cabin, you didn’t draw a floor, but one was implied. The three 
exterior doorway openings have thresholds that indicate a small change in level 
from the cabin floor down to the decks. You’ll now create additional objects to 
make the floor, foundation and supports, and the thresholds. Follow these steps:

 1. Continue using I16-07-ExteriorOpenings.dwg (M16-07-
ExteriorOpenings.dwg), or open it if it’s not already open.
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 2. Continuing from the previous set of steps where you completed the first 
openings, open the Layer Properties Manager and do the following:

 a. Create the following new layers:

A-DOOR-THRE-3DOB

A-FLOR-3DOB

A-FNDN-3DOB

 b. Make A-DOOR-THRE-3DOB current.

 c. Give each layer a unique color.

 d. Freeze the A-WALL-EXTR-3DOB and A-WALL-INTR-3DOB layers.

 e. Thaw the A-DECK-STRS layer.

To see where you’re going, look ahead to Figure 16.26. You’ll use 
the EXTRUDE command to create a series of solids that represent the 
thresholds and boxes for the steps and the floor.

 3. Zoom in on the back door opening and its threshold.

 4. Draw a polyline around the perimeter of the threshold; use the Close 
option to make the last segment. The threshold extends 3″ (76 mm) 
beyond the door opening, and 2″ (50 mm) beyond the cabin.

For clarity only, the polyline is shown wider than necessary in 
Figure 16.24.

F I G u R E   1 6 . 2 4 :   A polyline drawn around the perimeter of the threshold

◀

To find your 3D object 
layers quickly in the 
Layer Properties 
Manager, try entering 
*3DOB in the text 
box in the upper-right 
corner.
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The Extrude tool extends a 2D object in the Z direction, creating 
surfaces on the newly formed sides and end caps.

 5. Click the Extrude tool in the Modeling panel of the Home tab, select 
the threshold polyline, and then press ↵.

 6. At the Specify height of extrusion or [Direction/Path/Taper 
angle] <-1′-0″>: prompt, enter 1.05↵ (27↵).

The first threshold is completed, as shown in Figure 16.25.

F I G u R E   1 6 . 2 5 :   The extruded polyline

 7. Make a similar extruded threshold for the sliding glass door.

 8. Make the A-FLOR-3DOB layer current.

 9. To create the floor, first draw a polyline around the inside perimeter 
of the cabin, ignoring the interior walls and thresholds.

 10. Start the EXTRUDE command, select the floor polyline, and then 
extrude it 1″ (25 mm), as shown in Figure 16.26.
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F I G u R E   1 6 . 2 6 :   The 3D floor with the thresholds

 11. Save your drawing as I16-08-Thresholds.dwg (M16-08-Thresholds.dwg).

Creating the Foundation and Supports
The cabin’s foundation is a concrete slab 18″ (457 mm) thick that sits directly 
on the ground. The foundation supports the structure except where the pop-out 
projects out from the side wall. At the outside corners of each deck are concrete 
support posts. All the objects are placed on the 3D-Foundation layer. Model the 
foundation and supports by following these steps:

 1. Continue using I16-08-Thresholds.dwg (M16-08-Thresholds.dwg), 
or open it if it’s not already open.

 2. Make the A-FNDN-3DOB layer current, and thaw the A-DECK layer.

 3. Freeze the A-FLOR-3DOB and A-DOOR-THRE-3DOB layers.

 4. Draw a closed polyline around the outside perimeter of the cabin, 
making sure you span the pop-out area as if it didn’t exist.

Alternatively, you could use the Rectangle (RECTANG) command.

 5. Extrude the polyline 18″ (457 mm) in the negative Z direction. You can 
do this with Dynamic Input active by dragging the extrusion in the neg-
ative direction and entering 18↵ (457↵), or by dragging it in the positive 
direction and entering -18↵ (-457↵).
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 6. Using the Rectangle (RECTANG) command, draw a 12″ × 12″ (305 mm 
× 305 mm) rectangle at each of the four outside corners of the decks.

The outside corner of each rectangle should match the outside cor-
ner of each deck post corner.

 7. Start the EXTRUDE command, select all four rectangles, and then 
extrude them 2′-10″ (864 mm) in the negative Z direction.

When you’re finished, the foundation and supports should look like 
Figure 16.27.

F I G u R E   1 6 . 2 7 :   The foundation and supports

 8. Save your drawing as I16-09-FoundationSupport.dwg (M16-09-
FoundationSupport.dwg).

t I P  Similar to the way you used Quick Filter to create a Wblock (WBLOCK) previ-
ously in the book, try using the Quick Select button on the Properties palette to select 
the four foundation posts.

Building the Windows
Now that the openings are in place and the foundation is complete, you just 
need to build the geometry for the doors and windows. These can be as com-
plete as you like, with sills, drip grooves, tapered panels, kick plates, and so on. 
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For the exercises in this book, however, you’ll create fairly simple frames, door 
panels, and glazing.

 1. Continue using I16-09-FoundationSupport.dwg (M16-09-
FoundationSupport.dwg), or open it if it’s not already open.

 2. Make a new layer named A-GLAZ-SILL-3DOB, and set it as the current 
layer.

 3. Freeze the A-FNDN-3DOB layer.

 4. Thaw the A-WALL-EXTR-3DOB layer.

 5. Zoom in to the kitchen window near the back door.

 6. Click the Customization button on the status bar, and then select 
Dynamic UCS from the menu that opens.

 7. Click the Allow/Disallow Dynamic UCS button in the status bar to 
turn on Dynamic UCS mode.

When you are in a command, Dynamic UCS causes the current 
UCS to adapt to the orientation of whichever face the cursor is over. 
This is important because, when using creation tools such as the 
BOX command, the footprint is made in the xy-plane, and the height 
is projected along the z-axis. When Dynamic UCS is active, the UCS 
shown at the cursor overrides the UCS shown by the UCS icon.

 8. Start the BOX command and then move your cursor near the UCS icon.
Notice that the color-coded axes of the crosshairs match the orien-

tation and colors (RGB = XYZ) of the UCS icon axes.

 9. Move the cursor over the faces on the back wall of the cabin, and 
notice that the blue z-axis now points in the same direction as the 
UCS icon’s y-axis.

This identifies the orientation of that particular wall’s face.

 10. With the Endpoint osnap active, click the lower-left outside corner of 
the kitchen window, and then move the cursor away from that corner.

The box starts to form with its orientation parallel to the outside 
wall, and the UCS icon temporarily changes its orientation (see the 
left image in Figure 16.28).
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F I G u R E   1 6 . 2 8 :   With Dynamic UCS turned on, the box’s base is oriented 
parallel to the wall (left), and the box’s base is completed (right).

 11. Click the opposite outside corner of the window for the base of the 
new box (see the right image in Figure 16.28).

 12. At the Specify height or [2Point]>: prompt, move the cursor 
until you can see the box projecting out from the wall and then enter 
-4↵ (-100).

The box’s Height parameter projects it 4″ (100 mm) into the win-
dow opening. You can switch to a Wireframe visual style to see this 
more clearly.

 13. Turn off Dynamic UCS, select the box, and move it 1″ (25 mm) in the 
positive X direction to center it in the wall.

The box you just made will be the frame for the kitchen window. 
Now you need to make a block-out to subtract from the box to create 
the opening for the glazing.

 14. Copy the box you just made, move it in front of the back wall, and 
then select the copy to expose its grips.

Use Ortho mode, keyboard input, or the Move grip tool to ensure 
that the box is moved along the x-axis only.

▶

For clarity, the illustra-
tions for the kitchen 
window are shown 
using the Conceptual 
visual style.
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 15. Turn on Polar Tracking.

 16. Select each of the four outward-pointing triangular grips along the 
perimeter, and move them 1″ (25 mm) toward the inside of the box 
(see the left image in Figure 16.29).

F I G u R E   1 6 . 2 9 :   Moving the block-out’s perimeter grips to shrink it slightly 
(left) and the box’s increased depth (right)

 17. Click the triangular grip on the back of the box, and drag it until the 
box extends all the way through the back wall (see the right image in 
Figure 16.29).

 18. Using the in-canvas viewport controls, switch to the 3D Wireframe 
visual style and turn on the Selection Cycling tool in the status bar if 
it’s not already on.

 19. Using the Subtract Boolean function, subtract the block-out from the 
frame.

 20. Switch back to the Conceptual or X-Ray visual style, and your win-
dow should look similar to Figure 16.30.
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F I G u R E   1 6 . 3 0 :   The completed kitchen window frame

 21. Create a new layer named A-GLAZ-3DOB, give it a light blue color 
such as 151, and make it current.

A polyline can be drawn only in the xy-plane, but a 3D polyline can 
be drawn along any axis.

 22. Click the 3D Polyline button in the Home tab ➢ Draw panel, or enter 
3DPOLY↵ at the command line.

 23. Turn on the Midpoint running osnap, and then draw the 3D polyline 
by using the midpoints of the frame’s four, 4″ (100 mm) wide inner 
corners.

 24. Switch to the Wireframe visual style and freeze the A-WALL-EXTR-
3DOB layer if you have trouble locating the midpoints.

Be sure to switch back to the Conceptual or X-Ray visual style and 
thaw the layer when you are finished.
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 25. Use the Extrude tool to extrude the glazing 0.25″ (6 mm).
If you have trouble selecting the 3D Polyline, enter L↵ to use the 

Last option at the Select Objects: prompt. Your kitchen window 
should look like Figure 16.31.

F I G u R E   1 6 . 3 1 :   The completed kitchen window

 26. Save your drawing as I16-10-KitchenWindow.dwg (M16-10-
KitchenWindow.dwg).

Rotating in 3D (the Second Right-Hand Rule)

When you rotated objects in a 2D environment, all the rotations were perpen-
dicular to the screen, and you never had to consider the axis around which the 
object was rotating. Because all 2D rotations happened in the xy-plane, the 
objects were rotated around the z-axis. Positive rotations were in the counter-
clockwise direction, and negative rotations were clockwise.
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In 3D, however, rotation can occur around any axis, and you need to under-
stand whether a rotation should be in the positive or negative direction. Use the 
second right-hand rule to understand how the rotation direction is identified in 
a 3D environment. It states that if you grasp an axis with your right hand, with 
your thumb pointing in the positive direction, then your fingers will be curled 
in the positive rotation direction. Figure 16.32 illustrates this concept.

F I G u R E   1 6 . 3 2 :   The right-hand rule as it applies to rotations

To rotate an object in 3D, you use the 3D Rotate tool, called a gripper, shown 
in Figure 16.33. It consists of three intersecting circular bands, the center of 
which is the pivot point of the rotation. Each band is color coded (RGB = XYZ) 
to identify the axis around which the objects are rotated. When you’re prompted 
for a rotation axis, clicking the green band, for example, restricts the rotation to 
the y-axis.
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F I G u R E   1 6 . 3 3 :   The 3D Rotate gripper

Completing the Windows

When Boolean operations are used, the component objects, called operands, are 
not replaced with the resulting object; they just become subobjects of it. You 
always have the ability to edit the operands and alter the object itself. Here’s how:

 1. Continue using I16-10-KitchenWindow.dwg (M16-10-
KitchenWindow.dwg), or open it if it’s not already open.

 2. Copy the existing window frame and glazing, and move the copy in 
front of the 5′-0″ (1525 mm) window on the south side of the cabin. 
Then zoom in to that window.

 3. With the two objects selected, click the 3D Rotate tool on the Home 
tab ➢ Modify panel.

 4. At the Specify base point: prompt, click the endpoint of the lower 
corner of the frame nearest to the cabin.

The 3D Rotate gripper relocates to the specified corner.

 5. At the Pick a rotation axis: prompt, click the blue z-axis ring.
It turns yellow to indicate that it is the currently selected axis, and 

a blue line is emitted from the 3D Rotate grip tool to identify the 
pivot axis.

Imagine your right hand gripping the blue axis line with your 
thumb pointing upward, as in the hand shown in Figure 16.32. This 
shows you that a positive rotation, the direction in which your fin-
gers are pointing, is required to rotate the window counterclockwise.

 6. Enter 90↵ at the Specify angle start point or type an angle: 
prompt.

The window rotates 90˚ (see Figure 16.34).
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F I G u R E   1 6 . 3 4 :   Rotating the window 90˚ counterclockwise

This window is currently 4-′0″ (1220 mm) wide, while the opening is 5′-0″ 
(1525 mm) wide. You can correct the discrepancy by editing the subobjects of 
the window frame. Subobjects are selected by holding the Ctrl key down while 
selecting an object. Follow these steps:

 1. Turn running object snaps off, and turn Polar Tracking on.

 2. Select the window frame, right-click, and choose Properties.

 3. In the Solid History rollout, choose Yes for the Show History option. 
See Figure 16.35.

F I G u R E   1 6 . 3 5 :   In the Properties palette, set the Show History property  
to Yes.
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An outline of the box, used to subtract the volume for the opening, 
appears as shown in Figure 16.36.

F I G u R E   1 6 . 3 6 :   Selecting the box from the Subtract Boolean operation

 4. Hold the Ctrl key down, and click the window frame to select it and 
expose the grips.

n o t E  The object that you are editing is the window frame, and the operand is the 
subobject. You must hold down the Ctrl key when selecting a subobject to expose its grips.

 5. Click one of the triangular grips that control the width of the box, 
and drag it to make the box wider.

 6. Enter 12↵ (305↵) to stretch the box 12″ (305 mm) in the X direction, 
as shown in Figure 16.37.

www.MouradEngineering.com



8 8 4 	 C h a p t e r 	 16 	 • 	 C r e a t i n g 	 3D 	G e ome t r y

F I G u R E   1 6 . 3 7 :   Adjusting the size of the window frame

The side of the window frame is now much wider than the other 
edges of the frame. You can fix this by adjusting the size of the box 
operand.

 7. Hold the Ctrl key down, and then click to select the box operand and 
expose its grips.

 8. Click the triangular grip on the same side that you selected for the 
window frame, and drag the grip to make the frame larger.

 9. Enter 12↵ (305↵), as shown in Figure 16.38.
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F I G u R E   1 6 . 3 8 :   Adjusting the size of the box from the Subtract Boolean 
operation

The operand is extended 12″ (305 mm).

 10. Disable the Show History property by selecting the window and using 
the Properties palette.

 11. Change the Visual Style to Wireframe.

 12. Select the glazing, and then select each of the two exposed endpoints.

 13. Use the Midpoint osnap to extend them to the new frame size (see 
Figure 16.39).
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F I G u R E   1 6 . 3 9 :   Adjusting the size of the window glazing

Finally, you need to move the new window into the opening.

 14. Turn on the running object snaps. Then select the frame and glazing.

 15. Use the Endpoint osnap to pick the lower-left front corner of the 
frame as the first move point, and the lower-left front corner of the 
opening as the second point.

The window is moved into place, as shown in Figure 16.40.
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F I G u R E   1 6 . 4 0 :   The new window moved into the opening

The frame is flush with the outside wall.

 16. Use the 3D Move tool to move the window 1″ (25 mm) in the positive 
Y direction.

 17. Repeat the process in this section to make two of the other three rect-
angular windows in the cabin. Two of the windows are 3′-0″ (915 mm) 
wide, and you can simply copy one into the opening of the other.

When you’re finished, your drawing should look similar to 
Figure 16.41.
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F I G u R E   1 6 . 4 1 :   The cabin after all the rectangular windows and frames are 
finished

 18. Save your drawing as I16-11-FinishedWindows.dwg (M16-11-
FinishedWindows.dwg).

Adding the Pivot and Bifold Doors

For this exercise, you will represent the two pivot doors with simple boxes, and 
the two bifold doors with extruded polylines. Later, if you choose, you can add 
knobs and glass panes.

 1. Continue using I16-11-FinishedWindows.dwg (M16-11-
FinishedWindows.dwg), or open it if it’s not already open.

 2. Set the A-DOOR-3DOB layer as current, and thaw the A-DOOR-
THRE-3DOB layer.

 3. Zoom in to the back door.
Rather than moving the primitives as you have been doing, here 

you’ll use Object Tracking to place the start point.

 4. Switch to the Wireframe visual style, turn on Object Snap Tracking 
mode in the status bar, and make sure the Polar Tracking and 
Intersection running object snaps are on as well.

 5. Start the BOX command.
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 6. At the Specify first corner or [Center]: prompt, place your 
cursor near the bottom-left outside corner of the front door, where it 
meets the top of the threshold, until the small cross in the intersec-
tion marker appears.

 7. Move the cursor in the X direction until the tracking vector appears, 
and then enter 2↵ (50↵) to set the first corner of the door 2″ (50 mm) 
from the corner of the opening (see Figure 16.42).

F I G u R E   1 6 . 4 2 :   Locating the first corner of the door box

 8. Enter @2,-36↵ (@51,-915) to place the second point of the 3′-0″ (915 
mm) door.

 9. Give the door a height of 7′-6″ (2286), the distance from the top of 
the threshold to the bottom of the door opening.

 10. Thaw the A-WALL-INTR-3DOB layer.

 11. Use a similar process to add the bathroom door, with these 
differences:

▶▶ The door is only 2′-6″ (762 mm) wide.

▶▶ The door is only 1 1/2″ (38 mm) thick.

▶▶ The door is 7′-5″ (2261 mm) tall.
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▶▶ Offset the door 1 1/4″ (32 mm).

▶▶ Start or move the door 1″ (25 mm) above the bottom corner to 
accommodate the 1″ (25 mm) thick floor.

 12. Zoom in to the bifold closet doors.

 13. Thaw the A-DOOR layer, and change the layer of the bifold doors to 
A-DOOR-3DOB.

 14. Move the four polylines 1″ in the Z direction so that they rest at the 
same level as the top of the floor.

 15. Start the Extrude tool, and extrude each polyline 7′-5″ (2260 mm).

 16. Zoom out, and switch to the X-Ray visual style.
Your cabin should look like Figure 16.43.

F I G u R E   1 6 . 4 3 :   The cabin after the doors are in place

 17. Save your drawing as I16-12-DoorModel.dwg (M16-12-DoorModel.dwg).

navigating with the ViewCube
Changing the viewpoint used to view your drawings is especially important 
in a 3D environment because you are more likely to encounter a situation 
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where foreground objects obscure background objects. You’ve already used the 
ViewCube to complete several tasks in this chapter. Located in the upper-right 
corner of the drawing area, is used to access common views quickly, return to a 
saved view, or navigate freely in the drawing area.

The ViewCube (see Figure 16.44) consists of a center cube with each face labeled 
to identify the orthographic view that it represents. Clicking any of these labeled 
faces changes the viewpoint in the drawing area to display the objects from that 
point of view, based on the World Coordinate System (WCS).

Click and drag to set a
nonstandard view.

Click a letter to switch to
an elevation view from

that direction.

Click an edge to switch to
a view rotated 45º from the

adjacent orthographic views.

Click to set the view and right-click
to display a context menu.

Click to set the view and right-click
to display a context menu.

Click a corner to switch
to an isometric view.

Gray area indicates the
current view is most similar
to this predesigned view.

Click a face to switch to
an orthographic view.Switch to the home view.

F I G u R E   1 6 . 4 4 :   The functions of the ViewCube

The following examples explain how the ViewCube works:

▶▶ Clicking the ViewCube face labeled Top changes the drawing area to 
display the cabin from the top, with the x-axis pointing to the right 
and the y-axis pointing to the top of your screen.

▶▶ Clicking the face labeled Front changes the drawing area to display 
the cabin from the front, the view you designated as the south eleva-
tion, with the x-axis pointing to the right and the z-axis pointing to 
the top.

The orthographic views are not the only viewpoints that you can 
access from the ViewCube.

▶▶ Clicking any corner (see the left image in Figure 16.45) changes the 
drawing area to display the objects from an isometric vantage point 
that is a combination of the three labeled faces.
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F I G u R E   1 6 . 4 5 :   Clicking a ViewCube corner (left) and clicking a ViewCube 
edge (right)

▶▶ Clicking the corner at the intersection of the Top, Front, and Left 
faces produces a view identical to the Southwest Isometric view you 
selected from the Viewpoint drop-down list.

That corner is currently gray, indicating that it is the viewpoint 
most similar to the current view.

▶▶ Clicking any of the edges (see the right image in Figure 16.45) 
changes the drawing area to display the objects rotated 45˚ from one 
of the adjacent orthographic views.

Clicking any of the ViewCube features not only changes the view but also exe-
cutes a Zoom Extents, displaying all of the visible objects in the drawing area. 
You’ll usually perform a zoom after using the ViewCube. Clicking and dragging 
the ViewCube changes the viewpoint freely without any constraints.

Surrounding the cube is a ring with the compass directions indicated. 
Clicking any of the letters switches the view in the drawing area to a view from 
that direction. For example, clicking the letter E on the ring displays the east 
elevation of the cabin. This is a view showing the 3D cabin from the east, and 
not the 2D east elevation that you drew. You can click and drag the ring to 
rotate the view in a free-form manner.

The ViewCube also provides access to the named UCSs that you created in 
Chapter 10 and, when a named UCS or the WCS is current, displays the name 
below the compass ring. Clicking the rectangle shape below the ViewCube opens 
a context menu (see the left image in Figure 16.46), from which you can select 
the current view. Right-clicking the rectangle shape opens a context menu 
where you can, among other things, set the ViewCube settings and designate 
the current view as the home view (see the right image in Figure 16.46).

You can quickly switch to the home view by clicking the house icon, which is 
visible when the cursor is over the ViewCube.
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F I G u R E   1 6 . 4 6 :   Selecting the current view from the ViewCube (left) and accessing the 
right-click context menu (right)

Switching to a predefined view is quick and can often provide the vantage 
point that you need, but you may need to view your objects from a specific, non-
standard location.

Adding the Sliding Door
The remaining door to add is the sliding door on the front of the cabin. 
Although this is a door, the procedure for creating it will be more like that for 
the windows you’ve already made. Here are the steps:

 1. Continue using I16-12-DoorModel.dwg (M16-12-DoorModel.dwg), or 
open it if it’s not already open.

 2. Click the northeast corner of the ViewCube to display the front of the 
cabin. Then zoom in to the front door.

Your view should look similar to Figure 16.47.

F I G u R E   1 6 . 4 7 :   The view looking at the front of the cabin

◀

Holding down the 
Ctrl key while hold-
ing down and drag-
ging with the scroll 
wheel has a function 
similar to dragging the 
ViewCube.
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 3. Make the A-GLAZ-SILL-3DOB layer current.

 4. Create a box from the right edge of the patio opening, on top of the 
threshold that is 3′-7″ (1092 mm) wide and 2″ (51 mm) thick.

 5. Specify the height of the door by using the Perpendicular osnap, as 
shown in Figure 16.48, to pick one of the upper doorframe edges.

F I G u R E   1 6 . 4 8 :   Using the Perpendicular osnap to choose the door height

 6. With the box in place, use the 3D Move tool to position the door 1″ 
(25 mm) inside the right edge of the patio opening.

 7. Create a block-out that is 4′ (102 mm) smaller than the width and 
height of the frame you just drew but significantly deeper. Then cen-
ter it on the sliding-door frame, as shown in Figure 16.49.
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F I G u R E   1 6 . 4 9 :   The first sliding-door frame and block-out

Some display-roughness may occur where the block-out and frame 
meet, but this is just a function of the current visual style and the 
thin faces shown.

n o t E  The Conceptual visual style is used in Figure 16.49 for clarity. Often, 
the opaque nature of the Conceptual style makes objects easier to interpret; at other 
times, the transparent nature of the X-Ray visual style is preferred. Your choice will likely 
change based on the task at hand.
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 8. Subtract the block-out from the sliding-door frame.

 9. Set the A-GLAZ-3DOB layer as current.

 10. Use the 3D Polyline tool to create the boundary to the glazing, 
extrude it 0.25″ (6 mm), and then center it in the frame.

 11. Copy the frame until it butts the opening on the left and then move 
it 2″ (51 mm) toward the inside of the cabin so that the two door 
frames are offset (see Figure 16.50).

F I G u R E   1 6 . 5 0 :   The completed sliding door with two offset panels

www.MouradEngineering.com



 C r e a t i n g  t h e  F l o o r ,  F o u n d a t i o n ,  a n d  T h r e s h o l d s  8 9 7

 12. Save your drawing as I16-13-SlidingDoor.dwg (M16-13-
SlidingDoor.dwg).

Building the Decks
You’re nearly finished modeling the cabin. The next step is to make the two 
decks by using basic shapes and copying redundant objects. Follow these steps 
to create the front deck:

 1. Continue using I16-13-SlidingDoor.dwg (M16-13-SlidingDoor.dwg), 
or open it if it’s not already open.

 2. Make a new layer called A-DECK-3DOB, assign it color 240, and 
make it current.

 3. Thaw the A-FNDN-3DOB layer, and freeze the other 3DOB layers 
except A-DOOR-THRE-3DOB and A-WALL-EXTR-3DOB.

 4. Click the Box tool, and create a box to represent the floor of the deck.

 5. Use the Endpoint osnap to locate the two opposite corners of the 
deck, and then give the box a height of –1 5⁄8″ (–41 mm).

Your model should look like Figure 16.51.

F I G u R E   1 6 . 5 1 :   The beginning of the deck
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 6. Draw a box that follows the perimeter of the railing on the left side of 
the deck, and make this box 2″ (51 mm) tall.

 7. Move the box 4″ (102 mm) in the Z direction to represent the lower 
railing.

 8. Copy this box, and move the copy 3′-2″ (965 mm) higher to represent 
the upper railing.

Your railings should look like those in Figure 16.52.

F I G u R E   1 6 . 5 2 :   The first upper and lower railings
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 9. Repeat the process to create the two sets of railings at the front of 
the deck and on the left side of the stairs. Then copy both sets to the 
opposite side of the deck.

 10. Switch to the right and top views with the ViewCube to check your 
work, and adjust the size of the railings on the right side of the steps.

 11. Use the Zoom Previous command (Z↵P↵) to return to the current 
view (see Figure 16.53).

F I G u R E   1 6 . 5 3 :   The railings in place and adjusted for size

 12. To draw the first railing post, click the down arrow below the Box 
button on the Home tab ➢ Modeling panel, and choose Cylinder 
from the flyout menu.
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 13. At the Specify center point of base or: prompt, click the mid-
point of the first lower railing that you drew, where it meets the exte-
rior wall, and enter 3/8↵ (9.5↵) for the radius (see Figure 16.54).

F I G u R E   1 6 . 5 4 :   Creating the first railing post cylinder

 14. At the Specify height or: prompt, make sure the cursor is above 
the cylinder’s base, and then enter 3'↵ (914↵).

 15. To fill in the row of posts, move the first post 3 5⁄8″ (92 mm) in the X 
direction and then copy it 20 times at 4″ (102 mm) increments in the 
X direction.

The first set of railing posts should look like those shown in 
Figure 16.55.
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F I G u R E   1 6 . 5 5 :   The first set of railing posts

t I P  Rather than manually copying the railing post 20 times, tr y using the 
Rectangular Array (ARRAYRECT) command. This command includes the source object in 
the row and column count, so to use it to complete step 12, you’ll need to create an array 
with 1 row and 21 columns.

 16. Repeat steps 12–15 to draw the posts along the front of the deck, adjust-
ing the count and the direction appropriately. Then copy the posts from 
the left side of the deck to the right. Add any new post as required.

The completed railing posts should look like those shown in 
Figure 16.56.
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F I G u R E   1 6 . 5 6 :   The completed railing posts

 17. Zoom in to the front-left corner of the deck, where the support post 
sits.

 18. Use the Box tool to draw the 8″ × 8″ (204 mm × 204 mm) post and 
give it a height of 7′-8″ (2337).

You may need to adjust the height later when the roof is applied.

 19. Copy the post to the opposite side of the deck, and adjust the place-
ment as necessary.

Figure 16.57 shows the two support posts in place.
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F I G u R E   1 6 . 5 7 :   The support posts in place

 20. Save your drawing as I16-14-DeckRailing.dwg (M16-14-
DeckRailing.dwg).

Building the Steps

The steps, the step railings, and the posts transition from the ground level to 
the top of the deck. In this section, you’ll build and move the stairs and create 
and then rotate the handrail. To begin this process, follow these steps to build 
the steps:

 1. Continue using I16-14-DeckRailing.dwg (M16-14-DeckRailing.dwg), 
or open it if it’s not already open.

 2. Create a new layer named A-DECK-STRS-3DOB, and make it 
current.
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 3. Zoom in to see the steps clearly. Then switch to the 3D Wireframe 
visual style.

When you drew the steps in the plan view, the lines defining their 
width were trimmed back to the edge of the handrail. In reality, the 
steps extend all the way to the outside edges of the handrails.

 4. Use the Box tool and Object Snap Tracking or the Apparent Intersection 
osnap to draw the four steps. Give each box a height of –1 5⁄8″ (–41 mm).

 5. Switch back to the Conceptual visual style.
Your steps should look like those shown in Figure 16.58.

F I G u R E   1 6 . 5 8 :   The front deck steps before setting their elevations

 6. Move the step farthest from the deck 24″ (609 mm) in the negative Z 
direction, the second 16″ (406 mm), and the third one 8″ (203 mm).

The top step remains flush with the top of the deck.

 7. To draw a polyline that you’ll extrude to become the stringer (the 
support for the steps), you’ll use a 3D Polyline (see Figure 16.59). 
Follow these steps:

 a. Click the 3D Polyline (3DPOLY) button in the Draw panel.
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 b. Using the Object Snap Tracking tool, start the polyline 8″ (203 
mm) below the back of the top step.

 c. Use the Endpoint object snap to continue drawing the stringer 
in a clockwise direction; snap to the corner of the top step.

 d. Follow the bottom and back edges of the steps until you reach 
the front of the bottom step.

 e. Continue the polyline in the negative Z direction 8″ (203 mm) 
and then in the negative X direction 8″ (203 mm).

 f. Enter C↵ to close the polyline.

Start here.

Follow these edges.

8"

8"

8"

F I G u R E   1 6 . 5 9 :   Drawing the stringer

 8. Extrude the stringer 2″ (51 mm), and move it 2″ (51 mm) in the posi-
tive Y direction so that it’s tucked under the steps a bit.

 9. Copy or mirror the stringer to the opposite side of the steps.
The completed steps should look like those shown in Figure 16.60.
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F I G u R E   1 6 . 6 0 :   The completed steps

 10. Save your drawing as I16-15-DeckSteps.dwg (M16-15-DeckSteps.dwg).

Creating the Stair Handrails

To create the handrails for the stairs, you’ll first draw the vertical posts, create 
a box at the end of one of one of them, and then rotate it into place. Using the 
Dynamic UCS tool will ensure that the box is created in the correct orientation.

 1. Continue using I16-15-DeckSteps.dwg (M16-15-DeckSteps.dwg), or 
open it if it’s not already open.

 2. Zoom in to the top of the stairs, and draw a box 3′-9″ (1143 mm) tall, 
using the rectangle at the end of the railing to define the footprint.

 3. Click the Allow/Disallow Dynamic UCS button in the status bar to 
turn it on.
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 4. Start the BOX command.

 5. Pick a point on the front surface of the post, and then specify a 2″ × 2″ 
(51 mm × 51 mm) base and a 4′-6″ (1372 mm) height for the box.

The box is created perpendicular to the front surface of the post.

 6. Move the handrail so that it is centered on the post and 1″ (25 mm) 
from the top, as shown in Figure 16.61.

F I G u R E   1 6 . 6 1 :   The box drawn perpendicular to the post

 7. Start the 3D Rotate tool on the Modify panel of the Home tab, and 
select the handrail.

 8. At the Specify base point: prompt, pick the midpoint of the hand-
rail where it meets the post.

 9. At the Pick rotation axis: prompt, click the green y-axis ring. 
Then, at the Specify angle start point or type an angle: 
prompt, enter -39↵ as shown in Figure 16.62.
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F I G u R E   1 6 . 6 2 :   Rotating the handrail into place

The handrail rotates into place.
The last items to build for this handrail are the 1″ (25 mm) posts 

that support it.

 10. Copy one of the cylindrical railing posts you drew earlier, and space it 
evenly on the top step, centered under the handrail.

 11. Using the grips, adjust the height of each post so that each ends 
inside the handrail.

t I P  W h e n c o py i n g t h e r a i l -
ing post, tr y using the Center osnap 
to acquire the bot tom center point. 
To ensure that the pos t is  properly 
centered under the top railing post, 
use the Mid Between 2 Points osnap, 
and pick the front intersection of the 
2D railing post line and the midpoint 
of the outer edge of the 3D step, as 
shown here.

2. Pick this midpoint.

1. Pick this intersection.

www.MouradEngineering.com



 C r e a t i n g  t h e  F l o o r ,  F o u n d a t i o n ,  a n d  T h r e s h o l d s  9 0 9

 12. Using the endpoints of the steps as a reference, copy the posts to the 
other steps and then copy the handrail and posts to the opposite side 
of the steps.

When you are finished, the completed steps should look like 
Figure 16.63.

F I G u R E   1 6 . 6 3 :   The completed steps

 13. Save your drawing as I16-16-Handrails.dwg (M16-16-Handrails.dwg).
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Adding the Skirt

The final piece to add to the deck is a skirt, a linear member that acts as a con-
nection surface for the structure and a visual shield so that the residents can’t 
see under the deck. With the modeling skills and experience that you picked up 
in the previous chapter, this should be a quick fix; you’ll just build a skirt around 
the three open sides of the decks to obscure the underside. Here’s how:

 1. Continue using I16-16-Handrails.dwg (M16-16-Handrails.dwg), or 
open it if it’s not already open.

 2. Switch to the Wireframe visual style, and make sure that the 
Endpoint running osnap is active.

 3. Make the A-DECK-3DOB layer current.

 4. Draw a 2″ ×6″ (51 mm × 153 mm) box on the side and front of the 
deck, just below the surface, as shown in Figure 16.64.

Draw this box. Draw this box.

F I G u R E   1 6 . 6 4 :   The 2″ × 6″ skirt added below the deck

Use your preferred visual style to draw the boxes. For clarity, 
Figure 16.65 uses the Conceptual visual style. The boxes should span 
the distance from the foundation to the support post and between the 
support posts, respectively.
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F I G u R E   1 6 . 6 5 :   The completed front deck

 5. Copy the shorter box to the opposite side of the deck.

 6. Change the visual style back to Conceptual, and your completed deck 
should look like Figure 16.65.

 7. Save your drawing as I16-17-DeckSkirt.dwg (M16-17-DeckSkirt.dwg).

Mirroring the Front Deck

Because the front deck is similar to the back deck, you can mirror all the objects 
that you’ve already worked hard to create, to the back of the cabin, similar to the 
way you did in the 2D section of the book. After the objects are in place, you can 
edit them to meet the design criteria. Follow these steps to mirror the deck:

 1. Continue using I16-17-DeckSkirt.dwg (M16-17-DeckSkirt.dwg), or 
open it if it’s not already open.

 2. Freeze all the layers except A-DECK-3DOB and A-DECK-STRS-3DOB. 
Then thaw the A-WALL layer.

 3. Click the face labeled TOP in the ViewCube to switch to a plan view of 
the cabin.
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 4. In the Layer Properties Manager, click the open lock icon in the Lock 
column next to A-WALL so that objects on the A-WALL layer can’t be 
selected or modified.

 5. Select all the deck and step objects.

 6. Click the Mirror tool in the expanded Modify panel on the Home tab.

 7. For the first point of the mirror line, select the midpoint of the long 
outside wall on the north side of the cabin, the wall that has the 
closet attached to the inside of it.

 8. For the second point, pick a point directly to the right.

 9. Press ↵ to accept the default option not to delete the original objects 
(see Figure 16.66).

F I G u R E   1 6 . 6 6 :   Mirroring the front deck

t I P  If the length of the cabin is displayed vertically, rather than horizontally, 
click the counterclockwise-facing arrow () in the top-right corner of the ViewCube. This 
will rotate your current view 90˚ around the z-axis, giving your plan a more familiar 
orientation.

 10. Thaw and lock the A-DECK layer. Then zoom in to the back deck.

 11. Change to the Wireframe visual style.
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 12. Delete any of the handrail posts that exist between the 8″ (204 mm) 
3D support posts and the 8″ (204 mm) 2D support posts on both sides 
of the deck (see Figure 16.67).

3D Post Delete these posts on both sides of the deck.

2D Post

F I G u R E   1 6 . 6 7 :   Delete the posts shown.

 13. Click the Move tool from the Home tab ➢ Modify panel, and drag a 
crossing window—dragging from right to left around the front of the 
deck and the stairs, as shown in Figure 16.68.

Click here for the 
�rst move point.

The Selection Window 

Click here for the 
second move point.

F I G u R E   1 6 . 6 8 :   Moving the deck to make it narrower
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 14. Move the deck 4′-0″ (1220 mm) in the X direction to fit the narrower 
rear deck’s size. The floor, railings, and skirt project into the cabin, 
and they will be corrected in the coming steps.

 15. Select the deck floor, horizontal railing, and horizontal skirts. Then, 
using the triangular grips, move their right ends 4′ (1220 mm) to the 
left so that they extend only to the back wall of the cabin.

Figure 16.69 shows the back of the cabin after adjusting the 
features.

F I G u R E   1 6 . 6 9 :   The rear deck after adjusting the handrails, skirts, and deck 
floor

 16. Delete the 3/4″ (20 mm) handrail posts in the vertical row on the 
north side of the 3D steps between the 4″ (102 mm) 3D vertical post 
and the 4″ (102 mm) 2D vertical post (see Figure 16.70).
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Delete these posts.

Selection Window

Add new posts here.

Click here for the
second move point.

Click here for the
�rst move point.

F I G u R E   1 6 . 7 0 :   Moving the deck to make it narrower

 17. So that you don’t accidentally move the deck surface, select the deck 
and then click the Isolate Objects button in the lower-right corner of the 
Application window to choose Hide Objects from the menu that opens.

The Isolate Objects icon glows blue to indicate that an object isola-
tion is active.

 18. Using the MOVE command, move the steps into place, as shown in 
Figure 16.70.

 19. Add any new posts that are required on the south side of the steps.

 20. Use the triangular grips to adjust the lengths of the railings as 
required.

 21. Click the red lightbulb in the lower-right corner of the Application 
window, and choose End Object Isolation.
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 22. Change to the Conceptual visual style, and drag the ViewCube to get 
a good look at the new deck. It should look like Figure 16.71.

F I G u R E   1 6 . 7 1 :   The completed back deck

 23. Save your drawing as I16-18-BackDeck.dwg (M16-18-BackDeck.dwg).

Putting a Roof on the Cabin
You’ll finish the 3D model of the cabin by constructing a roof. The surface of the 
roof will be a different color from the roof structure, so you’ll make them as two 
separate objects, each on its own layer. Both objects will be extruded from the east 
elevation, and you’ll use the Subtract Boolean function to cut the roof in the areas 
where it doesn’t project as far as it does over the pop-out. Follow these steps:

 1. Continue using I16-18-BackDeck.dwg (M16-18-BackDeck.dwg), or 
open it if it’s not already open.
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 2. Create two new layers: A-ROOF-3DOB with color 32 and A-ROOF-
DECK-3DOB with color 114. Make A-ROOF-3DOB current.

 3. Thaw the A-WALL-EXTR-3DOB and A-ROOF layers.

 4. Also thaw all layers beginning with A-ELEV except for those with a 
-PATT or -BNDY suffix.

 5. Click the Top face of the ViewCube to change the view orienta-
tion of your drawing, and then zoom in to your east elevation (see 
Figure 16.72).

F I G u R E   1 6 . 7 2 :   The east elevation

The east elevation is the one that displays the sliding glass door; 
it is found in the upper-right portion of the drawing file provided in 
this chapter’s download.
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 6. Use the Endpoint osnap, and carefully draw a closed polyline around 
the thin roof surface.

Make sure that the pline follows both the inner and outer surfaces 
of the roof covering and extends to the limits of the pop-out. There 
should be a total of six picks and then the Close option.

 7. Make the A-ROOF-DECK-3DOB layer current, and then draw a closed 
polyline around the perimeter of the roof deck in the east elevation.

 8. Pick the southeastern corner of the ViewCube to change to an iso-
metric view of your drawing. Zoom back in to the east elevation.

The two roof polylines you just created by using the east elevation 
as a template are still in the 2D drawing plane. You’ll use the 3DALIGN 
command to orient these polylines with the 3D model of your cabin.

 9. Choose the 3D Align tool from the Modify panel of the Home tab.

 10. At the Select objects: prompt, choose the two polylines you drew 
in steps 4 and 7.

The 3DALIGN command will change the orientation of the selected 
objects from one plane to another. To do this, you must select the 
axis defining the source plane and, finally, the destination plane.

To define the source plane, you’ll need to select three points: the 
base point, a second point, and a third point.

 11. Select these points, as shown in Figure 16.73.

Select any point
along this line as
the second point.

Base Point

Select any point
along this line as
the third point.

F I G u R E   1 6 . 7 3 :   Defining the source plane from the east elevation
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 12. Without exiting the 3DALIGN command, zoom in to the left deck col-
umn on the east side of your cabin, as shown in Figure 16.74.

Base Point
Second Point

Third Point

F I G u R E   1 6 . 7 4 :   Defining the destination plane within the 3D model

 13. To define the destination plane, select the base, second, and third 
points, as shown in Figure 16.74.

 14. Zoom out so that the entire eastern side of your cabin is viewable.
Your model should look like Figure 16.75.

F I G u R E   1 6 . 7 5 :   Eastern edge of the 3D model after aligning the roof 
polylines to the model
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 15. Use the Extrude tool to extrude the two polylines that you just drew 43′ 
(13,110 mm).

 16. Move the extruded roof 1′-6″ (457 mm) along the positive x-axis.
When finished, your cabin should resemble the one shown in 

Figure 16.76.

F I G u R E   1 6 . 7 6 :   The eastern side of the cabin with extruded roof polylines 
correctly aligned

 17. The Extrude tool creates the extrusion in the current layer, so select 
the thinner of the two extrusions and move it to the A-ROOF-SURF-
3DOB layer by using the Properties palette.

 18. Save your drawing as I16-19-CabinRoof.dwg (M16-19-CabinRoof.dwg).
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Adjusting the Cabin Walls

The cabin walls were drawn with a constant height. In this section, you’ll cre-
ate the peaks at the front and back of the cabin to accommodate the roof. To 
accomplish this, you will add segmentation to the top of the walls by using the 
Slice tool and then move the new edges in the z-axis. Here’s how:

 1. Continue using I16-19-CabinRoof.dwg (M16-19-CabinRoof.dwg), or 
open it if it’s not already open.

 2. Freeze the A-DECK-3DOB, A-DECK-STRS-3DOB, A-ROOF-3DOB, 
and A-ROOF-DECK-3DOB layers.

 3. Click the Slice button on the Solid Editing panel of the Home tab to 
start the SLICE command.

 4. At the Select objects to slice: prompt, pick the exterior walls.
The Slice tool uses a plane with an infinite depth to cut the 

selected objects, so you need two points to define the plane.

 5. At the Specify start point of slicing plane or: prompt, use 
the Midpoint osnap to pick the midpoint of the top of the front wall, 
as shown in the left image of Figure 16.77.

F I G u R E   1 6 . 7 7 :   Selecting the first Slice point (left) and selecting the second 
Slice point (right)

 6. At the Specify second point on plane: prompt, pick the mid-
point of the top of the back wall, as shown in the right image of 
Figure 16.77.
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The Slice tool can display both sides of the sliced object or it can 
delete one of the sides. In this case, you want to keep both sides.

 7. At the Specify a point on desired side or [keep Both sides]: 
prompt, press ↵ or enter B↵ to retain both sides.

The new edges appear on the walls (see Figure 16.78), and there are 
now two sets of exterior walls: one on the south side of the cabin and 
one on the north. Notice that the slice is centered on the wall, but 
not centered over the doorway.

F I G u R E   1 6 . 7 8 :   The new edges created with the Slice tool

Just as you were able to edit the size of a box object by dragging its 
grips, you can do the same with nonprimitive objects. The grips are 
available at the edges, faces, and vertices—the points where two or more 
edges end. You access the subobjects by holding down the Ctrl key and 
clicking the grip location. The grips won’t appear until you click.

 8. Zoom in to the newly sliced area on the front wall. Hold the Ctrl key 
down, and click the middle of the top edge.

The small, rectangular, red edge grip appears as shown in Figure 16.79.
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Edge Grip

F I G u R E   1 6 . 7 9 :   Exposing the edge grip

 9. Click the grip, and enter @0,0,8'2-1/4↵ (@0,0,2496) to move the 
edge 8′-2 1/4″ (2496 mm) along the z-axis.

The faces bound by the edge are adjusted accordingly and form 
one-half of the peak, as shown in Figure 16.80.

F I G u R E   1 6 . 8 0 :   Creating half of the peak
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 10. Adjust the edge on the other side of the front wall in the same 
manner.

 11. Zoom out, and you’ll see that adjusting one end of the sliced object 
adjusted the other and that the peak is already constructed at the 
back of the cabin (see Figure 16.81).

F I G u R E   1 6 . 8 1 :   Both peaks are completed.

 12. Thaw all of the A-ROOF layers: A-ROOF, A-ROOF-3DOB, and 
A-ROOF-DECK-3DOB.

Using the ViewCube to look around the model, you can see that the 
northern walls and roof are largely okay. However, your walls are pro-
truding out of the roof, along the southern edge of your cabin (see 
Figure 16.82).

www.MouradEngineering.com



 C r e a t i n g  t h e  F l o o r ,  F o u n d a t i o n ,  a n d  T h r e s h o l d s  9 2 5

F I G u R E   1 6 . 8 2 :   The cabin model with the roof and extended walls displayed

 13. Save your drawing as I16-20-WallPeaks.dwg (M16-20-WallPeaks.dwg).

tweaking the Roof and Walls

As you can see, the walls poke through the roof on the south side of the cabin, 
and you still need to modify the roof so that it projects out only over the pop-
out. You’ll do these tasks by using the subobject grips and Boolean tools.

 1. Continue using I16-20-WallPeaks.dwg (M16-20-WallPeaks.dwg), or 
open it if it’s not already open.

 2. Use the ViewCube to rotate the view so that you can see the roof that 
covers the pop-out.

 3. Make sure Dynamic UCS is turned on and Endpoint osnaps are 
running.

 4. Start the BOX command.

 5. Create a box, starting at the southeast corner of the roof, with a foot-
print that is 3′-4″ (1016 mm) wide and that extends to a point 1′-6″ 
(457 mm) from the pop-out.
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 6. Give the box some height, and then repeat the process on the oppo-
site side of the pop-out, as shown in Figure 16.83.

F I G u R E   1 6 . 8 3 :   The boxes to be used to subtract the roof

The Dynamic UCS tool creates the boxes aligned to the roof.

 7. Use the grips to extend the outside edges of the boxes beyond the 
edges of the roof (see Figure 16.84).

F I G u R E   1 6 . 8 4 :   Extend the outside edges of the boxes.
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 8. Move the boxes so that they protrude through the roof, using the 
endpoint of one edge as the first point of displacement and the mid-
point of the same edge as the second.

When you’re finished, the model should look similar to the one 
shown in Figure 16.85.

F I G u R E   1 6 . 8 5 :   Move the boxes so that they protrude through the roof.

 9. If you subtract both roof objects at the same time, the resultant roof 
object will be a single entity. Use this procedure to cut the boxes out 
of the roof:

 a. Copy the boxes in-place by using the same point as the base point 
and the displacement. This can be done by pressing ↵ at the 
Specify base point: and Specify displacement: prompts.

 b. Select the roof surface, and subtract one set of boxes from it.

 c. Select the roof deck, and subtract the second set of boxes from it.

When you are finished, the roof should look like Figure 16.86.

F I G u R E   1 6 . 8 6 :   The roof after subtracting the boxes

www.MouradEngineering.com



9 2 8 	 C h a p t e r 	 16 	 • 	 C r e a t i n g 	 3D 	G e ome t r y

 10. Hold the Ctrl key down, and click the middle of the outer wall of the 
pop-out.

You may have trouble selecting the proper edge when both of the 
adjacent faces are visible. If you encounter a problem, try selecting 
the edge from a northeastern viewpoint.

 11. Turn on Ortho mode. Then move the edge downward, below the 
surface of the roof.

Figure 16.87 shows the edge being moved from a northeastern 
viewpoint.

F I G u R E   1 6 . 8 7 :   Adjusting the pop-out walls

 12. Freeze and unlock all the 2D layers (including those with an A-ELEV 
prefix), and thaw the 3D layers (with a -3DOB suffix).

 13. Drag the ViewCube to change to an isometric view, and then adjust 
the height of the roof support posts so that they extend into the roof 
deck but not through the roof surface (see Figure 16.88).

Your completed cabin should look like Figure 16.89.

 14. Save your file as I16-21-RoofWallFinishing.dwg (I16-21-
RoofWallFinishing.dwg).
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F I G u R E   1 6 . 8 8 :   Adjusting the height of the roof support posts

F I G u R E   1 6 . 8 9 :   The completed cabin
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Getting Further Directions in 3D
Covering 3D in depth is beyond the scope of this book, but I can mention a few 
other tools and features that you might enjoy investigating. In this chapter, I’ll 
summarize a few of the solid- and surface-modeling tools that I didn’t cover in 
the tutorial on the cabin. In the next chapter, I’ll cover the rendering process as 
it’s approached in AutoCAD.

using other Solid-Modeling tools
You used the box primitive to build the block-outs for the cabin walls, and the cyl-
inder primitive for the railing posts. AutoCAD has several other primitive shapes, 
and all are found on the flyout menu on the left edge of the Modeling panel. Six are 
described here. You can also see a description of the creation procedure, as shown 
in Figure 16.90, by pausing the cursor over any primitive option. 

F I G u R E   1 6 . 9 0 :   The other 3D primitives and the extended tooltip for the cone

Box  Similar to the RECTANG command, you begin the BOX command by speci-
fying a rectangular base. The command completes by specifying the height.
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Cylinder  Starting with a circular base, you specify the radius or diameter, and 
complete the command by entering the height.

Cone  You specify the center point of the base, the radius of the base, and the 
height of the pointed tip. The base is parallel to the xy-plane, and the height is 
perpendicular to it. You can choose for the cone to be elliptical and for the top 
to be flat instead of pointed.

Sphere  You specify the center point and the radius or diameter.

Pyramid  The pyramid primitive is similar to the cone primitive, but it can 
have up to 32 flat sides, rather than a curved side.

Wedge  The wedge has a rectangular base and a lid that slopes up from one 
edge of the base. You specify the base as you do with the box primitive and then 
enter the height.

torus  This is a donut shape. You specify a center point for the hole—the 
radius of the circular path that the donut makes, and the radius of the tube that 
follows the circular path around the center point.

The other tools on the Modeling panel are for creating additional 3D solids, 
manipulating existing 3D shapes, or using 2D shapes as components for making 
3D shapes. You’ve already used some of these tools, and I’ll cover the others here:

Planar Surface  Found exclusively on the Surface Ribbon tab ➢ Create panel, 
the Planar Surface tool creates a flat, rectangular surface that is segmented in 
both directions. The segments are visible only when the object is selected or in a 
Wireframe visual style (see Figure 16.91).

F I G u R E   1 6 . 9 1 :   A Planar surface
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Revolve  Select a closed 2D shape, and then define the axis and the angle of 
rotation. A Revolve object is shown on the left in Figure 16.92.

F I G u R E   1 6 . 9 2 :   A Revolve object (left) and a Sweep object (right)

Sweep  Similar to the Extrude tool, the Sweep tool extrudes a 2D shape along a 
path to create a 3D shape. A Sweep object is shown on the right in Figure 16.92.

Loft  Similar to the Extrude and Sweep tools, the Loft tool extrudes a 2D shape 
along a path, but it allows you to change cross sections along the path.

Press/Pull  The Press/Pull tool creates a 3D object by extruding the perimeter 
of an area surrounded by a closed boundary. The left image in Figure 16.93 
shows the closed area, and the right image shows the resultant object. The 
boundary does not have to be a polyline; it can simply be a conglomeration of 
any objects that combine to define an open area.

F I G u R E   1 6 . 9 3 :   An enclosed area (left) and the result of using the Press/Pull tool (right)
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Helix  Located on the Home Ribbon tab ➢ Draw panel, a Helix object is a 2D 
or 3D spiral (see Figure 16.94). When you use it in conjunction with the Sweep 
tool, you can create springs, corkscrews, coils, and so forth.

F I G u R E   1 6 . 9 4 :   A helix extending in the Z direction

There are two other Boolean tools for modifying solids. When you formed the 
cabin walls, you used the Subtract tool as well as Slice. Two other solids-editing 
tools, Union and Intersect, create an object based on two overlapping objects:

union  Joins the two objects and eliminates any internal edges

Intersect  Finds the volume that two solids have in common and retains that 
volume while deleting the other portions of the objects

This is only a brief introduction to the tools used for creating and modifying 
solids, but it should be enough to get you started.

using Mesh-Modeling tools
In addition to the solid objects available in AutoCAD, a set of tools is available to 
create mesh models. Unlike solids, meshes can’t be easily manipulated and do 
not have a true volume, just faces that surround an empty area. For example, 
imagine this book next to a cellophane wrapper having the same dimensions. 
The book would be a solid, and the wrapper would be a mesh.

The following list describes a few of the mesh tools found on the Mesh Ribbon 
tab (see Figure 16.95).
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Edge Mesh

Ruled Mesh

Tabulated MeshRevolved Mesh

F I G u R E   1 6 . 9 5 :   AutoCAD’s mesh-modeling tools

Revolved Mesh  Creates a 3D surface mesh by rotating a 2D curved line 
around an axis of revolution.

tabulated Mesh  Creates a 3D surface mesh by extruding a 2D object in a 
direction determined by the endpoints of a line, an arc, or a polyline.

Ruled Mesh  Creates a 3D surface mesh between two selected shapes.

Edge Mesh  Creates a 3D surface mesh among four lines that are connected at 
their endpoints. Each line can be in 2D or 3D, and the original shape must be a 
boundary of a shape that doesn’t cross or conflict with itself.

Most 3D models today use the solid-modeling tools for their basic shapes 
because the tools for adding, subtracting, slicing, and so forth are easy to use 
and allow complex shapes to be fabricated quickly. Still, mesh-modeling, legacy 
tools retained from AutoCAD’s initial foray into 3D have their uses. Any serious 
3D modeler will be familiar with both sets of tools.
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using Surface-Modeling tools
The surface-modeling tools share some similarities with both the solid- and 
mesh-modeling tools already discussed. Surfaces are like meshes in that they do 
not have a true volume; the cellophane wrapper analogy also applies to surfaces. 
On the other hand, you’ll notice that a number of tools appear on both the Solid 
and Surface Ribbon tabs.

Tools such as Loft, Sweep, Extrude, and Revolve are found on both tabs, and 
they are nearly identical in both contexts. The core difference between the two 
types is the 3D object created. When these tools are used from the Solid tab, 
they create solid objects, with volume and mass. Using these same tools from 
the Surface tab will create a skeleton object, a cellophane wrapper, with neither 
volume nor mass.

Figure 16.96 shows two boxes, each created using the Extrude tool. The box 
on the left was created using the Extrude tool found on the Solid tab, and it is 
a solid box with a top, bottom, and sides. By comparison, the box on the right 
was created using the Extrude tool found on the Surface tab. Notice how it lacks 
both a top and a bottom, but each of its four sides is constructed with smaller 
rectangles. This grid structure is more easily manipulated into complex shapes, 
something that’s much harder to do using solid objects.

F I G u R E   1 6 . 9 6 :   Rectangles extruded with the Extrude tool on the Solid tab (left) and the 
Extrude tool on the Surface tab (right)

Surfaces can be created by using any of the tools shown in Figure 16.97, and 
described in the following list.
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Network Loft

Loft

O�set

Patch

F I G u R E   1 6 . 9 7 :   AutoCAD’s surface-modeling tools

network  Creates a 3D surface between several curves, other 3D surfaces, or 
solids in the U and V directions

Loft  Creates a 3D surface between several 2D cross sections

Sweep  Creates a 3D surface along a path, similar to the Solid Sweep tool 
shown earlier in Figure 16.92

Planar  Creates a flat surface between several coplanar objects

Extrude  Creates a 3D surface from a 2D or 3D line, curve, or polyline

Revolve  Creates a 3D surface by rotating a 2D line or curve around an axis

Blend  Creates a continuous 3D surface between two existing surfaces

Patch  Creates a 3D surface to close or cap an existing 3D surface

offset  Creates a 3D surface parallel to an existing 3D surface
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If You Would Like More Practice…
Creating 3D models is a highly effective way to communicate designs with 
groups of people who may not otherwise know how to read engineering plans. 
For more practice modeling in 3D, you can try the following:

▶▶ Model the kitchen cabinets and appliances.

▶▶ Add a small window to the back door.

▶▶ Create mullions for each of your windows.

Are You Experienced?

now you can…

✔✔ change visual styles

✔✔ create	linear	3D	objects	with	the	Polysolid	tool

✔✔ use 3D solid, mesh, and surface tools to generate 3D models

✔✔ extrude 2D shapes into 3D geometry

✔✔ cut	holes	in	objects	by	using	the	Subtract	Boolean	tool

✔✔ resize	3D	objects	by	using	grips

✔✔ create 3D surfaces

✔✔ navigate in a 3D scene
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CHAPtER 17

Rendering and 
Materials
After developing a 3D model, you’ll usually want to apply materials and 
render it to get a better feel for the substance of the project so that you can 
produce a clearer presentation for clients.

In this chapter, I’ll give you a quick tour of some of these rendering steps 
as you set up a view of the cabin and render it. Developing a full rendering 
takes time and patience, but touching on a few of the many steps involved 
will give you a feel for the process. You’ve put in a lot of time working your 
way through this book, and you deserve to have a rendered 3D view of your 
cabin to complete the process. Be aware, however, that rendering is compu-
tationally intensive and can task your computer pretty heavily. It’s a good 
rule to save your file prior to each rendering attempt.

In this chapter, you will learn to

▶▶ Use the Loft tool

▶▶ Create cameras to reproduce views

▶▶ Create a lighting scheme

▶▶ Enable	and	control	shadow	effects

▶▶ Choose	the	background

▶▶ Assign materials to surfaces

▶▶ Adjust	mapping	and	tiling

▶▶ Save	setup	views	and	lights	as	restorable	scenes

▶▶ Render and output to a file
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Creating Cameras to Reproduce Views
Similar to saving named views in Chapter 10, “Generating Elevations,” using 
cameras is a method for returning to a saved viewpoint. The most significant 
advantage of cameras is the ability to select the camera object and change its 
position or orientation, rather than panning or zooming in the drawing area. 
Cameras can also be animated to show your model from a variety of locations. 
Before you place the cameras, however, you’ll create some land on which your 
cabin will sit so that it no longer appears to be floating in the air.

using the Loft tool
The Loft tool builds 3D geometry in one of three ways: by connecting a series of 
2D shapes, called contour lines, with 3D surfaces; by extruding a cross section 
along a path; or by controlling the transition between two cross sections with 
2D guide curves. You’ll use the first method to create a loft object to serve as the 
land by drawing concentric 3D polylines, converting them to splines, changing 
their elevations, and then lofting them. Follow these steps:

 1. With I16C-SPLAYO.dwg (M16C-SPLAYO.dwg) as the current drawing, 
change to the Wireframe visual style with the in-canvas viewport 
controls, and zoom in to the cabin.

 2. Make a new layer named C-TOPO-3DOB, assign it color 94, and set it 
as the current layer.

 3. Freeze all the other layers except A-DECK-STRS-3DOB and 
A-FNDN-3DOB.

 4. Start the Rectangle (RECTANG) command, and draw a closed polyline 
around the perimeter of the base of the foundation, as shown in 
Figure 17.1.
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Draw the �rst
3D polyline here.

Draw the second
3D polyline here.

F I G u R E   1 7 . 1 :   Draw the first two 3D polylines around the cabin. 

 5. Use the Endpoint osnap to snap to opposite vertices at the bottom 
corners of the foundation.

 6. Use the Polyline (PLINE) command to draw another closed polyline 
around the concrete support posts, snapping the outside corner of 
each, and the outside corners of the stringers (see Figure 17.1).

You can pick an interim point between each of the long sides of the 
cabin to break up the perimeter. These are the first two contour lines.

 7. Switch to the Insert tab, and then choose the Insert tool found on the 
Block panel to insert the I17-PropBndy.dwg (M17-PropBndy.dwg) file.

 8. Insert the drawing by using the 0,0,0 insertion point, a uniform scale 
of 1, and a rotation of 0 degrees.

 9. Finally, be sure that the Explode check box is selected in the lower-
left corner of the Insert dialog box.

◀

Because each contour 
you’ll draw will have 
a constant elevation, 
you’ll use a standard 
polyline instead of a 
3D polyline. Standard 
polylines can have 
only a single elevation, 
whereas 3D poly-
lines can have many 
elevations.
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If you haven’t already downloaded the dataset for this chapter, 
visit the book’s web page at www.sybex.com/go/autocad2015ner 
or www.thecadgeek.com to access the Chapter 17 download, which 
includes the I17-PropBndy.dwg (M17-PropBndy.dwg) file.

 10. Turn off Ortho mode or Object Tracking if they are on; then click the 
Top face of the ViewCube® to switch to a top view.

 11. Continue using the PLINE command to draw two more oddly shaped, 
closed polylines between the cabin and the property line.

 12. Change the layer of the inserted property line to the C-TOPO-3DOB 
layer (see Figure 17.2).

F I G u R E   1 7 . 2 :   Draw two more polylines between the cabin and the  
property line.

 13. Click the Edit Polyline button from the extended Modify panel on the 
Home tab, or enter PEDIT↵. Enter M↵ to choose the Multiple option.

 14. Select the two polylines between the cabin and the property line.

 15. Click the Spline option in the context menu, as shown in Figure 17.3, 
to change the polylines into curved splines and then click ↵.
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F I G u R E   1 7 . 3 :   Select Spline from the context menu.

The last three contour lines you drew are at the same level as the top of the 
foundation. You need to move them downward to define the slope of the prop-
erty away from the cabin:

 1. Switch to an isometric view by selecting a corner of the ViewCube.

 2. Use the 3D Move (3DMOVE) tool on the Home tab ➢ Modify panel 
and then move the spline closest to the cabin foundation down 3′-6″ 
(1070 mm) in the negative Z direction.

 3. Repeat the 3DMOVE command, moving the spline closest to the prop-
erty line down 4′-4″ (1320 mm) and then moving the polyline that 
follows the property line down 5′-4″ (1625 mm).

This should provide a gentle slope for the land.

 4. Select the Front or Left face of the ViewCube to view your model 
from the side, and verify that each of the contours is lower than the 
previous (see Figure 17.4).

F I G u R E   1 7 . 4 :   The contour lines as viewed from the side

 5. Switch back to an isometric view, freezing all layers except 
C-TOPO-3DOB.

 6. Click the Loft button in the Modeling panel on the Home tab.
It may be hidden under the Extrude button.

◀

A spline is a curved line 
with control points 
for adjusting the 
curvature.
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 7. At the Select cross sections in lofting order or: prompt, 
select MOde, or enter MO↵ to set the creation mode.

 8. Choose Surface by entering SU↵.
The creation mode is changed to Surface, and the command line 

once again reads Select cross sections in lofting order or:.
It’s important to pick the cross sections for a lofted surface in 

order; otherwise, the surface may not generate as expected.

 9. Press ↵ after you’ve selected each of the cross sections to advance 
through the LOFT command.

Select the outermost polyline and then each subsequent spline or 
polyline in order, from outside to inside.

You can adjust how lofted surfaces are created by entering S↵ with 
the LOFT command still running.

 10. Verify that the Smooth Fit option is selected in the Loft Settings dia-
log box that opens, shown in Figure 17.5.

F I G u R E   1 7 . 5 :   The Loft Settings dialog box

Smooth Fit creates a soft transition from one contour to the next.
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 11. At the Enter an option: prompt, enter C↵ for the Cross Sections 
Only option.

 12. Click OK, and then change to the Conceptual visual style.
Your cabin land parcel should look similar to Figure 17.6.

F I G u R E   1 7 . 6 :   The completed cabin land

 13. Thaw all layers with a 3DOB suffix.

 14. Save your drawing as I17-01-LoftedSurface.dwg (M17-01-
LoftedSurface.dwg).

Creating the Cameras
Autodesk® AutoCAD® software uses a camera analogy to define reproducible 
views. The cameras and their respective targets are placed in model space and, 
using several available grips, are adjusted to capture the desired view. Follow 
these steps to create two cameras:

 1. Continue using I17-01-LoftedSurface.dwg (M17-01-
LoftedSurface.dwg), or open it if it’s not already open.

 2. Click the Visualize tab; then, on the Camera panel, click the Create 
Camera (CAMERA) button and move the cursor into the drawing area.

A camera icon appears at the cursor location.
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t I P  If you don’t see the Camera panel, right-click the title bar of any panel and 
choose Show Panels ➢ Camera from the context menu.

 3. Click near the edge of the land at a point southeast of the cabin, 
using the ViewCube as a guide, and then move the cursor again.

Now the camera stays in place, as shown in Figure 17.7, and the 
target is moved with the cursor. The location of the target deter-
mines the orientation of the camera, and the visible cone emitting 
from the camera shows the camera’s field of view (FOV), or the angle 
visible through the camera’s lens.

Field of 
cone view

Camera

Target

F I G u R E   1 7 . 7 :   Placing a camera into the drawing

 4. Turn off any running osnaps, and then click the middle of the deck to 
place the target.

The camera disappears temporarily while AutoCAD waits for input 
at the cursor and the command line.

 5. Enter N↵, or click Name, to activate the Name option.

 6. At the prompt, enter Cam Southeast↵.
The camera reappears in the drawing area.
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 7. Create another camera that views the cabin from the northwest cor-
ner of the property.

 8. Place the target at the middle of the cabin, and name this camera 
Cam Northwest.

 9. Use the ViewCube to change the current view to a viewpoint from the 
southeast and slightly above the cabin (see Figure 17.8).

F I G u R E   1 7 . 8 :   Viewing the cabin and cameras from above and to the 
southeast

 10. Select the Cam Southeast camera.
The Field of View cone and grips are displayed, and the Camera 

Preview dialog box opens. This dialog box displays the view from the 
camera in one of the available visual styles (see Figure 17.9). The 3D 
Wireframe visual style is the default and the one you will use here.

◀

You should always 
give your cameras 
descriptive names to 
make it easier to find 
the correct view when 
multiple cameras exist 
in a drawing. You can 
change the camera 
name in the Properties 
palette.
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F I G u R E   1 7 . 9 :   Selecting the camera displays its grips and the Camera Preview 
dialog box.

 11. Place your cursor over the grip at the center of the camera, and you 
will see a tooltip that reads Camera Location.

 12. While the camera is selected, a 3D gizmo displays at the camera’s 
origin. Click the z-axis (blue axis line), and then move the camera 5′ 
(1524 mm) up in the Z direction to about eye level.

You may need to click the grip again for the Camera Preview dialog 
box to refresh.

 13. Select the Camera Target grip, and move it 7′ (2130 mm) in the Z 
direction.

Raising the target brings the cabin more into the preview window.

 14. Press Esc to deselect the camera, and then select the Cam Northwest 
camera.

 15. Move the camera 30′ (9150 mm) in the Z direction to get a higher 
view of the structure.

 16. Next, adjust its view however you like by moving the square Target 
Location or triangular Lens Length/FOV grips.

 17. Select the View Controls menu from the in-canvas viewport controls, 
and then click Custom Model Views.
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Notice that the two cameras now appear in the list, as shown in 
the left image of Figure 17.10.

F I G u R E   1 7 . 1 0 :   The View Manager dialog box showing the two new cameras 
listed

Alternatively, the list of custom model views is accessible from the 
View Manager dialog box (see the right side of Figure 17.10). Open 
this dialog box from the View tab ➢ Views panel.

 18. Select Cam Southeast from the list, click the Set Current button, and 
then click OK.

Your drawing area changes to view the scene from the selected 
camera, as shown in Figure 17.11.

F I G u R E   1 7 . 1 1 :   The cabin as viewed through the Cam Southeast camera

 19. Save your drawing as I17-02-CreateCameras.dwg (M17-02-
CreateCameras.dwg).
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Creating a Lighting Scheme
Without a well-thought-out lighting scheme, the scene can look flat and unap-
pealing. In this section, you will add a light to represent the sun and then an 
additional light to add ambient illumination to the scene.

Creating a Light Source
AutoCAD has four kinds of lighting, each with a distinct method for distributing 
light rays into the scene. They are as follows:

Point Light  All light rays are emitted from a single location and diverge as 
they get farther away. An incandescent lightbulb is a real-world example of a 
point light, even though the light does not travel in the direction of the light’s 
fixture.

Spotlight  With this type of light, rays are emitted from a single point, but they 
are restricted to a conical portion of the amount of light that a similar point 
light would emit. Flashlights and headlights are examples.

Distant Light  With this type of light, all light rays are parallel. Although the 
sun is technically a point light, at the enormous distance the light rays travel to 
Earth, they are nearly parallel.

Weblight  These are photometric lights with real-world distributions. These 
lights can be used in conjunction with light distributions derived by manu-
facturers of real-world lights. Using manufacturer data to establish lighting 
distributions helps ensure more accurate representation of rendered lights than 
possible when using point or spotlights.

Each light type has a unique set of parameters. The sun is a special distant 
light and has its own settings, including determining the light’s position based 
on the geographic location of the scene, the date and time, and the ability to add 
ambient light to the drawing.

To add this type of light, you’ll use tools in the Visualize tab of the Ribbon:

 1. Continue using I17-02-CreateCameras.dwg (M17-02-
CreateCameras.dwg), or open it if it’s not already open.

 2. Use the in-canvas viewport controls to set the current view to Top.

 3. Click the Ribbon’s Visualize tab.
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 4. In the expanded Lights panel, make sure the Default Lighting option 
is turned off.

When it is off, the button will not have a blue background as the 
cursor pauses over it, and there will be no default illumination in the 
scene.

 5. In the Sun & Location panel of the Visualize tab, check the status of 
the Sun Status button.

Be sure that it’s toggled on by verifying that the button has a blue 
background.

 6. Click the Sun Properties button at the right end of the Sun & Location 
panel to open the Sun Properties palette, as shown in Figure 17.12.

F I G u R E   1 7 . 1 2 :   Set the date in the Sun Properties palette (left), and specify 
a date using the Calendar dialog (right).

 7. In the Sun Angle Calculator rollout, set the Date to 6/19/2014 and the 
Time to 3:00 PM (see Figure 17.12).

The date is set by clicking the button at the right end of the Date 
field and choosing from a calendar.

 8. In the Sun & Location panel on the Visualize tab of the Ribbon, click 
the Set Location ➢ From Map button.

◀

The palette may be 
docked on the side of 
the AutoCAD window.
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 9. The Geolocation - Live Map Data warning dialog box opens to dis-
play some basic information about the Live Map Data feature within 
AutoCAD. Click Yes to accept this information and continue.

The Geographic Location dialog box shown in Figure 17.13 lets you 
define the specific location for your project by using Live Map Data 
powered by Bing Maps.

F I G u R E   1 7 . 1 3 :   Designating a geographic location for the cabin project

 10. Enter 37.666,-77.504 in the Address text box, and press ↵ to search 
based on latitude and longitude.

The map zooms in to a location near the intersection of Mountain 
Road and Purcell Road (see Figure 17.13).

 11. Click the Drop Marker Here button to accept the location near the 
intersection of Mountain Road and Purcell Road. Click Next.

The Geographic Location - Set Coordinate System (Page 2 of 2) 
dialog box opens.
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 12. Choose VA83-SF (VA83-S) from the list of available coordinate sys-
tems within this dialog box (see Figure 17.14). Click Next.

F I G u R E   1 7 . 1 4 :   Designating a geographic coordinate system for the cabin 
project

 13. Press ↵ at the Select a point for the location: prompt to accept 
the default 0", 0", 0" (0, 0, 0) location.

 14. Turn on Ortho mode from the status bar, and pick a point to the 
north at the Specify the north direction of [Angle]<Angle>: 
prompt.

Once a geographic location and North direction are specified, 
AutoCAD will display aerial imagery for your project from Bing Maps, 
as shown in Figure 17.15.
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F I G u R E   1 7 . 1 5 :   Aerial imagery acquired based on geographic location

 15. The aerial imagery is not used in this exercise. To turn it off, click Map 
Aerial ➢ Map Off from the Online Map panel within the contextual 
Geolocation Ribbon tab.

 16. Save your drawing as I17-03-SetLocation.dwg (M17-03-
SetLocation.dwg).

Enabling Shadows
Shadows add depth and realism to a scene and tie the objects to the surfaces on 
or near where they rest. You have significant control over the types of shadows 
cast by the lights in the drawing and whether those shadows appear in the view-
ports. You adjust how the shadows appear in the viewport and how they render 
in the Visualize tab.

When shadows are turned on, AutoCAD will render them by using one of 
three methods: simple, sorted, or segment. The simple method is the default 
used by AutoCAD, and it calculates shadow shaders in random order. By con-
trast, the sorted and segment methods each calculate shadows in the order they 
are cast, and they produce higher-quality renderings at the cost of machine 
performance. Segment shadows will produce the highest-quality rendering, but 
they take the longest time to complete.
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To ensure that you’ll be able to work through this chapter’s exercises in a 
timely manner, we’ll stick to the simple method. While this method doesn’t per-
form the advanced calculations done by the sorted and segment methods, it still 
produces a detailed rendering without sacrificing system performance. Enable 
shadows in your scene by completing the following steps:

 1. Continue using I17-03-SetLocation.dwg (M17-03-SetLocation.dwg), 
or open it if it’s not already open.

 2. In the Lights panel, click the down arrow under the No Shadows 
icon and choose Full Shadows from the flyout menu, as shown in 
Figure 17.16.

F I G u R E   1 7 . 1 6 :   Choosing the Full Shadows option

This displays an approximation of the shadows in the viewport.

W A R n I n G  The Full Shadows option requires that your video card utilize 
hardware acceleration. See the Display Backgrounds And Shadows page of the AutoCAD 
2015 help file to determine whether your system is equipped with hardware acceleration.

 3. Click the Advanced Render Settings button on the right end of the 
Render panel’s title bar.

 4. In the Advanced Render Settings palette that appears, scroll down to 
the Shadows drop-down list and make sure that Mode is set to Simple 
and that Shadow Map is set to On (see Figure 17.17).
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F I G u R E   1 7 . 1 7 :   The Shadows settings in the Advanced Render Settings 
palette

 5. Close the Advanced Render Settings palette.

Creating the First Render
A rendering is the visual result of the program calculating the effects of the 
lights and materials on the surfaces in the drawing. Let’s make a preliminary 
render now. Later, you’ll add materials and a background and then render the 
drawing again.

 1. Click the Render button on the Render panel.
The Render window opens and, after a few moments, the rendering 

fills in the graphic area (see Figure 17.18). As you can see, the right 
side of the cabin is unlit and in total darkness.
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F I G u R E   1 7 . 1 8 :   The first cabin rendering in the Render window

 2. Click the Point button in the Lights panel (it may be hidden under 
another light button), and then click to place the light on the ground 
about 20′ (6100 mm) northeast of the front deck.

 3. Click the Name option in the context menu that appears at the cursor 
and give the light the name Northeast Ambient.

 4. Double-click the light to open its Properties palette, and make the 
following changes:

Shadows: Off

Intensity Factor: 60.000

Lamp Intensity: 15,000 Cd

Position Z: 30′ (9150)

◀

As with cameras, you 
should give your lights 
descriptive names.
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 5. Click the down arrow in the Filter Color field, and then choose Select 
Color as shown in Figure 17.19 right.

 6. In the Select Color dialog box that appears, change the Color Model 
to RGB, and enter 252, 250, 212 in the Color field, as shown in 
Figure 17.19 right.

F I G u R E   1 7 . 1 9 :   The properties for the point light

This gives the light a pale yellow hue.

 7. Click OK to close the Select Color dialog box, and close the Properties 
palette.

 8. Switch back to the Cam Southeast view if necessary, and render the 
scene again.

As you can see in Figure 17.20, this time the shadows on the right 
side of the cabin are not as stark as they were previously, but the over-
all appearance is still pretty dark. You need to add some ambient light.
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F I G u R E   1 7 . 2 0 :   The cabin rendering after adding the second light

 9. Open the Advanced Render Settings palette again, and then click 
the lightbulb icon next to Global Illumination in the Indirect 
Illumination drop-down list (see Figure 17.21).

F I G u R E   1 7 . 2 1 :   Turning on Global Illumination
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This will add a measure of ambient light to your scene without 
washing it out.

This rendering looks a bit better than the last. The Render window 
maintains a history of the recent renderings, and you can compare 
them by clicking any of the renderings listed in the pane at the bot-
tom of the Render window. To delete a rendering, follow these steps:

 a. Select it.

 b. Right-click it.

 c. Choose Remove From The List.
You can continue to tweak the lighting as you want. For indoor proj-

ects that require rendering, a good rule of thumb is to expect to dedi-
cate 15 to 25 percent of the total project time to creating an excellent 
lighting scheme. For outdoor scenes, dedicating 5 to 10 percent should 
be sufficient.

 10. Save your drawing as I17-04-FirstRender.dwg (M17-04-
FirstRender.dwg).

The building looks fine, but it would be nice to have something in the back-
ground other than the blank screen, and the lights need to be tweaked.

Controlling the Background of the Rendering
Some of the options you can set when choosing a background for the rendering 
are as follows:

the AutoCAD Background  You use this option for the preliminary rendering.

Another Solid Color  You use the slider bars to choose another solid color.

Gradient  You can use varying colors (usually light to dark) blended together.

Image  You can supply or choose a bitmap image.

Sun & Sky Background  You can use a computer-generated sky. This background 
has the option of introducing additional ambient illumination into the scene.
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You’ll use the Sun & Sky Background option with the Illumination option here:

 1. Continue using I17-04-FirstRender.dwg (M17-04-FirstRender.dwg), 
or open it if it’s not already open.

 2. Click the Home tab, click the 3D Navigation drop-down list on the 
View panel, and then choose View Manager at the bottom of the list 
to open the View Manager dialog box.

 3. Expand the Model Views entry, and then select Cam Southeast.

 4. Expand the drop-down list for the Background Override entry 
in the General rollout, and then choose Sun & Sky, as shown in 
Figure 17.22.

F I G u R E   1 7 . 2 2 :   The Cam Southeast camera selected in the View Manager 
dialog box

This selection opens the Adjust Sun & Sky Background dialog box, 
as shown in Figure 17.23.
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F I G u R E   1 7 . 2 3 :   The Adjust Sun & Sky Background dialog box

n o t E  The sky background options are available only when the lighting units 
are not set to generic. This is controlled by the LIGHTINGUNITS system variable. Enter 
LIGHTINGUNITS↵2↵ to set the lighting units to International. A setting of 1 sets the 
lighting units to American, and 0 sets them to generic units.

 5. In the Sky Properties rollout, change the Intensity Factor value to 3.

 6. Expand the Status drop-down list, and choose Sky Background And 
Illumination.

 7. Click OK to close the Adjust Sun & Sky Background dialog box.

 8. Click Set Current in the View Manager dialog box, and then click OK 
to close it.

 9. Open the Advanced Render Settings palette from the Visualize tab’s 
Render panel.

 10. Scroll down to the Final Gather rollout, and make sure Mode is set to 
Auto or On.

Background Illumination will not work if Final Gather Mode is 
set to Off.
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 11. Save your drawing as I17-05-RenderBackground.dwg (M17-05-
RenderBackground.dwg).

 12. Render the scene.

It will take a little longer to process this image, and you’ll notice that the 
image in the Render window is replaced twice—the first time with a very 
rough-looking representation of the cabin, and then again with a sharper result. 
When it is done, the display in your Render dialog box should look similar to 
Figure 17.24. The background image not only appears behind the cabin and 
ground, but it also contributes light to the scene.

F I G u R E   1 7 . 2 4 :   The cabin rendered with the Sun & Sky background and additional 
illumination

n o t E  Rendering is a processor-intensive function. It’s not uncommon to expe-
rience a lag in computer performance or to hear increased cooling fan activity while a 
rendering is in progress. To help speed up rendering time, you’re encouraged to leave 
AutoCAD as the current application and refrain from performing other tasks on your com-
puter if possible.
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Adding Materials
Adding the proper materials to a scene can greatly increase the realism of the 
drawing and convey a better sense of size and texture to the person viewing the 
image. This chapter assumes that you installed the material library that ships 
with AutoCAD 2015, along with the rest of the package.

You can assign materials to your drawing objects from several premade 
libraries, you can create materials from scratch, or you can edit materials that 
originate from the libraries. In this exercise, you will apply materials from the 
AutoCAD libraries:

 1. Continue using I17-05-RenderBackground.dwg (M17-05-
RenderBackground.dwg), or open it if it’s not already open.

 2. Click the Visualize tab, and then click the Materials Browser button 
in the Materials panel to open the Materials Browser palette shown in 
Figure 17.25.

F I G u R E   1 7 . 2 5 :   The Materials Browser palette
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The Materials Browser palette is divided into two primary areas:

Document Materials  The upper region of the Materials Browser 
palette displays the materials that have been loaded into your cur-
rent drawing. Above the name for each material, a small thumb-
nail preview of the material displays.

Libraries  AutoCAD materials are filed away into a series of librar-
ies. A list of available libraries together with the material catego-
ries within each library displays along the left side of the palette. 
Selecting any library or category on the left will display the mate-
rials belonging to that library or category as a series of thumbnails 
along the right side of the palette. The default installation creates 
two libraries: the Autodesk Library and the My Materials Library.

Materials may be added to the current drawing from any of the 
libraries listed in the lower portion of the Materials Browser.

Display Material thumbnails

Because materials are inherently visual, many users find the Thumbnail View 
type to be more useful than the default List View type. You can change this by 
clicking the panel display button and selecting Thumbnail View beneath the 
View Type heading.
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 3. If it’s not open already, expand Autodesk Library in the Libraries por-
tion of the Materials Browser.

A list of categories containing an assortment of materials displays.

 4. Browsing the Flooring category, locate and then select the Red Oak 
- Wild Berries material on the right side of the Materials Browser 
palette.

The Red Oak - Wild Berries material is added to the Document 
Materials list at the top of the Materials Browser palette.

 5. Repeat steps 3 and 4 to load the materials listed here:

Category Material name

Wood Hardwood

Yellow Pine - Natural No Gloss

Brick 12in Running - Burgundy

Glass Blue Reflective

Metal ➢ Aluminum Satin - Brushed

Sitework Grass - Dark Bermuda

Siding Shakes - Weathered

Roofing Shingles - Asphalt 3-Tab Black

Wall Paint Flat - Antique White

All of the materials you’ll need for your cabin are now loaded into the current 
drawing. However, before those materials are used for rendering, they must 
be assigned to objects in your drawing. Materials can be applied to individual 
objects, faces, or layers. Whenever possible, it’s best to assign materials to an 
entire layer as opposed to individual objects or faces. Subscribing to this prac-
tice will help ensure the manageability of your model.

Follow these steps to assign materials to the layers in your drawing:

 1. Switch to the Visualize tab if you haven’t already done so, and then 
expand the Materials panel to select the Attach By Layer tool.
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The Material Attachment Options dialog box opens to display 
a list of materials and layers in the current drawing, as shown in 
Figure 17.26.

F I G u R E   1 7 . 2 6 :   The Material Attachment Options dialog box

As you can see, this dialog box is split into two parts:

▶▶ The left side displays a list of materials loaded into the current 
drawing.

▶▶ The right side displays a list of layers in the current drawing.

By default, the Global material is assigned to each layer.

 2. Locate the Red Oak - Wild Berries material on the left side of the dia-
log box and the A-DOOR-3DOB layer on the right.

 3. Drag the Red Oak - Wild Berries material from the left side of the dia-
log box onto the A-DOOR-3DOB layer on the right.

 4. Verify that the material was applied by checking the Material column 
in the Layer list on the right side of the dialog box.
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 5. Repeat this procedure by assigning materials to each of your 3DOB 
layers, as shown in the following table.

Layer Material

A-DECK-3DOB Yellow Pine - Natural No Gloss

A-DECK-STRS-3DOB Yellow Pine - Natural No Gloss

A-DOOR-THRE-3DOB Satin - Brushed

A-FLOR-3DOB Hardwood

A-FNDN-3DOB 12in Running - Burgundy

A-GLAZ-3DOB Blue Reflective

A-GLAZ-SILL-3DOB Yellow Pine - Natural No Gloss

A-ROOF-3DOB Shingles - Asphalt 3-Tab Black

A-ROOF-DECK-3DOB Flat - Antique White

A-WALL-EXTR-3DOB Shakes - Weathered

A-WALL-INTR-3DOB Flat - Antique White

C-TOPO-3DOB Grass - Dark Bermuda

Created in earlier exercises:

A-DOOR-3DOB Red Oak - Wild Berries

 6. Save your drawing as I17-06-RenderMaterials.dwg (M17-06-
RenderMaterials.dwg).

 7. Render your drawing one more time.

Your drawing should now look like Figure 17.27. Notice how the roof is 
reflected in the living room window.
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F I G u R E   1 7 . 2 7 :   The cabin rendered with materials applied to the remaining 3D objects

n o t E  During the rendering process, you probably noticed the small, black 
squares being replaced one at a time by small areas of the rendered drawing. This indi-
cates that AutoCAD is using bucket rendering. Before the rendering process begins, 
AutoCAD determines the sequence to process the squares, called buckets, in order to max-
imize the memory usage and thereby increase the efficiency of the rendering.

Adjusting the Material Mapping
Image maps are the components of a material that consist of image files, such 
as a JPEG or TIFF. When a material uses an image map, its purpose can be 
to change the color of an object (diffuse maps), to give the illusion of texture 
(bump maps), or to define the transparency of a surface (opacity maps).
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Adjusting the Map Size

The individual properties of all materials are controlled in the Materials Browser 
palette. Here you’ll find the controls for setting the parameters for the size of 
the map, which map to use, and several other features for the selected material. 
Follow these steps to edit the material mapping properties:

 1. Continue using I17-06-RenderMaterials.dwg (M17-06-
RenderMaterials.dwg), or open it if it’s not already open.

 2. In the Visualize tab, click the Materials Browser button in the 
Materials panel.

 3. In the Document Materials portion of the Materials Browser  
palette, hover over the Shakes - Weathered material and click the 
Edit (pencil) icon.

The Materials Editor palette opens to display details about the 
Shakes - Weathered material (see Figure 17.28).

F I G u R E   1 7 . 2 8 :   The Materials Editor palette with the Shakes Weathered 
material selected
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 4. From the Materials Editor, click the photographic image found under 
the Generic group (see Figure 17.28).

Selecting the image in the Materials Editor palette will open the 
Texture Editor palette, shown in Figure 17.29.

F I G u R E   1 7 . 2 9 :   Modifying the material scale from the Texture Editor palette

 5. Expand the Transforms group and then the Scale group to locate the 
Sample Size setting.

 6. Enter 2′-4″ (710 mm) into the Height text box.
Note how the dimensions shown in the preview at the top of the 

Texture Editor palette update to reflect this change.

 7. Close the Texture Editor, Materials Editor, and Materials Browser pal-
ettes, and then change your visual style to Realistic.

The Realistic style displays the materials and maps, and the 
changes that you make to them, all at the expense of system perfor-
mance (see Figure 17.30). You should use this visual style only when 
necessary.
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F I G u R E   1 7 . 3 0 :   View of the cabin using the Realistic visual style

 8. Save your drawing as I17-07-AdjustMaterial.dwg (M17-07-
AdjustMaterial.dwg).

Adding texture

The exterior walls of the cabin consist of flat surfaces, and there are no features 
that would cause shadows to be cast. The Bump Map option adds apparent tex-
ture by adding shadows where they would appear if the surfaces had texture. 
In the Maps rollout, you can see that only the Diffuse Map option is checked, 
meaning that no map is used to define the opacity and bump features of the 
material. Opacity maps and bump maps don’t use any of the color information 
from an image map, but this doesn’t mean that color maps can’t be used—only 
that the grayscale equivalent of the colors will be interpreted by AutoCAD. Add 
texture to your materials by completing the following steps:

 1. Continue using I17-07-AdjustMaterial.dwg (M17-07-
AdjustMaterial.dwg), or open it if it’s not already open.

 2. Open the Materials Editor palette once again by locating the Shakes 
Weathered material in the Materials Browser palette.

 3. Select the check box next to the Bump group heading in the 
Materials Browser.
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 4. In the Bump area, click the Select Image button to open the Select 
Image File dialog box. It should open to one of the following directo-
ries, depending on your computer system:

Windows 32-Bit  C:\Program Files\Common Files\Autodesk 
Shared\Materials\Textures\3\Mats

Windows 64-Bit  C:\Program Files (x86)\Common Files\
Autodesk Shared\Materials\Textures\3\Mats

Navigate to one of these directories if the Image File dialog box 
does not automatically open there.

 5. Select the Thermal - Moisture.Shakes.Weathered.jpg file (which is 
the same file that’s used as the diffuse map), and then click Open.

 6. Move the Bump Amount slider to 10 (see Figure 17.31).

F I G u R E   1 7 . 3 1 :   Changing the amount of bump applied to a material

◀

The Thermal - 
Moisture 
.Shakes 
.Weathered.jpg 
image is also included 
in the Chapter 17 
download.

www.MouradEngineering.com



9 7 4 	 C h a p t e r 	 17 	 • 	 R e n d e r i n g 	 a n d 	M a t e r i a l s

Figure 17.32 shows the cabin rendered with the new material 
parameters.

F I G u R E   1 7 . 3 2 :   The cabin with the new material parameters

 7. Adjust the mapping and materials for the remaining objects and 
then save your file as I17-08-MaterialTexture.dwg (M17-08-
MaterialTexture.dwg).

There are enough tools and features relating to AutoCAD materials to fill sev-
eral chapters, and this was just an introduction. Some of the features not cov-
ered are copying mapping between objects, applying different maps to different 
surfaces of the same object, and using opacity maps. I strongly encourage you to 
investigate the full capabilities of the AutoCAD materials.

Rendering to a File
By default, the Render feature creates a rendering in the Render dialog box only. 
The picture is not saved unless you explicitly tell AutoCAD to save it. You can 
also instruct the program as to the quality level of the rendering and the size, in 
pixels, of the image created. Follow these steps:
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 1. Continue using I17-08-MaterialTexture.dwg (M17-08-
MaterialTexture.dwg), or open it if it’s not already open.

 2. Switch back to the Conceptual visual style and the Cam Southeast view.

 3. From the Visualize tab’s Render panel, click the Render Output File 
button and then the Browse For File button to open the Render 
Output File dialog box.

 4. Navigate to the folder where you want to place the new image file, 
and then select a supported image file type in the Files Of Type drop-
down list. For this exercise, do the following:

 a. Choose TIF as the file type.

 b. Name the file Cabin Rendering Small.tif (see Figure 17.33).

F I G u R E   1 7 . 3 3 :   Saving the final cabin rendering

 5. Click the Save button.
Depending on the file type you choose in the future, an Options 

dialog box, similar to the one shown in Figure 17.34, will appear.
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F I G u R E   1 7 . 3 4 :   The TIFF Image Options dialog box

 6. In the TIFF Image Options dialog box, select 24 Bits (16.7 Million Colors), 
make sure the Compressed option is checked, and then click OK.

The next time you render the drawing, the rendering will be saved 
as an image file on your hard drive, and the filename will appear in 
the Output File Name column of the Render window, with a folder 
and check mark next to it (see Figure 17.35). The files with clocks and 
teapots won’t be saved, but you can open them in the Render window 
by clicking the appropriate filename.

F I G u R E   1 7 . 3 5 :   The saved file shown at the bottom of the Render window

 7. In the AutoCAD window, expand the Render Presets drop-down list 
and select Presentation, as shown in Figure 17.36.

F I G u R E   1 7 . 3 6 :   Choose the Presentation rendering preset.
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 8. Expand the Render panel, expand the Render Output Size drop-down 
list, and then choose Specify Image Size (see Figure 17.37) to open 
the Output Size dialog box.

F I G u R E   1 7 . 3 7 :   Set the output size.

 9. In the Output Size dialog box (see Figure 17.38), set the Width to 
2000 and the Height to 1600, and then click OK.

F I G u R E   1 7 . 3 8 :   The Output Size dialog box

This is the resolution required to print a 10″ × 8″ (250 mm × 200 mm) 
image at 200 dots per inch (dpi).

 10. Click the Browse For File button to open the Render Output File 
dialog box.

 11. Name this file Cabin Rendering Large.tif, and make it a 24-bit TIF 
file at 200 dpi. Click OK.

www.MouradEngineering.com



9 7 8 	 C h a p t e r 	 17 	 • 	 R e n d e r i n g 	 a n d 	M a t e r i a l s

 12. Save your drawing and then click the Render button again and wait a 
while as the new image renders.

With the higher quality and larger image size, this may take con-
siderably longer to process.

 13. When the rendering is completed, look at the file size in Windows 
Explorer and then compare the two images in your image-viewing 
software. The larger file is much crisper than the smaller image at 
the expense of increased rendering time.

This has been a brief introduction to the world of 3D and rendering in AutoCAD, 
but you should now be oriented to the general way of doing things and have enough 
tools to experiment further. For a more in-depth discussion of the process, including 
rendering, see Mastering AutoCAD 2015 and AutoCAD LT 2015 by George Omura 
(Sybex, 2014), or visit this book’s web page at www.sybex.com/go/autocadner2015 
and www.thecadgeek.com.

If You Would Like More Practice…
Renderings can be an invaluable way to both explore and validate design alter-
natives. For more practice working with materials as a way of design validation, 
you can try the following:

▶▶ Experiment with different materials for the exterior of your cabin.

▶▶ Create an additional camera to explore your cabin from another van-
tage point.

▶▶ Render your cabin with new materials applied to the scene.
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Are You Experienced?

now you can…

✔✔ create	a	loft	object	by	using	contour	lines

✔✔ create and manipulate cameras

✔✔ add sunlight to a scene

✔✔ place a point light

✔✔ specify	a	scene’s	real-world	location

✔✔ assign	materials	to	the	objects	in	a	drawing

✔✔ adjust	mapping	and	tiling

✔✔ render a drawing, and save the result as an image file
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2-Point option, 224, 421
2D Wireframe option, 10, 10
2Point option

Horizontal constraints, 226, 226
Vertical constraints, 227

3-Point option, 224
3D Align tool, 918
3D Basics workspace, 6
3D models, 846–847

decks
building, 897–903, 897–903
handrails, 906–909, 907–909
mirroring, 911–916, 912–916
skirts, 910–911, 910–911
steps, 903–906, 904–906

doors
adding, 888–890, 888–889
block-outs, 859–862, 860–862
sliding, 893–897, 893–896

floors, 870
foundation and supports, 873–874, 874
mesh-modeling tools, 933–934, 934
moving and rotating, 863

first right-hand rule, 864–868, 864–867
second right-hand rule, 879–880, 880

roof
constructing, 916–920, 917–920
tweaking, 925–928, 926–929
wall adjustments for, 921–925, 921–925

solid-modeling tools, 930–933, 930–933
surface-modeling tools, 935–936, 935–936
ViewCube, 890–893, 891–893
walls

exterior, 854–856, 855–856
interior, 856–858, 857–858
openings, 868–870, 869–870
tweaking, 925–928, 926–929

windows
block-outs, 862–863, 863
building, 874–879, 876–879
completing, 881–888, 882–888

workspaces and environment, 6, 848–853, 849–853

3D Move (3DMOVE) tool
contour lines, 943
grips, 865

3D Polyline (3DPOLY) tool, 878, 904–905
3D Rotate tool, 880, 881, 907
3D Wireframe visual style, 876
3DALIGN command, 918–919
3DMOVE (3D Move) tool

contour lines, 943
grips, 865

3DPOLY (3D Polyline) command, 878, 904–905

A
absolute coordinates, 40–41
absolute paths for external references, 754
acad.ctb file, 841, 842–843
acad.dwt file, 33, 33, 396
Acad_ISO linetype family, 277
acquiring tracking points, 358
Action Macro dialog box, 319–320, 319–320
Action Recorder, 317–321, 318–320
actions for dynamic blocks, 507–513, 510–513
active grips, 308
Adaptive Grid option, 74, 79
Add-A-Plot Style Table Wizard, 840
Add Annotation Scales tool, 410
Add Leader tool, 691
Add option for area calculations, 493
Add Scales to Annotation Objects when the Annotation 

Scale Changes tool, 21
Add To Dictionary option, 461, 463, 467
Additional Format dialog box, 497, 497, 501
additions, garage, 170–171, 170, 705, 706
Adjust Space tool, 698
Adjust Sun & Sky Background dialog box, 961, 962
Adobe Photoshop (PSD) documents, 746
Advanced Render Settings palette, 955, 956, 959, 959, 962
alias commands, 27–28, 177
Align Below Previous Attribute Definition option, 487
aligned dimensions, 684, 684
Aligned With Dimension Line option, 657
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alignment
cells, 532
tables, 527
text, 424–425, 425, 448, 465, 467

Allow/Disallow Dynamic UCS mode, 875, 906
Alt key for commands, 177
Alternate Units tab, 664–665, 664
American National Standards Institute (ANSI) hatch 

patterns, 614
angles with Surveyor's units, 715
angular dimensions

settings, 659–661
working with, 685, 685

angular units, 66, 93
Annotate tab, 398
Annotation Monitor, 22
Annotation Scale of the Current View tool, 21
Annotation Visibility tool, 408
annotative blocks, 472
annotative objects, 410
annotative text and Annotate tab, 401–402

annotation scales
changing, 311, 311
room labels, 404–407, 405–407
synchronizing positions, 410–412, 411–412
working with, 407–410, 408–409

borders
creating, 428–429, 428
drawing, 429–432, 429–431

breaking lines, 413–417, 413–414, 416
dimensions, 651, 651

child, 684
styles, 653–657, 655–658

grid
finishing, 425–427, 426–427
justifying, 424–425, 425
working with, 417–424, 418–424

leaders, 689
moving, 407–410, 408–409
multiline, 464
spell-check, 462
styles

current, 398, 398
defining, 402–404, 403–404
making, 653–657, 655–658
setting up, 390
view titles, 392

tables, 524, 528
title blocks, 428–429, 428

constructing, 432–438, 433–437
placing, 438–446, 439–445

Another Solid Color setting, 960
ANSI (American National Standards Institute) hatch 

patterns, 614

Application menu, 2, 6, 22–27, 23–26
Application window, 2
ARC command, 138–139
architectural references, 759
Architectural tab, 381, 382
Architectural Tick option, 655
Architectural units

from Decimal units, 71
description, 92
distances, 108
foot sign for, 76
setting up, 67–69, 70, 658–659, 659

arcs
door swings, 138–141, 139–141
length dimension, 680, 680
options, 139

area calculations, 490–493, 490–492
AREA command, 490
ARRAY command, 569
Array option with COPY, 199, 199
ARRAYPATH (Path Array) command, 569–571, 570–571
ARRAYRECT (Rectangular Array) command, 901
arrays for railing posts

copying, 901
drawing, 569–572, 570–572

arrows
dimensions, 649, 655–656
North arrow, 726–727, 726

ASCII symbol codes, 694–695, 695
assigning

colors and linetypes to objects, 316–317
elevation layers, 563–564, 564
layer color, 266–269, 267
linetypes to layers, 274–276, 275–276
objects to layers, 279–282, 280–281

associative hatch patterns, 612, 637–638, 638
Associative Path Array error dialog box, 583
at symbol (@) for relative coordinates, 42–43
ATT command, 476
Attach By Layer tool, 966
Attach DWG button, 728, 729
Attach External Reference dialog box

overlays, 759
settings, 730, 730
sheet templates, 784, 784

Attach Image dialog box, 747, 747
Attach Image option, 745–746, 745
Attachment references

circular references, 760
working with, 732–733, 732

ATTDEF command, 472, 474, 486
ATTDIA command, 479, 501
ATTEDIT command, 501
-ATTEDIT command, 502
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attribute definitions, 476
attributes and Attribute Definition dialog box, 471

blocks
defining, 477–479, 478, 488–489, 489
editing, 499–501, 500–501
inserting, 479–481, 479–481
miscellaneous uses, 507
room information, 494–499, 494–499
setting up, 483–488, 484–488
title, 767–772, 768–770, 772
tools, 501–502
visibility, 503–507, 503–506

grids, 472–477, 473–477
tables from, 537–542, 537, 539–542
text, 482–483, 482–483

Author drawing property, 779, 779–780
Auto Constrain tool, 222, 222, 225
Auto-Hide option, 278, 384, 385, 646
AutoCAD

command line, 345–346, 345–346
palettes, 381–384, 382, 384–385

AutoCAD Background setting, 960
AutoCAD LT parametric drawings, 219–221, 219–221
AutoCAPS tool, 466–467
autocomplete feature, 177
Autodesk 360 platform, 91, 91
Autodesk 360 Storage, 89–90, 89
Autodesk Library, 965
Autodesk ReCap products, 728
Autodesk - Sign In dialog box, 89, 89
Autodesk TrustedDWG tool, 22
Automatically Add Annotative Scales mode, 473
Automatically Add Scales mode, 408
AutoSave tool, 742
axes color, 854
Axis, End Ellipse tool, 247

B
back elevation, 593–604, 594–599, 601–604
Back option in DesignCenter, 377
background

color, 272
changing, 610
drawing area, 11, 11

rendering, 960–963, 961–962
Background Mask dialog box, 468
Background Mask tool, 465, 468
Background Override setting, 961
balancing traverses, 719, 719
BASE command

external references, 758
site plans, 727

base points
in copying, 142
hatches, 619–620, 620
rotation, 137
title blocks, 763, 764

Base rows for text, 425
baselines, dimension, 671–672, 672
batch plotting, 834
bathrooms, 236, 237

doors, 149–151, 149–150
fixture selection, 290–293, 291–292
openings, 125–127, 125–127
perimeter, 492, 492
running osnaps, 237–238, 238
shower units, 239–241, 239–241
sink and mirror, 241–245, 242–245
tiled hatch patterns, 631, 631
toilet and shelves, 245–248, 247–248

BATTMAN command, 502
bearings in Surveyor's units, 715
BEDIT (Block Edit) tool, 367, 757
Beside The Dimension Line option, 703
Best Fit option, 657
bifold doors

3D models, 888–890, 889–890
drawing, 162–168, 163–166

Bind Xrefs/DGN Underlays dialog box, 756, 756
binding external references, 755–758, 756–757
Bing Maps, 952–953, 952–953
Blend tool, 936
Block Attribute Manager dialog box, 502
Block Authoring Palettes panel, 509–511, 510
Block - Changes Not Saved dialog box, 335, 335
Block Definition dialog box

attributes, 477–479, 478, 488–489, 489
doors, 331–335, 331, 333
options, 335
window blocks, 353

block definitions, 328
Block Edit (BEDIT) tool, 367, 757
Block Editor

doors, 333–335, 334, 339
dynamic blocks, 507–509, 509, 516
revising blocks, 366–369, 367–368

block-outs
doors, 859–862, 860–862
windows, 862–863, 863

block references, 335
Block Unit option, 339
blocks and BLOCK command, 327, 328

attributes
defining, 477–479, 478, 488–489, 489
editing, 499–501, 500–501
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inserting, 479–481, 479–481
miscellaneous uses, 507
room information, 494–499, 494–499
setting up, 483–488, 484–488
title, 767–772, 768–770, 772
tools, 501–502
visibility, 503–507, 503–506

doors, 328–329
creating, 329–335, 330–335
inserting, 336–341, 336–340

drawing from, 379
dynamic. See dynamic blocks
exploding, 365–366
vs. external references, 713
finding

grips, 344, 344
LIST command, 345–347, 345–346

vs. groups, 341–344, 342–343
names, 516–517, 517
Properties palette, 347–348, 348
revising, 366–369, 367–368
rotating, 354–357, 355–357
scaling, 352, 360–362
title. See title blocks
views, 171–173, 171
windows

creating, 348–353, 349–351, 353
finishing, 362–366, 362–365
inserting, 353–360, 354–359
insertion points, 357–360, 358–359
placing, 316
scale factor, 360, 361–362

bold text, 455, 455, 464
Bold tool, 464
Boolean functions

doors, 859–862
frames, 877
roof, 925
solids, 933
walls, 868–869
windows, 862–863, 881, 883, 883, 885

borders for annotative text
creating, 428–429, 428
drawing, 429–432, 429–431

boundaries for hatch patterns, 612, 626
Boundaries panel, 626
boundary edges, 57, 115
BOX command, 859, 875, 930
box object, 859–862, 930
breaking and BREAK command

lines, 413–417, 413–414, 416
multiline text columns, 453, 453
options, 415

Bring To Front command, 629
Browse For Drawing File dialog box, 764

Browse For Plot File dialog box, 831
bucket rendering, 969
buckets, 969
Bullets and Lists option, 467
Bullets And Numbering list, 465
Bump Amount setting, 973
Bump Map option, 972
burners, stoves

drawing, 223–225, 224–225
geometric constraints, 225–229, 226, 228

BURST command, 366
ByBlock option

blocks, 329
color, 272

ByLayer option
blocks, 329
color, 272
linetypes, 312

C
calculating areas, 490–493, 490–492
CAMERA (Create Camera) button, 945
Camera Preview dialog box, 947, 948
cameras, 945–949, 946–949
cams, 387
Cancel option for multiline text, 468
canceling commands, 130
caps, 680
cars, 386–387, 386
Cartesian Coordinate System

overview, 37–38, 37–38
relative, 42, 43
working with, 38–41, 40–41

case
of commands, 38
multiline text, 464, 467

cellophane wrapper analogy, 935
cells, table, 525–527, 526, 532–535, 533
Center, Diameter option, 224
Center, Radius option, 224
center justification, 425, 465
Center object snaps, 248
center points

arcs, 139–140
ellipses, 243–244, 244

Center The Plot option, 816, 828
centerlines, dimensioning to, 706–710, 706–707, 709–710
centroids, 342, 342
CHAMFER command

corners, 55
shower units, 239, 239

Change All option, 463
Change Case option, 467

www.MouradEngineering.com



	 C h a n g e 	 P a t h 	 t o o l 	 • 	 C o p y 	C l i p 	 o p t i o n  9 8 5

Change Path tool, 754
Character Set option, 468
Check Spelling dialog box, 462–463, 462
child dimension styles, 681–684, 682–683
circles

2-Point option, 224, 421
snapping, 248
stove burners, 224–225, 224–225

circular references, 733
civil plans, 727
cleaning up

interior walls, 110–113, 110–112
title blocks, 765–767, 766–767

Clear Screen tool, 22
Clipboard panel, 370
CLIPROMPTLINES command, 17
Close All Except This Tab option, 33
Close Block Editor option, 335, 339, 516
Close Hatch Creation option, 617
Close panel, 466
Close Test Block Window option, 516
Close Text Editor option, 448–449
Closed Fill option, 656
closet openings, 128–129, 128–129
closing traverses, 719
color

axes, 854
background

changing, 610
drawing area, 11, 11

current, 317
gradients, 625, 625
grid, 72, 75
hatch patterns, 644
layers, 261

assigning, 266–269, 267, 600
Color Books tab, 273–274, 274
True Color tab, 271, 271, 273

multiline text, 446, 455, 465
objects, 316–317
rendering, 958, 958
traditional, 272–273
UCS icon, 853

Color Books tab, 273–274, 274
color-dependent plot-style tables, 840–841, 841
Color property

layers, 266
plot-style tables, 844

Color swatch for blocks, 355
columns for multiline text

adding, 450–454, 451, 453–454
tools, 465, 467

combining
objects. See blocks and BLOCK command
paragraphs, 465, 468

command line
description, 8
expanded, 345–346, 345–346
interface, 17–20, 17–20

command prompt, 35–36, 35–36
commands

aliases, 177
canceling, 130
case sensitivity, 38
keyboard, 177
palettes for, 644–646, 646
starting and running, 175–178, 176

Compiled Shape (SHX) font files, 396
Compressed option, 976
Conceptual visual style, 895, 904
concrete hatch, 616–617, 616–617
cones, 931
Confirm Each Object To Be Purged option, 518
Connect panel, 4
connections for multileaders, 688
constraints

dimensional, 229–233, 230–232
geometric

applying, 225–229, 226, 228
working with, 221–223, 222–223

Constraints Settings option, 222
Construction Line (XLINE) command, 553
construction lines

copying, 554–556, 555–556
working with, 553–554, 554

contact information, title blocks for. See title blocks
Content tab for leaders, 683, 688
context menus, 176, 176, 178
continuing dimensions, 668–671, 669–671
contour lines, 940–945, 941–944
conversions

multiline text, 446
objects to blocks, 333, 335
square inches to square feet, 497

Convert To Block option, 333, 335
coordinate filters, 206–210, 207–210
coordinates and coordinate systems

in copying, 142
decks, 206–210, 207–210
readout, 40–41
relative, 41–44, 43–44
UCS. See UCS (user coordinate system)
WCS, 584, 603
working with, 38–41, 40–41

Coordinates panel
enabling, 796
loading, 589

Coordinates Ribbon panel, 589, 589
Copy Clip option, 370
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copying and COPY command
Array option, 198, 199
blocks, 366
construction lines, 554–556, 555–556
deck posts, 193–194, 194–195
dimension styles, 654
doors, 142–144, 143–144
elevations, 596, 596–597
grips, 556
hatch patterns, 642, 643
multiline text, 467
objects between drawings, 369–371, 370–371
railing posts, 908, 908
title blocks, 440

corners
interior walls, 119, 119
rounding. See filleting and FILLET command
ViewCube, 891–892, 892

counters, 211–215, 212–213
cover sheets, 781–782, 781–782
Create A Copy option, 787, 787
Create A New Cell Style dialog box, 526
Create A New Data Extraction option, 538
Create Camera (CAMERA) button, 945
Create New Dimension Style dialog box, 654, 654
Create New Folder button, 87
Create New Multileader Style dialog box, 686, 686
Create New Table Style dialog box, 525, 525
Create page, 3–4, 3
Create Separate Hatches option, 616–617, 616, 620
Create Sheet Set dialog box, 798–799, 801
Create Sheet Set - Begin dialog box, 799
Create Sheet Set - Sheet Set Details dialog box,  

799–800, 799
Cross Sections Only option, 945
crossing windows, 282, 283

doors, 286–288, 286
kitchen objects, 290–292, 291
overview, 167
sliding glass doors, 159, 159

.ctb files, 840–841
cue cards, 14, 14
curb returns, 719
current color, 317
current layer, 278–279, 647
current linetypes, 317
cursor

description, 7
with grids, 75
with lines, 35, 35

Customization tool, 22
Cut tool, 467
cutting wall openings, 120–121, 121

3D models, 868–870, 869–870
closet, 128–129, 128–129

exterior, 121–124, 122–124
interior, 125–127, 125–127
sliding glass door, 124, 124

cycling
lines, 234, 234, 601–602
polylines, 491–492, 492

cylinders, 931

D
Dashed linetype, 275–276, 276
Data Extraction - Begin dialog box, 538
Data Extraction - Define Data Source dialog box, 538
Data Extraction - Refine Data dialog box, 540, 540
Data Extraction - Select Objects dialog box, 538–539, 539
Data Extraction - Table Style dialog box, 541, 541
data extraction tables from attributes, 537–541, 537, 

539–542
Data Extraction Wizard, 538–541
data types for tables, 526
DDEDIT command

accessing, 695
grids, 426–427
title blocks, 440

DDPTYPE command, 484
Decimal Degrees option, 69
decimal distances for Architectural units, 108
Decimal units, 66

Architectural units from, 71
description, 92
settings, 69, 70

decks
3D models

building, 897–903, 897–903
handrails, 906–909, 907–909
mirroring, 911–916, 912–916
skirts, 910–911, 910–911
steps, 903–906, 904–906

area calculations, 493
attributes, 504, 504–505
back, 201–206, 201–206
dimensions

setting up, 673–675, 673–675
spacing, 698–699, 698–699

elevations, 565–569, 565–569
foundation and supports, 873–874, 874
front, 186–190, 187–190
hatch patterns, 635–636, 637
mirroring, 202–203, 202–203, 580–582, 581–582
point filters, 206–210, 207–210
posts, 190–195, 191–195

default justification points, 463
Default Lighting option, 951
Define Attributes option, 476
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Deg/Min/Sec units, 93
Delete From Drawing option, 764
deleting and Delete option

block definitions, 517–519, 519–520
and blocks, 333, 335
layer states, 325
layers, 274
railing posts, 913, 913

Descartes, René, 37
descenders, text, 425
Description setting in DesignCenter, 377
DesignCenter tool

dynamic blocks, 520–522, 520
options, 377
sharing information, 371–376, 372–376
tool palettes, 640, 640

designing tables, 528–532, 529–532
DETACH command, 758
Deviation tolerance method, 665
diameter dimensions, 679–680, 679
DIC (Digital Image Correlation) standard, 270
dictionaries, spell-check

multiline text, 466
realtime, 460–461, 461

Diffuse Map option, 972
Digital Image Correlation (DIC) standard, 270
Digital Orthophoto Quadrangle (DOQ) format, 746
DIMANGULAR command, 685
DIMARC command, 680
DIMBASELINE (Dimension Baseline) command, 669, 

671–672, 672
DIMCONTINUE (Dimension Continue) command,  

668–671, 669–671
DIMDIAMETER command, 679
Dimension Continue tool, 675–676
Dimension Input Settings dialog box, 84, 84
dimension lines, 649, 650
dimension styles and Dimension Style Manager dialog 

box, 649–650
Alternate Units tab, 664–665, 664
child dimensions, 681–684, 682–683
creating, 652–653
families, 681
Fit tab, 657, 658
making, 653–657, 655–658
preparing for, 650–651, 651
Primary Units tab

architectural, 658–659, 659
metric, 660–661, 660

saving, 661–663, 662
saving settings, 661–663
short distances, 701–703
Symbols And Arrows tab, 655–656, 656
Text tab, 656–657, 657
Tolerances tab, 665, 665

dimensional constraints, 223–225, 229–233, 230–232
dimensions, 389, 649

aligned, 684, 685
angular

settings, 659–661
working with, 685

arc length, 680, 680
to centerlines, 706–710, 706–707, 709–710
components, 649–650, 650
continuing, 668–671, 669–671
diameter, 679–680, 679
finishing, 676–677, 676
garage addition, 705, 706
leader lines, 686

adding, 689–692, 690–692
creating, 686–689, 686–689

modifying overview, 692
moving, 696–697, 696–697
overrides, 700–701, 700
parent and child styles, 681–684, 682–683
placing, 666–668, 666
property lines, 716
radial, 678–679, 678
regular vs. parametric, 229
short distances, 701–704, 702–704
site plans, 725
stacked, 698–699, 698–699
styles. See dimension styles and Dimension Style 

Manager dialog box
text, 649, 650

appearance, 656–657, 657
editing, 693–694, 693–694
multiline, 446

types, 677
vertical, 673–675, 673–675

DIMRADIUS command, 678
DIMSPACE command, 698
Direct Distance method, 44
direct entry

kitchen counters, 211–213, 213
working with, 47–48, 48

Direction Control dialog box, 70
direction in Surveyor's units, 715
Disable All Window Transparency (Global) option, 383
discipline designator codes, 262–264
Display option for Plot Area settings, 816
Display All Attributes option, 503, 503, 506–507
Display All Object Types option, 538
Display Blocks Only option, 538
Display Drawing Grid tool, 21
Display Grid Beyond Limits option, 74
Display tab for background color, 610
Distance Linear parameter, 513
distances and DISTANCE command, 69

Architectural units, 108
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Direct Distance method, 44
dynamic blocks, 511–513, 511, 513
with OFFSET, 49–51, 50–51
relative coordinates systems, 43
site plans, 720

distant lights, 950
Distribute tool for multiline text, 465
Document Materials setting, 965
dollar sign ($) symbols for layers, 742
doors, 130–131, 131

bifold
3D models, 888–890, 888–889
drawing, 162–168, 162–166

block-outs, 859–862, 860–862
blocks, 328–329

creating, 329–335, 330–335
inserting, 336–341, 336–340

copying, 142–144, 143–144
dynamic blocks

creating, 507–509, 509
inserting, 517–523, 518–523
parameters and actions, 507–509, 510–513
properties, 513–517, 514–517

Floor Plan Doors sheets, 791–793, 792–793
groups, 341–344, 342–343
openings, 120–121, 121

exterior, 121–124, 122–124
interior, 125–127, 125–127
sliding glass door, 124, 124

pivot, 888–890, 888–889
rotating, 136–138, 137
scaling, 149–151, 149–150
selecting, 286–290, 286–287
sliding glass, 872

3D models, 893–897, 893–896
alternative, 169, 169
drawing, 151–162, 151–162
openings, 124, 124
selecting, 288–290, 289

strategy review, 168–169
swing, 138–142, 139–141
swinging, 131–136, 132–136
tables

designing, 528–532, 529–532
formulas, 532–536, 533–534, 536

thresholds, 178, 179
back, 184–186, 184–185
extruding, 870–873, 871–873
front, 179–184, 180–183

DOQ (Digital Orthophoto Quadrangle) format, 746
double-pitched roofs, 304
Drafting & Annotation workspace, 5–10, 9–10
Drafting Settings dialog box

Dynamic Input tab, 82–85, 83

grid
settings, 73–74, 73–74
spacing, 78–79, 78

hot tub, 249
Midpoint and Endpoint osnaps, 207–208, 207
Object Snap tab

blocks, 330
settings, 237–238, 238
sliding glass door, 151–152, 151
swinging doors, 132–133, 132

Polar Tracking tab, 186, 188, 188
Drafting Tooltip Appearance option, 84
Draw Dim Line Between Ext Lines option, 657
Draw Order command, 628, 629
drawing area, 71–72

background color, 11, 11
description, 7
Drawing Limits setting, 76–79, 76–78
grid, 72–76, 73–75

Drawing#.dwg drawings, 66
drawing information, title blocks for, 432
drawing limits

grid size, 72
property lines, 718
setting, 76–79, 76–78

Drawing Set Description (DSD) files, 836–837
drawing units and Drawing Units dialog box

settings, 66–71, 66–68, 70
Surveyor's units, 717–718, 717

Drawing Utilities menu, 518
Drawing Window Colors dialog box, 11, 11
drawings

inserting into other drawings, 380–381
parametric, 218–219, 219, 221–223
saving

Autodesk 360 storage, 89–90, 89
drives, 85–88, 86

sharing information between. See sharing 
information

driveways, 719–727, 720, 722–724, 726
drop-down lists, 68
DSD (Drawing Set Description) files, 836–837
DST files, 798–799
DWF and DWFX format, 811
DWT files, 33
dynamic blocks, 471

creating, 507–509, 509
inserting, 517–523, 518–523
parameters and actions, 507–509, 510–513
properties, 513–517, 514–517

Dynamic Input feature
commands with, 35
working with, 82–85, 83–85

Dynamic Prompts settings, 84
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Dynamic UCS
roof, 926
stairs, 906–907
windows, 875–876, 876

E
East Elevation sheet files, 796, 796
EATTEDIT command, 502
eaves, 304–309, 305–306, 308–309
eaves lines, 304
Edge Mesh tool, 934, 934
EDGEMODE system variable, 160
edges, ViewCube, 892, 892
Edit Attributes dialog box

description, 501
room information, 494–495, 494–495, 498, 498
sheet templates, 778–779

Edit Dictionaries tool, 466
Edit Drawing Scales dialog box, 776
Edit Hyperlink dialog box, 457–458, 458
Edit Layer State dialog box, 325
Edit Reference In-Place (REFEDIT) command,  

740–743, 757
Edit Reference tab, 741–742, 741
editing

attribute text, 482–483, 482–483
attributes, 499–501, 500–501
dimension text, 693–694, 693–694

Editor Settings option for multiline text, 468
Either Text Or Arrows (Best Fit) option, 657
electrical diagrams, 387
elevation points, 553–554, 554
elevations, 547

front and back, 593–604, 594–599, 601–604
height lines, 551–552, 552
interior, 606
north, 583–586, 584–586
scale issues, 604–605
sheet files, 793–797, 795–797
south. See south elevation

ellipses and ELLIPSE command
sink and mirror, 243–245, 244
snapping, 248
toilet and shelves, 247

Enable Automatic Sync option, 90, 90
enabling Coordinates panel, 796
Endpoint object snap

arcs, 140–141, 140–141
blocks, 330, 337
in copying, 143
decks, 207–209, 207
in mirroring, 145–146
sliding glass doors, 155

stairs, 195
swinging doors, 135, 135

Engineering units, 92
Enhanced Attribute Editor dialog box

blocks, 499–501, 500
settings, 502
text 482–483, 482

Enter A Title For Your Table setting, 541
Enter key, 38
Entire Drawing option with WBLOCK, 379–380
entrance thresholds, 178, 179

back, 184–186, 184–185
extruding, 870–873, 871–873
front, 179–184, 180–183

Equal constraint, 227–228, 228, 232
Equal X And Y Spacing option, 78
equipment attributes, 507
Erase option with OFFSET, 52
erasing and ERASE command

blocks, 366
deck, 580
elevation items, 587, 587
lines, 46–47
sliding glass doors, 161

Esc key, 130
existing drawings, adding to sheet sets, 802–804, 

802–804
Existing File Or Web Page option, 458
Exit AutoCAD command, 87
EXPLODE command

blocks, 340, 365–366
lines, 198
multiline text, 446
polylines, 97

exporting layer states, 325
EXTEND command

bathroom openings, 125–126, 126
EDGEMODE variable, 160
errors with, 130
interior walls, 115, 115
from keyboard, 177
lines, 57–58, 57
tips, 562–563

extension lines
construction, 558–561, 558
dimensions, 649, 650, 655
suppressing, 700–701, 700

Extents option, 816
exterior openings, 121–124, 122–124
exterior walls

3D models, 854–856, 855–856
description, 97
lines, 102–106, 103–105
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external references (xrefs), 261, 713
architectural, 759
attachments vs. overlays, 732–733, 732
binding, 755–758, 756–757
current drawing, 736–739, 737–739
in host drawings, 740–745, 740–741, 743–744
images, 745–749, 745–748
layer definitions, 824–827, 826
moving and rotating, 735–736, 735
paths, 730

changing, 754–755, 755
setting, 751–753, 752–753

setting up, 727
types, 760
uses, 749–751, 750–751

External References palette
bindings, 756
information on, 738, 738
layer properties, 825
missing references in, 752–753, 753
object organization, 733–735, 734
paths, 754, 755
working with, 727–731

extrusions and EXTRUDE command
deck, 874
description, 936
roof, 920
surfaces, 935, 936
thresholds, 870–873, 871–873
windows, 879

F
families for dimension styles, 681
Favorites option in DesignCenter, 377
feet in distances, 106, 108
Fence option for TRIM

construction line extensions, 558, 558
lines, 59
wall openings, 123, 123

field of view (FOV), 946
fields and Field dialog box

attributes
room information blocks, 495–498, 495–496, 498
title blocks, 768, 768

hyperlinks, 456, 457
multiline text, 466

File Tabs, 7, 15–16, 16, 33–34, 34
files, rendering to, 974–978, 975–977
filleting and FILLET command, 52–55, 52–55

elevation lines, 560–561, 561, 599
exterior walls, 104–105, 104–105
gasket, 255
hot tub, 250–251, 250

interior walls, 111–113, 116, 119, 119
from keyboard, 177
kitchen counters, 214–215
mirror, 242
parking lot, 257–258
and polylines, 97
roofs, 306–307
sinks, 235–236, 242
windows, 588, 589

fills, 610
Filter Color field, 958
filters

color, 958
point, 206–210, 207–210

Find and Replace dialog box, 466
finding blocks

grips, 344, 344
LIST command, 345–347, 345–346

first right-hand rule, 864–868, 864–867
Fit tab

dimension styles, 657, 658
short distances, 701–703, 703

Fit To Paper option, 816, 828
floating layouts, 789
floor plan

dimensions. See dimensions
hatches, 629

finishing, 634–636, 634–636
origin, 632–634, 633
user-defined, 630–632, 630–631

room labels, 404–407, 405–407
floor plan sheets

composing, 788–793, 789–792
Floor Plan Doors sheets, 791–793, 792–793
Floor Plan Materials sheets, 790, 790
generating, 783–788, 784–787

floors
3D models, 870
area calculations, 490–493, 490–492

folders, creating, 87
Font Name setting, 394
Font Style setting, 394
fonts

annotative text, 403
list, 394
multiline text, 464
SHX and TTF, 396
styles, 394–397

foot sign (') for Architectural units, 76
Form View tab, 843, 843
formatting and Formatting panel

multiline text, 450–452, 451, 455–456, 455
table cells, 533–534, 533–534, 536
Text Editor, 464–465

formulas in tables, 532–536, 533–534, 536
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Forward option for DesignCenter, 377
Found In option for external references, 730
foundation

3D models, 873–874, 874
elevations, 578–580, 579–580
hatching, 616–617, 616–617

FOV (field of view), 946
Fraction Format setting, 659
Fractional units, 92
fractions

distances, 106
multiline text, 465
in scaling, 149

frames, window, 882–884
freezing layers, 295–299, 296–299
From Object Data In the Drawing  

(Data Extraction) option, 537
From Template option, 781, 781
front elevation, 593–604, 594–599, 601–604
Front option in ViewCube, 891
full-bleed devices, 429
full paths for external references, 754
Full Shadows option, 955, 955
function keys, 28
furniture, 253, 253

G
Gap Tolerance setting, 632
garage additions

cabin, 170–171, 170
dimensions, 705, 706

gasket, 254–256, 254–255
gear teeth, 387
gears, 387
general notes, 450

columns, 450–454, 451, 453–454
formatting words, 455–456, 455
hyperlinks, 456–459, 457–459

General tab for tables, 526–527, 527, 841, 842
Geographic - Live Map Data dialog box, 952
Geographic Location dialog box, 952–953, 952–953
geometric constraints

applying, 225–229, 226, 228
working with, 221–223, 222–223

Getting Started panel, 3
Getting Started Videos panel, 4
glazing

size, 885, 886
window blocks, 352–353

Global Illumination setting, 959, 959
gradients

background rendering, 960
description, 609

hatches, 614
shading with, 623–628, 624–628

Grads units, 93
gray shades, 272
Grid Behavior settings, 74
Grid X Spacing setting, 78
Grid Y Spacing setting, 78
grids

attributes, 472–477, 473–477
drawing with, 79–82, 80–82
text

finishing, 425–427, 426–427
justifying, 424–425, 425
working with, 417–424, 418–424

working with, 72–76, 73–75
grip edits, 407
gripper tool, 880, 881
grips

block detection, 344, 344
boxes, 861, 861, 877, 877
camera, 948, 948
centroids, 342, 342
for copying, 369
copying construction lines, 554–556, 555–556
dimensions

moving, 696–697, 696–697
multifunctional, 670–671, 670

doors, 861, 861
hatch origin, 620–621, 620
leaders, 691
lines, 285
Move, 865–867, 865
multifunctional, 420–421, 670–671, 670
multiline text columns, 453
offset lines, 549, 550
polylines, 100
railing posts, 908
rectangles, 430
roofs, 307–308, 308
text, 407–408
walls, 922, 923
windows, 883
working with, 556–557

GROUP command, 341
Group Selection option, 343, 343
groups, 341–344, 342–343

H
handrails, 195, 906–909, 907–909
Hardware Acceleration tool, 22
Hatch Creation tab, 611, 611

foundation, 616–617
vs. Hatch Editor, 619–620
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hatch pattern library, 614
user-defined hatch patterns, 630

Hatch Editor tab
foundation, 618
origins, 619–620

Hatch Pattern Scale setting, 612, 612, 616
Hatch Spacing setting, 630, 632
Hatch Type setting, 624, 630
hatches and hatch patterns, 609

area calculations, 490
associative, 612, 637–638, 638
available, 614–615
creating, 647–648, 648
floor plan, 629

finishing, 634–636, 634–636
origin, 632–634, 633
user-defined, 630–632, 630–631

palettes for, 642–644, 643–644
roofs, 647–648, 648
south elevation, 610–613, 611–613

foundation, 616–617, 616–617
pop-outs, 619–620, 620–621
shading, 623–628, 624–628
solid-fill, 622–623, 622–623
walls, 618–619, 619

headers, 299–303, 300–303
height and Height setting

annotative text, 403–404
dimension text, 653, 656
elevations, 549, 549
fonts, 394
layout text, 391
lines, 551–552, 551–552
multiline text, 449, 464
tables, 526
windows, 876

helices, 933, 933
Help option for multiline text, 468
Hide All Attributes option, 507
hiding palettes, 384, 385, 646
highlighting view titles, 406
hinge points, 329, 331, 332, 338
Home option for DesignCenter, 377
Horizontal constraint tool, 226–227, 226, 228
horizontal dimensions, 666–668, 666
hot grips, 308
hot tub, 249–251, 249–251
Hue, Saturation, Luminance (HSL)  

model, 271, 271
hyperlinks, 456–459, 457–459
hyphens (-) in distances, 106

I
icons, 57
Identify Reference tab, 741
Ignore option for spell-check, 463
Ignore All option for spell-check, 463, 467
Image File dialog box, 973
image maps, 969
IMAGEFRAME variable, 748–749
images

adding, 745–749, 745–748
background rendering, 960
textures, 972

imperial units, 67
implied intersections, 595
Import Layouts As Sheets dialog box, 802–803, 803
Import Text option, 466–467
importing

layer states, 325
layouts, 802–804, 802–804
text, 466

In-Canvas Viewport Control toolbar, 7, 592, 592
in-place xref editing, 745
inch sign (") for Architectural units, 76
inches in distances, 106, 108
Include Current Drawing option, 538
Include Model When Adding Sheets option, 835
Index Color tab

gradients, 625
settings, 266–269, 267, 272–273

Indicate Layers In Use option, 296, 296
InfoCenter toolbar, 7
information in title blocks. See title blocks
Insert Column Breaks option, 453, 453
Insert Data Extraction Table Into Drawing option, 541
Insert Field option, 467
Insert Layout(s) dialog box, 782, 782
Insert markers, 363, 363
Insert panel, 465–466
Insert Table dialog box, 528–529, 529, 537, 537
inserting and Insert dialog box, 220, 220

blocks
attributes, 479–481, 479–481, 494–499, 494–499
doors, 336–341, 336–340
dynamic, 517–523, 518–523
title, 445, 445
window, 353–360, 354–359

contour lines, 941
DesignCenter, 376
drawings into other drawings, 380–381
external references bondings, 756
North arrow, 726
tables, 528–529, 529, 537, 537, 541
text, 465–466
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insertion points
blocks

doors, 329, 331, 332, 338
windows, 357–360, 358–359

snapping to, 363, 363
Insertion Scale setting, 70
interior door, 338–341, 338–340
interior elevations, 606
interior walls

3D models, 856–858, 857–858
cleaning up, 110–113, 110–112
creating, 106–109, 107–109
finishing, 117–120, 118–120
zooming, 113–120, 113–120

International Organization  
for Standardization (ISO)

hatch patterns, 614
layer standards, 270

Intersect function, 933
Intersection function, 858
intersections

implied, 595
T-intersections, 113–116, 113–116, 119

Invert Filter option, 266
Invert Selection option, 490
Invisible mode for attributes, 486
ISO (International Organization  

for Standardization)
hatch patterns, 614
layer standards, 270

Isolate Objects tool, 22
Isolate option, 762
Isometric Drawing tool, 21
italicized text, 455, 464

J
jambs, 121
Job Already In Progress dialog box, 836, 836
JOIN command

polylines, 97, 99
rooflines, 587, 588
roofs, 309

JPG files for external references, 727
justification and justification points

cells, 532
text

multiline, 448, 463–464, 464
single-line, 399, 399, 424–425, 425

Justification tool, 465
Justify tool, 465

K
keyboard

commands from, 177
working with, 27–28

kitchen, 210, 211
area calculations, 493
counters, 211–215, 213
fixtures selection, 290–293, 291–292
hatch patterns, 632–634, 633
refrigerator, 216–218, 217–218
sink, 233–236, 233–235
stoves, 216–218, 217–218

burners, 223–233, 224–226, 228, 230–232
dimensional constraints, 229–233, 230–232
geometric constraints, 221–223, 222–223
parametrics, 218–219, 219, 221–223

windows
building, 874–879, 876–879
completing, 879–880, 880
rotating, 881, 882–888

L
labels

room
annotation scales, 407–410, 408–409
breaking lines, 413–417, 413–414, 416
placing, 404–407, 405–407
synchronizing positions, 410–412, 411–412

site plans, 725
in title blocks, 439–440, 439–440

landings, leader line
distance setting, 687
gap setting, 688

landscape orientation, 817
Large Icons view, 640, 640
lasso window selection, 286–287, 286
lateral tolerances, 665
layer 0

blocks, 329
as default layer, 262

-LAYER command, 472
Layer Filters tree view box, 266
Layer List box, 266
Layer Notification Warning dialog box, 814
Layer Off tool, 624
Layer option for OFFSET, 52
Layer Properties Manager, 726
Layer Settings dialog box, 296–297, 296
Layer State - Successful Import dialog box, 652
Layer States Manager

external references, 734, 734
features, 325
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layer properties, 825, 826
new layer states, 320–325, 322–324
restoring layer states, 651–652

Layer Walk tool, 313–316, 314–315
layers and Layer Properties Manager, 259

assigning objects to, 279–282, 280–281
blocks, 329, 355–356
color, 261

assigning, 266–269, 267, 600
Color Books tab, 273–274, 274
True Color tab, 271, 271, 273

current, 278–279, 647
deleting, 274
in DesignCenter, 373–375, 374
elevations, 548, 563–564, 564
external references, 742, 757
freezing, 295–299, 296–299
headers, 300–301
linetypes, 274–276, 276
lineweights, 818–824, 822–823
locking objects, 912
macros for, 317–321, 318–320
names, 262–265, 262, 270
as organizing tools, 260–262, 260–261
Quick Properties panel, 284–286, 285
roofs, 303–304
setting up, 262–266, 262, 265
sheet templates, 778
states. See Layer States Manager
title blocks, 762, 763
turning off, 295–299, 296–299, 624
unreconciled, 814
working with, 264–266
Xref definitions, 824–827, 826

LayerWalk dialog box, 314–315, 314–315
LAYISO option, 762
LAYMCH command, 438
LAYMCUR command, 647
LAYOFF command, 624
LAYON command, 734
Layout Tabs, 8
layouts, 391, 761

floating, 789
plan sheets

cover sheets, 781–782, 781–782
floor plan sheet composition, 788–793, 789–792
floor plan sheet generation, 783–788, 784–787

plotting, 832–839, 833–838
Sheet Set Manager. See Sheet Set Manager
sheet templates, 772–777, 773–774

finishing, 778–780, 779–780
layout parameters, 774

title blocks
attributes, 767–772, 768–770, 772

creating, 762–765, 763–765
sizing and cleaning up, 765–767, 766–767

viewports. See viewports
Xref layer definitions, 824–827, 826

LAYTHW command, 734, 762
leader lines, 686

adding, 689–692, 690–692
creating, 686–689, 686–689

Leader Structure tab, 686, 687
Learn page, 4–5, 4
Left Attachment setting, 688
left justification, 425, 465
left mouse button, 28
legal descriptions in surveys, 715
Length units, 66–68
LENGTHEN command, 420
less than signs (<) for angles, 43
libraries of materials, 965–966
lighting, 950

background, 960–963, 961–962
first render, 956–960, 957–959
shadows, 954–956, 955–956
source, 950–954, 951–954

LIGHTINGUNITS variable, 962
LIMITS command

drawing limits, 76
property lines, 718

Limits option for plot area settings, 816
Limits tolerance method, 665
Line Spacing tool, 465
Linear Dimension tool, 666, 673, 676
Linear dimensional constraints, 229–231, 230–231
Linear Dimensions settings, 659–661
Linear Parameter option, 509, 510
Linear tool, 229, 670
linear units, 66, 92
lines and LINE command, 19, 19, 28

blocks, 350–351
breaking, 413–417, 413–414, 416
construction

copying, 554–556, 555–556
working with, 552, 553–554

contour, 940–945, 941–944
coordinates with, 39, 40
dimension, 649, 650
driveways, 721–724
elevation. See elevations
erasing, 46–47
errors with, 130
extending, 57–58, 57
extension

construction lines, 558–561, 558
dimensions, 649, 650, 655
suppressing, 700–701, 700
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exterior walls, 102–106, 103–105
gaskets, 255
grids, 72–76, 73–75, 79–80, 80–82
headers, 301
height, 551–552, 551–552
interior walls, 110–113, 110–112
kitchen counters, 212
leader, 686

adding, 689–692, 690–692
creating, 686–689, 686–689

linetypes. See linetypes and LINETYPE command
lineweights. See lineweights
mirror, 145, 146
property, 716–719, 716–719
sidewalks, 724–725
sliding glass doors, 152, 154–157, 161–162
stairs, 195
surveys, 715, 715
thresholds, 180, 184–185
title blocks, 437
trimming

elevations, 557–562, 558–562
process, 59–62, 59–61

working with, 31–37, 32–36, 45
Lines Of Prompt History option, 17, 18
Lines tab, 655, 655
LINETYPE command, 19, 20
linetypes and LINETYPE command

assigning
to layers, 274–276, 275–276
to objects, 316–317

AutoCAD types, 277
current, 317
description, 266
Layer List box, 266
scale factor setting, 309–312

Lineweight dialog box, 822–824, 822
Lineweight Settings dialog box, 832
lineweights

applying to layers, 822–824, 822–823
assigning, 818–824
displaying, 277
Layer List box, 266
project, 818–821
settings, 277

LIST command, 345–347, 345–346
Live Map Data, 952–953, 952–953
living room

area calculations, 493
hatch patterns, 634, 634–635

Load dialog box
DesignCenter, 377
opening, 372

Load Or Reload Linetypes dialog box, 275–276, 275
locking

objects, 912
viewports, 786

Loft Settings dialog box, 944, 944
Loft tool

description, 932, 935–936, 936
working with, 940–945, 941–944

LTSCALE variable, 310–311, 605
LWUNITS command, 823

M
M2P object snaps

handrails, 908, 908
window blocks, 352, 353

macros, 317–321, 318–320
Major Discipline Designators in layer names, 264
Make Lowercase tool, 464
Make Object's Layer Current option, 314, 647
Make Relative option, 755
Make Uppercase tool, 464
Manage Cell Styles dialog box, 526
Manage Layer States option, 651, 734, 734
Manage tab, 318
Manage Text Styles option, 402, 652
mapping materials, 969–972, 970–972
Maps rollout, 972
markers

Insert, 363, 363
osnap, 135, 135

masks
background, 465, 468
multiline text, 417

MATCHPROP (Match Properties) command
attributes, 767, 769
overview, 438
polylines, 436

Material Attachment Options dialog box, 967, 967
materials, 939

adding, 964–968, 965, 967, 969
Floor Plan Materials sheets, 790, 790
mapping, 969–972, 970–972
texture, 972–974, 973–974
thumbnails, 965, 965

Materials Browser, 964–966, 964, 970–971
Materials Editor, 970–971, 970
MBUTTONPAN variable, 181, 246
Measure option, 492, 492
MEASUREGEOM (Measure Geometry) command, 490, 493
menus, context, 176, 176, 178
Merge To Layer dialog box, 766, 766
mesh-modeling tools, 933–934, 934
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metric units, 67, 660–661, 660
Mid Between 2 Points object snaps

handrails, 908, 908
window blocks, 352

middle mouse button, 28–29
Midpoint object snaps

blocks, 349
deck, 207–209, 207, 209
deck posts, 192
mirroring, 197
sliding glass doors, 154, 155, 161
swinging doors, 135
toilet and shelves, 247

Minor Discipline Designators in layer names, 264
mirror, bathroom, 241–245, 242–245
mirror lines, 144, 146
mirroring and MIRROR command

bifold doors, 164, 164
blocks, 341
with copying, 144
decks

3D models, 911–916, 912–916
front and back, 202–203, 202–203, 580–582, 

581–582
elevations, 583, 584
gasket, 254, 256
grips, 556–557
objects, 144–148, 145–148
posts and railings, 192, 197–200, 197–200

mistakes
correcting, 130
TRIM and EXTEND, 563

MLEADER (Multileader) command, 686
model space

plotting from, 827–832, 829–831
sheet templates, 773, 773
viewports, 789

Model Space Text Height setting, 392
modeless palettes, 266
Modify Dimension Style dialog box

Alternate Units tab, 664–665, 664
short distances, 701–703, 703
Tolerances tab, 665, 665

Modify Multileader Style dialog box, 686–688, 687–688
Modify panel, 14–15, 14–15
monochrome.ctb file, 844
More tool for multiline text, 466
mouse, 28–29
Move Or Copy dialog box, 787–788, 787
moving and MOVE command

3D models, 863
blocks, 366
dimensions, 696–697, 696–697
elevations, 597
external references, 735–736, 735

grips, 556, 865–867, 865
leaders, 691
multiline text columns, 454
Ribbon tools, 13, 13
text, 407–410, 408–409
title blocks, 440–442

MrSID (Multiresolution Seamless Image Database)  
files, 746

MSLTSCALE variable, 310–311, 605
Mtext. See multiline text
MTEXT command, 447, 450–451
Mtext context menu, 466–468
mullions, 606, 606
multifunction grips, 420

dimensions, 670–671, 670
hatch origin, 620, 621

Multileader (MLEADER) command, 686
Multileader Style Manager, 686, 686, 688, 688–689
multileaders

adding, 689–692, 690–692
creating, 686–689, 686–689

multiline text
columns

adding, 450–454, 451, 453–454
tools, 465, 467

hyperlinks, 456–459, 457–459
justification points, 463–464, 464
masks, 417
overview, 446
vs. single-line, 389, 397
special characters, 468
spell-check feature, 459–463, 460–461
title blocks, 446–450, 447–449
tools summary, 464–468
word formatting, 455–456, 455

Multiline Text Editor, 450–454, 464
Multiline Text window, 451
multiple layouts, 834–837, 835–836
Multiplier For Alt Units setting, 664
Multiresolution Seamless Image Database  

(MrSID) files, 746
My Materials Library, 965

n
named objects, 369
named plot styles, 841
named selection sets, 341
named UCS, 590, 590, 892
names

blocks, 516–517, 517
cameras, 947
dimension styles, 654
filenames, 319–320
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font, 394
layer states, 325
layers, 262–265, 262, 270
layout tabs, 782
macros, 319–320
table styles, 525, 525
text styles, 393–394, 393, 396, 402–403, 403
in title blocks, 438

National CAD Standard (NCS)
filenames, 88
layer names, 262–265, 262, 270

Navigate 2D command, 132
navigating with ViewCube, 890–893, 891–893
Navigation bar, 8
NCS (National CAD Standard)

filenames, 88
layer names, 262–265, 262, 270

Nearest osnaps for blocks, 350, 350
nested xrefs, 758
Network tool, 936, 936
New button, 25
New Dimension Style dialog box

Alternate Units tab, 664–665
Fit tab, 657, 658
Lines tab, 655, 655
Primary Units tab

architectural, 658–659, 659
metric, 660–661, 660

saving settings, 661
Symbols And Arrows tab, 655–656, 656, 681, 682
Text tab, 656–657, 657

New Layer State To Save dialog box, 322, 322, 734
New Page Setup dialog box, 774
New Palette option, 639, 642
New Style Name setting, 654
New Tab, 3–5, 3–4
New Tab button, 33
New Table Style dialog box, 525–527, 525, 527
New Text Style dialog box, 393–394, 393, 402
New UCS command, 598
New View/Shot Properties dialog box, 591, 591
No Path option for external references, 754
normal attribute state, 506, 506
North arrow in site plans, 726–727, 726
north elevation

generating, 583–586, 584–586
sheet files, 797, 797

notes, 450
columns, 450–454, 451, 453–454
formatting words, 455–456, 455
hyperlinks, 456–459, 457–459

Notifications panel, 4
Number Of Copies settings, 815
Number Of Recently Used Files list, 27
numbering multiline text, 452, 452, 465

o
Object Snap Tracking tool

blocks, 358
kitchen counters, 211–213, 213
rectangles, 434–436, 434–436
working with, 181

object snaps (osnaps) and Object Snap tab
bathrooms, 237–238, 238
blocks, 330, 349–350, 349–350, 352, 358
deck, 207–208, 207–208
doors

sliding glass doors, 151–154, 151, 155, 161, 161
swinging doors, 131–134, 132

ellipses and circles, 248
hot tub, 250
insertion points, 357–360, 358–359, 363, 363
kitchen counters, 211–213, 213
mirroring, 197
rectangles, 434–436, 434–436
starting, 307
stove and refrigerator, 217
thresholds, 183–184, 183
toilet and shelves, 246–247
tools access, 180–181

objects
assigning colors and linetypes to, 316–317
assigning to layers, 279–282, 280–281
combining. See blocks and BLOCK command
copying, 142–144, 143–144, 369–371, 370–371
mirroring, 144–148, 145–148
selection windows, 282–284, 283–284
WBLOCK, 380

Oblique Angle Spinner tool, 465
Offset From Origin setting, 655
Offset tool, 936, 936
offsets and OFFSET command

bathroom openings, 125
blocks, 351, 368
decks, 190
distances, 49–51, 50–51
driveways, 720, 720
elevations, 549–551, 550, 566, 567
errors with, 130
extension lines, 655
exterior walls, 102–103, 103
with FILLET, 55
grids, 418
height lines, 551–552
hot tub, 250
interior walls, 106–109, 107–109, 117–120, 118
from keyboard, 177
kitchen counters, 214–215, 215
parking lot, 257
Plot Offset settings, 816
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roofs, 304–305
sinks, 233–235, 235, 244
sliding glass doors, 152, 156–158, 158
stairs, 573, 574
wall openings, 122
working with, 56–57, 56–57

Online Map panel, 954
Online Resources panel, 5
OOPS command, 216
opacity maps, 972
Open and Save tab, 27
Open button, 25
Open In Block Editor option, 333, 339
opening

drawings, 23–26, 23–26
recent documents, 27
tool palettes, 383

openings
doors, 120–121, 121

exterior, 121–124, 122–124
interior, 125–127, 125–127
sliding glass door, 124, 124

marking, 56–57, 56–57
walls. See walls

operands, 858, 881
OPTIONS command and Options dialog box

Autodesk 360, 90
background color, 11, 610
Recent Documents list, 27

Options panel in Text Editor, 466
Orbit option, 252
orientation, printing, 817
Origin Point option, 621
origins

coordinate systems, 38, 38, 40
hatches, 619–620, 620, 632–634, 633

Ortho mode
bifold doors, 165
Direct Distance method, 44
doors, 137
in mirroring, 146–147, 147

orthogonal projections, 606, 607
orthographic projections, 547
osnaps. See object snaps (osnaps) and Object Snap tab
outer walls extensions, 926, 926
Output Size dialog box, 977, 977
Over Dimension Line, Without Leader option, 657
overlays, 759

vs. attachments, 732–733, 732
layers. See layers and Layer Properties Manager

Overline tool, 464
Override OS Settings For All Drafting Tooltips option, 85

overrides
background, 961
dimensions, 700–701, 700
page setup, 800, 839
text, 693–694

P
Page Setup dialog box, 774–775, 776
Page Setup Manager dialog box, 774–775, 774
Page Setup Overrides, 839
Page Setup Overrides File property, 800
palettes. See tools and tool palettes
Pan Realtime mode

toilet and shelves, 246
working with, 251–252

Pan tool, 252, 583
panels, 13, 13
panning and PAN command, 163, 163
Paper Size settings

printer, 815
sheet templates, 775

paper space for layouts, 773, 773
Paper Space Height setting, 403–404
Paragraph Alignment option, 467
Paragraph dialog box, 467
Paragraph panel, 465
Paragraph tool, 465, 467
paragraphs in multiline text, 446, 465, 467
parameters for dynamic blocks, 509–513, 510–513
parametric drawings

AutoCAD LT, 219–221, 219–221
dimensional constraints, 223–225, 229–233, 230–232
geometric constraints

applying, 225–229, 226, 228
working with, 221–223, 222–223

stoves, 218–219, 219, 221–223
parent dimension style, 681–684, 682–683
parking lot, 256–258, 256
parquet hatch pattern, 634, 634–635
Paste option, 467
Paste Special option, 467
Paste To Original Coordinates option, 370, 370
Patch tool, 936, 936
Path Array (ARRAYPATH) command, 570–572
path arrays, 569–572, 570–572
paths

external references, 730
changing, 754–755, 755
setting, 751–753, 752–753

images, 747, 747
patterns, hatch. See hatches and hatch patterns
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peaks, roof, 923, 923–924
PEDIT command

contour lines, 942
roofs, 307
title blocks, 431

pen plotters, 811
perimeter measurements for bathroom, 492, 492
Perpendicular object snaps

blocks, 349
desks, 189, 189
hot tub, 250
sliding glass doors, 161, 161
thresholds, 183–184, 183

Photoshop (PSD) documents, 746
Pick Insertion Base Point option, 763
pickbox, 35, 46
picking objects, 295
pinning panels, 14–15
pipe symbols (|) for layers, 742
pivot doors, 888–890, 888–889
PLAN command, 585, 598, 602, 796
plan sheets

cover sheets, 781–782, 781–782
floor

composing, 788–793, 789–792
Floor Plan Doors sheets, 791–793, 792–793
Floor Plan Materials sheets, 790, 790
generating, 783–788, 784–787

planar surfaces, 931, 931
Planar tool, 936
plats for surveys, 716
PLINE (Polyline) command. See polylines and PLINE 

command
Plot Area settings, 815–816
PLOT command and Plot dialog box

expanded, 813, 814
plot configuration, 827–829, 829
Plot Offset settings, 816
preview, 829, 831–832
settings, 815–817
tasks, 812–813, 813

Plot Offset settings, 816
Plot Scale Confirm dialog box, 829
Plot Style layer property, 266
Plot Style Table Editor dialog box, 841–843, 842–844
plot-style tables, 817

organization, 841–844, 841–844
overview, 840, 840

Plot Styles folder, 840, 840
Plot Upside-Down option, 817
plotting. See printing/plotting
plumbing diagrams, 387
POINT command, 484–485

point filters, 206–210, 207–210
point lights, 950
Point Style dialog box, 484, 484
Pointer Input Settings dialog box, 83–84, 83
points

attributes, 484–485, 484
elevation, 552, 553–554
grids, 79, 80
hinge, 329, 331, 332, 338
insertion. See insertion points
justification

multiline text, 463–464, 464
single-line text, 399, 399, 424–425, 425

with LINE, 35–36, 36
registration, 259
styles, 484
tracking, 180, 217, 358–359, 358–359

polar coordinates, 43–44, 43, 47
Polar Tracking and Polar Tracking tab

decks, 186, 188, 188
Direct Distance method, 44
Direct Input method, 47
hot tub, 249–250, 250

Polar Tracking Increment Angle setting, 249
polylines and PLINE command

contour lines, 941–942, 941–942
creating and editing, 100–102, 101–102
decks, 189
from existing objects, 97–100, 98–99
hot tub, 249–251
selecting, 491–492, 492
title blocks, 432, 436

POLYSOLID command, 857
Polysolid tool, 854
pop-outs in hatching, 619–620, 620–621
portrait orientation, 817
position of arcs, 139
posts

decks, 190–195, 191–195
mirroring, 192, 197–200, 197–200
railings, 569–572, 570–572, 899–903, 899–903
roof support, 928, 929

precision of units, 67–68, 70, 659, 661
Presentation rendering setting, 976, 976
Press/Pull tool, 932, 932
previewing

DesignCenter, 377
hatch patterns, 612, 613, 626
print, 829–832, 830–831
thumbnails, 16, 16

Primary Units tab
architectural, 658–659, 659
metric, 660–661, 660
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primitives, 859, 930–931, 930
Print options, 22, 23
printable areas, 428, 428
Printer/Plotter settings, 815
printing/plotting, 811

layouts for. See layouts
lineweights, 818–824, 822–823
model space, 827–832, 829–831
Plot dialog box. See PLOT command  

and Plot dialog box
plot-style tables, 839

organization, 841–844, 841–844
overview, 840, 840

previewing, 829–832, 830–831
Processing Background Job dialog box, 836
properties and Properties palette

attributes, 502
blocks

dynamic, 513–517, 514–517
scale factor, 360–362, 361–362
working with, 347–348, 348

layers, 264–266, 267
sheet set, 800, 801, 804–808, 805
synchronizing, 438

property lines, 716–719, 716–719
PSLTSCALE variable, 310–311, 605
Publish dialog box, 834–835, 835
Publish To DWF/DWFx option, 838
Publish To PDF option, 838
Publish To Plotter option, 838–839
Publish Using Page Setup Override option, 839
publishing

multiple layouts, 834–837, 835–836
with Sheet Set Manager, 837–839, 837–838
single layouts, 832–834, 833–834

PURGE command and Purge dialog box
block references, 518–519, 520
features, 380

Purge Nested Items option, 518
pyramids, 931

Q
QSAVE (Quick Save) command, 87
Quadrant object snap, 248
quadrants, 38, 38
quarter-inch scale, 428, 428, 615
Quick Access toolbar, 6, 25
Quick Properties panel, 284–286, 285
Quick View Layouts tool, 833

R
Radial child style, 681–683, 682
radial dimensions, 678–679, 678
radians, 93
radius and Radius tool

child dimensions, 683, 684
FILLET curves, 52–53, 55, 55

Radius constraints, 232
railings

deck, 898–903, 898–903
mirroring, 197–200, 197–200
posts, 569–572, 570–572, 906–908, 908, 913, 913

raster image files, 727
ratios

hatch pattern scales, 615
scale factors, 391–392

rays, 553
Realistic visual style, 971, 972
ReCap products, 728
Recent Documents list, 24, 27
Recent Documents panel, 3
Recent Input option, 176, 176
Reconcile Layer option, 814
Record button, 318
Rectangles and RECTANG command

bifold doors, 163
borders, 429–432, 429
contour lines, 940
deck, 874
deck posts, 190–191
extruded, 935, 936
refrigerators, 216–217, 217–218
shower units, 239
supports and foundation, 578–579
swinging doors, 134, 134, 136
title blocks, 432–437, 434
toilet, 246

Rectangular Array (ARRAYRECT) command, 901
Red, Green, Blue (RGB) color model, 271, 271
red grips, 308
Redo tool and REDO command, 214

multiline text, 466
working with, 130, 216

REFEDIT (Edit Reference In-Place) command, 740–743, 
757

Reference Edit dialog box, 741, 741
references, external. See external references (xrefs)
References - Unresolved Reference Files dialog box, 752, 

752
Refine Data settings, 540
refrigerators, 216–218, 217–218
Regapps option, 519
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REGEN command, 504–505
REGENALL command

attributes, 504–505, 505
hatch patterns, 627
linetypes, 312

registration points, 259
relative coordinates

Cartesian
description, 42, 43
working with, 45, 45–46

overview, 41–42
polar

description, 43–44, 43
working with, 47

Relative Path option
external references, 730
images, 747, 747

Remove Formatting option, 468
removing

multiline text formatting, 468
objects from selection sets, 295

Rename dialog box, 516–517, 517
Rename & Renumber Sheet dialog box, 807
renaming

blocks, 516–517, 517
layer states, 325
layout tabs, 782

Render Output File dialog box, 975, 975
Render window, 956–957, 957, 963
rendering, 939

cameras, 945–949, 946–949
to files, 974–978, 975–977
lighting, 950

background, 960–963, 961–962
first render, 956–960, 957–959
shadows, 954–956, 955–956
source, 950–954, 951–954

materials. See materials
Repeat option, 104
Repeat Command option, 176
Replace dialog box for multiline text, 467
Restore States option, 652
restoring layer states, 325, 651–652
Restrict Cursor Orthogonally Mode and tool, 21
Retain option for blocks, 335
Retain Attribute Display option, 503, 506, 506
revising blocks, 366–369, 367–368
Revolve objects, 932, 932
Revolve tool, 935–936
Revolved Mesh tool, 934, 934
RGB (Red, Green, Blue) color model, 271, 271
Ribbon, 7

overview, 12, 12
panels, 13, 13

tabs, 12, 12
tools, 13, 13

displaying, 13–14
working with, 13–15, 13–15

ridgelines, 304, 312–313, 312–313
Right Attachment setting, 688
right-click context menus, 176, 176
right-hand rules

first right-hand rule, 864–868, 864–867
second right-hand rule, 879–880, 880

right justification, 425, 465
right mouse button, 28
rise in stairs, 572
Roman fonts, 396
roofs, 303–304, 304

3D model
constructing, 916–920, 917–920
tweaking, 925–928, 926–929
wall adjustments for, 921–925, 921–925

eaves, 304–309, 305–306, 308–309
hatches, 642–644, 643–644, 647–648, 648
linetypes, 309–312, 311–312
ridgelines, 312–313, 312–313

room labels
annotation scales, 407–410, 408–409
breaking lines, 413–417, 413–414, 416
placing, 404–407, 405–407
synchronizing positions, 410–412, 411–412

rotating and ROTATE command
3D models, 863, 879–880, 880
arcs, 138
bifold doors, 164
with block insertion

doors, 338, 340–341
windows, 354–357, 355–357

blocks, 366
doors, 136–138, 137
elevations, 596, 597
external references, 735–736, 735
grips, 556
text, 400
UCS, 585, 585, 795–796

rounding corners. See filleting and FILLET command
RTF formats, 466
Ruled Mesh tool, 934, 934
Ruler tool, 466
run of stairs, 572
running commands, 175–178, 176
running object snaps

bathrooms, 237–238, 238
disabling, 365
doors, 135, 151
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S
Save Block option, 368, 516
SAVE command, 87
Save Data Extraction As dialog box, 538
Save Drawing As dialog box, 26, 26, 86–87, 86
Save List As dialog box, 836
Save Sheet List dialog box, 835–836
Saved Path option, 730
SAVETIME command, 742
saving

dimension styles, 661–663, 662
drawings

Autodesk 360 storage, 89–90, 89
drives, 85–88, 86

layer states, 322, 322
UCS, 589

Scale Action option, 513, 513, 515
Scale For Dimension Features settings, 657
Scale List tool, 776
scalelistedit command, 776
scales and SCALE command

annotation
changing, 311, 311
floor plan labels, 404–407, 405–407
synchronizing positions, 410–412, 411–412
working with, 407–410, 408–409

bathroom doors, 149–151, 149–150
blocks, 352, 366

dynamic, 513, 513, 515, 523, 523
insertion, 337, 339
title, 765–766, 766
windows, 360–362, 361–362

considerations, 604–605
deck posts, 194, 195
grids, 473, 473
hatch patterns, 612, 612, 615
layouts, 731
linetypes, 309–312, 311–312
multileaders, 688
sheet templates, 776
text, 391
viewports, 786, 786

schedules, tables for, 471
from attributes, 537–542, 537, 539–542
designing, 528–532, 529–532
display, 542–544, 543–544
formulas, 532–536, 533–534, 536
styles, 524–525, 524–528

Scientific units, 92
Search dialog box in DesignCenter, 377
second right-hand rule, 879–880, 880
sections, 605
segments for polylines, 100
Select All option, 467

Select Boundary Objects option, 626
Select Color dialog box, 266–269, 267

blocks, 355
Color Books tab, 273–274, 274
gradients, 625, 625
Index Color tab, 272–273
point lights, 958, 958
True Color tab, 271, 271, 273

Select File dialog box, 24, 98
multiline text, 466
sheet templates, 778

Select Image File dialog box
adding, 745
textures, 973

Select Layout As Sheet Template dialog box, 800, 800
Select Linetype dialog box, 274–276, 275–276
Select New Path dialog box, 753
Select Object option for fields, 495
Select Objects option for hatch patterns, 626
Select Reference File dialog box, 728, 729, 746–747, 746
Select Similar command, 293–294, 294
Select Template dialog box, 24, 800
Select Template From File dialog box, 781
selecting

doors and swings, 286–290, 286–287
kitchen and bathroom fixtures, 290–293, 291–292
with picking, 295
walls, 293–294, 294

Selection Area Effect settings, 167
Selection Cycling tool

lines, 234, 234, 601–602
polylines, 491–492, 492

Selection dialog box, 492
lines, 234, 234
Selection Cycling, 602

selection sets
names, 341
removing objects from, 295

selection windows
objects, 282–284, 283–284
sliding glass door, 289, 291–292
working with, 167

Send To Back command, 628–629, 629
Separate Hatches option, 620
Set Current option, 662
Set Landing Distance option, 687
Set Origin tool, 620, 632
SETBYLAYER command, 316
setup, 65

drawing area, 71–72
Drawing Limits setting, 76–79, 76–78
grid, 72–76, 73–75

drawing units, 66–71, 66–68, 70
Shaded Viewport Options, 817
shading with gradients, 623–628, 624–628
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shadows, 954–956, 955–956
shakes, 618
shapes

drawing, 44
Direct Input method, 47–48, 48
erasing lines, 46–47
extending lines, 57–58, 57
FILLET command, 52–55, 52–55
OFFSET command, 49–51, 50–51, 56–57, 56–57
relative Cartesian coordinates, 45, 45–46
relative polar coordinates, 47
trimming lines, 59–62, 59–61

hatch patterns, 637–638, 638
sharing information, 369

AutoCAD palettes, 381–384, 382, 384–385
copying objects, 369–371, 370–371
DesignCenter tool, 371–376, 372–376
inserting drawings into other drawings, 380–381
WBLOCK command, 378–380, 378

Sheet Creation Template property, 800
sheet files

elevations, 793–797, 795–797
floor plans

Floor Plan Doors sheets, 791–793, 792–793
Floor Plan Materials sheets, 790, 790

Sheet List palette, 801, 804, 806, 837
Sheet Properties dialog box, 804–808, 805
Sheet Set Manager, 779

attributes, 768
description, 798
plotters, 838
publishing with, 837–839, 837–838
sheet sets

creating, 798–802, 798–801
existing drawings, 802–804, 802–804

Sheet Set Properties dialog box, 800, 801
Sheet Storage Location property, 800
sheet templates

finishing, 778–780, 779–780
setting up, 772–777, 773–774

shelves, 245–248, 247–248
Shift key

EXTEND command, 115, 115, 126, 126–127
FILLET command, 111
osnaps, 140, 146–147, 147, 181
radius setting, 53
for selections, 281, 295

short distances, dimensions for, 701–704, 702–704
Show 2 Dimension Input Fields At A Time option, 84
Show Additional Tips With Command  

Prompting option, 84
Show All tool, 222
Show Annotation Objects tool, 21
Show Command Prompting And Command Input Near 

The Crosshairs option, 84

Show Count Column option, 540
Show History option, 882, 882, 885
Show Name Column option, 540
Show Panels option, 796
Show Snapping Reference Lines tool, 21
Show UCS Icon option, 850
shower units, 239–241, 239–241
SHX (Compiled Shape) font files, 396
sidewalks, 723–725, 724
Sign In To Autodesk 360 option, 89
single layouts, publishing, 832–834, 833–834
single-line text

justification, 399, 399
vs. multiline text, 389, 397

Single Line Text tool, 397, 399, 423
sink

bathroom, 241–245, 242–245
kitchen, 233–236, 233–235
snap tracking, 357–360, 358–359

site plans, 714, 714
driveways, 719–727, 720, 722–724, 726
labels, 725
North arrow, 726–727, 726
Surveyor's units, 715–719, 715–719

size
annotative text, 403–404, 403
arcs, 139
command line history, 17, 18
decks, 203–206, 204–206
dynamic blocks, 521–523, 521–523
material maps, 970–971, 970–972
paper, 775, 815
rendering output, 977–978, 977
title blocks, 765–767, 766–767
window glazing, 885, 886

skirts for decks, 910–911, 910–911
Sky Properties rollout, 962
SLICE command, 921
Slice tool, 921–922, 921–922
sliding glass doors, 872

3D models, 893–897, 893–896
alternative, 169, 169
drawing, 151–162, 151–162
openings, 124, 124
selecting, 288–290, 289

Smooth Fit option, 944
Snap And Grid tab, 73, 74, 78–79, 78
Snap Cursor to 2D Reference Points tool, 21
Snap Mode and tool, 21. See also object snaps (osnaps) 

and Object Snap tab
drawing with, 79–82, 80–82
with grid, 75, 78

Snap To Midpoint option, 209
Snap X Spacing setting, 78
Snap Y Spacing setting, 78
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soffits, 551
solid-fill hatches, 622–623, 622–623
Solid History rollout, 882
SOLID pattern, 622
south elevation

construction lines
copying, 554–556, 555–556
working with, 552, 553–554

creating, 548–551, 549–550
decks

drawing, 565–569, 565–569
mirroring, 580–582, 581–582

hatching, 610–613, 611–613
foundation, 616–617, 616–617
pop-outs, 619–620, 620–621
shading, 623–628, 624–628
solid-fill, 622–623, 622–623
walls, 618–619, 619

layers, assigning, 563–564, 564
lines

for heights, 551–552, 551–552
trimming, 557–562, 558–562

railing posts, 569–572, 570–572
revising, 586–593, 587–592
sheet files, 794, 795
stairs, 572–578, 573–578
supports and foundation, 578–580, 579–580

spaces in distances, 106
spacing

grid, 77–78, 78
hatches, 630, 632
multiline text columns, 454, 454
stacked dimensions, 698–699, 698–699
text lines, 465

special characters
dimension text, 694–695, 694–695
filenames, 320
multiline text, 468

special effects with shading and gradients, 623–628, 
624–628

Specify Axis Endpoint option, 247
Specify Image Size option, 977
Specify Included Angle option, 141
Specify On-Screen option

block insertions, 339–340
dynamic blocks, 520
insertion points, 220
title blocks, 445

Spell Check Complete dialog box, 463
spell-check feature, 459

entire drawing, 462–463, 462
realtime, 460–462, 460–461

Spell Check panel, 466
Spell Check tool, 462
Spelling Suggestions option, 467

spheres, 931
Spline option for contour lines, 942, 943
spotlights, 950
Stack tool for multiline text, 465
stacked dimensions, 698–699, 698–699
stairs, 195–197

back, 201–206, 201–206
deck, 903–906, 904–906
elevations, 572–578, 573–578
handrails, 906–909, 907–909
posts and railings, 197–200, 197–200

Standard dimension style, 654
standard linetypes, 277
Standard text styles, 392, 397
Start, Center, Angle options for arcs, 138–140
Start Drawing tool, 5, 33, 66, 66
starting

AutoCAD, 2
commands, 175–178, 176

states, layers. See Layer States Manager
static text styles, 392
status bar, 8, 20–22, 20
status properties for layers, 266
.stb files, 840
steps. See stairs
Stop button, 318–319
stoves

burners
drawing, 223–225, 224–225
geometric constraints, 225–229, 226, 228

drawing, 216–218, 217–218
geometric constraints, 221–223, 222–223
parametrics, 218–219, 219, 221–223

Stretch action, 509
Stretch mode, 430
stretching and STRETCH command

annotation scales, 409
bathroom doors, 149
construction lines, 555
decks, 203–206, 204–206, 504, 504
doors, 511–513, 512–513, 515
elevations, 602
multiline text columns, 454
title blocks, 432

Strikethrough tool, 464
stringers, 575, 576, 579, 904–905, 905
structural grids, 417–418
studs, 668
Style panel

multiline text, 451, 451
settings, 464

styles and STYLE command
cells, 532
dimensions. See dimension styles and Dimension 

Style Manager dialog box

www.MouradEngineering.com



	 S u b t r a c t i o n 	 f u n c t i o n 	 • 	 Te x t 	O v e r r i d e 	 s e t t i n g  1 0 0 5

points, 484–485, 484
table, 524–528, 524–528
text. See text styles and Text Style dialog box

Subtraction function
area calculations, 493
description, 858
wall openings, 868–869
windows, 877, 883, 883, 885

suggestions, spell-check, 460, 463, 467
Sum formula, 534
Summary tab for sheet templates, 779, 779
Sun & Location panel, 951–952
Sun & Sky Background setting, 960–962, 963
Sun Angle Calculator rollout, 951–952
sun light, 951–952, 951
Sun Properties dialog box, 951, 951
Sun Status button, 951
supports

3D models, 873–874, 874
elevations, 578–580, 579–580

suppressing extension lines, 700–701, 700
surfaces

planar, 931, 931
surface-modeling tools, 935–936, 935–936

Surveyor's units, 715
description, 93
overview, 715–716, 715
property lines, 716–719, 716–719

swatches, 267–268, 272
Sweep objects, 932, 932
Sweep tool, 935–936
swinging doors, 131–136, 132–136
swings, door

drawing, 138–142, 139–141
selecting, 286–290, 286–287

switching workspaces, 8
symbol codes, dimension text, 694–695, 694–695
Symbol option and Symbol dialog box, 465
Symbol tool, 467
Symbols And Arrows tab

child dimensions, 681, 682
settings, 655–656, 656

Symmetrical tolerance method, 665
Synchronize Multiple-Scale Positions tool, 411, 411
synchronizing

annotation scale positions, 410–412, 411–412
properties, 438

synonyms, command line, 18, 19

t
T-intersections, 113–116, 113–116, 119
Table Cell Format dialog box, 526, 526, 532–539, 533
Table Cell tab, 532

TABLE command, 537
Table Style dialog box, 524–525, 524, 527, 528
Table View tab, 842–843, 843
Table Width property, 542
tables, 524–525

from attributes, 537–542, 537, 539–542
cells, 525–527, 526, 532–535, 533
designing, 528–532, 529–532
displaying, 542–544, 543–544
formulas, 532–536, 533–534, 536
plot-style, 839

organization, 841–844, 841–844
overview, 840, 840

styles, 524–528, 524–528
tabs, Ribbon, 12, 12
Tabulated Mesh tool, 934, 934
Tag setting for attributes, 474
Tan, Tan, Radius circle option, 224
Tan, Tan, Tan circle option, 224
TEDIT command, 427, 440, 695
Template Options dialog box, 777
templates, sheet

finishing, 778–780, 779–780
setting up, 772–777, 773–774

temporary tracking points, 180
insertion points, 358–359, 358–359
stove and refrigerator, 216–217

Test Block option, 516, 516
text and TEXT command, 389

annotative. See annotative text and Annotate tab
attribute, 482–483, 482–483
attribute definition, 475–476, 475–477
dimension. See dimensions
multiline. See multiline text
styles. See text styles and Text Style dialog box
view title, 406

Text Editor tab
Close panel, 466
column breaks, 453
dimension text, 695, 695
Formatting panel, 464–465
hyperlinks, 456
Insert panel, 465–466
justification points, 464
leaders, 690
Mtext context menu, 466–468
Options panel, 466
Paragraph panel, 465
Spell Check panel, 460, 466
Style panel, 464
tables, 530
Tools panel, 466

Text Height setting, 653
Text Mask utility, 417
Text Override setting, 693–694

www.MouradEngineering.com



1 0 0 6 	 Te x t 	 S e t t i n g s 	 g r o u p 	 • 	 t r imm i n g 	 a n d 	 T R IM 	 c ommand

Text Settings group, 769
text styles and Text Style dialog box

annotative
current, 398, 398
defining, 402–404, 403–404
dimension, 657, 657
setting up, 390
view titles, 392

creating, 652–653
notes, 451, 451
scale, 391–392
setting up, 390, 390
tables, 525–527
title blocks, 439, 439–440

annotative, 428–429, 428
multiline, 446–450, 447–449
placing, 438–446, 439–445

view titles
defining, 392–397, 392–393
placing, 397–401, 397–401

Text tab
dimension styles, 656–657, 657
tables, 526–527

Texture Editor palette, 971, 972
texture for materials, 972–974, 973–974
Thaw All Layers tool, 313, 762
thickness

interior walls, 106
lineweights, 821

thresholds, 178, 179
back, 184–186, 184–185
extruding, 870–873, 871–873
front, 179–184, 180–183

Through option for OFFSET, 51
thumbnails

materials, 965, 965
selected files, 25, 25

thumbnails previews, 16, 16
tick marks for dimensions, 649, 650
TIF files

external references, 727
rendering, 975–976, 976

TIFF Image Options dialog box, 975–976, 976
tiled hatch patterns, 631, 631
tiled viewports, 789
Tip panel, 4
title bars

description, 7
palettes, 381–382, 384, 385
Plot dialog box, 813

title blocks
attributes, 767–772, 768–770, 772
constructing, 432–438, 433–437
creating, 762–765, 763–765
sizing and cleaning up, 765–767, 766–767

text in
annotative, 428–429, 428
multiline, 446–450, 447–449
placing, 438–446, 439–445

titles, view
defining, 392–397, 392–393
placing, 397–401, 397–401

toilet, 245–248, 247–248
tolerance forms, 465
Tolerances tab for dimensions, 665, 665
Tool Palettes tool, 639
Tool Properties dialog box, 641–644, 643–645
toolbars, 34, 35
tools and tool palettes, 57, 639

AutoCAD, 381–384, 382, 384–385
for commands, 644–646, 645
creating, 639–642, 639–642
for hatches, 642–644, 643–644
hiding, 646
Ribbon, 13, 13

displaying, 13–14
working with, 13–15, 13–15

Text Editor, 464–468
Tools panel, 466
Tooltip Appearance dialog box, 84, 85
tooltips, 13, 13, 84, 85
Top option for ViewCube, 891
torus, 931
tracking points, 180

insertion points, 358–359, 358–359
stove and refrigerator, 216–217

Tracking Spinner tool, 465
traditional colors, 272–273
transferring information. See sharing information
transparency

layers, 266
palettes, 382–384, 382, 384

Transparency dialog box, 382–383, 382
Transparency property, 266
transparent commands, 144
traverses, 716, 719, 719
Tree View Toggle option, 377
trees, 386–387, 386
Trim Fence option, 123–124, 123
trimming and TRIM command

breaking lines, 415–417, 416
construction lines, 553
deck, 580
EDGEMODE variable, 160
elevation lines, 557–562, 558–562, 567–568, 568, 599
errors with, 130, 563
gasket, 256
interior walls, 112–113, 116–117, 119
from keyboard, 177
lines, 59–62, 59–61
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openings, 129
polylines, 101–102, 101–102
posts, 192, 193
railings, 200
sliding glass doors, 152, 158–159, 160
stoves, 217
tips, 562–563
wall openings, 124

True Color tab, 271, 271, 273
TrueType font (TTF) files, 396
Turn All Layers On tool, 299
turning off layers, 295–299, 296–299, 624
TXT2MTXT command, 446
Type The File Or Web Page Name setting, 457

u
U command, 55, 214
UCS (user coordinate system)

Dynamic
roof, 926
stairs, 906–907
windows, 875–876, 876

elevations, 584, 585, 598, 601–602
named, 590, 590, 892
rotating, 795–796
saving, 589
ViewCube for, 892

UCS command and UCS dialog box, 585, 590, 590
UCS icon, 8

3D workspace, 852–853, 865
displaying, 850
Dynamic UCS, 875
model space and paper space, 773, 773
purpose, 72
right-hand rules, 864–865
rotating, 585, 585
and viewpoints, 852, 853

UCSMAN command, 590
Underline tool, 464
underlined text, 455, 455, 464
UNDO command, 55, 214
Undo tool

activating, 130
fillets, 105
multiline text, 466
options, 216

Union function, 858, 933
units and UNITS command, 67, 91

alternate, 664–665, 664
angular, 93
architectural, 658–659, 659
converting, 496
drawing, 66–71, 66–68, 70
linear, 92

metric, 660–661, 660
text, 404

Unload option for external references, 759
unpinning panels, 15
unreconciled layers, 814
Unreconciled New Layers option, 814
Up option in DesignCenter, 377
Update The Location Of The Referenced Files option, 752
Use Object Color option, 844
Use Overall Scale Of setting, 657
user coordinate system. See UCS (user coordinate system)
user-defined hatch patterns, 630–632, 630–631
user interface (UI)

Application menu, 22–27, 23–26
command line, 17–20, 17–20
File Tabs, 15–16, 16
New Tab, 3–5, 3–4
overview, 2
Ribbon, 12–15, 13–15
status bar, 20–22, 20
working with, 10
workspaces, 5–10, 5, 9–10

USGS Digital Orthophoto Quadrangle (DOQ) format, 746

V
variables, dimension, 653
vector image files, 727
Vertical Cell Margin setting, 543, 543
Vertical constraint tool, 227, 228
vertical dimensions, 673–675, 673–675
vertices for polylines, 100
View Controls menu, 851, 851
View Controls tool, 9, 9
View Manager dialog box

cameras, 949, 949, 961–962, 961
elevations, 590–592, 591

View option for Plot Area settings, 816
View Ribbon tab, 589, 589
view titles

defining, 392–397, 392–393
highlighting, 406
placing, 397–401, 397–401

ViewCube
3D workspace, 853
description, 7
navigating with, 890–893, 891–893
UCS, 584, 585, 598

Viewport controls, 10, 10
viewports

elevation sheet files, 793–797, 795–797
floor plan sheets, 784–786, 785

Floor Plan Doors sheets, 791–793, 792–793
Floor Plan Materials sheets, 790, 790

Views option in DesignCenter, 377
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virtual devices, 815
visibility

attributes, 503–507, 503–506
image frames, 749

Visible/Invisible mode, 507
VISRETAIN variable, 824–825
Visual Effect Settings dialog box, 167, 168
Visual Style control, 10
Visual Style Controls menu, 852
visual styles for 3D models, 853–854, 853
Visualize tab, 964, 966

W
walls, 852, 852

dimensions, 666–668, 666
exterior

3D models, 854–856, 855–856
description, 97
lines, 102–106, 103–105

hatching, 618–619, 619
interior

3D models, 856–858, 857–858
cleaning up, 110–113, 110–112
creating, 106–109, 107–109
finishing, 117–120, 118–120
zooming, 113–120, 113–120

openings
3D models, 868–870, 869–870
closet, 128–129, 128–129
cutting, 120–121, 121
exterior, 121–124, 122–124
interior, 125–127, 125–127
sliding glass door, 124, 124

overview, 96, 96
polylines

creating and editing, 100–102, 101–102
from existing objects, 97–100, 98–99

under roof, 921–925, 921–925
selecting, 293–294, 294
tweaking, 925–928, 926–929

WBLOCK (Write Block) command and Write Block dialog 
box

sharing information with, 378–380, 378
title blocks, 763–764, 765

WCS (world coordinate system), 584, 603
weblights, 950
wedges, 931
West Elevation sheet files, 797, 797
What To Plot list, 828
What's New panel, 4
width

multiline text columns, 454, 454, 465
tables, 543, 543

Width Factor Spinner tool, 465

wildcards for layers, 472
Window option for Plot Area settings, 816
windows

3D models
block-outs, 862–863, 863
building, 874–879, 876–879
completing, 881–888, 882–888

blocks
creating, 348–353, 349–351, 353
finishing, 362–366, 362–365
inserting, 353–360, 354–359
insertion points, 357–360, 358–359
placing, 316
scale factor, 360–362

dimensions, 696–697, 696–697
selection

objects, 282–284, 283–284
sliding glass door, 288, 289
working with, 167

wood shingles, 618
word formatting for multiline text, 455–456, 455
Workspace Switching tool, 8, 22
workspaces, 2

3D models, 848–853, 849–853
Drafting & Annotation, 6–10, 9–10
overview, 5–6
switching, 8

world coordinate system (WCS), 584, 603
Write Block (WBLOCK command) and Write Block dialog 

box
sharing information with, 378–380, 378
title blocks, 763–764, 765

WSCURRENT command, 8

X
x-axes and coordinates, 37–41, 37–38, 40, 43
X point filters, 206, 208–209, 208
X-Ray visual style, 852–853, 853
X scale factor, 337
X Setting for printing offset, 816
XLINE (Construction Line) command, 553
XR command, 727
xref-dependent layers, 742
xrefs. See external references (xrefs)
xy planes, 37, 37
xz planes, 37, 37

Y
y-axes and coordinates, 37–41, 37–38, 40, 43
Y point filters, 206
Y scale factor, 337
Y Setting for printing offset, 816
yz planes, 37, 37
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Z
z-axes and coordinates, 37, 37, 850
Z scale factor, 337
Zero Suppression settings

architectural units, 659–660
metric units, 661

Zoom Extents option
block insertion, 340, 340
description, 252
interior walls, 110
sliding glass doors, 152

Zoom In command for grid, 72, 75
Zoom Object option, 486
Zoom Original option, 252
Zoom Out command for grid, 72, 74, 75
ZOOM Previous option, 283

blocks, 368
interior walls, 116, 116, 120

Zoom Realtime mode
toilet and shelves, 246
working with, 251–252

Zoom Scale option, 110, 110
zoom windows and Zoom Window option

blocks, 350, 350
description, 252
interior walls, 114–115, 114, 120
swinging doors, 132, 133

ZOOMFACTOR variable, 153
zooming and ZOOM command

block insertion, 338, 338, 350, 350
with copying, 144
drawing area, 76
interior walls, 110, 113–120, 113–120
sliding glass doors, 152, 153
swinging doors, 132, 133
thresholds, 179–184, 182–183
toilet and shelves, 246

uploaded by [stormrg]
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